
www.xara.com 

 
 

 

         

 



 

 2 Contents 
  

 

 

Contents 

Introduction to Xara Photo & Graphic Designer 13 

Welcome to Xara Photo & Graphic Designer 13 

Photo & Graphic Designer terminology 13 

Windows terminology 14 

Getting Help 17 
Support 17 

Document info 19 

About Xara Photo & Graphic Designer 19 

Tooltips 19 

Getting Started 20 
Program Layout 20 
Drawing Tools 23 
Object Based Design 27 
The Selector Tool 28 
Right-click context menus 30 
Using Templates & Clipart 30 
The Online Content Catalog 30 
The Local Designs Gallery 32 
Theme Colors 34 
Photos 39 
Text 41 
Page Size 43 
Saving & Exporting Your Work. 43 
Automatic Backups 43 
Groups 44 
Repeating Objects 44 
Layers 45 

Document handling 46 
Starting a new document 46 
Opening an existing document 47 
Selected document and title bar 47 
Control bars 48 
InfoBar 48 
Main toolbar 49 
Rulers 49 
The status line 49 
The indicators 50 
X/Y co-ordinates 50 
Normal/full screen modes 50 
Opening a second window 51 



 

Contents 3  
 
 

 

Changing the zoom value 51 
Sliding the document within the window 53 
Changing the page size 54 
Multi-page Documents 58 
Saving the document 65 
Closing the document 65 
Automatic Backups 66 
On-screen grid 68 
Rulers 69 
Measurement units 70 
Decimal point & thousands separator characters 72 
View quality slider 73 
The constrain key 73 
Galleries 74 
Naming objects 82 
The Name Gallery 83 
Exports, slices, and stretches properties 85 
Selecting objects using the Name Gallery 86 
Undo and Redo 87 
Copying & Pasting between Xara Photo & Graphic Designer and other 

programs 88 

Drawing Lines and Shapes 89 
The Drawing tools 89 
The Freehand & Brush Tool 89 
Editing lines/shapes with the Freehand & Brush Tool 91 
The Straight Line & Arrow tool 92 
Shape Painter tool 94 
The Shape Tool 96 
Extending the line 98 
Finishing the line 98 
Adding a new point handle 99 
Selecting multiple point handles 99 
Deleting points 100 
Moving point handles—Shape Editor Tool 100 
Constraining the line 102 
Changing curves 102 
Changing a straight line to a curve (and vice versa) 104 
Joining lines 104 
Splitting a shape 105 
Changing the line width (thickness) 105 
Variable width lines 106 
Line Gallery 107 
Brushes 109 

Selecting Objects 115 



 

 4 Contents 
  

 

 

The Selector Tool 115 
Selecting objects 116 
Double-click shortcuts to tools 119 
Identifying a selected object 119 
Hiding objects 121 
Locking objects 121 
Soloing objects 121 

Object Handling 123 
Moving objects 123 
Removing objects from the document 127 
Duplicating and cloning 127 
Moving objects forward and backwards 128 
Rotating objects 130 
Scaling (resizing) objects 132 
Stretching and squashing objects 136 
Skewing objects 137 
Flipping objects 138 
Feathering 138 
Snapping 138 
Guide Objects and Guidelines 143 
Summary of shortcuts on the numeric keypad 145 
Grouping and ungrouping objects 145 
Photo Groups 147 
Editing inside groups 147 
Other types of groups 148 
Soft Groups 149 
Alignment 150 
Copying Styles: Paste Attributes 153 
ClipView 154 
Repeating Objects 155 
Live Copies 159 
Auto-fit to page... 160 
Adding Hyperlinks 167 
Conflicts in page layouts 168 

Shape Handling 169 
Shape drawing tools 169 
SmartShapes 169 
Editing SmartShapes 170 
Table SmartShape 171 
Timeline SmartShapes 173 
Chart SmartShapes 175 
Pie chart SmartShapes 176 
Text Panel SmartShapes 178 
Arrow SmartShapes 180 



 

Contents 5  
 
 

 

Labeled lines 181 
Chevron Bar SmartShape 182 
Flowline SmartShapes 183 
Creating rectangles and squares 183 
Creating circles and ellipses 184 
Creating polygons and stars 184 
Combining shapes 187 
Joining shapes 190 
Making shapes editable 191 

Page & Layer Gallery 193 
The Page & Layer Gallery 193 
Pages 195 
Layers 195 
Layer Operations 197 
Special Layers 200 
Objects 201 
Hiding Layers and Objects 203 
Locking Layers and Objects 203 
Solo Mode 203 
Show All & Unlock All 204 
Moving Objects Between Layers 204 

Color Handling 205 
The color line 205 
Applying fill & line colors by drag & drop 207 
Editing an object’s color 208 
The Color Editor (simple) 209 
The Color Editor in detail 210 
Specifying colors in the Color Editor 212 
The color models 212 
Colors on the screen and on the printer 213 
Local colors and Theme colors 213 
Creating your own color schemes 214 
Creating new named colors 215 
Replacing colors 216 
Editing named colors 217 
Normal colors, Tints, Shades and Linked colors 220 
Creating a Tint, Shade or Linked color 221 
Importing colors and palettes 222 
The Color Gallery 223 

Text Handling 225 
Introduction 225 
Terminology 226 
The Text Tool 227 



 

 6 Contents 
  

 

 

The Font Menu 229 
Google fonts 231 
Symbols 233 
Font replacement 236 
Simple text 236 
Text in a column 236 
Text areas 237 
Text along a curve 242 
Text inside shapes 244 
Editing text 246 
Spell checker 248 
Auto correction 249 
Hyphenation 250 
Find & Replace 252 
Smart Fields 253 
Synchronising text across multiple text objects 256 
Tabs, Margins and Indents 256 
Repelling text objects 259 
Anchored Graphics 262 
Embedding Graphics 265 
Bulleted and Numbered lists 268 
Text Styles 273 
Applying text attributes 281 
Copying text appearances 289 
Copying/Pasting formatted text (RTF) 290 
Seeing fonts in use 290 
Changing text into editable shapes 290 
The Fonts Gallery 291 
Fonts and PDF 293 
Document Font embedding 293 

Fills 295 
Introduction 295 
The Fill Tool 296 
Flat fills 298 
Linear fills 299 
Circular fills 300 
Elliptical fills 300 
Conical fills 300 
Diamond fills 301 
Three-color fills 301 
Four-color fills 301 
Bitmap fills 301 
Fractal fills 304 
Multi-stage color graduations 305 
The Fill Gallery 306 



 

Contents 7  
 
 

 

Transparency 309 
Introduction 309 
Applying flat transparency 310 
Applying graduated transparency 310 
Multi-stage graduated transparency 310 
Enhance 311 
Profile 312 
Bitmaps 312 
Handle/resolution 313 
Applying transparency to several objects 313 
Opacity Masks 314 
Transparency types 317 

Shadows 320 
The Shadow Tool 320 
Applying a shadow 320 
Changing the shadow color or fill effect 323 
Converting shadows to shapes 323 
Removing a shadow 323 
Applying a shadow to several objects 324 
Selecting objects using the Shadow Tool 324 
Copying shadows onto other objects 324 

Bevels 325 
The Bevel Tool 325 
Applying a bevel 325 
Applying a bevel to several objects 325 
Modifying a bevel 326 
Removing a bevel 328 

Contours 330 
The Contour Tool 330 
Contouring objects 330 
Converting contours to shapes 333 
Removing a contour 334 

The Mold Tool 335 
The Mold tool 335 
Perspective 335 
Enveloping 337 
Editing mold shapes 338 

Photo Regions and Masks 339 
Masks vs Photo Regions 339 
Creating Regions and Masks 339 



 

 8 Contents 
  

 

 

Soft Masks 340 
The Photo Region and Mask tools 340 
Operations That Use A Mask 341 
Operations That Use Photo Regions 342 
Advanced 344 

Blends 346 
Blends 346 
Using the Blend Tool 347 
Removing blends 352 

Photo Handling 354 
Non-destructive photo editing 354 
Photo Objects 354 
Photo Groups 354 
Photo Grids, Panels and Frames 355 
Importing Photos 360 
Photo resolution 363 
Zero-memory Copies 364 
The Bitmap Gallery 364 
Embedded JPEG files 367 
Blending & Merging photos 368 
An Example Using a Photo Region 369 
Photo display quality 371 
Saving & Exporting Photos 372 
Photo Edit Attributes 373 
Editing the outline of Photos 374 
Cropping photos 375 
Magnetic Lasso 376 
Screenshots 377 
Coloring photos 379 
Photo Filter Presets 380 
Resize, rotate and position a photo within its frame 382 
Horizon Straighten 384 
Integration with external Photo Editors 386 
Viewing a scaled photo at its full size 387 
Making a photo its full size 387 
Optimizing Photos and Bitmaps 387 
Converting objects or drawings to bitmaps 390 
Photo Documents 391 
Editing Photo Files 392 
Tracer 393 
Opacity Masks 396 

The Photo Tools 397 
Common photo functions 397 



 

Contents 9  
 
 

 

Using the Photo Tools 398 
Enhance Tool 398 
Clip Tool 407 
Photo Clone Tool 410 
Photo Heal tool 412 
Effect Painter Tool 413 
The Red Eye Tool 415 
Live Effects 417 
Content Aware Photo Resize 421 
The Brightness Levels Dialog 425 
Panorama Stitching 432 
Perspective Correction Tool 434 
EXIF Tool 435 
Color palette from photo 435 
Photo Tool Notes 437 

Eraser tool 439 
Using the Eraser Tool 439 
Nib size 439 
Erasing backgrounds 439 
Soft erase 441 
Shape editing 442 
Non-destructive editing 442 

3D Extrude Tool 443 
Introduction 443 
Extruding a shape 443 
Extrude Tool InfoBar 444 
Textures & Photos 447 
Extruding Text 448 
Copying 3D extrude attributes 448 
Putting shadows behind 449 

Web Graphics 450 
Creating Buttons, Banners And Other Web Graphics 450 
Stretchy Objects 451 
Text Panels 452 
Photo Resolution - It's All Automatic! 453 

Working with Templates 454 
Replacing photos 454 
Adjusting a photo in its frame 455 
Editing photos 455 
Changing text 455 
Changing colors 456 
Changing The Page Size of Templates 457 



 

 10 Contents 
  

 

 

Page Size 457 
Adding Pages 458 

Animations 459 
Introduction 459 
Core Principles 461 
Your First Animation 462 
Exporting a Flash File 463 
Exporting animations as AVI 464 
Creating animated GIFs 465 
Animation properties 466 
The Animation Frame Gallery 468 
Photos 470 
Animation Frame Rate and Tween Steps 472 
Cropping, Clipping and Animation Size 473 
Animation Speed 475 
Animation smoothness 476 
Rotation 476 
The Name Gallery 478 
Groups 479 
What Xara Photo & Graphic Designer features does Flash support? 480 
Color Transforms—Animating Color Changes 482 
Transparency 482 
URLs in Flash 483 
Advanced Flash Commands 483 
Xara Photo & Graphic Designer Flash Animation Summary 485 

Printing 487 
Show print borders 487 
Selecting and setting up a printer 487 
The print dialog box 488 
Print Options: Output tab  490 
Print Options: Print Layout tab 492 
Imagesetting 494 

Importing and Exporting 505 
General notes on exporting and importing 505 
Import and Export Supported File Formats 506 
Importing files 508 
Exporting files 512 
PDF Export 517 
JPEG, PNG, GIF and BMP export dialog overview 534 
Other bitmaps Export dialog box 540 

Customizing Photo & Graphic Designer 542 
Changing the blank template document 542 



 

Contents 11  
 
 

 

Options in the Utilities menu 542 
General tab 543 
Grid and Ruler tab 547 
Internet tab 548 
Mouse tab 549 
Page Size tab 551 
Backups Tab 553 
Effects & Plug-ins tab 553 
Photo Editing 554 
Scaling tab 555 
Tune-ups tab 556 
Units tab 558 
View tab 559 
Control bars 561 
Gallery docking and undocking 564 
Restoring the default control bars/galleries 564 

Menus and Keyboard Shortcuts 565 
Introduction 565 
File menu 565 
Edit menu 568 
Arrange menu 570 
Insert menu 574 
Utilities menu 575 
Share Menu 577 
Window menu 577 
Help menu 580 
Key shortcuts 582 

Integrated key shortcut utility 587 

Command categories 587 
Commands 587 
Key press 588 
Clashes 588 
Standard keys / Classic keys 589 
Save 589 
Load 589 
Cancel 589 
OK 589 
Example 590 
Temporary key shortcuts 590 

More about Xara Group 592 
About Xara Group Ltd. 592 

Legal 594 



 

 12 Contents 
  

 

 

Copyright 594 
Acknowledgements 594 

Index 597 
  



 

Introduction to Xara Photo & Graphic Designer 13  
 
 

 

Introduction to Xara Photo & Graphic Designer 

Welcome to Xara Photo & Graphic Designer 

Xara Photo & Graphic Designer is a powerful and easy to use graphics and document 

creation tool, able to produce everything from top quality web graphics and websites to 

highly detailed illustrations and multi-page documents for print and PDF output. 

If you're working with photos, then Photo & Graphic Designer can handle everything from 

a simple one-click auto-enhance of your photo to impressive digital photo compositions. 

If you're creating a website, then Photo & Graphic Designer can help you produce 

everything you need, from simple buttons and landing pages to complete websites. If 

your task includes drawing then this is a great tool for everything from simple logos to 

cartoons and astonishingly detailed illustrations. And since Photo & Graphic Designer is 

equally at home with drawing, photos and text it is the perfect solution for design work 

from cards and invitations to posters, adverts and multi-page brochures. 

Photo & Graphic Designer terminology 

This section describes some of the terminology used in Photo & Graphic Designer. 

Document 

You can think of a document in Photo & Graphic Designer as you would a conventional 

sheet of paper. Like a sheet of paper, you can draw lines and curves on it, place objects 

like shapes, clipart and photos and write and erase text. You can save the document for 

later use, or print it, or export it for the web, or for a variety of other uses.  

Page 

This is the white area in the document. You can place objects on the page margin, on the 

page, or overlapping both. However, only objects on the page are printed. A document 

can contain one or several single pages or double page spreads. A double page is like 

two separate sheets of paper placed next to each other. 

Lines, shapes, and objects 

 

These are all lines 

A line can be straight, curved or a mixture 

of both. A line must have a start and an 

end, thus it is always open. You can apply 

a thickness and color to a line. 
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These are all shapes 

A shape is a solid or closed object. The 

difference between a line and a shape is 

that a shape has no start or end. Because 

a shape is a closed object, you can fill it 

with a color or leave it empty with no color. 

You can apply a thickness and color to the 

line around the shape. 

 

These are all objects 

Object is a general term. This manual uses 

it to describe lines, shapes, bitmaps, 

photos and text.  

Many operations in Photo & Graphic Designer apply equally to a single object or a 

collection or group of objects. "Object" can refer both to one object and to several 

objects. 

In postscript terminology, a shape is a closed path. Photo & Graphic Designer sometimes 

uses "shape" as shorthand for "line or shape". 

Bars 

There are three types of bars: the MAIN TOOLBAR, the INFOBAR, and then various other 

button bars which are sometimes just referred to as control bars, e.g. the GALLERY button 

bar. 

Attributes 

The various characteristics that describe the look of objects on the page, such as color, 

line width, fill style etc are all called ATTRIBUTES of the object. 

The Attributes of objects can be copied and pasted between different objects using the 

Paste Attributes (on page 153) menu command. See Current Attributes (on page 24) for 

more information. 

Windows terminology 

We use many of the usual Windows conventions. For more information on using 

Windows, please refer to Windows help and support. 

The keyboard 

Keys are shown like this: "Ctrl" (this means the control key). 

Combinations of keys are shown as "Ctrl + A". This means: 

1. Press and hold down "Ctrl". 

2. Then press "A" (with "Ctrl" held down). 
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3. Then release both keys. 

The "Alt" keys 

Most keyboards have two "Alt" keys. There is a key labeled "Alt" towards the left of the 

keyboard, and a key labeled "Alt Gr" to the right. "Alt Gr" is interpreted by Windows as 

"Ctrl + Alt"; Photo & Graphic Designer cannot override this, so many "Alt" operations in 

Photo & Graphic Designer only work with the "Alt" key, and not "Alt Gr". 

Note: The "Alt Gr" key is region-specific and as a rule can only be found on most western 

European keyboards, apart from laptop keyboards. 

The "Shift" keys 

The "Shift" keys are at either side of your keyboard (labeled with a  sign) . Unlike the 

"Alt" keys, it does not matter which one you use when using keyboard shortcuts. 

The "Enter" keys 

When this manual refers to the "" key, it means the "Enter" (or "Return") key on the 

main keyboard, and not the "Enter" key on the numeric keypad. 

The cursor 

The text cursor (sometimes known as a carat) is shown a vertical red line in a line of text. 

Its purpose is to indicate your position within the text. 

Mouse actions 

Click: Press and release the mouse button. 

Double click: Click twice rapidly. 

Drag: Hold down the mouse button while moving the mouse. 

Drag & drop: Move the mouse over an item, then drag the item to the required place on 

the document and release the mouse to drop it in place. 

Ctrl + click, and Shift + click: hold down "Ctrl", or "Shift" as you click. 

The chapter "Customizing Photo & Graphic Designer (on page 542)" has information on 

configuring the mouse buttons. 

Pointer 

This is the on-screen pointer (mouse pointer) that follows mouse movements. 

Menus 

When you are asked to select a menu it will be described like this: 

Choose "WINDOW -> BARS -> RULERS" 
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This indicates that you should click the "Window" menu, go down to "Bars", and then 

click "Rulers". 

The clipboard 

This is a temporary store and is used like a physical clipboard. You can cut or copy part 

or all of your drawing onto the clipboard. You can then transfer the clipboard contents to 

another part of the same document or to another document or application. 

The clipboard can only hold one item or one set of items at a time. Placing something on 

it overwrites any existing contents. Objects remain on the clipboard until deleted or 

overwritten by either Photo & Graphic Designer or another application. This lets you 

paste the clipboard contents again and again if you wish. 
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Getting Help 

Support 

If you can’t find the answer in this guide, we highly recommend viewing the  Designer 

movie tutorials http://www.xara.com/movies/. It is the ideal way to get to know Xara 

Photo & Graphic Designer and get an overview of its features, allowing you to make the 

most of the program.  

Here are some other sources of information and help from Xara and the Xara community 

that may be of use: 

 Program help - Choose "Xara Photo & Graphic Designer Help" from the "Help" menu 

to open Xara Photo & Graphic Designer Help (containing hundreds of pages of 

information).  

 Status bar - Try reading the text on the status bar at the bottom of the main Xara 

Photo & Graphic Designer window. It always describes what actions are currently 

possible and what they will do (even during drags), and helps you learn to use the 

Xara Photo & Graphic Designer tools. It also gives details of what buttons and controls 

do as you move the pointer over them. See Status Bar (on page 49) for more details.  

 Tooltips - If you hold the mouse pointer over a button or control for a short while, then 

a short  message appears telling you what it does.  

 Menus - If you want to know what a menu item does, highlight it and press "F1". 

 Dialog boxes - If you want to know what a dialog box does or how to use it, click HELP.  

 Movies - Use the menu option "HELP" > "MOVIES" or click here 

http://www.xara.com/movies/ to view a list of available movies.  

 The TalkGraphics forums - Post your question in the popular, dedicated Xara forums 

at TalkGraphics.com (www.talkgraphics.com), where you can ask other Xara Photo & 

Graphic Designer users for advice or suggestions – available 24x7. You can share tips 

and ideas, ask questions or offer solutions to other users. 

MAGIX Support 

Dear MAGIX customer, 

Our aim is to provide convenient, fast and solution-focused support at all times. To this 

end, we offer a wide range of services: 

 Unlimited web support: 

As a registered MAGIX customer, you have unlimited access to web support offered 

via the convenient MAGIX service portal on http://support.magix.net, including an 

intelligent help assistant, high-quality FAQs, patches and user reports that are 

constantly updated. 

The only requirement is that you have registered your product. 

 The online community - on-the-spot support and a platform for exchange: 

MAGIX customers have free and unlimited access to the online community at 

www.magix.info, which includes approx. 120,000 members and offers the opportunity 

to ask members questions concerning MAGIX products as well as use the search 

function to search for specific topics or answers. In addition to questions & answers, 

the knowledge pool includes a glossary, video tutorials and a discussion forum. The 

http://www.xara.com/movies/
http://www.xara.com/movies/
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multiple experts, found round-the-clock on www.magix.info guarantee quick answers, 

which sometimes come within minutes of a question being posted.  

 Email support for MAGIX products: 

For every new MAGIX product you will receive, as of date purchase, 12 months of 

email based customer service. 

 

Please note: To be able to use the Premium email support and free product email 

support via the Internet, you have to register your MAGIX product using the serial 

number provided. This can be found in your purchase confirmation email, or on the DVD 

case or box. 

 Additional telephone service: 

Besides the large number of free customer service offers, we also offer a fee-based 

telephone customer service available to customers that have purchased from Magix. 

Here you can find a summary of our technical support telephone numbers: 

http://support.magix.net  

Mail (Europe): MAGIX Development Support, P.O. Box 20 09 14, 01194 Dresden, 

Germany 

Mail (North America): MAGIX Customer Service, 1105 Terminal Way #202, Reno, NV 

89502, USA 

Please make sure you have the following information at hand: 

 Program version 

 Configuration details (operating system, processor, memory, hard drive, etc.), sound 

card configuration (type, driver) 

 Information regarding other audio software installed 

MAGIX Sales Department 

You can reach the MAGIX Sales Department workdays for help with the following 

questions and problems: 

 Orders 

 Product consulting (pre-purchase) 

 Upgrade requests 

 Returns 

Europe 

Monday - Friday, 09:00-16:00 GMT 

U.K.: 0203 3189218  

Denmark: 699 18149  

Sweden: 0852500858  

Finland: 09 31581630 

Norway: 0210 30665 



 

Getting Help 19  
 
 

 

North America 

9 am to 4 pm EST Mon-Fri 

Phone: 1-305-722-5810  

Document info 

"FILE > DOCUMENT INFO" displays information about the selected document such as its 

size and any fonts or plug-ins used. This is a good way to find out if you are missing a 

required font or plug-in that could prevent the document from displaying correctly. 

Anything you type into the comment field is stored as part of the file. This comment is 

displayed whenever you display the document info dialog box. 

About Xara Photo & Graphic Designer 

Choose "HELP" > "ABOUT XARA PHOTO & GRAPHIC DESIGNER". This displays general 

information about the program. If you contact the support, you may be asked for this 

information. 

Tooltips 

 

When you move over a button, the tooltip tells you the function 

of the button. 
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Getting Started 

This section gives an overview of the main functionality of Photo & Graphic Designer. 

Later sections go into more detail about each tool. 

Program Layout 
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Info Bar - changes with each tool 

 
Zoom 

 
Designs Gallery 

 
Page & Layer Gallery 

 
Selector Tool 

 
Mask Tools 

 
Photo Tools 

 
Eraser Tool 

 
Drawing Tools 

 
Text Tool 

 
Shadow Tool 

 
Color Line 

 
Tabs for all open documents - icon identifies document type. 

 
Web Toolbar 

Note: By default Photo & Graphic Designer opens a new document showing just one 

page. To view all the pages in your document, right click a page and choose MULTIPLE 

PAGE VIEW. You can now scroll the Photo & Graphic Designer window up and down to 

view all the pages in the document. 

Note: All Photo & Graphic Designer InfoBars now have improved text rendering for 

easier viewing, if you have ClearType text enabled in your Windows Control Panel. 

Zooming / Scrolling / Pushing your page 

These common operations are made very easy: 

 To Zoom in or out, hold Ctrl and use the mouse-wheel 

 To push the page, press your mouse-wheel and push (yes it's a button as well) 

 To scroll use the mouse-wheel (or the scroll bars of course) 



 

 22 Getting Started 
  

 

 

 

Web documents are 

displayed in single page 

mode by default and print 

documents in multi-page 

view mode. Switch 

between display modes by 

right clicking on the page 

or pasteboard and 

selecting or deselecting 

MULTIPLE PAGE VIEW from 

the drop-down menu. An 

example of multiple page 

view is shown to the left. 

You can drag and drop 

items between pages. 

When you make 

document-wide Theme 

color changes, you can 

see how the changes 

affect all pages.   

 

The current page is marked with 4 corner brackets.  

 

In this example you can see some items have been placed on the pasteboard area 

beside the pages. When exporting to most export formats, off-page objects are not 

included. The pasteboard area is useful as a place to keep temporary or working 

graphics, photos or other objects.  

Flyout Bars 

Some tools on the main toolbar are grouped together under a single icon. These icons 

have a small triangle indicator in the bottom right corner and when you move the mouse 

pointer over one of these icons a flyout bar appears. The bar holds the other tool icons 

that are in this group. Simply move the mouse pointer over each one to see a tooltip, and 

click to select the tool you want.  

If you select a modal tool from a flyout bar, that tool becomes the primary tool for that 

group. So you’ll then see its icon highlighted on the main toolbar.  
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There are also some flyout bars on the toolbar at the top of the window. Again these are 

used to group together closely related operations under a single icon. This makes them 

conveniently accessible while not taking up too much space on the bar. 

See Customizing (on page 542) for more information on flyout bars. 

Drawing Tools 

 

 

Photo & Graphic Designer provides all the graphics tools you need to create just about 

any graphical object on your page, as well as a range of pre-designed graphical 

elements in the Online Content Catalog and the Local Designs Gallery. There are several 

basic drawing tools that let you create rectangles, ellipses, regular polygons stars or any 

shape you like.  

Photo & Graphic Designer provides vector drawing tools, which means you can resize, 

edit the outline shape and re-color with no loss of quality. You can zoom in to see almost 

infinite detail, and all edits can be undone. For details on drawing rectangles/squares, 

circles/ellipses and other shapes, see Drawing Lines and Shapes (on page 89) and 

Shape Handling (on page 169). 

 

The SHAPE TOOL  allows you to create detailed vector based shapes, and also 

to edit the outline of any shape. 

Refer to the section THE SHAPE TOOL to learn how to use this very powerful tool. 

 

The STRAIGHT LINE & ARROW TOOL adds arrow heads and tails to any type of 

line as well as drawing single lines. See the STRAIGHT LINE AND ARROW TOOL 

for more information. 

 

The FREEHAND & BRUSH TOOL allows you to draw freehand as you would with 

a pencil as well as creating brush strokes. See the FREEHAND & BRUSH TOOL 

(ON PAGE 89) for more information. 

 

The SHAPE PAINTER TOOL allows you to ‘paint’ with a ‘nib’ to extend an existing 

shape or draw a new one. The strokes you draw with this tool are merged on 

the fly to form filled shapes. See the SHAPE PAINTER TOOL (on page 94) for 

more information. 
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Current attributes 

An ‘attribute’ is some characteristic of an object which you can modify in Xara Photo & 

Graphic Designer. For example a shape’s attributes include its color, its outline width and 

its outline color.  

You can change the attributes of an object after you’ve drawn it, by selecting it and then 

changing its fill color, line width, or any of its other attributes. But Xara Photo & Graphic 

Designer also keeps track of the ‘current’ attributes, which are the attributes that get 

applied to newly drawn objects as they are created. 

Setting current attributes manually 

If, for example, you want the next rectangle you draw to be red, make sure you have 

nothing selected (press "Esc" or click an empty part of the page) and then click red on 

the color line. You’ve now set the current fill color attribute to red. Now when you draw a 

new shape, it will be filled red. You can set other current attributes the same way – by 

first making sure nothing is selected before changing the attribute’s value.  

Setting current attributes automatically 

By default, Xara Photo & Graphic Designer automatically updates the current attributes 

for you, to match the object you last drew, or last selected. So for example if you draw a 

rectangle and then make it green, the next shape you draw will also be green. If you 

have a blue rectangle in your design and you wish to draw another one just like it, first 

select the blue rectangle (this makes its attributes current) and then the next shape you 

draw will also be blue. So by simply clicking an object, you set the current attributes to 

match that object. 

This allows you to use existing objects as a ‘palette’ of available styles. Click an object to 

select it, then draw new objects in that style. 

You can turn off this behavior in the GENERAL TAB (on page 543) of the "UTILITIES" > 

"OPTIONS" dialog. Select the GIVE NEW OBJECTS MOST RECENT ATTRIBUTES (GNOMRA) 

checkbox. Now the current attributes will only change when you set them manually, as 

described above. 

Attribute groups 

Many designs consist of a combination of closed filled shapes and open shapes (lines 

where the start and end points are not coincident). Normally it wouldn’t be desirable to 

have the attributes of an open shape used for a closed shape, nor vice-versa. Therefore 

the attributes for open and closed shapes are kept separate – these are known as 

attribute groups. Setting the values of one group does not affect the other group. So for 

example, selecting a filled rectangle with no outline will not change the current line width 

to zero for open shapes. 

For the same reasons, text attributes make up a third attribute group. The text attribute 

group is only set when you select text objects, or when you set the attributes manually 

while in the text tool. 
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Exempt attributes 

Some attributes do not get set as current automatically even when ‘Give new objects 

most recent attributes’ is on. This is because some attributes can cause problems if they 

become current.  

For example if you applied a 10 pixel feather to a large object (to blur the edges) and 

then drew a new 10 pixel sized shape, that new shape would be invisible if the feather 

attribute was copied to it, due to the amount of feathering!  

Other attributes can adversely affect the way designs export, or significantly increase the 

time taken to render the design and so should not be applied unnecessarily. 

Examples of attributes which are copied automatically: 

 Fill colors, fill styles, line width, line color, line style, line join style, line endcap style, 

arrow heads/tails, text font, text font size, text margins. 

Examples of attributes which are not copied automatically: 

 Feather, transparency, shadow, bevel, contour, 3D extrude, live effects. 

Resetting current attributes 

You can reset all current attribute groups instantly by pressing "Esc" when you have no 

objects selected. If you have objects selected, pressing "Esc" clears the selection, so just 

press "Esc" again to reset the current attributes back to their default values. 

Fill Tool 

 

You can easily put a graduated color fill onto a shape using this tool 

(and a lot more besides). Select the tool and just drag across your 

object. 

The fill arrow can be adjusted by dragging the ends to alter the direction, angle and 

extent of the graduation.  

  

Rounded rectangle with a graduated fill. 
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Transparency Tool 

 

You can adjust the transparency of any graphic or photo to make it see-through. More 

than this, Photo & Graphic Designer supports graduated transparency. It works very like 

the graduated color fill. In the Transparency tool just drag across your shape and you can 

see the transparency fades.  You can adjust the degree of transparency of each end of 

the fill arrow, by clicking on either end of the arrow, and adjusting the Transparency 

slider. See Transparency for more information. 

Feather 

This is a graphical term for blending the edges of objects. Photo & Graphic Designer 

provides a feather control that enables any object, graphics, text or photo to be feathered 

- giving it a blurred edge that blends with the background. The Feather control is not a 

tool on the left, but one of the controls on the top bar. See Feathering (on page 138) for 

more information. 

 

Shadow Tool 

A very popular graphics effect is to create a soft drop-shadow under a graphic or some 

text. This serves to lift the object away from the background.  

 

The SHADOW TOOL lets you add a soft shadow to any object, text, graphics or 

photo. Select the SHADOW TOOL and just drag on the object. You can adjust the 

shadow blur and transparency using InfoBar controls. 

 

Some text with a soft shadow.  

To adjust the position of an existing shadow, go into the SHADOW TOOL and drag on the 

shadow. 

Example Graphics 
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This button combines many of the features described above - it's drawn by combining 

just a few feathered shapes, and using graduated transparency (the white reflection 

effect). The text has a slight soft shadow and the button has a glow shadow. The whole 

thing is grouped.  (You do not need to draw this button as it's provided in the Button 

category of the ONLINE CONTENT CATALOG). 

The huge benefit of vector graphics, compared to 'bitmap' graphics created in pixel 

editing software, is that you can re-color, edit, rotate, and resize the button with no loss of 

quality. Make it huge and it remains pin sharp: 

 

On top of that you can re-color easily, Just select, click a color and choose the color you 

want to replace from the list shown in the Color Replacement dialog that appears. And it 

will even stretch as required - everything in Photo & Graphic Designer remains non-

destructive (which means you can always edit it, with no loss of quality). 

 

Something that would take skill and time to produce using alternative graphics software, 

is trivially easy in Photo & Graphic Designer. 

Object Based Design 

All the types of elements are collectively referred to as objects. 

One of the unique benefits of Photo & Graphic Designer is that you have complete 

freedom to place any object anywhere on the page, and your document or website will 

faithfully reproduce this. 

 

The SELECTOR TOOL can be used to select any object on the page, and to move 

(just drag it), resize and rotate the objects. 

You can adjust the stacking order (that is whether an object appears in front or behind 

others on the page) using the ARRANGE menu options or right click and choose ARRANGE. 

With the SELECTOR TOOL you can resize objects by dragging on the corner resize 

handles. You can rotate any object by dragging just inside the corner selection handles. 

 

Use the Text Tool to edit text and add new text. To add some text to your 

document, select the TEXT TOOL and click anywhere on the page and start 
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typing.  

You can also create text columns, by clicking and dragging horizontally in the Text Tool, 

or text boxes by dragging diagonally. See the Text section below for more details and the 

Chapter Text Handling (on page 225) for a complete reference of text functions of Xara 

Photo & Graphic Designer 

 

 

You can use the drawing tools to create rectangles, rounded 

rectangles, circles and ellipses, and just about any shape you like 

using the SHAPE TOOL. See the Drawing tools (on page 89) section for 

more detail.  

 

 

Stacking Order 

All objects on the page are placed one on top of another. The most recently drawn or 

created object is always on top, that is, in front of any others. You can adjust the stacking 

position by right clicking and choosing ARRANGE or using the ARRANGE menu options. 

For example, when you draw a new rectangle it always appears to cover all the objects 

behind it. By right clicking and choosing ARRANGE or pressing "Ctrl + B" (or the menu 

"ARRANGE" > "PUT TO BACK") the object is moved behind everything else. Similarly "Ctrl + 

F" brings any selected object to the top, that is, in front of everything else. 

 

These objects are stacked over each other. 

All objects are collected into named layers, and each layer can be turned on or off to 

show or hide everything on that layer.  

The Selector Tool 

 

This tool is a general purpose tool that allows you to select, move, resize and 

rotate all objects on your page. 
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You can do all these things by just dragging on the objects on the page, or on the 

selection handles around the object, or you can enter precise numeric values. The 

selected object is shown with  8 handles around the outside, and the status line at the 

bottom of the screen also tells you what is selected. 

 

Drag on any corner handle to resize an object. Drag just inside the corner handles to rotate.  

Nudging Objects 

The arrow keys can be used to nudge the selected object, one pixel at a time. If you hold 

"Shift", it nudges objects 10 pixels at a time. 

Rotating Objects 

There are two ways to rotate an object. Either click on the object a second time, so the 

selection handles change to show rotation handles, which you can then drag on to rotate 

the object. Or, when it's showing the square selection handles, move the mouse pointer 

just inside the corner handles until you see the mouse pointer change to a rotation 

indicator - you can then also drag to rotate the selected object. 

InfoBar 

When an object is selected, the InfoBar - just above your document - shows all the 

relevant controls for the current tool.   

Important: This bar changes depending on which tool is selected.  

This is the InfoBar in the SELECTOR TOOL: 

 

The InfoBar, just above your document, shows controls for the selected tool.  

You can enter numeric values into any field; e.g. to reduce the size of an object by 20% 

you can enter 80% into the W field (which is a % size). The little padlock selects whether 

both the width and height change together. 
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Copying Objects 

You can use the usual "EDIT" > "COPY" ("Ctrl + C") and "EDIT" > "PASTE" ("Ctrl + V") 

options or right click an object and choose COPY, but a really quick way to copy any item 

is drag on it with the right mouse button. 

You can also copy and paste a page anywhere in your document from the current 

document or another document – see Copying and pasting (on page 60) pages. 

Right-click context menus 

When you right-click any object in the Xara Photo & Graphic Designer workspace, a 

drop-down context menu lists useful operations that are relevant to the object clicked on. 

For example, if you right-click a rectangle you've drawn previously, the drop-down menu 

allows you to perform actions only relevant to a rectangle. 

If you right-click a photo, however, some of the menu options that appear apply only to 

photos, while others are similar to the actions you can perform on a rectangle. The 

object-specific operations are listed towards the top of the right-click menu's list, e.g., in 

the case of a rectangle the first three actions above apply only to rectangles. 

You can also right click both the page and pasteboard to see a menu of page and 

pasteboard  background-related operations you can apply.  

If you select more than one object and right-click, the menu lists actions specific to 

multiple objects, such as group, align and combine, as well as the common operations 

such as cut, copy and delete. Similarly if you right-click objects that you have previously 

grouped, actions specific to a group are displayed.  

It's recommended that you right-click any object or multiple objects in the workspace to 

access the context menu specific to those objects. Once you've done this a few times 

you will know which actions you can quickly perform with right-click menus.  

Using Templates & Clipart 

 
Open the LOCAL DESIGNS GALLERY by clicking the Local Designs Gallery tab in 

the Galleries bar or the ONLINE CONTENT CATALOG using "FILE" > "NEW FROM 

CONTENT CATALOG"). 

These show folders containing collections of template designs, Smart Shapes, clipart and 

web widgets. Some templates are intended for printing (photo albums, calendars, 

newsletters, etc.), others for web use and most of the graphical clipart designs can be 

used in any type of document.  

The Online Content Catalog 

The Online Content Catalog is essentially a "cloud" companion to the LOCAL DESIGNS 

GALLERY (on page 32). That is to say, all the content is stored online and as such 

requires you to be connected to the internet before you can import items to the Local 

Designs Gallery.  The catalog contains Photo & Graphic Designer's full library of Stock 
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photos, SmartShapes, symbols, design templates, widgets and vector art, and provides 

an easy and intuitive way to search all of the content.  

When you import a piece of content from the Content Catalog it is downloaded to your 

PC and remains available when you are offline as part of the Local Designs gallery. 

To open the Content Catalog 

 Click "FILE" > "NEW FROM CONTENT CATALOG" (Shift+Ctrl+Alt+K) 

 Click "INSERT" > "FROM CONTENT CATALOG"   (Shift+Alt+I)  

 

The Online Content Catalog 

The catalog is a resizable window - drag the edges or lower right corner to resize. You 

can enter a keyword to search either all or individual categories, or else traverse the 

content categories on the left. A small pop-up preview appears as you traverse the 

categories - click to select and that category is expanded and shown on the right side. 

For categories that have many items there is a page control at the top right, allowing you 

to flick to the next and previous pages of content. 

Import an item either with a double click or by clicking the IMPORT button that appears as 

you mouse-over the item. After the import, the catalog closes. If you want the catalog to 

remain open after an import hold down the Shift key as you click. 

An enhanced Online Content Catalog is included free for one year as part of our new 

Update Service. It now offers:- 

 Regular updates to the templates as part of the Update Service 

 Full keyword search of the entire catalog 

 A new more logical structure to the content offering a better work flow 
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When using the free trial version, items shown in blue in the left content list are free to 

use during the trial period. All items shown in grey are available instantly for free once 

you've purchased and unlocked the program. 

Stock Photos 

One of the categories you will see on the left is STOCK PHOTOS. These are provided by an 

external company called Pixabay and so the first time you import one of these photos 

you will be asked to read and accept Pixabay’s Terms & Conditions. But you only need to 

do this once on each computer you use, then you can import as many photos as you like. 

The photos are released under a Creative Commons CC0 license and are totally royalty 

free. You can use the images for personal or commercial use with almost no limitation.  

There are thousands of photos available - just select STOCK PHOTOS on the left and then 

enter keywords in the search field at the top to find them. Alternatively you can replace 

an existing photo by right-clicking it in your document, and then choosing  "REPLACE 

PHOTO" > "WITH STOCK PHOTO" from the context menu. 

When you import a stock photo into a print document you get the photo’s full resolution 

into your design. The resolution of photos varies, but most are much higher than HD 

resolution. When you import into a web document, as when importing local photos, the 

resolution is still limited to HD because it’s rare to need any higher resolution than this for 

a website.  

Stock Illustrations 

In addition to the STOCK PHOTOS, there is also a category of vector graphic STOCK 

ILLUSTRATIONS.  All the images have keywords so you can easily search for the graphic 

you want. Because the original vector files vary enormously in size, graphics larger than 

around 300px are scaled down. Also un-grouped images are placed in a group for ease 

of manipulation. Because this is vector clipart, it’s re-sizable to any size without loss of 

quality. 

The Local Designs Gallery 

This gallery is a local offline repository of content imported from the ONLINE CONTENT 

CATALOG. As the name implies, this now shows only content that you have present 

locally on your device, or was downloaded from the CONTENT CATALOG. This makes it 

easier to find and access designs you use regularly. 

To open this gallery: 

 Click the LOCAL DESIGNS GALLERY tab on the Galleries bar. 



 

Getting Started 33  
 
 

 

 Or choose "UTILITIES" > "GALLERIES" > "DESIGNS GALLERY". 

 

 

The top level folders are divided into four main categories. 

 First Look  

 Components 

 Websites 

 Print 

 Presentations 

Add more content by browsing through the folders and clicking on + MORE ONLINE... This 

will open the relevant folder category in the ONLINE CONTENT CATALOG for you to browse 

and import content to the LOCAL DESIGNS GALLERY.  The folder structure in the LOCAL 

DESIGNS GALLERY mirrors that of the ONLINE CONTENT CATALOG and each folder in the 

gallery has a link allowing you to jump straight into the corresponding folder in the 

CONTENT CATALOG, so you can easily view what other content is available for download 

into that folder. Whenever you open or import a design file from the Catalog, that file then 
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appears in the Gallery and so you can use it even when offline. The freshly imported item 

is also opened in your current document as well. 

You can download a whole category, so it's available offline, by right clicking on the 

category name in the Gallery, and selecting the DOWNLOAD ALL option. The Gallery tab 

informs you of the update status. 

To open a template or piece of content from the Gallery as a new document double-click 

on it. To import it into your current open document, drag it and drop it into your design. 

Page templates are added as new pages to your current document when you do this. 

Other templates and widgets are dropped onto your current page. 

See Document Handling (on page 46) for more information on using galleries generally. 

Theme Colors 

Most templates use a small set of theme colors, and various shades of those theme 

colors (also referred to as 'Named colors').  Most themes provide a selection of 

alternative color schemes in the Designs Gallery along with all the pages, graphics and 

other items that make up the theme. You can re-color your design instantly by simply 

dragging and dropping one of these color schemes onto your page! 

If you don’t like the provided color schemes you can edit the named colors individually 

yourself almost as  'Named Colors' appear on the left side of the Color Line along the 

bottom of the window easily. 
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Current Outline and Fill Color 

 
Color Editor 

 
Eye dropper color picker 

 
‘No color’ patch. 

 
Named ‘Theme’ Colors and Linked Colors 

 
Fixed palette of standard colors 

 
Hold pointer over a color to see its name 

 
Status line. Shows what is selected, and provides hints 

Simply right-click on any of the Named Colors and select the Edit option (if you hover the 

mouse pointer over the color you will see a tooltip name). 

 

 
When editing a color you can drag the eye dropper to pick colors off screen, even 

from other open windows 

 
Select the color to edit: Fill color/Line color of the selected object or any of the 

named theme colors 

 
Click the label icon to create a Named Color 

 
Click to show extended color controls 

 
Previous Color 

 
Actual color 

 
Drag here to select any shade of the selected hue 

 
Drag here to select any hue 

The Color Editor provides easy way of choosing any color. Click the Extended Controls 

to enter RGB values. 

Note that when you change a Theme Color in this way, all the related shades used 

throughout the document will change as well. 
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Coloring Shapes 

You can fill any drawn shape with a color, either by dragging the color from the Color 

Line and dropping it on to the shape, or by first selecting the object and then clicking on 

the Color Line.  

 Alternatively right click the shape and choose FILL COLOR or click the small Color 

Editor icon (or press "Ctrl + E") to display the Color Editor, where you can set any 

color you like. 

You can give drawn objects a graduated color fill using the FILL TOOL (ON PAGE 296). 

Coloring Imported Clipart 

When you import a clipart graphic by dragging from the ONLINE CONTENT CATALOG, using 

the "FILE" > "IMPORT" option, or dragging a .web or .xar file onto your page, you will 

usually be asked whether you want to match the colors. If you select DON'T MATCH, then 

any named colors used in this graphic will be added to the Color Line. Clicking on any 

color on the Color Line will give you the option to edit the color. 

You can also change the colors of any multi-colored object by selecting it and clicking a 

color on the color line. A dialog appears showing you the set of colours currently used in 

the object – just click the one you want to change. Or bring up the color editor and the 

color list at the top includes the same set of colors – choose the one you want to edit. 

Coloring Photos 

If you try to color a photo it turns it into a 'contoned' photo. For example, to make any 

photo black and white, right click and choose "CONTONE" > "MAKE BLACK AND WHITE" or 

select it and click on the white color patch on the end of the Color Line. You can set the 

light or dark color to be any two colors, not just white and black - right click, choose 

"CONTONE" > "LIGHT" and click a color in the Color Editor. 

 

You can also use the ENHANCE TOOL to provide a direct and very fast way of adjusting 

the brightness, contrast, color adjustment levels and sharpening of photos, You can also 

adjust the individual colors and tints within a photo as well as the shadows and highlights 

- even for ultra high-resolution images. 

Note: If the photo is inside a group, as many of the photo objects in the templates or 

clipart are, then you will have to select the photo inside (on page 117) the group first. You 

can do this by holding "Ctrl" down when clicking on the object in the SELECTOR TOOL. 

Another way of directly selecting the photo is to click on it in the PHOTO TOOL. 

Page Background Color 

NOTE: This is normally only useful for documents you intend to export as a website. 
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To set the page background color, right click a page, choose CHANGE PAGE BACKGROUND 

and click a color in the COLOR EDITOR. Alternatively you can drag a color from the Color 

Line over the page and drop it on an empty part of the page. 

 
To set a repeating background texture, drag the photo or bitmap onto your 

document. Open the Bitmap Gallery, scroll to the photo you just loaded, click on it 

to select it, and then click the Background button on the gallery. 

 

Creating your own Named Colors 

If you want to use a color many times throughout a document, you can create your own 

named color by clicking the Name label on the top of the Color Editor. This color will now 

appear on the Color Line. 

 

Click the label icon to create a Named Color 

The power of a named color is that when you edit it later (right click the color in the Color 

Line, select EDIT) all objects using this color are instantly changed. 

Linked shades 

You can create colors that are lighter or darker shades of another color, so that when you 

alter the 'parent' color, all the lighter and darker shades change to match the new hue. 

For example a graduated color shade on a button, such as this: 

 

This is a simple rounded rectangle with a graduated color fill 

created with the FILL TOOL. In the FILL TOOL you can click on 

the either end of the arrow to set the color. 
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If you create the main green color as a named color, and then make a lighter or darker 

shade of the color, as a linked shade, when you now edit the named color the shades 

change as well, so you get simple re-coloring of complex shaded objects. 

 

To create a linked shade, open the extra controls in the Color Editor and select the 

'NORMAL COLOR' drop-down menu and choose 'SHADE OF ANOTHER COLOR'. 

 

 
Click this button to reveal the extra controls. 

 
You can now select any light or darker shade of the parent color. The cross marks 

the parent color. 

 
Select SHADE from this drop-down list and then the parent color. 

You can also create a Linked Shade that appears on the Color Line (so you can easily 

apply it to other objects). When you select to create a new Named Color you can choose 

to make this a linked 'Shade of another color'. 
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Photos 

You can replace any photo by dragging and dropping it from your File Explorer onto any 

photo in Photo & Graphic Designer. If you drop it onto the background then it is imported 

and placed where you dropped it. Photos larger than 500 pixels wide will be displayed at 

500 pixels wide, but you can of course change this to be any size in the usual way with 

the Selector Tool.  

There is also the option of importing stock photos from the Online Content Catalog. You 

can either browse the catalog from the File menu. "FILE" > "NEW FROM CONTENT 

CATALOG". Or you can replace a photo by right-clicking it, and then choosing  "REPLACE 

PHOTO" > "WITH STOCK PHOTO" from the context menu. 

 

Drag and drop your photo over any existing picture to replace it. Drop onto the background to 
import as a new photo 

 

When you replace an existing photo, the Photo tool is selected and the 

smartphoto adjustment handles (on page 382) appear on the photo. 
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You can use the adjustment handles to rotate and scale the picture, move it within its 

outline frame, resize the frame and even round its frame edges. 

See Photo Handling and The Photo Tools (on page 397) for more information, including 

replacing multiple photos and importing large photos. 

Importing Large Photos 

When importing high resolution photos (anything above 1920 pixels either wide or high) 

into a web document, Xara Photo & Graphic Designer automatically resizes the photo 

down to HD screen size without asking you if you want to import a lower resolution 

version. For a web document, even at the reduced size, there should be more than 

enough resolution in your photos for high quality results on your website, so it’s rarely 

necessary to import digital camera images at full resolution for web use. 

However, if you are importing a large photo into a print or animation document, Xara 

Photo & Graphic Designer asks you if you want to import a lower resolution version of 

your photos. If your document is to include many photos, you may want to choose this 

reduced resolution option. Otherwise with large photos you may find that your saved 

design file is much bigger than it needs to be (because it contains a copy of each of your 

photos). And memory requirements when editing and exporting your document will be 

higher than necessary.   

The Photo Tool 

The Photo Tool provides a range of ways to enhance and crop any photo. 

 

 

To crop a photo, just drag across the photo while in the ENHANCE PHOTO TOOL. 

You can adjust the crop edges by dragging on the crop handles around the 

outside of the photo.  

 

Or use the CLIP TOOL for more control over crops.  

See the section on Photo Handling (on page 354) for background information on the 

advanced way in which Xara Photo & Graphic Designer handles photos, and the section 

on the Photo tool to find out how to use the Photo tool. 

Photo Resolution 

Photo & Graphic Designer always stores the full resolution image (unless you chose to 

import reduced resolution images when asked during import, as mentioned above). This 

means you can resize or crop your image as required with no loss of quality. 

If you want to size a photo, or any object, to a specific size, just enter the required size 

into the SELECTOR TOOL InfoBar width or height fields. 

When you drop a photo on the page (assuming you're not replacing an existing photo), 

it's sized to be 500 pixels wide. But if you want this to be exactly 200 pixels wide, just 
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enter 200px into the W size field of the SELECTOR TOOL. You can enter it in any unit, e.g., 

entering 2in will make it 2 inches wide. 

Text 

 

You can edit the text by selecting the TEXT TOOL and clicking on the text. 

You have all the usual word processing facilities, and can paste text from the system 

clipboard. Double click will select a word, triple click will select a whole line - which can 

be useful for selecting all the text in a button. As usual the InfoBar provides a wide range 

of controls for this tool. Alternatively you can right click within text and choose ADVANCED 

TEXT PROPERTIES. 

 

See Text Handling (on page 225) for more information on the font menu, creating new 

text objects, bulleted and numbered lists, text repel, anchored objects in text, spell 

checking, auto correction and more. 

Font Size 

The font size field shows the font size in pixels in web documents and in points in print 

documents. You can enter any size in points by entering a value with pt (for point) after it, 

or pix for pixels. 

Creating New Text Objects 

There are three types of text object - a single line of text, a column of text or a 

rectangular text area. To create a simple line of text, select the TEXT TOOL and then you 

can click anywhere on the background and start typing. To create a column click and 

drag horizontally on the background, and then start typing. You can adjust the column 

width at any time. To create a text area, click and drag diagonally. You can adjust the 

width and height of a text area by clicking and dragging on it in the TEXT TOOL. 

Bulleted and numbered lists 

Use the bullet and numbered list buttons on the TEXT TOOL InfoBar to quickly enter 

bulleted or numbered lists. You can right click on a numbered list and choose LIST 

PROPERTIES… from the context menu to change the numbering scheme for your list. You 

can also use any graphic as the bullet or number in your list. See the Text Tool chapter 

(on page 225) for more information. 

Soft Shadows, Color Filled Text, Transparent Text 

You can apply any of these effects using the appropriate tools, e.g., if you drag across 

some text in the FILL TOOL (ON PAGE 296) it will give it a graduated color, or if you drag on 

it with the SHADOW TOOL it will give it a soft shadow. 
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Text Repel Around Objects 

If you right click on an object like a photo and select the menu option 'REPEL TEXT UNDER 

(on page 259)' you can make text flow around the object that is on top of the text. 

Many of the objects, such as photos, side panels, buttons and headings used in the 

templates from the ONLINE CONTENT CATALOG are automatically repelling - the text will 

always flow around these objects as you drag them around.  

Repelling objects only repel text that is behind the object - so you may have to 'bring to 

front' the object in order for the repel to work ("Ctrl + F"). Alternatively if you only want an 

object to repel text within an individual layer (on page 45), you can prevent text that is 

below that layer from being repelled - see Layer Properties (on page 198). 

All operations in the TEXT TOOL are live - the text re-formats and re-flows as you adjust 

the column width or move repelling objects around. 

Note: You can now also repel text around anchored objects (on page 42). 

Anchored Objects 

If you want a graphical object to appear next to a particular part of a block of text, you 

can anchor the object to the text so it moves with it.  

Right click the object and choose ANCHOR TO TEXT. Using the SELECTOR TOOL click and 

drag the anchor symbol that appears in the top left of the object to the location in the text 

where you would like the object anchored. Now if you edit or move the text, the anchored 

object moves with the anchor point.  

Spell Checker 

 

On the TEXT TOOL InfoBar is a button that selects the spell checker, auto 

correction options and language. If you select CHECK SPELLING AS YOU TYPE this 

will also mark all unrecognized words with a red dotted underline. Right click on 

any marked word to be presented with suggested alternatives. 

 

Embedded Fonts 

Photo & Graphic Designer stores the character shapes of all the fonts used in your 

document. This means if you give someone else your Photo & Graphic Designer file, or 

transfer the file to another computer they will see exactly what you see, even if the 

correct fonts are not installed on that computer. But this only embeds the characters that 

are used in the document (it's not a full font that is included). So on computers with the 

fonts missing, any text that is added in the missing fonts may be missing the correct 

character shapes. 

Text Tip: There are a lot of shortcuts available in the TEXT TOOL. Refer to the reference 

section on keyboard shortcuts to see them all. One useful one for experimenting with 

page layouts, "Ctrl + Shift + L", inserts a block of random pseudo Latin. 
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Page Size 

You can set any page size you like by selecting the PAGE SIZE tab of the OPTIONS DIALOG 

(right click > "Page Options" or choose Page Options from the File menu). The dialog 

offers a range of commonly used page sizes in the drop-down list, some intended for 

web use and others for print use. Or Choose the custom option to enter any other page 

size. 

You can directly adjust the height and width of your page by just dragging on the bottom 

or right margin of the page. Go into the Selector Tool and hover the pointer over the 

bottom edge of the page, and it will change to indicate you can now drag resize the page 

up or down as required. This is normally only useful for web documents as print 

documents usually need a fixed paper size. You will be prompted to choose whether the 

change should apply to all the pages in the document or website, or just the current one. 

  

  

Saving & Exporting Your Work. 

Use the SAVE or SAVE AS menu options to save your work in progress. This saves a file 

with the .xar extension, which is the native file format for Photo & Graphic Designer. You 

are recommended to regularly save your work as you go along, particularly if you don’t 

have the automatic backup facility turned on (see below). If you want to edit or update 

your document in future, you must save a .xar file this way and use it to do further 

updates, even if you've also exported it to different standard file formats. 

To export your document, right click and choose EXPORT or use "FILE" > "EXPORT" and 

choose the file format you want to export to from the list of formats shown. Use JPEG for 

exporting photos for web use, PNG for web graphics, HTML to create a website, and 

usually PDF is best if you want to print or distribute print work.  You can also export to a 

Word file or export a print document as a web viewable HTML document or "Web 

document". 

See the Importing & Exporting (on page 505) chapter for information on these and many 

other export formats supported by Xara Photo & Graphic Designer. 

Automatic Backups 

The Backups tab in the UTILITIES->OPTIONS dialog allows you to turn automatic backups 

on and off. When this is turned on, Xara Photo & Graphic Designer will take regular 

backups of your open modified documents at times when you are not actively using the 

program.  It’s recommended that you work with this option turned on, so that you don’t 

lose large amounts of work in the event of an unexpected interruption such as a power 

cut.   
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You can access the backup files via the FILE->OPEN RECENT->BACKUPS… option. 

Also in this dialog you can decide whether Xara Photo & Graphic Designer should 

prompt you about each open modified document when you close the program, or just 

silently save copies of such documents for you and re-open them the next time you start 

the program. For more information on all this, see the DOCUMENT HANDLING (on page 46) 

chapter. 

Groups 

You can group together any selection of objects on the page. Groups act much like a 

single object, in that you can drag them around the page, resize and rotate them as if 

they were one object. Many of the items in the template designs from the Designs 

Gallery such as buttons, text panels, and photo objects are grouped items.  

For example, you can draw a simple button from scratch by drawing a rectangle with the 

RECTANGLE TOOL, and then placing a text label on top of this with the TEXT TOOL. These 

are separate objects and you can move them around independently in the Selector tool.  

But if you select both in the SELECTOR TOOL (you can lasso drag around to enclose them 

both, or hold Shift and click on additional objects) and then right click and choose GROUP 

or press "Ctrl + G" (or the menu ARRANGE -> GROUP) these now become a grouped object 

(Hint: the status line at the bottom always tells you what is selected).  Now when you 

drag, resize, rotate this object, all component parts of the group are moved and 

transformed as if they are one object. 

By un-grouping ("Ctrl + U") you can access all the parts of your group again to make any 

changes. An alternative is that you can sometimes edit items directly inside a group, for 

example when using the Text tool to edit text or the PHOTO TOOL to edit a photo, a click 

will automatically select the item inside a group.  

Soft Groups 

There is another type of group, called a 'Soft Group', which is a more loosely connected 

set of objects. See the Object Handling (on page 123) chapter for details.   

Synchronized Text 

There is another useful feature of Soft Groups. If you have the same text on two or more 

objects within a Soft Group, the text will be synchronized when you edit it. 

Repeating Objects 

It's common to have items like navigation buttons, headers or logos repeating on all 

pages of your document or website. Xara Photo & Graphic Designer provides the ability 

to repeat any item in the same place on any of your documents. When you update one of 

the copies, all changes are automatically replicated across all pages.  

See the Repeating Objects (on page 155) section of the Object Handling chapter for 

details. 
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Layers 

All items can be placed into named layers.  Each layer can have any number of objects, 

and has the ability to be turned on or off. When the layer is turned off all objects on that 

layer become invisible. 

The PAGE  & LAYER GALLERY allows you to easily see and adjust the stacking order of 

objects and layers. Objects are listed in order from front to back in the gallery. See Page 

& Layer Gallery (on page 196) for details. 

 
The layers are controlled from the PAGE & LAYER GALLERY on the Galleries bar to 

the right of the workspace. 

In website documents, layers are used to provide mouseover (sometimes called rollover) 

features on your website. These include highlighting buttons (they highlight when you 

move the mouse over them) and also other pop-up effects. See the Web Graphics 

chapter of the help for full details. 

Moving Objects Between Layers 

There are several ways to move objects between layers. First select the object or objects 

you want to move, then; 

 CUT the object ("Ctrl + X" or right click and CUT). Ensure the target layer is the current 

layer (shown with  , click the layer if it's not) and then right click and choose PASTE or 

PASTE IN PLACE. Note that if you cut or copy multiple items that are on different layers, 

the layer structure is preserved when you paste. Items are pasted to the same layer 

they were copied/cut from, instead of being pasted to the current layer. If you want to 

paste all such items to the current layer, ignoring the layer structure, use the PASTE IN 

CURRENT LAYER option instead. If you want to retain layer structure, choose PASTE IN 

PLACE IN CURRENT LAYER. These paste options are also in the clipboard fly-out bar on 

the top bar, as well as the EDIT menu. 

 Right click and choose ARRANGE then MOVE TO LAYER IN FRONT / MOVE TO LAYER 

BEHIND to shift the selected objects one layer up or down. 

 Ensure the target layer is selected as current, then find the selected item in the PAGE & 

LAYER GALLERY (click the LOCATE button), right click and select MOVE TO CURRENT 

LAYER. 
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Document handling 

Starting a new document 

Choose FILE > NEW 

This opens a sub menu with several pre-defined but blank template documents to start 

from.  

 

Primarily, there are five different types of documents in Xara Photo & Graphic Designer. 

Icon Document type Menu option Use for.. 

 

Print  A4 PORTRAIT 

A4 LANDSCAPE 

A4 DOUBLE PAGE- 

SPREAD 

US LETTER 

Creating drawings, DTP and text 

documents (single or multi-page) that 

you want to print or perhaps export as 

PDF documents. 

 

Website  WEB PAGE 640 PX  

(VGA) 

WEB PAGE 760 PX 

(SVGA) 

WEB PAGE 955 PX 

(XGA) 

Creating complete websites or web 

graphics. 

 

Presentation 955 PIX PRESENTATION Creating web presentations. 

 

Animation ANIMATION Creating animations such as a Flash 

animation or animated GIF. 
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Photo       BLANK PHOTO If you load a JPEG photo into Xara 

Photo & Graphic Designer it’s loaded 

as a photo document. Photo 

documents are used where the 

purpose of the document is only to 

edit or produce a photo. 

Choosing the first entry A4 PORTRAIT creates a document based on the Photo & Graphic 

Designer default template. 

 

Clicking the NEW button on the STANDARDcontrol bar (shortcut "Ctrl 

+ N") also creates a document based on the default template. 

Tip: Ctrl + Shift + N opens a new animation document. 

When your new document opens, its tab is added to the top of the workspace with an 

icon showing which type of document it is, as shown in the example below. 

 

You can save your own templates with the "File" > "Save Template" command – see 

Changing the template document (on page 542) for details. 

Opening an existing document 

To open an existing document: 

 Drag & drop a file. Select the file in Windows Explorer or on your desktop, and drag it 

over an existing open document to import it  into that document, or any other part of 

the Photo & Graphic Designer window to open the document. 

 Or double click a Photo & Graphic Designer file. 

 Or to open a recently used file, select it from "FILE" > "OPEN RECENT" 

 Or select "FILE" > "OPEN" (shortcut "Ctrl + O"). 

 Or click the OPEN button on the standard control bar. 

 

The open dialog will be displayed. The dialog allows multiple file selection, "Ctrl 

+ click" to select several files or "Shift + click" to select a range of files. 

 
As in Explorer windows, you can switch the file display to a detailed or thumbnail 

view with this button 

If SHOW PREVIEW in the upper right corner is checked, the selected file is shown in an 

even bigger preview (this does not work for a multiple file selection). 

Selected document and title bar 

You can have more than one file open at a time in Photo & Graphic Designer, which 

displays all open documents as tabs at the top of the workspace. 
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The current document is displayed in the workspace and its name is highlighted gray in 

the document tabs. Right click on a document tab for a menu of document operations. 

The current document type is indicated in the top left corner of the Photo & Graphic 

Designer window, next to the menu options. The current document receives all input. Any 

unsaved changes in a document are indicated with a star after the file name. 

 

Document tabs show all open documents, with the current document tab highlighted gray.  

Control bars 

These contain buttons that you can use to operate Photo & Graphic Designer. You can 

customize control bars in several ways, such as re-ordering, creating, and hiding bars. 

The default window shows the standard button bar with commonly used buttons: 

 

You can customize the standard control bar in the same way as other control bars. 

Those icons with a triangle indicator in the bottom right corner have "fly-out bars" on 

them. Hold the mouse pointer over these icons and you’ll see the fly-out bar appear, with 

more icons. 

For information on customizing control bars, refer to "Customizing Photo & Graphic 

Designer (on page 561)". 

InfoBar 

This is a special control bar. Its contents change when you select different tools. InfoBars 

specific to certain tools are described in their relevant chapters. 

You cannot customize the InfoBar. 

 

The InfoBar for the Selector Tool 
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Main toolbar 

 

This is a control bar that initially contains all the tools available in Photo & 

Graphic Designer (see left). You can customize the toolbar, or move tools to 

other control bars. 

Some of the toolbar icons have a small triangle indicator in the bottom right 

corner. This indicates that there is a flyout bar containing more tool icons. 

Hold your mouse pointer over the icon to see the flyout bar appear.  

 

You can then move the mouse pointer over each icon in the bar to see a 

tooltip indicating what each one does. Click on a tool to select it (some tools 

have keyboard shortcuts, too). 

For information on customizing control bars, refer to "Customizing Photo & 

Graphic Designer (on page 561)". 

 

Rulers 

 

You can hide the rulers, change their zero point (origin), and 

use them to create guidelines. For more information, see 

Rulers (on page 69). 

 

The status line 
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Selected objects 

 
Available options 

 
Indicators 

 
Mouse pointer X-Y 

This appears at the bottom of the window. The status line tells you about the selected 

objects, available options, live drag/snapping indicators, and the X/Y position of the 

pointer. 

The indicators 

These appear on the right of the status line: 

 Live drag indicator 

This indicator shows whether live drag is active or not (it is active by default). 

Double click the indicator to toggle live drag on/off. When active, if you 

reposition, resize, or rotate an object, the whole object moves (not just an 

outline), making it far easier to judge the effect of your edits in real time. Drawing 

in the FREEHAND, STRAIGHT LINE, QUICKSHAPE, RECTANGLE and ELLIPSE TOOLS 

(on page 184) is also live with this option on. If your computer is unable to cope 

with a particularly complex document, it will automatically turn active drag off to 

ensure editing remains fast and efficient. 

 

 

Snapped indicator 

This indicator is active when SNAP TO OBJECTS is enabled. Click the SNAP TO 

OBJECTS button (shown left) to toggle off and on. Snap to objects allows you to 

see potential snapping paths and points relative to other objects and the page 

center and edges by showing blue snapping lines for snapping paths and red 

dots for points as you drag an object. For more information on snapping, refer to 

"Object Handling (on page 123)". 

 

X/Y co-ordinates 

Photo & Graphic Designer shows measurements relative to the bottom left corner of the 

page area or spread. However, this is configurable. For more information refer to OBJECT 

HANDLING (on page 123). 

Normal/full screen modes 

In normal screen mode part of the window is occupied by the title bar, menu bar, and 

scroll bars. This can be inconvenient if you want the maximum possible editing area. 

Photo & Graphic Designer has a second screen mode, fullscreen, which displays a more 

streamlined screen. You can configure each screen mode as you wish. For example, 

each can have its own configuration of the control bars. The configuration is remembered 

and applies whenever you swap between screen modes. 
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Normal/full screen is controlled by "WINDOW" > "FULL SCREEN" or right click and choose 

FULL SCREEN ("8" on the numeric keypad toggles between the two displays). 

To display the menu bar in full screen mode, move the pointer to the top of the screen. 

Opening a second window 

You may want to open a second window onto the same document to: 

 Get an enlarged or reduced view of the document; 

 Show another part of the document; 

 Have two views of the same area at different quality settings (quality settings are 

described later.) 

Choose "WINDOW" > "NEW VIEW" to open another window. You can have several windows 

open on the same document. Additionally, Ctrl+Tab will allow you to flick between 

windows. 

Selecting which window to display 

Each window that you have currently open is displayed as a tab below the InfoBar. Click 

on a tab to display the window or click on the WINDOW menu and choose a window name 

at the bottom. 

Ordering multiple windows 

"WINDOW -> ARRANGE VIEWS" and "WINDOW -> CASCADE" help you organize multiple 

windows. Each window has its own title bar but no control bars. Click on a window to 

make it the current window. Pressing "Ctrl + Shift + F6" steps through the windows in 

sequence. 

ARRANGE VIEWS displays the windows arranged vertically or, for more than three 

windows, as tiles. 

CASCADE displays the windows staggered behind each other. 

Minimizing multiple windows 

Minimizing one of several windows displays an icon on the background of the main Photo 

& Graphic Designer window. Double click the icon to reopen the window. Minimizing and 

then reopening several windows can scatter icons on the background. "Window -> 

Arrange" icons tidies up scattered icons. 

Changing the zoom value 

It’s often useful to enlarge your view of the document to examine details or reduce your 

view to get an overall impression. Scalings above 100% show an enlarged view (similar 

to looking through a magnifying glass); below 100% a reduced view. The only change is 

your view of the document; the size of the document itself and the objects in it are 
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unchanged (changing the document size is described later). To change the zoom value 

you can use either the ZOOMTOOL, mouse, or control bars. 

Some shortcuts are available for quick setting of zoom values: The plain numeric keys (1, 

2, 3, 4) set the zoom to between 100% and 400%. The number 5 key sets it to 50%. 

Using the Zoom Tool 

 

To zoom: 

 Select the ZOOM TOOL from the MAIN TOOLBAR. 

 Or press "Alt + Z" to toggle between the current tool and the ZOOMTOOL. 

 Or press and hold down "Alt + Z" to temporarily swap to the ZOOMTOOL (release "Alt + 

Z" to return to the previous tool). 

 Or press "Shift + F7" to select the ZOOMTOOL. 

Changing the zoom value using the mouse 

If you have a mouse wheel: 

 Hold "Ctrl" and scroll your mouse wheel to change the zoom level. 

You can also configure a mouse button to zoom in or out. Furthermore, you can change 

the mouse wheel action between scrolling and zooming in "UTILITIES" > "OPTIONS" > 

"MOUSE TAB (ON PAGE 550)" or right click and choose "PAGE OPTIONS" > "MOUSE" tab. The 

opposite action is available then by pressing "Ctrl". 

Alternatively, select the ZOOMTOOL, and 

 Click to zoom in (enlarge). 

 "Shift + click" to reduce the zoom value (to see more of the document). 

 Drag the mouse diagonally to create a rectangle. When you release the mouse button, 

the area within the rectangle is enlarged to fit the window. 

Changing the zoom using the zoom InfoBar/control bar 

There is a flyout bar on the standard toolbar which gives you quick access to zoom 

functions, without having to go into the ZOOM TOOL. There is also a flyout bar on the 

ZOOM TOOL icon on the main toolbar. 

 

Hold the mouse pointer over the zoom icon on the standard toolbar to see the 

flyout bar. 

To change the zoom: 
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Shortcut "Ctrl + R". Click the PREVIOUS ZOOM button. This is the zoom value 

before the current setting. Using this button lets you flip zoom in and out on the 

document. This is useful for switching between examining an area in detail and 

an overall view. The previous zoom value is stored for each window. You can 

swap between windows and the previous zoom values are retained. 

 

Shortcut "1" Click the Zoom to 100% button. The zoom factor is changed to 

100%. 

 

Shortcut "Ctrl + Shift + J". Click the ZOOM TO DRAWING button. The window 

shows all the objects in the document. 

 

Shortcut "Ctrl + Shift + P". Click the ZOOM TO PAGE button. The window shows 

the entire page or pair of pages. 

 

Shortcut "Ctrl + Shift + Z". Click the ZOOM TO SELECTION button. The selected 

object or objects fill the window. 

 

 

Type a value into the text box. Press "" to implement 

the change, or select preset zoom values including those 

above (page, drawing, selected, previous) in the drop-

down menu. 

 

Sliding the document within the window 

The quickest and easiest way to move around the document is to use the middle mouse 

button (normally the mouse wheel) if you have one. Click and hold the middle button 

down and then move the mouse. Release the button to return to your previous tool. 

To move the document within the window you can also: 

 Use the scroll bars and arrows at the side of the window. 

 Use the mouse wheel to scroll the document up and down ("Shift + mouse wheel" for 

left and right) 

 

 Or select the PUSHTOOL from the main toolbar ("H"). 

 Or press the space bar or "Alt + X" to toggle between the current tool and the 

PUSHTOOL. 

 Or press and hold down the space bar or "Alt + X" to temporarily switch to the 

PUSHTOOL (release key(s) to return to the previous tool). You can then use the mouse 

to drag the document around in the window. 

The PUSHTOOL InfoBar is the same as the ZOOMTOOL InfoBar (described above). 
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Displaying the scroll bars is optional. Choose "WINDOW" > "BARS" > "SCROLLBARS" to turn 

them off. 

You can change the mouse wheel action between scrolling and zooming in "UTILITIES" > 

"OPTIONS" > "MOUSE" or right click and choose "PAGE OPTIONS" > "MOUSE". The opposite 

action is available then by pressing "Ctrl". 

Changing the page size 

You can change the size of the current page to a standard size: 

1. Right click the page and choose "PAGE OPTIONS" > "PAGE SIZE" tab or choose 

"UTILITY" > "OPTIONS". 

2. Choose the required paper size. 
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"Customizing Photo & Graphic Designer (on page 542)" has full details of the options 

dialog box. 

Paper size 

You can either choose the CUSTOM option from the paper size list and then enter the 

width and height, or choose a standard size. Or you can go into the SELECTOR TOOL and 

drag on the bottom edge or right edge of the page to change the page height or width 

respectively. If you use this method you will be prompted to choose whether the change 

should apply to all the pages in the document or website, or just the current one. 
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Position the mouse pointer over the edge of the page – 

you will see the mouse pointer change when you are in 

the right position, then click and drag. 

 

The current page size is shown in the status bar as you drag. 

Automatic Page Extension 

Objects that have the PUSH option turned on (see right click menu, "PAGE POSITION" > 

"PUSH") will make the page extend automatically if they extend over or close to the 

bottom of the page. All the web page templates in the DESIGNS GALLERY use this feature 

so that pages grow as required during editing. See the Push section in the Object 

Handling (on page 123) chapter for details.  

Double page spread 

 

Single page      Double page spread 

Your illustration may run across two facing 

pages in a multi-page publication. This is 

called a "double-page spread". 

 

Orientation 

 Portrait orientation displays the longest sides vertically. 

 Landscape orientation displays the longest sides horizontally. If you entered a custom 

page size, landscape turns the page sideways. 

Outer margin 

This lets you set the width of the pasteboard around the page or spread. 
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Bleed 

To produce format filling print results printing shops use a larger format paper and crop it 

to the target format after it has been printed. Due to mechanical tolerances inaccuracies 

can happen during this process. For this reason, printing shops recommend including an 

additional "safe area" around the actual print motif. This is often referred to as the 

"bleed". This ensures that no important content is cropped and that no white borders 

appear on the edges if the motif background is not white or a background pattern is used. 

 

Without this "bleed" area a mechanical error during cropping can lead to white borders or 

image elements that are too close to the edge being cut. 

The bleed area is set in the Page area of the Page Options (on page 551) and in the 

program it is displayed as a red rectangle around the page. Normally this bleed area is 1-

3mm wide. When a PDF is exported for printing the final page size of the PDF will appear 

based on the page size settings plus the bleed area beyond the actual page. For 

example, an A4 page (29.7 x 21cm) with a 2mm bleed area will result in a format of 30.1 

x 21.4cm.  

The exact value depends on the print shop - so consult for details. Some online print 

shops also request a file format that already contains the bleed area. Here is an 

example: For a flyer in A6 format (14.8 x 10.5cm) the shop may request a file format of 

15 x 10.7cm. This corresponds to a value of 1mm for the bleed area beyond the actual 

page. 
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Make sure that the rectangle that contains the background pattern or color extends 

beyond the page borders at least to the edge of the bleed area. It is also important to 

make sure that all important page elements are at a safe distance from the page borders. 

This distance should be at least the size of the bleed area. 

 

The background image was extended to the edge of the bleed area (red frame) and the header 
was made smaller. If a cropping error does occur, the background will still cover the entire 
format and the heading will not be affected. 

Auto-fit to Page... 

The AUTO-FIT TO PAGE... button will open the AUTO-FIT TO PAGE dialog. This enables the 

automatic repositioning and scaling of page content to fit a new page size. The dialog 

also lets you fine tune the position of document content. This may sometimes be 

necessary especially with items around the margins of the document like headers, 

footers etc. 

 See the Auto-fit to Page (on page 160) section in the Object Handling (on page 123) 

chapter for details. 

.  

Multi-page Documents 

Xara Photo & Graphic Designer supports multi-page documents to make DTP and 

website building projects simple.  

You can easily create documents that are comprised of many pages, for example 

newsletters, PDF eBooks, brochures, small magazines or even complete HTML 

websites. When working on a website document, each page in the Photo & Graphic 

Designer document is exported as one page of the website.  
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By default when you open or create a new web document,  Photo & Graphic Designer  

shows only one page. Print documents however are displayed in multiple page view by 

default. Right click a page and select/deselect MULTIPLE PAGE VIEW to toggle between 

display modes.  

The current page 

If you click a page in a multi-page document it will become the current page. 

 

The current page is relevant when inserting, duplicating, or moving pages as 

described in the following sections. 

The current page in the document is shown by indicators on the page’s corners. 

 

Inserting pages into your document 

Right click a page and choose NEW PAGE or NEW DOUBLE PAGE SPREAD. A new blank 

page is inserted after the page. 

or 

Right click a page and choose DUPLICATE CURRENT PAGE. A duplicate of the current page 

is inserted after the page. 

 

The new page will be the 

same as the original page, 

including its size and 

orientation, and will include all 

its content so that you can 

use it as a template for new 

content. 

You can also use the Menu 

items under "EDIT" > "PAGES" 

In addition, the standard toolbar has a flyout bar which allows you to add, duplicate and 

delete pages quickly. 

 

Hold the mouse pointer over each icon in the bar to see a tooltip for each available 

operation. You can add a new blank page, duplicate the current page or delete the 

current page. 
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Copying and pasting pages 

You can copy and paste whole pages in the current document or paste pages to another 

document. This copies the page dimensions, layers and other page attributes in addition 

to all the objects on the page.  

 

To copy the current page, clear any current selection by pressing Esc or by clicking on 

an empty part of the page or pasteboard. The status line says "No objects selected". 

Right click an empty part of a page and choose COPY PAGE (or press "Ctrl + C").  

When you paste a copied page, it is added immediately following the current page. To 

paste use "Ctrl + V" or  right click the page and choose PASTE > PAGE from the context 

menu. 

Note: If the document into which you paste a page has the ALL PAGES IN DOCUMENT THE 

SAME option enabled in FILE > PAGE OPTIONS, the dimensions of the pasted page will be 

overridden by the page dimensions of the document. So the new page will be given the 

same dimensions as all the other pages in the document.  

New page from template 

 
To insert a new page into your document using a pre-designed template, open the 

DESIGNS GALLERY, drag your chosen page template thumbnail, and drop it onto 

your document. The new page is added immediately following the page that you 

drop on. 

 

Duplicate a page 

To create a copy of the current page after the page, right click the page and choose 

"DUPLICATE CURRENT PAGE". 
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You can also use this toolbar button: 

 

 

The new page will be the same 

as the original page, including 

its size and orientation, and 

will include all its content so 

that you can use it as a 

template for new content. 

You can also duplicate a page using the PAGE & LAYER GALLERY. Select the page in the 

Page & Layer Gallery and click the DUPLICATE button. The new page is added after the 

current page. 

Moving pages within the document 

If you wish to change the order of pages in your document you can do so. 

Right click a page and choose "MOVE PAGE/DOUBLE PAGE SPREAD UP" or "MOVE 

PAGE/DOUBLE PAGE SPREAD DOWN". 

 
You can also change the order of pages in the PAGE & LAYER GALLERY. 

Click the PAGES button in the PAGES & LAYER GALLERY so it shows a simple list of pages. 

Then you can drag and drop pages up and down in the gallery to change the page order. 

You can also duplicate a page using the PAGE & LAYER GALLERY. Select the page and 

click the DUPLICATE button. The new page is added after the current page. 

Alternatively, to move the current page: 

 Choose "Edit" > "Pages" > "Move page up" or right click and choose Move page up to 

swap the current page with the one previous to it. 

 Choose "Edit" > "Pages" > "Move page down" or right click and choose Move page 

down to swap the current page with the one after it. 

These options will be grayed-out of if you are on the first or the last page of the document 

respectively. 
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Removing pages from your document 

To delete the current page from your document right click and choose "DELETE CURRENT 

PAGE/DOUBLE PAGE SPREAD". 

Or to cut the current page, right click an empty part of the page and choose CUT PAGE.  

Or select the page in the PAGES & LAYER GALLERY and click the DELETE button. The 

current page and all its content will be deleted. In the case of a spread, the entire spread 

will be deleted along with its content. 

Navigating between pages 

As well as the usual methods of moving through your document (such as scrollbars and 

the mouse wheel), there are also some other ways to navigate through the pages using 

the set of keys to the right of your keyboard: 

Page up: Moves up the document. The amount moved depends on your zoom level. The 

further you are zoomed out the bigger the move. 

Ctrl + Page up: Go to and center on the previous page. 

Page down: Moves down the document. The amount moved depends on your zoom 

level. The further you are zoomed out the greater the move. 

Ctrl + Page down: Go to and center on the next page. 

Or click the up or down arrow on the status line: 
 

The status line is also useful for knowing what page(s) you are currently viewing. 

Note: All of these movements are relative to the page you are viewing, not the current 

page. 

The PAGE & LAYER GALLERY also makes it easy to go to find a specific page in your 

document. Click the PAGES button in the gallery, so it shows a simple list of pages. Then 

as you click on each page in the gallery, the document view is scrolled automatically to 

show that page. 
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Pages with different sizes and layers 

You can choose whether the pages in your document should be all the same size or not, 

and whether or not all pages should have the same layers. See the Document section 

(on page 552) on the PAGE SIZE tab of the UTILITIES > OPTIONS dialog or right click a page 

and choose "PAGE OPTIONS". 

 

Double page spreads in multi-page documents 

 

Your illustration may run across two facing 

pages. This is called a double-page 

spread. 

Single Double page  

To switch between single or double-page spreads, right click the page and choose "PAGE 

OPTIONS", and then check or uncheck the "DOUBLE-PAGE SPREAD" option.  

Note: If ALL PAGES IN DOCUMENT THE SAME (on the same Page Options tab) is turned on, 

then any changes you make will apply to all pages in your document. So if you want only 

some of your pages to be double-page spreads, turn off the All pages in document the 

same option. 
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If you change from a double-page spread to single pages in an existing document, your 

spreads will be split into single pages. Similarly, converting to a double-page spread will 

cause the pages in your document to be "paired up" into spreads. 

 

The result of converting a double page spread document to individual pages, and then back 
again. 

Note: it is possible for objects to overlap the pages of a spread (i.e. on pages 1 and 2 in 

the illustration above) but not over separate pages or spreads (i.e. 1 and 3; if you did 

want to do this, you would need to copy the object from page1 and paste it on to page 3 

so that it appears there as well). 
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Page & Layer Gallery 

You can also use the PAGE & LAYER GALLERY to conveniently manage the pages in your 

document. It allows you to view, add, duplicate, delete, re-order pages all from a single 

view. For more information see PAGE & LAYER GALLERY (on page 196). 

Saving the document 

This section covers saving in Photo & Graphic Designer’s own format (native format). 

Refer to Importing and Exporting (on page 505) for details of exporting in other formats. 

We recommend that you always save documents regularly. A complicated document 

may represent many hours of work and power failures or computer crashes always 

happen at just the wrong moment.  Make sure you have the automatic backup facility 

turned on, so that regular backups are taken of your open documents as you work. See 

the Automatic Backups (on page 66) section below for details. 

Save option (on the File menu) 

 

("Ctrl + S", or click the SAVE button on the standard control bar.) 

This provides a quick way to save a document using the same file name. The option is 

disabled unless the document has unsaved changes, i.e. you have made changes, but 

haven't saved them yet. 

For a new document that has not been saved, this option acts like "Save as" (described 

below). 

Save as (on the File menu) 

This opens a dialog box letting you save the document under a different name or to a 

different directory. This option is useful for making backups of Photo & Graphic Designer 

documents. 

Save all (on the File menu) 

This acts like a series of SAVE or SAVE AS commands to save all currently open files. 

Closing the document 

To close the document: 

 Choose "FILE" > "CLOSE". 

 Or press "Ctrl + F4", or "Ctrl + W". 

 Or click the smaller, lower X of the two in the top right hand corner. 
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 Or right-click on the document tab to view a context sensitive menu with a series of 

save and close options for both individual and all open tabs. 

 

Right-click on a tab to display multiple save and close options. 

Automatic Backups 

Xara Photo & Graphic Designer will optionally save regular backup copies of your open 

documents while you work.  

To turn automatic backups on or off, open the "UTILITIES" > "OPTIONS" dialog and choose 

the BACKUPS tab. 

 

Backup open documents 

To turn backups on select this checkbox and choose how often you would like backups 

to be taken. The suggested period is 10 mins, which means each open document will be 

backed up if it’s more than 10 mins since the last backup of that document was taken (or 

since the document was created or opened).  

Note that once the configured period since the last backup has expired, the next backup 

is only saved when the program has been idle for at least 15 secs. This is to avoid 

interrupting your work as much as possible and to avoid backing up the document while it 

is being actively modified. In normal use it’s unlikely that there won’t be regular inactive 

periods of 15 secs or more, allowing a backup to be taken soon after it is due. But note 
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that if you are actively editing for an extended period of time it could be significantly 

longer than the configured backup period before the next backup runs. 

The Automatic Backup facility does not save modifications to open ‘edit inside’ sub-

documents. Only the parent main document is saved when a scheduled backup runs, in 

its current state without the unsaved group edits. For this reason it's recommended that 

you save ‘edit inside’ edits back to the parent document regularly.  

When a backup is taken, you’ll see the save progress bar appear at the bottom of the 

Xara Photo & Graphic Designer window while the save is completed. 

Backup location 

User the BROWSE button if you want to change the folder where your backups are stored.  

You can access the backup documents saved here at any time using the "FILE" > "OPEN 

RECENT" > "BACKUPS" menu option. This opens a file dialog onto your backup folder so 

that you can browse, open, or delete any of your backup files. 

Revisions 

By default up to 10 revisions of each design are kept in your backups folder, but you can 

choose to change this number in the revisions field.  Older revisions in excess of the 

number chosen are deleted automatically. Each backup file is named using the name of 

the document from which it is taken, suffixed by the date and time at which the backup 

was taken.  

Warning: Note that if you have multiple documents that share the same filename in 

different folders on your computer, their backups will also share the same names in the 

backups folder. Therefore try and use unique filenames for your designs to avoid the 

backups of one design overwriting another with the same name. 

Untitled documents 

Documents that you have created and not saved are backed up using the name 

"Untitled" followed by a number and the date/time. This name and number corresponds 

to those shown in the titlebar when you are editing new unsaved documents.  

Warning: Since all new unsaved documents are named Untitled1, Untitled2, etc. 

backups of these documents are likely to be overwritten relatively quickly. Therefore you 

should always save important documents with a unique name of your choice, so that you 

can easily identify backups of that document in the backups folder. 

Backup open documents on program close 

The Backups tab in the Options dialog also allows you to turn on AUTOMATIC BACKUP 

AND RESTORE. When this option is on, when the you close Xara Photo & Graphic 

Designer you will not be prompted to save  any modified documents that you have open. 

Instead all open documents are backed up to the backups folder and the program closes. 
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Then when you next start the program, the same documents are automatically reloaded 

so that you can continue working where you left off.   

Note that if you have any "Edit inside" sub-document views open, these are silently 

closed and saved back to the main document when the program is closed, and the main 

document is backed up. The ‘edit inside’ sub-document views are not re-opened on next 

program start. See editing inside groups (on page 147).  

Recovering from abnormal program closures 

If you have automatic backups turned on and the program closes abnormally (perhaps 

due to a power failure for example)  the program should detect this when it is next 

restarted. It will then offer you the chance to restore the most recent backup version of 

each document that was open at the time of the last backup. 

Abnormal closure will not be detected if no automatic backup completed since the last 

normal program closure. 

Backups on system shut down 

If you shut down Windows without first closing the program, all open documents are 

backed up to the backup folder even if ‘Backup open documents on program close’ is not 

turned on. This allows system shutdown to proceed without Xara Photo & Graphic 

Designer interrupting it by prompting you about unsaved or modified documents. On next 

program startup you’ll be asked whether or not you want to restore the documents that 

were open at the time of the system shut down. 

Recovering backups 

You can access your document  backups using the "FILE" > "OPEN RECENT" > "BACKUPS" 

menu option. This opens a file dialog onto your backup folder so that you can browse, 

open, or delete any of your backup files. It’s a good idea to use this file dialog to clear out 

any old unwanted backups periodically. 

Note that when you load a backup document, it is not automatically associated with the 

design file from which the backup was taken. It’s treated as an independent document in 

its own right. Therefore if you decide to keep a backup document you should use "FILE" > 

"SAVE AS" to save it elsewhere with a suitable name. 

On-screen grid 

To help you lay out your document, Photo & Graphic Designer can display a grid on the 

screen (the grid appears only on the screen; it is never exported or printed.) The grid 

helps you align objects (similar to using graph paper as a drawing aid). 

Right click and choose "SHOW GRID/GUIDES" > "SHOW GRID" to turn display of the grid 

on/off or choose "SNAP TO" > "SNAP TO GRID". You can also choose "WINDOW" > "SNAP TO 

GRID".  

The grid points then act like magnets, and as you move objects, they snap to the nearest 

grid point. By default web documents have "SNAP TO GRID" on, with a 1 pixel grid. 
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The type of grid (isometric/rectangular), the 0,0 point (the origin), and spacing of grid 

points is controlled by the GRID & RULERS TAB (on page 547) of the options dialog box. 

Any changes you make apply only to the selected document. 

Magnetic object snapping is also enabled by default in web documents. Object snapping 

is a very powerful way of accurately aligning lines, points and the edges of objects to any 

other object so they exactly touch. 

You can even use this to align the centers of objects, or align objects to the center of the 

page, or align them horizontally and vertically anywhere in the middle of the page or 

edge of the page. 

 

To toggle object snapping, click the SNAP TO OBJECTS button or right click and 

choose "SNAP TO" > "SNAP TO OBJECTS". You can also choose "WINDOW" > 

"SNAP TO GRID".  

Refer to Object Handling (on page 123) for details on snapping to grid and snapping to 

objects. 

Rulers 

Rulers are turned off by default. To turn them on: 

 Right click and choose "SHOW GRID/GUIDES" > "SHOW RULERS" to turn display of the 

grid on/off. 

 Press "Ctrl + Shift + R". 

 Or select "WINDOW" > "BARS" > "SHOW RULERS". 

Photo & Graphic Designer uses rulers to: 

 Control text margins, tabs and indents (on page 256) in the TEXT TOOL. 

 Let you know which part of the page you are viewing; 

 Show the current pointer X/Y position; 

 Apply guidelines. If "WINDOW" > "SNAP TO GRID" is active, guidelines snap to divisions 

on the ruler. For more information on guidelines, refer to the guides & guidelines 

section in "Object Handling". 

As you create or scale objects, you can use the rulers to check their size. You can also 

more accurately use the SELECTORTOOL (see "Selecting objects (on page 115)" for more 

information). 

Rulers are displayed at the left and top of the window. A dotted line on each ruler follows 

the current pointer position. 

The units and number of divisions on the rulers are the same as those set for 

customizing the on-screen grid. These are set using the Grid & Ruler Tab (on page 547) 

of the options dialog box. The current units and any scaling factor are displayed on the 

right hand end of the top ruler. 
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Displaying/hiding rulers 

Right click and choose "SHOW GRID/GUIDES" > "SHOW RULERS" ("Ctrl + Shift + R") to turn 

rulers on/off. Any change applies to the current window and subsequent windows you 

open. It does not affect other open windows. 

Changing the ruler zero points 

It is often easier to measure objects if you align the origin (0,0) point of the rulers with the 

object. To move the origin (0,0) point, drag the square at the intersection of the two 

rulers. 

 

You can drag vertically or horizontally along the rulers 

or over any part of the Photo & Graphic Designer 

editing window. As you do, a dotted line will outline the 

new position. 

This also moves the grid origin so that divisions on the 

ruler always align with the grid. 

You can also move the zero point under the GRID & RULER tab (on page 547) of the 

Options dialog. 

Measurement units 

You can define the units in which to display measurements. The default display units are: 

 points (1/72 of an inch) for text and line widths. 

 centimeters for most measurements. 

You can enter dimensions in the other units by using a suffix or prefix (dependent on the 

unit type). For example, 2.5in for 2.5 inches. You can enter dimensions using two units. 

For example, 2pi 4pt for a dimension of 2 picas, 4 points. Note that units entered will be 

converted and displayed in your default unit. 

Millipoints 

A millipoint is 1/1,000th of a point (1/72,000th of an inch). All Photo & Graphic Designer 

measurements are stored internally in millipoints and then converted to the appropriate 

units when displayed. Dimensions other than millipoints are rounded if necessary. If you 

want to work in exact units without rounding, display measurements in millipoints. 

"Customizing Photo & Graphic Designer (on page 542)" has full details of the options 

dialog box. 
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Options dialog box 

Measurement units for the selected document are controlled by the Options dialog. 

Choose "UTILITIES -> OPTIONS" or right click a page and choose  "PAGE OPTIONS -> 

UNITS". 

Changing the default display units 

Display the options dialog box. If necessary, click the units tab. 

 

Font units are used for 

text sizes.  

Page units are used for 

other measurements. 

 

Creating a new unit 

You may want to specify measurements in units not provided as standard. For example, 

racecourses are measured in furlongs (220 yards). Or a financial diagram may use US$. 

Display the OPTIONS dialog box. If necessary, click the UNITS tab. 

1. NEW UNIT. The unit properties window will appear: 

2. Type in the unit name (e.g. US dollars). This name appears in menus. 

3. Type in the ABBREVIATION ($). This is used when entering or displaying the units. 

4. PREFIX ($xxxx) or SUFFIX (xxxx$ ) as appropriate. Photo & Graphic 

Designer must be able to relate the new unit to an existing unit. Type the 

relationship into the "IS EQUIVALENT TO" field. For example, if you had used 

furlongs, then 1 furlong is equivalent to 220 yards. 

 
 

For units that do not relate to distance (for example US$), type in an appropriate scaling 

factor. For example, 10US$ as equivalent to 10 millimeters. 

Deleting a unit 

You can only delete a unit you have created, not a standard unit. 
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Display the OPTIONS dialog box. If necessary, click the UNITS tab. 

1. Choose the unit you want to delete from the UNIT DEFINITION list. 

2. Click DELETE UNIT. 

Applying a scaling factor 

For example, you may want to specify dimensions in kilometers when drawing a map. 

You can apply a 1:10,000 scaling factor to kilometers. A line 10cm long on the map is 

reported as a dimension of 1km. 

 

1. ilities -> Options". If necessary, click the SCALING tab. 

2. Select USE SCALE FACTOR. 

3.  

Alternatively, type 1 into the drawing field and 10,000 into the real-world field. 

Deleting a scaling factor 

This is similar to applying scaling: 

1. Choose "Utilities -> Options". If necessary, click the SCALING tab. 

2. Deselect "USE SCALE FACTOR". 

3. Click "OK". 

Decimal point & thousands separator characters 

The characters used as a decimal point (1.23) and as a thousands separator (1,000) are 

those set in the Windows Control Panel. (In Windows XP, the relevant section is the 

"Regional and Language options".) 

Similarly, the number of digits following the decimal point is also set in "Regional and 

Language options". 
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View quality slider 

 

This slider (on the STANDARD control 

bar) affects how the document 

appears on the screen. It has no 

effect on the actual document or on 

printing. 

There are 5 different quality settings: 

 
OUTLINE MODE ONLY. This is now fully anti-aliased for higher quality screen display. 

 OUTLINE MODE WITH BLEND STEPS. 

 
FULL COLOR (no anti-aliasing). 

 
HIGH QUALITY (full anti-aliasing and image smoothing) 

 
VERY HIGH QUALITY Bi-cubic photo display considerably improves the quality of 

scaled down photos. 

The default quality level is VERY HIGH QUALITY which means the document is displayed 

on screen exactly as it will be printed (except that the monitor is lower resolution than a 

printer.) Anti-aliasing gives a much smoother and more accurate screen display, 

especially when displaying small details. However, one of the consequences is that 

sometimes objects can look slightly blurred. 

FULL COLOR shows the document colored, but with anti-aliasing turned off. 

On the OUTLINE MODE setting only the outlines of the shapes appear (they are drawn as 

wire frames). This makes it easier to select objects hidden behind other objects. 

OUTLINE WITH BLEND STEPS is particularly useful for seeing outlines of the various steps 

of a blend. 

 

You can also change these settings with "WINDOW -> 

QUALITY". There are toolbar buttons available for the five 

quality settings on the Window toolbar (on page 561). 

Refer to "Blends (on page 346)" for more on how the quality setting affects the display of 

blends. 

The constrain key 

The "Ctrl" key has a special function in Photo & Graphic Designer. It constrains the 

action of the current operation in some way. For example, normally you can rotate an 

object to any angle. But in Photo & Graphic Designer,if you hold down "Ctrl" while you 

rotate an object, the rotation is constrained to a subset of the possible angles. By default 

the object will rotate only to multiples of 45 degrees plus any rotations where a significant 

straight edge in the object becomes vertical or horizontal.  
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The black line on the left can be rotated to 

any angle within the circle. On the right is 

the same line, but with "Ctrl" held down it 

can only be rotated to the positions 

indicated. 

Similarly, constraining a rectangle creates a perfect square and constraining an ellipse 

creates a perfect circle. Release "Ctrl", and they will not be constrained. 

The constrain angle feature is defined in "FILE" > "PAGE OPTIONS" > "GENERAL" > "ANGLE 

CONSTRAINT (ON PAGE 546)" 

Galleries 

Xara Photo & Graphic Designer uses galleries to provide convenient access to external 

libraries of content like templates, fonts, colors, clip-art, line attributes, and 

bitmaps/photos.  This section of the manual gives general information on features which 

are common to multiple galleries. Individual sections of this manual describe  features 

specific to a particular gallery. 

When you create a new Photo & Graphic Designer document, the following gallery tabs 

are displayed in the gallery bar to the right of the workspace in the following default 

order. 

 

 
Local Designs 

 
Page & Layer 

 
Animation Frame 

 
Bitmap 

 
Line 

 
Fill 

 
Font 

 
Color 

 
Name 

Note: The ANIMATION FRAME gallery is only displayed in animation documents. When you 

open an animation document, the ANIMATION FRAME gallery is displayed already open on 

the right of the workspace. 

Some galleries display objects held in libraries external to the document: 
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FONTS, LOCAL DESIGNS, FILL. 

Other galleries relate to objects in the document, or options for those objects in the 

document: 

COLOR, BITMAP, LINE, PAGE & LAYER, NAME. 

Displaying a gallery 

To display a gallery: 

1. Click or hover the mouse pointer over the vertical tab for the gallery to the right of 

the workspace (the gallery bar). The gallery opens automatically. When you move 

the mouse pointer away from the gallery, it automatically closes. 

2. To keep a gallery open while you work, click the Auto Hide (pin) button in its top 

right corner.  The Auto Hide button changes so the pin points downwards to indicate 

that the gallery is now ‘pinned’ to the workspace.  

 

Unpinned: gallery closes when you move the mouse pointer away from the 

gallery. 

 

Pinned: gallery stays open when you move the mouse pointer away, and can 

also be moved and docked (on page 76) elsewhere. 

Note: By default the Line, Fill, Fonts, Color and Name Gallery do not display their title, 

just their individual icons, until they have been opened. Photo & Graphic Designer always 

displays the title of the last gallery that you have viewed. 
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Moving and docking a gallery 

You can ‘detach’ any gallery from the gallery bar and move it to a more convenient 

location anywhere in the workspace. You can also dock the gallery (or a gallery group, 

see Grouping Galleries) in the top, bottom, left or right of the workspace. 

 

You can move a gallery anywhere in the workspace 

To move a gallery: 

1. Open a gallery and click the Auto Hide button to pin the gallery. The button changes 

to a downward-pointing pin to indicate that the gallery can be moved and pinned 

elsewhere.  

2. Click and drag on the gallery’s title bar to move it around. You can either leave the 

gallery ‘free floating’ anywhere in the workspace or dock it in a new location. 

If you move any of the following galleries, the others accompany it as a group. 

 Bitmap 

 Line 

 Fill 

 Font 

 Color  

 Name 

 Access an individual gallery by clicking its tab at the bottom of the group or click and 

drag a gallery tab to move it away from the group. 
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When you click and drag on an dockable gallery’s open title bar, a number of arrows 

appear on the workspace, indicating where you can dock the gallery.  
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Dragging a gallery causes docking arrows to appear in the center, top, bottom, left and right of 
the workspace. Dock the gallery by dragging it to an arrow. 

 

Example of a gallery that has been docked to the left of the workspace 

To dock a gallery: 

1. Click and drag the gallery to the arrow pointing towards the location where you want 

to place the gallery. For example, if you want the gallery at the top of the screen, 

move it to the upward pointing arrow at the top of the workspace. 

2. When the mouse pointer reaches the arrow, a gray transparent box highlights the 

gallery’s new location.  

3. Let go of the mouse button to dock the gallery. Now when you close or ‘auto hide’ 

the gallery, its tab will be displayed in the new location. 

4. Hover over or click its tab to reopen the gallery.  

Note: To move all galleries back to their default position, choose CONTROL BARS from the 

WINDOW menu, click GALLERIES then RESET. 

Using galleries 

To fold or unfold a section in a gallery: 

 Click the FOLD/UNFOLD icon. 

 Or double click the title strip. 
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 Or right click a section to display a pop-up menu. Select FOLD/UNFOLD section. The 

pop-up menu also has options to scroll to the previous section or next section. 

 

This illustration shows the gallery is unfolded. Other galleries are similar. 

The buttons along the top depend on the gallery (e.g. FILL and TRANSP are specific to the 

BITMAP GALLERY.) However, most galleries have these buttons: 

APPLY applies the selected item in the gallery. Click on an item to select it. 

MORE opens a menu from which you can choose from the following: 

 FIND is described later in searching for an item name. 

 SORT is described later in re-ordering items in a gallery. 

 PROPERTIES provides control over size of the icons and amount of information 

displayed in the gallery. 
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 ADD (clipart, fill, and fonts galleries) is described later in adding to a gallery. 

 REMOVE (clipart, fill, and fonts galleries) is described later in deleting sections from a 

gallery. 

Selecting items 

To select an item: 

 Click an item to select it. 

 Or click an item, then "Shift + click" on another item; all items in between the two 

points will be selected. 

 Or "Ctrl + click" to add that item to the selection. 

Re-ordering items in the gallery 

In some galleries, "MORE" > "SORT" opens a dialog box. You can sort by name and, 

depending on the gallery, by other criteria. The primary key controls the initial sort. For 

some sort parameters such as file type or name length, there may be two or more files 

with the same type or name length. These files can be further sorted using the secondary 

key. 

Searching for an item name 

You can search, for example, for all names containing the word red: 

 

1. Choose "MORE" > "FIND". 

2. Type "red" into the text box. 

3. Select "SEARCH NAMES & KEYWORDS" to search 

only the item names, e.g. file, color, etc., or 

"SEARCH ALL INFORMATION" to search the names 

and keywords available in some galleries. 

 

Adding to a gallery 

You may want to add extra items to these galleries (LOCAL DESIGNS, FILL & FONTS 

galleries only). To do this: 

4. Copy the files you want to add into a new directory (folder) using the Windows 

Explorer. 

- For the LOCAL DESIGNS GALLERY these files can be any of a wide range of 

vector or bitmap file types. 

- For the FILL GALLERY they can be any of the bitmap formats supported by Photo 

& Graphic Designer (listed in importing and exporting (on page 505)). 

- For the FONTS GALLERY they can be Adobe Type 1 or TrueType fonts. 

5. In the appropriate gallery, click the "DISC DESIGNS/FILLS/FONTS" button. This opens 

a dialog box. 

6. Use the dialog box to select the directory you want to add. 

7. Click "ADD". This creates a new section in the gallery. 
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If you later want to add more items to the folder: 

1. Copy the new files into the existing folder. 

2. In the gallery, click "DISC DESIGNS/FILLS/FONTS". This opens a dialog box. 

3. Use the dialog box to select the folder you want to add. 

4. Click "UPDATE" to update the section in the gallery. 

Deleting sections from a gallery 

To delete a section from a gallery (CLIPART, FILL & FONTS galleries only): 

1. Click on the title strip of the section or sections you want to delete. 

2. REMOVE". 

If you later want the section again, add its folder to the gallery (described earlier). 

Moving content from previous versions of Xara Photo & Graphic 

Designer 

Sometimes when Xara Photo & Graphic Designer is updated from one version to 

another, some content is dropped from the Designs Gallery to make space for new 

content. If you discover that some content you liked and used is missing from the latest 

version of the program, you can import it from an installation of an earlier version. 

Designs Gallery content is installed into the "Clipart" folder of the main program folder. 

Eg. C:\Program Files\Xara\Xara Photo & Graphic Designer\Clipart\ 

The sub-folder names inside the Clipart folder loosely correspond to the names of the 

categories as they appear in the Designs Gallery.  

So before uninstalling an older version of the program, you may want to copy out some 

of the Designs Gallery content and then add to the Designs Gallery in the latest version 

of the program. Follow these steps:- 

1. Identify the location of the old Clipart folder and the decide which sub-folders inside 

it you want to keep. 

2. Copy the sub-folders to a convenient location on your machine.  

3. Select the "Disc designs…" button in the Designs Gallery and in the dialog that 

appears navigate to the sub-folder. If you want to add the "food" folder for example, 

you need to navigate right into the food folder, before clicking Add in the dialog. 

4. All the items in the folder are added to a new category in your gallery. Repeat the 

above process for each folder of content that you want to add. 

5. Once you’ve copied out all the folders you want and have added them to your 

Designs Gallery, you can uninstall the old version of the program if it is no longer 

required. 

You can following a similar process to that above to copy fills and fonts from previous 

versions to the Fill and Font galleries. Fills are installed into a "Fills" folder in the program 

folder and fonts in a "Fonts" folder. 
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Naming objects 

 

You can apply names to any object in Xara Photo & Graphic Designer using the 

“Apply, remove or inspect names of objects” button on the SELECTOR TOOL 

InfoBar. Alternatively right click an object and choose NAMES from the drop-down 

list. 

Naming is a general mechanism which has a variety of uses, some of which are 

described below. Most commonly names are used to form loose sets of objects. 

Example uses of names 

 Record information about the objects, e.g. what they are used for; 

 Select the objects. This is particularly useful if the objects are widely separated in the 

drawing or in a complicated drawing. One click and you can select just those objects 

that share a name; 

 Selectively export parts of the document. This is particularly useful for web pages with 

complex graphics, which are often split into "slices" (or small parts) on the web page; 

 For linked stretching where one named object can automatically stretch another 

named object. For example, changing the text on a button can automatically change 

the width of the button. 

 Animations - names are used in animations to mark objects which are to be tweened 

by the  exporter. See the Animations chapter (on page 459) for full details. 

 

This dialog is modeless, so you can change the selection while the dialog is displayed. It 

shows the names for the current selection. The text field at the top of the dialog shows 

you how many objects are currently selected. 
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Adding names 

To add a name to an object, select the object and open the NAMES dialog using the 

button on the SELECTOR TOOL InfoBar or right click on the object and choose NAMES... 

Type the new name into the APPLY NAME field, or use the drop down list on the same 

field to select a name which is already used elsewhere in the current document. Click 

ADD. You should see the name appear in the NAMES APPLIED list. 

Names applied 

The NAMES APPLIED field shows you the names applied to the current selection. If more 

than one object is selected, a list of names is only shown if all objects in the selection 

have exactly the same set of names applied. Otherwise “<many>” is displayed, indicating 

that there are differences in terms of the names applied to different objects in the 

selection. 

To remove a name from the selected object(s), click the name in the NAMES APPLIED list 

to select it and then click the REMOVE button. 

The Name Gallery 

The NAME GALLERY gives you information about the current document, and is an easy 

way to manage the various elements of your document. It lists: 

 Names – you can name objects using either the NAME GALLERY or the NAMES DIALOG 

(via NAMES BUTTON in the SELECTOR TOOL). 

 Fonts used – if you have text in your document, then the used fonts will be listed. 

 Bitmaps used  – a list of bitmaps currently used. 

 Colors used – The USED COLORS section of the NAME GALLERY lists the colors used. 

 Styles used – Use this section of the gallery to select text on the current page that 

uses a given style. 

Note: In the case of multi-page documents, the Name Gallery lists the items usage by 

the current page. All Names are shown anyway, because a Name can be present in the 

document without actually using it. In the case a Name is not applied to an object on the 

page, the little selection circle (see below) is not present before the Name. 

To display the NAME GALLERY: 

 Choose "UTILITIES -> NAME GALLERY" ("Ctrl + Shift + F9"), 
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 Or click the NAME GALLERY button on the GALLERIES bar. 

 

 

With the commands on the buttons you manipulate names, for some commands to work, 

a name, a property like color or font and/or an object has to be selected: 

 APPLY is used to give names to objects. 

 NEW opens the NAMES dialog (on page 82) to apply a new or existing name to the 

selected object(s). 

 DELETE deletes a name from the NAME GALLERY and from any objects using that 

name. 

 INTERSECT selects the objects that have all the selected items (name, font, bitmap or 

color). 

 REMOVE deletes a name from any objects using that name, but does not delete it from 

the NAME GALLERY. 

 RENAME changes the name shown in the NAME GALLERY. 

 REDEFINE changes which objects use a name. 

 MORE reveals some more options: 
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- SELECT selects (in the document) the objects that have any of the selected items 

(name, font, style, bitmap or color). 

- EXPORT exports the selected named objects. 

- HELP shows the according help article  

Exports, slices, and stretches properties 

 
In this list box you can select which property of the used names are 

shown in the Name Gallery. 
 

Exports 

 

These options are used when exporting graphics as a series of slices (on page 516) and 

for batch exporting. 

A click on the arrow displays a dialog box that lets you select the file name, destination 

folder  and file format to export in. By default the file name is the same as the name in 

the Name Gallery. Note that clicking "APPLY" just stores the selected options, and that it 

doesn't save a bitmap; do this by exporting the image with the MORE  > EXPORT option. 

 (Extension displayed depends on the file format chosen.) Click the box to open the 

"Export dialog (on page 534)" to specify more details. Click "APPLY" to store the 

selected options. 

 

Slices 
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When you choose the SLICES check box those named objects slice underlying objects. 

For more information on image slicing read Image slicing (on page 516)  

Note: When exporting images as slices, the chosen destination folder from the exports 

property is ignored. All the sliced graphics must be in the same folder, and the 

destination folder is that selected for the HTML file when you export the slices. 

Stretches 

You can use named objects to stretch other named objects, e.g. the text on a button. 

Both the text and the button are named objects, with the text flagged as stretching the 

button. When you change the length of the text (for example by typing in more 

characters), the button automatically resizes to match. 

When you choose STRETCHES properties, a check box to the right of object names shows 

those objects you want to stretch. The arrow to the right of the check box shows if the 

stretching options are set up (solid arrow) or not (hollow arrow). Click the arrow to display 

the EXTEND DIALOG BOX which lets you select those objects from the list of named objects 

to control the stretching. For each direction you can select if the size changes in the 

same direction as the controlling object (EXTEND) or equally from the center (SCALE). 

Selecting objects using the Name Gallery 

You can use the Name Gallery to select objects that use any of the items (names, 

bitmaps, colors, or fonts) listed in the gallery. This can speed up making changes, e.g. 

you want to change from one named color to another. 

 



 

Document handling 87  
 
 

 

 
Select objects that use any of the chosen items in the Name Gallery 

 
Select objects that use all of the chosen items in the Name Gallery 

 
Click circles to chose items 

 
Currently chosen 

 

Undo and Redo 

What are undo and redo? 

We all make mistakes or change our minds. Photo & Graphic Designer makes it easy to 

correct mistakes or cancel unwanted changes. Every action you make is recorded in an 

undo list which lets you undo not just the last operation, but also to step back by undoing 

successive operations. In this way, you can experiment freely knowing that you can 

always undo anything that doesn‘t look correct. 

The undo command 

 

"UNDO" cancels the effects of the last operation. To undo an operation: 

 Click UNDO on the standard control bar. 

 Or choose "EDIT" > "UNDO" (the exact wording tells you what the next undo step is, i.e. 

undo scale). 

 Or press "Ctrl + Z". 

 Or press the comma key (in any tool except the TEXTTOOL). 

You can repeat the undo command to step back through the sequence of previous 

operations. 

The redo command 

 

Redo cancels the last undo command. To redo the last operation: 

 Click the REDO button on the standard control bar. 

 Or choose "EDIT" > "REDO" (the exact wording tells you what the next redo step is, i.e. 

redo scale). 

 Or press "Ctrl + Y". 

 Or press the period (full stop) key (in any tool except the TEXTTOOL). 

You can only redo immediately after undo. You cannot redo after changing the document 

(for example, by moving or adding an object). 

Changing the size of the undo list 

By default the size of the undo list is set to 100MB, You can change this value, or make 

the list size unlimited (or limited only by available memory on your computer). 
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To change the list size: 

 

1. Choose "UTILITIES -> OPTIONS". 

2. Select the "TUNE UPS" tab. 

3. Select a "LIMITED" undo size. 

4. Type in the required value followed by 

- "M" or "m" for a value in megabytes (4M). 

- "K" or "k" for a value in kilobytes (200K). 

- Or no suffix for a value in bytes (3000). 

- Values can include decimal points (1.234M). 

- The list has a minimum size of 1024 bytes (1K). 

- Click either: 

- "OK" to make the change and close the dialog box, 

- Or "APPLY NOW" to make the change but leave the dialog box on screen. This 

lets you make further changes. 

If the new undo list size is less than its current size you are warned that data will be lost 

from the undo list. Then in future, as the list becomes full, the oldest information is 

automatically discarded. 

Copying & Pasting between Xara Photo & Graphic Designer 

and other programs 

When you copy any object, vector graphics object, text or photo, it's made available to 

the system-wide clipboard, so that pasting into another application will usually paste the 

selected object into the other applications. 

However since each program treats the clipboard differently, and some programs provide 

a greater degree of control over the pasted contents, you may get different results in 

different programs. 

Microsoft Outlook 2003 

This pastes an image of the clipboard into your email, and cleverly converts it to a 

compressed JPEG in order to reduce the size of the email. This works very well and 

means you can simply copy any drawing, selection or image and paste directly into your 

email and it will appear exactly the same size as in Xara Photo & Graphic Designer (at 

100% zoom) and is automatically optimized for sending in an email. 

When copying only text from Xara Photo & Graphic Designer, this is pasted in accurately 

including formatting such as font changes, italic and bold. 
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Drawing Lines and Shapes 

The Drawing tools 

 

You can use any of these tools to draw lines and shapes: 

 The FREEHAND & BRUSHTOOL ("F3"). 

 The STRAIGHT LINE & ARROW TOOL 

 The SHAPE TOOL ("F4"). 

 The SHAPE PAINTERTOOL 

The FREEHAND & BRUSHTOOL is the easiest way to draw simple lines, curves, and 

shapes, and it acts rather like a pencil. 

The STRAIGHT LINE & ARROW TOOL is best if you want to draw single segment straight 

lines, or add arrow heads and tails to any types of lines. 

The SHAPE TOOL is best for drawing precise curves and lines. It is also the main tool to 

edit lines and shapes. 

The SHAPE PAINTER TOOL allows you to draw new shapes, or extend existing shapes, by 

‘painting’ on the page with a round or elliptical ‘nib’.  

 

Note: Although it is not in the Drawing Tools toolbar, you can also use the PEN 

TOOL to create precise shapes. It has limited functionality and works like the line 

tool of other drawing programs. To use the PEN TOOL, choose CONTROL BARS 

from the WINDOW menu and click the BUTTON PALETTE checkbox. Then click the 

PEN TOOL icon in the Button Palette.  

 

The Freehand & Brush Tool 

 

You can use this tool to draw in a freehand manner, as you would with a pencil. 

It can also be used to create brush strokes described below. And it includes the 

option to draw variable width lines using a compatible pressure sensitive drawing 

device such as a graphics tablet. While using this tool the status line provides 

reminders on how to use the tool. 

1. Position the pointer where you want the line to start. 

2. Press and hold down the mouse button. (or draw with your graphics tablet or other 

connected device). 

3. As you drag the pointer around the document, your line is drawn in real time. 

4. Release the mouse button to terminate the line.  
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Smoothing  Re-fit Indicator 

After you’ve drawn a freehand line you 

can control how smooth the curve is (i.e. 

how many control points) by adjusting the 

smoothing control slider on the InfoBar. 

Low values make the line follow your mouse movement more closely by creating more 

control points, and higher values produce smoother curves with fewer control points. 

 

Low values are less smooth  

 

Higher values produce a smoother curve 

You can change the smoothing at any time until you make further edits to the line (the re-

fit indicator on the InfoBar tells you when you can still change the smoothing.) 

Erasing while drawing 

Before you release the mouse button you can erase part of the line by holding "Shift".  

 

The pencil icon reverses so the eraser at 

the end is downwards. You can now 

erase back along the line. Release "Shift” 

and you can continue drawing. 

 

Drawing straight segments in the Freehand Tool 

While drawing a freehand line hold down "Alt", move the pointer to a new position and 

release "Alt" to draw a straight line. You can continue drawing a line or hold down "Alt" 

again to draw another straight segment. Remember, you can use "Ctrl" to constrain the 

angle of the line. If you only want to draw lots of single segment straight lines, use the 

STRAIGHT LINE TOOL described below. 

Extending a line 

Make sure the line is selected (a single click on the shape or line in the FREEHAND & 

BRUSH TOOL will do this). Now if you move over the end of the line, a small + sign next to 

the pencil icon will indicate you can just draw to add a new freehand section to the line. 

Joining two lines 

Select both lines, ("Shift + click" on the second line to add it to the selection) and you can 

now just draw from the end of one line to an end of the other. A small + sign next to the 

pencil icon (appearing after a pause) indicates you are over the end. 
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Closing a freehand shape (to create a filled shape) 

You can directly create a closed shape by ending a line back at the beginning over the 

start handle. A "+"  by the pointer shows when it is positioned over the start handle.  

You can now alter the fill color by dragging colors from the Color Line or using the Color 

Editor (on page 210). 

Editing lines/shapes with the Freehand & Brush Tool  

You cannot directly modify shapes created by the QuickShape, Rectangle, or Ellipse 

Tools. First convert them to editable shapes using "ARRANGE" > "CONVERT TO EDITABLE 

SHAPES". See "Shape handling (on page 191)" for more information. 

You can use the FREEHAND & BRUSHTOOL TO EDIT LINES (OR OUTLINES OF SHAPES) BY 

SIMPLY REDRAWING THE SECTION OF LINE YOU WANT TO REPLACE. FOR EXAMPLE: 

To edit the object: 

Select the object that you wish to edit. 

 

Move the freehand pencil over a part of the line. A ~ shows when 

the pencil is in position. 

 

Draw the required line, then move the freehand pencil over to the 

second point of the existing line. Again, a ~ shows when the 

pencil is in position. 

 

Release the mouse button, and the section of line is replaced. 

 

 

Sketch Mode 

  

Located on the InfoBar this option is useful if you are rapidly sketching lots of 

separate lines close to each other, perhaps using a drawing tablet. 
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Hold the mouse pointer over an existing line, or end point, and you’ll notice that there is a 

short pause before the mouse pointer changes to indicate that the line will be edited or 

extended. This pause means you can still edit existing lines if you want, but you won’t do 

so unintentionally when you actually mean to sketch new lines. 

Pressure sensitive drawing 

 

Xara Photo & Graphic Designer supports pressure sensitive drawing using a 

compatible tablet device that supports pressure sensitivity. This option is located 

on the InfoBar. 

Most modern tablets should be compatible. This allows you to draw variable width 

strokes  - the more pressure you apply the wider the stroke. 

 

High Pressure Low Pressure 

To draw a variable width stroke using your tablet: 

1. Enable pressure sensitive drawing by pressing the ENABLE/DISABLE PRESSURE 

RECORDING button on the Freehand tool InfoBar. 

2. Clear the current selection (click an empty part of the canvas, or press Escape). 

3. Choose a suitable line width from the line width dropdown list on the top bar. The 

width you select will be the width of the line that is drawn when you are applying 

maximum pressure. 

4. An alert appears asking if you want to make the selected line width the default for 

new objects. Press the Set button to confirm. 

5. Start drawing using your tablet device. Vary the pressure as you draw to vary the 

line width accordingly. 

There is a special entry in the stroke shape dropdown list on the InfoBar entitled 

"Pressure" to indicate that the selected line has a custom profile. To convert a pressure-

drawn line into an ordinary stroke simply choose an alternative stroke profile from the list. 

This deletes all the pressure data that was recorded for the stroke. 

Brush styles 

The FREEHAND & BRUSH TOOL can also be used to apply different brush stroke styles 

along the path of the line. Instead of being a solid, fixed-width line, you can change it to 

be a variable-width line, or one of a huge range of fancy brush styles, like airbrush, felt tip 

marker, and many more. See Brushes (on page 109) for more details. 

The Straight Line & Arrow tool 
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This tool makes it easy to draw single segment straight lines and to add arrow heads and 

tails to any lines in a way that is much easier and more powerful than doing the same 

thing with the LINE GALLERY (on page 107).  

Why a straight line tool? 

Prior to the addition of this simple tool, many users new to Xara Photo & Graphic 

Designer had great difficulty doing something as simple as drawing a straight line using 

the other drawing tools! That’s because the SHAPE EDITOR is more geared to drawing 

multi-segment lines and shapes and the FREEHAND TOOL to drawing freehand.  

Hence the need for this tool, which makes it obvious how to do something elementary. 

Drawing & editing straight lines 

Simply click and drag on the page to draw a straight line. You can click on any existing 

line to select it, and once selected you can click-drag on either end to move the end of 

the line around. 

Adding arrowheads & tails 

The InfoBar has two dropdown lists on the left which allow you to choose an arrow head 

or tail style for each end of the selected line.  

 

 
Arrow head 

 
Arrow tail 

 
Arrow head/tail size 

 
Reverse path 

The slider on the InfoBar allows you to change the size of the arrow head and tail on the 

current selected line. Or you can enter a percentage value into the size text field to the 

right of the slider.  

Enter a value less than 100% to reduce the size of the arrowhead (and tail), or greater 

than 100% to increase. Although the slider only takes the size value up to a maximum of 

800%, you can enter percentage values larger than this into the size text field. 

Reverse path 

 

Press the REVERSE PATH button on the InfoBar to switch around the head and tail 

of the selected line. 

 

Adding more line segments 

Lines created with the STRAIGHT LINE TOOL are of course fully compatible with the other 

drawing tools. So if you want to add more segments to a line, make it curved, or perhaps 

even turn it into a closed shape, use the SHAPE EDITOR TOOL. 
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Shape Painter tool 

 

This tool enables you to ‘paint’ onto an existing shape to enlarge it, add new areas or 

adjust the shape or outline. It does this in a vector way, and is much more direct and 

often easier way than using the vector SHAPE TOOL. You can adjust the size of the ‘nib’ 

as well as its aspect ratio and rotation angle.  

If you use one of the liquify plugins you can also choose from a range of effects to adjust 

outlines of shapes, lines and rectangles. 

To use the tool in standard PAINT mode, simply select the tool from the DRAWING TOOL 

(on page 89) flyout menu. If a shape is already selected, or you click on a shape to select 

it, then strokes on the page will adjust the outline of the selected shape. If there is no 

shape selected, or you click on the background to clear the selection, then new strokes 

will create new shapes. 

If multiple shapes are selected the Painter tool will join them if the nib shape touches 

them during the drag. The resulting joined shape has the attributes of the topmost shape. 

Quickshapes are automatically converted to editable shapes if the nib touches them. 

The InfoBar for this tool provides controls over Nib size,the Roundness, Nib angle and 

the Softness, as well as a smoothing control which adjusts how accurately the nib follows 

your mouse movement (this is exactly like the Freehand tool smoothness control). 
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Nib Size - fixed or zoomed, plus nib size control slider  

 
Nib Roundness, Angle and Softness settings sliders 

 
Edge Softness - set a profile to control the softness at the nib edge 

 
Smoothing - adjusts how accurately the nib follows the mouse 

movements 

 
Enable/disable pressure sensitive drawing device (if attached) 

 
Liquify Plugins dropdown menu.  

Nib Size 

Control the nib size by dragging the slider. Use the Size button to control whether the nib 

size zooms in when you zoom into the page or stays the same size. If you keep the nib 

size the same then it effectively becomes smaller relative to the objects on the page 

allowing you to erase smaller details.  

You can also conveniently adjust the nib size by holding down the Alt key and using the 

mouse wheel.  

Note: this tool only works in a vector way (i.e. editing the shape vector outline) if the 

softness control is set to zero. If the softness setting is anything other than zero, then this 

will always add a new feathered shape to the page. 

Note: This tool can be used on Photos, but it’s only useful to enlarge an already edited or 

cropped photo outline. 

Note: The softness control is really just changing the Feather value applied to the stroke, 

and you can adjust the softness afterwards using the Feather slider (on page 138). 

Liquify Plugins 

The Liquify plugins, accessed from the dropdown menu on the InfoBar allow you to use a 

wide range of effects to modify the outlines of simple shapes, lines and rectangles. The 

plugins allow you to do this in an intuitive and painterly way without having to think about 

individual control points and curve handles as you would with the Shape Tool.  
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The plugins take on the roundness, angle and softness settings of the nib and sit 

beneath the main PAINT setting.  

 

Line (left) modified by the Warp fast Liquify plugin (right) 

Select a plugin, and then just slowly drag the nib over the edge of your line or shape to 

see it in action.  

The Shape Tool 

 

The SHAPE TOOL is the main tool used for both creating precise curves, lines, 

and shapes, as well as editing or altering lines and shapes.  

 

 
Add/Change/Edit Indicator 

 
Make curve 

 
Make line 

 
Smooth join 

 
Sharp join 

 
Break at points 

 
Delete points 

 
Reverse paths 

 
Positions of handles 

 
Smoothing 

The InfoBar, shown above, provides a wide range of controls as well as precise numeric 

control. 

All lines and shapes in Xara Photo & Graphic Designer are made from a sequence of 

curve and line sections. Curves are sometimes called "Bézier" curves after the 

mathematician who first described them. 
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Although this section describes the SHAPE TOOL, you 

can also edit lines and shapes using the SELECTORTOOL 

if you have the SHOW EDIT OBJECT handles button 

selected on the SELECTORTOOL InfoBar. 

 

The sections or segments of a line are marked by small black point handles. You can 

drag, add and delete these handles to manipulate the shape of the line or outline. 

Some objects such as quickshapes, rectangles, ellipses, and text have to be converted 

into editable shapes before you can use the SHAPE TOOL on them. Select the "ARRANGE" 

> "CONVERT TO EDITABLE SHAPE" menu ("Ctrl + Shift + S") to do this. 

To draw a straight line segment 

Using the SHAPE TOOL, start a straight line: 

1. 
have to work left to right, or top-to-bottom. This creates a point handle, and is 

displayed as a red square to indicate that it is the selected handle. 

2. MAKE LINE button on the InfoBar ("L"). This ensures the 

next click will draw a straight line segment. 

 

 

Either click where you want the next point 

handle to be, or click and drag, and then 

release the mouse button when the line is 

correct. This creates a line segment and 

selects the new end point handle. 

 

Mixing curved and straight lines 

To create an object which is a mixture of straight and curved segments, just switch 

between the MAKE CURVE and MAKE LINE buttons as you create the object (you can also 

press "L" or "C" on the keyboard.) 
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Note: You can also use the keyboard shortcut "X" to create a Cusp Join or "S" to create 

a Smooth Join while using the SHAPE TOOL. These affect the way two line segments 

come together. A Cusp Join creates 2 independent Bezier control handles that you can 

edit separately. With a cusp join, you can create a sharp angle. A Smooth Join creates a 

symmetrical join that works like a see saw. If you drag one Bezier control handle down, 

the opposing control handle goes up. 

To draw a curved line segment: 

 

This is similar to starting a straight line (described above). 

1. Click where you want to start the line. 

2. If necessary select the MAKE CURVE button (shortcut "C".) 

3. Either click or drag (as described for straight lines) to create a second point handle, 

and a curve segment will be added to the line. 

 

A curve segment has CURVE HANDLES associated with 

the selected point handle. You can drag these to 

adjust the angle and radius of the curve. 

 

Extending the line 

Make sure an end point handle is the selected handle (red outline) and then just click 

again to add a new line or curve section.  Each successive click places a new point 

handle and draws a new line segment to the selected point handle. 

Finishing the line 

Shift + click completes the line (keeps it selected), or press "Esc" to finish the line and 

de-select it.  After this, additional clicks will start a new line. 

This applies also to SHAPE EDITOR and PEN TOOLS. To use the PEN TOOL, choose 

CONTROL BARS from the WINDOW menu and click the BUTTON PALETTE checkbox, or press 

"Shift + F5" on your keyboard. 
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Adding a new point handle 

The SHAPE TOOL has three modes, depending on whether no point handles are selected 

(a click will start a new line), an end handle is selected (a click will add a new section), or 

one or more other point handles are selected (you can drag or change the handles).  

The InfoBar shows the current mode. 

 

 NEW: Click to start a new line, 

 ADD: Click to extend the line, 

 CHANGE: Drag or delete point handles to change. 

This applies to the SHAPE TOOL only. 

To the end of a line: 

Make sure the line is selected, then: 

1. If necessary, click on the end point to 

select it. 

2. Position the pointer and click to add 

a new section. 

 

 

To the middle of a line: 

Make sure the line is selected, then; 

1. Click on the line to add a new point handle 

into the line 

2. Drag the point handle to the required position. 

 

 

To the start of a line: 

If the end point is selected, clicking on the start point closes the shape (this is described 

in "Closing a shape” ). To add a new control handle to the start of a line: 

1. Finish the line using "Shift + click". 

2. Click on the start handle. 

3. Position the pointer and click. 

Selecting multiple point handles 

You may want to select several point handles to delete them, move them as a group, or 

change a region of points to curved or straight lines. To do this: 

1. Select one point handle in the normal way by clicking on it. 

2. "Shift + click" the other point handles to select them ("Shift + click" also deselects.) 
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- Or "Ctrl + Shift + click" on a point handle to select all point handles on the line. 

- Or drag the mouse pointer diagonally to create a selection rectangle. All point 

handles in the rectangle are selected. 

- Or "Shift + drag" diagonally to create a selection rectangle. This adds all points 

within the rectangle to those already selected. 

3. If the line has one or more selected point handles: 

- End moves the selection to the end of the line. 

- Home moves the selection to the start of the line. 

- Tab moves the selection to the next point handle towards the end. 

- "Shift + Tab" moves the selection to the next point handle towards the start. 

The start and end points are significant when applying arrows (on page 107). 

Selector Tool 

 

You have limited shape editing abilities using the SELECTOR Tool if 

you have the SHOW OBJECT EDIT HANDLES button selected. 

 

Deleting points 

 

Select the point handle(s) as described above and either click the 

DELETE POINTS button (SHAPE TOOL InfoBar), or press "Del". 

 

Moving point handles—Shape Editor Tool 

 

You can move one or more selected handles: 

 Drag the handles using the mouse. 

 Or use the arrow keys on the keyboard. 

Or to move a single handle, type new values into the text boxes on the InfoBar (see 

below). 
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Using the text boxes on the InfoBar 

 

The center pair of text 

boxes always shows the 

X/Y co-ordinates of the 

selected point. 

The surrounding X/Y fields show the co-ordinates of the curve handles on either side of 

the selected point. 

X/Y co-ordinates are relative to the bottom left corner of the page by default for print 

document and top left for web documents. You can change this in the Grid and ruler (on 

page 547) tab in the options dialog. 

If the selected point is on the end of a straight line section, the left fields show the length 

and angle of the line. You can adjust either by entering a new value and pressing return. 

 

 
Length and angle for straight line 

 
Position of selected point 

 
Position of curve handle 

 

Smoothing a line 

Imported shapes or shapes from tracers may have unnecessary points on a line. Lines 

with too many points can be unwieldy and can slow down rendering. Xara Photo & 

Graphic Designer can smooth the line to remove unnecessary points. 

 

Select all the points on the part of the line you want to smooth (see above). Drag 

selecting around the region in the SHAPE TOOL is probably the easiest way to select a 

large number of points. 
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Drag the smoothing slider on the end of the SHAPE 

TOOL InfoBar.  

 

Tip: to make sure important points are not deleted, make sure they are not selected 

("Shift + Click" on a selected point deselects it). 

Moving point handles—Selector Tool 

 

You can only select and move point handles when the SHOW EDIT 

HANDLES button is selected. 

 

Constraining the line 

 

When dragging a point handle, holding down the 

constrain key ("Ctrl") will constrain the movement to 

multiples of the constrain angle (controlled from the 

OPTIONS dialog, GENERAL tab). When dragging a curve 

handle the angle is constrained. 

 

Changing curves 

Using the curve handle 

Dragging the curve handle will adjust the curvature of the adjoining curve segments. 

 

Move the curve handle towards or away from the point 

handle to pull the curve in the required direction. 
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Dragging the line segment 

You can also change the curve by dragging the line segment between points. 

 

Notice the difference between dragging the line to change its shape, and clicking on the 

line to add a new point handle. Dragging a straight line segment changes it to a curved 

line segment. 

Making sharp corners 

Normally, Xara Photo & Graphic Designer draws a smooth curve through a point handle. 

For this, the two curve handles either side of a point handle are linked. Moving either 

curve handle also moves the other. 

Sometimes you will want a sharp corner, and to achieve this, you need to unlink the 

curve handles: 

1. Double click the point handle, 

2. Or select the point handle and either: 

 

Click the CUSP JOIN button, or press "Z". 

You can now move each curve handle independently. 

Making smooth curves 

To convert a sharp join into a smooth curve: 

1. Double click the point handle, 

2. Or select the point handle and either: 

 

Click the SMOOTH JOIN button, or "S". 

The two curve handles become linked and move to opposite sides of the point handle. 

This may change the shape of the curve. 
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Balancing curves 

Balancing makes the two curve handles the same distance from the point handle, which 

gives smoother, more symmetrical curves. To balance a curve, select the point handle, 

then drag one of the curve handles with "Shift" held down. As you drag one curve handle 

the other one will move to be exactly opposite it and the same distance from the point 

handle. 

Changing a straight line to a curve (and vice versa) 

1. Select the point handles at both ends of a line segment. For several line segments 

select all bordering point handles. 

2. Click the Make curve   or Make line  button on the InfoBar, or press "L" or "C" 

(these shortcuts only work in the Shape Tool). 

 

After changing the line type, you may need to move the curve handles for a smooth 

transition between curved and straight line segments. 

You can select several line segments and convert them all. The point handles at both 

ends of the segment must be selected. 

Joining lines 

You can only join lines if both are selected (the point handles are shown on both lines): 

Using the SELECTOR Tool, hold down "Shift" and click on the lines to select them (if you 

are already in theSHAPE EDITOR TOOL, YOU CAN PRESS "ALT + S" TO TEMPORARILY GO 

INTO THE SELECTOR TOOL, "SHIFT + CLICK" TO SELECT THE SECOND LINE, THEN "ALT + S" 

AGAIN TO RETURN TO THE SHAPE EDITOR TOOL). 

Selecting objects is described fully in "Selecting objects (on page 115)". 

Once both objects are selected, in the SHAPE EDITORTOOL or the PENTOOL, drag the end 

handle of one line over the end of the other line. As you drag the mouse pointer will show 

a + symbol to indicate that the lines will be joined.. 

 



 

Drawing Lines and Shapes 105  
 
 

 

If the ends of the two lines are already very close to each other (but not joined), then you 

can either zoom in or drag the end point away, and then back again so it’s over the end 

point, and you see the + sign to indicate a join will occur. 

To create a filled shape, drag the other two end handles together. Because you join the 

end handles, you can only join lines and not shapes. Shapes are closed objects and so 

have no end handles. 

There’s more information on this in "Shape handling (on page 169)". 

Notes: 

 To use the PEN TOOL, choose CONTROL BARS from the WINDOW menu and click the 

BUTTON PALETTE checkbox, or press "Shift + F5" on your keyboard. 

 You can also use the FREEHAND & BRUSHTOOL (described earlier) to join lines. 

 There is an ARRANGE > JOIN SHAPES menu option which joins two or more shapes into 

one single shape, even if they are separated on the page. This makes overlapping 

areas transparent. For example, joining an object with a smaller circle on top this way, 

produces an object with a circular hole in it. 

Splitting a shape 

If you want to split (break) a line or shape: Either select an existing point handle on the 

line or outline of the shape, or create a new one where you want to break the line. Just 

click on the line in the SHAPE TOOL(SEE ABOVE). 

Click on the BREAK AT POINTS button, or press "B". 

 

If you split a line, there is no visible change. However, if you move the point handle, then 

only part of the line moves. If you split a shape, it changes to being a line. Any fill 

disappears. 

Note: "Slice shapes" (part of "ARRANGE" > "COMBINE SHAPES") also lets you split shapes 

into two separate shapes. This is described in "Shape handling (on page 189)". 

Changing the line width (thickness) 

To change the line thickness or the outline thickness of a shape, first select the object or 

objects: 

Type a new line width into the text box on the STANDARD control bar or 

choose the default line thickness from the menu.  

Or position the mouse pointer over the edge of a line or shape, hold down Ctrl + Shift and 

use your mouse wheel to rapidly adjust the outline width. This works whether or not the 

line/shape is selected. 
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Line thickness is traditionally measured in points, abbreviated to pt. 1 point is 1/72nd of an 

inch (about 0.3mm), which is slightly less than the thickness of one screen pixel when 

viewed at 100% zoom. 

You can enter the thickness value in any unit, and Xara Photo & Graphic Designer will 

convert it to the correct number of Points. E.g. you can enter 0.5cm, and you will get a 

line half a centimeter thick, but it will show just over 14pt in the line width field. 

If you have no object selected and you change the line thickness value, this changes the 

default for all new lines. 

Note: A zero width line is a special case, and should not normally be used. This draws a 

line one device-pixel wide. The actual size will therefore depend on the device the 

drawing is displayed on. On a monitor screen one pixel is clearly visible and is never 

shown anti-aliased. On devices such as printers and particularly on image setters, which 

have a much higher resolution, the line is almost invisible (zero width lines in imported 

files are converted to 0.25pt). 

Variable width lines 

From the FREEHAND & BRUSH TOOL InfoBar you can select a drop-down menu that shows 

a selection of alternative variable line thickness profiles. As you move the mouse over 

the selection, an enlarged preview is shown on the right. 

 

Selecting one of the styles will change the line (or outline of a shape) from being a 

constant thickness line, to a variable thickness. This is great for creating pen and ink 

style artwork, and is often used in the creation of cartoons. 

The line width dropdown still should be used to change the overall thickness of the line. 

To restore a constant line width, select the top left corner item from the menu. 
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The special "PRESSURE" profile in the dropdown menu is used to indicate when a line has 

a custom profile as a result of being drawn with a pressure sensitive device, with the 

pressure sensitivity drawing (on page 92) option turned on. 

Line Gallery 

 

The LINE GALLERY can be used to apply a range of line styles or attributes, such as brush 

strokes, dash patterns, arrow heads, and more. 

To display the LINEGALLERY: 

 Choose "UTILITIES" > "LINE GALLERY" 

 Or click the LINE GALLERY tab on the GALLERIES tab.  

The LINEGALLERY is split into sections. To open or close any section, click on the small folder 
icon in the gallery window. 
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Line Width 

 
Join type 

 
Line cap 

To apply any line style or attribute from the gallery you can: 

 Drag and drop the required style from the gallery onto the shape or line. 

 Or double click on the required style in the gallery. 

 Or select the style and then click the APPLY button. 

Line width 

The text box at the top of the gallery duplicates that on the standard control bar. 

Brush strokes 

There are several sections that show a selection of various brush styles. 

Dash pattern 

This section provides a selection of line dash styles. 

Arrowheads 

The best way to apply an arrowhead is to use the STRAIGHT LINE TOOL (on page 92), as 

described earlier in this chapter. However you can also use the line gallery. Drag and 

drop the arrowhead from the gallery onto the appropriate end of the line. 

Alternatively, to apply an arrowhead: 

 Double click on the arrowhead in the gallery. 

 Or select the required arrowhead and click APPLY. 

Photo & Graphic Designer has two types of arrowhead designs: beginning and end. If the 

line already has a beginning arrowhead, applying an end arrowhead automatically places 

it at the opposite end of the line. 

If the line has no arrowheads, and you use the APPLY button or double click a style to 

apply it, then the arrowhead will be placed at the end of the line. 

The size of the arrow head is related to the thickness of the line. Thicker lines have 

proportionally larger arrowheads. 

If you hold "Ctrl" down and double click an arrow head or tail style, it will apply it to the 

other end of the line. 
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For general information about galleries see document handling (on page 74). 

Change join type 

This control on the top of the LINE GALLERY sets the style of corners. 

 

To change an existing line, select the line. 

To change the current join type, deselect all lines and 

select the required type from the menu. 

 

Change line cap 

This control at the top of the LINE GALLERY sets the style of the ends of the line. 

 

To change an existing line, select the line. 

To change the default line cap, deselect all lines. 

Select the required type from the menu. 

 

Brushes 

Brush strokes control the appearance of lines - for example, to apply an airbrush effect. 

There are two types of brush in Photo & Graphic Designer.  

1. SCATTER brushes repeatedly stamp or scatter shapes from the brush definition at 

intervals along a line - you can use feathering, text, extrusions, etc. in scatter brush 

definitions.  

2. ART brushes stretch or repeat the brush shape, which can be either vector or a 

bitmap, along a line. 
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Art brush (left) Scatter brush (right) 

Using an existing brush 

 

To use a brush, click on the FREEHAND AND BRUSH TOOL 

Now on the InfoBar choose a brush and a stroke profile. 

 

 
Select a brush  

 
Select stroke shape 

There is a wide range of both SCATTER and ART brushes. For ease of identification, the 

Art brushes have an (A) following the name in the preview window. Draw a line, and it will 

use your chosen brush and stroke shape.  

You can also browse different brush types using the LINE GALLERY (ON PAGE 109). It’s 

easier to browse brushes in the Line Gallery because they are categorized into folders.  

You can also select an existing line in the document and then choose a different brush or 

stroke shape, to change the appearance of the line.  

Creating a new brush 

To create a new brush type: 

1. Design your desired brush shape in Photo & Graphic Designer, then select it and go 

into the FREEHAND AND BRUSH TOOL. 

2. Click CREATE BRUSH. 
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3. A dialog box will appear - give your brush an appropriate name and then decide 

whether it is to be a SCATTER or ART brush. 

4. Click CREATE.  

You can then draw with your new brush straight away. Your new brush appears as the 

first entry in the brushes dropdown on the FREEHAND AND BRUSH TOOL InfoBar, and in the 

first DOCUMENT BRUSHES folder in the Line Gallery (on page 107). 

Brushes are stored in the document. If you want to re-use a brush in another document, 

you have to load the document containing your custom brush first. Only the default 

brushes are always available. 

Important: Although you can edit a default brush, you cannot save the edits into this 

brush for use beyond the current session. The default brushes are always restored when 

the program is started. If you want to edit one of the default brushes, then you have to 

save it as a new one, using the Save As buttons in the brush setting dialogs. 

Guidelines for new brushes 

If brushes are created from bitmaps, then the bitmap should be clipped to remove as 

much empty space from the outside edges as possible. This means the brush will not 

introduce redundant invisible parts to the strokes you draw with it, and it can also reduce 

the chances of rendering problems. If there is invisible space at the ends of the brush 

then lines won't terminate exactly at the points where you start and end the strokes. And 

if there is empty space along the top and bottom edges then the line won't appear to be 

of the correct width, it will appear narrower.  

Brushes should be more or less horizontal. Otherwise strokes will tend to deviate from 

the line you draw.  

Brushes should ideally be defined from fully saturated colours. This ensures that when 

you change the colors of brush strokes the stroke color achieved more closely matches 

the chosen color, rather than just being a shade of it.  

Coloring brush strokes 

By default when you select a brush and draw with it, the line you draw has the same 

color(s) as the brush. But you can change the color of your line by simply selecting it and 

clicking a color on the color line (on page 206), or using the Color Editor (on page 210). 

Any new lines you draw subsequently will use the same brush and line color. To draw 

new lines that have the same characteristics as an existing line, just click on that line and 

then the next line you draw will look the same.  

Editing a Scatter brush 

You will see a different dialog depending on whether you are editing a Scatter or Art 

brush.To access advanced editing options for a Scatter brush: 
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1. Select the Scatter brush line that you wish to edit with the FREEHAND AND BRUSH 

TOOL 

2. Click EDIT BRUSH on the InfoBar. 

You will see the following dialog - you can alter: 

 

 SPACING: Gap between the objects in 

the brush. 

 OFFSET: Distance between the 

original line and the objects in the 

brush. 

 SCALING: Size of objects in the brush. 

 ROTATION: Rotation of the objects in 

the brush as they follow the line. 

 TRANSPARENCY: Transparency of the 

brush. 

 FILL PROPERTIES: Miscellaneous 

options, including color options. 

Transparency is described in "Transparency" and colors are described in "Color handling 

(on page 205)". 

If you use a pressure-sensitive graphics tablet, the transparency and scaling options 

allow you to configure the brush’s sensitivity levels. If you do not have a pressure-

sensitive graphics tablet, you can mimic the effects using brush shapes (on page 106). 

Save your edits with the SAVE button, with the SAVE AS NEW button a new brush is 

created. 

Editing an Art brush 

To edit an Art brush: 

1. Select the Art brush line that you wish to edit with the FREEHAND AND BRUSH TOOL. 

2. Click EDIT BRUSH on the InfoBar. 
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You will see the following dialog: 

 

The SCALING options determine how the brush is made to fit your line.  

 STRETCH TO FIT STROKE LENGTH - by default the brush is stretched along the line to fit 

the stroke.  

 Choose the SCALE PROPORTIONATELY option if you want to keep the brush design in 

proportion, ignoring the line width.  

 REPEAT ALONG STROKE - rather than being stretched along the brush stroke, the brush 

shape repeats along the stroke, precisely following its course and orientation.  

The LINE COLOR options allow you to determine how the brush uses the current line color 

attribute. For example, if your current line color is set to red and you choose a green 

brush, do you want a red brush stroke or a green brush stroke?  

 IGNORE (USE COLORS IN DEFINITION ONLY) This is the default option. The current line 

color will be ignored when you draw with this brush and you’ll get the natural colors of 

the brush. You can still change the line color of this brush stroke later if you want to, 

using the Color editor (on page 210) or clicking a color on the color line (on page 206).  

 MIX LINE COLOR WITH DEFINITION COLORS This option is intended for brushes that have 

a strong hue, as in some of the default brushes provided. The strong hues in those 

brushes will be replaced with your chosen color, but greyscale tones such as blacks, 

whites, and greys remain unchanged. 

 MIX LINE COLOR WITH DEFINITION GREYS This option is intended for greyscale brushes. 

Shades of grey and shades of other colors in the brush will be replaced by 

corresponding shades of your chosen line color. When you create a new grey brush, 

this coloring option is selected for you by default.  

Brushes are shared between documents - so when you change any of the above options 

you are asked if you want the changes to apply to all the lines in all currently loaded 

documents that use that brush - or just lines you have currently selected.  
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Use the SAVE AS button to make a new brush instead of modifying the current brush. 
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Selecting Objects 

The Selector Tool 

 

The SELECTOR Tool is the main tool for selecting, moving, scaling, and rotating 

objects. It is typically used more than any other tool and is the central tool for 

manipulating documents. 

 

The Selector tool InfoBar - left side 

 
Show bounds 

 
Show edit handles 

 
Show fill handles 

 
Show rotation handles 

 
Rotation center 

 
Position of selection 

 
Dimensions of selection 

 
% size controls 

 
Lock aspect ratio 

 

The Selector tool InfoBar - right side 

 
Rotate & Shear 

 
Flip horizontal 

 
Flip vertical 

 
Scale line widths 

 
Apply, remove or inspect names of objects  

 
Perimeter and area indicator 

To use the SELECTOR Tool: 

 Click on the SELECTOR Tool on the MAIN TOOLBAR. 

 Or press "Alt + S", "V", or "F2". 

When switching to the SELECTOR TOOL, if there are objects selected inside a group or 

other composite object type, the parent object (group) becomes selected instead.  
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The InfoBar 

All the buttons on the InfoBar are described in the following sections except: 

 SHOW EDIT HANDLES which is described in "Drawing lines (on page 102)". 

 SHOW FILL HANDLES which is described in "Fills (on page 295)". 

 APPLY, REMOVE OR INSPECT NAMES OF OBJECTS which is described in "Document 

handling (on page 82)". 

The first two buttons let you edit the outlines and fills of objects without the need to 

switch tools. 

Alt + S 

Because the SELECTORTOOL is the most used tool, there is an additional shortcut that lets 

you switch to the SELECTOR TOOL to perform a selection or other operation, and quickly 

switch back to the previous tool. If you are using another tool, you can easily switch to 

the SELECTOR TOOL: 

 Press and release "Alt + S" to switch to the SELECTOR TOOL. Press again to return to 

the previous tool. 

Selecting objects 

To select a single object, click on any visible part of the object.  

Change object selection 

Once an object is selected, you can use the following keys to change the selection: 

 End selects the back object. 

 Home selects the front object. 

 "Tab" selects the next object towards the back. 

 "Shift + Tab" selects the next object towards the front. 

Front and back objects are described in "Object handling (on page 123)". 

Marquee selection 

To select multiple objects, press and hold down the mouse button. Dragging the mouse 

draws a selection rectangle, by default all objects wholly within the selection rectangle 

are selected.  

If you have an object in the way which is preventing you from drawing a rectangle 

because you end up moving the object, hold down "Shift" while dragging out the 

selection rectangle. 

By default, dragging a selection rectangle selects only those objects which are 

completely inside the rectangle. This behavior can be changed so it's compatible with the 

way selection works in other applications, whereby the objects touching the rectangle 
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outline also become selected. Hold down "CTRL" while dragging to include those objects 

touching the selection rectangle in the selection. 

The "UTILITIES > OPTIONS" (on page 543) dialog (General Tab) enables you to change the 

default setting for marquee selection. So you can choose to have objects touching the 

selection rectangle selected, without having to hold down "Ctrl" during the drag. In this 

case, holding "Ctrl" down while dragging selects only the objects wholly inside the 

rectangle. 

Extend Selection 

To select additional objects: 

 "Shift + click" on them. 

 Or "Shift + drag" the mouse pointer. This draws a selection rectangle and adds objects 

within the rectangle to the selection. 

Select under 

Hold down "Alt" to select objects hidden by other objects. By "Alt + clicking" you can step 

through several overlapping objects. 

Select inside 

You can select an object that’s inside a group or other container object by holding down 

"Ctrl" while you click on it. This is called selecting inside. The object you click on will 

always become selected, even if it’s deep down inside several levels of nested groups. 

When you have such deep nesting of groups, sometimes you may want to select one of 

the nested groups (a group inside another group). If you hold down the "Alt" and "Ctrl" 

keys while you click you can do this easily. The first such click will select the top level 

group (just as  an unmodified click does). Click again and the next group down in the 

hierarchy will be selected instead. Continue clicking to ‘drill down’ into the group structure 

until the group you want becomes selected. 

Note that some operations are not permitted with select inside. For example, you are not 

permitted to delete the end object of a blend (because the blend would then be 

meaningless). 

Marquee selection does not work for select inside, because "Ctrl" is used to toggle the 

two marquee selection modes. 

Scribble Selection 

In the Selector Tool, drag with "Alt" held down and instead of dragging a box, a freehand 

line is draw. Every object that is touched by the line becomes selected. Hence you can 

drag the mouse around the page, touching all the objects that you want to select. This 

also works in conjunction "Shift" for extend selection (on page 117) and "Ctrl" for select 

inside (on page 117). 
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Moving objects selected under or inside 

If you need to move a selected object that’s either under others or inside a group, then 

just dragging doesn’t work as it will select and drag a different object. To overcome this 

hold "Ctrl + Alt" and start dragging. This will always drag the existing selected object. You 

can let go of the keys once you’ve started dragging. 

Or you can use the arrow keyson the keyboard to nudge the object. 

Selecting and layers 

You cannot select objects in locked or invisible layers. 

See "PAGE & LAYER GALLERY (on page 196)" for more details on layers. 

Selecting Photos and SmartShapes 

When you select a photo or SmartShape with the SELECTOR TOOL, you see SmartPhoto 

handles (on page 382) rather than the usual bounds handles. This allows direct editing of 

the photo or SmartShape without having to first switch into the Photo Tool or Quickshape 

Tool. 

 
You can revert to showing the normal selection bounds handles using the toggle 

button on the left of the SELECTOR TOOL INFOBAR. 
 

Selecting all objects 

To select all objects: 

 Choose "EDIT" > "SELECT ALL", 

 Or press "Ctrl + A". 

Deselecting an object 

To deselect all objects: 

 Click anywhere on an unused part of the document, 

 Or choose "EDIT" > "CLEAR SELECTION", 

 Or press "Esc". 

To deselect one object from several: 

 "Shift + click" on the object. This deselects that object. Other objects remain selected. 

Selecting with Soft Groups 

When you click on an object which is a member of a soft group, all members of the soft 

group become selected. This is one of the main purposes of Soft Groups – to keep 

closely related objects together even when they are on different layers. If you want to 

select just one member of a Soft Group, use Ctrl to select inside, as described above. 

See the “Soft Group (on page 149)” section in “Object Handling” for more information. 
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Double-click shortcuts to tools 

For some types of object, double-clicking on them will take you into the tool which is most 

applicable to that object. So for example if you want to edit some text, double click on it 

to go into the Text Tool, so you can start editing it immediately. The following table 

summarizes the available shortcuts for different object types: 

Double click on Selects this tool 

Text 

 

Text Tool 

Photo 

 

Photo Tool  

Rectangle 

 

Rectangle Tool 

Ellipse 

 

Ellipse Tool 

Shape 

 

Shape Editor 

SmartShape 

 

Quickshape Tool 

Group 

 

Starts an ‘edit inside’ by opening the contents of the group 

in a separate sub-document view 

 

Identifying a selected object 

The selected object shows SELECTION MARKERS and usually SELECTION BOUNDS 

HANDLES or ROTATION HANDLES (although this can be turned off). 

Selection markers 

 

Each selected object displays a single 

selection marker to show it is selected. 

This is a useful reminder when selecting 

and deselecting several objects. 

 

Status line 

The status line at the bottom of the window also describes what is selected. 
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Selection bounds handles 

 

Selection bounds handles enclose the overall selection. 

These are controlled by the SELECTION BOUNDS button on 

the InfoBar.  

Selection bounds handles let you scale and stretch selected objects see Shape handling 

(on page 169), Object handling (on page 123), and Distorting objects for more details. 

Successive clicks on an object alternate between showing selection bounds and rotation 

handles.   

 

When you select a photo or Smartshape, you see the smart photo adjustment handles 

(on page 382) displayed. This allows you to directly edit these without having to first 

switch into the Photo Tool or Quickshape Tool. You can revert to showing the normal 

selection bounds handles by clicking the bounds button, which will also let you toggle 

between the two views. 

Finding objects in the Page & Layer Gallery 

You can quickly locate an object in the Page & Layer Gallery by selecting it and then 

clicking the LOCATE button at the top of the Page & Layer Gallery. The Page & Layer 

Gallery automatically expands the required nodes and highlights the selected object. See 

"Page & Layer Gallery (on page 196)" for more information. 

Rotation handles 

 

Rotation handles enclose the overall selection. 

These are controlled by the ROTATION HANDLES 

button on the InfoBar.  

Rotation handles let you rotate and skew selected objects; see "Object handling (on page 

123)" for more details. Successive clicks on an object alternate between showing 

selection bounds and rotation handles. 

Tab 

With any selected object, pressing "Tab" and "Shift + Tab" will move through the selected 

objects (previous and next object in the document). 
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Hiding objects 

Using the PAGE & LAYER GALLERY you can make objects, groups or entire layers invisible 

temporarily. Once an object is invisible, it can't be selected either, so this is useful if you 

want to work on objects near to, above or below other objects that you don't want to 

change.  

For example if you have a large semi-transparent shape on top of some of your artwork, 

you can hide that object to make it easier to work on the artwork below it. Once the 

shape is invisible, you can click on the objects beneath it to select and move them, 

without having to use Alt to select under the large shape as described above. Once you 

are done, you can turn the object back on again. 

Click the eye icon  against the object in the Pages & Layer Gallery to make it invisible 

(the eye closes ). Click it again to make it visible again. See "Page & Layer Gallery (on 

page 196)" for more information. 

Locking objects 

You can also lock objects in your design so that they still appear on the canvas, as 

normal, but are not selectable. This is useful to make it easier to select other objects 

near, above or below an object that is getting in the way, but where you still want to be 

able to see that object.  

For example you might have a large shape sitting behind some smaller shapes that you 

want to work on. Once the large shape behind is locked, you can marquee select around 

the small shapes, without selecting or dragging the large shape behind. As far as 

selection is concerned, it's just as if the object is not there. 

To lock an object, right click on it and choose the Lock option from the menu that 

appears. Or lock the object by clicking on the arrow icon  next to it in the PAGE & 

LAYER GALLERY. The Icon changes into a lock icon . Click the icon again to unlock.  

You can't unlock the object by right-clicking on it on the canvas, because of course once 

it's locked you can't select it. However the canvas right-click menu does include an option 

to unlock all objects, which is useful.  

You can lock groups or entire layers as well as individual objects. See "Page & Layer 

Gallery (on page 196)" for more information. 

Soloing objects 

You can click the Solo button next to an object in the Page & Layer Gallery, to 

temporarily make all other objects invisible. This makes it easier to work on a specific 

object if you don’t want or need to be able to see the other objects around it. Also, to find 

a specific object you can click and drag across the solo mode buttons in the gallery. As 

you drag, only the item under the mouse pointer is displayed on the page, so you can 
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quickly scan for the object you want to find. See the Page & Layer Gallery chapter (on 

page 196) for details. 
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Object Handling 

Moving objects 

To slide an object across the page 

 

1. Choose the SELECTORTOOL.  

2. Drag the object to the required position. Hold down "Ctrl" to restrict the direction of 

movement to one of the constrain angles. 

The constrain angles are user definable. Refer to "Customizing Photo & Graphic 

Designer (on page 542)" 

Hold down "Ctrl + Alt" and you can drag the selected object even if the pointer is not over 

it. This is useful when the selected object is hidden behind another object or part of a 

group. Release "Ctrl" and "Alt" after you start the move unless you want to constrain the 

move. 

You can also move objects using the arrow cursor keys. This is described on the next 

page. 

Object snapping is a very powerful way of accurately aligning lines, points and the edges 

of objects to any other object so they exactly touch. It also helps you align to the 

horizontal and vertical center lines of the page. 

 

To toggle object snapping, click the SNAP TO OBJECTS button or right click and 

choose "SNAP TO" > "SNAP TO OBJECTS". You can also choose "WINDOW" > 

"SNAP TO OBJECTS".  

Click and drag on the object you want to snap. As you drag, Photo & Graphic Designer 

displays a magnet icon whenever you are near a "point of interest" or potential snapping 

site relative to a visible object on the page.  

To snap in a path relative to the page center (both horizontally and vertically), move the 

object over the lines that appear as you drag on the page. A red dot on the line also 

indicates potential "point to path" snapping points, so that you can snap the object to a 

point such as the center or center line of the page. 

See Snapping (on page 138) for details on snapping to grid and snapping to objects. 

Drop copy 

During a move (and while still holding the left mouse button down) click the right mouse 

button or press + on the numeric keypad to drop a copy of the object. The original object 
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doesn’t move. You can do this as many times as you wish to create a series of 

duplicated objects. 

You can also hold down the right mouse button and drag a copy of the object. Left click 

to leave a copy at the current mouse position. 

Fills 

Usually, moving an object also moves the fill with it: 

 

Normal move left to right with a linear filled object. 

This also applies to rotating, skewing, scaling and 

stretching objects. 

Photo & Graphic Designer can also move the object but not the fill origin.  

 

To do this click the "−" key on the numeric keypad during 

the move. 

The same move, but pressing "−" (minus) during the drag. 

 

Nudging objects 

Usually you can move an object a small amount by using the arrowkeys to nudge the 

object (these keys sometimes have other uses, especially in the TEXTTOOL). 

Nudging is not affected by either magnetic or grid snapping (snapping is described later). 

Nudge modifiers 

To modify the nudge distance, use these key combinations while using the arrow keys: 

 Ctrl  nudge 5 times the normal distance 

 Shift  nudge 10 times the normal distance 

 Ctrl + Shift nudge by l/5th the normal distance 

 Alt  nudge by 1 pixel 

 Alt + Shift nudge by 10 pixels 

You can change the normal nudge distance under the GENERAL tab in "UTILITIES" > 

"OPTIONS". Refer to "Customizing Photo & Graphic Designer (on page 546)". 

Nudge works in most tools. 

Cut, copy and paste 

These let you move or copy an object in the same document or between different 

documents. The procedure is: 
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1. Select the object. 

2. To remove the object, choose "EDIT" > "CUT" (or "Ctrl + X"). To copy the object but 

not remove it, choose "EDIT" > "COPY" (or "Ctrl + C"). Either option puts the object 

(or a copy of it) onto the clipboard. 

3. Choose "EDIT" > "PASTE", "Ctrl + V", or "INSERT". This pastes the clipboard contents 

into the document. 

Note that if the objects you copy are all on the same layer, then you can paste those 

objects to any layer by first making it the current layer and then choosing "EDIT" > 

"PASTE" >  "PASTE IN LAYER" or "PASTE IN PLACE IN CURRENT LAYER". The layer from 

which the objects were copied is ignored in this case. 

However if the objects you copy are on several different layers, then the layer structure 

is maintained when you paste.  

This allows you to copy layered data within a document or to a different document. Any 

layers which are missing in the target document are created automatically by this 

operation. So for example if you copy a mouse-over button, which has one object on the 

MouseOff layer and another object on the MouseOver layer, to a new document, the 

MouseOff and MouseOver layers will be created if they don’t already exist and the button 

objects copied onto them. 

"Ctrl + Shift + V" or "EDIT" > "PASTE IN PLACE" pastes the clipboard contents into the 

same X/Y position from where they were cut or copied or the same position relative to 

the bottom of the page in the case of footer objects. This only applies to objects cut or 

copied from within Photo & Graphic Designer. Objects imported from other programs are 

always pasted into the center of the current view. 

The object remains on the clipboard so you can paste the same object several times. 

You can paste the clipboard content into multiple pages of your document by simply 

selecting the pages in the PAGE AND LAYER GALLERY. A simple "Ctrl + V" paste will place 

the object in the center of the page when you have more than one page selected.  

If there is a choice of formats on the clipboard, Xara Photo & Graphic Designer will 

display a PASTE SPECIAL dialog which allows you to choose the format you want to paste 

in (eg. When pasting in text you may have the choice of pasting in unformatted text or 

Rich Text). 

In addition you may see the following paste options, depending on the clipboard 

contents: 

Paste unformatted text 

Pastes any text on the clipboard into your document without any formatting. 

Paste in place (Ctrl+Shift+V) 

The same as Paste, except your object will be pasted in the exact same position from 

which you copied it. This is useful for moving objects from one layer or page to another, 

without changing its X/Y position 
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Paste format/attributes (Ctrl+Shift+A) 

Preserves the format (e.g., font and font size) or style attributes (e.g., line and fill color) of 

the pasted object.  It is a quick way of applying multiple attributes. When you Paste 

Attributes, the attributes of the objects on the clipboard are applied to all the objects 

currently selected  

Paste position 

This option applies the position of a copied object on the clipboard to a currently selected 

object, which moves to the exact same position as the copied object. 

If multiple items have been copied to the clipboard, Photo & Graphic Designer treats 

them as if they are a group and moves the currently selected object to the position of the 

copied group as a whole. 

The currently selected object is pasted or moved into the center position of the copied 

object or group of objects. 

Paste size 

This option applies the size of a copied object on the clipboard to a currently selected 

object, which resizes around its center to the exact size of the copied object. 

If you have multiple items selected when you ‘paste size’, each of those objects is made 

the target size, instead of the selection as a whole. So for example if you copy a 200x200 

pixel photo, then select 10 other photos and ‘paste size’, all 10 photos each become 

200x200 pixels. This gives a quick way to make a bunch of objects a particular size. 

Paste size and position 

As the name suggests, this option applies both the size and exact position of the object 

on the clipboard, to the selected object. This useful for making text areas have the same 

size and position on each page of your document, if you have previously made them 

different.  

Paste replacing selection 

This is similar to PASTE POSITION, except that the copied object on the clipboard replaces 

the currently selected object and retains the deleted item's position. 

The copied object is pasted into the center position of the deleted object. 

Paste in current layer 

The same as PASTE IN PLACE, except your object will only be pasted into the current 

layer. 

This is useful if you want to display or hide just your pasted object when layers above or 

below are displayed. 
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Paste in place in current layer 

The same as PASTE IN CURRENT LAYER, except your object will be pasted into the current 

layer in the exact same position from which you copied it. 

Paste opacity mask (Ctrl+Shift+M) 

See Opacity Masks (on page 396) 

Paste opacity mask in place 

The same as PASTE OPACITY MASK, except your opacity mask will be pasted in the exact 

same position from which you copied it. This is useful for moving opacity masks from one 

layer or page to another, without changing its X/Y position. 

Paste on all pages 

Pastes the copied object at the same size and position on all pages of the document.  

Removing objects from the document 

First select the objects you want to remove. You can then either cut the objects to the 

clipboard or delete them. 

Cutting objects 

Choose "Edit" > "Cut", or press "Ctrl + X".The contents of the clipboard are overwritten 

and you can paste the deleted object(s) somewhere else if desired. 

Deleting objects 

 

Right click and choose DELETE or choose DELETE from the EDIT menu, or press 

the "Delete" key, or click the DELETE button on the STANDARD control bar. 

In this case the deleted objects are not put onto the clipboard. If you accidentally delete 

an object, undo retrieves it. 

Duplicating and cloning 

Both these options create a copy of the selected object. The original object is deselected 

and the duplicate or clone becomes the selected object. 

You can also duplicate an object during moving, rotating, scaling, or skewing. During the 

drag action (and while still holding the left mouse button down) click the right mouse 

button or press "+" on the numeric keypad to drop a copy of the object. The original 

object doesn’t move. You can do this as many times as you wish to create a series of 

duplicated objects. 
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So an easy way to create one or more copies of an object that is exactly horizontally or 

vertical aligned, is to drag the object, hold "Ctrl" to constrain the movement, and right 

click (or press "+" on the numeric keypad) for each copy required. 

 

To quickly create  a line of objects, draw one, then drag while holding "Ctrl" and right click for 
each copy required.  

Duplicating 

Choose "Edit -> Duplicate", or press "Ctrl + Alt + D", or select the object in the PAGE & 

LAYER GALLERY (on page 193) and click the DUPLICATE button. The copy is displaced 

slightly, usually down and to the right, from the original. 

The duplicate distance is user definable, see "Customizing Photo & Graphic Designer (on 

page 546)" 

Cloning 

 

Choose "Edit" > "Clone", or press "Ctrl + K". This 

places a copy exactly on top of the original. Cloning is 

an easy way to create concentric shapes. 

This example uses an original large letter "A" with a 

black fill and a 4pt thick white outline and a clone with 

no fill and a 1pt black line. 

 

Moving objects forward and backwards 

Complex documents have objects stacked on top of each other, such as this target: 
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The target on the left is made from three circles stacked on top of each other.  

To ensure that objects overlay each other in the correct order, you often need to 

rearrange their order from front to back. The front object always covers lower objects, 

and objects always cover other objects which are further back. Each new object you 

create is always created on top of older ones. 

The PAGE & LAYER GALLERY is useful for viewing and manipulating the stacking order of 

objects. It shows you the objects in their stacking order. The order of objects in the 

gallery from top to bottom, mirrors the stacking order of those objects in the design from 

front to back. So the target design above looks like this in the Page & Layer Gallery (on 

page 193): 

 

And you can change the stacking order of objects using the Page & Layer Gallery by 

simply dragging them up and down. So for example in the target design, dragging the 

blue circle in the Page & Layer Gallery, and dropping it above the green circle will bring 

the blue circle to the front. The ARRANGE menu gives you four options: 

 BRING TO FRONT ("Ctrl + F"): This makes the selected object the front object, and it will 

hide any other object it covers. 

 MOVE FORWARD ("Ctrl +Shift + F"): This moves the object up a level towards the front 

rather like climbing a staircase one step at a time. 

 MOVE BACKWARD ("Ctrl +Shift + B"): This moves the object one level towards the back. 

 PUT TO BACK ("Ctrl + B"): This moves the object to the back. 
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These options move objects forwards and backwards within their layer. MOVE TO LAYER 

IN FRONT and MOVE TO LAYER BEHIND lets you move objects between visible layers 

(invisible layers are skipped when moving objects). 

Read more in "Page & Layer Gallery (on page 193)" 

Rotating objects 

 

This is part of the SELECTOR TOOL. 

 When in rotate mode, the transformation center (around which the object rotates) 

initially appears in the center of the object, as shown by a small target like this. 

Simply click on a object again to put the selector into rotate mode, or click the ROTATION 

HANDLES button on the InfoBar. 

 

To move the transformation center: 

 Drag the transformation center target where required. 

 Or use the 3x3 matrix on the InfoBar for accurate positioning. 

 

 This moves the transformation center to the corners, the center or the side mid-points 

of the object or selection. The transformation center aligns with the outer edges of the 

object. This means that if the object has a thick line applied, the transformation center 

can be outside of the object. 

Attention: If the rotation center is moved, it remains in this location for any selected 

object until all objects are deselected, at which point it returns to the center of any 

selected object. 

Rotating using the mouse 

The SELECTOR Tool must be in rotate/skew mode (the selection handles are arrow 

shaped). 
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Dragging the side handles stretches the object. This is described in Stretching and 

squashing objects. 

Drag on a corner arrow. As you drag, the object rotates around the transformation center. 

The InfoBar shows the current rotate angle. 

"Shift + drag" to rotate the object around its center (the transformation center is ignored). 

Hold down "Ctrl" to restrict rotation to the constrain angles. Note that the set of constrain 

angles includes those rotations which align the object with the screen. This makes it very 

easy to ‘straighten’ any object with a straight edge – just hold down the Ctrl key and 

rotate until the object snaps to the screen-aligned rotation you want. 

The constrain angles are user definable. Refer to "Customizing Photo & Graphic 

Designer (on page 546)". 

To create a copy while rotating, click "+" on the numeric keypad while rotating, or click 

the right mouse button. 

 

To quickly create a fan like this, draw a single line, then position 

the transformation center in the bottom right (click the bottom left 

button of the 3x3 transformation center control on the InfoBar), 

and then as you drag rotate the object, right click for each 

successive line you require. 

 

Rotating by exact angles (using the InfoBar) 

Type an angle into the rotate box and press "". Positive angles rotate anti-clockwise 

and negative angles rotate clockwise. 

 

Click the arrows to the right to nudge the rotate angle. 
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Rotating objects in Resize Mode 

 

It is possible to rotate and skew an object even if not in rotate mode. Using resize mode, 

move the mouse pointer into the according small areas near the selection area handles 

as illustrated above. The mouse pointer changes into a rotate or skew icon, showing you 

that you are now able to rotate or skew the object by dragging with the mouse. 

Scaling (resizing) objects 

 

This is part of the SELECTOR TOOL. 

Scale Line Widths button 

The SCALE LINE WIDTHS button on the SELECTOR TOOL InfoBar is used in many 

operations where the width and height of the selected objects are important. It controls 

whether the line attributes (not just line widths) are taken into account when working out 

the size and position of the selected object(s). 

 

With the SCALE LINE WIDTHS button set, scaling an object also 

scales its line widths. With this button unset, line widths remain 

unchanged. 

You can toggle this button during drags by clicking "/" on the numeric keypad. 

If you have a rectangle with a 4 pixel line width, as you turn SCALE LINE WIDTHS on and 

off you'll see that the X, Y W And H fields in the SELECTOR TOOL change as the effects of 

the line width are included and excluded. 

 

The following features are affected by SCALE LINE WIDTHS: 

 Position and size as reported on the SELECTOR TOOL InfoBar XYWH fields 
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 Changing position and size by entering values into the InfoBar XYWH fields 

 Changing size by entering values in the W% H% fields 

 Scaling/stretching objects by dragging in the Selector tool 

 Alignment 

 Snapping 

The line attributes that are taken into account when SCALE LINE WIDTHS is turned on are: 

 Line width 

 End caps 

 Join type 

 Dash pattern 

 Arrowheads 

 Brush style 

 Stroke type (inc. variable width strokes) 

 

In general, if you are interested in the visual positions of objects you should turn SCALE 

LINE WIDTHS on. If you're interested in the exact positions of lines (e.g. where the centers 

of lines are, as is typical in technical drawings) then you should turn SCALE LINE WIDTHS 

off. 

Lock Aspect button 

 

With the LOCK ASPECT padlock button set, the width/height aspect 

ratio remains constant as you scale the object.  

In other words, the shape remains in the same proportions as the original. It’s 

recommended that this button remains selected most of the time in order to ensure that 

when you resize objects they do not become squashed. 

With this button unset, you can change the aspect ratio as you scale the object, in other 

words, you can stretch object one way or another when dragging a corner resize handle 

or when entering a new size. 

Smart transform 

Additionally you can right click on the padlock button to display a context menu giving 

you the option to turn on or off both ASPECT RATIO LOCK and SMART TRANSFORM. The 

latter attempts to scale the shape smartly rather than just squashing all members of the 

group and is on by default. 

If you want a simple ‘squashed’ or 'stretched' result, where each member of the group is 

simply scaled - make sure you you have the SELECTION BOUNDS handles selected - click 

the button on the SELECTOR TOOL (on page 115) infobar to display the handles. 

 

Then all you need to is to hold down the Alt key while performing the drag, or else un-

check the SMART TRANSFORM option. Holding down the Alt key will toggle the existing 

selection.  
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Scaling using the mouse 

The SELECTORTOOL must be in 

scale mode (the selection 

bounds handles are squares). If 

necessary, click on the object to 

change to scale mode.  

Drag one of the corner handles. The object scales as you move the pointer diagonally. 

The InfoBar shows the current scaling. The object will scale between the dragged handle 

and the opposite one. To use any other point of the object as the fixed point move the 

transformation center to it and use the InfoBar buttons to scale (on page 134). 

Hold "Shift" while dragging to scale the object around its center. This works 

independently of the position of the transformation center. 

"Ctrl + drag" scales the object in multiples of its original size (x2, x3, and so on). 

To create a copy while scaling (leaving the original in place) right click, or press "+" on 

the numeric keypad. 

Dragging the side handles stretches or squashes the object. This is described in 

Stretching and squashing objects. 

Scaling using the InfoBar 

 

 
Type into the SCALE TEXT boxes and press "". 

 Scalings below 100% reduce the object. 50 halves the size of the object. 

 Scalings above 100% enlarge the object. 200 doubles the object size. 

 
If LOCK ASPECT is set, you can type into either text box to resize the object by the 

desired percentage. If this button is unset, you can enter separate values for both 

the width and height. 

 
Alternatively, type the required size of the object into the W or H text boxes. 

If the LOCK ASPECT button is on, this scales the object and maintains the aspect ratio. 

You can enter the size in any unit, such as 1 cm. 

Scaling with the InfoBar buttons (or number boxes) always scales around the 

transformation center. You can position this anywhere else in the object, as described in 

"Rotating objects (on page 130)".  

If you scale a text area or text column using the SELECTOR TOOL, the text itself is not 

scaled, only the dimensions of the area or column are changed. Use the TEXT TOOL font 
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size control to change the actual text size. However if the text is inside a Group, resizing 

the group will scale the text. 

Scaling groups 

If you scale a group using its side handles, an attempt is made to scale it smartly rather 

than just squashing all members of the group - we call this SMART TRANSFORM. This is 

commonly useful when attempting to make a narrower ‘mobile-friendly’ website variant of 

a wider website – you need to make wide objects like headers and footers fit the smaller 

page width.  

Take this footer group as an example:  

 

The result you get should look something like this: 

 

The text has remained the same size and the rounded corners have been preserved.  

This works better for some groups than others, depending on the design and complexity 

of the group. If instead you want a simple ‘squashed’ result, where each member of the 

group is simply scaled, all you need to do is hold down the Alt key while performing the 

drag.   

 

As you can see the text has been squashed and the rounded corners are no longer 

round. But this can be useful for some groups, typically graphics that don’t include any 

text or rounded corners. 

Turn SMART TRANSFORM on or off by right-clicking on the LOCK ASPECT RATIO (on page 

133) padlock button and selecting or de-selecting the option. It is on by default and 

holding down the Alt key during the drag will toggle the selected option. 
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Perimeter & Area 

  

The 2 controls on the right of the Selector tool InfoBar show the 

perimeter and area of the current selected shape(s). Perimeter is 

shown in the current units for the document and area is shown in the 

current units squared. These fields are not editable. 

 

Stretching and squashing objects 

This is similar to scaling objects except that the object is scaled in one direction only. 

Stretching and squashing are basically the same action — stretching makes the object 

larger, squashing makes it smaller. 

Stretching/Squashing using the mouse 

Make sure you you have the SELECTION BOUNDS handles selected - click the button on 

the SELECTOR TOOL (on page 115) infobar to display the handles. 

 

Also make sure that the SMART TRANSFORM option on the LOCK ASPECT RATIO button is 

unchecked (right-click on the button to display the context menu and uncheck the option). 

Use the side, top and bottom handles, instead of the corner handles, to stretch or squash 

a shape in one dimension only. 

 

Drag one of the side handles. The 

object scales as you move the 

pointer in the appropriate direction. 

The InfoBar shows the current 

scaling. 

The LOCK ASPECT button is ignored. 

Right click or press "+" on the numeric keypad while dragging to stretch or squash a copy 

of the object, leaving the original in place. 

Stretching/squashing using the InfoBar 

The LOCK ASPECT button must be unset (if it is set, you scale the object instead of 

stretching or squashing it). 

Type into either the width or height text box (as appropriate) and press "". Alternatively 

enter a % scale (width or height). So entering 200% into the top % scale box will make 

the object twice as wide, but the same height. 
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Skewing objects 

 

This is part of the SELECTOR Tool. 

 

 

Left is the original object, to the right with a horizontal 

skew 

Skewing using the mouse 

Switch the SELECTOR Tool to rotate/skew mode. (The selection handles are arrow 

shaped) by clicking on the object. 

Drag a side arrow to skew the object. 

 

As you drag, the object skews in the direction of movement 

(vertical or horizontal).  

 

The InfoBar shows the current skew angle. 

"Shift + drag" to skew the object around its center. Hold down "Ctrl" to restrict the skew to 

the constrain angles. Right click, or press "+" on the numeric keypad as you drag to 

create a copy, leaving the original where it was. Or right-drag with the mouse to create 

instant copies, additional copies by left clicks. 

You can also skew an object in the Selector Tool's resize mode using the skew areas. 

Read more under Rotating objects in resize mode (on page 132). 

Skewing using the InfoBar 

 

To skew horizontally type an angle into the skew text box and press "". 

To skew vertically: 

 

1. Click the center-right button on the 3x3 matrix on the InfoBar. 

2. Type an angle into the skew text box and press "". Positive values skew 

downwards, and negative upwards. 
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Flipping objects 

 

This is part of the SELECTORTOOL. Clicking on the FLIP buttons flips the 

object vertically or horizontally around the transformation center. 

The scale and aspect ratio do not change; the object just flips. 

Feathering 

Sometimes you want to blur the edges of an object so it blends, or fades, into a 

background object. This is called "feathering". An example is merging two photos 

together when you want to avoid a sharp edge between them. 

The feather control is on the right side of the top bar. 

 To feather an object: 

 

1. Select the object or objects you want to feather. 

2. Either enter a numeric size for the feather into the text box 

Or 

Click the arrow to show the pop-up slider. As you drag the slider the objects are 

feathered. 

 

Feathering blends or blurs the edges of objects. 

If you have multiple objects selected, the feather appears around each object. If you 

group the objects, the feather appears around the outside of the group. 

 

You can also change the feathering profile. Normally a linear 

transition across the feather produces the best effect, but you 

may want to change this. 

Select the PROFILE button to display the PROFILE dialog and adjust the sliders. 

Snapping 

Snapping makes it easier to position edges, or specific points on objects, exactly where 

required. It can be used to align edges to a specific point or line, or to evenly space 

objects, using the grid. 
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 Xara Photo & Graphic Designer offers three types of snapping. 

 Snap to grid 

 Magnetic snapping (snap to objects) 

 Snap to guidelines or guide objects 

Grid snap is useful for making objects evenly spaced, or making the sizes exact multiples 

of a given value. Guidelines are useful for aligning edges (although it’s a lot more 

powerful using guide objects) and lastly magnetic snap is a general purpose way of 

accurately positioning lines, points or object edges relative to other objects or to the page 

center or edges. 

Snap to grid 

When SNAP TO GRID is selected, grid points act like magnets. Right click on the 

pasteboard and choose "SNAP TO" > "SNAP TO GRID" or use the menu option "WINDOW" > 

"SNAP TO GRID", (or press "." (decimal point) on the numeric keypad). You can control the 

grid spacing from the options dialog (right click and choose PAGE OPTIONS or use the 

menu command "UTILITIES" > "OPTIONS") on the Grid and Ruler tab.  

When dragging objects the edges will snap to grid points. If the size of the object is such 

that opposing edges can't both be snapped, the edge that snaps depends on the 

direction the object is dragged in. 

 

This shows a coarse grid with 5 subdivisions between major divisions. The shape has a very 
thick gray outline. Because the object has been dragged down and to the left, the lower and 
left outside edges are snapped to the nearest grid point. 

Note: The default grid spacing is 50 pixel spacing for major grid lines with 50 

subdivisions. This means the grid is spaced at exactly one screen pixel and so may 

appear not to be working at a normal 100% zoom. If you zoom in to say 500% then you 

can see it does snap correctly. 

Alternatively, change the grid values to have, say, 10 subdivisions which means that the 

grid points are on 5 pixel boundaries. 
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Snapping and line widths 

 

The SCALE LINE WIDTHS control on the SELECTOR TOOL 

InfoBar affects whether snapping happens to the bounds of 

objects including their outlines. 

The above example shows a shape with a very thick gray outline. It also shows (thin 

black line) the outline of the shape itself (you can see the thick outline is drawn equally 

on either side of the center line so that it partly overlaps the inside of the shape and 

partially goes outside). 

With scale line widths on, the width of the outline is deemed to be important and so ‘snap 

to grid’ will snap the bounds of objects, including outlines, to the grid. Snap to objects will 

allow you to snap using the bounds or the outline center lines. If the outlines as they 

appear on screen are small, so there is little difference between these two snapping 

positions, bounds snaps are favored. So zoom in if you want to snap outline centers in 

this case. 

With scale line widths off, ‘snap to grid’ and ‘snap to objects’ will snap the center lines of 

objects, ignoring the outline widths.  

 

Because snapping honors the Scale line widths switch it means that the bounds used by 

snapping are always the same bounds that are reported in the SELECTOR TOOL InfoBar. 

Magnetic object snapping (snap to objects) 

Magnetic object snapping makes it much easier to accurately position objects relative to 

each other or relative to the page center or edges. 

So, for example, if you want several lines to start at exactly the same point, or want a line 

to exactly join the edge of a circle, then using "magnetic object snap" is useful.  

You can even use this to align the centers of objects, or align objects to the center of the 

page, or align them horizontally and vertically anywhere in the middle of the page. 

Magnetic snapping works when either moving or scaling objects using the SELECTOR 

TOOL.  

  

To toggle Magnetic snapping to objects on and off, click the SNAP TO OBJECTS 

button in the top toolbar. Alternatively right click the pasteboard and choose 

"SNAP TO" > "SNAP TO OBJECTS", or use the menu option "WINDOW" > "SNAP TO 

OBJECTS". You can also toggle it on/off during dragging by tapping ‘s’. 

Click and drag on the object you want to snap. As you drag, Photo & Graphic Designer 

displays a magnet icon, blue lines and red points whenever you are near a "point of 

interest" that it has snapped to.  
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Snap indicators 

 

Snap indicators are shown whenever a snap occurs. That is whenever a point of interest 

on the object you are dragging comes in range of a point of interest in the document 

(which could be on another object or be part of the page). Photo & Graphic Designer 

snaps to the point of interest and the mouse pointer changes to show a magnet symbol 

so you know a snap has happened. Also further indications are shown dynamically on 

screen to help you see what snap has occurred.  

 A red dot indicates that a specific point has snapped 

 A blue line indicates a snap to some feature of another object (e.g. to the edge of a 

rectangle). 

 An orange line indicates a snap to a page feature (corners, edges, center) 

The snap indicator lines pulse to show that they are temporary "live" indicators and to 

help them be seen over different background colors. 
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The snapping distance is controlled by the MOUSE tab of the OPTIONS dialog box 

("UTILITIES" > "OPTIONS" or right click a page and choose PAGE OPTIONS).  

 

You can specify two snap distances in the "Magetic snap radii" section, which control 

how close things need to be before they will snap together. The size of a circle around 

points (point) and the distance either side of lines (lines). It's usually best to make the 

point value larger than the line value,  so that it's easier to snap to the end points of lines. 

Customizing Photo & Graphic Designer (on page 542) has full details of the Options 

dialog. 

Snapping modes 

You can change the behavior of snap to objects while dragging by tapping a key to 

toggle different modes on and off. These mode changes are effective only for the 

duration of the current drag. 
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S Toggle ‘snap to objects’ on and off. This temporarily overrides the Windows-

>Snap to objects setting. 

G Group snapping. By default, to minimise the complexity and numbers of 

snapping lines shown, objects inside groups are ignored and only the bounds 

and centre of the whole group are considered for snapping. Pressing G turns on 

group snapping so that objects inside groups also contribute to snapping just as 

if they were not grouped. 

A Angled snapping. See Angled snapping below. 

Snapping to original position 

When ‘snap to objects’ is on and you drag an object to move it, the bounding box of the 

original position of the object is indicated by a red dashed rectangle. This also 

contributes to snapping making it easy for you to (for example) move an object in one 

dimension only. However note that you can also constrain the angle of any drag by 

holding down "Ctrl" while you drag. 

Angled snapping 

Xara Photo & Graphic Designer is not restricted to axis-aligned snapping. With Angled 

snapping turned on, the snapping system can snap parallel lines, whatever their 

alignment, and find the intersections between crossing line constraints. So for example 

you can snap the edge of a shape that runs at 30º with the edge of another running at 

the same angle. 

Angled snapping is not on by default, because in most cases it’s not useful. To activate it 

while dragging, simply press the ‘A’ (for Angle) key. Press again to turn off. 

Snapping notes 

Note: Only the objects that are fully or partly visible in the current view are considered for 

snapping. You cannot snap to objects outside the view (except the page). 

Note: Snapping distances are measured in screen pixels so if you have several snapping 

positions close together it’s best to zoom in to make sure you snap to the one you want. 

Note: When snapping text to text, the baseline of the text is favored over any other snaps 

that are within snapping distance. This makes it easy to vertically align one text object to 

another with matching baselines, which is normally more useful than snapping the 

centers or bounding boxes of text for example. 

Guide Objects and Guidelines 

Guide objects and guidelines are objects on a special layer, the guides layer. A guide 

layer is automatically created when you create a guideline (see below), or you can create 

one manually by right clicking in the  PAGE & LAYER GALLERY and selecting CREATE GUIDE 

LAYER (see "Page & Layer Gallery (on page 196)" for more information on layers). 
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Use SNAP TO GUIDES in the Window menu (or key 2 on the numeric keypad) to turn on 

snapping to guide objects. 

Any object placed on the guides layer becomes a guide object. These can be any object 

type including lines at any angle, irregular shapes, and quickshapes. You can create, 

scale, and delete objects on the guides layer as usual, but they always appear as thin 

dotted red outlines; any applied line width or fill color is ignored. This information is 

retained, and if you later move the object from the guides layer to a normal layer, line 

thickness, and colors are shown again. 

You can use guide objects to draw construction lines such as lines passing through a 

vanishing point for perspective drawing.  

Placing objects onto the Guides Layer 

First ensure there is a guide layer in the PAGE & LAYER GALLERY, see above. You can 

create objects directly on the guides layer by selecting it and creating objects as usual. 

 

The Page & Layer Gallery showing a guides layer above 
two other layers, and selected. 

You can also cut or copy 

objects from another layer 

and then paste those objects 

into the guides layer. To 

paste the objects in the same 

relative position on the guides 

layer use the keyboard 

shortcut "Ctrl + Shift + V". 

 

MOVE TO LAYER IN FRONT and MOVE TO LAYER BEHIND on the ARRANGE menu (or right 

click and choose "ARRANGE" > "MOVE TO LAYER IN FRONT/BEHIND") will skip the guides 

layer and so cannot be used to move objects onto the guides layer. 

Creating a guideline 

Guidelines are vertical or horizontal lines and are a quick and easy way to align a series 

of objects on the page. 

 Turn rulers on ("Ctrl + L"). 

 Drag from a ruler onto the page. 

Or 

 Double click on the ruler to create a guideline aligned to the click point. 

This automatically creates a guides layer and puts the guidelines on that layer. 
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Or, using the Page & Layer Gallery (on page 193): 

1. Right click in the Page & Layer Gallery and choose PROPERTIES. 

2. If necessary, click the Guides tab. 

3. Select horizontal or vertical. 

4. Click new. 

5. Type in the required position. 

Deleting a guideline 

Using the SELECTOR TOOL drag the guideline onto the appropriate ruler (the vertical ruler 

for vertical guidelines, horizontal ruler for horizontal). 

Or, right click on the guideline and then choose DELETE. 

Summary of shortcuts on the numeric keypad 

+ Makes a copy while dragging, resizing, skewing, and so on. The original object 

doesn‘t change. 

/ Toggles leaving line widths unchanged during scaling and scaling with changing 

line widths. 

- Toggles leaving fills unchanged during moves, scaling, skewing, etc.  

* Toggles object magnetic snap on and off. 

2 Toggles snap to guides on and off. 

. Toggles snap to grid on and off. 

 

Grouping and ungrouping objects 

The Shadow and Transparency Tools offer different results depending on whether 

objects are grouped or not. For more information see "Transparency" and "Shadows (on 

page 320)". 

You will often create complex shapes from several different objects. The "ARRANGE" > 

"GROUP" menu option (or right click selected objects and choose GROUP) lets you lock 

those objects together to form what appears as a single object. You can then select the 

grouped objects and copy, rescale, move or perform any other operation on the entire 

group. 

To create a group 

1. Select all the objects you want in the group. 

2. Right click and choose GROUP or choose GROUP from the ARRANGE menu (or "Ctrl + 

G") to create the group. 
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Ungrouping objects 

1. Select the group. 

2. Right click and choose UNGROUP or choose UNGROUP from the ARRANGE menu (or 

"Ctrl + U"). 

After this, all the individual objects in the group remain selected. 

To add more objects to a group 

1. Select the group. 

2. Ungroup ("Ctrl + U") 

3. Select the extra objects. 

4. Group again ("Ctrl + G") 

You can also incorporate a group into a second group by omitting step 2. Photo & 

Graphic Designer remembers the original grouping information. If you ungroup the 

objects later, the original group remains. 

Removing objects from a group 

1. Ungroup the objects. 

2. "Shift + click" on the objects you want to remove. This deselects them; the other 

objects remain selected. 

You can then choose "ARRANGE" > "GROUP" to regroup the remaining objects. 

Selecting a single object from within a group 

This feature called SELECT INSIDE, is useful for changing an object's color, for example. 

"Ctrl + click" on the object (you can also use this to select a "group within a group"). 

Pressing "Tab", or "Shift + Tab" moves the selection within the group, to the next, or 

previous object. Once you have selected an object inside a group, you can also use "Alt 

+ click" to select the object under the selected one. 

Groups and layers 

There’s more about layers in "Page & Layer Gallery (on page 196)". 

If all the objects to be grouped are in one layer, the group is created in that layer. The 

group is at the level of the highest member of the group, i.e. the group does not 

automatically become the front object. 

If the objects are in more than one layer, then the group is created in the layer containing 

the object nearest the front. The PAGE & LAYER GALLERY shows you the structure of a 

group. Expand the group node in the Page & Layer Gallery to see the members of the 

group in the gallery, in their stacking order. 
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If you want to group objects together while keeping them on different layers, use a SOFT 

GROUP instead of a Group. See the Soft Groups (on page 149) section of this chapter for 

details. 

Photo Groups 

Photo Groups are very similar to groups, except that they are made up of a base photo 

object plus any number of other objects on top, and they are can be treated as if they 

were ordinary photos by most Xara Photo & Graphic Designer tools.  

Photo Groups are used to keep a photo together with one or more vector objects which 

modify it in some way. For example if you import a photo and then edit it with the Photo 

Tool RED EYE REMOVAL tool, the result is a Photo Group which consists of the photo plus 

the ellipse shapes which remove the red eye effects. Usually Photo Groups also have a 

Clipview around them, which clips all objects in the group to the bounds of the base 

photo. See below for information on Clipviews. See the Photo Handling (on page 354) 

chapter for more information on Photo Groups. 

Editing inside groups 

If you want to edit the objects inside a group, there are broadly two ways to approach 

this. You can either select the objects inside the group and work on them directly in your 

document, or you can double click on the group to open its contents in a separate 

document view. 

Selecting inside 

If you hold down Ctrl and click on an object in the Selector tool, that object will be 

selected even if it’s inside one or more groups. That’s called a "select inside" operation. 

Also some tools will let you directly select objects relevant to them inside groups, just by 

clicking on them. For example in the Photo Tool you can just click on a photo to select it, 

even if it’s in a group.  

It is just as easy to replace symbols as which are part of a group as well, either with a 

replacement symbol or an image, just right-click on the symbol and select REPLACE from 

the context menu.  

Editing group contents 

If you want to edit several objects inside a group, it can get tedious having to keep 

Ctrl+clicking on each one first. So instead you can instantly open the group’s contents in 

a separate sub-document view, to make editing much easier.  

Double click on a group and a new document view opens (or right click on it and choose 

Open from the context menu). It contains only the contents of the group and not the 

group itself, so you can select all the direct children of the group just by clicking on them. 

You can also draw new objects and these will be added to the group when you save your 

changes back. Since the sub-document contains only the contents of the group, you 

won’t see the effects of any group attributes in the sub-document view.   
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Once you’re done editing the group, hit "Ctrl + S" to instantly close the sub-document 

view and save your changes back to the parent document. Or you can close the view 

using the close button in the top right of the window, just as you close ordinary 

documents, and you’ll be prompted to save or discard any changes you’ve made.  

If the group you are editing contains other groups (because the parent document had 

multiple levels of nested groups) you can double-click on them to open those in a sub-

document too. 

Live Copies & Repeating Objects 

You can edit inside a Live Copy just as if it was a normal group – just double click it to 

open in a sub-document view. As with all edits made to the objects inside a Live Copy, 

when you save the changes back, all copies of that Live Copy will be updated. And 

similarly you can edit a repeating object the same way. 

Molds 

 

You can edit the contents of a mold, which is something that is not possible using direct 

selection inside (molds do not allow objects inside them to become selected). Right click 

on the mold and choose OPEN MOLD from the context menu. 

Limitations 

Groups cannot contain layers and so if you introduce any layers while editing a group, 

those layers will be ‘flattened’ when you save the changes back to the parent document. 

In other words all the objects will be moved to the original single layer on save and any 

layer structure you introduced lost. 

Similarly a group can’t contain multiple pages and so any pages you add while editing 

will be ignored and lost when you save back – only the first page is relevant. 

The Automatic Backup facility does not save modifications to open sub-documents. Only 

the parent main document is saved when a scheduled backup runs, in its current state 

without the unsaved group edits. For this reason it’s recommended that you save group 

edits back to the parent document regularly. 

If you close the program or shutdown Windows while you have group sub-documents 

open with unsaved changes, when you next start the program, the main document will be 

loaded and it will include all the group edits that were unsaved at the time of closure. 

Other types of groups 

Special types of group are used by some tools and functions to keep objects together 

and/or to give an object some special behavior.  
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When you anchor an object to text for example, the object is placed in an Anchored 

Group, as shown on the status line when you select such an object. Similarly when you 

make an object repeating (see Repeating Objects (on page 155)) or make it a Live Copy 

(see Live Copies (on page 159)) the objects are placed inside a "Repeating group" or 

"Live copy group" respectively.  

When one of these groups contain a single object, you can directly select that object 

instead of selecting the group that encloses it. Look at the Status Line (on page 49) and 

the Page and Layer Gallery (on page 196) to see this in action.  

Soft Groups 

Ordinary Groups as described in Grouping and un-grouping objects (on page 145) sit on 

a single layer, they cannot span layers. SOFT GROUPS are an alternative way of linking 

objects together where the objects can be across several different layers. 

Selecting one member of a Soft Group also selects all other members of the same Soft 

Group – even members that are on invisible or locked layers. This means when you 

delete, move, rotate or otherwise transform one member of a Soft Group, all the other 

members are similarly modified.  

The status line indicates when a Soft Group is selected. 

Soft Groups are useful for keeping closely related objects together. For example the 

MOUSEOFF and MOUSEOVER states of a web button are Soft Grouped together, so that if 

one state is moved or transformed, so is the other state. 

Creating Soft Groups 

To create a Soft Group, select all the objects that are to be included in it and then choose 

“ARRANGE > APPLY SOFT GROUP” (or press “Ctrl+Alt+G”). Note that if the Soft Group is to 

include members on invisible or locked layers, you’ll need to make those layers 

temporarily visible and editable using the Page & Layer Gallery in order to select the 

objects and Soft Group them.  

An object cannot be a member of more than one Soft Group and Soft Groups cannot be 

nested (soft groups as members of soft groups). 

Removing Soft Groups 

To disband a Soft Group, select it and choose “ARRANGE" > "REMOVE SOFT GROUP” (or 

press “Ctrl + Alt +U”). The objects don’t get deleted, they are just no longer linked 

together by a Soft Group. 

Text Synchronization 

In some circumstances text objects in a soft group are kept synchronized so that if you 

edit the text of one, the others update too. This feature was added before support for LIVE 

COPIES was introduced and LIVE COPIES are much more flexible and powerful, so this 

feature is less useful than it used to be. But it’s still relied upon by many of the templates 

and elements included in the ONLINE CONTENT CATALOG and is commonly used for 
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mouse-over buttons, where both the off and over states of the button need to show the 

same label at all times. When the button off-state label is changed, the mouse-over state 

changes to match.  

Also sometimes "shadow-like" effects can be achieved by placing two or more copies of 

text very close to each other, but slightly offset. Again, editing one causes them all to 

change in sync.  

To stay synchronized, the text objects must: 

 Be all in the same soft group. 

 And have exactly the same text on them at the time when the soft group is created. 

 And either have overlapping bounding boxes, or be on different layers or different 

animation frames. 

If you need text to stay synchronized in other circumstances, use LIVE COPIES (ON PAGE 

159). 

Alignment 

This lets you accurately align or distribute two or more objects. 

Quick aligning 

Select the objects you want to align, and right click the selection to choose ALIGN from 

the drop-down menu, and then do one of the following: 

 Align the objects vertically by choosing LEFT EDGES, CENTERS, DISTRIBUTE CENTERS or 

RIGHT EDGES. 

 Align the objects horizontally by choosing TOP EDGES, CENTERS, DISTRIBUTE CENTERS 

or BOTTOM EDGES. 

Aligning and distributing space 

If you want to distribute space between the objects as well as align them, select the 

objects, right click the selection and choose "ALIGN" > "ALIGNMENT" to display the Object 

Alignment dialog. Alternatively choose "ARRANGE" > "ALIGNMENT" ("Ctrl + + L"). 
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The small diagram at the top of the dialog box shows 

you the effect of selecting each option. The selected 

objects in the document do not change until you click 

APPLY. 

The alignment dialog is a non-modal dialog, which 

means you can keep it on screen and continue to work 

on the document at the same time. So you can change 

tools, draw, and change your object selection, and then 

easily select from the various alignment options. 

If you’ve got your selection wrong, you can change the 

selection, and just click the APPLY button to apply the 

last alignment settings again. This can be a real-time 

saver. 

 

Within 

This section of the dialog controls the boundaries within which you align or distribute the 

objects. The options are: 

 

SELECTION BOUNDS: The boundaries are the outer 

edges of the selected objects. Their relative position 

on the page or spread has no effect. 

 

BOUNDS OF BACK OBJECT: The boundaries are the 

outer edges of the backmost selected object. This 

object is not affected by the alignment. 

You can use this to define the "reference" object when 

you want to align several objects in a row, for instance. 

With the normal "Selection bounds" options on the 

leftmost object is the reference object (the one that 

won't move) 
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PAGE: If the objects are on a single page, the 

boundaries are the edges of the page. (This lets you, 

for example, center objects on the page or align 

against the page edge.) 

 

WHOLE PAGE: In most cases, this is the same as PAGE 

unless you have a double page spread, in which case 

it will use the bounds of both pages.  

 

Aligning 

To align objects, for example, so their left edges are aligned to the left. 

1. Select the objects and right click the selection. 

2. Choose "ALIGN" > "LEFT EDGES" from the drop-down list. 

The selected objects move to align the left edges. 

Alternatively: 

1. Choose "ALIGN" > "ALIGNMENT" or press "Ctrl + Shift + L" or choose ALIGNMENT 

from the ARRANGE menu to open the Object Alignment dialog. 

2. Select the required WITHIN option, e.g. Selection bounds. 

3. Select ALIGN LEFT for horizontal positions. 

4. Leave vertical positions to NO CHANGE. 

5. Click APPLY. 

The selected objects move to align the left edges. 

All the align options act in a similar way. For brevity, only the left align option, shown in 

the illustration of the dialog box is described. Experiment to learn about the other options. 

To quick-select any combinations of vertical and horizontal alignment click with the 

mouse in the diagram:  

 A simple mouse click aligns horizontal and vertical positions to the clicked position to 

any of the nine combinations of top-centrally-bottom/left-centrally-right. 

 "Ctrl + mouse click" leaves the horizontal position unchanged and arranges the objects 

in a to a top, centrally, or bottom aligned row. 

 "+ mouse click" leaves the vertical position unchanged and arranges the objects in a 

left, centrally, or right-aligned column. 
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Distribute 

The distribute options will position all the selected objects evenly across the "Within" area 

(usually within the selection bounds, but it could be the PAGE or WHOLE PAGE). 

Again all the distribute options work in a similar way. The following examples show how 

the different vertical position options align objects: 

 

TOP EDGES DISTRIBUTION: the tops of the objects are 

evenly spaced. BOTTOM EDGES distribution is the 

inverse—the bottom of the objects are evenly spaced. 

 

CENTERS DISTRIBUTION: the centers of the objects are 

evenly spaced. 

 

EQUI-SPACED DISTRIBUTION:the objects are evenly 

spaced from each other. 

The horizontal position options are similar but operate in the horizontal direction. 

So, for example, to distribute this collection of randomly positioned ellipses, so they are 

all equally spaced and aligned to the top edge: 

 

 Select the shapes 

 Display the Alignment dialog ("Ctrl + + L") 

 Ensure WITHIN shows SELECTION BOUNDS 

 Select Horizontal positions: Distribute centers 

 Select Vertical position: Align top 

 Click APPLY 

 

And they will now look like this, all equally spaced horizontally 

and aligned to the top. 

Remember if you make a mistake you can always undo the operation. 

Copying Styles: Paste Attributes 

This lets you copy attributes (such as line pattern or fill color) between objects. It is a 

quick way of applying multiple attributes to an object. 
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The square has a specific color, shadow, 

line and fill style. Copying it and then 

pasting its attributes on to the circle in the 

middle, results in the circle to the right. 

1. Select the object from which you wish to copy the attributes. 

2. Copy the selection to the clipboard. ("EDIT" > "COPY", or "Ctrl + C".) 

3. Select the object(s) to which you want to apply the attributes. 

4. Choose "EDIT" > "PASTE FORMAT/ATTRIBUTES", or "Ctrl + Shift + A". 

The object remains on the clipboard until overwritten by a cut or copy operation. This lets 

you repeat paste attributes as many times as required. 

ClipView 

ClipView lets you hide or ‘clip’ parts of a shape within another larger shape. The effect is 

similar to the Intersect shapes option, described in the chapter on Shape handling (on 

page 188). The difference is that the Intersect shapes option actually cuts the objects, 

whereas ClipView just hides the parts outside the ClipView object. What’s more you can 

then adjust the position of the objects inside the ClipView. 

To create a ClipView: 

1. The ‘window’ object must be behind the other objects 

in the ClipView. If necessary move it backwards. In this 

example the dark ellipse is the window object. 

Alternatively draw the ‘window’ shape on the mask 

layer (on page 339). 

2. Select all the objects you want to be inside the 

ClipView (including your ‘window’ object unless it is on 

the mask layer). 

3. Choose "ARRANGE" > "APPLY CLIPVIEW" ("Q"). All of the 

"window" object remains visible plus those parts of 

other objects that overlap the "window" object. 

 

 

 

Setting the ClipView background color 

The fill color of the original object used as the ClipView is the background color. So either 

set this to the desired color before setting the ClipView or perform a "select inside" ("Ctrl 

+ click") on the background, and then adjust the color. 

Selecting different parts of a clipview 

There are 3 ways to select a clipview in order to manipulate it or its contents. You can 

select the whole clipview object, just the clipping object, or the objects being clipped. 

If you just click on the clipview, the whole clipview object is selected and you can delete, 

move or otherwise transform it just like any other object using the Selector Tool. 
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Right click on the clipview and the context menu that appears has two more selection 

options.  

Select clipping shape 

This selects only the shape that you used to do the clipping. Effectively this is the 

‘window’ through which you see the other object(s) in the clipview. Once it’s selected you 

can move it around or otherwise transform it, to adjust your clipview. 

Select clipped objects 

This selects all the objects in the clipview that are being clipped. Therefore once these 

are selected, you can drag them around inside the clipview to adjust their position 

relative to the clipping shape. 

Selecting objects in the Clipview 

You can perform a "select inside" by holding "Ctrl" and clicking on the desired object. 

This is very like selecting objects inside a group described earlier in this chapter 

(ClipView objects are a type of group). You can now perform most edit operations on the 

object. 

Removing a ClipView 

Just select the object and the menu "Arrange -> Remove ClipView", or press "Alt + Q". 

Soft edged ClipView 

With the whole ClipView object selected, you can adjust the FEATHER slider control on 

the top bar, to give the whole clipped object a soft feathered edge. 

Note: You can have ClipView objects inside ClipView objects. 

Repeating Objects 

It's common to have items like navigation buttons, headers or logos repeating on all 

pages of your website. Or to have the same logo, header or footer on each page of a 

printable document.  

Xara Photo & Graphic Designer provides the ability to repeat any item in the same place 

across any of your pages in a document. When you update one of the copies, Photo & 

Graphic Designer automatically replicates those changes across all pages. 

On most of the template designs the main navigation bars are repeating. You can make 

any object such as a button a repeating object by right clicking it and choosing 

"REPEATING OBJECT" > "REPEAT ON ALL PAGES". The object is copied to the same place 

on all pages, displaying the repeating symbol icon in the top right hand corner. If you 

make any further changes to this item all the copies will be automatically updated. 
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Note: This uses the current page as the source of the repeating items to copy across all 

the other pages. So make sure you're on the right page before updating objects. The 

current page is the one you're working on, and is shown with markers around the page 

corners. Just click anywhere on the page (or even outside it) to make the page current. 

Or click the page in the Page & Layer Gallery. 

 

The red box highlights the repeating object symbol, shown on every instance of the repeating 
object 

If you don't want a copy of the repeating object on a page, just delete it from that page. 

When edited, the repeating object is only automatically updated to those pages that 

already have it. This means you can choose which of the pages in your document should 

have the repeating object and which should not. 

If you want a repeating object on just a few pages of a large website, you can: 

1. First make your object repeat on all pages of your site, using "ARRANGE" > 

"REPEATING OBJECT" > "REPEAT ON ALL PAGES". 

2. Select one of the repeating objects and copy it to the clipboard ("Ctrl + C"). 

3. Hit the Delete key and choose the DELETE FROM ALL PAGES option when prompted. 

4. Now simply paste the repeating object onto each page that needs a copy of it. 
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Editing the contents of a repeating object 

When Photo & Graphic Designer creates a repeating object, the repeating items are 

placed in a containing 'repeating group', similar to a normal group. If you drill down to a 

layer containing a repeating object in the PAGE & LAYER GALLERY, you can see that 

there's a repeating group containing each repeating object on that layer. 

 

Photo & Graphic Designer places each repeating object inside a repeating group 

If you want to edit an item inside this repeating group, press "Ctrl + click" on the item to 

select it inside (on page 117) the repeating group. Alternatively if you go into a specific 

tool you can usually click directly on any object that is applicable to that tool and it will be 

selected inside its repeating group (or any other type of group). So for example you can 

select a rectangle that’s inside a repeating group by simply going into the Rectangle tool 

and then clicking on the shape. 

If the repeating group consists of a single object you can directly select that object 

instead of selecting the repeating group that encloses it. 

As with any other edits made to a repeating object, any edits you make inside a 

repeating group are applied to all instances of that repeating object on other pages. 

Locking a repeating object 

You can lock a repeating object right clicking it and choosing LOCK REPEATING OBJECT. 

Once locked, the object is not selectable. But editing any other copies of that repeating 

object on other pages, which aren’t locked, will change all copies, including the locked 

copy. 
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Headers/Footers 

You may have pages in a document of varying lengths and want some repeating objects 

to be positioned relative to the top of each page and others (e.g. footers) positioned 

relative to the bottom of each page. You can configure Xara Photo & Graphic Designer to 

do this, so header and footer repeating objects will move with respect to the top and 

bottom of each page.  

The position of a repeating object on the page determines whether it is considered to be 

a header or footer. If any part of the object is in the top half of the page, Xara Photo & 

Graphic Designer treats it as a header and will move it to the same position relative to 

the top of each page. 

Objects entirely in the bottom half of the page are treated as footers and  Xara Photo & 

Graphic Designer positions them relative to the bottom of each page, irrespective of page 

length. 

For some repeating objects, this automatic decision making about whether the object 

should be positioned relative to the top or bottom of pages may be inappropriate. So if 

required you can force any repeating object to be positioned relative to the top or bottom 

of pages by right clicking on it and choosing "REPEAT POSITION" > "TOP" or "REPEAT 

POSITION" > "BOTTOM".  

To restore normal automatic positioning behavior to a repeating object, right click it and 

choose "REPEAT POSITION" > "AUTOMATIC". 

Stopping objects repeating 

Right click an object and choose "REPEATING OBJECT" > "STOP REPEATING" to turn off the 

repeating nature of an object, or all of its copies in your website. Choosing STOP 

REPEATING from the "ARRANGE" > "REPEATING OBJECT"  menu also allows this.  

You’ll be asked whether you want to just stop the selected object repeating or all copies 

of the object in the website. Choose the ALL option. Now the different copies of that 

object can be independently edited and the next time one is changed it won’t update any 

of them. 

Use this if, for example, you’ve used REPEAT ON ALL PAGES to copy an object to all pages 

of your website, but then you want to make those objects different on each page so that 

they are no longer tied together.  

STOP REPEATING is also useful if you want to make a copy of a repeating object (eg. a 

footer or logo) on one page and you don’t want that copy to be updated. In this case 

choose the JUST THIS COPY option when prompted.  

Note that you can’t use STOP REPEATING on NavBars which have the SITE NAVIGATION 

BAR option turned on in the NAVBAR DIALOG. That’s because site navigation bars always 

update across the whole website. See the Navigation Bar chapter for more information 

on site navigation bars. 
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Deleting repeating objects 

If you don't want a copy of the repeating object on a page, just delete it from that page. 

Xara Photo & Graphic Designer displays a prompt asking whether to delete just that copy 

or all copies of that repeating object.  

Pressing "Ctrl + Delete" will delete just the selected repeating object without asking 

whether you want to delete all instances or just this one. 

Live Copies 

Live Copies give you a way of having multiple copies of an object that are linked together 

so that if one copy is changed they all change. However each Live Copy can be 

transformed independently, so for example you could have larger and smaller versions of 

the same Live Copy, or perhaps copies with different rotations. 

Live Copies are similar to Repeating Objects, but more powerful because you can have 

multiple Live Copies on the same page and they do not share a common position in the 

way that Repeating Objects do. 

Live Copies are Groups 

In common with Repeating Objects and many other advanced object types in Photo & 

Graphic Designer, Live Copies are a special type of group. The object or objects that 

constitute the Live Copy reside inside a ‘Live Copy Group’. You can see this structure if 

you examine a Live Copy in the PAGE & LAYER GALLERY where it’s called a “Live Copy 

Group”, but on the status line when selected the shorter term “Live copy” is used. 

Local and Global Edits 

The objects inside the Live Copy Group are common to all the linked Live Copies. So if 

you change objects inside the group those changes are reflected in all the linked Live 

Copies. These are “global edits”, because all copies of the Live Copy get the same 

changes. 

However if you transform a Live Copy (move, scale, rotate or skew it using the SELECTOR 

TOOL) the change is not applied to other copies. These are ‘local edits’, so you can 

transform each copy differently if desired. 

As with all groups, you need to select the object or objects inside the Live Copy to edit 

them directly, so that the changes are reflected in all copies. Many tools will do this select 

inside for you automatically if the object you click on is recognized by the tool. So for 

example in the QUICKSHAPE TOOL, clicking on a Quickshape that is inside a Live Copy 

will select the Quickshape inside, so that you can immediately start modifying it with the 

QUICKSHAPE TOOL. 

So for example if you have a photo as a Live Copy, any edits you perform with the PHOTO 

TOOL on the photo inside the Live Copy group are global edits - all copies of the Live 

Copy will get the same photo edit. But if you select the Live Copy, instead of the photo 

inside, and make it bigger by resizing it with the SELECTOR TOOL, only that Live Copy is 

resized. Other copies do not change in size. 
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Creating Live Copies 

You can turn any object or group into a Live Copy. Just select the object and choose 

"ARRANGE" > "LIVE COPY" > "CREATE LIVE COPY". A second copy of the object appears 

and the two copies are ‘linked’ in that if either one is edited the other copy updates to 

match. But you can move and transform the two objects independently, placing them on 

the same page or on different pages. 

You can make more copies of the Live Copy the same way you copy normal objects, 

using copy/paste, duplicate, right-click drag, etc.. Each copy you make belongs to the 

same ‘family’ of Live Copies and so editing one also changes all the others. 

Try this with an example: 

1. Draw a hexagon using the QUICKSHAPE TOOL and make it red. 

2. Go back to the SELECTOR TOOL. With the hexagon selected, choose "ARRANGE" > 

"LIVE COPY" > "CREATE LIVE COPY". Or right click and choose "LIVE COPY" > 

"CREATE LIVE COPY" from the drop-down menu. 

3. A second copy of the hexagon appears and selecting either copy shows “1 live 

copy” on the status line. 

4. Make several more copies of the object, using copy/paste, or any other means. 

Note that each is a “live copy” according the status line when you select them. 

5. Go back into the QUICKSHAPE TOOL and click on any one of the red hexagons. Note 

the status line says “1 Quickshape ‘inside’”. That shows that you’ve selected the 

Quickshape object inside the Live Copy group. 

6. Change the number of sides on the Quickshape from 6 to 8, using the control on 

the infoBar. All copies of the hexagons instantly become octagons. 

Advanced 

 You can apply transparency to a Live Copy and this is treated as a ‘local edit’ and is 

not applied to all linked Live Copies. That’s because transparency can be applied to a 

group and not only to the objects inside the group (see Applying transparency to 

several objects (on page 313)). This allows you to put different transparencies onto 

different Live Copies if desired. The same goes for other operations that can actually 

be applied to a group and not just to its children, like feather and shadow. 

 Live Copies force SCALE LINE WIDTHS and TRANSFORM FILLS switches to be on within 

themselves. So for instance, a thin line in a Live Copy will always become wider when 

you scale the Live Copy up, even if the SCALE LINE WIDTHS switch is off. This is done 

to ensure that Live Copies can be reliably updated from each other without 

unexpected changes. 

 It's not possible to select objects inside two Live Copies at the same time. 

 Pressing "Ctrl + Delete" will delete just the selected Live Copy without asking whether 

you want to delete all instances or just this one. 

Auto-fit to page... 

The AUTO-FIT feature enables you to create flexible documents that adapt to almost any 

size change you might want. This means you can design social media documents once, 

and then easily deploy to a variety of sizes and aspect ratios. You can convert 
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documents from A5 to A4, or A3 or vice versa. And even change orientation, from portrait 

to landscape. 

 

Re-sized Facebook, Instagram and Twitter post templates. 

The feature is controlled by the AUTO-FIT TO PAGE dialog which you can access by right-

clicking on any item on the page and selecting AUTO-FIT TO PAGE… You can also find it in 

"UTILITIES" > "AUTO-FIT TO PAGE...". 
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The Auto-fit dialog controls how items move or stretch as the page size changes 

The AUTO-FIT ALL OBJECTS checkbox controls the automatic behavior of all items in the 

document. The dialog defaults to AUTOMATIC for all items in your document, but you can 

control the behavior of individual objects using the settings in the lower panel. 

The AUTO-FIT ALL OBJECTS checkbox turns the feature on. Bear in mind that even if this 

option is un-checked existing documents that had items marked as footers, or to stretch, 

will continue to behave as usual. This option just enables a more comprehensive, 

automatic positioning of items on the page. 

Width only or Width & Height 

There are two distinct use-cases where you might want automatic positioning of items on 

the page: 

1. Websites, particularly ‘blog’ style websites where the pages are of variable length, 

depending on how much text you have. Here you do not want the position of items 

on the page (typically at the top of the page) to be moved as the page grows.  In 

this case select the WIDTH ONLY option. This means things will be repositioned when 

you change the page width, but not when the page height changes. 

2. Print documents, Social Media documents or Presentations, where you want things 

to re-position and stretch (automatically adapt) whenever the page width or height is 

changed. In this case select the WIDTH & HEIGHT option. This is the default when 

you enable AUTOMATIC FIT. 

So to summarize for most document types, print, presentations and social media, select 

WIDTH & HEIGHT. For websites choose the WIDTH ONLY option.  

Click APPLY to effect the change - you can now test the result by dragging the right or 

lower page edge to see how things move as you adjust the page size. Or alternatively in 

the PAGE OPTIONS (on page 54) dialog, select from drop-down list of common page sizes. 
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Auto-fit for individual page objects 

Once you have enabled the AUTOMATIC FIT option you can control the behavior of 

individual objects on the page. By default everything is marked as AUTOMATIC.  

 

To control the behavior of individual objects just select the item you want to control, un-

check the AUTOMATIC checkbox - which will enable all the lower panel settings. You can 

now set the position rules for your selection. 

Again click APPLY to effect the change - and now test the result by dragging the right or 

lower page edge to see how things move as you adjust the page size. Or alternatively in 

the PAGE OPTIONS (on page 54) dialog, select from drop-down list of common page sizes. 

The options are... 

 

The TOP, MIDDLE and BOTTOM options for vertical adjustment and the corresponding 

LEFT, CENTER and RIGHT, for horizontal adjustments will keep the items the same size (so 

won't be stretched, enlarged or shrunk) and at the same position relative to the edge or 

center of the page. 

So items marked to be TOP, will stay at the same current absolute position to the top 

edge. Items marked as LEFT will remain positioned at the left edge of the page. 
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So if you want a footer to remain at the exact same vertical size and vertical position 

relative to the bottom of the page, set the vertical options to be BOTTOM. Similarly if you 

want an item, perhaps a logo, to remain at the exact same offset in the top right corner, 

irrespective of page size, then set it to be TOP and RIGHT. 

% Position 

 

Items marked with either of these options will not change size as the page is enlarged or 

shrunk, just be moved to remain at the same relative position on the page.  For example 

an item that is 1/3rd of the way across the page will always be 1/3rd across the page. 

% Scale height or width 

 

This is like the AUTOMATIC option - but applying to the selection only, where position and 

stretch occurs with page width or height change. 

Maintain edge offsets 

This option is useful where you want a fixed gap between the edge of the page and the 

item. 

Scale (Locked Aspect Ratio) 

Items enlarge or shrink as the page size enlarges or shrinks but retain the same aspect 

ratio. 

Reset all objects 

This button will remove any and all manually auto-fit settings you have on everything in 

the document. This puts everything back to the AutomatiC setting. 

An Example 

This is a relatively simple social media graphic that is adaptable to just about any page 

size. With the AUTOMATIC options it would work, but the border width and height would 

not remain the same.  So in this case specific items on the page have been marked to 

behave differently. 
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Photo: set to STRETCH - MAINTAIN EDGE OFFSETS.  

 
Center text panel: AUTOMATIC - text is set to center vertically and horizontally. 

 
Background rectangle: set to AUTOMATIC. 

 
Footer text panel: set to BOTTOM and % SCALE WIDTH. 

 

Previewing and testing Auto-fit pages 

A great way to test the adaptability of your page design is to preview and test using the 

PAGE SIZE dialog - right click on the page background - select PAGE OPTIONS... (ON PAGE 

54)  and then the PAGE SIZE TAB. 

 

In the Page Options dialog - the Paper size field has a drop-down list of common page sizes. 

So you can select a preset paper size from the drop down, but a much easier way is to 

unlock the page, which allows you to drag the width and height to any desired value. To 

enable page size dragging, just un-check the LOCK PAGE SIZE option. Now if you move 

the mouse pointer near the right or bottom edge of the page, the pointer changes to 

indicate you can drag the edge to resize. 

Resizing picture and text 

It’s important to understand that when a page is stretched (e.g. if you drag the right edge 

of the page to be wider), text items and images are resized, but the program does not 

distort the text or images. There’s nothing worse than a photo that has the wrong aspect 

ratio, or stretched text. 

So in the case of text objects, when the container of the text is resized, the text just re-

flows within the new container size. So, for example, changing a page from A4 portrait to 
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A4 Landscape the body text is not stretched, it remains the same point size, but the text 

frame is stretched. 

 

In the example above the page is made wider (and less tall). The text remains the same point 
size, but the text frame, and other items on the page have been resized in proportion.  

This is the out-of-the-box behavior when everything is set to AUTOMATIC. Using the 

manual controls you can optimize the behavior, so that for example the width or height of 

items can be fixed. In the above example you can see the height of the header and footer 

has become reduced as the page height has reduced. This might not be what you want, 

and this is where the individual HORIZONTAL and VERTICAL controls come into play - as 

described. 

Resizing text 

If the page is made taller AND wider, then the text will be resized. The example below 

shows a small page on the left, and a much larger Facebook post size version, with 

approximately the same aspect ratio on the right.  If we did not scale the text, then the 

Facebook one would have unreadably small text. 
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Tip:Always design for the smallest page size, it's easier to enlarge a format than to shrink 

it. 

Tip: Don't fill up your text boxes - leave room for content to flow. 

Adding Hyperlinks 

 

Use the Link button to open the Link Dialog. With this dialog you can apply 

hyperlinks to selected text or any other object like photos or graphical elements. 

When exporting your document to PDF (on page 517) this link is preserved. When you 

click the link in the exported PDF file an internet browser will open and display the 

specified web address. 

Note: The links are ignored when exporting to bitmap files or when the document is 

printed  

  

The settings on this tab apply to the selected object(s) or selected text. To add a link to 

just some of the words in a paragraph of text, go into the Text Tool and drag over the text 

you want to link to select it. Then set up the link in this dialog. 

Enter a web or email address to link to that address. If you leave the “CORRECT 

AUTOMATICALLY”  checkbox selected, your address will be adjusted if required when you 

click OK or APPLY. For example, if you enter "www.example.com" it will correct it to 

"http://www.example.com/". 

Select the LINK TO: option to link to another page in the current website. The drop-down 

list allows you to select which page or step to link to. You can also choose this option to 

link an object to the top of the page - creating a rapid jump from the bottom of a long 

page to the top. 
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Select the LINK TO ANCHOR: option to jump the visitor to a specific part of any page in 

your website.  

To setup an anchor point, first go to the page and object you want to be jumped to. 

Select the object and add a name to it by right clicking and choosing the NAMES... option. 

Then select the object to which you want to add the link and choose the anchor name 

you added from the list provided with the “Link to anchor” option. 

When you have created a link to an object you can quickly change its behavior by just 

clicking on the object. A pop-up will appear with the link's details and options to Change 

or Remove the link. 

 

Conflicts in page layouts 

When too many objects on the page are trying to affect each other's positions or sizes in 

too many ways an error message is displayed which says... 

"THE REQUESTED CHANGE IN PAGE LAYOUT IS TOO COMPLEX TO PROCESS. PLEASE 

SIMPLIFY THE PAGE AND TRY AGAIN" 

To fix this, it is necessary to reduce the interactions between objects on the page. This 

means doing things like: 

 Grouping (on page 145) or Soft-grouping things that should move together 

 Removing push where it's not needed especially on objects that are also stretching or 

have "Footer" or "Auto" page positions 

 Setting page position to "Fixed" or "Footer" 

 Removing stretching markup 

 Removing repelling (on page 259) 
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Shape Handling 

Shape drawing tools 

 

Use any of these tools to create regular shapes. 

 RECTANGLE TOOL ("M")  

 ELLIPSE TOOL ("L")  

 QUICKSHAPE TOOL ("Shift + F2")  

The RECTANGLE TOOL creates rectangles and squares.  

The ELLIPSE TOOL creates circles and ellipses. 

The QUICKSHAPE TOOL creates polygons, stars, and SmartShapes. 

SmartShapes 

SmartShapes are a way enhanced functionality can be added to Photo & Graphic 

Designer. SmartShapes are plug-ins. Each SmartShape incorporates its own editing 

controls, usually in the form of small handles you drag to adjust the shape.  

Find SmartShapes throughout the ONLINE CONTENT CATALOG and under the INSERT 

MENU. For example choose "INSERT" > "SHAPE" from the main menu to choose from a 

selection of simple SmartShapes.  

 

Or with the QUICKSHAPE TOOL selected, click on the INSERT button on the InfoBar.  

 

Simple SmartShapes 
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Although there are simple SmartShapes that are just a single shape, the underlying 

SmartShape architecture supports much more complex examples, including charts, 

percentage rings, photo grids, text panels and charts which can all be customized.  

 

Chart and photo grid SmartShapes 

See the topic Photo Grids (on page 355) in the Photo Handling (on page 354) section for 

more detail on editing the Photo Grid smartshapes. 

Editing SmartShapes 

You can edit a SmartShape simply by clicking on the shape in the Selector tool. 

Alternatively, select them using the QuickShape (or rectangle or ellipse) tools from main 

tool bar. 

When selected the SmartShape will show a set of control handles on and around the 

shape, like this: 

 

This is a simple Text Panel 

SmartShape. The blue 

circular handles on the sides 

allow you to stretch the panel 

to be any size. The top right 

corner handle will rotate the 

whole object. The bottom 

right will enlarge or reduce 

the size of the whole 

SmartShape.  

  

Each SmartShape has its own set of control handles. Hold the mouse-pointer over any 

handle for a handy tool-tip. The Status Line (bottom of window) also provides some 

description of the function of each handle. In this example the top left orange handle 

adjusts the rounded corner of the panel background (and most rectangular SmartShapes 

have a similar function). The inset handle at the top right, in this case, adjusts the margin 

around the text. Where SmartShapes contain text, you can edit the text - change its size 
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and font, etc. just as for any other text, using the TEXT TOOL. All shapes show dimensions 

when dragging (in document units). 

 

This percentage segment SmartShape has controls 

to drag either end of the segment (doing so will 

update the value), or using the Text Tool you can 

edit the value, in which case the segment bar is 

changed. The handle mid-way around the arc allows 

you to adjust the thickness of the band. 

The top right handle will rotate the whole thing, the 

lower right will resize it. 

To change the colors in a smartshape, you can select the shape and click the colors on 

the color line or open the COLOR EDITOR (on page 210). Or drag and drop colors from the 

color line onto it. Where there are multiple colors in the shape, the Color Replacement 

(on page 216) dialog will appear allowing you to choose which color you want to change.  

Table SmartShape 

The Table Smartshape is a simple table which supports basic table insertion and editing, 

including adding, removing and resizing rows and columns, various table formatting 

options and automatic formatting of the table to fit contents. You can also paste data 

from other sources like Excel and Google spreadsheets to quickly populate a table.  

 

Find the tables in the "INSERT" menu, or in the CONTENT CATALOG under "COMPONENTS" 

> "PRINT & WEB COMPONENTS" > "TABLES", where you will find a range of designs. 

Table Handle Summary 

Hover over the adjustment handles to see what they do. They are... 
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PADDING Drag to adjust the Outer padding, the Inner padding and the Cell 

padding 

SELECT/REPOSITION Click to select columns and rows - drag to reposition them 

ADD/REMOVE Drag to add or remove columns or rows.  

SHOW/HIDE CAPTION Click to show or hide the table caption title - edit using the TEXT 

TOOL 

COLUMN WIDTH Drag to adjust column widths 

ROW HEIGHT Drag to adjust the height of the rows 

RESIZE Drag to scale - Ctrl + Drag to stretch. Drag to stretch either 

horizontally or vertically. 

Cell borders and merging cells 

Select a cell, range of cells, row or column - then click on the green blob in the corner of 

the selection to open a cell border menu.  

The first 4 controls represent the four edges of the selected cells. You can click to 

highlight any, or all, of them. In the above case the right edge is highlighted. If you now 

adjust a line value, say to select a line width of 2pt, it will apply the line to the right edge 

of the selected cells. 

To merge adjacent cells into a single larger cell select two or more adjacent cells, and 

click the MERGE CELL icon - the last one on the right of menu. Merged cells can be 

restored back to  their original un-merged state, by clicking the same control again. 

Note: only while the Border Control UI is visible does applying line values affect the 

selected edges. if you close the border control, then applying a line width, or line color, it 

will apply to all 4 edges of the selection. 

Adding rows and columns 

When you add a row, the last row of the table is duplicated to create the new row. If the 

table has different background colors for alternate rows, that formatting is maintained as 

you add more rows. Adding columns works similarly. If the table cells contain embedded 

objects or symbols however, then these will not be duplicated. Select rows and columns, 

or ranges of cells using standard CTRL and SHIFT keys. 

Deleting rows and columns 

Drag the row or column orange select handle outwards, away from the table. At a certain 

distance a red cross will appear, if you now let go, the row or column will be deleted. 
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Table cells 

Each table cell has a text column and a background shape, which determines the 

background color of the cell. Use the TEXT TOOL to edit and format text within the cell, 

just as you would edit any other text. You can also place any other type of object in a 

table cell by inserting it embedded in the text. To do this select and copy the object you 

want to insert to the clipboard, place the text cursor in the cell and paste (Ctrl+V). Select 

multiple cells using SHIFT + SELECT or CTRL + SELECT 

Colors and tables 

The table as a whole has a background color and that determines the default color of 

each table cell. But each cell can have its own background color and you can set the 

color of a whole row or column of cells. 

If the table is not already selected, the first click on the table will select the whole table 

(you see all the table’s handles appear). Click on a color to change or replace any of the 

colors used in the table. The REPLACE COLOR dialog will appear allowing you to choose 

the color to replace. 

You can also change the color of all cells in a row or column by selecting the whole 

row/column. With the whole table selected, click on the row or column’s 

SELECT/REPOSITION HANDLE. That selects all the background shapes in the row or 

column. You can then set the background color, or reset the background color, of all the 

selected cells. 

Outlines 

With the whole table selected, the line width control on the top bar shows the width of the 

cell outlines for the whole table. You can change the outline width using that control, or 

remove the visible outlines by selecting NONE.  

To set the color of the outline, right-click on the COLOR LINE and choose SET LINE COLOR. 

You can also select the line colors in the same way as cell backgrounds, by selecting the 

color and selecting LINE COLOR in the replace colors dialog. 

Copying data from other sources 

You can paste tab delimited text data to quickly populate a table - so in Excel for 

example:  

 Select and copy cells  

 In Designer place the text cursor in the top left cell of the destination table - make sure 

the cell is empty  

 Paste using the ‘Unformatted Text’ option 

Timeline SmartShapes 

Timelines are common in many types of documents and particularly in presentations. 

The Timeline Smartshape consists of a line with an object (or group of objects) repeated 

along its length with regular spacing. You can increase or reduce the number of objects 
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on the line, adjust their spacing, size, vertical alignment, etc. using the SmartShape’s 

handles.  

 

Timeline Smartshape with editing handles  

To insert a Timeline, use "INSERT" > "FROM CONTENT CATALOG" > "COMPONENTS" > 

"PRINT & WEB COMPONENTS" > "TIMELINES"  

Timeline Handle Summary 

END HANDLES Drag either end to change the length of the line, or rotate the whole line. 

SPACING Drag to adjust the spacing of the objects on the line and therefore determine 

how much of the line sticks out on each end.  

ADD/REMOVE Click to add a copy of the rightmost object, or drag to add or remove multiple 

objects. If nothing happens when you try to add a copy, that means there is not 

enough space on the line to fit another copy.  Try reducing the size of the 

objects using the Size handle, or extending the line length by dragging it out. 

VERTICAL 

OFFSET 

Drag to adjust the vertical positioning of the objects on the line. 

DELETE Delete an object from the line.  

LINE WIDTH Drag to adjust the width of the line. 

SIZE Change the size of the objects on the line.   

Text Editing 

Many of the timelines include text, which of course you can edit using the TEXT TOOL. If 

you find you can’t fit the text you want into the space available, try increasing the size of 

the objects on the line using the Size handle and then select the text and reduce its font 

size, so you can fit more text in. If the change the font size of all the text on one object, 

you should see the text on all the other objects update too, to help you choose the size 

that fits best.  

Symbol Replacement 

Some timelines include symbols that you will want to replace. Select the symbol inside by 

holding down Ctrl and clicking on the symbol. Then right-click and choose REPLACE 

SYMBOL from the context menu. 
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Chart SmartShapes 

With the chart SmartShapes - see "INSERT" > "CHARTS…" You can just edit the values 

and labels on the charts using all the usual TEXT TOOL attributes, and the graphics 

update accordingly.  

 

Bar Chart, Column Chart, and Percentage Ring 

As with all SmartShapes, double-click to go into the QUICKSHAPE TOOL and you will see 

the SmartShape handles appear. Move the mouse pointer over each handle for a tip on 

what each does. On the bar and column charts there are handles for adjusting the bar 

width, chart width/height, the spaces between the bars, the roundness of the bar corners 

and of course for adding/removing bars. Each bar also has a handle for changing its 

position in the chart  and a handle for changing its value by dragging. If you need more 

resolution or accuracy, just zoom in and drag. Alternatively you can enter any precise 

numeric value, even with decimal places, using the Text Tool. 

Customizing Bar & Column Charts 

You can change the colors of charts easily just by selecting the whole chart and clicking 

a color on the COLOR LINE. The REPLACE COLORS dialog appears to let you choose which 

of the colors in the chart you would like to replace with your chosen color. Similarly you 

can use the COLOR EDITOR (on page 210) to edit the colors - the list of replaceable colors 

appears at the top of the color editor, so select the color you want to edit from that list.  

Sometimes you may need to do more than just replace or edit the existing colors in the 

chart. You can select a specific bar or column by Ctrl+clicking on it in the SELECTOR 

TOOL. That selects just that bar/column inside the chart. Then you can change its color 

directly, or its outline, or even change the type of its fill using the FILL TOOL (on page 

296). If you want to copy the style of one bar onto the other bars, first copy (Ctrl+C) the 

selected bar to the clipboard. Then select one of the other bars and use "EDIT" > "PASTE" 

> "PASTE FORMAT/ATTRIBUTES". 

Changing label and value text styles 

The Chart labels and values can be edited using the TEXT TOOL - you can apply the usual 

text attributes, to adjust the appearance of the text. When you change the appearance of 

a chart label, such as changing the font, font size or color, that change is immediately 

replicated across the other labels for each bar. However this only happens if those other 

labels have the same text style applied (usually BAR CHART LABELS). So if you want one 
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of the labels to be different, perhaps to highlight one of the bars, simply give it a different 

style or use the NO STYLE option in the styles menu to remove the style. The same 

happens with the value text. 

Chart, Bar chart, Column Chart, Graph, Line chart, Pie Chart, Diagram. 

Pie chart SmartShapes 

Find the Pie charts in the Charts section of the Content Catalog. These offer a super-

easy way to create a high-quality vector pie charts, with the program automatically 

calculating the correct percentages for each pie slice. 

 

You can adjust the pie segment values by... 

 By dragging directly on pie segment handles to adjust the % size of each slice. 

 By using a Data Input Form to the enter a simple column of numbers, with optional 

labels 

 By pasting data into the input form from a spreadsheet - you can display the values as 

a percentage or absolute value. It automatically positions the labels around the pie, 

using a common text style. Edit one label style and they all change to match (although 

you can apply different styles to each label if you wish). 

 You can ‘pull out’ to highlight any one segment simply by clicking on it, as shown 

above. 

 The segment colors are based on the Theme Colors used in your document (Theme 

Color 1 to 5 and then shades) so the pie chart will match your document color theme. 

 Or you can easily customize the color of any segment 

As with all the shapes, hover over the adjustment handles to see a function description.  
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The green handle top left opens the shape to allow data input - switch between decimal 

and percentage values. There is a 15 entry limit - but if you enter more than 15 the 

segment labels cleverly reformat to display an indicator pointing to the relevant segment. 

 

Shows the Data Input Form area. You can show / hide this using the green handle top left.  

Using the TEXT TOOL click in the lower data input area and type label, value pairs as 

required. As you edit this the pie chart is updated live. Each time you add a new entry on 

a new line, a new pie segment is created. You can also drag the handles on the edge of 

the pie slices and the corresponding data values change in proportion. 

You can also import data from other sources if you want to - just paste into the data input 

panel. The pie charts also support data taken from Excel and Google spreadsheets, just 

make sure you paste the data as unformatted text. 

Coloring the pie chart 

The pie segments use THEME COLOR 1 TO 5 for the first five segments, and then lighter 

and darker shades of these colors for the next ten segments. If your document contains 

more than five slices, it will use lighter and darker shades of THEME COLOR 1 TO 5 for the 

next ten segments. If you do not have any THEME COLOR defined, the slice will appear 

black and you will have to manually color the segment. 

To color any segment, first click it (this will pull out the selected segment), and now click 

a color on the COLOR LINE. 

Editing label text 

If you change the whole text of any label e.g. the color, font or size, they all change to 

reflect this. To change an individual label, give it an alternative TEXT STYLE (on page 

273). You’ll notice labels on the left side are left aligned and right side labels right 

aligned.  

If you want to change the relative size of the pie to the text, use the orange Radius 

handle to resize the pie. 
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Text Panel SmartShapes 

Find the Text Panel SmartShapes in the ONLINE CONTENT CATALOG under 

"COMPONENTS" > "PRINT & WEB COMPONENTS". Or under the "INSERT" > "PANELS" > 

"TEXT PANEL / MORE TEXT PANELS… " menu. 

 

You can freely edit the text using the TEXT TOOL. If you hover over the SmartShape 

control handles (display by selecting using the SELECTOR TOOL or the QUICKSHAPE TOOL) 

you will see a tooltip explaining the function of each handle. The functionality depends on 

the style of the panel. 

Generally the panels allow you to...   

 Adjust the width and height (and the text re-flows),  

 Change the margin width around the text   

 Round the corners of the whole panel.  

 You can also rotate the whole object and it remains fully functional. 



 

Shape Handling 179  
 
 

 

These text panels are smart in that they grow to accommodate whatever text you put in 

them - drag the bottom centre or top centre handles to change the vertical panel height. If 

you ever add more text than can fit into the panel at that height, the panel will grow to 

accommodate the additional text. But if you later remove text, the panel will shrink back 

no further than the height you last set using the height adjustment handles. This helps to 

keep panel sizes consistent, which is useful where you have a panel occupying a defined 

space or aligned vertically with other panels or objects of the same height. 

Text Alignment 

You can align text vertically within the panels, so it’s TOP, CENTER or BOTTOM aligned. 

This is useful where you have text that you want to edit regularly so the number of lines 

varies. To change the vertical alignment, place the text caret in the text and select the 

VERTICAL TEXT ALIGNMENT button on the text InfoBar.  

 

Then choose an option from the menu. The last option - AUTO-FIT TO CONTAINER, allows 

you to fit any text into any restricted area on a page, so it’s great for text that needs to 

change often where there is restricted space.  

If the panel is full of text with no empty vertical space, then it will look the same no matter 

which of the three alignment options are selected. But the alignment setting also 

determines how the panel grows and shrinks, as text is added or deleted, so the setting 

is still relevant even for ‘full’ panels. Top aligned panels will always grow and shrink from 

the bottom, with the top edge staying fixed. Bottom aligned panels are the other way 

around - they grow upwards with the bottom edge fixed, so these are commonly used at 

the bottom of pages. And centered panels will grow and shrink equally at the top and 

bottom, so the center of the panel is fixed. 

For more info on text area alignment see Vertically aligned text (on page 238) and Auto-

fit to text areas (on page 239). 

  

Many of the panels will allow you to change the width or style of lines or outlines included 

in the panel. For example the Ribbon Panel shown above allows you to change the width 

or style of the dashed circle inside the panel. Just select the whole panel and then use 

the line width control to change the line width. Or with the mouse pointer over the line, 

hold down Ctrl+Shift and use your mouse wheel to adjust the line width. Use the Line 

Gallery (on page 107) to change the line style, corner style, or end cap.  
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A collection of similar panels containing both photo and text can be found in the ONLINE 

CONTENT CATALOG under "IMAGE RESOURCES" > "PHOTO PANELS".  

Arrow SmartShapes 

One of the most popular graphic elements is the arrow. Photo & Graphic Designer 

includes perhaps the most flexible, yet simple-to-use arrow tool - the Arrow SmartShape. 

The great thing about the Arrow SmartShape is that there’s no complex arrow tool to 

learn - the arrow is controlled by dragging a few handles on the shape. So creating and 

customizing an arrow is an interactive, visual experience. As with all the shapes, hover 

over the handles to see a tooltip. 

We provide a library of preset designs, which can be customized as required. Use the 

menu "INSERT" > "SHAPE" > "LINES & ARROWS" to insert an arrow. 

  

The arrow shaft is a line, rather than a filled shape. This means it is possible to apply any 

line effects such as dash or line profile. You can use the standard line END CAP (on page 

107) control to control whether the dash lines have rounded caps or square caps. 

 

 Hold Shift to resize or rotate around center. For example to make a line wider, but 

remain centered where it is, use Shift and drag outwards. 

 It snaps to 45° angles by default. Use Ctrl to un-snap. 

 Shift on the orange handle to produce a balanced (symmetrical) curve. 

 It shows the angle from either end. Interactively, live as you drag. And also length 

(when straight line only) is shown in the current page units. 
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 Unlike legacy (non SmartShape) arrows the line length includes the space for 

head/tail. 

 Accepts and shows the correct line width via the standard line width control.  

Note that the arrows selection in the ONLINE CONTENT CATALOG includes some different 

types of arrows where the head and shaft are formed from a single shape - these  arrows 

are simple smartshapes of an entirely different design and are filled shapes rather than 

lines.   

 

Labeled lines 

These designs are useful as headings, titles, dividers and for labeling in diagrams.  

You can find these in the ONLINE CONTENT CATALOG and in the Insert menu - "INSERT" > 

"SHAPE" > "LINES & ARROWS". As with all SmartShapes, hold the mouse pointer over 

each handle to see a tooltip telling you what the handle does if it’s clicked or dragged. 

  

Various labeled line examples 
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 When you set the label text to a number followed by a dimension unit, the line length 

will automatically change to match the length specified. So for example if the label is 

set to 10cm, as soon as you click away from the label text, the line will update to be 

10cm long. You can enter other units such as inches, px (pixels), mm, etc. If you enter 

a number without any indication of units, the units of the current document are 

assumed (as set in "UTILITIES" > "OPTIONS" > "UNITS").  

 When the labeled line is selected, the line width control on the top bar shows you the 

current width of the line. You can change the line width using that control, or drag the 

line width handle on the line. Or with the mouse pointer over the line, hold down Ctrl 

and Shift and use your mouse wheel to adjust the line width.  

 You can also change the line style, by selecting the labeled line and choosing from 

styles in the Line Gallery (on page 107). Or apply a brush stroke or line profile using 

the  

 Freehand Tool, as shown in the last example above.  

 Drag the end style handle on each end of the line to cycle through a variety of different 

end styles. 

 As you make the label text longer or shorter, the lines adjust their size to fit, without 

changing the width of the overall design.  

 Drag the end handles to move the ends and adjust the length of the line, just as you 

do with arrows . 

Chevron Bar SmartShape 

The Chevron Bar is useful in presentations.  See "INSERT" > "SHAPES" > "ARROWS..." 

 

Chevron Bar smartshape 
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Drag on the different handles to add/remove chevron shapes, re-order, change the arrow 

angles, etc. And of course just click on the text in the TEXT TOOL to edit the labels. 

Flowline SmartShapes 

Great for flowcharts, diagrams, exploded views, etc. The Flowlines behave just like 

Arrows, in that you can change the heads and tails, apply rotation, thickness and so on - 

as well as having 90° segments which you can drag to reposition. Find them in the 

Arrows folder - "INSERT" > "SHAPE" > "ARROWS…"   

 

Creating rectangles and squares 

To create a rectangle 

 

Use the Rectangle Tool ("Shift + F3", or "M"). On the main toolbar. 

Click and drag on the canvas to draw a rectangle. 

To create a square rather than a rectangle, hold down "Ctrl" while dragging.  

You can also enter width and height 

dimensions in the EDITABLE ITEMS menu 

on the InfoBar.   

 

Creating rounded corner rectangles 

 

To give your rectangle rounded corners, select it and then press the 

“Curved corners” button on the RECTANGLE TOOL InfoBar. 

You can then drag on the selection handles shown on the corners to adjust the diameter 

of the rounded corners. 
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You can resize rectangles using either the RECTANGLE TOOL (by dragging on the handles 

shown at the corners) or the SELECTOR TOOL.  

Note that if you change the aspect ratio of a rounded corner rectangle using the 

SELECTOR TOOL (by stretching it in one dimension only) the aspect ratio of the rounded 

corners is not stretched, it is maintained. However if you have multiple objects selected, 

or if you’re stretching a group containing a rounded corner rectangle, the aspect ratio of 

the corners is not maintained. 

TIP: When rotating rectangles or any shape with straight edges, hold down Ctrl to easily 

rotate so that one of the straight edges is exactly horizontal or vertical. 

Creating circles and ellipses 

To create an ellipse or circle: 

 

Select the ELLIPSE TOOL ("Shift + F4", or "L") from the main toolbar. 

The RADIUS AND DIAMETER buttons on the InfoBar automatically create circles. 

 

 
Radius 

 
Diameter 

 
Bounds creation 

Select the RADIUS option to draw circles. The start point of a drag determines the circle’s 

center. 

Select the DIAMETER option. Now the start point of a drag determines the position of the 

edge of the circle. 

With the BOUNDS CREATION button selected, drag on the canvas to draw an ellipse. Hold 

down "Ctrl" while dragging to create a circle rather than an ellipse. 

You can convert an ellipse into a circle at any time by double clicking on a control handle. 

Creating polygons and stars 

Use the QUICKSHAPE Tool to quickly create almost any regular, symmetrical shape with 

sharp or rounded corners. You can then drag the edges to bend the sides, and at any 

time you can change the number of sides or make the object an ellipse, a polygon, or a 

star.  
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1. Select the QUICKSHAPE Tool ("Shift + F2") from the main toolbar 

flyout. 

2. Select CREATE POLYGONS or STARRED SHAPES from the InfoBar. 

3. Select the number of sides either from the menu, or by typing into 

the text box. 

 

 
Creation Modes: Radius/Diameter/Bounds 

 
Polygon 

 
Ellipse 

 
Starred shapes 

 
Round corners 

 
Restore edges 

 
Number of sides 

 
Editable items menu 

 
Editing fields 

 
Insert SmartShapes  

To create the polygon or star drag in exactly the same way as for a circle or ellipse using 

the Radius, Diameter and Bounds Creation buttons to control the origin point of your 

shape. 

 From the center outwards (RADIUS button), 

 Or from an outside edge (DIAMETER button), 

 Or diagonally to create an imaginary rectangle enclosing the polygon (BOUNDS 

CREATION button) letting you distort the polygon or star. 

Polygons or stars with rounded corners 

Select the ROUND CORNERS button or 

double click on a corner point. 

 

 

The polygon has extra handles (radius 

handles) where the rounding starts. To 

increase or decrease the radius, drag any 

of the radius handles. 

To remove the round corners: 

 Click the ROUND CORNERS button. 

 Or double click a control handle. 
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Editing polygons and stars 

The SELECTOR Tool lets you move, rotate, resize, and skew the shapes as normal. The 

SELECTOR Tool is described in Object handling (on page 123). 

Using the QUICKSHAPE Tool, you can resize or rotate: 

 Drag the corner handles. 

 Or select SIZE & ROTATION in the EDITABLE ITEMS menu. Type the required values into 

the text boxes. 

 

Size 

Rotation 

You can also nudge the values using the buttons to the right. 

To move: 

 Drag the handle in the center of the shape. 

 Or use the arrow keys on the keyboard. 

 Or select CENTER in the EDITABLE ITEMS menu. Type the required X/Y values into the 

text boxes. 

 

Apply or remove rounded corners by clicking the ROUND CORNERS button. 

 

Change the polygon to an ellipse by clicking the CREATE ELLIPSE button or 

double clicking the polygon's center.  

Make a polygon star-shaped by clicking the STARRED SHAPES button. Or by 

double clicking on a side.  

Drag the sides to make them curved. Move the pointer over the edge of the polygon (it 

changes to an arrow shape). You can now drag the sides. 

 

On the left are the original polygons. Just drag on 

the sides to create curved sides. 

"Ctrl + double click" on a side, or click the RESTORE EDGES button to make the sides 

straight again. 
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Change the number of sides by typing the number into the menu or 

selecting from it. 
 

 

Editing stars 

To increase or decrease the depth of stellation: 

Drag a star handle or select STELLATION RADIUS & 

OFFSET on the EDITABLE ITEMS menu. Type the 

required values into the text boxes. 
 

The original shape is on the left. 

Or drag the sides to make them curved: 

 

The original shape is on the left. 

You can also nudge the values using the buttons to the right. 

 

Offset from center 

Angular offset 

"Ctrl + drag" one side of a star moves all the sides symmetrically. "Ctrl + Shift dragging" 

moves pairs of sides as mirror images. "Ctrl + double click" on a side, or click the 

RESTORE EDGES button to make all sides straight again. 

Combining shapes 

The COMBINE SHAPES option (select the objects, right click and choose COMBINE SHAPES) 

provides you with a range of advanced options to combine shapes to make new shapes, 

such as adding, cutting, or slicing. You can use combine shapes on any type of object, 

including bitmaps. 

When subtracting, intersecting and slicing, you can either use the topmost selected 

shape to do the “cutting” of the lower shapes, or you can use one of the Photo Region 

tools.  

Select one of the Photo Region tools to draw your cutting shape over the lower 

shapes. The selected area will be outlined with a dashed 'marching ants' effect.   

Then RIGHT CLICK and choose COMBINE SHAPES and then one of the options. The Photo 

Regions shape is used to cut the shapes underneath.  

See Photo Regions and Masks for more information on the Photo Regions tools. 
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Creating holes in shapes 

 

Right click and choose "COMBINE SHAPES" > "SUBTRACT SHAPES". This is similar to using 

join shapes (described above). The differences are: 

 The top shape (or mask shape if the mask layer is used) becomes a hole through the 

other shapes. 

 The line attributes and colors of the underlying shapes are unchanged. 

 Combine shapes physically alters the lines. The only way to restore the original 

shapes is by using undo. 

 The number of overlapping shapes has no effect. 

Merging several shapes into one 

For example, to produce the shape on the right from the three shapes on the left: 

     

1. Create the two circles and the rectangle. 

2. Select all three shapes. 

3. Right click and choose "COMBINE SHAPES" > "ADD SHAPES". 

The new shape takes line attributes and colors from the top shape (in this case the 

rectangle in the illustration). 

Intersecting shapes 

With the INTERSECT SHAPES option, the new object is created from those parts of lower 

shapes that are covered by the top object, or by a mask shape using one of the Photo 

Region or Mask tools (on page 339). 
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Select the shapes you want to mask and the front 

(mask) shape. Or put the mask shape on the mask 

layer.  

 

Right click and choose "COMBINE SHAPES" > 

"INTERSECT SHAPES". This creates a new shape. The 

top shape or mask disappears. 

 

The line attributes and colors of the underlying shapes are unchanged. Areas not 

covered by the top shape or mask are discarded. The top shape can be a group for more 

complex subtracting. Groups are described in Object handling (on page 145). 

Slicing shapes 

Xara Photo & Graphic Designer lets you easily slice shapes into two or more pieces, and 

you can use either a solid object or a line for slicing. For example, to cut a segment from 

a circle: 

1. Create a circle and put a triangle on top or on the mask layer. 

2. Select them both (not required if using the mask layer). 

3. Right click and choose "COMBINE SHAPES" > "SLICE (CUT) SHAPES". 

The edges of the triangle cut the circle into two shapes. The 

triangle disappears. 

4. You can now drag the segment out from the circle: 
 

 

You can also use a line to cut an object: 

The line should be drawn completely though the object 

and extend beyond it (as shown in the illustration). If the 

line is too short, this operation cuts out a thin slice. 

 

 

Slicing complex shapes 

When you use the INTERSECT ALL SHAPES option, selected objects are sliced along their 

lines of intersection.  
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Three selected rectangles, with a 1px 

border.  

 

"ARRANGE" > "COMBINE SHAPES" > 

"INTERSECT ALL SHAPES" slices the shapes 

along the intersected lines. The 1pt 

borders show the outlines of the new 

shapes. 
 

You can then pull the rectangles apart to 

reveal the new shapes. 

 

The line attributes and colors of the intersected shapes are unchanged. 

Joining shapes 

"Arrange -> Join shapes" lets you create holes in solid shapes. Because overlapping 

parts of the same shape are drawn with no fill color (i.e. you can see through the 

overlapping parts), you can use this effect to create holes in shapes but retain the ability 

to break them apart later. 

For example, to create a donut shape: 

1.  

2. Create a second ellipse over the first. (The color of the second 

ellipse has been changed to make it obvious.) 

3. Select both. 

4. -> Join shapes". 

This creates a single shape with a hole in it. 

 

 

 

You can combine or join several shapes. 

The cutout is made using the top object. If that object is a group, you can make several 

holes in one operation. For example, a group of three stars can make a hole in this 

rectangle shape: 
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Groups are described in Object handling (on page 145). 

When several shapes overlap: 

 The top shape (or top group) becomes a hole through the other shapes. 

 The line attributes and colors of the other shapes change to those of the top shape. 

 If several shapes overlay: 

- an even number of shapes overlapping becomes a transparent area; 

- an odd number of shapes overlapping becomes a solid area. 

 The numbers on this example of three circles show how many shapes overlay in each 

area: 

 

The joined shape on the left shows the number of segments which overlap. On the right are the 
original three circles shown unjoined. 

Breaking joined shapes 

Choose "Arrange -> Break shapes". This breaks the joined shape into separate objects, 

but the original attributes will not be restored to the separated objects. You can also 

break several joined shapes in one operation. 

Making shapes editable 

Choose "ARRANGE -> CONVERT TO EDITABLE SHAPES" ("Ctrl + Shift + S") to convert 

predefined objects like rectangles, ellipses, QuickShapes, SmartShapes, and text into 

shapes. This lets you edit their outline like a normal shape. 

This has several applications: 

 You can manipulate just a part of predefined objects after making them editable. 

 You can manipulate text in almost unlimited ways, adding new curves and 

ornamentation almost at will. Note that you cannot edit text converted to shapes as it 

ceases to be text. 
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 You may want to send a .xar file to someone who does not have that particular font. 

As converted text is just a collection of lines and curves; it does not need to use the 

original font. 

However, the disadvantage is that you can no longer edit the objects with their original 

tools. 

For more information on text refer to "Text handling (on page 225)". 

You can also convert lines (open shapes) to the equivalent closed shape, by selecting 

the line and then "ARRANGE" > "CONVERT LINE TO SHAPE". If you have a straight line with 

a 10 pixel line width, converting it to a shape will change it into a filled rectangular shape 

with no outline width. 
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Page & Layer Gallery 

The Page & Layer Gallery 

By default the PAGE & LAYER GALLERY is displayed on the right hand side of the Photo & 

Graphic Designer window when you open the program. You can pin, move or dock the 

gallery - see Galleries (on page 74) for more information. 

 
You can open and close the gallery by clicking the PAGE & LAYER GALLERY tab 

on the Galleries bar, or press F10. 

The PAGE & LAYER GALLERY lists everything in your document, from the pages and layers 

right down to each individual item on the page. It provides a way to select, hide, lock and 

re-arrange these items. 

It works at many different levels: PAGES, LAYERS, PRESENTATION STEPS and OBJECTS. 

The hierarchy of items is like this: 

Pages    

 Layers/steps   

  Page items, which may include 

groups 

 

   Group contents 

Some of the key features of the PAGE & LAYER GALLERY include: 

Page control 

 Displays a list of pages 

 Pages mode displays a narrow list of page thumbnails for easy page navigation 

 Add new page, duplicate, cut, copy and paste or delete pages. 

 Re-arrange the page order by dragging 

 Rename pages (right-click > RENAME PAGE) 

Layer control 

 Displays a list of all layers on each page, from the bottom (usually background layer) 

to the top most layer 

 In a presentation document, displays a list of all presentation steps and layers on each 

page, from the first to the last 

 Create new layers, delete, re-order and rename layers 

 Hide or show layers 

 Lock layers (which makes the layer non-editable) 

 Solo a layer - turn all other layers off 

Object control 

Display a list of all items (objects) on the page in the stacking order they appear on the 

page, bottom to top. 

 Hide or show any item 

 Move up and down the stack 
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 Lock any object so it becomes non-editable 

 Locate and highlight any object in the gallery by clicking it on the page when in 'Locate' 

mode - toggle the LOCATE button on (enabled) and off (disabled) 

 Solo an object - turn all other objects off 

 Move objects into or out of a group using drag and drop, or move an object from one 

group to another. (Note this is only supported for ordinary groups, not anchored or 

repeating groups for example). 

 Rename objects (right click > RENAME OBJECT) 

In addition the PAGE & LAYER GALLERY shows a thumbnail of each page and a tiny 

thumbnail of each item on the page. Hover the mouse pointer over an item to view a 

larger thumbnail. 

 

This shows the MouseOff layer has been expanded to show the contents of that layer. This 
shows a NavBar group and other various groups, text line and text column items, and a couple 
of shadow group items. 
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Hovering the mouse pointer over the tiny thumbnails will display a larger one so you can easily 
identify each object on the page. 

Note the right two columns indicate (and control) whether the items are editable (a pale arrow) 
or locked (padlock icon) and whether they are visible on the page (pale open eye icon) or 
hidden (darker closed icon). 

Clicking on these icons will change the visibility and / or the locked or editable nature of each 
object. 

Pages 

Clicking the PAGES button on the top of the PAGE & LAYER GALLERY (or right clicking in 

the gallery and choosing SHOW PAGE LEVEL) will open pages mode, displaying only the 

pages in the document and collapsing all other opened levels. 

When in pages mode and the gallery is docked, the width of the gallery is reduced to its 

minimum, to take up as little space as possible. Also the number of buttons at the top of 

the gallery is cut down to just those applicable to pages. To leave pages mode, simply 

expand one of the pages to reveal its layers. The gallery returns to its full width and the 

full button set is restored.  

You can select multiple pages in the gallery by Ctrl+clicking on pages to add them to the 

selection, or by holding Shift down  to select a range of pages. Then you can copy, 

paste, delete or re-order multiple pages at once. You can also paste objects from your 

clipboard to the selected pages.  

You can re-order pages by dragging on the selected pages in the PAGE & LAYER 

GALLERY, or by right clicking a page and choosing MOVE PAGE UP/DOWN. 

You can change the page transitions for multiple pages at once by first selecting them in 

the gallery and then changing the settings on the Page tab of the "Utilities" > "Web 

Properties" dialog. This is particularly useful to quickly change the page transition effect 

used for all pages in a presentation at once. 

You can rename a page by right clicking it and choosing RENAME PAGE. As well as being 

a useful way to identify pages in long documents, the page name is used when exporting 

your document as a website.  

Layers 

Everything in your document has a stacking order but with more complex documents that 

have dozens, maybe hundreds or thousands of items, your work area can be become 

cluttered.  

Using layers you can group a collection of items together and then turn the whole 

collection on or off (make it visible or hidden) in one easy operation. Layers can be made 

invisible, to hide parts of your document. You can give layers names, and you can easily 

create new layers or delete them. And you can open a layer and view its contents. 
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When you select any object, the layer it's on is shown on the status line at the bottom of 

the window. 

The Current Layer 

When you create any new object on the page, it's placed in one of the layers, called the 

active layer or simply the current layer. On a blank document this will either just be called 

Layer 1 or, in the case of web documents, it's called MouseOff. The current layer is 

shown with a selection arrow  . 

Important: All new drawn items, shapes, photos, text, and all pasted items, are placed 

on the current layer marked with the  symbol. 

You can change the current layer simply by clicking on its row in the PAGE & LAYER 

GALLERY.  It's important to understand that you can have a selected object on any layer 

or even multiple layers, and these need not be the current layer. The current layer, with 

the arrow, only indicates where new items will be placed. 

 

This example PAGE & LAYER GALLERY shows the current layer is called MouseOff (the current 
page is called news). So if you draw anything new it will be placed on the MouseOff layer.  
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It also shows a shadow group item selected in the document (highlighted in blue) inside 
another group which is on a completely different layer called Holiday photo 2. 

Four layers are hidden (called Holiday photo 4, Holiday photo 3, Holiday photo 1 and 
MouseOver). The 'Page background' layer is locked. 

Make the current layer always visible 

It's possible that the current layer can be hidden or even locked. Just clicking on a layer 

to select it and making it the current layer does not normally change its visible or locked 

state. But there is a preference in the General (on page 543) tab of the Options dialog 

(right click a page and choose PAGE OPTIONS or choose OPTIONS from the UTILITIES 

menu) to make the current layers always visible and editable (unlocked). If you select this 

option then whenever you select any layer in the PAGE & LAYER GALLERY it's made visible 

and unlocked. Moving to another layer will restore the previous visible and locked state of 

the layer you just moved from. 

Layers in PDF documents 

Layers are useful for producing overlays. For example on a floor plan of a building, you 

might have overlays showing the fire points, power outlets or wiring. By putting such 

items on named layers you can easily show or hide them. When saving a document as a 

PDF (on page 517), you can select to enable layers in your PDF document, and so then 

using the Layers control in PDF reader you can turn the layers on or off. 

To enable layers in your PDF file: When exporting as a PDF, select the Advanced option 

on the export screen, and then choose Adobe Reader 6 or higher (PDF version 1.5 or 

higher) from the PDF Version list. And then on the Layers tab of the same dialog, select 

the 'Enable Reader layers..' option. When you view your PDF file in Adobe Reader there 

is a Layers control available. 

Soft Groups and Layers 

Soft Groups (on page 149) are unusual because they are groups of objects that can span 

different layers. (Normal groups have to be contained within one layer). When you select 

any part of a soft group the other parts are also selected, even if they are on hidden or 

locked layers. The PAGE & LAYER GALLERY will show all selected items highlighted in 

blue, but in the case of soft groups these items may be on other layers that you've not 

expanded, and so are not immediately visible.  

See the section on Soft Groups (on page 149) in the Object Handling chapter to find out 

more. 

Layer Operations 

Clicking the LAYERS button on the top of the Page & Layer Gallery (or right clicking in the 

gallery and choosing LAYER MODE) will display only the layers on the current page. This is 

a mode - the Layers button stays depressed. While in layers mode, as you move to 

different pages the layers for the current page are always shown and all other page 

nodes are collapsed. Click the LAYERS button (or right click and choose LAYER MODE) 

again to turn off layers mode.  
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You can re-order the layers, that is, the stacking order on the page, by using drag and 

drop on the layers in the Page & Layer Gallery. 

You can rename a layer by performing a second (slow) click on the layer name. (The first 

click would select the layer.) This is very like file renaming in Windows Explorer. 

Alternatively right click the layer and choose RENAME LAYER. 

Clicking the small right arrow  or double clicking anywhere on the layer row will expand 

the layer to show its contents. Doing the same again will collapse and hide the layer 

contents. 

Holding the mouse pointer over the small layer icons  will show a thumbnail of the 

contents of the layer. 

The NEW LAYER button will create a new blank layer and place it at the top of the stack. 

You can re-arrange the order by dragging it to the required position. 

The DUPLICATE button will copy the layer and its contents and place it on top of the stack 

- that is on top of all other objects on the page. 

Right clicking the layer and choosing NEW LAYER, DUPLICATE LAYER or DELETE LAYER 

performs the same functions. 

Layer Properties 

This opens the Layer Properties dialog. 
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Creating layers and editing layer properties 

Using the Layer tab you can: 

 Create a new layer or edit an existing one. 

 Make the layer editable and visible by default. 

 Define the layer as a web page background that will not appear when printed. 

 Specify that all objects in the layer will only repel text objects (on page 259) within the 

same layer. This prevents text on the layer being repelled by objects in other layers 

and is useful for popup layers in web pages. 

Using guidelines 

The Guides tab allows you to create layer guidelines at precise numeric values and 

choose a color for guide layer objects. 

See the GUIDE OBJECTS & GUIDELINES section in Object handling for more information on 

using  guidelines. 

Pop-up settings 

 

Note: The PRESENTATION LAYER checkbox is only enabled if you are in a presentation 

document. To convert a web document into a presentation document, see Web 

Presentations. 
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Using this tab you can apply animated transition effects to a layer, if it’s used as a pop-up 

layer on a web page, or if it’s a presentation layer. The layer then appears with the 

transition effect when it’s revealed in the exported web page. Use the slider to set a 

transition time from 0-5 seconds.  

In a presentation document, a layer can be set as a presentation by checking the 

PRESENTATION LAYER checkbox. See Website Presentations. 

Note: Turning off the PRESENTATION LAYER option will remove the step from the 

presentation. 

By default when a transition is applied, objects will only slide in/out to the edge of the 

web page. If you would like objects to start from the browser window edges, rather than 

the web page edges, deselect the CLIP TO PAGE edges checkbox in the Website tab of 

the Web Properties dialog. 

Special Layers 

There are several special types of layer. They appear in the Page & Layer Gallery and 

can be turned on and off as usual, but behave slightly differently. 

BACKGROUND LAYERS are non-printing layers that appear at the bottom of the document, 

under everything else. When you apply a color to the page background (drag and drop 

color from the color line) this will create a PAGE BACKGROUND layer automatically. 

Normally this is locked. 

You can also set the color of the pasteboard (the area around the page) by dragging a 

color from the color line and dropping it on the pasteboard. This creates a PASTEBOARD 

BACKGROUND layer automatically. Again, this layer is locked. 

When saving a document as a website, background layers are converted to web page 

backgrounds. See the Web Graphics & Websites chapter for more details on setting web 

page backgrounds and using the background layers. 

The GUIDES LAYER is where guidelines or guide objects are placed.  When you create a 

guideline this automatically creates a Guides layer. See Guide Objects and Guidelines 

(on page 143) in the Object Handling chapter to find out more. 

The MASK LAYER is where mask objects are drawn. This is created and turned on (made 

visible) automatically when you turn mask mode on. See masks (on page 339) to find out 

more. 

PRESENTATIONS STEPS are layers that are steps in a 'slide show'-style presentation - 

presentation documents only. Presentations steps can contain multiple objects and have 

transitions applied, the same as layers, but steps can be displayed by the viewer using 

the right/left keyboard arrow keys. See Website Presentations to find out more. 
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Objects 

Inside each layer (sometimes we just say 'on' the layer) are all the items that make up 

your document; lines, shapes, text, photos, etc. By expanding the layer level the usual 

way (click the  icon) you are presented with a list of all objects in the same order they 

appear on the page, top to bottom.  Because new objects are always placed in front of 

(on top of) all other objects on the current layer, they will appear at the top of the list. 

The Page & Layer Gallery is a great way to find and select items that may be hidden or 

difficult to get to on the page. Using the quick pop-up thumbnail feature you can quickly 

see each item. 
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This also shows a thumbnail pop-up of one of the photos at 
the bottom of the list. 

This example Page & Layer 

Gallery shows the hierarchy 

of document elements. 

The 'news' page is expanded 

and shows 7 layers. The 

'MouseOff' layer is expanded 

to show a collection of objects 

inside this layer, starting with 

a navbar group, five groups, 

two shadow groups, a text 

line and two text columns. 

One of the groups is 

expanded  to show a shadow 

group, a text column, and 

another group, which is 

expanded to show just one 

item inside it, a clipped photo, 

which is being displayed as a 

larger thumbnail as the 

mouse pointer hovers over it. 

The text column is selected 

on the page and so 

highlighted in blue. 

As you change selection on 

the page, the Page & Layer 

Gallery updates to reflect this, 

showing the selected item/s 

highlighted in blue. 

Vice versa, you can select 

any item in the Page & Layer 

Gallery by clicking on it, and it 

will select the corresponding 

item in the document as well. 

 

Shadows, Bevels & Contours 

Each of these effects creates a new object attached to the original item. For example 

when you apply a shadow to a shape, really what's happening is that a separate shadow 

object is created and tightly grouped with the shape - so they are permanently attached 

to each other.  The same applies to a bevel and contour. In the Page & Layer Gallery 

these items are shown as Shadow Group, Bevel Group or Contour Group. You can 
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expand this group and inside you'll see the original shape, and the shadow (or bevel or 

contour). 

Because these effects are tightly grouped to the object, you'll find many operations will 

also change the parent object, e.g., if you move or delete the shadow object, then the 

shape to which it's applied will move or be deleted. You need to use the appropriate tools 

to change most of the attributes of the shadow, bevel or contour. 

Finding Objects 

With any item selected on the page, click the LOCATE button on the top of the PAGE & 

LAYER GALLERY to locate the item in the gallery. 

Hiding Layers and Objects 

The rightmost two columns of icons in the Page & Layer Gallery control the visibility and 

locking of layers and all objects on the page.  

Clicking on the open eye  icon will hide the layer or object on the page, and the icon 

will turn to a closed eye . Clicking again will revert the layer or object to be visible. 

When any item is hidden, it becomes invisible on the page and can no longer be seen or 

selected. The way to get hidden items back is to click its closed eye  icon. 

Alternatively you can click the MORE... button and select SHOW ALL ON PAGE option, which 

un-hides all items on the current page. 

Locking Layers and Objects 

Clicking the open padlock icon  on the right end of an object or layer row will lock the 

layer or object (icon changes to a closed padlock ). Now you cannot select this object 

or any object on that layer. Any clicks on locked items will go straight through it, as if it's 

not there, and select items underneath. Clicking the padlock icon will unlock that object 

or layer again. Alternatively you can click the MORE.. button and select the UNLOCK ALL 

ON PAGE option. 

Soft Groups 

There is one exception to the locked rules. If a locked item (or item on a locked layer) is 

part of a Soft Group (on page 149), then selecting and operating on that soft group will 

also select and operate on any locked items in that soft group (this is the intended 

operation of soft groups). 

Solo Mode 

If you click any of the  icons in the column next to each layer, it will 'solo' this layer 

which means it hides everything else, except this layer. You can now work on this layer 

in isolation. Clicking the  icon again will restore everything back to how it was before. 

 



 

 204 Page & Layer Gallery 
  

 

 

You can also click and drag down the column of  icons to quickly browse through the 

layers in isolation from everything else. 

To exit the Solo mode, click the  button again. 

Show All & Unlock All 

 

These two controls on the top of the PAGE & LAYER GALLERY are a short-cut to show all 

items on the current page or unlock all items. They are a temporary override of all the 

individual object and layer settings. Clicking the controls again will restore the previous 

state. So this is a quick way of showing or unlocking everything, on all layers, performing 

some operation, and then restoring the previous state. 

The Unlock all button is useful if you have a locked object on the canvas that you want to 

unlock, without having to first locate it in the Page & Layer Gallery. Turn on ‘Unlock all’, 

then right click on the object on the canvas and choose the Unlock option from the 

context menu. Then you can turn ‘Unlock all’ off again. 

When either button is selected (the buttons are shown pressed in), then it's not possible 

to change the state of individual items. Un-select the buttons to enable the normal 

operation of the layer visibility and locking state. 

Clicking the MORE button will display menu options to SHOW ALL ON PAGE and UNLOCK 

ALL ON PAGE. 

Moving Objects Between Layers 

There are several ways to move objects between layers. First select the object or objects 

you want to move, then; 

 CUT the object ("Ctrl + X" or right click and CUT). Ensure the target layer is the current 

layer (shown with  , click the layer if it's not) and then right click and choose PASTE or 

PASTE IN PLACE. Note that if you cut or copy multiple items that are on different layers, 

the layer structure is preserved when you paste. Items are pasted to the same layer 

they were copied/cut from, instead of being pasted to the current layer. If you want to 

paste all such items to the current layer, ignoring the layer structure, use the PASTE IN 

CURRENT LAYER option instead. If you want to retain layer structure, choose PASTE IN 

PLACE IN CURRENT LAYER. These paste options are also in the clipboard fly-out bar on 

the top bar, as well as the EDIT menu. 

 Right click and choose ARRANGE then MOVE TO LAYER IN FRONT / MOVE TO LAYER 

BEHIND to shift the selected objects one layer up or down. 

 Ensure the target layer is selected as current, then find the selected item in the PAGE & 

LAYER GALLERY (click the LOCATE button), right click and select MOVE TO CURRENT 

LAYER. 
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Color Handling 

Xara Photo & Graphic Designer gives wide control over applying, creating and altering 

the colors of objects. For simple documents, you can just choose colors from the on-

screen color palette, the Color Line.  More advanced color operations are described later. 

The color line 

The Color Line is displayed at the bottom of the window. It shows you the current fill and 

line colors, provides access to the color editor and provides a palette of pre-defined 

colors including a special "no color". 

 

 
Color swatch:The outer rectangle of the color swatch shows the line color and the 

center rectangle shows the fill color. These are the colors of any selected objects, 

or the current color attributes if no objects are selected. 

 
This button provides access to the COLOR EDITOR (ON PAGE 209). 

 
Color picker:  Use the eye-dropper to pick a color from any part of the document or 

any part of the computer screen. See Using the eye-dropper to pick colors (on 

page 209) for details. 

 
NO COLOR: Clicking this applies a "no color fill". Shift-clicking applies "no color" to a 

line. Note that this is not the same as 100% transparent. "No color" and 

transparency are different. A shape with transparency applied remains a solid 

shape whereas a shape filled with "no color" is effectively hollow. The NO COLOR 

button can also be used to restore the original colors to a photo which has had a 

contone color applied. 

 
Current Fill color - the fill color of the currently selected object (displays a 

diamond marker on top left). 

 
Current Line color - the line color of the currently selected object (displays a 

diamond marker on top right). 

If the length of the Color Line exceeds the window, you can scroll through the Color Line 

with the scroll bar below or by "Alt + dragging" the Color Line. 

Xara Photo & Graphic Designer provides several options for the displayed size of the 

Color Line (described in Customizing Photo & Graphic Designer (on page 560)). 

If you do not want to display a Color Line, deselect "WINDOW  > BARS > COLOR LINE". 

Colors on the color line 
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Named (Theme) Colors: First comes the Named Colors (if present in the 

document, see below). Named colors are used to give templates and designs 

theme colors, so that the color scheme of a design can easily be changed without 

editing every object in it individually. 

 
Linked Colors are represented differently on the color line by smaller rounded 

rectangles, so it's much easier to distinguish which are normal independent Named 

Colors and which are linked to a parent. See Creating a Tint, Shade or Linked color 

(on page 221). 

 
Palette colors: There are 46 pre-defined palette colors. There are 5 shades of 7 

standard hues and 10 shades of grey, black and white. Palette colors are not 

editable (i.e they are not Named Colors) and are designed as a simple, limited 

selection of colors to apply to objects (either by dragging on to the object or 

clicking). 

Little markers in the color icons shows which of the named colors (if any) or  palette 

colors have been applied to the selected object(s). 

 
Diamond markers show the colors used by the selected objects. A diamond 

in the top-left corner  indicates the fill color, in the top-right corner indicates 

the line color. 

 
Cross-shaped markers show the current color attributes if there are no 

objects selected. Line color on the right, fill color on the left. 

 
Triangular markers show the colors of a fill if you have applied one. 

This works also when choosing a color with the color picker from existing objects, see 

Using the eye-dropper to pick colors (on page 209). The color line markers update 

immediately and indicate the color of the object under the eye-dropper as you're dragging 

around. 

Re-ordering colors on the color line 

Only named colors can be re-arranged on the Color Line. "Ctrl + drag" colors along the 

Color Line. This also reorders the COLOR GALLERY (on page 223).  

Color line context menu 

Right click on a color on the Color Line to show a context sensitive menu with the 

following options: 
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EDIT  Opens the color editor with the selected color (not 

available for palette colors) 

REPLACE COLOR This option is shown only when the selected object has 

multiple component parts or multiple colors, such as a 

button group. 

SET FILL COLOR / SET LINE 

COLOR 

Set the fill or line color of the selected object with this 

color 

SET TEXT BACKGROUND Set the the color for a text background - like a 

highlighter. 

RENAME Rename a named color (not available for palette 

colors) 

DELETE Delete a named color (not available for palette colors) 

OPTIONS Opens the "PAGE OPTIONS" > "VIEW" tab where you 

can change the appearance and attributes of the Color 

line. 

If the selected object is a bitmap, the fill and line color options are supplemented with SET 

CONTONE DARK COLOR / SET CONTONE LIGHT COLOR. See Bitmap coloring (on page 303) 

for more information. 

When right clicking the “no color” swatch, the fill and line color options are replaced by: 

CLEAR FILL COLOR / CLEAR LINE COLOR. This sets the selected object's relative attributes 

to "no color". When applied to a contoned photo/bitmap, this restores the original image 

colors. 

Applying fill & line colors by drag & drop 

 To apply a fill color to an object (selected or unselected), drag a color from the Color 

Line and drop it into the center of the shape. Alternatively right click and choose FILL 

COLOR to display the color editor. 

 To set the line or outline color, drop it on the line, not the center. 

 To change the page background color, "Ctrl + drag" a color onto the page background. 

When dragging colors an indicator beside the pointer tells you what effect dropping the 

color will have: 

 

Set flat fill color (seen when you drag over an object) or the intermediary colors of 

a multi-color fill (on page 305) 

 

 

Set line color (seen when you drag over a line). 

 

Set start color of graduated fill (seen when dragged over start of fill). 
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Set end color of graduated fill (seen when dragged over end of fill). For three and 

four-color fills, a number is added to mark the according end color handle. 

 

Set page background color (seen when you drag a color onto the page). 

Instead of drag & drop, if you have an object selected, you can just click on the Color 

Line. If only open shapes or lines are selected, this will set the line and the fill color. In 

any other case, you can alter the line color by "Shift + clicking" on the Color Line. 

If a bitmap or a bitmap-filled shape is selected, then clicking on Color Line will contone 

the bitmap. That means, the bitmap is converted to greyscale (black and white) and the 

used color is used as a contone light color. The contone dark color is usually black. You 

can set both contone colors via the Color Line context menu (see above). See Bitmap 

coloring (on page 303) for more information. 

 

To set a fill or line to no color (clear), perform the 

operations as outlined above but use the "No color" 

option instead of a color. 

 

Editing an object’s color 

To edit the fill color of the selected object(s): 

 Choose "UTILITIES" > "COLOR EDITOR" ("Ctrl + E"). 

 Or click the EDIT COLOR icon on the Color Line. 

 Or right click the object and choose FILL COLOR 

 Or double click on the current line and fill color icon on the Color Line (the edge of the 

leftmost panel). 

To edit the line color of the selected object/s 

 "Shift + click" on the EDIT COLOR icon 

 Or double click on the current line and fill color icon (the edge of the leftmost panel). 

This displays the COLOR EDITOR which allows you to select from any color of the 

spectrum. Unlike most graphics programs the Color Editor can remain on screen while 

you continue to work. It changes to reflect the color of the selected objects, and the fact 

that you can also drag the lower right corner to resize the COLOR EDITOR window means 

that you can easily and precisely adjust the color of the selected object.  
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The Color Editor (simple) 

The color editor has a simple and advanced mode. 

 

 
Eye dropper color picker 

 
Advanced options 

 
Drag here to chose a shade of the selected hue 

 
Drag here to select a color hue 

The easiest way to create a new color is to select the hue along the bottom color strip. All 

possible shades of this hue are then shown in the top section, so just click or drag in the 

top section to select the new color. You’ll notice the selected objects change color as you 

adjust them in the color editor (called "live preview"). 

For example to select a pink color, which is a pale shade of red, select red along the 

bottom section and then select a very pale red (pink) from the top right area of the top 

section. 

Using the eye-dropper to pick colors 

Instead of selecting hues and shades on the COLOR EDITOR you can instead pick a color 

from any part of the document or any part of the computer screen—even from other 

windows and programs. 

To do this just click and drag on the eye dropper icon. As you drag you see the color 

editor continuously picks up the color under the eye dropper. Release the mouse button 

when you have the desired color.  This is an easy and quick way to use the same color 

again or copy colors from photos or from one object to another. 

If the object under the mouse pointer is complex (eg. has transparency applied) and the 

color cannot be determined, screen RGB color is applied. 
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The color sampler shows a small popup at the mouse 

pointer which indicates the color that is being sampled at 

that point. This will either be the palette color name, the 

name of a named color, or the color model and color 

value. 

 

Advanced color operations 

 

Click the SHOW ADVANCED OPTIONS icon on the color editor to reveal 

the lower part of the dialog that provides more options. 

 

The Color Editor in detail 
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Shows what you are editing 

 
New named color 

 
Show/hide advanced options 

 
Eye dropper color picker 

 
Previous color 

 
Current color 

 
Color panel (Color model dependent)  

 
HSV hue selector 

 
Numeric values (Color model dependent)  

 
RGB hex color value 

 
Color model (HSV, RGB, CMYK or grayscale) 

 
3D editor mode option (only RGB & CMYK) 

 
No color patch (only available when editing local color) 

 
Make Named Color local to Frame/Layer 

 
Rename named color 

 
Color editor help 

 
Type of color: Normal, Spot (if available), Tint, Shade or Linked 

The illustration shows the full version of the COLOR EDITOR. Click HIDE ADVANCED 

OPTIONS to display the smaller, simpler version. 

Previous and Current color 

As you drag on the color editor the two small color swatches in the upper right of the 

color editor show the current color and the previous (before you started changing the 

color). This is useful if you want to make a small change and want to compare the old 

and new colors. 

3D color editor 

When editing RGB or CMYK colors the editor can be put into an advanced 3D mode that 

displays colors in a color cube. Some people may prefer to work this way. 
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Specifying colors in the Color Editor 

 

Shows the expanded color editor, with the HSV 
picker on the left, RGB picker on the right. 

You can enter precise RGB (or HSV or 

CMYK) color values in a number of 

ways. The most common requirement 

for web graphics is to enter a 

hexadecimal RGB color. 

You can do this with the color editor 

showing either HSV colors (the default) 

or showing RGB colors. 

To select the RGB picker, right click on 

the dialog and select RGB. This allows 

you to enter RGB values as 

percentages or 0-255 values. 

  

Percentages are used by default, but Photo & Graphic Designer allows you to change 

which format is used. To do this: 

1. Display the UNITS tab of the OPTIONS dialog box (UTILITIES -> OPTIONS). 

2. Click the appropriate radio button in the COLOR UNITS section. 

3. Click OK to close the dialog box. 

Limit to Browser palette 

When clicked this button will shift the selected color to be one of the 216 common web 

browser palette colors. This is a legacy system that is no longer particularly important or 

relevant, as nearly all computers can display millions of colors, and there’s no benefit in 

restricting web graphics to only this limited palette. 

The color models 

Color models let you define a color in terms of different color components. RGB and HSV 

are typically used for screen use. If you know your document is going to be printed and 

require very specific CMYK color values, then you can use CMYK colors. 

Unlike some graphics software, Xara Photo & Graphic Designer allows you to mix RGB, 

HSV and CMYK colors in the same document. 

Models provided by Photo & Graphic Designer are: 

 RGB (Red–Green–Blue), 

 CMYK (Cyan–Magenta–Yellow–Key), 

 HSV (Hue–Saturation–Value), 

 Grayscale. 
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RGB and HSV colors are stored within Photo & Graphic Designer in 24-bit format. This 

gives you 16.7 million possible colors. 

CMYK colors are stored in 32-bit format. When printed or output as EPS or PDF they are 

output in CMYK format. 

CMYK colors and transparency effects 

When using any effect that involves transparency, including feathering, color calculations 

are performed in RGB. This is also true of live effects. 

Transparency is described in Transparency. 

This means that if objects are defined using CMYK colors, that any part of them that 

involve transparency of these effects will be output in RGB colors, and this can cause 

slight color shifts when printed on some devices. 

CMYK colors are best used when you require precise printed CMYK values (such as a 

company logo that has to be reproduced as an exact CMYK color), and thus typically 

would not be used with transparency or other effects that alter the color. It is therefore 

recommended that if using CMYK colors on shapes, that you avoid transparency or Live 

Effects on such shapes, or on any shapes that are on top or overlap. 

Colors on the screen and on the printer 

One problem with computer screens is that their colors do not match the available colors 

on a printer. Screens emit combinations of red, green, and blue. The brightness control 

has a dramatic effect on displayed colors. Printed images reflect combinations of cyan, 

magenta, yellow and black. 

As an example, pure green on computer screen is a fluorescent bright color that is 

impossible to reproduce accurately on any printer. Similarly pure blue on a computer 

screen will often print as a much darker purple-blue. Technically, the range of colors on a 

computer screen (known as the "color gamut") is far greater than that on a printer. So 

there will always be differences between screen and print colors. 

Xara Photo & Graphic Designer provides the ability to simulate how printed colors will 

look. Select the "WINDOWS -> SHOW PRINTER COLORS -> SIMULATE PRINT COLORS" menu 

to get a better idea of how your colors will look when printed. This is an approximation 

only since printers vary slightly, but it is far more accurate than normal screen colors. 

Tip: To get bright blue on a printer, select a color on screen that is almost pure cyan 

(printer’s cyan is much more blue than screen cyan). 

Local colors and Theme colors 

Photo & Graphic Designer has two types of color: 
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 LOCAL COLORS are used in only one place in the document. Each object has a 

separate color and nothing is shared. This is useful if you want to change the color of 

an object without affecting other objects. Local colors are the easiest method and best 

for simple documents that use relatively few colors. "Applying color" and "Editing an 

object’s color" above describe local color handling. 

 THEME COLORS (OR NAMED COLORS) can be used again and again in the document. (As 

such, they are like styles in a word processor.) Any edits you make to a Theme color 

are immediately reflected on all objects and parts of the drawing that use that color. 

You can also copy Theme colors between documents. Theme colors appear on the 

Color Line and in the COLOR GALLERY. If there are any Theme colors already present 

in the design and you import or paste templates from the Designs gallery containing 

Theme colors with the same name, you will be asked if you want to match the actual 

color of the imported Theme colors to the existing ones. The Theme colors in most 

templates are consistently named so when you import elements from different themes 

colors are matched perfectly. 

IMPORTANT: If you just select an object on the page that has a NAMED COLOR applied to it, 

and alter it with the color editor, this will always turn it into a LOCAL COLOR instead of a 

NAMED COLOR (because it is assumed that if you try to edit the color of the object that’s 

what you mean to do. If you really want to change the NAMED COLOR so this and all 

occurrences of the color change, then you should do so by editing the named color). 

Creating your own color schemes 

It’s very easy to create your own color scheme files, which you can pass on to other 

Photo & Graphic Designer users for them to apply to designs created with the same 

theme. 

1. Load one of the page templates for the theme. Choose one which shows off all the 

colors of the theme most effectively. You can add more elements to the page if 

required, to help show off the range of theme colors. 

2. Edit the named colors of the theme one at a time, as described in the ‘Editing 

named colors’ section (on page 217) below. 

3. Once you are happy with your new color scheme, use "FILE" > "SAVE AS" to save it. 

The filename you choose MUST include "themecolorscheme" as part of the 

filename. That is how Photo & Graphic Designer  identifies color scheme files – just 

by looking for that sequence in the filename. It’s a good idea to also include the 

name of the theme to which the scheme applies. For example a new blue color 

scheme for the "Beta" themeset could be named something like 

"betathemecolorschemeblue.web". 

To test your color scheme, drag and drop it from File Explorer onto a page that still has 

the default theme colors. The page should be instantly re-colored using your color 

scheme. 
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Creating new named colors 

If you want to use the same color in different parts of the drawing, and there is any 

chance you might want to change that color in future, it is highly recommended that you 

create a NAMED COLOR. This is easy in Xara Photo & Graphic Designer: 

Select an object whose color you want to use and then click NEW NAMED COLOR in the 

COLOR EDITOR. 

Click to create a new named color Give the color a suitable 

name, like "car color" and 

click create. You will see 

the new color added to the 

COLOR LINE. 

You can now apply this 

color to any object the 

usual way, by drag-

dropping it from the Color 

Line or just clicking (or right 

clicking to use it as a line 

color) to apply as the fill 

color. 

When you edit a named 

color, all objects that use 

this color will change. 

 

 



 

 216 Color Handling 
  

 

 

Replacing colors 

Photo & Graphic Designer makes it easy for you to recolor complex grouped objects 

such as buttons, text panels, navigation bars etc, by listing the colors used and 

prompting you to choose which one you want to replace. 

 

The color replacement dialog lets you select which color to replace in the group.  

Recolor an item in one of the following ways: 

 Drag and drop a color from the color line onto the item. 

 Select your item and then click a color on the color line. 

 Select the item and then bring up the COLOR EDITOR (ON PAGE 210) (Ctrl+E).  

The editor will display a list of the item's colors in the drop-down menu at the top of the 

editor. Select the one you want to edit and then use the color editor as normal to edit it.   

Note that when replacing colors in graphics this way, you can replace the use of named 

colors with unnamed/local colors, or vice-versa. So for example you could take a button 

that uses Theme Color 1 and replace Theme Color 1 with Theme Color 2. From then on, 

editing Theme Color 2 in your document would change the button color too. Or replace 

Theme Color 1 with a local color, so the button is no longer linked to any theme colors at 

all. And you can use this facility to quickly apply named colors to graphics that were not 

originally designed to use named colors at all.  
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The pen item is selected and the Color Editor displays the range of color replacement options 
available.  

Note that when an object with multiple colors is selected, the dropdown list in the color 

editor lists only those colors in it. The Local fill color, Local line color and list of named 

colors are not included in the list in this context, to avoid making the list too long and 

potentially confusing.  

  

Changing background colors 

Drag-drop colors from the color line onto the page or pasteboard background to set the 

color of either. If there are multiple colors in the background, the Replace Colors dialog 

will be shown to let you choose which color to replace. It works the same way as 

described above for groups with multiple colors.  

To use the color editor to change the background colors, right click on the page and 

choose "PAGE BACKGROUND">"EDIT PAGE COLOR", or on the pasteboard background and 

choose "PASTEBOARD BACKGROUND">"EDIT PASTEBOARD COLOR".  

Editing named colors 

There are four ways to display the color in the COLOR EDITOR (on page 210) so it can be 

edited: 

 Choose from the menu in the COLOR EDITOR. 
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 Or right click on the color on the COLOR LINE and choose EDIT from the menu that 

appears. 

 Or drag & drop a color from the Color Line onto the COLOR EDITOR. 

 Or drag & drop a color from the COLORGALLERY (described later) onto the COLOR 

EDITOR. 

You can then edit the color as required. All objects that use this color are automatically 

and immediately updated to show the new color across all pages of your document. 

Renaming named colors 

While editing a NAMED COLOR, right click on the COLOR EDITOR and select RENAME 

 Or select the color in the COLOR GALLERY and select the NAME button, or 

 Or right click the color on the Color Line and select RENAME. 

Deleting named colors 

To delete a named color: 

1. In the COLOR GALLERY, select the color or colors you want to delete. 

2. Click DELETE in the COLOR GALLERY. 

Or: 

Right click on the color on the Color Line and choose DELETE. 

Deleting unused color 

To clear the Color Line of unused colors, open the Color Gallery (on page 223) and 

select a range of colors (click on one and "Shift-click" on another) and then select the 

"Delete" button. This will ask whether you want to remove just the unused colors. 

However note that by default unused named colors are automatically deleted when a 

document is saved or loaded. You can change this option in the View tab of the Utilities-

>Options dialog. (on page 559) 
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Importing named colors 

When a design is imported into the current document (e.g. import from the ONLINE 

CONTENT CATALOG, import a XAR file or paste objects in from another design) if there are 

any named colors in the imported design which have the same names but different color 

values as colors in the current design, an alert appears as follows: 

 

If you want the imported objects to inherit the colors of your current design, choose the 

“MATCH” option. This makes all objects using a given named color use the existing 

instance of that color as it appears in the current document.  

Alternatively if you want the imported objects to keep their own independent colors, 

select the “DON’T MATCH” option. This adds new named colors into your design, with a 

number appended to the color names to distinguish them from the colors already in the 

current design. This allows the imported objects to keep their original colors.  

Note that if you import objects from lots of different designs and choose “DON'T MATCH” 

each time, you will end up with a large number of separate Named Colors on your color 

line. This is rarely useful. So a better option is to use the Replace Color facility described 

above to change the colors of objects where you don’t want them to pick up the theme 

colors of your document.  

The same prompt is shown if there are Text Style definition differences between the 

document and the imported design. So seeing this prompt does not necessarily mean 

that there are different named color definitions – it could just be due to Text Style 

differences. See the Text Styles section of the Text Handling chapter for details. 

The match prompt above includes a “DON’T ASK ME AGAIN” checkbox. If you check this, 

the option you choose will be assumed for all future imports, without asking you again. 

However this only applies during the current session, so after a program restart you will 

be asked again on the next import if there is a color clash. 

Using the MATCH option means that you can choose a template, change its theme colors 

and then import more templates of the same theme and the imported designs will 

immediately pick up your modified theme colors.  

For example, import a red graphical button from the ONLINE CONTENT CATALOG, change 

its main theme color from red to green, then import a red logo graphic of the same theme 

and choose the “MATCH” option. When the logo appears in your design, instead of being 

red it will have picked up your chosen green theme color automatically. Since most 
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themes have their main theme color named “Theme color 1”, you will also usually get 

good results when importing graphics from different themes and matching the colors. 

Make Named Color local to Frame/Layer 

 

When you click this button, a new named color is created which is identical to 

the one you have selected.  

This new color is then applied to all objects in the current frame or layer that use the 

selected named color. This means that with one click you can localize a color to the 

frame/layer. You can then independently edit the original color and this localized color. 

This feature is useful when you are creating animations and you want an object's color to 

change part way through the animation. 

This button is dimmed unless you are editing a named color that is also used in another 

frame or layer. 

Normal colors, Tints, Shades and Linked colors 

Normal colors 

These are the normal stand-alone colors you apply to objects. 

Xara Photo & Graphic Designer can also define colors that are linked to another color, 

that is when the parent color changes the linked color will change as well. There are 

three ways you can link a color to its parent TINTS, SHADES, and LINKED COLORS. These 

are very powerful techniques that allow, for example, single-click re-coloring of complex 

shaded drawings. Some of the example clipart uses this technique. 

Tints 

Tints are based on other colors (called the parent color) and are always a paler version 

of the parent. They have two main uses: 

 Where you have paler shades of a parent color and you may want to change the 

parent color in future with the tints automatically updating. 

 To extend the range of colors available from printing inks. 

 

For example, a 25% red tint gives a pink color. Therefore using just a red ink you can 

have both a pure red and a pink using only one ink. Similarly, if just using black-and-

white printing, it’s often useful to be able to use tints to create various shades of gray. 

 

If you are printing with a limited range of colors (it’s usually cheaper to print one or two 

color, instead of full or four color printing). 

A tint can be based on any type of color, including another tint. 

Any changes you make to the parent color also change tints based on it. For example, 

you might define the color pink as 50% of a red parent color. Changing the parent color 

to orange automatically changes pink to light orange. 
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Shades 

These allow both lighter and darker colors to be created all based on a parent color. 

Changing the color of the parent changes all associated shades. For example, a drawing 

of a car might use shades for the highlight and shaded regions of the car body. A single 

edit to the parent changes all the colors of the entire body but keeps the shading correct. 

Setting up shades this way is more time consuming but it is a very powerful way of 

altering colors. 

For best results, the parent color should be a "pure" saturated color. When using the 

HSV color mode, saturation and value should ideally be 100%. When viewed in the 

COLOR EDITOR (on page 210) the cross should be in the top left-hand corner. 

Linked colors 

Linked colors are similar to shades but give greater flexibility. These are also based on a 

parent color but you define which attributes you want the linked color to share with its 

parent. For example you can create a linked color that is a more or less saturated version 

of the parent, but the hue and lightness / darkness follow the parent. 

Creating a Tint, Shade or Linked color 

TINTS, SHADES and LINKED COLOR have to have a master "parent" color, which needs to 

be a named color, so that when you change this parent color, the tint will change as well. 

So, if necessary, first create a named color (see Creating new named colors (on page 

215)). 

To create a tint, shade or linked color: 

1. Select the object or objects to which you want to apply the color. 

2. Open the COLOR EDITOR showing the advanced options. 

3. Select the "normal color" drop-down menu and select the TINT, SHADE, or LINKED 

option. 

4. From the PARENT dropdown menu, select the named color that you want this color 

to be linked to. 

5. Adjust the TINT, SHADE or LINKED COLOR on the top section of the color editor. 
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On the left you can see the new color is a tint of the parent "yellow" and so the editor provides 
only paler tints of the parent color. On the right, if you select a shade, you get to choose any 
lighter or darker shades of the parent color. 

If you want to use this color in many places in the document it’s recommended that you 

also make this a Named Color, so it appears on the Color Line, for easy picking. Just 

click on the NEW NAMED COLOR label icon on the top of the Color Editor and give it a 

name. It will now appear on the Color Line where you can pick it for use on other objects. 

Editing the parent color 

The key point of using tints, shades and linked colors is that they track any changes to 

the parent color. To see this working try editing the NAMED COLOR that is the parent (drag 

it from the COLOR LINE to the COLOR EDITOR and alter the color). You will see the objects 

with the tint, shade or linked color change in sync with the parent. 

NOTE: Be careful not to edit the color of objects on the page to which you’ve applied 

NAMED, TINTS, SHADES, or LINKED COLORS as this will change them to LOCAL COLORS. 

Importing colors and palettes 

You can import the following color table and palette files: 

 CorelDRAW Palette .CPL and .PAL 

 Adobe Color Tables .ACT 
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 Adobe Color Swatches .ACO 

 PaintShop Pro Palettes .PAL 

 Microsoft Palettes .PAL 

You can import the colors of a palette file into a document, or place them in the COLOR 

GALLERY (on page 223) so they are always available. To import a palette file into an 

existing document drag the file icon from Explorer and drop it onto the document window 

away from the Color Line. To import it into a new, blank document drag the file icon from 

Explorer and drop it on the Color Line. 

To add a palette to the Color Gallery, open the folder into which you installed the 

program, open the palettes folder and copy the palette file into this folder. The file must 

be in one of the formats described above. 

Imported colors are always named colors. 

The Color Gallery 

The COLOR GALLERY displays all the NAMED COLORS used in the current, and other open 

documents. It also lets you create, edit, copy and delete NAMED COLORS. 

To access the COLOR GALLERY: 

 Choose UTILITIES -> GALLERIES -> COLOR GALLERY ("F9"). 

 Or click the COLOR GALLERY button on the GALLERIES bar. 

 

 

Buttons at the 

top are dimmed if 

they are not 

available, for 

example, if there 

is no selected 

color, or more 

than one color is 

selected.  

The REDEFINE 

button redefines 

the selected 

color in the 

gallery to be that 

of the selected 

object. 
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The Color Gallery shows colors for all documents currently loaded. 

Document handling (on page 74) has general information about galleries. 
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Text Handling 

Introduction 

The text editing facilities of Xara Photo & Graphic Designer are very like your text editor 

or word processor, but in addition it provides a range of features you won’t find in those 

programs: 

 

You can enlarge or magnify text to a huge degree. 

 

You can apply the range of normal Xara Photo & Graphic Designer 

attributes and effects: fills, feather, transparency, color fades, bevels, 

shadows, Live Effects and still continue to edit the text. 

You can convert the outlines of characters to shapes which can be 

edited just like all normal shapes. 

 

Fit text to a curve. All text can be rotated, skewed and stretched. 
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A fine degree of control over letter spacing and positioning.  Manual and automatic kerning. 

 

And text flowing around any repelling object 

Terminology 

FONT or TYPEFACE: A set of characters with a consistent style. 

FONT FAMILY: A set of similar fonts. For example Garamond and Garamond Italic are 

different fonts from the same Garamond family. 

JUSTIFICATION: An alternative way of describing text alignment. Left aligned text is 

sometimes called left justified, or flush-left, or ragged right. Fully justified text has text 

aligned or "flush" to both left and right margins. 

KERNING: Moving individual character pairs closer or further apart depending on the 

shape of the character. Most good fonts have kerning pair information included so this is 

automatic, although you can manually kern by any degree. 

MONOSPACED: All the individual characters of a monospaced font have the same width. 

Sometimes referred to a fixed width fonts. Useful for program listings. Courier is the most 

common monospaced font. Most fonts are proportional spaced fonts, meaning the 

characters vary in width. 

POINT: Text or font sizes are traditionally measured in points, abbreviated to pt. 1pt is 

approximately 1/72nd inch, so 72pt text is approximately 1inch tall, although different 

fonts of a given size can vary. 

TRACKING: Uniformly increasing or decreasing the spacing between characters. 



 

Text Handling 227  
 
 

 

The Text Tool 

Use the TEXT Tool ("F8") to enter or edit text. 

 

 

Text Tool InfoBar Left Side 

 
Font 

 
Font Size 

 
Style 

  

 
Bold 

 
Justify 

 
Italic 

 
Vertical Text Alignment 

 
Underscore   

 
Strikethrough   

 

Text Tool InfoBar Right Side 
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Subscript/Superscript 

 
Line Spacing 

 
Bulleted Lists 

 
Numbered Lists 

 
Outdent 

 
Indent 

 
Spell Checker / Auto correction  

 
Space before paragraph 

 
Space after paragraph 

 
Show / Hide Advanced text bar (toggle on/off) 

 

 

Advanced text bar 

 
Columns 

 
Baseline Shift 

 
Tracking/Kerning 

 
Aspect ratio 

 
Auto hyphenation 

 
Paragraph options 

 
Text Capitalization 

 
Ligatures 

 
Stylistic Sets 

 
Open Type Alternates 

 

Xara Photo & Graphic Designer supports three basic type of text objects 

 Simple text lines: Click on the page, and type. 

 Text columns: Click and drag to create a column, and type. 

 Text areas: Click and drag diagonally to create a rectangular area, and type. 

After you’ve created any text object you can transform it (rotate, scale, skew) and can 

apply all the normal attributes, fill color, transparency, feather etc, using the normal tools. 

You can also attach it to a curve. The text will remain editable. 
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The Font Menu 
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Live font size pop-up 

 
Fonts used in the current document 

 
Web safe fonts 

 
Style variants available for the selected font. Not all fonts have such variants 

 
Google fonts 

 
All fonts installed 

 
Font type - usually either OpenType or TrueType as designated by the 

accompanying symbol. 

The font menu lists all installed fonts, and is split into four sections. The top section 

displays those fonts that are currently used in the document. The second section shows 

the “web safe” fonts. These are the fonts you can safely use in web pages, because all 

commonly used web browsers will support these fonts. The third section shows the 

available Google fonts and the final section displays an alphabetical list of all other 

installed fonts. Each font name is displayed in the menu using its own typeface, making 

font selection easier. 

Those fonts for which multiple font styles are available are shown with small black 

triangles against them on the right hand side of the menu. Simply hold the mouse pointer 

over such a font name for a second or two and a small sub-menu appears to the right of 

the main menu, listing the available variant of that font. While this sub-menu is displayed, 

you can move the mouse pointer over it to select the desired font variant. 

Web Safe Fonts 

These fonts are safe to use in websites because the vast majority of computers and 

other devices will have these fonts installed. You can also use any of the hundreds of 

Google fonts in your website. And you can even use other fonts you have installed if the 

font license permits it. 

Live Font Preview 

As you move the mouse pointer over any entry in the font menu, the selected text in the 

document is instantly updated to preview the font. This is not a permanent change until 

you actually click on the required font. Moving the mouse pointer over the menu will 

revert back to the initial font until you move over another entry. This is great for very 

rapidly previewing large numbers of fonts. 

If you hold down the "Shift" key while traversing the font menu, then the font selection is 

not updated instantly, there is a short pause before it is updated. This is useful if you find 

that instant preview slows down your traversal of the menu (perhaps if you have a large 

amount of text selected).  
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Live Font Size preview 

Next to the font size menu is a small pop-up slider control, like that used elsewhere in 

Photo & Graphic Designer. This provides a direct, live font size control, and will adjust 

the font size of the selected text in real-time as you drag the slider. 

 

Click to display font size pop-up 

As with the pop-up sliders used elsewhere this can be used two ways. "Click + release" 

on the arrow and the pop-up will appear and stay on screen. You can now drag the 

slider, or use the mouse scroll wheel over the control to rapidly adjust the values. So in 

this case, this provides a fast way of adjusting the point size using the mouse wheel to 

see the results directly on the page of the document as you work. 

The alternative method of using the pop-up slider is to "click + drag + release" on the 

button and slider. This is a slightly more direct way of adjusting the control (requires less 

clicks). 

Instant font menu navigation 

While the font menu is displayed, you can type the initial characters of the font name, 

and the menu will be scrolled to that section of the list. E.g. if you type "ver" it will 

instantly scroll and locate the Verdana font. 

Bold, Italic & Synthesized fonts 

Xara Photo & Graphic Designer does not allow you to apply italic or bold to text if the 

necessary italic/bold font is not installed. Photo & Graphic Designer 3.2 and earlier 

versions would allow this and would artificially synthesize an italic or bold appearance as 

required. The results produced by doing this were generally poor quality. Besides this, 

you would encounter problems if later trying to export your design to PDF, since other 

applications would either not synthesize the bold/italic appearance or produce even 

worse results. 

Google fonts 

Photo & Graphic Designer also gives you the option of using one of the hundreds of 

Google fonts. These are free, open source web fonts that have the advantage of being 

hosted by Google so you don't have to upload font files with your document when it's 

exported as HTML - the visitor's browser will automatically fetch the fonts from the 

Google font hosting servers.  

The fonts are fully integrated within Photo & Graphic Designer  so you can browse and 

search through the font list using the FONT FINDER to download and install the fonts to 

your own computer. 
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To start using Google fonts simply click ADD on the font menu to pull up the Font Finder.  

  

Google Font Finder  showing some of the available fonts and font families.  

You can search for fonts by typing the font name into the search box, or else scroll down 

through the list to find a suitable font. Qualify your search by selecting font styles from 

the checkbox lists on the left and use the live preview slider to see the font at a different 

sizes. 

Click on your chosen font and you will be asked if you want to download and install the 

selected font. On many Windows computers, and depending on your Windows settings, 

you’ll be prompted by Windows to give permission for the installation, which is performed 

by a separate FontInstall program that is launched. Each font you install will appear in 

the Google Fonts section of the font menu. 

Some Google fonts, such as Exo, provide a wide range of weights. In these cases the 

‘Bold’ option changes subtly. Font weight values can be from 100 (typically very light or 

skinny fonts) to 900 (very heavy or black fonts). Instead of always selecting a given bold 

weight, applying Bold (selecting the B button, or using Ctrl+B when editing text) works as 

follows: 
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Main Text weight                                             Weight selected when ‘B’ is applied               

100 to 300 (Thin/Extra Light/Light)                             400 (Regular) 

400 to 500 

(Regular/Medium)                                      

700 (Bold) 

600 to 900 (DemiBold/Bold/Extra etc)                      900 (Black) 

Of course you don't have to use the fonts exclusively for webpages, because the fonts 

are TrueType they can also be used with any print document - a PDF for example. 

If you send another Photo & Graphic Designer user a .xar or .web file containing a 

Google font then they will be asked upon loading the document whether they wish to 

download and install the font. 

Note: some browsers do not render Google fonts as effectively as others, so it's always a 

good idea to test your webpages with a variety of browsers to ensure the font quality is 

acceptable.  

Symbols 

The symbols are a huge range of scalable icons which are regularly updated as new 

ones become available. Consisting of both Font Awesome symbols and Google Material 

Design Icons - you can either insert them into text as a character font or insert them into 

your document as a standalone graphic.  
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The symbols are divided into various categories such as Web Application Icons, Brand 

Icons, Text Editor Icons, Directional Icons and so on, and can be found on the INSERT 

menu. "INSERT" > "SYMBOL". They also appear in the ONLINE CONTENT CATALOG under 

the SYMBOL FONTS category. Just scroll down to see the full list. 

 

Some of the Font Awesome Symbols. 

There is a SEARCH function - for example type ‘Pay’ and it will show you Shopping cart, 

Credit card, PayPal and other related symbols.  

You can easily replace symbols as they appear in your documents, either with a 

replacement symbol or an image, just right-click on the symbol and select REPLACE. This 

works even if the symbol is inside a group 

This also works for symbols in bulleted lists (on page 273) - simply right click on any 

bulleted list with the text carat and select LIST PROPERTIES... from the context menu, and 

then REPLACE WITH SYMBOL from the dialog. 

You will be alerted if an updated version of a symbol font is released, or when we add 

more symbol fonts. Installation of the new or updated fonts is automatic. It’s important 

that you choose to accept these updates because the symbol picker and Content 

Catalog always show symbols from the newest font versions, so if you’re not up to date 

you may find symbols you choose to insert don’t work on your device if it has an out of 

date version of the font. 

The Material Icons font symbols are designed so that the symbol glyphs sit higher than 

those of Font Awesome. You can see this if you insert a Font Awesome symbol and a 
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Material Icons symbol next to each other in text. You can correct this in text by selecting 

the symbol in the TEXT TOOL and adjusting the baseline shift (on page 287) downwards.  

When using these symbols in bulleted lists (on page 273) you can adjust the vertical 

position using the VERTICAL OFFSET function within the LIST PROPERTIES dialog. Right-

click on a list item and select LIST PROPERTIES... from the context menu, and then adjust 

using VERTICAL OFFSET. 

Inserting Symbols into text 

Place the TEXT TOOL carat at the point in your text where you wish to place the icon and 

then click on an icon in the collection. The symbol character is inserted into the text.  

When you insert a symbol into your document this way, the symbol characters use either 

the Font Awesome or Material Icons fonts. If you later publish your document as HTML, 

you’ll see a warning telling you that the font will be published with your document or 

website. This is not a problem, because the font licenses permit such use.  

 

A symbol inserted as a font using the Text Tool 

Inserting Symbols as graphics 

To insert the icon as a scalable vector graphic simply make sure that the text caret is not 

present before you click on the symbol to be inserted. To clear the text caret, switch to 

the Selector Tool or any other tool except the Text tool.  

The symbol will appear in the center of the workspace (be aware this may be behind the 

symbol dialog). Use the Selector tool to move it to where you want it in your document, or 

resize it, etc.  

When you insert a symbol this way, your document does not need the appropriate font 

anymore because it’s been converted to a graphic on insertion. So if you publish to 

HTML you won’t see the font warning mentioned above.  

 

A symbol inserted as a scalable graphic 



 

 236 Text Handling 
  

 

 

Font replacement 

It’s often useful to be able to completely replace one font with another across your entire 

document or website, especially if you don’t have a particular font installed and want to 

replace it with a font you do have.  

In the Text Tool (on page 227) just right-click in the text with the font you want to replace 

and choose the REPLACE FONT WITH … option from the context menu.  

All variants of the font are replaced across your document, each with the matching 

variant and size of your chosen font. 

Simple text 

If you wish to type a small amount of simple text, position the pointer where you want to 

enter text and click. A red cursor appears where you clicked and you can now start typing 

on the keyboard. 

If you make a mistake, use "Delete" and "Backspace" in the usual way. 

Pressing "Enter" completes the line and starts a new line of text below it. The inter-line 

spacing is controlled by the line spacing text box on the InfoBar. 

Simple text is not suitable for large paragraphs of text because there is no automatic line 

wrapping (because the width is unlimited). Use a Text Column or Text Area instead (see 

below). 

By default text has no outline color. "Shift + clicking" on a color on the Color Line will give 

the selected text an outline color - the thickness of which can be controlled by the line 

width control, as usual. You will probably want to set the Line join type (on page 109) to 

be rounded to give it a more smooth appearance (control at the top of the LINE GALLERY).  

Line width is described in Changing the line width (thickness) (on page 105). Applying 

color is described in Color handling (on page 205). 

You can continue to enter text even after rotation, color filling or placing it on a curve. 

Text in a column 

If you are entering larger amounts of text, over multiple lines, using a column is more 

useful. Changing the width of the column will automatically re-flow the text. 

To type a column of text: 
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1. Select the TEXTTOOL. 

2. Move the mouse pointer where you want the column to start. 

3. Drag right to create a horizontal line the width of the column. This green/red dashed 

line just shows you the width of the column and the fact that the column is active. It 

is never exported or printed. 

4. Type in the text, the green/red dash line is replaced with solid red line. You don't 

need to press "Enter" at the end of a line. When the text reaches the edge of the 

column, it automatically flows onto a new line. 

NOTE: If you click away or change tools before you start typing, the green/red dashed 

column line will be replaced with a green line to indicate that you that you have an 

inactive text column. To reactivate the column just click on it again with the Text Tool, the 

line will return to its active state and you can start typing again.  

Instead of typing in the text you can create the text in a separate text editor or word 

processor, copy it to the clipboard and paste it into Xara Photo & Graphic Designer. Copy 

and paste supports RTF-formatted text. 

Changing the width of the column 

Drag either of the two red handles at the ends of the line. If you switch to the SELECTOR 

TOOL and drag one of the corner control handles the font size will scale together with the 

size of the column. 

Changing the angle of the column 

"+ drag" either of the red handles at the end of the line to change the angle of the 

column. Alternatively, "Ctrl + drag" to restrain the line to the constrain angles. Or 

alternatively you can use the SELECTOR TOOL to rotate the object in the usual way. 

For more on constrain angles, see Introduction to Xara Photo & Graphic Designer (on 

page 73). 

Text areas 

 

In the TEXT TOOL if you click and drag diagonally on the page you will create a 

rectangular text area. The blinking cursor will be positioned in the top left corner and you 

can type or paste text. 

A text area can contain a "flowing" text story. This is where a single piece of text flows 

from one text area to another. It’s called flowing text because, like water, as you add or 

remove text in one area it overflows into connected text areas or flows back from text 

areas. 

If the text overflows the bottom of the text area the overflowing text is shown gray, 

although you can continue to edit this text as usual. 
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Connecting text areas—text flow 

When text overflows the bottom of the text area, a  flow arrow is shown on the bottom of 

the area. If you drag this over any other text area, the overflow text will flow into the new 

text area, and the two areas become connected. This is shown with a flow arrow.   

 

Overflowing text area with  flow 
arrow. 

 

If the text cursor is in an area with overflowing text, then just click-drag on the page to 

create a new text area. The new text area is automatically connected and text will flow 

into the new area. 

Tip: You can flow text from one area to another on any page, even earlier pages. If you 

need to flow into an area many pages away, it’s probably easier to use the above 

method, although if you zoom out to a small page size you can drag the overflow arrow 

across pages. 

To disconnect one text area from another, just drag on the overflow indicator and drop it 

away from any text area. Or click on the flow arrow at the bottom of the text area and 

select UNLINK TEXT FLOW. 

If you delete a text area that is connected to another only the area is deleted, the text will 

simply re-flow into the remaining text areas. 

Vertically aligned text 

 

You can align text vertically within text areas, so it’s top, center or bottom aligned. This is 

useful wherever you want to align multi-line text vertically with other features on the 

page, especially text that you want to edit regularly so the number of lines varies. 
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Text areas with top, center and bottom alignments 

To change the vertical alignment of a text area, place the text caret in the text and select 

the VERTICAL TEXT ALIGNMENT button on the text InfoBar. This reveals a menu allowing 

you to choose the vertical alignment. This option is not available for text columns or 

simple text lines. 

 

Auto-fit to text areas 

The last option on the VERTICAL TEXT ALIGNMENT menu - AUTO-FIT TO CONTAINER, allows 

you to fit any text into any restricted area on a page, so it’s great for text that needs to 

change often where there is restricted space. 

With this option on, the font size of the text is automatically adjusted so that the text will 

just fit into the available space. Add more text and the font size reduces, so the text will 

still fit. Remove some text and the font size grows so the text will still fill the container. 

Just select the shape with the TEXT TOOL. You will see a dialog which gives you the 

following options... 
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It works with simple text areas... 

 

And also with text fitted into any shape… 

 

You can use mixed font sizes too, just as you would in a normal TEXT AREA. As you add 

and remove text, the text scales to fit, while always preserving the relative differences 

between the font sizes in the text. 

 

Clearly you can’t use fixed font point sizes with this auto-fit option on, because it works 

by dynamically changing the font sizes. So you will see some perhaps unexpected 

results if you do try to set specific font sizes. In the example above if we try to make the 

heading 28pt, it immediately changes to 24.19pt, but that’s expected with auto-fit turned 

on. 
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Dynamic sizing also works with repelling. The text automatically scales to fit the available 

space, taking into account the reduced space caused by the repel. 

 

  

Shrink text on overflow 

The last option on the VERTICAL TEXT ALIGNMENT menu - SHRINK TEXT ON OVERFLOW 

controls what happens to the text when it overflows the text area. With the option 

selected the text will scale down so that it always fits the text area. So useful for 

instances where you need to add more text yet are confined to a specific size. 

The left text area has plenty of space, so text appears with the font size it was given. In the 
center example, more text has been added so that it would no longer fit in the text area, so the 
text has been scaled down to fit. In the right example, some text has been removed so it will 
again fit in the text area with its original font size. 

If you subsequently drag the text area out to increase the area or if you delete some text 

then the text size will increase to fill the area but it won't get any larger than the original 

point size. As with Auto-fit to container, any relative size differences in the text are 

maintained as the text is scaled down and also as with Auto-fit you can't use this feature 

on linked text areas - a warning prompt will appear should you attempt to do so. 

 

Resizing text areas 

Using the TEXT TOOL, you can click and drag on any of the corner control handles. The 

text in the area will be reformatted to fit the new size. If you resize a text area using the 

SELECTOR TOOL, using the corner control handles, the text itself is scaled as well, but use 

any of the other control handles and the text area size is changed and the text reflows in 

it to fit the new size.  
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You can also change the size of the text in the text area, by going into the TEXT TOOL, 

select all the text with Ctrl+A and change the font size on the TEXT TOOL InfoBar. 

You can rotate a text area, using the SELECTOR TOOL as normal, and the text will flow 

through the rotated text area normally. 

 

Text flow is unaffected if you rotate any of the text areas 

Hold down "Ctrl" while rotating to constrain the text rotation angle to 90° angles and 

screen aligned angles. 

Word count 

The word and character count total of the current text is shown in the status line. This 

also shows the number of overflowing words. If any region of text is selected, it shows 

the count of this selection instead. 

Text along a curve 

To place text along a curve of your choice: 

1. Create either basic text, text in a column 

or a text area (see above). 

2. Select your text object and one curve. 

3. Choose "ARRANGE" > "FIT TEXT TO 

CURVE". 

 

Alternatively, select a curve or line and then in the TEXT TOOL, click on the line, where 

you want the text to start, and type. This automatically fits the text along the line. When 

you reach the end of the line the text will wrap onto a new line, immediately below the 

start of the previous one. 

If you do not want the text to wrap to a new line, "Shift + click" on the line. 
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To hide the curve so it’s not visible, select the SHAPE TOOL and set the line color to 

NO COLOR or a width of NONE. You can also edit the curve as usual this way.  

To hide the curve so it’s not visible, select the SHAPE TOOL and set the line color to NO 

COLOR or a width of NONE. You can also edit the curve as usual this way. 

Applying color is described in Color handling (on page 205). 

Adjusting the left and right margin of text on a curve 

If you just start typing or place a column of text on a curve, you can change the start and 

end position of the red handles. Just drag them along the curve as required.  If you 

center text it will be between these two margins. 

Swapping sides of the line 

Right click on the text and select the REVERSE TEXT ON CURVE menu option. 

Alternatively, if you reverse the direction of the line (SHAPE TOOL, REVERSE PATHS button 

on the InfoBar), then the text will move to the other side of the line or, in the case of a 

closed shape, move from the inside to the outside of the shape. 

An example 

 

Create an ellipse. Convert to editable shapes. 

In the shape editor, select the top half (top 

three control points) and select the "Break at 

points" function. Remove the top half to leave 

just the lower half as seen. In the Text Tool 

click at about 6 o’clock and type. 

Right click and select REVERSE TEXT ON CURVE 

to flip the text to the other side. 

Drag the red margin handles in from either 

end. Select the center text alignment option. 

 

 

To create offset text, create a separate curve and adjust its curvature and offset. In this 

case the line has also been made invisible and the text reduced in size. 
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Text inside shapes 

You can place text inside shapes, so that it flows within the shape’s outline.  

Create your own text filled shapes or have a look in the CONTENT CATALOG where you 

can find some text panel designs that  use this feature. See "COMPONENTS" > "PRINT & 

WEB COMPONENTS" > "TEXT PANELS"  or on the INSERT menu "SHAPE" > "MORE TEXT 

PANELS …"). 

 

In fact you can add text to any type of object, even groups, as long as there is not 

already any text in the object. Simply select the object, then go into the TEXT TOOL and 

click on the object. A text area (on page 237) is created for you on top of the object and 

you can enter your text and it will flow within the object’s outline.  

Alternatively you can right-click on an object and select ADD TEXT INSIDE from the context 

menu. 

You can select, edit and format the text just as you would any other text and it will always 

format within the outline of its containing object.  

If the text won’t fit in the available space within the outline, it will overflow out of the 

bottom of the text area, as with a normal text area. 

 

In this case you need to take some action so the text will fit. You could reduce the font 

size or line spacing of the text, make the container larger so it will fit more text, or reduce 

the padding margin (see below). 
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Padding margin 

The padding margin is the space between the shape outline and the text. Normally you 

will want at least a small margin as text flowing right up to the edge of a shape with no 

margin rarely looks good. You can change the margin in two ways. The easiest is to go 

into the TEXT TOOL and drag on one of the small red arrows in the corners of the text 

area. As you drag, the text reformats inside the margin. The distance between the arrows 

and the corners of the red dotted box mirrors the same margin value, as an additional 

visual cue. 

 

Text inside shape with adjustment handles 

Alternatively you can set the padding margin by right-clicking on the text area and 

choosing "TEXT INSIDE" > "PROPERTIES…", which allows you to enter a value.   

Selecting the containing object 

When you click on the object with text inside, you select the text area. The object within 

which the text flows (most commonly just a shape) is a child of that text area, so it 

behaves like a group. So if you move, copy, delete or resize the text area in the 

SELECTOR TOOL, the whole combined object is moved, copied, deleted or resized.  

If you want to select and edit the shape that contains the text, you can use CTRL + CLICK 

or right-click "TEXT INSIDE" > "SELECT …" With the shape selected you can resize or edit it 

and then the text will re-flow within the new outline. To detach the text entirely from the 

shape so they become completely separate objects, again right-click and select "TEXT 

INSIDE" > "DETACH".  
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A Group of 2 circles with text inside and one circle selected 

To make a copy of the shape without the text, select the shape, then copy and paste. To 

make a copy of the text without the shape, select all the text in the TEXT TOOL, then copy 

(CTRL + C) and paste (CTRL + V).  

Shaped text areas 

If you want to create a text area of a specific shape then all you need to do is to create a 

shape, fill it with text and then right-click the shape and select "TEXT INSIDE" > "SELECT 

SHAPE".  

Then just tap on the NO COLOR patch down on the color 

line. And set the line width to NONE if your shape had an 

outline. 

 

 

Editing text 

Double clicking on a text object in many of the tools takes you into the TEXTTOOL and 

places the cursor at the click position in the text. 

All the normal word processor-style cursor and mouse operations can be used. For 

example: 

 Click where you want to place the cursor. 

 Use the left and right arrow keys to move left, right, up or down. 

 Use "Ctrl + left and right arrow keys" to move left or right one word. 
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 Press "Home" or "End" to move to the start or end of the line. 

 Press "Ctrl + Home", or "Ctrl + End" to move to the start or end of the text object. 

Text selection: 

 "Shift + any" of the above keys to select text 

 Double click to select a word 

 Triple click selects a whole line of text, or "Ctrl + L" 

 Quadruple (4x) click selects a paragraph of text 

 Or just drag across the text in the Text Tool to select the text 

 "Ctrl + A" will select all the text in the text object (you must be in the TEXTTOOL.) 

If you have a text selection any attribute change will apply only to the selected region of 

text. If you have only the cursor in the text, then any attribute change, say selecting a 

new color, will only appear when you type new text. 

Selecting the whole text object 

There is a quick shortcut for selecting the whole text object. Instead of using "Ctrl + A" or 

dragging across all the text, simply press the "ESC" key. This removes the cursor but 

selects the whole text (the status line will confirm 1 text object). This makes it easy to 

apply an effect or attribute to the whole text selection. 

For example, to change the font size of the whole text object, just press "ESC" and select 

the new size from the InfoBar. 

Switching case 

Use the context menu to change the case of selected text, so right click and choose from 

the following options.. 

 "CHANGE CASE TO" > "LOWER CASE"   

 "CHANGE CASE TO" > "UPPER CASE" 

 "CHANGE CASE TO" > "SENTENCE CASE" 

Additionally... 

Pressing "Ctrl + Shift + F1" will make selected text toggle between all uppercase and all 

lowercase.  So, if you've accidentally typed a section of text with the caps lock key on, 

just select the text and press "Ctrl + Shift + F1". 

Pressing "Ctrl + W" will swap the case of the character after the cursor and move the 

cursor on. You can swap the case of a selected region of text, the same way. Uppercase 

characters will become lowercase and vice versa. The cursor will not be moved. 

Smart Quotes 

When you type quote ' or double quote " characters, Xara Photo & Graphic 

Designer will automatically convert these into the more appropriate and aesthetically 
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accurate opening or closing quotes. It is also smart enough to understand the use of 

single quotes within words to signify missing characters.  

Entering special characters 

There are a number of useful shortcuts to allow insertion of special characters, like © or 

™. See Special characters (in Text Tool) (on page 586) section in "Menus and keyboard 

shortcuts". 

All these shortcuts (with the exception of the hard space) are compatible with Microsoft 

Word. 

Entering dummy text ('Lorem Ipsum') 

You can insert a paragraph of dummy "Lorem ipsum" text by pressing "Ctrl + Shift + L" 

("L" for Lorem) while using the TEXT TOOL. To insert a larger block of text, just press the 

key combination a few times.  

The function is also available on the main INSERT menu or else as part of the right-click 

context menu. "INSERT" > "LOREM IPSUM TEXT" 

Spell checker 

 

The TEXT TOOL (on page 227) includes a spell checker, click on the "SPELL 

CHECKER / AUTO CORRECTION" icon on the Text Tool InfoBar, and you will see a 

dropdown menu.  

 

To use the spell checker select “CHECK SPELLING 

AS YOU TYPE”. Now all unrecognized words - both 

in your document - and as you type, are shown 

with a red dashed underline. 

To correct a misspelled word, right-click on it, and 

the context menu will suggest alternative 

replacements. Simply select one of the 

suggestions to replace the underlined word. 
 

ff 

Language selection 

The menu shown when you click on the Spell Checker icon on the InfoBar lists all the 

languages for which you have dictionaries installed.  

To change the language associated with all the text objects in your document, choose 

the required language from the "DOCUMENT LANGUAGE" submenu. Now all the text 

objects in the document will be checked against the dictionary for the language you 

chose.  

To change the language associated with an individual text object, select the text object 

with the TEXT TOOL and choose the required language from the Spell Checker menu. 

Now the text object will be checked against the dictionary for the language you chose. 
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When you change the current document language, you will be asked whether all existing 

text in the document should also be set to the chosen language, or left unchanged.  

If you don't want any of the text objects in your document spell checked at all, then select 

"DOCUMENT LANGUAGE" > "NO LANGUAGE (IGNORE)". And If you have individual text 

objects which you don’t want to be spell checked, select the object using the TEXT TOOL 

and choose the "NO LANGUAGE (IGNORE)" option from the Spell Checker menu 

When you open an older document, the document language is automatically set 

according to the language on the Normal text style in that document. Newly created 

documents have their document language set to match the language setting of the 

current device, as with previous versions of Photo & Graphic Designer.  

User dictionary 

Words that you use regularly which are not in the dictionary provided with Xara Photo & 

Graphic Designer can be added to your own personal dictionary. Right click on the word 

and choose “ADD TO USER DICTIONARY”. Now the word is no longer shown as being 

misspelled. The user dictionary applies to all documents that you use on your computer 

and it applies to all languages. 

Auto correction 

 

Click on the SPELL CHECKER / AUTO CORRECTION  icon on the TEXT TOOL InfoBar, 

to use the auto correction feature. Select AUTO CORRECTION OPTIONS...  from the 

dropdown menu.  

A dialog will open allowing you to add and replace words as well as keyboard symbols 

with symbols from the symbol (on page 233) catalog. The feature is always on by default 

but you can turn it off within the dialog.  

There is a selection of useful items already listed, and you can add your own. Click on 

ADD to create a new field and then type a word or a character in the REPLACE column, 

then click in the WITH column to either type a replacement, or click on PICK SYMBOL to 

choose a replacement from the symbol catalog. The symbol you've chosen appears in 

the WITH column. Close the dialog by clicking OK.   

Now when you type a word or character listed in the options it will be replaced with your 

alternative word, character or symbol.  

So for example if you want to be able to type “Rwd” and have that instantly replaced with 

“Responsive Web Design”, simply press the ADD button and enter “rwd” in the REPLACE 

field, and “responsive web design” in the WITH field. All text in the dialog is forced to lower 

case but the replacement tries to be smart about use of case.  

So if you type... 

 "RWD" will be replaced with "RESPONSIVE WEB DESIGN"  

 "rwd" will be replaced with "responsive web design" 
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 "Rwd" will be replaced with "Responsive Web Design" 

Hyphenation 

Words only split across lines if they contain a hyphen character (minus key) and while it 

is possible to do this manually using the keyboard (see below), Photo & Graphic 

Designer enables you to do this automatically using the auto hyphenation feature. 

Auto hyphenation is a paragraph attribute - like line spacing and paragraph styles. You 

can have hyphenation on in some paragraphs and off in others, all in the same text flow. 

Just place your text caret in the appropriate paragraph. 

 

To turn the Auto hyphenation feature on or off - click on the HYPHENATION 

button on the Advanced text bar. Or enable it from the dropdown menu of the 

SPELLCHECKER / AUTOCORRECTION / HYPHENATION button. 

 

To change the hyphenation settings click on the HYPHENATION SETTINGS... 

option on the dropdown menu of the SPELLCHECKER / AUTOCORRECTION / 

HYPHENATION button.  

The settings dialog will appear, allowing you to control how hyphens are inserted into 

your document. 
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You can decide the SMALLEST WORD to which a hyphen will be applied, and the position 

of the hyphen within that word.  

Adjusting the HYPHENATION ZONE will change the degree of "raggedness" before 

hyphenation is applied. So for example, with left justified text this would be the size of the 

margin to the right that would be empty without trying to fit in more text using automatic 

hyphenation. With right justified text this would be the margin to the left, and with fully 

justified text this would be empty areas - "rivers of white" between words. 

Increasing the zone allows less hyphenation - and consequently more white space. The 

Hyphenation zone can be expressed as an absolute value as in pixels, mm's, or as a 

percentage of the width of the text object (the default is 5%). 

Use the CONSECUTIVE HYPHENS fields to limit the number of consecutive lines ending in 

hyphens. The ATTENUATION setting creates a "soft" limit on this, so that you can set a 

balance between having consecutive hyphenated lines and lots of white space on 

following lines. A useful value is between 5% and 10%. Values higher than 20% often 

inhibit consecutive hyphens so much that they no longer occur at all. 

The final three checkbox options allow you to hyphenate ALL-CAPS WORDS, CAPITALIZED 

WORDS, and the LAST WORD IN A PARAGRAPH. These are options which you would 

normally leave unchecked as they generally look odd when hyphenated, but there may 

be instances where you want them to be hyphenated. 

Lastly you can create your own hyphenation list. Click on EDIT DOCUMENT HYPHENATION 

LIST...  to open the DOCUMENT HYPHENATION LIST dialog, and add words that you want to 

hyphenate in a specific way. Place a tilde (~) where you want the hyphen to appear. You 

can also add words that you don't want hyphenated to the list. Just add the un-

hyphenated word. 
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The list remains with the document so that if you share the document the hyphenation 

preferences remain active. You can also import your own list to a document, which will 

add your own preferences to the list.  

Inserting hyphens manually 

If you type "Ctrl + -" (minus key) it inserts a soft hyphen which is a hyphen that only 

appears if the word can wrap at the end of a line. It's called a 'soft' hyphen because when 

the word appears in the middle of a line the hyphen vanishes (unlike a normal dash or 

minus character), so it intelligently hyphenates the words only if it needs to. 

When editing the text a soft hyphen is treated as an invisible character (it takes no 

space), but you can tell it's in the text by moving the cursor left/right over where the 

invisible character is. 

A hard hyphen can be inserted by typing "Ctrl + Shift + -" (minus key). A hard hyphen is 

one that will not cause a wrap at all. This is useful in situations where you have dashes in 

words that you do not want split at the end of lines.  

Find & Replace 

The Find & Replace function performs live search so that as you type the search query 

the text is searched and highlighted in real-time. 
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To search for some text select the menu "EDIT" > "FIND/REPLACE..." or "Ctrl + Alt + F" and 

the following dialog is displayed: 

 

Enter the search term and it's shown highlighted in the text. You can choose to search 

just the current text flow, or the whole document (all text flows on all pages). 

The WHOLE WORD option will only search for whole words that match the search term. 

E.G. searching for 'met' will not find 'metro'.  The CASE SENSITIVE option will match only 

the exact case. E.g., with this option on, searching for 'aBc' will not find 'abc'. 

Smart Fields 

Smart Fields are any commonly used text phrases that you may want to insert in 

multiple places in text. Each Smart Field has a name and a value and when its inserted 

into text you see the value. 

For example you could have a Smart Field named Camera Price which you define to 

have a value of $499. You can then insert that into your document(s) wherever you want 

to show the price. But at any time you can edit the definition of the Smart Field to change 

the price and it will be updated everywhere it appears in your document. 

There are two types of Smart Field. PERSONAL SMART FIELDS are stored on your device, 

so once you've set them up you can easily insert them into any documents. DOCUMENT 

SMART FIELDS are stored only in the current document. 

Find the Smart Fields dialog on the INSERT or UTILITIES menus… 
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By default it opens with the PERSONAL SMART FIELDS selected - click the DOCUMENT 

SMART FIELDS button to switch to viewing the DOCUMENT SMART FIELDS. 

There are a default set of PERSONAL SMART FIELDS the first time you use Designer Pro. 

You can edit the values of each of these by clicking in the VALUE field. When you've done 

this once the values you entered are saved on your device and will be available for 

insertion into any document you edit on that device. 

Adding and deleting Smart Fields 

You can add as many additional Smart Fields as you like - just click the ADD button, then 

choose a unique name for your new Smart Field and enter a value. If you select an 

existing Smart Field before clicking ADD, the new field is added following the selected 

field. Otherwise it's added at the bottom of the list. The order of the PERSONAL SMART 

FIELDS is remembered too. 

To delete a Smart Field you don't need, click on it to select it and then click the DELETE 

button. 

Inserting & Editing in Text 

To insert a Smart Field into your document, make sure you are in the Text Tool, place 

the text caret where you want to insert, select the field you want to insert, and click the 

INSERT button. If you want to insert multiple Smart Fields you can keep the dialog open, 

move the text caret to a new position and then select and insert another field. 

mk:@MSITStore:C:/Xara/DESIGN~1/HelpAndSupport/ENG/XaraX.CHM::/2800.htm
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You can select Smart Fields in text just as you select ordinary text, and apply text 

attributes to them in the usual way. You can't place the text caret in the middle of a Smart 

Field - it behaves as a single object in the text, similar to how embedded objects work. 

If you want to edit the value of a Smart Field, you can right-click on it in the text and 

choose Edit Smart Field from the context menu. The Smart Fields dialog opens showing 

the DOCUMENT SMART Fields and the target Smart Field is pre-selected, so you can edit 

its value and it will update wherever that field appears in text of the current document. 

Updating Smart Fields 

The UPDATE button in the SMART FIELDS DIALOG checks the current values of your 

PERSONAL Smart Fields against those in the current document, and updates the fields in 

the document if they differ. So use this to update existing documents if you have 

changed your PERSONAL SMART FIELDS since the document was edited. 
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Synchronising text across multiple text objects  

Sometimes you may want the same text to appear in multiple text objects and for those 

objects to always have the same text, so that if one is edited they are all updated. You 

can achieve this using LIVE COPIES if the only difference between the text objects is in the 

way they are transformed (ie. only their position, scale, rotation or skew needs to differ). 

See LIVE COPIES (ON PAGE 159) in the Object Handling chapter for details. In some 

circumstances you can also use SOFT GROUPS to achieve text synchronization. See the 

SOFT GROUPS (on page 149) section of the Object Handling chapter for details. 

Tabs, Margins and Indents 

Rulers 

To adjust tabs, margins and indents you need to turn on rulers in your document. 

To do this: 

 Choose "WINDOW" > "BARS" > "RULERS" or right click a page and choose "SHOW 

GRID/GUIDES" > "SHOW RULERS". 

 Or press "Ctrl + (Shift) + R". 

 Or press "Ctrl + L" (when not in the TEXT TOOL). 

The enhanced text features will only appear on the ruler when you are using the 

TEXT TOOL and when the text cursor is in a text story or the text object is selected 

when in the TEXT TOOL. 
 

In the TEXT TOOL when you drag the margins or tabs on the ruler, you get a temporary 

vertical guide to make it easier to align the tabs or margins to objects elsewhere on the 

page. In addition when dragging tabs or margins, if you have magnetic snap switched on, 

these will snap to each other making it easier to position tabs and margins. 

Margins and indents 

Any changes you make are made to the current paragraph of text. (i.e. the paragraph 

containing the text cursor) or, if you have a selected region of text,  to the paragraphs of 

the selected region. 

You can apply changes to all text in a text story by selecting all the text within that story 

("Ctrl + A"). To change more than one text story, select the text objects while in the 

SELECTOR TOOL then change to the TEXT TOOL and make the required changes. 

 Left margin. Drag this to change the left margin of the text. 

 First line margin. Drag this to change the left margin for the first line of the 

paragraph (useful for lists, as shown below). 

 Right margin. Drag this to change the right margin of the text. 



 

Text Handling 257  
 
 

 

 

 

Demonstrating the left margin and first line margin  

Demonstrating a right margin 

 

Text along a curve 

If you have fitted a single line of text to the curve using the FIT TEXT TO CURVE option, 

then the curve line is the margin. If the text is longer than the line it will just flow off the 

end. 

FULL justification will always fit the text onto the line, if necessary overlapping characters. 

If you have clicked on the line or fitted a column of text to a curve or line then you have 

left and right margin indicators (small red squares) that can be dragged along the line to 

adjust the margins used for justification. 

Tabs 

By default, text stories are created with tabs set 0.5 cm apart. This means you can just 

press "Tab" and your text will be moved along to the next tab stop. You only need to 

define new tab stop positions if you want alternative tab spacing. 

These default tabs are shown as faint Ls on the ruler: 

 

Standard tabs, indicated by faint "L"s 

Custom tabs 

To create a custom tab position, just click on the ruler where you wish to place the new 

tab. It will replace default tabs up to that point on the ruler. 

For example: 
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 The triangle indicates a custom 
tab 

 To set more than one tab click multiple times on the ruler. 

 To move a custom tab drag it along the ruler. 

 To remove a tab drag it off of the ruler (default tabs will come back). 

Custom tab types 

You can set different types of custom tab. By default, custom tabs are left align tabs. This 

means that text will be aligned with the tab on the left of the text. 

To change the tab type, click the tab icon on the ruler. 

The following custom tab types are available. You are not 

limited to just one type in a story, and can choose a different 

type then set additional tabs. 

 

 Left align: The text will be aligned with the tab to the left. 

 

 

 Right align: The text will be aligned with the tab to the right. 

 

 

 Center align: The text will be centered on the tab. 

 

 

 Decimal point align: The decimal points in the text will be aligned with the tab. This 

is useful for lists and, however long the number, the decimal points  will be tab-

aligned. 
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How to creating hanging indents 

Hanging Indents, as they are known, are where the first line of a paragraph has a 

negative margin or a margin that hangs to the left of the normal left margin. Numbered or 

bulleted lists are examples of hanging indents. 

To create hanging indents: 

1.  

2. Click on the ruler away from the left margin (creates a new tab stop) and drag this 

tab stop to be exactly over the left margin. 

3. —you can insert any special character or 

number and press "Tab" to move to the left margin. And (as with this paragraph) all 

subsequent lines of text are indented to the left margin. 

Repelling text objects 

You can make any object in Xara Photo & Graphic Designer repel text so that text 

underneath it automatically flows around the object, instead of appearing underneath it. 

This makes it easy to lay out pages containing long passages of text combined with 

photos and graphics. Once you've set them to repel, you can adjust the positions of your 

graphics and photos and the text will automatically adjust and reflow around them. 
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You can also choose to only repel text within a layer, which stops objects within a layer 

from repelling text on other layers and also stops text on the layer being repelled by 

objects on higher layers.  

 

Making an object repel 

To make an object repel text, right click it and select the REPEL TEXT UNDER option. Any 

text object in the same layer but below the repelling object (look in the Page and Layer 

Gallery (on page 196)) will be repelled with a default margin of 5 pixels between the text 

and object. Note that repelling text objects only repel text that is underneath the objects, 

not any text that is on top. 
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Alternatively right click on the object and select REPELLING & ANCHORING to display the 

TEXT REPELLING & ANCHORING dialog. 

 

Click the REPEL TEXT AROUND THIS GRAPHIC checkbox. And if you want the text to repel 

as a rectangle around an object, click the RECTANGULAR REPELLING option as well. With 

this option what happens is that the text repels around the rectangular bounding box of 

the object, ignoring its outline. This is also more efficient if your document or website has 

long text flows and has a lot of repelling objects that are also anchored to the text. It is 

also the default option when you turn repelling on for rectangular objects.  

 

Text repelling around an object (left) and rectangular repelling (right).  

If desired, set a repel margin for the object to set the space between the text and the 

object. If you want a different height and width for the repel margin, click the padlock 

symbol and enter the margin height in the H (horizontal) box and width in the V (vertical) 

box. Click OK. 

To turn off repelling right click the object and choose the REPEL TEXT UNDER option again 

to deselect it. Or right click and select REPELLING & ANCHORING to display the Text 
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repelling & anchoring dialog again. Click the REPEL TEXT AROUND THIS GRAPHIC checkbox 

to deselect it and click OK. 

Note that single lines of text do not respond to repelling objects, only text areas and text 

columns do. 

To only repel text within the same layer as the repelling object, see Layer Properties (on 

page 198). 

Anchored Graphics 

You can position any graphic, or group, so it's tied (anchored) to a position in some text, 

so that as the text moves because of editing, the graphic object will move to remain at 

the same relative position. However anchoring should only normally be used for objects 

that sit outside the margins of the text (eg. A photo sitting to the right or left of a text 

column), or behind the text. Use Embedding for objects that sit within the text bounds 

(see below).    

1. The quickest way to anchor a graphic or group is to right click it and choose the 

ANCHOR TO TEXT option. However, if you also want to edit anchoring properties, you 

can right click on the object and select REPELLING & ANCHORING to display the TEXT 

REPELLING & ANCHORING dialog.  

2. Click the MOVE GRAPHIC WITH TEXT checkbox.  

3. By default MOVE VERTICALLY ONLY is also selected, so that your anchored graphic 

will only move vertically as the text is edited. This is usually the most useful option – 

if you want the object to track the anchor position horizontally as well, embedding 

the object is usually a better option. 

4. An anchor symbol appears in the top left of the object, indicating it's now anchored.  

5. Using either the SELECTOR TOOL or TEXT TOOL, click and drag the anchor symbol so 

that a red arrow appears.  

6. Move the arrow head and drop it in the location in the text where you would like the 

object anchored. A red caret (inverted 'T' mark) indicates the anchor position.  

7. As you edit the text around this caret mark, the anchor point and anchored object 

moves with the text. 

8. When an anchored object reaches the bottom of the text area to which it is 

anchored the text to which the object is anchored flows to the next page or column, 

taking the anchored object with it. This is the default behavior for newly anchored 

objects. However it’s controlled with the AFFECT TEXT FLOW checkbox in the 

REPELLING & ANCHORING dialog, so you can turn this off if required. For legacy 

documents the setting is turned off to avoid changing the way these documents are 

formatted.   
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An anchored object displays an anchor symbol and an arrow pointing to the anchor point, 
shown as a red caret mark.These disappear as you type, unless you're close to the anchor 
point. 

Note: If you drag the anchoring arrow to a place on the page where there is no text, the 

arrow turns into a red anchor that indicates the object's anchoring properties will be lost if 

it's dropped here. This also happens when the arrow is dropped on the object itself. 
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This is an example column of text with various graphic elements hanging to the left. Each of 
these is anchored to the start of a line of text immediately to its right.  

It's possible to anchor any graphic object or group, including groups containing text, such 

as the example side-panel, shown above. If the group consists of a single object you can 

directly select that object instead of selecting the group that encloses it. Look at the 

STATUS BAR and the PAGE & LAYER GALLERY to see this in action.  

It's also possible to anchor objects to appear on top of, or below the text. The example 

pale blue flower graphic, shown above, is anchored this way and will flow with the text.  

NOTE: If an anchored object is also set to repel, only the text that the object is anchored 

to is repelled.  

NOTE: Repelling is restricted for repeating objects: Text inside a repeating group is only 

repelled by repelling objects inside the repeating group. Individual repelling objects inside 

a repeating group only repel text that is also inside the repeating group. Repeating 

groups as a whole can repel any text stacked below on the page. 
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Moving Anchored Objects 

As new text is added or deleted, the object moves as the text flows, but will always 

maintain its new position relative to the anchor point. You can move an anchored graphic 

by dragging on it as usual. This changes its position relative to the anchor point, but does 

not move the anchor point, which remains visible at the end of the anchor symbol arrow 

as you click/move the graphic.   

If you want to move the anchor point to another location within the text, click and drag on 

the anchor symbol again to create a new arrow and drag it to the new location. 

If you cut and paste the text containing the caret mark, the anchored object is also cut 

and pasted. 

Soft Groups 

You can anchor Soft Groups (on page 149) the same way, even where part of the group 

is on another layer. For example web buttons with mouseover effects or pop-ups on 

different layers can be anchored in this way. 

Viewing the anchor point 

The anchor point of an anchored object is only visible if you click the anchored object in 

the SELECTOR TOOL or click in the surrounding text area in the TEXT TOOL.  

When you click in a region of text with the TEXT TOOL, it shows any anchors points within 

an inverted 'T' symbol, and also draws an arrow from the anchor point to the anchor 

symbol in the top left of each anchored object. So the easiest way to see all the anchor 

points for any text is to click in it with the TEXT TOOL. 

However, when you start to edit the text, the red caret, arrow and anchored symbol 

temporarily disappear until you stop typing. If you are close to the anchor point, Photo & 

Graphic Designer displays the caret mark, along with an arrow pointing to the anchor 

symbol, to let you know when you're close.  

Inline anchored objects 

If you want to embed a small graphic into a line of text, such as an icon graphic like this 

; inline with the text, so it flows with the text, drag or paste the image in as an anchored 

object that repels and position its anchor point anywhere in the copy. It's recommended 

you use non-breaking space characters ("Ctrl + Space bar"). 

Embedding Graphics 

If you take a graphic, a photo or other object you can paste it "embedded" into text. You 

can control how the text is formatted around embedded objects, and have the object 

resize automatically according to the width of its containing text area or column. You can 

also embed graphics into repeating text - like that which appears in headers and footers 

and have objects anchored to repeating text too. 
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This is particularly useful when you have the same text content with embedded graphics 

appearing in columns of different widths in multiple variants of a website. See mobile 

websites.  

 

An embedded graphic reformatted and resized for a main (left) and mobile (right) variant.  

To embed an object, copy or cut it to the clipboard, go into the Text Tool and place the 

text caret at the point in the text where you want to insert it, and then paste. Now if the 

object you insert is wider than the text area or text column, the object is automatically 

resized down to the width of the text column. Right-click on the embedded object and 

choose "EMBEDDED GRAPHIC OPTIONS..."  from the context menu - or in the ARRANGE 

menu.  
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A dialog appears with the following options...  

 

The SCALING options allow you to specify how the embedded graphic should behave if 

the width of the text column/area is changed, or if the graphic flows into a text area with a 

different width.  

 RESIZE FOR NARROWER COLUMNS - With this option (the default), the object will resize 

down if it’s too wide for the text column, but it will not grow up above its original size if 

the column is wider than the object.  

 RESIZE RELATIVE TO COLUMN WIDTH - This option allows you to specify that the 

embedded object should always be a fixed % of the column width.   

 FIXED SIZE - This option turns off the automatic resizing, so the object will never 

change its size. 

 SCALE ONLY IN HORIZONTAL DIRECTION - This option is useful mainly for simple divider 

or Rule-off graphics, where you want the object to just stretch horizontally without 

getting taller or shorter depending on the column width. It’s useful only for very simple 
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designs because more elaborate graphical divider designs are not likely to stretch well 

without looking distorted.  

Add a simple Rule-off divider at the carat position using the "INSERT" > "RULE-OFF" menu 

option.  

The POSITIONING options allow you to choose how the graphic should be formatted into 

the text.  

 INLINE WITH TEXT - This is the default option. The graphic stays inline with the text with 

no text wrapping, like this , and behaves as though it's a large text character in the 

text.   

 TEXT WRAPS RIGHT - The graphic will be positioned to the left of the text column with 

text wrapping to the right. 

 TEXT WRAPS LEFT - The graphic will be positioned to the right of the text column with 

text wrapping to the left. 

The MARGINS options allow you to add some space around your graphic, so it doesn’t 

appear too close to the text or to the edge of the column. You can specify different values 

for each of the 4 sides of your graphic, or use the lock  buttons if you want to have the 

same margin top and bottom, or left and right, without entering the same values 

repeatedly. 

Additionally in the "INSERT" menu, the "BREAK" > "MOVE BELOW EMBEDDED GRAPHIC" 

option enables you to force the next paragraph of text to start below the graphic when 

you have text flowing to the left or right of the embedded graphic. 

When you embed a single object in text, you can directly select that object in the text 

instead of selecting the “Embedded group” that encloses it. Look at the Status Line (on 

page 49) and the Page & Layer Gallery (on page 196)! to see this in action.  

Bulleted and Numbered lists 

Bullet Lists 

 

You can turn any text into a bulleted list by selecting the text and then selecting 

the bulleted list button on the InfoBar. 

Each paragraph of text becomes a separate bullet. If you press return to finish a line at 

the end of one bullet point, the next line starts with a bullet point too. If you hit backspace 

immediately after the return, the last empty bullet is removed, text cursor remains at the 

same position and allows you to continue adding text to the previous bullet point. 

To finish entering a bulleted list, hit return on the end of the last bullet and then 

immediately hit return again on the new bulleted line. This removes the last empty 

bulleted line and allows you to start entering normal text again. Or you can just turn off 

the list button on the InfoBar. 
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You can nest bulleted lists by pressing the indent button on the InfoBar. This 

indents the current bulleted line and changes the bullet character to a different 

style, to distinguish it from the parent bullet. 

 

Example of a nested bulleted list 

 

To move a bullet point from a sub-list into its parent bulleted list, simply place 

the text caret in it and press the outdent button. 

So it’s easy to make and edit arrangements of nested bulleted lists using the indent and 

outdent buttons.  

Numbered Lists 

 

You can create and edit numbered lists in just the same way as described for 

bullet lists above, using the numbered list button.  

You can choose the numbering scheme to be used for each list, using the NUMBERED 

LIST section of the LIST PROPERTIES dialog. Place the text cursor in one of the numbered 

list points, press the right mouse button and choose ‘LIST PROPERTIES…" from the context 

menu. The dialog is modal, which means it will stay open as you make edits to your list 

items and you can instantly see your changes as you make them.  

 

Numbered list dialog 

In the dialog you can choose from a variety of numbering schemes and also enter the 

value that should be used for the very first entry in the list. Then the number is 

automatically incremented for the second and subsequent entries in the list. 
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Editing List items 

If you want to make edits to the bullets or numbers themselves, perhaps a color, font size 

or position change, the LIST ITEM section of the LIST PROPERTIES dialog lets you do this. 

Place the text caret in one of the list points, press the right mouse button and choose 

LIST PROPERTIES… from the context menu.  

 

List properties dialog 

Link to previous list of the same level 

You can link separate lists so that the list item attributes of a second list continue from 

the previous list at the same level. This allows you to insert gaps, graphics, paragraphs 

etc. in the middle of lists. With numbered lists the numbering of the second list carries 

from the last number used of the previous list. 

The option also works with sub-lists, so when checked, the current list picks up its 

settings from the previous list at the same level and of the same type. So set this option 

on a bulleted sub-list and it will pick up the bullet symbol, margin, indent, color, etc. 

settings from the previous sub-list of the same level.  
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Just place the text carat in the second list and check the LINK TO PREVIOUS LIST OF THE 

SAME LEVEL checkbox to link to the previous list.  

 

A linked numbered list 

Indent 

The indent is the space between the numbers/bullets and the start of the list text. Use the 

Indent controls to adjust this spacing for the list at the caret position. 

 

Indent examples 

Margin 

The margin field controls the space to the left of the bullet/number. Use these controls to 

adjust the horizontal offsets of sub-lists.  

 

Margin examples 

Size 

Adjust the font size of the bullet or number. Enter a value, use the dropdown menu or 

use the slider that appears when you click the arrow to the right.   
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Color 

Create a custom color for the bullet or number by clicking the Edit button to bring up the 

color picker. (on page 210) Once you have opened the color editor in this way you can 

also click on any of the colors on the color line, if you want to choose a standard color. 

Use the dropdown to stick with the default color or pick out one of the current document's 

named colors (on page 216) should it contain any. 

Vertical offset 

Move the bullets or numbers up or down relative to the text list. This is particularly useful 

for bullet symbols because the vertical positions of these can vary, so depending on 

which symbols you choose for your bullets you may need to adjust the position. 

Replace with symbol 

For bullet lists only - choose a replacement symbol from the Symbol picker (on page 

233). Click to open the picker. If you choose any of the MATERIAL ICONS symbols, you will 

probably need to adjust the vertical position of the symbol - see above. 

Replace from clipboard 

Photo & Graphic Designer allows you to use any graphic for your bullets or numbers in 

lists. REPLACE FROM CLIPBOARD performs the same function as the PASTE AS LIST BULLET 

operation in the context menu. See the GRAPHICAL BULLETS AND NUMBERED LISTS 

section below, for more info. 

Reset to default list items 

Revert to the default bullet/number settings. 
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Graphical Bullets and Numbered Lists 

You can use any graphic or symbol for the bullet or number in a list. You can design your 

own bullets and numbered lists by using any of the normal drawing or text tools, or use 

one of the many bullet designs from the Online Content Catalog. Create a simple circle 

using the ELLIPSE TOOL for example, give it a fill and copy it to the clipboard. Then 

highlight the list you want to apply the style to using the TEXT TOOL. Right click the list 

and choose PASTE AS LIST BULLET from the menu. The design will now appear as a bullet 

for each of the list items.  

 

For a numbered list it's exactly the same procedure except you select or group a text 

item with your graphic and then select PASTE AS LIST NUMBER to replace all the numbers 

or text items in your list. The text object in the group is used to show the number. 

Both paste options are also available within the LIST PROPERTIES dialog (Right click the 

list and choose the LIST PROPERTIES... option and select REPLACE FROM CLIPBOARD).  

(Note that you cannot currently use graphical bullets and numbers with List text styles 

(on page 275) - you'll receive a warning prompt if you try) 

Text Styles 

TEXT STYLES are a powerful way to alter the appearance of text throughout a document 

with a few clicks.  

 

A TEXT STYLE is a named collection of attributes, such as font, size, color, line spacing 

and other text attributes. For example, the main heading at the top of this document 

might have a style called ‘Heading 1’, whereas the smaller sub-headings could have a 

style called ‘Heading 2’. 

 

By updating the definition of ‘Heading 2’, say, to be a different font, then every similar 

heading throughout the document will be updated instantly.  

 

Similarly the main text, sometimes called the ‘body text’ of a document is also a particular 

style, which Photo & Graphic Designer calls the "Normal text" style. By updating that 
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style to be, say, 12 point Times New Roman, then all "Normal text" throughout the 

document can be changed in one go, without having to select and apply the same font 

change over and over again. 

 

TEXT STYLES are, therefore, rather like the "Named Colors" feature that Photo & Graphic 

Designer also supports, where you can update "Theme Color 1" to be a new color and all 

parts of the document using that Named Color take on the new color. 

Text Styles InfoBar 

There is a Styles drop-down menu on the TEXT TOOL INFOBAR, that allows you to create 

Styles, apply them to any text, and to update the definition of the Style. 

 

By default there is a small set of pre-defined Styles, including ‘Normal text’, and three heading 
styles - Heading 1,2,3. 

Paragraph Styles and Character Styles 

Text Styles come in two varieties. Paragraph Styles and Character Styles.  

A Paragraph Style is denoted by a ¶ symbol on the style menu. An A symbol denotes a 

Character Style. 

Paragraph Styles apply to whole paragraphs, and are also typically used for headings. 

It’s not possible to apply a Paragraph Style to a smaller section than a paragraph, so you 

cannot, for example, apply a Paragraph Style to a single word within a paragraph. If you 

try, then the whole surrounding paragraph will take on this Style. 

Just place the text cursor anywhere on the line and select a Paragraph Style from the 

style menu, and the whole paragraph will take on that style. 

Character Styles, on the other hand, can be applied to any selection of text, from a single 

character upwards. For example, if you wanted to highlight certain words in your text in a 
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different color a Character Style would be ideal. The advantage is that you can then 

change the color (or font, etc) of all these highlighted words with a single Style update. 

Create a Character Style by clicking CREATE STYLE in the Style menu dropdown and 

checking the CHARACTER STYLE option from the dialog as you create a new text style. 

See Creating new Styles (on page 277) for more info. 

Paragraph styles can define all text attributes even bulleted/numbered list properties. 

Character styles can only define text attributes that can be applied to individual 

characters, such as text color, font size, font weight, etc. 

List Styles 

You can also apply Styles to bulleted and numbered lists. The style will take on all the 

attributes of the bullet or numbered list. Once you have applied a style to a list a "." 

appears in the Style menu to indicate that it is a List Style and to enable you to 

distinguish it from a Paragraph or a Character style.  

  

To make a list style, first create a list and customize it using the LIST PROPERTIES (on 

page 270) dialog. Then place the text caret in the list, or select part of the list, and 

choose CREATE STYLE … from the text styles dropdown list. Choose a name for your list 

style and click ok. 

List styles include all the list settings you see in the LIST PROPERTIES dialog, from indents 

to bullet symbols and colors. Each level within a list can have different settings and these 

are also all recorded in the list style. The example below has only 2 levels of list, but you 

can have as many levels as you like.  

 

To update a list style, simply modify a list that uses the style and then use the UPDATE 

option in the styles list, the same way you update ordinary Paragraph styles. The list will 

update whatever list level the text cursor is placed in - or all selected levels if you have 

more than one level selected - with the UPDATE option reflecting your choice. 

Note: Graphical lists (where you can use any graphical object as the bullet or number) 

are not yet supported with list styles. 



 

 276 Text Handling 
  

 

 

Next paragraph style 

This is one of the settings for a text style - look at the list's PROPERTIES… option in the 

style menu.  

For Paragraph styles it determines what style should be applied by default to a new 

paragraph created following the current paragraph. For example, heading styles normally 

set the NEXT PARAGRAPH style to NORMAL TEXT, because that’s usually what you want 

immediately following a heading. With a list style however, it’s more likely that you want 

another list item to be added when you hit return at the end of a list item. So for list styles 

the NEXT PARAGRAPH setting is only used when you end a list. End a list by hitting return 

once to add an empty list item, then hit return again. The new non-list paragraph will then 

use whatever NEXT PARAGRAPH style you chose for the list style. 

For more detail on editing lists see Bulleted and numbered lists (on page 268)   

Updating Text Styles 

To update an existing Text Style: 

1.  Select some text already in the style you want to update. 

2.  Apply whatever changes you require, say an alternative font, or font size, or maybe 

in the case of a list style a bullet or number style change. 

3.  Select "UPDATE 'STYLE NAME' TO MATCH" from the Style drop-down menu on the 

Text InfoBar. 

For example to change all the NORMAL TEXT to be a different font, select a few words in 

the NORMAL TEXT Style, change the font (and any other attribute) and then Select UPDATE 

'NORMAL' TO MATCH from the Style Menu on the Text Tool InfoBar. 

When you are working on a web document with RWD variants, it is possible to update a 

Text Style for an individual variant. This is useful for example when you need the text in a 

mobile variant to be a larger and/or different font. To update the style for an individual 

variant, change the text as above and then select UPDATE 'STYLE NAME' IN THIS VARIANT 

from the Style drop down menu on the Text InfoBar. This is an additional option that is 

shown in the STYLES menu when you are working in a document that has multiple 

variants.  

See Responsive Web Design for more information about variants. 

Redefining Text Styles 

Sometimes you may want to make an existing text style to look like some text that does 

not already have that text style applied. Perhaps some text that you imported from some 

other document. You can’t just apply the existing style to that text, because you would 

then lose its appearance. Instead use the UPDATE OTHER STYLE TO MATCH… option in the 

style menu.  

1. Place the text cursor within the text (or select some of the text). 

2. Select UPDATE OTHER STYLE TO MATCH... from the Style drop-down menu on the 

Text InfoBar. 
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3. Choose the Style you wish to update from the UPDATE STYLE TO MATCH... dialog. 

4. Tick the appropriate checkboxes to decide if you want the Text Style to match only 

the new text, and/or all similar text in the document. Uncheck APPLY TO ALL SIMILAR 

TEXT IN THIS DOCUMENT if you only want the Style to be applied to the paragraph 

containing the text cursor. 

5. Click APPLY. The text is now redefined as the selected Text Style. 

The APPLY TO ALL SIMILAR TEXT IN THIS DOCUMENT option is useful for applying text styles 

to existing documents that don’t already use text styles, such as imported PDFs. For a 

style to be applied to all similar text within the document, the text must have the same 

font and font size over more than 50% of a paragraph, and it must also have the same 

justification and indentation settings (within a small tolerance).   

  

Styles based on other styles 

In Photo & Graphic Designer, you can base one style upon another. For example, if you 

wanted another variant of Heading 2 style, that was identical in every respect, except a 

different color, then when you create the new style you would make it based on "Heading 

2" in the CREATE STYLE dialog. This means that if you update "Heading 2" to be, for 

example, a new font or size, your new Style would also take on that new font or font size. 

New Character Styles are typically based on the "Underlying Paragraph Style", but just 

with the changes you want. So this means if you have a Character Style that just sets the 

text color and nothing else, applied to a single word, then when you altered the 

Paragraph Style of the paragraph, this word would change to match, except its color. 

Creating new Styles 

To create a completely new Style, change a selection of text to appear how you want and 

then select the CREATE STYLE... option from the Style list drop-down on the TEXT TOOL 

INFOBAR. 

 

If you want to create a new Paragraph Style it’s recommended that you select and apply 

your changes to a whole paragraph, before selecting the CREATE STYLE... menu option. 
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Clicking CREATE STYLE... shows the following dialog... 

 

This dialog shows a new style, (NewStyle2) being created that is a PARAGRAPH STYLE, 

based on an existing HEADING 2 style. The NEXT PARAGRAPH option determines what 

style will be used for the subsequent paragraph when typing. 
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The OUTLINE LEVEL is used to set the outline level of a heading style when inserting a 

table of contents. The level determines the indentation level in the table and you can 

specify the maximum level of heading that should be included in the table. For example 

you might want to only include levels 1 and 2 (Heading 1 and Heading 2), to keep the 

size of the table down. 

 

The lower section of the dialog shows the complete definition of this Style. In this case 

you can see it’s based on Heading 2, with only a color change. 

 

To create a Style that is based on no other Style, that is to say, it inherits no attributes 

from another style, select (NO STYLE) from the BASED ON: option, as below. 

 

This dialog shows the creation of a NewStyle2, that is a Paragraph Style and based on 

no other style. The lower section lists all the attributes that make up this Style. The 

attributes listed have been taken from selected text, so this Style consists of a complete 

definition, listing all possible text attributes. 

 

In this case when entering text in this Style, the NEXT PARAGRAPH (i.e. when Return is 

pressed) will be in the same style again. 

Removing Styles 

The STYLES list in the STYLES menu includes the entry NO STYLE. Selecting this removes 

the Style (Paragraph and/or Character Style) from the selection whilst retaining the same 

appearance. When you select the option a dialog appears informing you of this. Click on 

the dialog's CLEAR STYLES button to proceed with the operation. Now your selected text 

looks exactly the same as before, but has NO STYLE applied to it. 
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Deleting Styles 

To delete a style select DELETE STYLE from the STYLES menu, the DELETE STYLE dialog 

opens. Now choose the text style you wish to delete from the dropdown menu in the 

dialog. The style will be deleted from the menu as will all references to the style, and the 

style will be returned to its base style. However, the returned style will still retain the 

deleted style's attributes and appearance. So for example a deleted style based on 

HEADING 1 WILL appear as HEADING 1+ to indicate this.   

If your style was based on nothing, ie NO STYLE then the style will revert to No style 

appearing as NO STYLE + in the menu and again retaining the same attributes and 

appearance.  

Note that you can't delete the default styles and you also can't delete styles which have 

other styles based on them. You will receive a warning prompt should you attempt to do 

so.   

Hidden Styles 

Text styles can be marked as HIDDEN in the STYLE PROPERTIES dialog, which means they 

won’t appear in the main styles list unless the text caret is located in text that uses that 

style.  

This is useful to help avoid the styles list becoming too long in documents that use a lot 

of different styles. Some SmartShapes such as the bar and column charts have their own 

text styles and these are now automatically made hidden styles, so they don’t appear in 

the main styles list. Similarly the TOC styles used for Tables of Contents are also hidden. 

Use the SHOW HIDDEN STYLES option in the styles menu to have all styles included in the 

styles list.  

Additionally hidden styles can’t become current, so any new text you add to a design 

should never use a hidden style by default.  

Style Properties 

If you want to change the definition of a style, such as the style it’s based on, or just look 

at its definition, use the PROPERTIES… option in the style menu. You need to select some 

text that has the style applied before you do this, to indicate the style you want to edit. 

The STYLE PROPERTIES dialog appears, which looks the same as the CREATE STYLE 

dialog shown above. 

The style description at the bottom of the dialog describes how the style differs from the 

style on which it is based. So if you want to see all of the style’s attributes, just 

temporarily select NO STYLE from the BASED ON list, to see a full description. Don’t forget 

to reset this to the correct BASED ON style, or click cancel in this dialog, if you don’t want 

to change the style! 
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Applying text attributes 

Changing the font size 

 

There are several ways to change the font size: 

 Type a new value into the size text box on the InfoBar and press . 

 Or select from the FONT SIZE drop-down list on the InfoBar. 

 Or use the Font size pop-up slider (on page 231). 

 Or manually increase/decrease font size with the "Ctrl + Shift + >" and "Ctrl + Shift + <" 

keyboard shortcuts. This applies only if all selected text parts are of the same font 

size. 

 Or use the SELECTORTOOL to scale the whole text object. 

Bold & Italic 

 

Click the BOLD or ITALIC button on the InfoBar ("Ctrl + B" or "Ctrl + I") 

This applies the bold or italic variant of the current font. 

Text Underlining 

 

Click the underline button on the InfoBar to apply an underline to the selected 

text. 

The underline color and size is automatically derived from the text color and size. 

Underlining links 

When you add a web address URL to some text, see the Web address dialog. You can 

decide to automatically underline all links. This is a check box option on the web address 

dialog ("Ctrl + Shift + W"). If you select this all linked text throughout the document is 

underlined, and the underline command does not affect this. 

If you apply a URL to a group that contains some text, then the text will not be 

underlined. 

Justification or text alignment 

Justification always applies to the complete line. Any selected region is ignored. 

 



 

 282 Text Handling 
  

 

 

 
LEFT justification: Align the left-hand edge of the text to the initial click position. 

 
CENTER justification: Centers the text around the click position. 

 
RIGHT justification: Align the right-hand edge of the text to the initial click position. 

 
FULL justification: This only applies when text is along a curve or in a column and 

when there is at least one full line of text to justify. 

When using simple text the initial click position on the page is taken as the origin for text 

justification. 

Ligatures 

 

A ligature is a connection between two or more characters to improve legibility or for a 

stylistic flourish. The linked sequences of characters then appear as a single glyph. 

Ligatures, where they exist, are contained within the font file and can be displayed 

according to the settings on the OPEN TYPE LIGATURES button on the InfoBar. The ligature 

settings can be used in text styles just like other text attributes. 

The various options are... 
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STANDARD  Only the default set of ligatures provided by the font designer will be 

displayed. 

 

 

 

Ligatures off (left) and on (right) 

DISCRETIONARY The discretionary ligatures are decorative - to be applied at the 

discretion of the user. 

 

 

           

HISTORICAL Historical ligatures are mainly ornamental suggesting a historical 

context. 

 

 

          

CONTEXTUAL The glyph applied depends not only on the actual characters replaced 

but also on the context in which those characters appear. So the actual 

ligature used for a given character combination may vary depending on 

what characters precede and follow the combination that is replaced. 

 

             

SELECT ALL All available ligatures for a particular font will be displayed. 

CLEAR ALL No ligatures will be displayed.  

You can choose which groups to turn on or off independently for any range of characters. 

Select a character range in the TEXT TOOL and then click on the Ligatures button. 

If you select some text and move your mouse pointer over the different options in the 

LIGATURES and STYLISTIC SETS menus, your text will update dynamically to show you a 

preview of what the option will do. This makes it easier to see the effects the different 

options will have on your text if you choose to apply them. 
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Stylistic Sets 

  

Some fonts include alternative sets of ligature characters that the user can choose from, 

allowing more flexibility. If any sets are available for any of the characters in the current 

text selection, they are listed under the STYLISTIC SETS menu, where they can be turned 

on and off independently. Select text and mouse over for a dynamic preview.  

 

 Font Gabriola (left) and with stylistic set applied (right)  

Open Type Alternates 

 

Some Open Type fonts provide alternative glyph designs for the same ligatures. Click the 

button to see a menu containing the various options.  

 

Font Camper Print Script 3 with no alternates (top) and with alternates (main).  

As with the LIGATURES and STYLISTIC SETS menus, if you select some text and move your 

mouse pointer over the different menu options your text will preview automatically.  

The menu options are... 
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None 

No alternates are displayed. 

Contextual Alternates 

Use the CONTEXTUAL ALTERNATES menu option to turn the alternates on and off for any 

character selection. In this example you can see the different glyphs used in the same 

word. 

 

Contextual Alternates off (left) and on (right). 

When you change this option, if you don’t see any differences in the selected text that’s 

because the font you are using doesn’t have any alternates for the characters you have 

selected. 

Titling Alternates 

When this option is turned on, default character glyphs from the font are replaced by 

alternative glyphs designed to look good at larger sizes. So they are intended for use in 

headings and titles, but you can use them anywhere. Not all fonts provide these 

alternates and not all characters in the font may have them. 

Stylistic Alternates  

Turn this option on to see alternative glyphs that may be provided with a font for some 

characters, as an alternative to the default glyphs. Experiment with these alternatives for 

different aesthetic or design effects, where the font provides them. 

Swashes 

Swashes are highly decorative or ornamental glyphs, typically with elaborate flourishes. 

All 

All the available alternates for the glyph are displayed. 

Text Capitalization 

 

Click the TEXT CAPITALIZATION button on the ADVANCED TEXT BAR to access the 

capitalization options. 

The options are...  
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AS TYPED This is the default setting for all text, the case remains as whatever 

you typed.  

ALL CAPS Text is always all upper case, whether it was typed as upper or 

lower case. 

ALL LOWER Text is always all lower case, whether it was typed as upper or 

lower case. 

INITIAL CAPS The first letter of each word is capitalized.  

SMALL CAPS Characters that were typed as lower case are shown as small 

upper case characters. Characters that were typed as upper case 

will appear as normal, so slightly larger.  

 

Many OpenType fonts actually include special character glyphs for SMALL CAPS and if the 

font you are using does, Designer 16 will use them, so you will see Small Caps text 

appear exactly as the font designer intended. If the font you are using does not provide 

its own Small Caps character glyphs, Designer will use the font’s ordinary upper case 

characters, but at a reduced size. Therefore you can safely use this option with any font, 

whether or not the font has Small Caps support.  

These options are all text settings, so they not only change the case of the selected text, 

they are also applied as settings to the text so that subsequent editing maintains the 

case setting you’ve chosen (in the same way that the Bold and Italic settings on text 

work). 

These settings also work with text styles, just as all other text settings do, so for example 

you can define a heading style to always appear in Capitals by applying ALL CAPS and 

then updating the style definition. 

TOGGLE CASE 

This option is shown in a separate section of the menu because unlike the other options 

above it is not a setting - it simply toggles the case of each letter in the selected text.

  

Subscript & superscript 

 

Click the appropriate button on the InfoBar. 

Normal text   subscript
superscript 
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Line spacing 

 

Line spacing allows you to change the space between two lines 

(so affects vertical spacing). 

Line spacing is measured in percentages (120%) or points (12pt). You can either type 

the line space value in the text box or click the arrows to nudge the values. 

A percentage setting has the benefit of scaling accordingly if you change your font size. If 

a percentage is applied to a line of text with more than one font size, the largest font size 

is used. For example, if a line contains 90% and 100% text, the line spacing is calculated 

on 100%. 

Indents and Outdents 

 

Indent a paragraph of text. 

 

Outdent a paragraph of text. 

 

Paragraph Spacing 

 

The last two fields on the end of the TEXT TOOL InfoBar allow you to set 

the spacing above and/or below paragraphs.  

This is particularly useful where you want half line spaces between paragraphs. 

Like Microsoft Word, when you use both spacing above and below paragraphs, the 

spacing between paragraphs is whichever is the greater value (it's not 

cumulative). Paragraph spacing above paragraphs will move the first paragraph down in 

a frame of text. 

Baseline shift 

 

On the Advanced text bar - Baseline shift allows you to move part of 

a line up or down. Positive values move the text upwards, negative 

downwards. 

The baseline is the imaginary line at the bottom of characters. 

Select the characters for which you wish to change the baseline shift then enter a value 

in the BASELINE SHIFT text box. 

 

The effect of selecting D-H and then applying an upwards baseline shift (i.e. 5pt). 



 

 288 Text Handling 
  

 

 

Baseline shift is measured in points but you can use any of Photo & Graphic Designer’s 

standard measurement units. Note that baseline shift is an absolute value, in points, and 

does not change if you change the font size. 

Tracking 

Whereas kerning (see below) changes the spacing between two characters, tracking (on 

the Advanced text bar) changes the spacing equally within a region of text. An EM is the 

width of the capital letter "M" in the current font and font size. It is therefore relative to the 

font size and not a fixed value. 

 

1. Select the region to which you want to apply tracking. 

2. Type a value into the TRACKING text box (values are in 

1/1000ths of ems). 

From the keyboard you can increase or decrease the tracking by pressing "Alt + Right 

arrow", or "Alt + Left arrow". Each key press changes the tracking by 10/1000. 

Kerning 

 

On the Advanced text Bar - Kerning lets you alter the space between 

two characters (so affects horizontal spacing). 

Most good fonts have auto-kerning which means they already move appropriate pairs of 

characters together slightly, as you can see from this diagram: 

 

Auto-kerning off  Auto-kerning on  Manual kerning 

Kerning is measured in "ems" (enter values in 1/1000ths of "ems".) You can either type 

the kerning value in the text box, or click the arrows to nudge the values. 

It shares the same key shortcuts as above. If there is just a cursor, it alters the kerning, 

but if there’s a selected range of text, then it alters the tracking. Each key press alters it 

by 10/1000ths of a em. 

Condensing and expanding characters (aspect ratio) 

The aspect ratio (on the Advanced Text Bar) is the ratio between the height and width of 

the text. Ratios over 100% make the text wider than normal; under 100% make the text 

narrower. 

To change the aspect ratio: 

 

Type a new value into the ASPECT text box on the InfoBar and press "". 

Or use the SELECTOR Tool to stretch or squash the complete line of text. 
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It is not recommended to use values below 80% or above 130%. Better to use a special 

condensed variant of the font family if available. Alternatively use the tracking control to 

adjust the spacing without distorting the actual shapes of the characters. 

IMPORTANT: When creating websites, avoid changing text aspect ratio or tracking 

because these changes will not be reflected in the text of your website. 

Advanced text properties 

Right click on a text object and select "ADVANCED TEXT PROPERTIES…" to bring up the 

Advanced text properties dialog. 

 

Here you can turn off auto-kerning on the selected text object if desired. See the kerning 

section above for information on kerning. 

You can also specify that the selected text should be converted to shapes before being 

sent to the printer, which is useful if there are any problems printing with the font used.  

Copying text appearances 

It’s easy to copy the style of any text to any other region of text using the PASTE 

FORMAT/ATTRIBUTES feature: 

 Select the source region from where you want to copy the style. This can be as little as 

a word (just double click). 

 Select "EDIT" > "COPY" ("Ctrl + C"). 

 Select the region of text to which you want to apply the style. 

 Select "EDIT" > "PASTE FORMAT/ATTRIBUTES" ("Ctrl +  + A"). 

If you just have the text cursor positioned in some text when you PASTE 

FORMAT/ATTRIBUTES the paragraph attributes will be pasted to this paragraph. 

If you have a region of text selected, then PASTE FORMAT/ATTRIBUTES will paste all the 

visual attributes of the source text.  
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Applying attributes to whole text stories 

When you have the cursor in a simple or column text object, pressing "Esc" will select the 

whole text object. You can then apply an attribute, say a color, and the whole text object 

is altered. This is often quicker than performing "Select all" ("Ctrl + A"). 

With text areas this method only works if all text areas of the story are selected. You can 

do this in the SELECTOR TOOL clicking and "Shift + clicking" on the different text areas to 

select them. But this method is only possible if the text areas are on a single page. If your 

text story flows over several pages and you want to change all the text, then it’s 

necessary to "Select all" ("Ctrl + A"), and then apply the required attributes. 

Copying/Pasting formatted text (RTF) 

You can copy "rich text" (as it's sometimes known) from other applications such as word 

processors or editors and paste into Xara Photo & Graphic Designer as text, and the 

fonts, margins, line spacing and text links will be preserved. This makes it dramatically 

easier to retain the style and appearance of your text.   

When you paste "Rich Text Format" (RTF) from other applications you are given the 

choice of pasting the text in as "Unformatted text" which means it will appear in the font 

and style at the cursor where you paste, or "Rich Text Format", i.e. it will retain the style 

of the source text. 

This also works the other way around. You can copy text in Photo & Graphic Designer 

and paste into other applications that support rich text editing and the style (font, size, 

colors, margins etc) will be retained. This will only work if you select and copy a single 

text object or from a single text flow.  

Seeing fonts in use 

It is sometimes useful to see what fonts are used in your document, particularly if you are 

sharing files with other Photo & Graphic Designer users who may not have the same 

fonts installed. 

For a complete list of fonts used in your document choose "FILE" > "DOCUMENT INFO". 

Any fonts that are used in the document but are not currently installed on your computer 

have NOT INSTALLED by them. 

Another way to see which fonts are used in your document is to just open the font menu 

of the TEXT TOOL InfoBar. The top section shows fonts used in your document. 

Changing text into editable shapes 

You may want to convert some text into editable character outlines for further 

manipulation or if you wish to give the document to someone who does not have the 

fonts used in your document. 
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To do this: 

1. Change to the SELECTOR TOOL. 

2. Select the text. 

3. Choose "Arrange -> Convert to editable shapes" ("Ctrl + Shift + S"). 

This converts the individual characters into a series of straight and curved lines. To 

manipulate individual characters, select the text then select "ARRANGE -> UNGROUP"  (Ctrl 

+ U) twice. All characters will then be separate objects. 

Note: you cannot edit the text with the TEXT TOOL after you have converted it, so make 

sure the text is correct before you convert it. 

The Fonts Gallery 

The FONTS GALLERY serves a number of useful purposes: 

 It’s an easy way to preview the style of all fonts on your system. 

 It lists all the fonts included on the Xara Photo & Graphic Designer CD (whether or not 

they are installed). 

 You can install fonts from the CD (or hard disk), or un-install fonts 

 You can apply fonts by drag-and-drop 

 

To display the FONTS GALLERY click its tab in the galleries bar to the right of the 

Photo & Graphic Designer window. Or you can toggle display of the FONTS 

GALLERY by choosing UTILITIES > GALLERIES > FONTS GALLERY or pressing "Shift 

+ F9". 
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The fonts are grouped into several categories: 

 At the top are fonts installed on the computer (i.e. all the fonts in your Windows/Fonts 

folder). 

 Next are all fonts (installed or available on the Photo & Graphic Designer CD)  

grouped by appearance (for example: script, decorative, sans serif) 

 Last is a complete alphabetical list of all fonts, installed or ready to install. 

The Document handling (on page 74) chapter has general information about galleries. 

Applying a font from the Fonts Gallery 

This is an alternative to using the TEXT Tool INFOBAR. You can either: 

 Select the font in the gallery and click APPLY to apply to the selected text object, or 

double click a font 

 Or drag & drop the font name onto any text (selected or not). The pointer changes 

shape when in position. 

If you apply a font that is not installed it asks if you want the font installed. 
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Installing or uninstalling a font 

The first part of the gallery shows fonts already installed. Remaining sections show fonts 

on the CD (either from the CD or from the hard disc made at install time). 

1. + 

clicking" to select a group or "Ctrl + clicking" to add an individual font to the 

selection. 

2. INSTALL or the UNINSTALL button on the top of the gallery. Alternatively if you 

apply an uninstalled font this automatically installs it. 

You can also click GET FONTS to download a selection of fonts, but this is only useful if 

you haven’t installed the fonts from the Photo & Graphic Designer CD. 

Fonts from other suppliers can also be installed using the Windows Control Panel 

(described in the Windows Help and Support section of Windows). 

Note that to install fonts from the Font Gallery Xara Photo & Graphic Designer must be 

running with Administrator privileges.  

Fonts and PDF 

When you create a PDF ("FILE -> EXPORT…"), you get the option to embed fonts into the 

PDF file. Font embedding ensures that anyone who receives the PDF can view and print 

the document with the correct font, but it does make the PDF files larger. 

 

PDF Export options 

This is only possible for those fonts that are marked by their creators as having 

permission for embedding. You are warned if it’s not possible to embed fonts. 

Document Font embedding 

Xara Photo & Graphic Designer stores the character shapes of all the fonts used in your 

document. This means if you give someone else your design file, or transfer the file to 
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another computer, the text will still look exactly right, even if the correct fonts are not 

installed on that computer. 
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Fills 

Introduction 

Photo & Graphic Designer has these types of color fill: 

FLAT FILLS - the shape has an even color or tone over its 

surface. 

 

LINEAR FILLS - the color gradually changes from one color to 

another. 

 

CIRCULAR FILLS - the color change radiates out from a single 

point in a circular pattern. 

 

ELLIPTICAL FILLS - similar to circular fills except the change 

radiates out in an elliptical pattern. 

 

CONICAL FILLS - the color change rotates around a single point. 

The effect is of a cone lit from one side with the opposite side in 

another color.  

DIAMOND FILLS - similar to elliptical fills, except the fill is like a 

diamond. 

 

THREE-COLOR FILLS - shows three different colors as if 

spotlights were lighting the object. 

 

FOUR-COLOR FILLS - the same as three-color fills, except four 

colors are possible. 

 

BITMAP FILLS - the object is filled with one or more tiled copies 

of a bitmap. Any bitmap in the BITMAP or FILL galleries can be 

used.  

FRACTAL CLOUDS - produces a patchy random fill which is 

especially useful for clouds or mist. 

 

FRACTAL PLASMA - a patchy random fill which has more 

contrast than a fractal cloud fill. 
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The FILL Tool lets you apply and edit any type of fill to the selected object. 

 

In addition to using the FILL Tool, if you have the SHOW 

FILL EDIT HANDLES option selected on the SELECTOR Tool 

InfoBar, you can adjust fills using the SELECTOR Tool ("Ctrl 

+ Shift + 3") 

Automatic select inside 

In the Fill Tool, an automatic "Select inside (on page 117)" is performed when you click 

on an object that is part of a group, instead of selecting the group as a whole. This 

makes it easier for you to work on fills inside groups. If you want to change the fill 

attribute of a group (which is not very likely), you need to select the group using the 

Selector Tool first.  

The Fill Tool 

Creating a graduated color fill 

 

The process of creating a different fill is almost identical for all the fill types: 

1. t the object or objects to which you want to apply the fill. 

2. Select the FILL Tool ("G"). 

3. Select the fill type from the dropdown menu. 

4. -drag across the object to create the fill. Or, drag one of the fill handles to 

adjust the fill size and position. 

Xara Photo & Graphic Designer provides a smooth interactive live preview of the fill as 

you drag.  

 

As you drag a fill arrow is created indicating the direction of 

the fill. Fill handles can be selected and dragged to adjust 

the position and angle of the fill. 

Coloring fills 

Select one of the fill handles and click a color on the COLOR LINE or bring up the COLOR 

EDITOR and choose a new color. You can press "Tab" to alternate between the fill 

handles. 

Fill Tool InfoBar 
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Fill type 

 
Fill tiling 

 
Fill effect 

 
Bitmap name 

 
Profile 

 
Fill handle/resolution 

 
Handle color/Grain 

FILL TYPE selects the type of fill. Selecting from this menu: 

 with a selected object, applies the fill to the object; 

 without a selected object, sets the current fill type which will then be used for newly 

drawn objects. 

FILL TILING is used when applying bitmap and fractal fills. The options are described later 

in bitmap fills. Fill tiling changes the repetition of the fill effect. The options are: 

 Simple-the fill is used only once, regardless of the size of the object. 

 Repeating/repeating tile-repeats the effect so that it fills the entire object. 

 Repeating tile inverted-only available on fractal and bitmap fills. This is similar to 

repeating tile, but every other tile is inverted. 

 

A repeating elliptical fill inside an ellipse shape 

Fill tiling options are not available for 

conical. All other fill types can be made 

to repeat. This can produce some 

useful effects. 

FILL EFFECT is used for all fill types, except 3 and 4-color fills. It controls how the fill colors 

fade from the start color to the end color: 

 FADE: Fades between the two colors in a linear fashion 

 RAINBOW: Blends along the shortest edge of the HSV color wheel. For example, a 

blend from yellow to cyan runs yellow-green-cyan. 

This option has no effect when the two colors are black, white or gray. 

 ALT RAINBOW: Similar to rainbow except the blend is along the longest edge of the 

color wheel. For example, yellow to cyan runs yellow-red-magenta-blue-cyan. 

BITMAP NAME displays a pop-down menu showing thumbnails of all the bitmaps in the 

BITMAP GALLERY and is an easy way to select the required bitmap for a bitmap fill. 



 

 298 Fills 
  

 

 

FILL PROFILE - you can change the rate of the color transition between the start and end 

of fills. This applies to all fill types except flat, three color, four color and bitmap (unless 

it's a contone colored bitmap). 

To change the profile of a fill: 

1. Select the filled object. 

2. On the FILL Tool InfoBar click PROFILE. This opens the PROFILE dialog box. 

3. You either select a predefined profile from the dropdown list or drag the sliders to 

create a custom profile. The top option in the dropdown list (the straight line) 

creates a linear transition between the start and end of the fill. 

 

Three different black-to-white graduated color fills and their corresponding profile dialogs. The 
center, default, is a linear black-to-white  transition. 

FILL HANDLE: Indicates if the start or end handle is selected. This field is blank for flat fills. 

RESOLUTION (bitmap and fractal fills only) Shows the resolution of the bitmap (as long as 

you don't have a fill handle selected). You can type in a new resolution to change the 

size of the bitmap. Low resolutions show the individual pixels of the bitmap. You rarely 

need a resolution greater than 150 DPI, even for typeset output. 

FILL HANDLE COLOR: (except bitmap fills) Indicates the color applied to the selected fill 

handle.  

Flat fills 

To apply or change a flat fill: 
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1. l type menu. 

2. COLOR LINE or COLOR GALLERY. 

 

The Color Line and Color Gallery are described in Color handling (on page 205). 

Linear fills 

To apply a linear fill: 

1. Select linear fill from the fill type menu (not necessary if 

the object currently has a flat fill). 

2. Position the pointer where you want to start the fill (this 

can be outside the object). 

3. Drag the mouse pointer to where you want the fill to end 

(again, this point can be outside the object). 

 

The arrow drawn on the selected object is called the fill arrow. It indicates the direction 

and extent of the fill. You can select either end of the arrow by clicking it. 

Moving the start or end handle of the fill 

To change the direction and extent of the fill: 

 

1. Move the pointer over the handle you want to move. When over the 

handle, the pointer changes shape. 

2. Drag the handle. 

 

Changing the colors in a fill 

To change a color in a fill: 

 Drag & drop the color from the COLOR LINE onto a fill handle (you do not have to select 

the handle first.) 

 Or, drag & drop the color onto the object. Each fill has an imaginary center line halfway 

along the fill arrow. Dropping the color on the start handle side changes the start 

handle color, and the end handle side changes the end handle. 

 Or, if one of the end handles is selected (it's shown highlighted) just click on a color. 

You can press "Tab" to select the other fill handle, and click the color required for the 

other end 

The Color Line is described in Color handling (on page 205). 

Each method changes the color of one handle only; they do not change any other 

selected fill handles, or: 

1. Select the required handle (or handles, also works with multiple objects). 

2. Choose the required color from the Color Line. 
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3. This changes all selected fill handles. 

Circular fills 

 

For circular fills, applying the fill, moving handles and changing 

colors are the same as for linear fills. The start handle is the 

center of the fill. 

Circular fills are useful for creating highlight effects. 

Changing the height/width ratio of the object automatically changes a circular fill into an 

elliptical fill (see below). 

Elliptical fills 

 

Applying an elliptical fill is similar to applying linear fills. As you 

drag the mouse pointer, you first create a circle with two end 

handles. You can then drag the end handles to create a suitable 

ellipse. 

"+ drag" preserves the aspect ratio of the fill. "Ctrl + drag" constrains rotation to the 

preset constrain angles. Moving handles and changing colors are the same as for linear 

fills. 

A quick way to apply a elliptical fill: 

"Shift + drag" to create a elliptical fill. 

Conical fills 

 

When you apply a conical fill, the fill arrow displays as a semi-

circle with two end handles. You can then rotate either end 

handle around the start handle to create suitable shading. 

The size of the semi-circle is irrelevant-it has no effect on the fill. "Ctrl + drag" constrains 

rotation to the preset constrain angles. 

You can also drag the center handle to change the position of the fill. 

Moving handles and changing colors are the same as for linear fills. 
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Diamond fills 

 

Applying diamond fills is similar to applying elliptical fills. As you 

drag the mouse pointer, the fill boundary appears as a square 

with two end handles. You can then drag the end handles to 

resize the diamond. 

"Shift + drag" unlocks the aspect ratio of the fill, allowing you to move the fill handles 

independently. "Ctrl + drag" constrains your selection to the preset constrain angles. 

Three-color fills 

 

Three-color fills give the effect of three colored spotlights lighting 

the object. As you drag the mouse pointer, the fill displays as a 

triangle with three end handles.   

By default there is a 60° angle between the two fill arrows. "ń+ drag" to create triangles 

with different angles to form the fill triangle you require. 

Unlike other three-handle fill types, three-color fills can have a different color applied to 

each handle (the center and the two end points). 

The object can contain a single (simple) or multiple instances (repeating) of the fill. 

Four-color fills 

 

Four-color fills are similar to three-color fills and give the effect 

of four colored spotlights lighting the object. When you apply a 

four-color fill, the fill boundary displays as a square with four end 

handles.  

You can then drag the handles to scale and rotate the rectangles. "ń+ drag" to create 

parallelograms instead of rectangles. Hold down Ctrl while dragging to constrain the 

rotation of the fill.. 

You can apply different colors to all four fill handles/lines. The object can contain a single 

(simple) or multiple instances (repeating) of the fill. 

Bitmap fills 
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Fill Type 

 
Fill Tiling 

 
Not used 

 
Bitmap name 

 
Resolution 

 
Not used 

The BITMAP GALLERY is described in THE BITMAP GALLERY (on page 364) in the Photo 

Handling chapter, for the FILL GALLERY see below (on page 306). 

Bitmap fills are one of the most powerful fill types. It allows any photo or texture to be 

used as a fill for any shape and you have direct immediate control over the size, angle, 

position and tiling. You can color bitmap fills. You can use any type of bitmap as a fill, 

including JPEG photos, and alpha-channel (semi-transparent) bitmaps. 

When you import a photo file into Xara Photo & Graphic Designer (eg. a JPG or PNG file) 

it appears as a shape with a bitmap fill type. When such an object is selected the status 

line shows it as a “photo”, but it is just the same as a shape that has had the photo 

applied as a bitmap fill. 

To fill a shape with a bitmap or photo fill, do one of the following:  

 Drag any bitmap from the BITMAP GALLERY or from your Windows File Explorer over 

any shape, hold "Shift" and drop, or  

 Drag any fill from the FILL GALLERY onto the shape (there is no need to hold "Shift" to 

drop in this case)  

 Select 'Bitmap' from the left side drop down menu of the FILL TOOLINFOBAR, and then 

select the required bitmap from the dropdown menu of bitmap names (this only shows 

bitmaps that are or have been previously loaded).  

You can fill an object with single or multiple tiles (repetitions of the bitmap image). 

   

Single tile (photo) Repeating tile Repeat inverted-the tiles fit together 
perfectly. 

The fill has three handles. Use it for Resizing and re-positioning bitmap fills. An 

alternative way to set the size of the bitmap is to type in a resolution into the InfoBar field. 

You first have to un-select the fill handle by clicking anywhere on the image away from a 

fill handle, then just type a new dpi resolution. 
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Replacing Bitmap Fills 

If a shape already contains a bitmap, or is a photo, then you can just drag and drop a 

new bitmap from any source, such as Windows Explorer, and it will replace the existing 

bitmap. The new image is ‘best fitted’ into the shape so that it just fits in. By default, 

doing this will also replace all other instances of that photo on the current page, if they 

are in the same soft group.  

Holding down SHIFT while replacing a photo in this way causes the position, scale and 

rotation of the bitmap fill to be preserved. 

Bitmap coloring 

You can color any bitmap or photo fill by just clicking on a color on the COLOR LINE (make 

sure no fill handles are selected, by just clicking on the image). This will create a 

Contone (technically a Duotone) which uses colors between black and the selected color. 

Alternatively right click on the object and choose CONTONE > SET LIGHT COLOR or 

CONTONE > MAKE BLACK AND WHITE. You can also right click the color line and select 

either the 'SET CONTONE LIGHT COLOR' or 'SET CONTONE DARK COLOR'. 

So, for example, to make a picture black and white, just requires you to click on the 

White color patch on the color line. 

 

To cancel any applied color, apply NO COLOR to either fill 

handle. This restores the bitmap to its original bitmap colors. 

The RESOLUTION box on the INFOBAR shows the resolution, which can be altered by 

moving the fill handles or typing in a value. 

Resizing and re-positioning bitmap fills 

If you hold down Shift and click and drag on a shape which already has a bitmap fill, a 

new bitmap fill is created centered on the click point. If you hold the "Ctrl" key down too, it 

limits the angle, so this makes it easy to create an upright bitmap fill. 

 

Once the fill has been created, you can drag 

anywhere on the image to re-position the fill inside 

the shape. 
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When you mouse over the outer fill handles the 

mouse pointer changes into a “rotate” mouse pointer. 

Dragging on these  handles will stretch and rotate the 

bitmap fill with the current aspect ratio locked; hold 

down "Shift" while dragging to change the horizontal 

and vertical size independently and to skew the fill. 

The InfoBar shows you the resolution of the bitmap fill 

(you can adjust this, and thus the bitmap size, by 

entering a new value). 
 

An example 

 

To fill the ellipse on the left with the photo in the center; 

1. file from Windows Explorer (or from the Bitmap Gallery if 

it is already used in the document) over the ellipse, and drop it while holding down 

“Shift”. The Fill Tool becomes the current tool. 

2. on the Fill 

Handles. 

The above example has a simple shadow - see the chapter on the Shadow Tool for more 

information. 

Fractal fills 

Xara Photo & Graphic Designer supports two types of fractal fill which are mathematically 

created naturalistic fill patterns. They are great for simulating sky and clouds or other 

natural textures. 

Each time you create a new fractal fill a new pattern is created. To replace an existing 

fractal with a new pattern choose fractal from the fill menu again. 

 

The GRAIN control on the INFOBAR 

provides control over the graininess of 

the pattern. Low values give a smooth 

flowing pattern, and high values give a 
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grainy pattern. 

You can adjust the size and position of the fractal fill in the usual way by dragging and 

adjusting the fill handles. De-select the fill handles (click on the fill away from a handle) to 

show the above resolution and grain controls. 

 

Fractal clouds fill. On the left a grain of 1, on the right a grain of 50.  

 

Fractal plasma fill. On the left a grain of 5, on the right a grain of 50. 

Note the difference between grain and resolution. Grain controls the flow of the pattern. 

Resolution sets the size of the fractal bitmap and how noticeable the individual pixels are. 

You can change the start and end colors of a fractal fill. Select the center or outer 

handles and then apply a color using either the Color Line or COLOR GALLERY.  To cancel 

any applied color, apply no color. 

Multi-stage color graduations 

Many of the graduated color fill types support multi-stage graduation fills, which means 

instead of just fading from one color to another, you can go through a number of different 

color fill stages. 

 

To add a new color stage to a graduation, select the Fill Tool so the fill arrow shows and 

then: 

 Either drag a color onto the fill arrow where required. 

 Or double click on the fill arrow to create a new fill handle, and now click a color or 

display the COLOR EDITOR. 
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You can re-position the fill handles by dragging. 

With one fill handle selected pressing "Tab" will select the next. If the COLOR EDITOR is 

open, this is updated to reflect the new fill handle 

To remove a fill stage handle, just click on it to select, and press "Del". 

The Fill Gallery 

The FILL GALLERY contains bitmap textures suitable for use as bitmap fills. Only when 

you use a fill is it copied into the document. 

To display the FILL GALLERY: 

 

To display the FILL GALLERY click its tab in the galleries bar to the right of the 

Photo & Graphic Designer window. Or you can toggle display of the FILL 

GALLERY by choosing UTILITIES > GALLERIES > FILL GALLERY or pressing "Shift + 

F11". 
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IMPORT - imports the selected bitmap into the document. A copy of the bitmap then 

appears in the BITMAP GALLERY. You can also drag-and-drop the bitmap onto a blank 

part of the page. This is usually easier than clicking IMPORT. 

FILL - imports and applies the selected bitmap as: 

 A bitmap fill to the selected object (if any). 

 Or, if no objects are selected, it inserts the bitmap into the document as a new photo 

object. 

You can also drag-and-drop the bitmap onto an object to apply a bitmap fill.  
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There are some differences between either dragging a bitmap from the BITMAP or FILL 

GALLERY: When dragging bitmaps from the FILL GALLERY and dropping on shapes to 

create a bitmap fill, the fill will be tiled and the bitmap won’t be best-fitted into the shape. 

This different behavior to that seen when dragging from the BITMAP GALLERY is because 

normally textures are applied from the Fill Gallery and these should normally be tiled and 

not best-fitted. 

TRANSP - (transparency) imports and applies the selected bitmap as: 

 A transparent bitmap to the selected object (if any). 

 Or sets the current transparency attribute. 

GET FILLS - download free fills from Xara. 

BACKGROUND - set the selected fill as the page background. 

REMOVE - delete the selected fill or folder. 

DISC FILLS - add new fills from your hard drive or a CD. 

MORE - lets you select the size of the preview icons and whether full information about 

the bitmap is shown, as well as find and sort the fills. 

STOP DOWNLOADING - if you have a slow connection and find getting fills from the Internet 

too slow, you can stop downloading them and then resume later. 

Find & Sort are described in the Document handling (on page 74) chapter. 

Document handling (on page 74) includes general information about galleries. 
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Transparency 

Introduction 

 

The TRANSPARENCY Tool lets you specify how much of the underlying colors 

and objects appears through an object.  

 

 
Shape 

 
Transparency type 

 
Tiling 

 
Bitmap name 

 
Profile 

 
Handle/Resolution 

 
Amount of transparency 

You have control over the level of transparency from fully opaque to fully transparent. 

Photo & Graphic Designer goes further than other drawing packages by offering a wide 

range of different graduated transparencies. 

You can apply flat and graduated transparency to all types of objects including bitmaps. 

Some uses of transparency: 

 Simulating water or glass. 

 Anywhere you want objects to fade to parts of objects to fade or blend with the 

background. Clouds or mist-fractal transparencies are particularly good for this. 

 Using the special type of transparency you can lighten, darken and apply special 

effects to objects and photos. 

 Creating highlights and reflections. 
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The windshield is created with multiple overlaid objects with different transparency. The 
reflection is 100% opaque white in the center fading in an elliptical fashion. 

Applying flat transparency 

It's called "flat" transparency because all parts of the objects have the same 

transparency, as opposed to graduated transparency. 

1. Select the object or objects 

2. Select the Transparency Tool ("F6") 

3. Drag the transparency slider on the InfoBar 

Xara Photo & Graphic Designer provides live-preview. As you drag the transparency 

slider the objects on the document are changed so you can see the effect immediately. 

Applying graduated transparency 

Graduated transparency works in a very similar way to graduated color fills. You just drag 

on the objects in the Transparency Tool to create a fading transparency. You have a very 

similar range of transparency shapes, the simplest being linear, but you can also have 

circular, elliptical, conical, fractal and bitmap transparencies, and others. To create a 

graduated fade: 

1. Select the object or objects 

2. In the TRANSPARENCY TOOL, drag across the objects to create a linear fade across 

the object. 

3. Select alternative transparency shapes from the dropdown menu on the InfoBar 

You can select and adjust the position and transparency strength using the "fill" handles 

shown on the object. 

Refer to Fills (on page 296) for more information on manipulating fill handles and the 

different fill shapes (in this case transparency shapes) 

Multi-stage graduated transparency 

Just as you can add multiple stages to a graduated fill, you can do the same with a 

graduated transparency. This allows you to fade, for example, from opaque to 50% 

transparent then back up to 25% transparent, back to opaque, etc.  

You can set the level of transparency at each stage, by selecting a handle and then 

adjusting the transparency slider. Add additional stages by double-clicking on the 

graduated transparency line then adjusting the slider.  

See the Fills chapter (on page 296) for more information on manipulating the handles. 
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Enhance 

Enhance transparency allows you to modify any part of your design using the Enhance 

Photo Tool, just as if it was a photo. For example you can draw a shape over any part of 

your design, apply enhance transparency to it and then adjust the brightness of just the 

area of your design which is covered by the shape. 

Applying Enhance transparency 

To apply enhance transparency: 

1. Draw or select the shape to which you want to apply the enhance transparency 

effect. 

2. Go into the TRANSPARENCY TOOL and select "ENHANCE" from the TRANSPARENCY 

TYPE list on the InfoBar. 

3. The shape seems to have disappeared from your page! That’s because it will only 

apply enhancements to objects underneath it, and you’ve yet to specify the 

enhancements it will apply. The object should still be selected however. 

4. Switch into the PHOTO ENHANCE TOOL. Turn up the brightness using  the control on 

the InfoBar. Now you can see that the area covered by your shape is brightened 

compared to the area outside the shape. 

5. You can adjust brightness, contrast, saturation, temperature and hue. 

6. Move your shape around, or transform it and it always applies the photo 

enhancement(s) to the area underneath the shape. 

Normally you’ll also want to apply some feathering to the shape using the FEATHER TOOL 

(on page 138), to soften the edges of your shape and blend it into your design.  

Photo editing with Enhance transparency 

When you apply enhance transparency as described above, the shape remains as an 

independent object that is not tied to any photos or other objects in your design (unless 

you go on to manually group it with other objects of course). Because you will most 

commonly want to use this effect when editing photos, there is a better way to use 

Enhance transparency which is more suited to working  with photos. 

To apply Enhance transparency to part of a photo; 

1. Select the photo.  

2. Select one of the Mask Drawing tools from the Mask flyout bar and draw around the 

area of the photo you want to modify.  

3. Then invert the mask in order that the area you drew around now becomes the 

unmasked area. Click on INVERT MASK on the InfoBar or else the invert mask icon 

on the Mask Tools flyout to do this. 

4. Then go to the PHOTO ENHANCE TOOL and start to modify the photo using the 

controls on the InfoBar. 

The inverted mask shape is converted into a shape with Enhance transparency applied. 

The shape is also grouped with the photo, to form a Photo Group (on page 354). This 
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means as you move or otherwise transform the photo, the enhanced shapes 

move/transform with it. The enhance shape is also clipped to the edges of the photo. 

For more information on using Enhance transparency with photos, see the Photo Tool 

chapter. 

Note that you can’t apply the Blur/sharpen effect to enhance transparent objects, except 

if they are applied as part of a Photo Group, as described above. 

Profile 

You can change the rate of change of transition between the start and end of 

transparencies. This applies to all single stage graduated transparency types except 

three point and four point (where the option is not available). 

To change the profile of a transparency: 

1. Select the object. 

2. On the TRANSPARENCY Tool InfoBar click PROFILE. This opens the PROFILE dialog. 

3. You either select a predefined profile from the dropdown list or drag the sliders to 

create a custom profile. The top option in the dropdown list (the straight line) 

creates a linear transition between the start and end of the transparency. 

 
The Transparency profile dialog 

Bitmaps 

BITMAP & FILL GALLERIES are described in Photo Handling (on page 364) and Fills (on 

page 306). 

When you select a transparency type of BITMAP, a default bitmap is initially used. Click 

on BITMAP NAME in the transparency InfoBar, or use the BITMAP or FILL GALLERIES to 
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change the bitmap used (click the TRANSP button in the gallery or drag-and-drop from the 

gallery). 

By default, the lighter colors in a bitmap are the most transparent (you can, of course, 

alter the relative amounts of transparency later). 

Handle/resolution 

If you have a handle selected, this box tells you what handle it is. With no handles 

selected, and when using a bitmap transparency, it controls the DPI. 

Applying transparency to several objects 

If you group objects and apply transparency, the whole group is treated as one object 

and the entire group is made transparent. But if the objects are not grouped and you 

apply transparency, each individual object is given a separate transparency and you get 

an entirely different effect when the objects are overlaid. 

 

Individual transparency (left) or group transparency (right) 

Mixing individual and group transparencies 

You can combine the methods above to create complex transparency combinations. For 

example you could set an object to 50% transparency, then group it and apply a 

transparency to the group as well. You are also able to apply a transparency to a group 

first, and then later apply attributes to individual objects within a group. Just hold down 

"Ctrl", click the individual object and change its attributes. 

Group transparency on blends 

For more on blends see Blends (on page 346). 

When adding a transparency to a Blend object, the transparency will be applied to the 

blend as a whole. It is treated like group transparency. 
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If you want the transparency to be applied to each individual step of the blend, first make 

the objects transparent, and then blend. 

 

Opacity Masks 

As described above, the Transparency Tool allows you to apply either flat or graduated 

transparency to any object or group.  But sometimes you need more advanced control 

over the transparency (or opacity) of an object. Opacity masks are a very powerful way of 

achieving this. 

The Opacity Mask system takes any object, or group of objects, and uses the color 

(usually black to white shading) of these objects to define which parts of any other object 

are transparent or opaque. 

 

Original watch design Watch applied as an opacity mask to a rectangle 

First draw the shapes you want to define the opacity (the opacity mask). It can be 

anything from a simple shape, or blend, to a complex grouped drawing. Any black color 

will become 100% transparent, while white will be 100% opaque and shades in-between 

will create varying degrees of transparency.   

You can apply the opacity mask to other objects in your design in two different ways 

(both give the same results).  Also if you use the SHAPE ERASER tool with a soft nib 

setting, it will create an opacity mask using your erase strokes to achieve the erasing 

effect on the selected objects.  

Applying using the clipboard 

Select the object which is to be the mask and copy it to the clipboard. Then select the 

object, photo, or group to which you want to apply this mask and select EDIT -> PASTE 



 

Transparency 315  
 
 

 

OPACITY MASK. There are two options, the first will position the opacity mask into the 

center of the selected object. The second option 'Paste opacity mask in place' will paste 

it into the selected object based on the original position of the mask. 

Apply directly 

Place the object to which you want to apply the mask behind the object(s) that you want 

to apply as a mask. Then select both the mask object(s) and the object to which the 

mask is to be applied, and select ARRANGE->APPLY OPACITY MASK.  

The backmost object is taken as the target for the mask and all other objects in the 

selection make up the opacity mask. So if you want to apply a mask to multiple objects 

this way, you need to group them first and place them behind the mask objects. 

You now have a special type of group called an 'Opacity mask group'. 

Soft erasing using the Eraser tool 

 

Just select the object(s) you want to erase, go into the ERASER TOOL and make the 

softness setting on the infobar a value greater than 0 (when softness is 0 a ‘hard erase’ 

is performed, which is used for permanently cutting objects and this does not use an 

opacity mask). Choose an appropriate nib size on the infobar and draw over the objects. 

An opacity mask is created automatically and your erase strokes are used as the mask. 

Editing inside an opacity mask group 

You can select objects inside the OPACITY MASK Group directly on canvas. Ctrl+click 

operations will select the objects that are being masked, not the mask objects that form 

the mask itself. To select the mask objects directly, use Ctrl+Alt+click. The first 

Ctrl+Alt+click selects the whole opacity mask group. Ctrl+Alt+click again and it will select 

the group of mask objects, so you can then drag around the whole mask inside. 

Ctrl+Alt+click again and it will select individual mask objects. 

You can also select any of the objects inside an opacity mask group using the Page & 

Layer gallery, which lets you see the structure of the group in its entirety. 

It can be difficult to make changes to the masked objects or to the masking objects as 

they appear on the canvas. So you can edit either of these in a separate sub-document 

view, just as you can edit inside normal groups. Right click on the opacity mask group 

and choose OPEN OPACITY MASK GROUP to edit just the objects that are being masked (or 

just double click on the opacity mask group). Or choose OPEN OPACITY MASK from the 

same right click menu (in the OPACITY MASK sub-menu)  to edit just the objects that are 

forming the mask.   

Advanced options 

If you right click on an opacity mask group, the context menu includes an "OPACITY 

MASK" sub-menu with the following operations. 
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Open opacity mask 

This is described above – it allows the masking objects to be edited in a separate 

document view. 

Invert opacity mask 

This inverts the nature of the transparency in the opacity mask group, so transparent 

parts become opaque and vice versa. This operation actually just changes the Clipped 

and Inverted settings described below, since fully inverting the opacity mask group 

involves changing both those settings.  

 

Intitial opacity mask Inverted 

Detach opacity mask from selection 

This operation extracts the masking objects from the opacity mask group, making them 

become normal objects on the page and makes the opacity mask group into an ordinary 

group.  

Clipped (Ctrl+Alt+C) 

This option makes the opacity mask group be clipped to the outline of the mask object(s). 

 

 Unclipped (default) Clipped to mask object 

Uses only alpha (Ctrl+Alt+A) 

This makes the rendering of the opacity mask ignore color saturation levels and use only 

transparency levels in the mask object(s) to set the transparency on the opacity mask 

group. 
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Inverted (Ctrl+Alt+V) 

This inverts the nature of the transparency produced by the mask objects, as 

demonstrated by this simple example. 

 

Default Inverted 

See the Photo Handling chapter (on page 396) for an example of opacity masks in action 

and for other tips. 

Transparency types 

Photo & Graphic Designer supports the main types of W3C transparency used by many 

other applications and include the following types: 

Normal (Mix) 

The color of the object mixes with the color of underlying objects. The effect is similar to 

spraying a thin coat of color (or paint) over underlying objects.  

Multiply (Stained glass) 

The effect is similar to viewing underlying objects through colored glass. It is useful for 

the simulation of glass and selectively darkening objects. The colors of objects with 

Multiply applied are: 

 White - no effect on the colors of underlying objects. 

 Gray & Black - darkens the colors of underlying objects. 

 Other colors - darken underlying colors towards saturated color (light red over light red 

results in mid-red: green over red results in black).   

Technically the process is subtractive in RGB color space. 

Screen (Bleach) 

Screen has no clear analogy in the physical world. It is useful for highlights when the light 

source is not white. The color of the object with Screen applied: 

 Gray & White - lightens the colors in underlying objects. 

 Black - no effect on the colors of underlying objects. 

 Other colors - lighten underlying colors towards unsaturated color. (Light-red over 

light-red gives a pale-red: green over red gives yellow.)  

Technically the process is additive in RGB color space. 
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Overlay 

Overlay is a combination of Screen and Multiply and generally used to boost the contrast 

in an image. The areas of the top object where the underlying objects are light becomes 

lighter and the areas of the top object where the underlying objects are dark becomes 

darker.  

 Gray (darker than 50% gray) will darken and add contrast to the underlying image. 

 Gray (lighter than 50% gray) will lighten and add contrast to the underlying image. 

 Other colors - lightens and adds contrast to unsaturated colors and darkens and adds 

contrast to saturated colors. 

Hard Light 

The same as Overlay, but with the base and overlying objects swapped.  

 White - no effect on the colors in underlying objects, the whites remain completely 

white. 

 Black - no effect on the colors in underlying objects, the blacks remain completely 

black. 

Soft Light 

This is a less extreme version of Hard Light. Again works similarly to Overlay although in 

a softer and less harsh way than Hard Light. 

Luminosity 

Luminosity affects the "lightness" of the image. It blends the lightness values of the top 

objects with the lightness values of the underlying objects, whilst ignoring the color 

values. 

Color 

Color is a combination of hue and saturation. Almost the opposite of Luminosity, the 

colors of the top objects are blended with the colors of the underlying objects whilst 

ignoring the luminance values.  

Color burn 

Similar to Multiply. Burns or darkens the overlying objects, The image will be generally 

darker.  

Color dodge 

Simlar to Screen (Bleach). Dodges or lightens the underlying objects, The image will be 

generally lighter.  

For all these, the slider controls the amount of transparency from opaque (0% 

transparent) to fully (100%) transparent.  

Applying a flat transparency to an object also applies transparency to the line around the 

object. It is not possible to set different transparencies, but you can remove the line by 

setting it to no color or by selecting "None" as the outline width. To create an object with 

a transparent fill and a non-transparent line, use a non-flat transparency type. 

For more information on colors see Color Handling (on page 205). 

Enhance 

See Enhance below for more information on Enhance transparency. 
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Note that for legacy reasons, Photo & Graphic Designer documents which contain older 

transparency types will still refer to those types by their original names, even though 

those types are no longer supported in Photo & Graphic Designer.  Look for (old) in the 

transparency type list to identify them. 

Blends, Blend modes, Blending  
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Shadows 

The Shadow Tool 

 

The SHADOW Tool (shortcut "Ctrl +  F2") lets you apply, remove, and modify 

semi-transparent (or "soft") shadows.  

The transparency of soft shadows increases towards the edges, which gives a very 

realistic effect. Shadows are resolution independent so you can scale them without losing 

quality. 

 

 
No Shadow 

 
Shadow Types 

 
Shadow Blur 

 
Shadow Transparency 

 
Profile 

 
Shadow Position 

Xara Photo & Graphic Designer has three shadow types: 

 Wall where the shadow is cast on a wall behind the object 

 Floor where the object appears to be standing upright on a surface. 

 Glow where the shadow is used to add a halo effect around the object 

 

Applying a shadow 

Applying a shadow 

To apply a shadow: 
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1. Select the object. 

2. Choose the SHADOW Tool. 

3. Select the WALL, FLOOR OR GLOW button on the 

SHADOW Tool InfoBar. 

4. You can drag the shadow away from or towards the 

object to create more or less distance between the 

object and the imaginary wall. 

 

 

Alternatively to create a wall shadow you can: 

1. Select the object. 

2. Choose the SHADOW Tool. 

3. Drag from the center of the object in the direction of the shadow. 

Applying a floor shadow 

1. Select the object. 

2. Choose the SHADOW Tool. 

3. Select the FLOOR button on the SHADOW Tool 

InfoBar. 

4. Drag towards or away from the object to change the 

size or radially to change the direction. 

 

 

 

Applying a glow effect 

Adding a glow or halo behind an object can create dramatic graphics. 

To create a glow effect: 

 

1. Select the object. 

2. Choose the SHADOW Tool. 

3. Select the GLOW button on the SHADOW Tool 

InfoBar. 

4. Drag towards or away from the object to change the 

size of the glow. 
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Blur the edges of the shadow 

 

This changes the size of the shadow. A small 

blur gives the effect of a sharp light source, a 

large blur, a diffused or distant light source. It 

is recommended that shadows are always 

blurred slightly as this is more realistic. 

To blur the shadow edge: 

1.  

2. Choose the SHADOW Tool. 

3. SHADOW Tool InfoBar either drag the blur slider or type a value into the text 

box on the right. 

 

Change the transparency of the shadow 

 

A semi-transparent shadow is more 

realistic than a solid shadow. But you can 

change the transparency level of the 

shadow to suit your needs. 

To change the transparency: 

1. Select the object 

2. Choose the SHADOW Tool. 

3. On the SHADOW Tool InfoBar, drag either the transparency slider or type a value 

into the text box on the right. 

 

Changing the shadow profile 

After applying a shadow, you can change how the shadow transparency changes across 

the blur. You can have a linear transition (which is the default profile and usually gives 

the most realistic results) or a profiled transition. 

To change the shadow profile: 

1. Create the shadow. 
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2. In the SHADOW Tool, click PROFILE. This opens the PROFILE dialog box. 

3. You can either select a pre-defined profile from the dropdown list or drag the sliders 

to create a custom profile. The top option in the dropdown list (the straight line) 

creates a linear transition. 

Changing the shadow color or fill effect 

After applying a shadow to an object, you can change the shadow's color or fill effect. 

You can apply any of Xara Photo & Graphic Designer's color effects including multi-stage 

fills. 

How to change the shadow color: 

For more on colors and the Color Line refer to Color handling (on page 205). 

The easiest way is to drag & drop a color from the Color Line onto the shadow (make 

sure you drop the color onto the shadow and not the object). Alternatively - this method is 

slightly more complex, but you have full control over the color: 

1. Select the shadow using the SELECTOR Tool (make sure you select the shadow 

and not the object). 

2. Use the COLOR EDITOR to edit the color. 

Converting shadows to shapes 

You can convert a shadow into a group containing the shadow and the object (or objects) 

casting the shadow. The shadow is converted to a simple shape and, after ungrouping, 

can be edited. Note that after converting a shadow to a shape, you cannot use the 

SHADOW Tool to edit it, as it is no longer a shadow. 

To convert a shadow to shapes: 

1. Select the shadow or the object (or objects) casting the shadow. 

2. Choose ARRANGE -> CONVERT TO EDITABLE SHAPES. 

Or to convert a shadow quickly, right-click on the shadow or the object (or objects) 

casting the shadow. This opens the pop-up menu. Choose CONVERT TO EDITABLE 

SHAPES. 

Removing a shadow 

To remove a soft shadow: 

1. Select the object 

2. Choose the SHADOW Tool. 

3. Select the NO SHADOW button on the SHADOW Tool InfoBar. 
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Applying a shadow to several objects 

The result of applying a shadow depends on whether the objects are grouped: 

 

 If the objects are grouped, 

overlapping shadows merge 

(they do not get darker if they 

overlap). 

 If the objects are ungrouped, 

each object has a separate 

shadow. Overlapping areas of 

shadow are darker. 

 If you have several shadowed objects selected, any changes apply to all the shadows. 

Selecting objects using the Shadow Tool 

Before you can apply or edit a shadow on an object, you must first select that object. The 

regular way of selecting objects is to use the Selector Tool but you can also use the 

SHADOW Tool, simply click on the object while in the SHADOW Tool. 

Copying shadows onto other objects 

Once you've got a shadow looking how you want it on one object, you can copy it onto 

other objects using "PASTE FORMAT/ATTRIBUTES". Simply copy the object that has the 

shadow ("EDIT" > "COPY"), select the object or objects you want to paste the shadow onto 

and choose "EDIT" > "PASTE FORMAT/ATTRIBUTES". 
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Bevels 

The Bevel Tool 

 

The BEVEL Tool (shortcut "Ctrl + F3") gives objects an appearance of depth 

instead of being flat on the page. 

Bevels are resolution-independent so you can scale them without losing quality. 

 

 
Bevel type 

 
Slider type list 

 
Slider and numeric value for selected parameter 

 
Outer bevel 

 
Inner bevel 

 
Join style 

You can apply bevels to most types of object. The exceptions are: 

 Part of a block of text (such as a single letter)-the bevel is instead applied to all the 

text. 

 To the curve in text along a curve. 

 Contoured objects. 

 Live effects (the bevel is applied to the object before the effect is applied if the effect is 

live, or to the bounding box of the effect if the effect is locked). 

Applying a bevel 

To apply a bevel to a single object: 

1. Select the object 

2. Choose the BEVEL Tool. 

3. Choose the bevel shape you want from the BEVEL TYPE list. Note that NONE 

removes any applied bevels. 

Applying a bevel to several objects 

The result of a bevel on several objects depends on if the objects are grouped: 
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 If the objects are grouped, overlapping 

bevels merge together. The bevel color is 

the same as the rear-most object in the 

group. 

 If the objects are ungrouped, each object 

has a separate bevel. The bevel color is 

the same as the object color. 

 

Modifying a bevel 

You can change the angle and elevation of the light and change the shape, direction and 

size of the bevel edge. 

Bevel direction 

Bevels can be inside the object or outside. Outside bevels make objects larger; inside 

bevels do not change the object size. 

To change bevel direction: 

1. Select the object. 

2. Click either the INNER or OUTER button.  

 

Changing the bevel light source 

The bevel effect is created by a light shining across the object and highlighting the shape 

(profile) of the bevel. You can change the direction and height of the light and its strength 

(the contrast). 

Changing the light angle (horizontal direction): 

1. Select the object. 

2. Drag the arrowhead to change the position of the light source. 

You cannot move the center of the arrow, only the arrowhead. 

 

For precise angles, select LIGHT ANGLE from the SLIDER TYPE list. Then drag the slider or 

type into the text box. 

 

If you have several beveled objects selected, light angle changes all bevels. Dragging 

the arrow changes just the bevel (or bevels) to which the arrow refers. 
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Changing the light strength (contrast) 

To change the light strength: 

1. Select the object. 

2. Select CONTRAST from the SLIDER TYPE list. Then drag the slider or type into the text 

box. 

 

If you have several beveled objects selected, any changes apply to all the bevels. The 

colors used in the bevel affect the contrast. For example, strong (saturated) colors 

require more contrast than weak colors to get the same effect. For best results, you will 

probably have to adjust the contrast for each object. 

Changing the light elevation (vertical angle) 

This lets you move the light anywhere from immediately above the object (90º) to the 

side of the object (0º). 

1. Select the object. 

2. Select LIGHT ELEVATION from the SLIDER TYPE list. Then drag the slider or type into 

the text box. 

 

For rounded bevels we recommend a light elevation of 30º. At this angle the bevel blends 

smoothly with the object. 

Changing the bevel size 

How to change the bevel size: 

1. Select the object. 

2. Drag any of the outside arrows to enlarge the bevel. 

 

Alternatively: 

1. Select the object. 

2. From the SLIDER TYPE list choose SIZE. 

3. Either drag the slider or type a value into the text box. 
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Changing the bevel shape 

1. Select the object 

2. Choose the BEVEL Tool. 

3. Choose the bevel shape you want from the BEVEL TYPE list. 

Changing the bevel color or fill effect 

After applying a bevel to an object, you can change the bevel's color or fill effect. You can 

apply any of Xara Photo & Graphic Designer's color effects including multi-stage fills. 

For more on colors and the Color Line, refer to Color handling (on page 205). 

How to change the bevel color: 

 The easiest way is to drag-and-drop a color from the Color Line onto the bevel (make 

sure you drop the color onto the bevel and not the object.) 

Alternatively, this method is slightly more complex but you have full control over the 

color: 

1. SELECTOR Tool (make sure you select the bevel and 

not the object.) 

2. COLOR EDITOR to edit the color. 

Changing the bevel join style 

 

After applying a bevel to an object, you 

can change the shape of the corners 

(joins). 

How to change the bevel join style: 

1. Select the object. 

2. Click the appropriate join button on the BEVEL Tool InfoBar. 

 

 

 
Miter 

 
Round 

 
Bevel 

 

Removing a bevel 

To remove a bevel: 
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1. Select the object(s) from which you want to remove the bevel. 

2. Choose the BEVEL Tool. 

Choose NONE from the BEVEL TYPE list. 



 

 330 Contours 
  

 

 

Contours 

The Contour Tool 

 

The CONTOUR Tool ("Ctrl + F7") lets you create interesting effects around the 

edges of objects. The CONTOUR Tool creates a series of concentric outlines 

either on the inside or the outside of a selected shape. 

 

 
Edit distance between steps 

 
Number of steps 

 
Remove contour 

 
Color effect 

 
Contour width 

 
Outer contour 

 
Inner contour 

 
Position profile 

 
Attribute profile 

 
Inset path 

 
Join types 

 

Contouring objects 

To contour an object: 

1. Select the object. 

2. Choose the CONTOUR Tool. 

3. Then: 

 Drag any of the eight handles that surround the selected 

objects. As you drag, you see the outline of the contour.    

 Or drag the contour width slider. 

 Or type a new value into the text box. 

 

Contours can be either inside or outside of objects (outside contours make the objects 

larger). 
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To swap the contour direction: 

1. Select the contoured object. 

2. Choose the CONTOUR Tool. 

3. Then: 

 Drag any of the eight handles that surround the selected 

objects (drag the handles inside or outside the objects to 

swap). 

 Or click the INNER or OUTER contour buttons. 

 

Note that objects cannot have both a contour and a bevel. 

Changing the number of steps in a contour 

Contours are initially created with five intermediate steps. You can increase the number 

of steps to make each step less obvious. Alternatively, you can reduce the number of 

steps so you can clearly see each step. You can either enter the number of intermediate 

steps or enter the distance between steps. 

To change the number of steps in a contour: 

1. Select the contoured object. 

2. Choose the CONTOUR Tool. 

3. Select either distance or number of steps by pressing one of the two buttons on the 

left side of the InfoBar. 

4. Type the required value into the steps (or distance, depending on the above 

selection) field on the CONTOUR Tool InfoBar and press "". 

If required, Xara Photo & Graphic Designer rounds the distance to give a whole number 

of steps. 

Changing the contour color 

After applying a contour to an object, you can change the contour's color. 

For more on colors and the Color Line refer to Color handling (on page 205). 

How to change the contour color: 

The easiest way is to drag-and-drop a color from the Color Line onto the contour (make 

sure you drop the color onto the contour and not the object). 

Alternatively this method is slightly more complex but you have full control over the color: 

1. Select the contour using the SELECTOR Tool (make sure you select the contour and 

not the object). 

2. Use the COLOR EDITOR to edit the color. 
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Note that you can also select the contour using the CONTOUR Tool. Click on the contour 

to select it. 

Changing the contour join style 

 

After applying a contour to an object, 

you can change the shape of the 

corners (joins). 

How to change the contour join style: 

1.  

2.  CONTOUR Tool InfoBar. 

 

 
Miter 

 
Round 

 
Bevel 

 

Changing the contour attribute profile 

After creating a contour you can change how the attributes (such as color or line 

thickness) change. You might want a regular rate of change or a more pronounced 

change towards one end or the center. 

To change the attribute profile: 

1. Create the contour. 

2. In the CONTOUR Tool click ATTRIBUTE PROFILE. This opens the PROFILE dialog box. 

3. You can either select a pre-defined profile from the dropdown list or drag the sliders 

to create a custom profile. The top option in the dropdown list (the straight line) is 

the default and creates a regular rate of change. 

Changing the contour position profile 

After creating a contour you can change how the intermediate steps are spaced. You can 

have regular spacing or closer at one end than the other or closer in the center. 

To change the position profile: 

1. Create the contour. 

2. In the CONTOUR Tool click POSITION PROFILE. This opens the PROFILE dialog box. 

3. You either select a pre-defined profile from the dropdown list or drag the sliders to 

create a custom profile. The top option in the dropdown list (the straight line) is the 

default and creates regular spacing. 
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Applying a contour to several objects 

 

If the objects are grouped, 

overlapping contours merge 

together. The contour color is 

the same as the rear-most object 

in the group. 

If the objects are ungrouped, each object has a separate contour. The contour color is 

the same as the object color. 

The contour steps are not separate objects. To make them selectable, you need to 

convert the contour to editable shapes (see below). 

Using contours to resize objects 

You can use contours to change the size of objects by making the outline thicker or 

thinner. This has advantages over resizing for shapes like the letter "C": 

 

On the left is the original object. The center letter 

is resized using a contour, the right letter is 

resized by scaling the object up. 

To resize using contours: 

1. Select the object. 

2. Choose the CONTOUR Tool. 

3. Give the object a contour of the required size. 

4. Click INSET PATH on the CONTOUR Tool InfoBar. The contour steps disappear and 

the object is now the size of the contoured object. 

Converting contours to shapes 

You can convert a contour into a group containing all the contour steps. Each step is 

converted to a shape and, after ungrouping, can be edited. Note that after converting a 

contour to shapes, you cannot use the CONTOUR Tool to edit it as the object is no longer 

a contour. 

To convert a contour to shapes: 

1. Select the contour. 

2. Choose ARRANGE -> CONVERT TO EDITABLE SHAPES. 

To convert a contour quickly, right-click on the contour to open the pop-up menu and 

choose CONVERT TO EDITABLE SHAPES. 
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Removing a contour 

If a contour does not give the desired effect, you can easily remove it: 

1. Select the contoured object. 

2. Choose the CONTOUR Tool. 

Click on the Remove button on the CONTOUR Tool InfoBar. 
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The Mold Tool 

The Mold tool 

 

The MOLD Tool is used to distort shapes. It is used for both perspectivizing (that 

is, rotating in three dimensions) and enveloping (like distorting a rubber sheet). 

 

Mold tool InfoBar 

 
Mesh 

 
Remove mold 

 
Detach mold 

 
Rotate mold 

 
Copy mold 

 
Enveloping 

 
Paste envelope mold 

 
Perspectivizing 

 
Paste perspective mold 

The InfoBar contains two sets of preset mold shapes. Just click a button to apply the 

preset mold. The left-hand button in each group is the default "no distortion" mold which 

you can then manually edit after applying it.  

Perspective 

 

The MOLDTOOL lets you perspectivize shapes to 

give an impression of depth. 

You can perspectivize all types of objects 

including text and bitmaps. Note that bitmaps 

lose perspective if you later blend them or 

convert them to editable shapes. 

1. Select the object or objects. 

2. Select the MOLDTOOL (shortcut "Shift + F6"). 

3. Choose one of the perspective options: 
 

The right-hand button (paste perspective) is described later. 
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Photo & Graphic Designer draws a rectangle around the object or selection. You can 

drag the control handles at each corner of the rectangle to produce the perspective 

effect. 

You can rotate, resize and skew the perspectivized object using the SELECTORTOOL. 

You may want to move control handles without redrawing the perspectivized object 

(doing this speeds up screen redraws). 

 

To do this select the DETACH MOLD button. To refit the object, deselect the 

button. 

Using vanishing points 

As you reduce the size of the sides of the perspective mold, you see a "vanishing point" 

target. This is similar to vanishing points in conventional perspective drawings. 

 

You can use vanishing points to obtain consistent 

perspective for several objects. 

 

All three objects share a common vanishing point at the small cross. 

The perspective mesh 

 

This button paints a faint series of dots in a grid to preview the degree of 

perspective distortion of an object. 

Using molds 

You may want to apply the same perspective to several objects. To do this you create a 

mold shape, copy it to the clipboard and then use it to perspectivize the other objects. A 

perspective mold shape must have four straight sides: 

 

 

This is acceptable as a mold 
shape 

These are not acceptable. The object on the left has too 
many sides (must be four). The object on the right has 
curved sides (must be straight). 
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Removing perspective 

 

Click REMOVE to remove perspective. 

If the selected object has more than one perspective or envelope mold applied, only the 

most recent mold is removed. 

Rotating the object within the mold 

 

Sometimes you will find that the mold is the correct shape but the object needs 

rotating within it. You can rotate the object by clicking the rotate object button. 

 

Enveloping 

 

The MOLD TOOL lets you envelope shapes in a wide variety of ways.  

The effect is similar to a rubber sheet or balloon that you can stretch in any direction.  

You can envelope all types of objects except bitmaps. 

 Sample enveloped text 

Enveloping is similar to applying perspective. That is: 

1. Select the object or objects. 

2. Select the MOLDTOOL (shortcut "Shift + F6"). 

3. Choose one of the envelope options: 
 

The right-hand button is similar to paste perspective described earlier. 

The left-hand button does not initially alter the object. The other buttons immediately alter 

the object. 
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After applying the mold, to edit it: 

1. Drag any of the corner handles. 

2. Or click on a corner handle and then drag the curve handles. 

The above example shows the 4 curve handles of the corners have been dragged 

outwards to bend the content of the mold. 

You can also rotate, resize and skew the enveloped object using the SELECTOR TOOL. 

The mold mesh button 

 

The Mesh button displays a series of faint dots which can help preview the 

distortions that the envelope mold is giving. 

Envelope molds 

You can create an envelope mold from any four sided shape, which you can distort as 

you require, and then use as an envelope mold by clicking the PASTE ENVELOPE button 

on the MOLD TOOL InfoBar. 

Editing mold shapes 

You can edit the contents of a mold (essentially a group) using editing inside groups (on 

page 147). Editing is not possible using direct selection inside (molds do not allow 

objects inside them to become selected). To edit a mold inside, right click on the mold 

and choose OPEN MOLD from the context menu. 

You can edit the shape of envelope or perspective molds with the SHAPE TOOL (or the 

edit handles with SELECTOR TOOL, if shown). According to the nature of molds, there are 

some restrictions: 

 You cannot add point handles to a perspective or envelope mold, because it has to 

stay a  four-sided shape 

 You cannot change a straight line of a perspective mold into a curve. 
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Photo Regions and Masks 

In Xara Photo & Graphic Designer the Mask tools are not presented on the main toolbar 

at startup. If you want to use these tools you can find them in the Button Palette. 

 

To open the Button Palette choose CONTROL BARS... from the WINDOW menu and scroll 

through the list to the bottom. Then click the checkbox next to the Button Palette item. 

(Or right-click on an empty area of any button bar and choose Button Palette from the 

pop-up menu.) 

 

If you want to use these tools regularly you can move them out of the Button Palette by 

dragging them onto the toolbar. (Hold down Alt, then drag the button and drop it onto the 

toolbar, over one of the existing icons). 

 

 

Masks vs Photo Regions 

A mask is used to protect part of a photo from a photo operation. For example when 

using the CONTENT-AWARE SCALE/ZOOM (on page 421) tool to stretch or zoom a photo, 

you often want to ‘protect’ part of the photo to stop it being distorted by the operation. 

You use a mask to mark that area of protection.  

Conversely the Photo Region tools are used to select areas of a photo upon which you 

wish to perform a photo operation. This might involve a Photo enhance operation to 

brighten or tweak the color of a particular area of a photo, or you might want to just 

perform a simple crop, or cut and paste part of a photo. 

Regions and masks are actually interchangeable and the difference between them is 

only really one of presentation. A region identifies the part of a photo you want to operate 

on, while a mask works the other way around and identifies part of an image you don’t 

want to operate on (the masked area is protected from the operation). And in fact if you 

have drawn a region using a region tool and you switch to the mask painter tool, the 

region becomes a mask. And similarly if you start with a mask and switch to a region tool, 

the mask becomes a region. 

Masks have the advantage of being able to show levels of ‘softness’ whereas regions are 

indicated only by a hard outline. So if, for example, you use the Feather Tool (on page 

138) on a region, you won’t see any change to the region as you apply the feathering. 

But when you use that feathered region to enhance your photo, you’ll see that the 

enhanced area is indeed feathered. If you use a mask instead, the pink fill of the mask 

shape will show the feathering.  

Creating Regions and Masks 

To create a photo region use the REGION PAINTER TOOL, MAGNETIC LASSO (on page 376) 

or RECTANGLE REGION TOOL from the PHOTO REGIONS AND MASK TOOLS flyout bar to draw 
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round the area on which you wish to perform an operation. The selected area will be 

outlined with a dashed 'marching ants' effect.  

To create a mask choose the MASK PAINTER TOOL from the PHOTO REGIONS AND MASK 

TOOLS flyout bar and use it to draw a pink mask over your photo on the parts of it you 

want to protect.  

The masked areas are shown with a pink fill and have a dashed 'marching ants' effect 

around the outside. Any part of the objects covered by the pink area will be protected 

when performing a mask compatible operation. 

Soft Masks 

A soft mask is a mask that includes varying levels of masking, instead of consisting 

simply of just masked parts and unmasked parts. For example part of an image may 

have a 50% mask applied, so that a subsequently applied operation has only a 50% 

effect on that part of the image. Or a mask shape could have a graduated mask that 

smoothly graduates from 0% masking to 100% masking. If such a mask is then used with 

the PHOTO ENHANCE TOOL to brighten the photo, the effect of the brightening would be 

similarly graduated. 

Not all operations support soft masks. For example Content Aware Scale, Clone/Magic 

Erase and Clipview creation will ignore any softness in the mask. 

The Photo Region and Mask tools 

 

The Photo region and Mask drawing tools can be found on the Photo region and 

Mask tool flyout on the main toolbar. 

 

The region and mask tool flyout bar 

 

The REGION PAINTER tool allows you to 'paint' over an area or object that you want 

to select. Choose an appropriate nib size from the InfoBar and create a shape by 

stroking over the object. 

 

The MAGNETIC LASSO allows you to easily trace round objects in a photo to cut 

them out. This mode is enabled by default on the MAGNETIC LASSO mode toggle 

on the InfoBar. Disabling the mode lets you draw closed shapes around the areas 

or objects you want to select in much the same way as you would a pencil. It has 

a smoothing control and you can also hold down the 'Shift' key to erase your line 

as you draw. The MAGNETIC LASSO (ON PAGE 376)  is described in detail in Photo 

Handling (on page 354).  

 

The RECTANGLE REGION TOOL tool lets you drag a rectangular selection around an 

area or object. You can modify your shape using the width and height settings on 

the InfoBar. 



 

Photo Regions and Masks 341  
 
 

 

 

The MASK PAINTER TOOL allows you to 'paint' a pink mask over an area or object 

that you want to protect. Choose an appropriate nib size from the InfoBar and 

create a mask shape by stroking over the object. 

 

Use the SHOW MASK OR REGION button to toggle the mask or region on or off. 

Turning off a mask/region in this way does not delete it, so you can get it back at 

any time by turning it on again, but while turned off it won’t affect any 

mask/region-aware operations.    

 

The INVERT MASK OR REGION button inverts the masked area or selected region so 

that everything but the selected or masked areas are selected or masked instead. 

 

Use the CLEAR MASK OR REGION button to remove all the shapes on the mask 

layer. 

The INVERT and CLEAR functions also appear on the InfoBar. 

On the InfoBar there is also a toggle for turning mask/region outlines on and off. This is 

only normally useful when using these tools to edit regions inside Photo Groups. All it 

does is turn off the outline, so this toggle is Not the same as the SHOW MASK OR REGION 

button described above, which turns on/off the whole mask/region. See Photo Groups 

(on page 354) for details.  

 

Both the Region and Mask painter tools allow you to change the nib size quickly by 

holding down Alt and using the mouse-wheel. However the easiest way to work is usually 

to just zoom in where you need to paint a smaller area. 

For more on nib selection see the Shape Painter tool (on page 94). And for more 

information on the smoothing control feature see the Freehand and Brush tool. 

Operations That Use A Mask 

Photo Background Erase 

Before using this function on the Eraser Tool InfoBar, you use the mask painter to 

indicate the parts of the photo you don’t want to erase. See the Eraser tool (on page 439) 

for details on erasing backgrounds. 

Content Aware photo scaling 

To protect part of a photo from being scaled; 

1. Select one of the mask tools from the Regions and Masks tools flyout bar and draw 

whatever mask shape you require around the area you wish to protect. 

2. Now go into the Content Aware photo scaling tool  (Photo tool fly-out bar on 

the main toolbar) and click on the photo. 
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See the Content Aware Scaling (on page 421) feature for more information. 

Photo clone tool 

 

The clone tool will take a mask shape and convert it into a clone shape, which copies 

one part of a photo to another part. See the Clone Tool section (on page 410) of the 

Photo Tool chapter for details. 

Operations That Use Photo Regions 

Photo enhance tool 

 

Use one of the Enhance tools to apply brightness, contrast, saturation, temperature and 

blur/sharpen changes to any part of a photo.  

1. Select one of the Region tools from the Regions and Masks tool flyout bar and draw 

whatever  shape you require around the area you wish to enhance. 

2. Now go into the Enhance Photos tool (Photo tool fly-out bar on the main toolbar) 

and click on the photo. 

3. Use the Enhance controls from the Photo tool InfoBar. 

Advanced users may wish to use Soft masks to introduce graduated effects to the photo 

enhance operation. See the Photo Tool and Photo Handling chapters for more 

information. 

Cut, Copy, Delete 

These operations are useful when used with the PHOTO REGION TOOLS, to cut pieces 

from photos, but you can use them on any objects.  

1. Select one of the region tools from the PHOTO REGION AND MASK TOOLS flyout bar 

and draw whatever mask shape you require. 

2. Now select an option from the EDIT menu to perform a Cut/Copy/Delete operation.  

3. The SELECTOR TOOL is automatically selected and the operation performed. 
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The Rectangle Region  tool is used to create a selection (left). Cut or Delete then removes the 
selected area of the Photo (right). 

 

On the left example the selection has been inverted. Now when you Cut or Delete only the 
cat's eyes remain, everything else is deleted. 

You can use the PHOTO REGION AND MASK tools on top of any drawing or photo. 

If you use these operations with soft masks, an Opacity Mask is created using the soft 

mask. See the Opacity Masks (on page 314) section of the Transparency chapter for 

details on Opacity Masks. 

Duplicate, Clone 

This will copy only the selected part of the drawing or photo. The Clone option places a 

copy exactly on top of the original. 

ClipView 

You can clip your drawing or photo to be inside a selected shape.  
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1. Select one of the region tools from the PHOTO REGIONS AND MASKS TOOL flyout bar 

and draw whatever shape you require. 

2. Now select "ARRANGE" > "CLIPVIEW" (or press the key short cut "Q") and the 

drawing will be clipped to the visible areas of the selection. 

ClipViews are live and non-destructive in that the whole drawing is retained inside the 

Clipview object.  See Object Handling  (on page 154) for more details. 

Combine Shapes 

There are a set of operations under the "ARRANGE" > "COMBINE SHAPES" menu that allow 

you to combine shapes in a number of different ways. You can also use these with the 

region tools. 

For example to slice a piece of a photo out (cookie cutter style),  

1. Select one of the regions tools from the PHOTO REGIONS AND MASKS tools flyout bar 

and draw whatever shape you require. 

2. Select "ARRANGE" > "COMBINE SHAPES" > "SLICE". 

Advanced 

You can also edit region and mask shapes using the PAGE & LAYER GALLERY to access 

the mask layer. This is useful for the fine detail editing of mask shapes, or if you want to 

move the position of a mask, or else to create a soft mask. 

1. Click on the selector tool and open the PAGE & LAYER GALLERY. 

2. Click on the mask layer to unlock it. 

3. Select the mask or region shape you wish to alter and reposition/ resize the shape 

as required. 

4. Double click the shape to edit the shape using the SHAPE TOOL (on page 94). Or if 

you created the shape using the RECTANGLE REGION TOOL then a double click will 

enable editing with the RECTANGLE TOOL.  

It's easy to switch between the Regions and Mask tools - if you created a selection using 

one of the Regions tools and you want to turn it into a mask instead just click on the 

MASK PAINTER tool and the selection will now be a pink masked area instead. And the 

reverse is also true, create a mask shape using the MASK PAINTER tool, then click on one 

of the Regions tools and the mask will now be a region.     

Copying Shapes To The Mask Layer 

You may prefer to draw mask shapes using the ordinary drawing tools instead of the 

mask tools, or to use an existing shape on your mask layer. This is particularly useful 

when working with soft masks, where you are applying levels of transparency to the 

mask objects. In the SELECTOR TOOL, select the shape, and copy, or cut it. Now switch 

into one of the mask tools and PASTE. Use PASTE IN PLACE if you want the shape to 

appear in exactly the same place it was copied/cut from. 
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To copy shapes from the mask layer to any other, do the reverse. Select the shapes 

while in a region or mask tool, then switch to the SELECTOR TOOL, and paste. 
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Blends 

Blends 

This operation blends one object into another by a series of intermediate objects. This is 

sometimes known as interpolation, in--betweening, tweening, or morphing. 

 A five-stage blend of a star into an 
arbitrary shape. 

Blends have several different uses. This section describes firstly some of the uses and 

then using the BLEND Tool. 

A blend is treated like a group and you can move and copy the blend as you would a 

group. 

Groups are described in Object handling (on page 145). 

Uses of blends 

 To create a repeating design, such as a series of rules: 

 

For this you’d typically create an object, duplicate it to create the 

end object and then blend between them. 

Or a pattern: 
 

 To transform one object into another. The star to shape blend above is an example of 

this.  By using more intermediate stages you can create complex shading and 

highlighting effects. 

The blend does not just blend the shapes but also other attributes such as line thickness, 

line and fill colors and transparency. So when blending from an object of one color to an 

object of another color, the intermediate steps will take on intermediate colors. 
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Using the Blend Tool 

To create a blend: 

1. Select the BLEND Tool ("F7") 

2. Move the pointer over a visible part of the start object. 

3. Drag the pointer over the end object. As you drag the pointer a "blend line" 

appears. 

4. When over a visible part of the end object, release the mouse button. 

For object-to-object blends the blend line is colored black. When blending 

between control handles, it is colored red. 

 

 

The Blend Tool InfoBar 

 
Edit distance between steps 

 
Edit number of steps 

 
Steps in blend 

 
Remove blend 

 
Blend color effect 

 
Position profile 

 
Attribute profile 

 
1:1 node mapping 

 
Anti-alias blend steps 

 
Blend along a curve 

 
Rotate blend steps along the curve 

STEPS is the number of intermediate stages in the blend. At lower settings the individual 

steps are apparent. This is useful for object transforms. At higher settings the steps 

merge together. This is more suitable for highlight effects. Experience shows that you 

rarely need more than 50 steps even in a complex blend. 

The two objects can have different numbers of control handles and can be different types 

(for example, shapes to lines). 

When Xara Photo & Graphic Designer blends, it has to have a "start" handle on one 

object that maps onto an equivalent "start" handle on the other object. 
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 If you create a blend by dragging from the filled interior 

of one shape to the other, then Xara Photo & Graphic 

Designer will automatically choose the bottom-left 

control handles to match. However, you can force a 

blend to use any control handle as the starting handle 

by dragging exactly from one control handle to another. 

Blending between different control handles gives 

different blend patterns. 

 

 

A second way to adjust the blend is to 

add control handles to one object. The 

left-hand example is a blend between 

two triangles. The right-hand example 

has an extra control handle in the 

lower triangle. The blend was then 

made to that control handle. 

A third way is using the 1 TO 1 NODE MAPPING button. 

 

This only has an effect if the two objects have the same number of control 

handles. Usually Photo & Graphic Designer adds or removes handles as 

necessary to transform one shape into another. 

When blending with shapes that have the same number of handles (such as copies or 

duplicates) this can sometimes produce strange results. In this situation, the 1:1 button 

prevents extra handles being added. You can still control the start handles by dragging 

exactly between control handles as previously described. 

 

The left-hand example is a normal blend 

between the rectangles. The right-hand 

example uses 1:1 

 

Selecting the start or end object 

After creating the blend you may want to change some attribute of either the start or end 

object such as its color or line width or position. 

To change an object’s attributes: 

1. Select the SELECTOR Tool. 

2. "Ctrl + click" on the start or end object to "select inside" 

3. Make the required changes. 
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The Selector Tool is described in Selecting objects (on page 115). 

To change the color, drag-and-drop the color from the Color Line onto the object. You 

can’t select intermediate steps of a blend, unless you CONVERT TO EDITABLE SHAPES – 

see later. 

Multi-stage blends 

You are not limited to blending between only two objects. Photo & Graphic Designer can 

blend between several objects. 

 

The original three objects, left, and the resultant blends right  
 (It also shows blending between different types of object.) 

The produce a multi-stage blend just blend from the fist to the second, and then again 

from the second to the third, etc. 

Producing highlight effects 

By increasing the number of blend steps you can create some complex highlight shading 

effects. One of the most powerful features of Photo & Graphic Designer is that it allows 

blends from just about any shape to any other shape, with dissimilar numbers of handles. 

However, blends between objects with sharp corners can produce unwanted twists in the 

blend. 

 

The two shapes have different numbers of handles, and a blend from one to the other 

produces the result on the right. It has a twist in the top right corner. 

You can control exactly which point handles map, when creating the blend, by dragging 

from the point handle of one shape to a corresponding handle on the other shape. You 

will need to have both shapes selected in order to see the control points. 
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The left example has the top right handles mapped so now there is no twist in the right 

side. In order to get the exact desired effect it’s sometimes necessary to experiment by 

mapping between alternative points or adding or removing point handles to one of the 

shapes. The Apple drawing on the front of this chapter is an example of complex 

highlights created entirely from blends. 

The number of steps 

 

To change the number of steps in your blend, just enter a 

value in the STEPS box. 

It is also possible to change the distance between steps, but this option is only available 

when creating a blend along a curve (see below). 

The Anti-Alias button on the InfoBar 

When producing highlight effects, anti-aliasing the intermediate steps has no visible 

benefit. However, it slows down screen redraws by up to 30% on slow computers.  

 

Therefore, deselecting the ANTI-ALIAS button means that Photo & Graphic 

Designer never anti-aliases the intermediate steps of this blend. 

 

Profiles 

 

POSITION PROFILE lets you select how to space the intermediate steps in a blend. 

You can have regular spacing or closer at one end than the other or closer in the 

center. 

 

ATTRIBUTE PROFILE lets you select how attributes (such as transparency, colors or 

line thickness) change in a blend. You can have a regular rate of change, greater 

change at one end, or greater change in the center. 

Changing profiles 

To change a profile: 

1. On the BLEND Tool INFOBAR click either POSITION PROFILE or ATTRIBUTE PROFILE. 

This opens the required profile dialog box. 

2. You either select a predefined profile from the dropdown list or drag the sliders to 

create a custom profile. The top option in the dropdown list (the straight line) 

creates regular spacing. 
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Blending along a curve 

To make your blend follow a curved line or 

shape: 

 

 

1. Select both the blend and a line or shape. 

2. Select the BLEND Tool. 

3. Select the BLEND ALONG A CURVE button. 

 

 

 

 

You will most likely want to hide the line or shape, and just leave the items going along 

an invisible curve. To do this: 

1. Select the blend. 

2. "Ctrl + click" (select inside) to select just the line, or choose the SHAPE 

TOOL. This selects just the line or shape. 

3. " + click" (or right click) on the NO COLOR button on the Color Line, 

(described later in Color handling (on page 205)), or, select a line width of 

none. 

 

 

Rotating along a curve 

If you have blended along a curve, you can make 

the objects rotate to match the curve. 

 

 

To do this, select the ROTATE ALONG CURVE button on the BLEND Tool INFOBAR. 

 

Blends and PDF or PostScript files 

When printing or exporting to a PDF file, using a large number of blend steps can result 

in large files (megabytes in some cases) which can be very slow to print or view. If 

necessary reduce the number of blend steps. 

Editing the shapes in a blend 

The intermediate steps of a blend are calculated on-the-fly and are not selectable or 

editable. Use the menu, ARRANGE -> CONVERT TO EDITABLE SHAPES to convert the 

individual blend steps to separate objects. (The result is grouped so you would need to 

ungroup before editing the individual steps.) Doing this is less efficient because to 

change the blend you will have to re-blend from the start object to the end object. 
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Color Blend Effect 

The COLOR BLEND EFFECT menu on the BLEND Tool InfoBar gives you a control over 

intermediate colors: 

 FADE: Fades between the two colors. 

 RAINBOW: Blends along the shortest edge of the HSV color wheel. For example, a 

blend from yellow to cyan runs yellow-green-cyan. (This option has no effect when the 

two colors are black, white or gray.) 

 ALT RAINBOW: Similar to rainbow except the blend is along the longest edge of the 

color wheel. For example, yellow to cyan runs yellow-red-magenta-blue-cyan. 

The HSV color wheel is described in Color handling (on page 205). This menu is identical 

to the fill effect menu in the Fill Tool. 

Viewing blends as outlines 

WINDOW -> QUALITY controls how blends are displayed: 

 At OUTLINE only the start and end objects appear. The intermediate objects are not 

drawn. 

 At OUTLINE WITH BLEND STEPS start, end and intermediate objects are drawn as 

outline. 

 At FULL COLOR the outlines and fill colors of the intermediate objects are drawn. 

 At HIGH & VERY HIGH QUALITY all the information is shown anti-aliased if the ANTI-ALIAS 

button (described above) is active. If not, the intermediate steps are not anti-aliased. 

 

With the view quality slider in the second position you can see all the intermediate steps of a 
blend as outlines. 

Removing blends 

Removing a standard blend 

Select the blend, then click REMOVE on the BLEND Tool InfoBar. 
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Removing blend from a curve 

Select the blend, then deselect the BLEND ALONG A CURVE button. 
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Photo Handling 

Non-destructive photo editing 

Photos are an integral part of almost all creative work nowadays, from websites, to flyers, 

brochures, DTP work and more. 

Photo handling in Photo & Graphic Designer is very different to other graphics programs 

that you may be used to. 

In Xara Photo & Graphic Designer you can color, crop, copy, blend, enhance, clone, 

feather (fade the edges of) photos as much as you like. The object oriented, non-

destructive nature of the photo handling means that, for example, when you resize a 

photo, you are not really altering the original photo, but just resizing a visual copy. The 

original imported image is saved in the .xar file, so that you can later edit, and resize 

again, or apply any of the Photo Tool editing options, with no loss of quality.  You can 

even un-crop cropped photos. 

This is fundamentally different to the way most photo editing programs work (which are 

destructive - i.e. they alter the actual pixels of the image). 

The photo handling is astonishingly fast. You can open a 50 Megapixel photo, and 

perform any of the enhance operations, and rotate the full resolution image in real-time. 

This chapter covers the basic principles of manipulating photos and bitmap images in 

Xara Photo & Graphic Designer. The operation of the Photo Tool is covered in the 

separate Photo Tool chapter. 

*Benchmarks based on photo compositions created with multiple hi -res JPG digital photos 

Photo Objects 

In Photo & Graphic Designer photos (or bitmaps) are just another type of object on the 

page. You can drag and drop photos onto the page from your Windows file explorer, and 

then you can resize, rotate, copy and move them around just like any other object. 

Importantly you can adjust the transparency, even graduated transparency, feather 

edges and clip and cut shapes out of photos with ease. The transparency feature lets 

you blend, merge or create composite photos. 

Where you might have to use layers in other photo tools, every object in Xara Photo & 

Graphic Designer is on its own layer and, just as with any object on the page, you can 

move it forward to be in front, or backwards to be behind other objects. 

Photo Groups 

If you edit a photo using some tools such as the integrated Red Eye tool or Clone Tool 

(on page 410), the photo becomes grouped with other objects that modify the image in 

some way. For example with the Red Eye tool, the ellipse shapes that are used to modify 
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the red eye areas of the photo are grouped with the photo itself. This is called a PHOTO 

GROUP and you’ll see this on the status line when you select such a modified photo.  

Similarly - if you enhance a photo while you have an active Mask or region, an enhance 

region is placed inside the Photo Group 

Just like an ordinary group it keeps the photo together with the other objects that have 

been added to modify it, but unlike a group it is still treated as if it was an ordinary photo 

by the Photo Tools and other tools. Normally photo groups are automatically placed 

inside a clipview object, which clips any objects which overlap the edge of the photo, to 

the boundaries of the photo itself. That’s why when you select a photo group the status 

line usually shows you have a "Clipped photo group" selected. 

If you want to convert a Photo Group into an ordinary photo object, you can use 

"UTILITIES" > "OPTIMIZE PHOTO". But note that this is destructive in that thereafter you will 

not be able to modify any of the photo edits you’ve applied to the photo. Some other 

operations such as content-aware scaling, photo background erase and contoning also 

convert photo groups into flat photos, because these operations aren’t able to preserve 

the photo group structure. 

You can also duplicate/clone (Ctrl+K) objects within photo groups - the cloned object 

then appears as the topmost object in the Photo Group (look in the Page and Layer 

Gallery (on page 196) to verify!)  

Photo Grids, Panels and Frames 

There are essentially two types of Photo Grid, which are a compact array of photos: 

RESIZABLE PHOTO GRIDS, and SMART PHOTO GRIDS. The PHOTO PANELS are a 

combination of photos, text and graphic elements and the PHOTO FRAMES are a collection 

of simple, attractive frames.  

You can find the grids in the ONLINE CONTENT CATALOG under "COMPONENTS" > "IMAGE 

RESOURCES" > "PHOTO GRIDS". All the SmartShape photo grids (as opposed to the 

Resizable ones) have 'smart' in the title. 
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Resizable Photo Grids 

These are aesthetically pleasing arrays of photos, Initially, they are set to sizes that are 

commonly useful, such as square, 16:9, 4:3, etc. but once you’ve added them to your 

document you can change the width and height to make them any size and aspect ratio 

you like, from wide and short to tall and slim.  

 

A resizable Photo Grid. 

Just drag on the side, top and bottom handles to resize. The photos are scaled, cropped 

or uncropped as you do this. Once you have the grid at the dimensions you want, you 

may need to adjust the scale and positioning of each image, to fit nicely within its new 

frame shape. Go into the PHOTO TOOL and click on each image to select, then use the 

adjustment handles on the photo to rotate/scale inside, or move the image in its frame.  

Note you can’t change the number of photos in these designs, or the layout, they are 

fixed designs.  

Smart Photo Grids 

This is a more flexible SmartShape that lets you display any collection of photos, even 

those with different shapes and aspect ratios, in a compact grid. You can adjust the 

number of photos on each row, or number of rows, drag to re-order the photos, and 

adjust the gap between all the photos.  
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To show these SmartShape control handles, click on the grid. As you hover over each 

handle a little info tip appears. 

 

 
Drag the blue handles in the centers of images to re-order images. 

 
Adjusts the gap between the images. 

 
Rotate the whole grid. 

 
Click a green edge handle to add a new image to the row. This will add a 

placeholder image onto which you can drag a new photo. 

 
Resize the whole grid, alternatively, use the Selector Tool. Hold down shift 

to resize the grid around its center. 

 
Drag down to add another row of images. 

 
Click an interior green handle to delete the image. This will reshuffle and 

resize the other images on the row.  

You can also use the Smart Photo handles on individual images, by going into the PHOTO 

TOOL and clicking on an image. Each time you replace an image, it puts you into this 

Photo Tool mode. To get back to the SmartShape handles use the QUICKSHAPE TOOL 

(Shift+F2) or go back to the SELECTOR TOOL (on page 115) and click again. 

Adding & Replacing images 

To replace an image with your own photo, just drag and drop a photo file from Windows 

Explorer (or from the BITMAP GALLERY (on page 364) if the photo is already in the current 
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document). The image in the grid that you drop onto is replaced with your photo and the 

grid automatically updates to accommodate your photo.   

To add more images click the green "Add photo" handle on the right end of each row, or 

drag the "Add / remove rows" handle at the bottom left of the grid to add a complete row.  

Note: The height of a row is calculated by fitting the number of images in this row into the 

width of the grid. So the more images per row, the less tall that row is, especially if the 

images are wide such as panorama photos. Similarly rows containing just a single image 

will usually be taller. 

Border 

There is a "Border width" handle on the top left photo in the grid that lets you adjust the 

space between each photo. You can have no space at all if you choose, but when you do 

have a border it’s simply empty space between the photos so you see whatever is behind 

your photo grid. Therefore if you want to see something other than the page background 

behind, just draw a rectangle behind and set its color or fill to give the border effect you 

would like.  

Photo grid, Grids, Stacked photo grids, Smart grids, Smart photo grids.  

Photo Panels 

Most of the Photo Panels are customizable. Resizable usually in width and height, you 

can easily adjust them to fit any space, whether short and fat or tall and thin. Drag the left 

or right handles to change the width and the top or bottom handles to change the height - 

the elements will all re-format to fit the new dimensions.  

All text can be edited and styled using the TEXT TOOL, the same as with ordinary text. To 

replace a photo image, go into the PHOTO TOOL, click on the photo to select it inside the 

panel, then right-click and choose the REPLACE PHOTO option in the context menu. Or 

you can drag a photo from Windows Explorer or from the BITMAP GALLERY and drop it 

directly onto the photo you want to replace. 
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Find the panels on the INSERT menu "INSERT" > "PANELS" or in the CONTENT CATALOG  

under "COMPONENTS" > "IMAGE RESOURCES" > "PHOTO PANELS".  

Photo Frames 

The photo frames are a selection of attractive designs for presenting photos. As with all 

photos, to replace the images with your own, just go into the PHOTO TOOL click on the 

photo to select it and then right-click and choose REPLACE PHOTO from the context menu. 

Find the frames on the INSERT menu "INSERT" > "IMAGE" > "PHOTO FRAME..." or in the 

CONTENT CATALOG under "COMPONENTS" > "IMAGE RESOURCES" > "PHOTO FRAMES"   
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Importing Photos 

Xara Photo & Graphic Designer supports a very wide range of photo or bitmap types 

including JPEG, PNG, TIFF and RAW digital camera images, as well as many more 

types. The term "bitmap" is the general term encompassing all types, but 

interchangeable with the word "photo". 

 

The easiest way to open an image is to drag the photo or bitmap file from your Windows 

file explorer onto the Photo & Graphic Designer Window. The photo is imported at the 

position you drop it. Or you can select the "FILE" > "OPEN" or IMPORT menu options. 

You can select multiple photo files in the file dialog by clicking with Shift or Ctrl held down 

to add to the selection, just as in Windows Explorer, to open or import multiple photos. 

You can also import stock photos from the Online Content Catalog through the File menu 

"FILE" > "NEW FROM CONTENT CATALOG". Or you can replace a photo by right-clicking it, 

and then choosing  "REPLACE PHOTO" > "WITH STOCK PHOTO" from the context menu.  
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Optimization on import 

When importing high resolution photos (anything above 1920 pixels either wide or high) 

into a web document, Xara Photo & Graphic Designer automatically resizes the photo 

down to HD screen size without asking you if you want to import a lower resolution 

version. For a web document, even at the reduced size, there should be more than 

enough resolution in your photos for high quality results on your website, so it’s rarely 

necessary to import digital camera images at full resolution for web use. 

However, if you are importing a large photo into a print or animation document, Xara 

Photo & Graphic Designer asks you if you want to import a lower resolution version of 

your photos. If your document is to include many photos, you may want to choose this 

reduced resolution option. Otherwise with large photos you may find that your saved 

design file is much bigger than it needs to be (because it contains a copy of each of your 

photos) and you may not have enough memory in your computer to load, edit and export 

your documents. 

Automatic conversion to JPEG 

The JPEG image format is usually the best choice for photo images, because it 

maintains high quality with smaller file sizes. So when you import non-JPEG photo files, 

Xara Photo & Graphic Designer will examine the image to see if it would be more 

appropriate as a JPEG. If so, a prompt is shown giving you the option to convert it to 

JPEG on import. This reduces the size of your document files and reduces memory 

usage when editing. 

When pasting in images from the clipboard, the same analysis is done and the image is 

imported as JPEG if that’s appropriate. This is done silently with no prompts. This is 

particularly useful when copying and pasting in images from web browsers because 

although the images are often JPEGs in the web page, some browsers don’t 

communicate this to the clipboard. 

Replacing photos 

If you drag and drop a photo file (from Windows Explorer or from the Bitmap Gallery) 

onto an existing photo it will replace that photo, but keep the same container or frame 

size.  

The same is true if you replace an existing photo with a stock photo from the Online 

Content Catalog - right click on your photo and select "REPLACE PHOTO" > "WITH STOCK 

PHOTO". 

This makes it very easy to replace photos on templates. You can use the photo 

adjustment handles to quickly adjust the scale, rotation, and position of the photo inside 

its outline, as well as being able to resize, rotate and even add rounded corners to the 

frame itself.  This is not true for photo documents (on page 391), where dropping a photo 

on the page will always import it as a new photo document. 

When replacing a photo or bitmap this way, it is sized to best fit in the existing picture 

outline.If you hold "Shift" when replacing a photo, the new one will inherit the same scale 

and rotation as the old photo, instead of being ‘best fitted’. This is useful where you've 
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manually adjusted the scale or rotation of a fill and then want to replace the image with 

another which has the same aspect ratio. 

When you drop a new photo onto a Photo Group (on page 354), the entire Photo Group 

is replaced, leaving you with a photo object showing the new image. 

Using photos as fills 

You can also use any bitmap as a fill style for any drawn shape. Simply drag the file over 

the shape (which can be from your file system, or from the Bitmap or Fill galleries), and 

hold the "Shift" key down before you drop. This will replace the existing color fill with a 

bitmap, fitted to the object. Again you can use the smartphoto adjustment handles to 

change the scale, angle, position etc. 

Initial Photo size 

When you import a photo into a document, by default if it’s bigger than 500 pixels wide 

the photo is automatically scaled down to 500 pixels. This is because it’s rarely useful to 

drop a huge digital camera photo into a drawing document and have it displayed at its full 

size, so it’s scaled down to a more manageable size. You can change this behavior on 

the VIEW tab of the UTILITIES > OPTIONS dialog: 
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You can choose a different size to which photos should be scaled, or elect for them to be 

imported at 96dpi (default screen resolution) so that at 100% zoom they are displayed at 

1:1. Or you can choose to have photos imported at the dpi which is indicated in the photo 

file itself. Note that some digital cameras set this dpi value wrongly and so this third 

option may not always give you the results you expect. 

When importing at 96dpi each pixel of the photo takes one pixel of screen, so you're 

seeing the full resolution image when viewing at 100%.  

However because most digital photos are very high resolution, this means you may only 

see a small part of your photo, so initially Xara Photo & Graphic Designer will 

automatically alter the zoom scale to zoom out so you can see the whole image.  This 

also means that a typical digital photo will be far, far larger than your page size (your 

screen is probably only about 1200 pixels across, and a typical digital photo is 3 or 4 

times as wide, sometimes a lot more) 

To reduce the size, just drag one of the photo adjustment handles, or one of the 

SELECTOR TOOL, corner handles or enter a new width in the SELECTOR TOOL InfoBar 

width field. 

Photo resolution 

One fundamental difference between Xara Photo & Graphic Designer and other photo 

tools is that when you resize a photo it retains the full resolution. Scaling an image to be 

smaller, just increases the dpi or ppi (pixels per inch). In other words no pixels are lost, 

they are just made smaller. 

 

96ppi image on the left when scaled down to half size becomes twice the resolution, 192ppi. 
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The status line shows the resolution of any selected image. Retaining the full resolution 

is important because it means you can see all the detail when you zoom in, and that 

when printing the maximum resolution is sent to the printer. Also it means you can 

enlarge all or part of the image and Photo & Graphic Designer retains the original 

maximum quality. 

Zero-memory Copies 

One of the most revolutionary differences between Photo & Graphic Designer and other 

software is that when you copy any photo on the page, it doesn't really make a complete 

new copy of the original imported photo but instead just displays another 'view' of the 

original image.  Photo & Graphic Designer's rendering engine is fast enough that it can 

display any number of copies of the same image 'on the fly' this way. This saves huge 

amounts of memory and dramatically reduces files sizes. 

This doesn't detract or limit what you can do with each copy, and they can be treated as 

completely separate independent copies. Each copy does not have to be identical. You 

can manipulate each as required, resizing, rotating, cropping. coloring, feathering, or 

applying a wide range of photo and transparency effects. All for no memory or native file 

size increase. 

 

This shows separate copies of the same image, each manipulated in a different way. 

Each retaining the full resolution of the original imported JPEG, as you can see from the 

right image. The memory (RAM and file size) is no more than the original JPEG size. 

The Bitmap Gallery 

The Document handling chapter (on page 74) has general information about galleries. 

The BITMAP GALLERY shows all the bitmaps or photos used in any document, along with 

information about its pixel size and file size.  
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You can open it by clicking it in the Galleries bar, or from within the "UTILITIES" > 

"GALLERIES" menu, or "F11". 

 

The following useful information is displayed about the original image: 

 Filename of the original JPEG 

 The file type, in this case a JPEG, and the file size, 1,006K. (This is the original size of 

the file, and also how much of the .xar file will be taken up by this image.) 

 The pixel dimensions of the original, the Megapixel size (in this case just under 2MP) 

 The color depth, in this case "24 bit" which is sometimes called true color. 

 The original resolution of the image, in these cases 96dpi 

The BITMAP GALLERY always contains a default bitmap, with the gray default image. This 

is used as the default bitmap for bitmap fills and in cases where other bitmaps are 

missing. It's useful to have as a placeholder as well. 

As with all galleries, you can drag the objects from the gallery onto the page to create a 

new copy. Or you can select an image in the gallery and click one of the buttons across 

the top. The following section details the operation of the BITMAP GALLERY controls, most 

of which are for the more advanced user. 
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Filling shapes with a bitmap 

Select the shape on the page, then select the bitmap in the gallery and click the fill 

button. Alternatively drag the image from the BITMAP GALLERY and drop it onto any shape 

while holding "Shift". You can adjust the size, angle etc using the smart photo adjustment 

handles. 

Setting a Bitmap Transparency 

This is for the more advanced user. You can use any bitmap as a transparency mask on 

any filled shape or bitmap. The lightness of the bitmap affects how transparent the 

selected object is. The bitmap transparency size, rotation and tiling can be controlled 

from the TRANSPARENCY TOOL InfoBar. 

Deleting images from the Gallery 

When you delete a bitmap from the page, it remains in the BITMAP GALLERY. Any unused 

bitmaps will be deleted from the file when saved and re-opened.  However you can force 

the deletion of any bitmap by selecting it and pressing the DELETE button. If the bitmap is 

used in the document, it will be replaced by the standard X bitmap. 

Setting the page background to a bitmap 

Select the bitmap in the gallery and click the BACKGROUND button. This reveals a menu 

allowing you to choose between setting the PASTEBOARD BACKGROUND or the PAGE 

BACKGROUND. When setting the pasteboard background, if the image is narrower than 

the page, it’s assumed you want to have the image tiled to fill the whole browser 

background. Otherwise the image is applied single tiled. You can change these settings 

by right clicking on the pasteboard and looking under the Pasteboard Background sub-

menu.  

You can also apply an image to the background without using this gallery – just right click 

on the image and see the options in the context menu. 

See Website Backgrounds for more information. 

Save 

Select the bitmap and click SAVE will save the original image. In the case of an 

embedded JPEG this will save the original JPEG file.  Other bitmap types are best saved 

as PNG bitmap type. 

Bitmap Properties 

The PROPERTIES button will display information about the selected bitmap in the gallery. It 

also provides a way to stop image smoothing when bitmaps are enlarged. Usually all 

bitmaps are smoothed when enlarged, or zoomed into, on screen. There is a check-box 

option in the Properties dialog to turn this feature off, so that individual pixels are visible 

when you zoom in.  
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Note that this option only affects scaled up bitmaps. Note also that NEVER SMOOTH in the 

VIEW tab of the OPTIONS dialog box overrides this check box. 

It also provides information about the Animation properties of the bitmap. This is only 

really applicable to animated GIF images 

GIF ANIMATION:  

 DELAY (the time this frame is left on screen) 

 RESTORE: The Animated GIF Restore setting sets what happens between each frame 

in an animated GIF. Nothing means no action is taken. Many browsers take this as 

meaning the same as the Leave As Is option. Leave As Is displays the frames one on 

top of another - this leaves many frames visible in a stack if some are transparent. 

Some browsers clear the animation before it loops again, some do not. Background 

restores the area covered by the graphic to the background color of the GIF (usually 

white). Restore Previous restores the area covered by the frame to what it was before 

the frame was displayed. This is interpreted by some browsers to mean that the frame 

should be cleared to the background before each frame is displayed and by others to 

mean that the frame should be shown on top of the previous frame. As browsers 

interpret these values in different ways, you may need to experiment to achieve the 

desired result. 

Embedded JPEG files 

JPEG files are hugely compressed from their original state, being up to 10 times smaller 

than the original uncompressed image.  In the above example, the original 

uncompressed image requires more than 7mb of memory, but as the BITMAP GALLERY 

shows, this JPEG file is only 1mb. A very significant reduction. This is why JPEG images 

are the standard file type for digital photography and use on the web. 

When you drag and drop a JPEG file (or use the "Open" or "Import" menu options) the 

JPEG (reduced in size if it was large) is stored in the document, and this is what is saved 

in the .xar file when you save your document. 

It's important to understand how this differs from other graphics tools, both vector 

drawing software and photo editing programs. Other products will typically un-compress 

the image and store the un-compressed "raw" image in memory and the native file when 

you save to disc. What's more each copy you make is typically a complete copy of the 

original raw image, as mentioned above. Make four copies of your photo and save your 

file - it will be four times larger. In Xara Photo & Graphic Designer the file is no larger, no 

matter how many copies you make. 

So by embedding the JPEG file instead of saving the un-compressed image, that's a file 

size saving of more than 7:1 compared to other graphics editors. The fact that there are 

four complete copies of the image means that in this particular case the memory used is 

more like 30 times less. So this represents a huge file size (and time) saving over other 

graphics tools*. 

*This is easy to test. Import a JPEG into your favourite graphics editor, make four copies, 
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perhaps change each one slightly, to be colored or blurred or rotated. Then save the native file 
and compare it against the original JPEG size, and the equivalent .Xar file. A .Xar native file is 
about the size of the original JPEG, no matter how many copies of the image are made. 

Extracting the original JPEG 

Right click on any image in the BITMAP GALLERY and select the SAVE menu option to 

save the original JPEG back to your file system. 

Blending & Merging photos 

By making copies of photos on top of each other, and applying different effects to the 

copies, combined with Photo & Graphic Designer's advanced transparency controls, you 

can easily create blended photo compositions. For example to selectively blur parts of a 

photo takes a few seconds. 

 

By placing the blurred copy with the 'hole' created by the transparency effect over the 

sharp original, the blended result shows the sharp face area through. 

 

Creating copies of any object requires a single key press, or click (drag with right mouse 

button). Blurring a photo takes a single drag on a blur slider of the Photo Tool, applying a 
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gradated transparency is just another click-drag in the Transparency Tool, and finally 

positioning the photos on top of each other takes a second. So the whole process takes 

a few clicks, drags and just a few seconds in Xara Photo & Graphic Designer. 

Of course you're not limited to blurring effects, you can adjust colors, brightness and 

contrast levels, or apply any of the wide range of Live effects (on page 417) to create a 

infinite range of interesting or creative results.  

An Example Using a Photo Region 

 

The left picture is rather under exposed on the right side of the girl's face. The version on 

the right has had just the right side of her face brightened. 

These are the steps to re-create this effect: 
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Select the REGION PAINTER TOOL from the PHOTO REGIONS AND MASKS flyout, and paint 

over the region you want to adjust. It doesn’t need to be especially accurate. It’s usually 

best to make the region slightly larger than the area you want to adjust because later we 

will use feather to blend the edges. 

The selection region is shown with an animated ‘crawling ants’ outline. 

Now select the PHOTO ENHANCE (on page 397) tool and adjust the brightness slider (you 

can also adjust contrast, saturation, temperature and blur/sharpen).  

 

This is what the photo now looks like, with a rather obvious brightened area. Using the 

Transparency tool you can adjust the strength of the effect. 

  

In this example the transparency has been graduated across the area, so the effect 

fades right to left. 
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Just select the TRANSPARENCY TOOL and adjust the main transparency slider. To create a 

graduated fade like in this example just drag across the image in the TRANSPARENCY 

TOOL. This shows an arrow indicating the direction and size of the graduated 

transparency. You can adjust this by just dragging either end of the arrow and you can 

adjust the strength of the effect at each end using the transparency slider. 

The final step is to blend the edges of the brightened area with the FEATHER (on page 

138) tool. This gives the final result as shown top right. 

Note: The region or mask is an editable vector shape and you can edit the vector outline 

to be as exact as you want. But using the Feather effect to blend the edge means you do 

not have to be that exact. 

Secondly, as with most tools in Photo & Graphic Designer, these are non-destructive 

edits. Not only can you adjust the effect (and the region it covers, or any enhance effects) 

at any time in the future, but you can delete the effect to restore the original image. 

Photo display quality 

 

Xara Photo & Graphic Designer can display photos in one of five useful quality levels. 

The top two settings smooth the screen pixels so avoiding visible pixels or rough sections 

along the edges (anti-aliasing). Change the quality level using the QUALITY entry in the 

WINDOW menu. 

VERY HIGH 

QUALITY 

(DEFAULT)   

Displays images using bicubic sampling. This displays images at the 

best quality, particularly for large hi-res images that are scaled down 

or zoomed out a lot. 

HIGH QUALITY Anti-aliasing on, but images are rendered faster and at lower quality. 

FULL COLOR No anti-aliasing, thus showing individual pixels. This can be useful 

when you're zoomed in and you need to clearly see the separate 

image pixels.  The downside is that images generally look poor 

when reduced or enlarged resulting in clearly visible pixelation and 

jagged "staircase" edges, especially if you rotate the image. 

OUTLINE WITH 

BLEND STEPS 

Is particularly useful for seeing outlines of the various steps of a 

blend. Blends are not supported in Xara Photo & Graphic Designer 

but imported .xar files could contain blends. 

OUTLINE  Only object outlines are shown. This is useful for finding and 

selecting objects that are difficult to see due to other objects in front 

of or behind them. 

There is an additional control that allows you to stop all image smoothing or anti-aliasing 

on images that are scaled up or zoomed in. In other words, instead of a smoothed image, 

you see all the pixels when zoomed in. Open the BITMAP GALLERY and right click on the 



 

 372 Photo Handling 
  

 

 

image and select "properties". In the dialog un-check the "Smooth when scaled up" 

option. Now, no matter what viewing quality you select the image (and all copies) will 

always show the un-smoothed pixels when enlarged or zoomed in. 

Note: If you use the PHOTO TOOL sharpen / blur control then images have to be displayed 

at maximum quality. So if you think the viewing quality has stopped working, it's almost 

certainly because you have sharpened or blurred the image with the PHOTO TOOL. 

Saving & Exporting Photos 

Selecting the SAVE option will always save a native .xar file file (unless you’re editing a 

Photo document – see Photo Document section below). To save a photo as a JPEG, 

PNG or other image file type, it's necessary to use the EXPORT option, or the shortcut 

"Ctrl + Shift + E". 

You may select from a very wide range of file types, such as JPEG, PNG, GIF, TIFF, 

PDF, PSD, Flash (.swf), BMP, as well as other lesser well known types. 

  

There are two icons available on the top bar that are short-cuts to save 

the selection as JPG or PNG. These are in the flyout bar shown when you 

move the mouse pointer over the Export HTML icon. 

For photos we recommend saving as JPEG (sometimes called JPG) as this offers the 

greatest compatibility and the best size / quality compromise. 

When you export a JPEG or PNG, there is a Settings option on the Save Dialog. 

Selecting this provides many advanced export options, as well as compare side-by-side 

alternative settings or even alternative file types such as PNG.  

When you export a JPEG, an export preview dialog is shown where you can adjust many 

export options, as well as compare side-by-side alternative settings or even alternative 

file types such as PNG. 

The Export Preview dialog allows you to adjust the size, resolution, JPEG quality and 

even select from 3 alternative export file types if you so wish. The default values should 

be fine for all normal purposes and you can just click the export button to save your 

photo.  

Things to remember when exporting: 

 First select the object or objects you want to export 

 The default exported size of the image will be the size you see on screen at 100% 

zoom. 

The Export Preview dialog (on page 534) is described in more detail here. 
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Tip: You can control the JPEG quality in the Export Settings dialog on the Options tab. 

The default and recommended value is 85% 

 

The JPEG system is designed so that a setting 

of 85 is the optimum value. We recommend 

you do not save JPEGs at 100% quality, as the 

results are visually identical to the 85% quality, 

only the file size and memory use are 

dramatically increased with no benefit.   
 

When saving for use on the web it's quite possible to reduce the quality below 85 to 

increase page view speed. The preview window shows the quality of any value you 

select. 

Tip: If you expect you may want to perform any further edits on your exported image, for 

example to create the image again at another size, we strongly recommend saving the 

.xar file as well. This will preserve the lossless master image along with all its edits and 

changes. 

Example: To resize a photo and save as a new JPEG 

This process is very quick and simple: 

 Drop your photo onto Xara Photo & Graphic Designer (either onto a blank page or 

onto the title bar to create a new document) 

 In the Selector Tool either drag a corner handle to resize the image, or enter the 

required width or height into the "W" or "H" field on the InfoBar. Check the image size 

is correct at 100% 

 Type "Ctrl + Shift + E" to start the export process 

 Enter a filename, and ensure JPEG is selected from the file type dropdown 

 In the preview dialog simply click the export button 

To save any image as a PNG go through the same process except choose the PNG file 

type. 

Photo Edit Attributes 

All edits performed using the PHOTO TOOL (on page 397), such as any altering of the 

brightness, contrast, color, blur or sharpen values, or even the more advanced levels 

adjustment, are all just stored on the photo as attributes. See the terminology section (on 

page 14).  

Just as you can alter the color of a shape or line without altering the underlying shape, so 

Photo Tool attributes alter the visible appearance of the photo without affecting the 

original image (this is called non-destructive editing).  Another way of looking at this is 

that Xara Photo & Graphic Designer just stores a list of edits applied to your photo, and 
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you can change, remove or add new edits. You can always recover the original 

untouched photo, even after the brightness, resizing, even clipping or cropping. 

Attributes can be copied and pasted between objects. Not only does this apply to 

traditional attributes such as line color and thickness, it also works with all the PHOTO 

TOOL attributes including the LEVELS settings. So this means you can easily copy all the 

enhancements made on one photo to any other using the copy / paste attribute feature. 

For example to apply the same white balance adjustment (made using the levels control) 

to another photo, just copy the edited photo to the clipboard and then select the "EDIT -> 

PASTE ATTRIBUTES" menu on any image to which you want to apply the same 

corrections. 

This also applies to some other attributes of the photo, such as line width and shadows, 

etc.; all these can be copied from one photo to another using the same technique.  

Editing the outline of Photos 

You can use the SHAPE TOOL (on page 169) to directly adjust the outline shape of a 

photo.  Similarly you can apply outlines the same way as for any shape, and shadow, 

etc. 

 

Using the SHAPE TOOL you can push or pull on the 

sides. This example also has a black outline and 

soft shadow added. To restore the image back to 

its original rectangular shape, select the "Un-clip"  

in the clip mode of the PHOTO TOOL InfoBar. 

When photos are edited this way, they are treated 

like any normal vector shape, containing a bitmap 

fill. This is why you can use the normal line and 

shape editing features, and indeed you can use the 

Photo adjustment handles (on page 382) to adjust 

the size, angle and position of the photo "fill" inside 

the shape. 
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Cropping photos 

 

The easiest way to crop a photo is to just drag on one of the smart photo 

adjustment handles (on page 382) which appear when you select a photo using 

the Photo tool or the Selector Tool. Simply hover over one of the handles to see a 

function information flag. 

 

For more advanced cropping control, select the CLIP BUTTON on the PHOTO TOOL 

flyout bar which provides aspect ratio control and precise numeric clipping control.  

This also provides an Un-clip button that will remove any clip rectangle and restore the 

original image. 

One important feature is that this crop feature is really a dynamic clip, in other words it's 

a non-destructive crop, and you can adjust the crop boundary afterwards to reveal 

hidden parts of the photo.  If you want to really crop - i.e. make this a destructive crop, 

that really removes the invisible parts of an image then use the Optimize Photo feature. 

Cropping photos with the Eraser Tool 

The ERASER TOOL (on page 439) lets you crop a photo by dragging a nib over it. If you do 

this with the softness setting set to 0 (hard erase), the crop is permanent, just as when 

using the clip tool discussed above. Although you can put back erased parts of the image 

using the SHAPE PAINTER TOOL (on page 94). 

If you use a soft nib with the erase tool you get soft edges wherever you erase. 

Technical note: This is achieved by applying an Opacity Mask to the image – see the 

Transparency Tool Chapter for information on Opacity Masks.  

Cropping photos with a mask 

If you want to make non-rectangular photo shapes or cut pieces out of a photo, use a 

mask. First select the photo and then choose the  MASK PAINTER TOOL from the Mask 

tools flyout bar. 

 

Use the MASK PAINTER TOOL to paint around the section of photo you wish to 

crop. 

Switch to the SELECTOR TOOL and select the photo underneath the mask, or clear the 

selection (press "Esc"). Now if you copy ("Ctrl + C") you will copy just the unmasked part 

of the photo to the paste buffer. Hit "Delete" and you'll delete the unmasked part. Or 

press "Ctrl + X" to cut it. You can also use the mask to apply "ARRANGE" > "COMBINE" 

shapes operations with it. 

See the Photo Regions and Masks chapter for more information on using masks. 
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Magnetic Lasso 

 

The Magnetic Lasso allows you to semi-automatically trace around objects in a photo to 

create a region. Once the region has been created you can copy or cut the object out, or 

apply an effect, or enhance the region.  

Find the tool on the Photo Regions and Mask Tools (on page 340) flyout.  

The tool is on by default - but you can toggle the auto-trace properties on or off using the 

toggle button on the InfoBar or by pressing T on your keyboard. Click the ? button next to 

the MAGNETIC LASSO toggle to bring up a step by step guide. 

 

Magnetic Lasso InfoBar 

 
Smoothing 

 
Invert/clear outline 

 
Show/hide outlines (Ctrl + H) 

 
Toggle Lasso on/off (T) 

 
Help guide 

Tracing 

To start - trace a dotted line around the edge of an object in your photo.  

There are two ways to do this - Click and drag around the edge. Start on the edge you 

want to follow. As you drag around the item you’ll see the dotted outline snapping to any 

nearby edge. You can press Shift to erase back along the path if things go wrong.  

Additionally pressing the space-bar will ‘anchor a point’ at the current pen position. 

Pressing T while dragging this way will toggle the magnetic snap off or on.  

Alternatively - click on the edge - then click again a short distance further along, to trace 

the edge between the two click points. Continue clicking around the edge to trace around 

the object. 

If at any point the dotted line misses the edge you wanted to follow, hit Backspace or 

Undo (Ctrl+Z) to undo the last click point. Then zoom in and click closer to the last point, 

on the edge you want the trace to follow. You will need to move in smaller steps along 

any parts of the edge that are less clearly defined, but where the edge is clear against 

the background you can move along the edge in much bigger steps.  

For both methods, pressing the Alt key while clicking or dragging will draw a straight line 

section from the last point to the current position.  Pressing T will toggle the magnetic 
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aspect off or on. With no Magnetic snap, then dragging acts exactly drawing with the 

Freehand tool. Clicking with no magnet snap will just add a straight line segment to the 

current point. 

Following the photo edge 

Sometimes you may want the outline to follow the edge of the photo. To do this, click just 

outside the photo edge. 

Finishing 

When you get back close to where you started, click on the start point again to complete 

a closed outline (the mouse pointer will change to show a + sign when you are over the 

start point) .  

Once you have a complete closed outline, you can now copy (Ctrl + C), cut (Ctrl + X) or 

delete the selected part of the photo. You'll notice that as you perform the operation the 

SELECTOR TOOL is automatically selected.  

Feathering 

Once you have cut out an object, you can usually improve the edges by applying a small 

amount of feathering (on page 138) using the feather control on the top InfoBar. 

Magnetic Lasso works well on images where there is a high contrast between the object 

you want to cut out and its background. Also if you have an image with lots of fine detail - 

like hair or fur for example then you will get a better result if you use the Background 

Erase (on page 439) feature instead.   

Photo cut out, cutout, magic lasso 

Screenshots 

In combination with a built-in screen capture feature you can easily capture and create 

screen shots.You can either use the SCREEN CAPTURE UTILITY which is included in Xara 

Photo & Graphic Designer or use the screenshot capability built into Windows. 

Using Windows to capture screenshots 

 Press the "Print screen" button on your keyboard. This places a screen capture of the 

whole screen on the clipboard. Alternatively, select "Alt + Print screen" which will 

capture just the current window. 

 In Xara Photo & Graphic Designer select "Ctrl + V" to paste, and select "Bitmap" to 

have the results pasted onto the page. 

You can now crop, add text annotation, resize as required and save the results. It's best 

to save this type of image as a PNG file.  
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Screen capture utility 

This utility offers some advantages over the method above, including the option to 

capture the mouse pointer in the image. Open it by choosing UTILITIES  > SCREEN 

CAPTURE.  

 

SCREEN AREA:  Here you can choose the screen area you would like to capture. You can 

capture the full screen, the active window in its entirety, or just the content of the active 

window without the window border. 

OPTIONS: Here you can choose whether or not the mouse pointer is included in the 

screenshot. Also choose whether you just want to capture one screenshot or whether to 

keep the utility turned on for the session so you can take successive shots each time you 

press the assigned key shortcut.  

The output section lets you choose how to handle the captured screen image. By default 

it will be directly inserted into the current Xara Photo & Graphic Designer design. 

Alternatively you can also save a BMP (Windows Bitmap) or PNG file for each 

screenshot into any folder. The files created are named "ScreenCapture", 

"ScreenCapture1", "ScreenCapture2", etc. Choose the TARGET FOLDER for the files using 

the BROWSE... button. 

You can define almost any hot-key combination (Shift, Alt, Ctrl + key) to trigger the 

screenshot. Just click in the key shortcut field and then press the desired key 

combination, e.g. “Ctrl+S”. The chosen shortcut appears in the key shortcut field. If it 

clashes with any defined Photo & Graphic Designer shortcut, you'll be warned with a 
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message appearing at the bottom of the dialog, but this doesn’t matter if you will have 

other windows active when taking the screenshots. Press RESTORE to return to the 

previous selected shortcut. 

Instead of using a shortcut key to take the screenshot, you can instead use the TIME 

option. This is useful in cases where any keyboard activity can change the display you 

want to capture, such as a pop-up tooltip which may disappear if you were to press a 

key. Select the time option and enter a delay value in seconds. The screenshot will then 

be taken for you automatically once the specified period of time has elapsed. The timer 

starts as soon as you click the START button. 

Pressing the START button closes the Screen capture dialog and activates the system-

wide hotkey. Switch to the window you want to capture and press the chosen key 

combination, or wait for the chosen time period to elapse if the timer option was chosen. 

The screenshot is taken and inserted into Photo & Graphic Designer or saved to file, 

depending on the option chosen. If you selected the “Capture always” option you can 

take additional screenshots by pressing the key combination again (this is unavailable 

with the timer option). To deactivate the utility if you chose this option, close down Xara 

Photo & Graphic Designer to end the session. Alternatively return to the Screenshot 

dialog, choose the “once only” option and take one more screenshot. 

Coloring photos 

With any photo selected just click on the Color Line to apply a color to any photo. 

Clicking the white color patch will turn the image black and white. Technically this is 

called a "contone" (it's a continuous tone from black to white), or sometimes a "duotone". 

Simply click a pale yellow color on the color line to create a yellow contone picture. 

Or, right click on the Color Line which shows a context menu for you to apply the 

selected color as either the light or dark color. 

 

You can also use the color 

editor to select any color 

as either the light or dark 

contone colour. Right click 

the photo and choose 

CONTONE > LIGHT to 

display the color editor 

("Ctrl + E"). Select the light 

or dark contone from the 

dropdown menu at the top 

of the color editor. 
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You can restore the original color of a photo by clicking the cross-hatched "no color" 

patch on the left of the Color Line, or right clicking on it and selecting the "Restore color" 

option. 

 

You can also use the ENHANCE TOOL to provide a direct and very fast way of adjusting 

the brightness, contrast, color adjustment levels and sharpening of photos, You can also 

adjust the individual colors and tints within a photo as well as the shadows and highlights 

- even for ultra high-resolution images. 

Photo Filter Presets 

The PHOTO FILTER PRESETS allow you to instantly apply professional photo effects to your 

photos. Find the filters in the Content Catalog under "COMPONENTS" > "IMAGES 

RESOURCES" > "PHOTO FILTER PRESETS". They are grouped into categories and there is a 

wide range of moods and themes to choose from. 

 

Some of the Photo filter presets in the Online Content Catalog 

To apply a filter to a photo, first select the photo and then click the IMPORT button on your 

chosen filter in the Catalog. The preset filter is then applied to your photo and also 

imported to your LOCAL DESIGNS GALLERY.  

Note: You can keep the Catalog open after an import by holding down the Shift key as 

you click the Import button. Useful if you want to try a range of filters. 

Using presets from the Local Designs Gallery 

Once you’ve imported one preset, you can optionally download all the presets to your 

Local Designs Gallery, for easier access.  

Right click on the "COMPONENTS" > "IMAGE RESOURCES" > "PHOTO FILTER PRESETS" 

folder in the gallery and choose DOWNLOAD ALL. Re-open the folder and now you can 
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drag and drop any of the effects onto your photos, or select the target photo and double 

click an effect in the gallery.  

Using multiple filters 

There are multiple different ‘classes’ of filters and overlays that can be applied together. 

The set of filter presets is divided into two folders under "COMPONENTS" > "IMAGE 

RESOURCES" > "PHOTO FILTER PRESETS". The FILTERS folder contains presets that affect 

the overall look of your photo. It would not be useful to apply more than one of these 

presets to a photo and so these will replace each other. In other words, only one of these 

presets can be applied to a photo and applying a second will automatically remove the 

first. 

However the OVERLAYS folder contains various different classes of presets that can be 

applied in addition to any of the presets under the FILTERS folder.  

 

This photo has had the "Softlight" filter effect applied from "Filters" > "Effects" and also the 
"Stripes" pattern, from "Overlays" > "Patterns".  

Each of the presets in the same sub-folder under OVERLAYS will also replace each other, 

because it wouldn’t be useful to have for example two different patterns applied. But you 

can mix presets from each of the other folders under OVERLAYS as much as you like. So 

you could for example apply a check pattern from the PATTERNS folder, a texture from the 

TEXTURES folder and a transparency effect from the TRANSPARENCY folder all to the same 

photo.  

Replacing photos and removing presets 

If you drop a replacement photo onto a photo with a filter applied the filter preset will be 

maintained. And if you have any existing photo edits in place, for example if you used the 

RED EYE or PHOTO HEAL (on page 410) tools then the applied filter will merge with these 

edits too. 
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When you right-click on a photo, you will see a PHOTO FILTER option in the context menu 

that appears. This option has a sub-menu, which allows you to apply filters to your photo 

and remove filters that are already applied.  

The APPLY FILTER… option opens the CONTENT CATALOG onto the PHOTO FILTER PRESETS 

folder so you can apply a filter to the selected photo. Following this option in the menu, 

you will see REMOVE options for each of the filters you currently have applied to the 

photo, so you can remove any of them.  

The final option in the menu allows you to clear all applied filters from the photo. 

Editing Photo Filter Presets 

Most of the preset filter effects modify the image by adjusting the same settings that you 

see in the PHOTO TOOL and the BRIGHTNESS LEVELS DIALOG. Therefore remember that 

applying an effect may remove any photo enhancements you have applied manually 

beforehand, using the PHOTO TOOL. Similarly if you apply a preset filter and later adjust 

the settings in the PHOTO TOOL, if you later remove the preset it may also remove your 

enhancements.  

Similarly, the overlay effects under "OVERLAYS" > "TRANSPARENCY" work by applying 

transparency effects to your photo directly. You can see and modify these effects by 

selecting your photo and going into the TRANSPARENCY TOOL.  

Applying presets to your photo and then examining the settings in the PHOTO TOOL and 

BRIGHTNESS LEVELS DIALOG is a great way to learn about the capabilities of the PHOTO 

TOOL. 

Resize, rotate and position a photo within its frame 

  

The shape of your photo is really a fully editable outline around the image contained 

inside. So when you crop, or edit the outline shape, you're not affecting the fill, which is 

clipped inside the shape. 

Photos and bitmaps on the page are always contained within an outline shape. Not only 

can you change the shape of the outline, you can also adjust the scale, rotation and 

position of both the photo and its frame using the smart photo adjustment handles, which 

provide a quick and easy way to perform the most common photo editing tasks.  
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The handles automatically appear whenever you select a photo with either the Selector 

Tool (on page 115), the Photo Enhance Tool or the QuickShape Tool.  

 

For example, to scale, rotate and round the image on the left, just drag on the 

appropriate adjustment handle. A little info flag will appear as you hover over a handle. 

As you drag the handles to adjust an image, a 'ghost' copy of the full uncropped image is 

shown behind. This makes it easier to make adjustments because you can see parts of 

the image that fall outside the crop area, as you drag the handles. 

 To rotate and scale drag on the white circular top right icon - the degree of rotation is 

displayed 

 To move the image within the frame drag the "hand" icon on the bottom left 

 To round the frame edge drag the orange corner handle 

 To rotate the entire frame drag on the blue circular top right icon 

 To scale the frame drag on the bottom right + handle (hold down the shift key to scale 

the image from the center) 

To reset a photo back to it’s ‘best fit’ state, double click on the rotate/scale handle. To 

centre the image in its frame, double click on the “hand” icon. The handles on the edges 

of the photo allow you to change the shape of the photo frame (hold down the shift key to 

resize around the centre). These operations are smart and the image inside is 

automatically cropped, scaled or moved in order to preserve the correct aspect ratio. 

Double click any of the edge handles to change the frame to fit the whole photo exactly.  

These smart photo operations also work with photos of any shape, not just rectangular 

photos, and unlike the Fill Tool they also work with PHOTO GROUPS (on page 354) and 

CLIPVIEWS (ON PAGE 154). 

 

For more control over cropping use the CLIP TOOL 
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"Smartphoto handles", "Photo handles" "Smart photo" "Adjustment handles" 

Horizon Straighten 

  

Using the smart photo adjustment handles as previously described it's easy to straighten 

the horizon of an askew picture. 

 Select a photo - this will show the adjustment handles, which allow you to scale, rotate 

and position the fill inside the shape. 

 Drag on the rotation handle to rotate and scale as required. 
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The following shows a landscape (created using the panorama stitching feature of Photo 

& Graphic Designer) that has a sloping horizon. 

 

Drag on the adjustment handle (circled) to rotate and scale the photo within the frame - 

the degree of rotation is displayed. You can also reposition the photo within the frame 

using the move photo "hand" icon (bottom left).  

The handles on the edges of the photo allow you to change the shape of the photo 

frame. Again these operations are smart and the image inside is automatically cropped, 

scaled or moved in order to preserve the correct aspect ratio. Double click any of the 

edge handles to change the frame to fit the whole photo exactly.  

To reset a photo back to it’s ‘best fit’ state, double click on the rotate/scale handle. To 

centre the image in its frame, double click on the “hand” icon. 
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Integration with external Photo Editors 

While Xara Photo & Graphic Designer provides a great many photo editing and 

compositing features, it is not a "pixel editor", and for these purposes you may want to 

use a separate program. Xara Photo & Graphic Designer makes integration with these 

easy. You can configure any external program to be launched when you double click a 

photo  while in the Photo Tool, and after editing, for the photo to automatically be 

transferred back into your Photo & Graphic Designer document. 

Double clicking a photo when you are not in the Photo Tool, selects the Photo Tool so 

you can edit the photo using Xara Photo & Graphic Designer’s integrated editing 

features. Double click the photo while in the Photo Tool to invoke the external editor. 

To choose an external editor, select the PHOTO EDITING tab in the Options dialog. 

 

XPE is a basic picture editor. Most of its functionality is now provided by the Photo Tool 

directly and so this tool provides little benefit. It's here mostly for back compatibility 

reasons. 

Alternatively, if you select the "Edit bitmap with this program" option and browse to select 

an external program, then this can be launched by double clicking on any image when in 

the Photo tool (you will probably need to browse to your program files folder on your local 

hard drive and select the program executable .exe file). 

It should be understood that images transferred to and from external editors are 

transferred as uncompressed images (to avoid compression / decompression cycles) 

and so this will increase the file size of your .xar file. 

When editing a photo in a separate program in this manner, you can carry on using Xara 

Photo & Graphic Designer as normal. Each time you save the image from the photo 

editor (or just close the program and click the Save option) Xara Photo & Graphic 

Designer will automatically pick up the changed version and replace the original image. 

This means you can just continue editing the photo in the external program, and to see 

how this looks in context in your Photo & Graphic Designer document, just click "Ctrl + S" 

(or whatever the normal saving shortcut in your photo editing software). 

Note: Xara Photo & Graphic Designer always sends the original un-clipped whole photo 

to the external editor. Any images that are enhanced (e.g. brightness altered) or clipped 



 

Photo Handling 387  
 
 

 

with the photo clip, or have any live effects applied, will have these changes missing 

when you edit them this way. However, when the edited image is returned, the clip and 

photo attributes are re-applied to the edited image.  For this reason, it's not 

recommended that you alter the size or crop images in an external editor. 

You can, of course, Undo any external edits you've applied by using the usual Photo & 

Graphic Designer Undo feature (it always stores a copy of the 'before' image). However 

when you save and re-open the .xar file all Undo information is lost. 

Editing images this way is a destructive edit. i.e. the image is permanently altered by the 

external Photo Editing Tool, and the original cannot be recovered once the file has been 

saved and closed. 

Viewing a scaled photo at its full size 

 

The ZOOM TO 1:1 button on the PHOTO TOOL InfoBar adjusts the zoom so that the selected 

image is shown at full size, which is where each pixel of the image is mapped to each 

screen pixel. This is useful if you want to edit an image that’s been scaled down on the 

page, but want to see it at its full size while you work on it. 

Making a photo its full size 

 

The SCALE PHOTO TO 100% button on the PHOTO TOOL InfoBar takes the currently 

selected photo and scales it to its full size on the page. So for example if the selected 

photo is scaled down to 500 pixels wide, but the original imported photo was 1000 pixels 

wide, the photo on the page will be scaled up to 1000 pixels wide. When the document 

zoom is 100%, that means that each pixel of the image is mapped to each screen pixel. 

Optimizing Photos and Bitmaps 

With the ever increasing resolution and file size of digital camera JPEGs, if you have a 

document containing many images, the file size can quickly become very large. For 

example, a multi-page document containing 20 full resolution JPEGs, each of 5mb, 

would produce a .xar file of over 100mb*. 

Furthermore, these photos are often unnecessarily high resolution. Reducing a photo 

from a 8 megapixel digital camera to be 2 inches (5 cm) wide on the page will result in 

this image being around 1500 dpi.  Whilst a very high resolution image gives greater 

flexibility for printing (and you can zoom in, or enlarge small parts of the photo), this is far 

higher than required for even the best quality commercial printing, and even more so for 

web graphics or HTML production. 
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If you clip to a small part of the image, or cut-out only a small part of your photos, there 

could be large parts of hidden image outside the visible area. For editing purposes this 

"live crop" is a great feature, as you can un-crop, alter the size, position and scale and 

everything remains as sharp as possible. But for finished documents you may want to 

remove the invisible parts. 

 

The cut-out butterfly image still has the rest of the photo attached. If you go into the FILL 

TOOL you can easily see this by resizing the fill inside the outline. So the parts of the 

image outside the butterfly will probably be superfluous in your final document. 

Right click a photo and choose OPTIMIZE PHOTO or choose "UTILITIES" > "OPTIMIZE 

PHOTO..".. This dialog performs three important functions: 

 Removing invisible parts of photos 

 Reducing resolution of photos 

 Converting PNG or bitmaps to embedded JPEGs to optimize file size 
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Selecting this menu option for any bitmap will display the OPTIMIZE PHOTO dialog. 

 

The default resolution depends on the type of document you are working on: 

 192 dpi  Web documents with Retina hi-definition images.  

 150 dpi Print documents. 

 96 dpi  Other documents.  

When optimizing non-JPEG images, Photo & Graphic Designer will automatically decide 

whether it’s best to optimize to a PNG or JPEG, depending on the nature of the image 

itself. 

You can click the SETTINGS button on this dialog, if you want to change any settings such 

as the image format used for the optimization, JPEG quality, etc. 
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You can change the resolution used in this dialog, by either choosing the physical size 

you want for the optimized image (width/height in pixels), or by entering a different dpi 

(eg. perhaps 150dpi if you want print quality). 

If you choose the dpi option the value you enter is remembered and becomes the default 

just for the current session. You can also maintain the photo's current resolution by 

choosing CURRENT from the PPI list. 

You can also choose to optimize as a PNG (produces much larger images, but better 

quality for graphics and text images) or change the quality used for JPEG optimization 

(higher quality means larger JPEG sizes). 

If your photo is cropped, only the visible part of the image is preserved in the optimized 

image. 

For printing, a photo resolution of 150dpi gives very good results, whilst 300 dpi will 

provide the highest quality commercial printing (most people cannot tell the difference 

between 150dpi and 300dpi, but the 300dpi requires four times as much memory or file 

space). 

Warning: "OPTIMIZE PHOTO" is a "destructive" operation. When you save the file the parts 

of the image removed are lost, and the resolution changed permanently (you can of 

course undo the changes while the file is open for editing). 

You can optimize multiple photos at once if you want them to all have the same dpi. 

Select the photos you want to optimize and then choose the OPTIMIZE operation as 

described above.  If your photos have different dimensions, the option to optimize by 

pixel size is disabled and you must just choose the required dpi.  

Or you can use the "UTILITIES" > "OPTIMIZE ALL IMAGES" facility to optimize all the bitmap 

images in your document in one operation. 

The optimization process will convert large non-JPEG images to smaller JPEG images if 

it decides that the image can be stored and exported as a JPEG without an unacceptable 

loss in quality. 

Note that after optimizing the original unoptimized and now unreferenced photo remains 

in the BITMAP GALLERY (ON PAGE 364). This means it is still in memory and so the memory 

requirements of your design will not have been reduced. Simply save your design and 

reload after optimizing, to eliminate the original large images. 

Converting objects or drawings to bitmaps 

You can easily create a bitmap from any object, or part of your drawing, including from 

other bitmaps. The bitmaps can be any size or resolution and can contain transparency. 

You can also create bitmaps with reduced numbers of colors which can be useful for web 

use. 
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To create a bitmap from objects: 

1. Select the object/s on the page. 

2. Right click and choose CREATE BITMAP COPY or choose CREATE BITMAP COPY from 

the ARRANGE menu ("Ctrl + Shift + C"). 

3. In the dialog box, select the color depth, the size and other options. 

For maximum quality select a color depth of true color, or if you want transparency to be 

included select "true color + alpha" (alpha transparency is the technical term).  You can 

create bitmaps with fewer colors by selecting a color depth of 256 colors or less. This 

also provides control over the dithering and palette options. These options are described 

in the section on exporting bitmaps (on page 534). 

Note this always creates PNG images, which are the highest quality image type. 

However for full color photo purposes, these require a lot of memory and file space. Use 

the optimize photo option to convert PNG images into embedded JPEG images to 

reduce the file size. 

Photo Documents 

Sometimes it's useful to work on one photo alone, rather than as "objects on a page". 

This is called a photo document or "photo mode" in Photo & Graphic Designer, and it 

behaves more like a traditional photo editor. You can create a photo document in a 

number of ways: 

 Drag a photo file from your file explorer onto the title bar or toolbar of Photo & Graphic 

Designer 

 Select "FILE" > "OPEN" and select a photo file 

 Create a blank photo document by selecting "FILE" > "NEW" > "BLANK PHOTO" 

Photo documents are characterized by the following behavior differences compared to 

traditional Photo & Graphic Designer documents: 

 There is no visible white page. In fact the page dimensions are set automatically to 

match the photo plus any other objects you've added. 

 Photo documents have a 1 pixel grid by default and snap to grid is turned on. This 

makes it easier to get pixel-accurate crop or clip regions. 

 The Pasteboard (the area around the photo) is a darker color. This makes it easy to 

distinguish at a glance between photo documents and drawing documents. 

 The document zoom is set so that the photo fills the view and the PHOTO TOOL is 

automatically selected as the current tool. 

 Dropping additional photo files on top of an existing photo just adds a new photo to the 

document instead of replacing the photo in its frame.  And the view will zoom out so 

you can see the whole image. 

 Images are not resized to be 500 pixels on import as they are in normal documents, 

but are imported at 1:1, so that at 100% zoom you're seeing the image at full size. 

 The pixel smoothing options are altered. By default it selects the "Very high quality" 

display mode, which is best for images scaled down or zoomed out. It also has pixel 
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smoothing turned off when zooming in, so you can see the pixels are very large zoom 

factors. 

 If you’ve opened a JPEG photo file as a photo document, when you save changes 

your JPEG file will be overwritten. See Editing Photo Files below for details. 

In all other respects Photo Documents behave like normal Xara Photo & Graphic 

Designer documents. You can use all the normal drawing and text tools as usual.  If you 

want to create a photo document of a given size, you can alter the "canvas" or page size 

by selecting "UTILITIES" > "OPTIONS" and the "PAGE" tab and entering the required 

dimensions. 

 

In Photo Documents two extra controls become enabled. The PREVIOUS and NEXT button 

will move onto the Previous or Next image in the folder from which this image was 

opened. This will close the current image, so you may be prompted to save the file. 

Editing Photo Files 

You can use Xara Photo & Graphic Designer to easily edit your JPEG photos and save 

back the modified JPEG. And unlike with most photo editors, you can do this multiple 

times without loss of quality, even though the JPEG format is a lossy format. That’s 

becauseXara Photo & Graphic Designer is able to save your edits in a lossless way, 

along with the original photo. Here’s how it works. 

First open the JPEG, using "FILE" > "OPEN", drag and drop, or in Windows File Explorer 

right click and choose Xara Photo & Graphic Designer from the "open with" list. The 

photo is opened as a Photo document. 

Edit the photo using the PHOTO TOOLS as described above. 

If you then do "FILE" > "SAVE" ("Ctrl + S"), the JPEG file you loaded will be overwritten 

with the modified image. However by default Xara Photo & Graphic Designer also saves 

your photo in its native .xar format. This file is placed into a "Masters" folder alongside 

your JPEG file. It has the same name as your photo file but with a .xar extension. The 

.xar file includes within it your original photo without the modifications applied, and of 

course details of your edits. 

In future if you load the modified JPEG file in order to edit it further, Xara Photo & 

Graphic Designer will look in the Masters folder to see if there is a .xar file available for 

that photo. If so, the .xar file is loaded instead of the JPEG file and you can continue 

editing from where you left off. When you next save, the JPEG file is again overwritten 

and an updated .xar file also saved into the Masters folder. 

Of course if you don’t want to overwrite your original JPEG file with your changes, you 

can use "FILE" > "SAVE AS", to save the modified photo elsewhere, or use the many 

export facilities to export your photo into different formats.  
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You can get hold of the original photo from the .xar file by opening it, opening the BITMAP 

GALLERY, right clicking on the photo and choosing the SAVE option. 

In the Photo Editing tab of the "UTILITIES" > "OPTIONS" dialog you can choose to change 

the saving behavior described above. You can choose to not have a .xar file 

automatically saved for you into the Masters sub-folder, or you can choose to have the 

original photo file saved there instead. 

Note if you turn off this original photo preservation, you'll lose the original photo when you 

do a Save! 

Tracer 

"UTILITIES" > "BITMAP EDITOR" allows you to trace a bitmap, converting it to editable 

vector shapes. The tracer is typically used to trace two types of artwork-photographs and 

simple line art or logos. The tracer can be used for either type of work and selecting the 

correct trace mode is the easiest way to control this. 

 

 
Original bitmap 

 
Traced output view 

 
Bitmap name 

 
Trace mode 

Initially, the tracer shows: 
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 If there is a selected bitmap or, if you copied a bitmap from the BITMAP or FILL 

GALLERY, that bitmap. 

 Otherwise, the default bitmap. 

You can select a different bitmap: 

 From the dropdown list, 

 From the BITMAP GALLERY (click the "TRACE" button), or 

 By clicking on any bitmap in any Photo & Graphic Designer document. 

By default, the tracer does a "photographic" trace. That is, it produces a drawing with lots 

of colored shapes to simulate the photographic bitmap being traced. If you want to trace 

a black-and-white scanned bitmap, such as a logo or symbol, select one of the other 

trace modes such as monochrome or 256 colors. These are optimized for producing 

simpler but generally more precise tracings. 

Click "INSERT" to copy the tracing into the document. 

Click "TRACE" to start the trace operation. 

Press "ESC" to abort a trace operation. 

Trace mode 

This lets you specify the maximum number of colors in the final object: 

 Monochrome-2 colors. 

 Grayscale-256 shades of gray. 

 256 color-256 colors. 

 Photographic-16 million (24 bit) colors. 

Selecting more colors than exist in the original bitmap is usually not beneficial. The only 

time increasing the colors is useful is when tracing a heavily dithered 256-color bitmap 

and you want near-photographic quality. 

Each of these modes can have different settings for passes, color tolerance and so on. 

To restore the settings to their saved defaults click "RESET SETTINGS". 

To make the current settings the default, click "SAVE SETTINGS". 

To restore the settings to the factory defaults, click "DEFAULTS". 

Passes 

(Range 1-5) 

The greater the number of passes, the longer the trace operation takes and the greater 

the resultant file size, but the final result is closer to the original. 
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With each pass, the tracer attempts to more closely match any shading in the original 

bitmap. Obviously, this increases the memory required for the final object. You may 

require an object with minimum shading and just broad areas of color. Use one pass for 

this. 

Alternatively you may require color shading to closely match the bitmap. Use multiple 

passes for this. 

Remove noise 

If you scan a photograph you often scan small specks of dust sticking to the photo's 

surface. These produce "noise", or small, unwanted areas of a different color. 

Also many bitmaps try to improve the look by "dithering" pixels and this introduces 

unwanted noise (especially common for 256 or fewer color bitmaps). 

When tracing 256-color bitmaps that are heavily dithered, you should set remove noise to 

high (if you zoom into the bitmap in the document, you can see if it is dithered). 

This control removes noise and dithering by ignoring very small areas of color. 

Minimum area 

Areas smaller than the size set in this control are ignored (size is in pixels). Examples are 

scanned photographs with a lot of fine detail such as blades of grass. 

Initial and final color tolerance 

Color tolerance is how great a color change is required before the tracer considers two 

areas to be of a different color. 

Initial color tolerance is used for the first of multiple passes. It is similar to the broad 

brush strokes used to create the underlying colors on a conventional painting. 

Final color tolerance is used for the last pass. It is similar to merging the edges of color 

transitions to simulate shading. 

On multiple passes, the tracer gradually reduces color tolerance from the initial value to 

the final value. Thus, initial color tolerance should always be set higher than final color 

tolerance. On a single pass, only the final value has any effect. 

Accuracy 

This controls how accurately the tracer follows the outlines of the original bitmap. The 

more accurately it traces the outlines, the more control handles are required on each 

shape and hence the more memory is required for the final object. 

This option has no effect on corners, only on smooth curves. 
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Smoothing 

This controls how accurately corners (sharp changes of direction) are traced. Increasing 

the smoothing takes longer to trace the image but can reduce the final file size. 

Opacity Masks 

 

The Transparency tool allows you to apply either flat or graduated transparency to any 

object or group.  But sometimes you need more advanced control over the transparency 

(or opacity) of an object. The OPACITY MASK system takes any object, or group of objects, 

and uses the color (usually black to white shading) of these objects to define which parts 

of any other object are transparent or opaque. 

See the Opacity Masks (on page 314) section of the Transparency chapter for more 

information. 
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The Photo Tools 

Common photo functions 

The following buttons are available on the InfoBar when you are in the ENHANCE, CLIP, 

RED EYE or CONTENT-AWARE SCALING photo tools.  

 

Rotate by 90° controls 

 

The two rotate icons will rotate the selected photo or photos by 90 degrees anti-

clockwise or clockwise. 

Previous & Next 

 

When you 'open' a photo using Xara Photo & Graphic Designer the photo is loaded into a 

new Photo Document, because Photo & Graphic Designer assumes you want to edit or 

view the photo itself rather than use it as part of a drawing or other document. When 

you've opened a photo you can use the 'Previous' and 'Next' buttons on the PHOTO TOOL 

InfoBar to close the current photo document and open the next (or previous) photo in the 

same folder as the current photo.  This allows you to browse through the photos in a 

folder, without having to open and close each one individually. If you've made any 

unsaved changes to the photo you'll be asked if you want to save the changes when you 

press previous or next. 

See Photo Handling for more information on Photo Documents. 

Zoom 1:1 

 

Select a photo and click the Zoom 1:1 button. 

The ZOOM TO 1:1 adjusts the zoom so that the selected image is shown at full size, which 

is where each pixel of the image is mapped to each screen pixel. Use this option if you 

want to work on a photo at full size in a document where you have scaled the photo 

down. 
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Scale photo to 100% 

 

The SCALE PHOTO TO 100% operation takes the currently selected photo and 

scales it to its full size. It also puts the photo onto the pixel grid. 

So for example if the selected photo is scaled down to 500 pixels wide, but the original 

imported photo was 1000 pixels wide, the photo on the page will be scaled up to 1000 

pixels wide. When the document zoom is 100%, that means that each pixel of the image 

is mapped to each screen pixel. 

Using the Photo Tools 

 

To access the PHOTO TOOLS, move your mouse pointer over the Camera icon in 

the main toolbar on the left of the window. A flyout bar appears with icons for 

each of the available photo tools. 

 

If you’re in the SELECTOR TOOL a double click on a photo will switch into the PHOTO TOOL. 

Enhance Tool 

 

Click the Camera icon to enter the ENHANCE TOOL. 

The Enhance Tool provides a direct and very fast way of adjusting the brightness, 

contrast, color adjustment levels and sharpening of photos, You can also adjust the 

individual colors within a photo, even for ultra high-resolution images. 

The tool provides: 

 One-click auto-enhance your photos; this is particularly good for dull, underexposed 

images. 

 Manually adjust the brightness, contrast, color saturation, color temperature, hue, and 

blur or sharpness of photos. 

 Manually adjusts the brightness of the shadows in a photo. 

 Manually adjusts the brightness of the highlights in a photo. 

 Display a brightness levels histogram of your photo. 

 Adjust the brightness levels curve for more advanced levels control. 

 Correct color casts or white balance. 

 Enhances the individual colors of a photo. 

 A single-click "Compare" function to quickly compare changes against the original. 

 Crop images. This is "live crop" so you can un-crop and adjust the crop at any time. 

 Easy copy / paste all photo enhance edits between different images. 
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All these operations are interactive with live update. As you adjust the values, the image 

is updated instantly. They are also all non-destructive, meaning that your original image 

is not altered and you can always adjust or remove any adjustment. 

 

The first six InfoBar buttons to the left (not shown above) are common to all tools and are 
described above 

 
Auto-Enhance 

 
Brightness 

 
Contrast 

 
Shadows brightness 

 
Highlights brightness 

 
X-Process effect 

 
Color saturation 

 
Color temperature 

 
Photo hue 

 
Blur / Sharpness control 

 
Compare current with original settings 

 
Brightness levels dialog 

 
Photo colors enhance 

You can either enter values directly into the text fields or use a small pop-up slider for 

adjusting the values interactively. 

Pop-up slider controls 

The pop-up sliders can be used in one of two ways: 

 

1. Click and release the pop-up arrow. The slider control now remains on screen and 

you can adjust the values as many times as you like by dragging the slider control.  

Alternatively, if the mouse is held over the control, the mouse-wheel can be used to 

make small adjustments up or down. The slider will hide when you click anywhere 

else in the document. 
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2. Or you can click & hold the mouse button down, and drag over the slider bar to 

adjust the value. When you release the mouse the pop-up vanishes. This is a 

quicker more direct way, since it requires only one click & release to alter the 

values. 

Auto Enhance 

Clicking the "ENHANCE" button will analyze the overall brightness and contrast of the 

picture and automatically adjust the enhance values to obtain the best image. It is 

particularly effective with under-exposed (dark) images. After applying automatic 

enhancement to a photo you can adjust the values that were chosen, using the controls 

to the right of the "enhance" button. Clicking the "COMPARE" button will restore the 

original, clicking it again restores the last enhance values. 

Brightness/Contrast/Color Temperature/Saturation/Hue 

 

Brightness 

 

Contrast 

 

Saturation 

 

Color Temperature 

The image is altered as you adjust these values. The saturation alters the color intensity. 

At the minimum setting of -100 this will make a picture black and white. The Color 

Temperature control makes a picture more ‘warm’ or ‘cool’. The Hue control applies a 

particular color tint to the image and allows you to control the intensity of the selected 

color. 

 

Hue 

The HUE slider lets you choose 

the color to apply and the 

STRENGTH slider sets the 

intensity of the color change 

applied. 

  

 

Shadows brightness 

 

The Shadows brightness control allows you to bring out the detail in the shadows (darker 

areas) of your photo without affecting the rest of the image.  

The slider is initially positioned on the far left of the slider scale as it is assumed that you 

would always want to increase the shadow detail.  
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Highlights brightness 

 

The Highlights brightness controls the intensity of the highlights (bright areas) in a photo. 

This allows you to bring out the detail in the highlights which might not normally be 

visible. Bear in mind though that there may be areas in certain photos which have all the 

detail in the highlights "crushed" or totally burnt out, in which case the control will have no 

effect. 

The slider is initially positioned on the far right of the slider scale as it is assumed that 

you would always want to decrease the intensity.  

X-Process effect 

 

Cross processing simulates a photographic processing technique which historically used 

the 'wrong' chemicals to develop film - thus resulting in some dramatic contrast and 

saturation effects. Photo & Graphic Designer and other photo editing programs achieve 

this by manipulating the red, green and blue color channels. Use the slider to experiment.  

xprocess, crossprocess 

Blur/Sharpen 

 

This control blurs images if the slider is dragged to a value below 0, and sharpens 

images when dragged above 0. For sharpen it's recommended that only small values be 

used, and typically only on images that have been reduced in size a lot. You can enter 

blur values larger than the -100 maximum value available on the slider. E.g. entering -

400 will produce a very blurred image. 

Enhance photo colors 

 

Normally the ENHANCE controls will apply to the whole of a selected photo - but if you just 

want to make changes to a particular color within your photo then use the ENHANCE 

PHOTO COLORS option. You might want to change the color of the sky or tweak the 

brightness and contrast of a patch of grass for example. Additionally there is also the 

option to make a selected color transparent. 
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Just click on the SELECT COLORS TO ENHANCE button on the Enhance tool InfoBar to 

switch into Enhance Photo Colors mode. Now you can click on the part of the photo you 

want to adjust. 

 

Cross positioned over the color to be selected. 

The color at the click point determines the color that gets selected in the photo - you will 

see a brief flash of a chequerboard pattern on your photo, indicating how much of your 

photo has been selected.  

Also a red color point appears at your click point.  

 

Red color point at click point 

You can click-drag on this to move it around, if you didn’t quite hit the color you wanted to 

select. As you drag, the chequerboard pattern appears again and it updates dynamically 

as you do so, so you can see what parts of the photo have been selected. Or to review 

what you have selected, just click and hold over a point without dragging it to reveal the 

chequerboard pattern again.  
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If you haven’t selected all the colors you wanted, you can simply click again to add 

another selection point. So for example if you are trying to select all of the blue sky in 

your photo, there may be various different shades of blue in the sky and so you may 

need to click on several different parts of the sky to capture them all so that the 

chequerboard pattern covers the whole sky. You can do this as many times as you want, 

to extend the selection.  

 

Chequerboard pattern indicating color selections 

You may also find that you’ve selected parts of the photo you didn’t want to select. There 

are two ways to help solve this problem. You can adjust the extent of the color selection 

by adjusting fade and tolerance values, and/or you can use a region or mask to limit the 

area of the photo to which the color selection is applied. See sections below. 

Note that enhance photo colors mode is turned off automatically when you leave the 

Photo Tool or switch to another document. 

Applying Enhance 

Now choose any of the Enhance functions to alter the selection. 

 Brightness 

 Contrast 

 Photo saturation 

 Photo temperature 

 Hue 

 Sharpness 

 Brightness levels 

Or else to make the color selection transparent use the option on the right-click context 

menu. 

Even after you’ve started to enhance your color selection, you can still go back and 

modify the selection as described above, by moving points, adding more points, etc.  
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Context Menu 

If you move the mouse pointer over a color selection point and right-click the mouse 

button, a context menu appears with the following options. 

 DESELECT Deselect the current color selection so you can start a new color selection. 

You can also deselect by pressing the Esc key.  

DELETE COLOR 

SELECTION 

Delete the color selection to which the point you clicked on belongs. 

Therefore all the points that are part of the same color selection will 

disappear. 

DELETE THIS COLOR 

POINT 

Delete only the point you clicked on. Any other points in the same color 

selection remain. 

MAKE TRANSPARENT Makes the current color selection transparent. You can toggle on or off. 

.  

Resizing color points 

Selected color points are shown in red and have resize handles shown around them.  

 

Color points with resize handles 

Drag on the resize handles to change the size of the color point. This is useful if you 

need to be very accurate with your selection and you find that it’s difficult to place a color 

point over just the color that you want to select. Make the point smaller to make this 

easier.  

The color selected by a color point is the average color over the area it covers, so by 

using a smaller point size you can control this color more accurately.  

Enhancing different colors 

As described above, when you are trying to select a color in your photo you can click as 

many times as you want to keep extending the selection. Each point appears in red to 

show it is selected and is part of the same color selection. But what if you want to start 

selecting a different part of your photo so you can apply different enhance settings to 

that? For example, after adjusting the sky you may want to start work on another part of 

the picture.  
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To start a new color selection, you first need to deselect the first color selection you’ve 

been working on. Do this by right-clicking on one of the red color points and choosing 

"DESELECT" from the context menu, or just press the Escape key. Now you see the color 

selection points you’ve already added are shown in black instead of red. This shows you 

they are no longer selected.  

 

Now you can start clicking again on a different part of your photo and new red points 

appear. This is a new color selection and you can extend and adjust it just as you did for 

the first, then start enhancing it.  

So now you have two separate color selections. To modify or extend either of them, just 

click on one of the points. All the points in that color selection turn red to show that color 

selection is selected. Clicking on the photo will add more points to that current color 

selection and the enhance controls on the InfoBar show the current settings for that color 

selection.  
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So in summary, clicking on a photo to add new points will add them to the current color 

selection (whose points are shown in red) . To start a brand new color selection, first 

make sure you start with all existing points shown in black (not selected), by choosing 

DESELECT from the context menu. Then you can start adding the new color selection.   

Adjusting tolerance and fade 

 

Tolerance and Fade slider controls. 

You can adjust the extent to which colors are selected using the Tolerance and Fade 

controls. These are available from the button next to the Enhance Photo Colors button, 

but this only appears when you have ENHANCE PHOTO COLORS mode turned on. The 

Tolerance slider affects the range of a particular color selection - capturing a wider range 

of hues and tones of the selected color, whilst the  Fade slider controls the extent to 

which the selection bleeds into the adjacent areas.  

Tolerance: This value determines how colors are treated that are close to, but not the 

same as, the sample point color. If the tolerance is set to 0, only colors exactly matching 

the color at the sample point are selected. As the tolerance is increased, colors further 

and further away from the color of the sample point are also selected, just as if they 

matched the sample color exactly. 

Fade: This value determines how colors that fall just outside the color tolerance are 

treated. If fade is 0, then colors are either selected or not, depending on whether they fall 

inside or outside the tolerance. This can result in ‘hard edges’ since every color is either 

fully selected or not at all. So as this value is increased, colors outside the tolerance are 

partially selected, proportionally to how far outside the tolerance they are. This gives a 

softer color selection. 

Using masks or regions 

If you want to just enhance a particular area of your photo, first use one of the Photo 

Region tools to mark the region of the photo you want to modify. Or use a Mask tool to 

protect parts of the photo you don’t want modified.   

Then switch to the Enhance Tool and make your changes. The mask or region is used to 

limit the parts of the photo the enhance operation is applied to and afterwards you are left 

with a region inside the Photo Group. Whenever this region is selected inside the Photo 

Group, its outline is shown with "marching ants". To select such a region inside a Photo 

Group, Ctrl+click on it or select it from the Page and Layer gallery (on page 193) where it 

will appear as a Region within a Photo Group (on page 354). Looking at the Status line 

(on page 49) will also clearly show you when you have a region or mask selected inside 

a Photo Group. 
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Note that you should almost always apply feathering to a region inside a Photo Group, to 

soften its edges and blend the enhance effect seamlessly into the photo. Hard-edged 

regions are rarely useful. See the Feather tool (on page 138) for details. You can apply 

and adjust the feathering on the region inside the Photo Group once it’s selected inside, 

or you can apply feathering to the mask or region before you apply the enhance effect. 

 

Left photo in partial shadow, right photo enhanced with brightness and feathering to soften and 
blend the outline. 

If you want to make adjustments to the shape of a region inside a Photo Group then just 

switch back to a mask or region tool and make your changes ensuring that the region or 

mask is selected (shown with marching ants outline). Again, even while in the 

Region/Mask tools, you can select regions inside a Photo Group using Ctrl+click.    

 

If you want to be able to work on selected regions inside a Photo Group without 

seeing the marching ants outlines, you can temporarily turn off the outlines 

using the button on the InfoBar of the region and mask tools. 

The outlines are turned on again as soon as you clear the selection or move to a different 

photo or document.  

Easy crop 

While in the Enhance tool  you can drag on the adjustment handles shown around the 

edge of the selected photo to quickly adjust the cropping of the photo without needing to 

go into the Clip Tool. 

Clip Tool 

Alternatively you can enter CLIP TOOL by selecting the Clip icon on the PHOTO TOOL fly-

out bar. This provides a range of additional crop options. You can enter exact pixel 

values, and select from various crop aspect ratios 
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For interactive clipping and some more options regarding aspect ratio, enter the 

CLIP TOOL with the CLIP TOOL button.  

This alters the InfoBar to look like this: 

 

As you drag over the photo, the clip rectangle is highlighted. 

 You can adjust the region by dragging on the corner or side handles 

 You can push the region around by just dragging inside the clip region 

 Select the CLIP button or just double click inside the clip region to perform the clip 

operation. 

 

You can tell whether a photo has been clipped or not from the status bar which will 

describe it as a "clipped photo". 

Clear 

Press the "CLEAR" button, or just click outside the marked clip region to clear the current 

clip rectangle. 

Rule of Thirds 

There's a photography guideline that helps the composition of many photographs called 

the "rule of thirds". Put simply this involves placing key objects in your photos at thirds 

across your picture. For example it's often better to position the horizon one third of the 

way down a picture rather than being across the center. When you drag a clip region 

across your photos lines are displayed at thirds across and down the image to help 

position objects to follow these composition guidelines.  
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Tip: Search for "rule of thirds" on Google for more information.  

Un-clip 

Press the UN-CLIP button with any clipped photo selected, to restore the original photo. 

This restores the clip rectangle, which you can adjust or clear by clicking outside it. 

The UN-CLIP button in the CLIP TOOL will change the outline of any clipped photo, and 

also arbitrarily formed shapes with a bitmap fill, to that rectangular outline of the complete 

photo or bitmap used as the fill. You may have to select the Clear button to clear the crop 

rectangle (or click outside the rectangle). 

Adjusting the clip region 

Because the un-clip button restores the clip rectangle (showing the area outside faded), 

you can easily make fine adjustments to a clipped photo. Just select the photo, press the 

Un-clip button and adjust the sides of the clip rectangle as required. Double click inside 

the photo to clip it again. 

Width / Height 

After drawing a clip rectangle, you can enter values directly into the width and height 

fields on the InfoBar to set the clip rectangle dimensions to exact values. 

Lock Aspect 

Select the "LOCK ASPECT" check-box to constrain the clip rectangle to a specific aspect 

ratio as you drag. The radio buttons to the right of the check-box determine the aspect 

ratio used. Select "CURRENT" to maintain the aspect ratio to that of the photo before the 

clip. Note that the clip rectangle automatically changes between landscape and portrait 

orientation as you drag a corner of the rectangle.  So if you drag sideways it tends to 

create a clip in landscape orientation. If you drag downwards more, then it will create a 

clip region in portrait orientation. 

The common preset crop aspect ratios are available of 4:3 (most consumer digital 

cameras and old-style TVs and monitors), 3:2 (that of traditional film cameras and higher 

end SLR digital cameras), and 16:9 (aspect ratio of widescreen TVs). 

You can override the lock-aspect option by using "Ctrl" while dragging. So if you're 

dragging out a clip rectangle (or adjusting one) without aspect ratio lock, then holding 

"Ctrl" will lock the aspect to the last selected aspect ratio. Similarly if you have lock 

aspect option on then "Ctrl" will temporarily un-lock the aspect ratio. 

Clipping in Photo Documents 

In photo mode, there is a one-pixel grid applied to the photo (when at 96dpi, the default 

resolution) and the clip rectangle snaps to this grid. This makes it very easy to get pixel 

exact clipping. For highly accurate or exact pixel snapping, it's recommended to operate 

in photo mode and to zoom in so you can see the pixels clearly. 

See Photo documents (on page 391) for more information. 
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Photo Clone Tool 

 

This is a tool (on the Photo Tool fly-out) that rapidly and effectively erases 

objects from images. The CLONE TOOL allows you to either copy or ‘clone’ parts 

of a photo and replace the unwanted objects with the cloned area, effectively 

erasing the objects.  

You can either automatically clone parts of the same photo (by allowing  Photo 

& Graphic Designer to choose the most suitable area of the photo to clone) or 

manually (by choosing the area from the same or another photo yourself).  

1. In the CLONE TOOL draw a freehand line around the area you want to erase, which 

is shown as a 'marching ants' dotted outline surrounded by 8 resize handles. 

2. To automatically clone an area of the same photo to replace this selected area (or 

‘clone area’), click the MAGIC ERASE button in the CLONE TOOL InfoBar. 

3. Photo & Graphic Designer replaces the clone area with another part of the photo. 

Drag on the resize handles to increase or decrease the area you want to replace. If 

you move the mouse pointer over the clone area, the CLONE TOOL displays an ‘M’, 

indicating that you have used Magic erase (which disables the ability to drag on the 

clone area to choose another portion of photo – see step 5). 

4. If you don’t like this replacement, just click the MAGIC ERASE button again to see 

another replacement. You click the Undo button in the standard toolbar (or press 

"Ctrl + Z") to go back to the replacement you prefer. 

5. To manually clone an area of the same or another photo, in step 2 drag anywhere 

on the photo outside the clone area to pick the new source for the clone area, which 

updates to display the portion of the photo you have just dragged on. You can also 

now drag within the clone area to pick a new part of the photo. 

6. To accept the changes, click anywhere outside the photo in the Clone Tool or select 

another tool. 

Note that as you apply more clones, the new clones are made using the final image that 

you see on the page, not from the original image. This means once you erase a feature 

from your photo it won’t re-appear in subsequently created clone shapes. 

Clone Tool Infobar 
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  OUTLINES ON OR OFF 

With outlines on all clone shapes on the selected photo are shown with a dotted 

outline. The current or selected clone shape is shown with an animated 

'marching ants' outline, resize handles and an arrow pointing from the source 

point. 

 SIZE SLIDER 

This allows the clone shape to be enlarged or reduced. This is particularly useful 

if you use a larger feather value (which blends the edge of the clone shape 

inwards) in that you can compensate by enlarging the clone shape. 

 FREEHAND SMOOTHING 

After you've drawn your freehand clone shape, you can adjust the smoothness 

of the line. This is exactly equivalent to the Freehand tool smoothness control. 

This is only active immediately after you've drawn the clone shape. If you edit 

the clone outline using the other tools such as the Shape Editor, this control 

become disabled. 

 MAGIC ERASE 

Click this button to allow Photo & Graphic Designer to automatically select areas 

of the same photo to copy and clone into the clone shape. Continue to click to 

view all other possible automatic replacements.  

 FEATHER CONTROL 

This pop-up slider adjust the blending of the edges of the selected clone shape. 

It replicates the main feather tool. 

 

Clone Tool Operation Summary 

To erase a part of a photo, select the CLONE TOOL and draw around the area you want to 

erase. Then either: 

 Click the Magic erase button in the CLONE TOOL InfoBar to allow Photo & Graphic 

Designer to automatically select areas of the same photo to clone into the clone 

shape. 

 Drag outside this area on the same or another photo to set the source point for the 

copy.  

 

You can switch on or off visible outlines for the clone shapes with this icon on the 

CLONE TOOL InfoBar. 

 You can adjust the feather of the clone shape using the InfoBar’s feather control slider 

and the size of the clone shape by dragging on one of the resize handles. 

 A click on a clone shape will select it. The selected clone shape is shown with an 

animated dotted outline (assuming outlines are on using the above control), 8 resize 

handles and an arrow indicating the source point of the cloned area (if you chose it 

manually rather than clicking Magic erase). . 
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 You can push the contents of the selected clone by dragging on the clone shape (if 

you selected the copied/cloned area manually). This is an alternative method of 

adjusting the fill position or fill source point for manual cloning. 

 When setting the source point of a clone shape manually, if you drag over another the 

photo you can copy regions of one photo onto another. 

 Dragging on the 8 resize handles around the shape will enlarge or reduce the clone 

shape size 

 Dragging the feather slider control on the InfoBar, or the main feather control on the 

top bar, will adjust the edge blend. 

 You can delete a clone shape by selecting it and pressing the Delete key 

 The clone copy will always be made from the image you see on the page, including all 

previously applied clones and other edits already made to the image. 

 Clicking on the background photo will de-select all clone shapes so allowing you to 

draw a new clone shape if required. 

 Clone shapes are normal vector editable shapes, and once selected you can switch 

into any of the normal line or shape editing tool to make further adjustments of the 

outline. 

 A photo with clone edits, is stored as a new 'Photo Group' structure. This acts like a 

normal photo for many purposes (you can resize it, rotate it, enhance it etc, and it will 

act as a single photo object). But using 'select inside' (Ctrl+click) or using the Page & 

Layer Gallery to view the group structure, you can select and edit the individual clone 

objects within the Photo Group. 

Photo Heal tool 

 

Use the Photo Heal tool to instantly remove unwanted objects and artifacts from 

your photos.  

Select the tool and then choose a nib size from the InfoBar.  

See the Shape Painter tool (on page 94) for a more detailed explanation of nib size. 
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Simply position the nib over the over the area you want to heal and then click. Select 

larger areas by click-dragging over them and then releasing the mouse button to perform 

the erase. 

 

Just select the tool and click on any blemish - it's instantly removed.  

If you are not satisfied with the results then click the MAGIC ERASE button on the InfoBar 

to generate alternative results. You can compare different results by shuttling backwards 

and forwards using the UNDO/REDO buttons or else using Ctrl+Z/Ctrl+Y on the keyboard. 

The ‘patches’ created by the Heal Tool are compatible with the PHOTO CLONE TOOL (on 

page 410), so if you switch to the CLONE TOOL you will see all your patches shown with a 

dashed outline. So you can select and delete or re-generate (using the magic erase 

button) any of the patches.  

Effect Painter Tool 

 

The EFFECT PAINTER TOOL (on the Photo Tool flyout) provides an easy and intuitive way 

to retouch photos and images. You can apply photo enhancements to particular areas of 

a photo by painting directly onto the image using a nib. It’s based on the Shape Painter 

Tool (on page 94), so it shares a lot of the same controls such as those for choosing the 

size of the nib, smoothing the painted shape and softening (feathering).  

Selecting and applying an effect 

Choose the effect you want to apply from the list on the left of the InfoBar. For example 

the Desaturate effect will reduce the saturation (color) on the areas of the photo you paint 

onto. 
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Choose a nib size using the Size control. Note that by default, as in the SHAPE PAINTER 

TOOL, the on-screen nib size stays the same as you change the zoom, which makes it 

easy to zoom in and work on intricate parts of the photo without also having to change 

the nib size. However if you prefer you can switch to an absolute nib size by clicking the 

SIZE toggle button.  

 

Use the SOFTNESS control to give your strokes some feathering, so they blend into the 

photo, instead of having a hard edge (Softness = 0%). Start painting onto your photo to 

apply the effect. This creates a new region shape on top of your photo.  

Your stroke shape will be outlined with a "marching ants" effect to indicate that it is a 

current or active shape. Toggle the "ants" on or off using the shortcut "Ctrl + H" 

Adjusting painted effects 

After painting, the new effect region you created on top of your photo remains selected, 

so you can adjust it if required. You can adjust the strength of the effect by using the 

TRANSPARENCY slider and you can adjust the softness/feathering on the region using the 

feather (on page 138) slider on the top InfoBar. You can also carry on painting to extend 

the selected region, or hold down Shift and erase parts of the region. 

You can even switch into the PHOTO TOOL with the region still selected and adjust the 

brightness, contrast, etc. of your region. 

Back in the the EFFECT PAINTER, to paint a new region, first deselect the existing selected 

region. You can do this by just clicking away from the photo or by hitting Esc. Now when 

you paint you will create a new region, on the same or on a different photo, and it will 

have the same attributes as the last region you had selected. Or of course, just select a 

different effect in the Effect control.  

At any time you can select an existing region by Ctrl + Clicking on it. Once selected, you 

can modify it as described above and if you then deselect it and draw a new region the 

new region will have the same attributes. 
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Photo enhance, retouching, spot effects, photo effects  

The Red Eye Tool 

Select the RED EYE TOOL from the PHOTO TOOL flyout bar. 

 

The RED EYE TOOL allows you to quickly remove red eye effects from faces in 

your photos.   

 

Click the icon shown above to enter red eye mode. Then: 

 Zoom into the red eyes in your photo using the ZOOM TOOL (ON PAGE 52) OR JUST 

USING "CTRL + MOUSEWHEEL".  

 Click and drag from the centre of the red eye outwards, to drag a circular red eye 

patch. The red color is removed from the area within this circle. 
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 Repeat the above for each red eye in your photo. 

 

You can select any red eye patch you’ve applied to a photo by just clicking on it while in 

the RED EYE TOOL. Then you can hit the delete key to remove the selected red eye patch.  

 

Or go into the QUICKSHAPE TOOL and you can edit the selected red eye patch 

just as you edit normal ellipse shapes in your documents.  

Therefore if required you can make the red eye patches elliptical if that makes them fit 

the red eye area better. See the Quickshape tool section for information on using this tool 

to edit ellipses. However for most photos the default circular red eye patches are good 

enough for removing red eye effects. 

The edge of the red eye ellipse has a 3 pixel feather applied by default, so there is no 

hard edge to the area from which the red is removed. You can easily adjust this feather 

value by selecting the red eye ellipse (as above) and adjusting the feather value with the 

main feather control (on the right hand side of the top bar), in the same way that you edit 

the feather values of ordinary shapes. 

After applying the RED EYE TOOL the red eye patches are grouped with the photo inside a 

PHOTO GROUP. This is so that as you move the photo around in your document, or 

otherwise transform it, the red eye patches move with the photo. Note that this means if 

you want to select a red eye ellipse when you are not in the RED EYE TOOL, you need to 

hold "Ctrl" down while clicking on the ellipse (which is called a ‘select inside’ operation). 

See the Photo Handling chapter for information on Photo Groups (on page 354). 

Click the CLEAR ALL button on the RED EYE TOOL InfoBar to delete all red eye ellipses 

from the current selected photo. 
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Live Effects 

 

Live Effects are bitmap effects that can be applied to any object using Xara Picture Editor 

tools or Adobe® Photoshop® plug-ins.  

The LIVE EFFECTS TOOL is located on the PHOTO TOOL flyout. 

Browse through the list of available Live Effects by clicking the NEW button on the Live 

Effects InfoBar. 

 

 
Add a new Effect 

 
List of effects applied, in order 

 
Edit the selected effect 

 
Live effect resolution 

 
Delete current effect 

 
Lock/unlock all effects 

 
Delete all effects 

 
Configure to find plug-ins 

 

Applying a Live Effect 

To apply a Live Effect: 

 

1. Select the object or objects in the usual way. 

2. Select the LIVE EFFECTS Tool. 

3. Click the NEW button on the left side of the InfoBar. This displays a partitioned list of 

available effects in a menu. The first set of effects listed in the menu are PICTURE 

EDITOR effects. The second set are effects provided by the built in Xara Photo & 

Graphic Designer FEATHER (ON PAGE 138) and SHADOW (on page 320) Tools. The 

third set of effects are "New-style" Photoshop plug-in effects and the final set are 

"Old-style" Photoshop plug-in effects (see below for an explanation of these 

diFFERENT TYPES). 

4. Select the effect you want to apply from the list. 

5. This will display a dialog or tool that belongs to the effect. You can adjust the 

various controls and you usually get a small preview of the effect in the dialog. 

Click OK when you're done to return to Xara Photo & Graphic Designer. 
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Locked vs. Live Effects 

When using "old-style" Adobe Photoshop plug-ins (also known as "unscriptable" plug-

ins), the effect is locked in place once applied and editing of the underlying shape is not 

possible. We call these locked effects. To edit an object that has had a locked effect 

applied, it is first necessary to remove the effect, edit the shape, and then apply the effect 

again. 

All PICTURE EDITOR effects and "new-style" Photoshop effects (sometimes called 

"scriptable" effects) can be used as real Live Effects where the underlying object remains 

editable even after the effect is applied. 

Editing shapes 

If you apply a Live Effect to a shape or text, the object remains fully editable. Each time 

you edit it in any way, the Live Effect is automatically re-applied to the object. For locked 

effects this is not possible, and you must remove the effect using the DELETE button on 

the Live Effect InfoBar, edit the shape, and then re-apply the effect. 

Adobe Photoshop vs. Xara Picture Editor plug-ins 

The LIVE EFFECTS Tool supports two basic types of plug-in. Photoshop plug-ins (old-style 

and new-style) and XARA PICTURE EDITOR plug-ins. For example the ENHANCE effect is 

the same tool that appears in the XARA PICTURE EDITOR, but can now be used directly on 

any object in Xara Photo & Graphic Designer. One advantage of XPE plug-ins is that they 

usually operate directly and interactively on the Photo & Graphic Designer drawing and 

so there is no separate preview window required. So, for example, you can select the 

ENHANCE Live Effect and directly adjust the brightness of the selected object or objects. 

Locking effects 

When you resize or rotate an object which has a Live Effect applied, Photo & Graphic 

Designer takes this to be an edit and re-generates the effect. This may not be what you 

want, so it's useful sometimes to be able to lock an effect. 

Old-style Photoshop plug-ins are LOCKED as soon as you apply them. This means the 

underlying shape can't be edited. You can also lock a Live Effect and then when you 

resize or rotate the object the effect remains fixed, as if you were resizing/rotating a 

bitmap. 
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As an example of this, imagine a plug-in that always applies horizontal ripples (the 

"Television" Live Effect shown does something similar). Apply this effect to a shape, and 

you'd then see horizontal lines across it. If you then rotated the shape, would you want 

the ripples to rotate with it? If so, lock the effect before the rotation. Or would you want 

the horizontal ripple effect to be re-applied to your now rotated rectangle? If so, leave the 

effect unlocked. 

 

When a Live Effects is locked the effect rotates with the object (left).  

When giving designs to other people to load, if they do not have the plug-ins that are 

used in the design, then they won't see the effects applied. To get around this problem, 

you can lock the effects. Locked effects are saved as bitmaps in the document so 

anyone can see them, even if they don't have the plug-ins that generated the effects. 

 

To lock an effect, select the object or objects and in the LIVE EFFECTS InfoBar 

click the PADLOCK icon. To unlock an effect that has been locked this way, just 

click the PADLOCK icon again. 

You can still alter the resolution of the effect. For printing, you may want to use a higher 

resolution than if the work is just for screen use. 

Editing Live Effects 

The dropdown list shows the effects applied to the currently selected object in the order 

that they were applied. Select the effect you want from the dropdown list and click the 

EDIT button. This will bring up the controls for that effect-in the case of a Photoshop plug-

in this is usually a pop-up window that allows you to alter the appearance of the effect. 

How Live Effects work 

Because all these effects are bitmap effects, the object to which the Live Effect is applied 

is first rasterized (converted to a bitmap) and then passed to the plug-in, which applies 

the effect and returns a modified bitmap. You can control the resolution of the bitmap 

using the LIVE EFFECTS InfoBar control. 

Live Effect resolution 

For screen and web use it's best to leave the resolution at the default 96 DPI; the same 

as the screen resolution. If you require a higher resolution image, for example if you're 

printing or wanting to export a high-resolution bitmap, then you can increase this to 150 

DPI or even higher. The higher the resolution, the longer it takes to generate or re-



 

 420 The Photo Tools 
  

 

 

generate the effect (because it has to work with a much larger bitmap) and the more 

memory is required. 

You can set the resolution of a Live Effect to "Automatic", instead of choosing a fixed DPI 

value. With this setting, the effect will be automatically re-generated when required, at 

the most appropriate resolution. For example, if you print a design containing Live 

Effects, any effects set to AUTOMATIC will be re-generated at print resolution if they are 

not already at that resolution or higher. In a large design with many effects, note that this 

can make printing much slower as each effect has to be re-generated at high resolution. 

You can change the resolution that's used to render effects in THE EFFECTS & PLUG-INS 

tab of the OPTIONS dialog. For more on the Options dialog see Customizing Photo & 

Graphic Designer (on page 542). To change the resolution of an effect that has already 

been applied, use the DPI control on the LIVE EFFECTS toolbar. 

Saving and transferring files 

When you transfer a file to someone else, unless they have the same plug-ins installed 

on their computer, they will not see the effects (this is similar to the problem of fonts; the 

recipient needs to have all the fonts used in the design to see an accurate representation 

of the text in the document). In order to guarantee that recipients can see the effects in 

your design, lock them before saving. 

Because locked effects are saved in the design file as a bitmap, this means the files are 

much larger than for unlocked Live Effects. 

Document Info and Live Effects 

For more on Document Info, see Text Handling (on page 225). 

You can quickly see which effects have been used in a design by selecting "File -> 

Document Info". The dialog shown lists the effects used, just after the list of fonts used in 

the design. It will also indicate any of the effects used in the design that are not installed. 

These effects will be missing from the design unless they are locked. 

Adding more Live Effects 

Many Adobe Photoshop plug-ins will work with Xara Photo & Graphic Designer and with 

the XARA PICTURE EDITOR, and it's easy to add new ones.  Xara also intends to provide 

some new XARA PICTURE EDITOR plug-ins which will also work with Xara Photo & Graphic 

Designer. 

To add a new XARA PICTURE EDITOR plug-in, copy or install it under a folder of its own in 

the Xara Picture Editor\XPEplug-ins folder of your Xara Photo & Graphic Designer 

installation, e.g. C:\Program Files\Xara\Xtreme\Xara Picture Editor\XPEplug-ins\  Then 

restart Xara Photo & Graphic Designer and/or the XARA PICTURE EDITOR. 

To add new Photoshop plug-ins, you can copy or install them under the Xara Picture 

Editor\PSplug-ins folder of your Xara Photo & Graphic Designer installation. Alternatively, 

use the SETUP button in the LIVE EFFECTS Tool to add the location of the folder on your 
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computer that contains the plug-in files. Or add the plug-ins to a folder which is already 

listed in the SETUP dialog. You can access the same list of plug-in folder locations from 

the EFFECTS & PLUG-INS tab of the OPTIONS dialog ("Utilities -> Options"), or via the PS 

PLUG-INS Tool of the XARA PICTURE EDITOR. 

Check the Xara web site regularly for recommended plug-ins that work well with Xara 

Photo & Graphic Designer: (http://www.xara.com/products/Xtreme/plugins/) 

Copying Live Effects 

For more on Copy and Paste, see Object Handling (on page 124). 

You can copy Live Effects in your design from one object to another using PASTE 

ATTRIBUTES, just as you can copy other object attributes. Simply select the object with 

the effect(s) you want to copy and select "Edit -> Copy". Select the object or objects you 

want to copy the effects onto, and select "Edit -> Paste Attributes". 

Note that you cannot copy "old-style" Photoshop plug-in effects in this way because 

those effects do not have the ability to re-apply themselves. 

Content Aware Photo Resize 

Photo & Graphic Designer includes the ability to stretch photos using a new technique 

that retains the proportions of key aspects of the photo. 

The human eye is particularly sensitive to changes in aspect ratio of everyday objects, 

and most people can tell something is wrong with images that are even slightly squashed 

or stretched. 

 

 

Here is an example photo of the famous 
Torii Gate in Japan. Clearly the gate itself is 
the main subject of this picture. 

 

 

http://www.xara.com/products/Xtreme/plugins/
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Here the photo has 
been stretched using 
the normal stretching 
method of the 
SELECTOR TOOL. 
Even with this 
moderate stretching 
it's obvious the 
proportions of the 
gate have been 
badly distorted. 

 

Stretching using Content Aware Scaling. It still looks perfectly natural. The gate proportions are 
intact, even at this extreme stretch, which is twice as wide as the original.  The stretched 
coastline remains looking natural. 

Preparing Your Photo 

The content aware scaling feature is part of the PHOTO TOOLS.  

  

Select your photo and from the Photo Tool fly-out bar. Select the CONTENT 

AWARE SCALING BUTTON. The right end of the InfoBar will now show a set of 

buttons. 

 

Select a photo, go into the PHOTO TOOL, and the InfoBar should look like this; 

First click the PREPARE button to prepare the photo for the scaling. This starts an analysis 

of the photo to calculate which parts of the image can be stretched and which parts 

should be kept. This process can take some time depending on the resolution of the 

photo, and how many processors your computer has. 

For really high resolution images it's recommended that the image resolution be reduced 

if you do not require the maximum resolution. Do this before you select the Prepare 

buttons. To reduce the resolution of your photo select the OPTIMIZE button and enter a 
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pixel width or dpi resolution into the dialog. The image size on the page will not change, 

only the resolution or number of pixels inside the photo changes. 

Once you've prepared the image, new resize arrows will appear on the sides of the 

photo. Just drag on these to stretch or squash the image in the desired direction. 

Optimize 

Photos that have been prepared to enable Content Aware resizing have a lot of 

additional data stored alongside them, to enable further adjustments.  When you save a 

document this additional data is saved also, meaning that you can load such a document 

and continue to adjust the width or height without having to do a new Prepare operation. 

When you've finished scaling the photo you are recommended to 'fix' the changes by 

using the Optimize feature. This will convert the stretched image back to an embedded 

JPEG image, at any required resolution, and so make a substantial file size saving. 

Reset 

Clicking the 'Reset' button will restore the image back to its original state, removing any 

stretch, and removing any mask that might have been applied. 

Content-aware photo zoom 

An alternative to content aware scaling is the whereby the photo remains the same size 

and the content is intelligently zoomed inside it. Here's an example of the effect. 

 

 Use the zoom slider on the InfoBar to control content-aware 

photo zoom. 

The picture remains the same size, but the program automatically detects and scales 

(zooms) the 'interesting' content. Note this is not just a crop of the girl, but that every 

element, cloud, and grass that appears in the original is still there in the zoomed version. 

The program automatically detects the girl is the 'region of interest' and so enlarges her 

only. 

Using Masks With Content Aware Scaling 

Using the MASK PAINTER TOOL you can provide further control by protecting areas of the 

picture from being distorted.  Masked areas will not be distorted at all.  See the Masks 
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(on page 339) chapter to find out more about masks, but here's a brief summary of how 

to use masks with Content Aware Scaling. 

To protect one or more areas of the photo from being distorted; 

1. Select the MASK PAINTER TOOL from the Mask tool flyout bar and mark the 

part or parts of the photo you wish to protect.   

2. Now go into the CONTENT AWARE PHOTO RESIZE TOOL and click on the 

photo.   

Now when you use the PREPARE button this area will be protected from distortion. You 

may need to select the photo to enable the PREPARE button. 

Note: You can't mask more than half the image. The prepare operation will give an error 

if you try this. 

Adjusting a mask, or adding a new mask 

You can't add a mask to an image that has already been stretched. Instead, if you want 

to add a new mask or adjust an existing one, you have these options: 

1. Click the RESET button and draw a new mask 

2. Click undo as many times as necessary to get back the mask, and then use the 

mask painter tool to adjust the mask shapes. 

3. Or, before you select the PREPARE buttons, copy the mask to the clipboard. If you 

want to use this later, perform a RESET on the image, then re-enter the MASK 

PAINTER TOOL and paste the shape back onto the mask layer. 

There is another alternative that you can 'fix' a stretched image using the OPTIMIZE 

feature, and then apply a new mask. This is not recommended in most cases because it 

will produce lower quality results than resetting the image and applying a mask to the 

original image. 

Alternative Content Aware Scaling 

When stretching photos there are two alternative ways to scale the image. The method of 

just dragging the size arrows sometimes doesn't work so well with some image types. 

However by holding the "Alt" key when dragging one of the side handles in the CONTENT-

AWARE PHOTO RESIZE TOOL (on page 421) performs a different intelligent scale using an 

alternative algorithm. 

Content Aware Scaling notes 

 You can only compress an image to half its initial width or height 

 If you save a document with a photo that has been prepared for Content Aware 

resizing, then it saves the resizing information in the document. The advantage of this 

is that you can later re-adjust the photo using the Content Aware feature. There is a 

significant file size overhead of saving photos like this. 
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The Brightness Levels Dialog 

 

Click the Levels Tool icon on the Photo Tool fly-out bar. 

The LEVELS TOOL provides detailed control over the brightness levels of photos. It's a 

very powerful, multi-purpose tool that not only shows a histogram of the brightness levels 

of the photo, but provides a greater degree of control than the simple brightness or 

contrast controls. It can lighten shadows without affecting other parts of the picture. It can 

adjust the white balance of a picture and also the black and white points. 

 

 
Channel selector 

 
Auto (= Auto-Enhance in the ENHANCE TOOL) 

 
Reset 

 
Toggle curve 

 
Input levels and Brightness value (Gamma) 

 
Histogram 

 
Visual input levels and brightness adjust (black point, brightness, white point) 

 
Output levels 

 
Black/gray/white point picker 

 
Visual output level adjust 

The red histogram graph shows the distribution of brightness levels in the selected 

picture, ranging from the blackest shades on the left to lightest (white) shades on the 

right. The height of the red graph indicates the amount (i.e. the number of pixels) of each 
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shade used in the picture. Typically a correctly exposed photograph would show a 

spread of brightness levels across the range, dark to light, as in the above example. Here 

are some pictures and example histograms. 

 

1. The first image shows a good spread, from the darkest to lightest shades, with a 

predominance of mid-brightness shades.  

2. The second image is obviously very dark, and the histogram reflects this with peaks 

at the dark (left) end. 

3. The third image has peaks at the bright (right) end which are typical for images that 

have a bright sky. There is nothing wrong with this and the overall exposure is 

about right and you can see a good distribution of shades across the histogram. 

Adjusting brightness 

Dragging on the center gray triangle adjusts the brightness (technically this is altering the 

gamma). It does the exact same thing as the brightness slider on the InfoBar. 

The brightness slider alters the darker shades in a picture more than it does the lighter 

shades, so it is particularly good for revealing details in shadows. 

Selecting the black, gray and white points 

 

The three eye-dropper icons can be used to pick the black, gray or white points on the 

photo, and adjust the three controls for you automatically.  These tools have the 

advantage that they also adjust the white balance or color cast that your photo might 

have. 
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 Click and drag one of the icons from the levels dialog over your photo. As you do this 

you will see the photo change. Release the mouse buttons when you're happy with the 

change. 

So to set the black point automatically you'd drag the black eye-dropper over the blackest 

part of your photo.  Similarly, you'd drag the white eye-dropper over the whitest part of 

your image. 

Note: These are buttons which can be dragged - they do not work by selecting the button 

and then clicking again on the photo. Instead you must drag them over the photo. These 

are interactive, so as you drag the picture is changed. 

Color cast - fixing the white balance 

The middle of the three eye-droppers sets the gray point and this is mostly useful for 

altering the white balance of your photos.  You drag it from the LEVELS Dialog, like the 

others, but drag it over any point in the picture that is meant to be gray. In doing this the 

balance of colors is altered to try and make the item under the mouse pointer a pure 

shade of gray, and thus alters the color balance of the whole picture. 

If you have a photo taken with the wrong light setting, they will come out orange or blue. 

This control can help fix this, although in bad cases it will never be possible to make 

them perfect. 

Tip: If there are no gray objects in the picture, find anything that is meant to be white and 

look for an area that's in shade or less than bright white. 

Tip: If you have multiple pictures taken with the same color cast, you can copy the 

correction from one to another using the Copy / Paste Attributes feature. 

Here is an example, a snow scene, that is badly under-exposed, and with a strong blue 

cast. Its histogram on the right shows the white levels are poor. 
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By dragging the white eye-dropper from the Levels dialog over the whitest part of the 

image, it not only restores a better overall histogram, but also corrects the blue cast so 

that the white snow really is white. 

 

The corrected histogram now shows a much better balance (it's largely at the white end, 

but that's to be expected in a snow scene). 

Auto Levels 

The AUTO button will automatically adjust the white and black points to correspond to the 

lightest and darkest shades in the selected picture. This works better for some images 

than others (the above snow scene works perfectly, so in fact this can be corrected with 

a single click). 

Reset 

The "RESET" button will reset all levels parameters back to their starting values. The 

"COMPARE" button on the Photo Tool's InfoBar also does the same thing, but has the 

advantage that pressing it again restores the altered settings. 

Advanced Levels - The Green Line 

For the more advanced user, the levels control is really mapping the range of input 

brightness levels to an alternative set of output levels. Overlaid on the red histogram is a 

green line that represents the mapping function. 

 

The default straight line means no change, so dark shades are mapped to dark, and light 

to the same light shades. But as you alter the controls the green line is altered to reflect 
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the new mapping. So, for example, increasing the brightness or gamma control will 

change the line like this; 

 

You can see now that it's no longer a straight line mapping, and that the darker input 

shades will be mapped to corresponding lighter output shades. 

 

Using one of the low contrast examples above, this is the altered histogram, showing the 

before, after and altered green mapping function line. 

You can see the black and white points are moved inwards. This is reflected in the green 

line which shows that mid-shades are now mapped to dark, and the lightest white points 

(about 80% along the horizontal) are now mapped to white. Thus the narrow range of 

input shades is mapped to the full dark-to-light range of output shades. 

Joined RGB - or separate Red, Green and Blue 

When altering the overall brightness or contrast, this operation is performed equally 

across the RGB component colors that make up the full color image. In other words the 

color balance is not altered (all colors are affected equally), it just alters the overall 

brightness levels.  The dropdown menu at the top of the dialog shows "Joined RGB" to 

reflect this.  However, you can adjust the levels of each red, green or blue component 

(channel) separately, by selecting from the dropdown list. And each of these color 

components has its own set of controls that work independently of the "Joined RGB" 

controls.  By adjusting the curves of one color component only, say blue, you will affect 

the overall color balance. So this is a way in which you can manually add or remove 

more red, green or blue to any picture. 

Note that when you use the "Auto" button or drag the black, gray, or white eye-dropper 

pickers, these functions alter the separate RGB components, rather than the "joined 

RGB" controls. This is how they correct the color balance. The side-effect of this mean 

the joined RGB controls appear not to have changed. 
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Output Levels 

The two lower controls adjust the minimum (black) and maximum (white) final output 

levels. Adjusting these has the effect of reducing the contrast. 

Tip: It is usually recommended that for printing purposes the photos do not contain pure 

white, but instead have a maximum "whiteness" of around 90%, especially when printed 

in black and white. The histogram makes it easy to see if there is a lot of pure white 

(peaks at the far right end), and by adjusting the white output level slider you can easily 

control this. 

 

Dragging the "White output level" slider inwards slightly alters the green line: 

 

Meaning the maximum white value is brought down slightly. 

Brightness Curves 

In the Levels dialog you can create a manual brightness curve which provides very 

detailed control over brightness levels for any photos. 

To create a manual curve just click or drag on the histogram area, and you will see a 

control point added and a curve. 

Right click on a control point to delete it. Use the TOGGLE CURVE BUTTON  to 

temporarily disable the curve. 
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The Curves control is used in combination with the other Levels controls, such as the 

central gamma control, and the black and white input and output levels.  This means you 

can have both a manually entered curve, and still make general adjustments such as 

adjusting the gamma, or even the contrast on the main Photo Tool InfoBar. 

 

This example shows a manually entered curve with three control points. In this example the 
mid to dark shades have all be lifted (lightened), but the brighter shades of the photo (right 
side of the curve) have not been altered at all. 

The histogram graph shows both the original histogram (dark red) of the unmodified 

photo and the modified histogram (pale red overlaid) that is the result of the adjusted 

curve. 

Applying the same Levels correction to multiple images 

It's common that photographs taken together under the same conditions suffer from the 

same exposure or color cast problems.  It's easy in Xara Photo & Graphic Designer to 

copy any levels adjustment from one image to any other. Just copy the source image to 

the clipboard in the usual way ("Ctrl + C"), and then select "Edit -> Paste attributes" ("Ctrl 

+ Shift + A"). 

Levels Tool notes 

1. The LEVELS dialog works in conjunction with the BRIGHTNESS and CONTRAST 

SLIDERS. You can use both sets of controls together or separately. All will alter the 

overall brightness levels, and all changes are reflected in the histogram and green 

mapping line. 

2. The LEVELS dialog is non-modal, which means that while it's on screen you can 

continue to use Xara Photo & Graphic Designer as usual. It will update to show the 
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histogram levels of any photo selected, and will show blank if none, or multiple, 

photos are selected. 

Compare & Restoring the original 

The COMPARE button can be used to reset all the ENHANCE and LEVELS Tool values back 

to their defaults, returning your photo to its original state. Press the compare button a 

second time, your previous values are reinstated. Therefore you can use the compare 

button to quickly toggle between your edited photo and the original photo so you can see 

the effects of the changes you've made. 

Panorama Stitching 

 

Xara Photo & Graphic Designer includes a tool that can automatically stitch 

together up to 8 photographs into a single wide, high-resolution panorama.  

Creating high-quality panoramas can be a very complex and technical process, often 

requiring special equipment or lenses and accurately exposed and aligned photographs. 

The panoramic stitching feature built into Xara Photo & Graphic Designer requires none 

of these, and can use an every-day digital camera so that anyone can create outstanding 

quality panoramic images in a few minutes. 

This tool features: 

 Automatic estimation of the focal length to warp the images to reduce fisheye effects 

 Automatic barrel, pin cushion and vignette adjustments 

 Automatic exposure correction 

 Automatic detection of shared overlap points and seamless blending of joins 

 Automatic cropping of the final result. 

To create a panorama you need to take a series of separate photos from a central 

position. Ideally each photo would overlap the next by approximately 30%, although it will 

work with more or less overlap. 

The process of creating a panorama is very straightforward: 

1. Import each of the photos. There is no need to try and position the overlaps 

correctly 

2. Select all the photos you want to stitch together, they don't have to be in order. 

3. Click the PANORAMA button on the PHOTO TOOL fly-out bar. 
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It will start the process of stitching and continue as a background process. A popup 

status window shows the progress through the various stages, although you can 

continue using Xara Photo & Graphic Designer like normal while this happens. When the 

process is complete the resulting panorama image is imported onto the page.  Note that 

it does not replace the original images, which you can delete if you no longer require 

them. 

 

Three example photos of a landscape. Each overlaps the other (in this case a bit more than 
necessary). 

 

The resulting single panorama image, with seamless integration. 

Optimizing images 

Xara Photo & Graphic Designer will always stitch photos at the full resolution, even if you 

reduce the size of the image on the page. This is often a desirable thing since it produces 

the maximum quality, highest resolution results. But it does mean that the stitching 

process can take a few minutes. So sometimes you may prefer to reduce the resolution 

of the images before you stitch them together, especially if you only require a medium 

resolution final result, perhaps for the web. 

To reduce the resolution of any image, reduce its size on the page to the required size 

and then use the "UTILITIES" > "OPTIMIZE PHOTO" option. Note that the panorama stitcher 

works better with higher resolution images (it's easier for it to find matching points on the 

photos). 
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When you get the stitched image back, this is stored as a PNG image in Xara Photo & 

Graphic Designer. This is the highest quality, but takes a lot of memory and file space, 

especially if it's a high-resolution panorama. (The BITMAP GALLERY will show you how 

much). Therefore you can usually benefit from reducing the resolution of the final image 

and converting it to a JPEG instead. Again use the "UTILITIES" > "OPTIMIZE PHOTO" option 

for this. 

Notes: 

 The panorama stitcher expects the images to be the same resolution and size. 

 Try to avoid taking pictures with moving objects in. These can confuse the system 

since the same object might appear in different places, or not at all. 

 Try to keep the horizon at the same approximate position on each photo 

Hint: By taking photos in a portrait orientation, you can get maximum vertical coverage. 

Perspective Correction Tool 

 

This tool is available on the Photo Tool fly-out.  It's designed to be a simple one-

click way to automatically correct common perspective effects. 

 

The image on the left, taken inside a very large Roman Basilica, shows the common 

perspective effects of photos taken with a camera close to the ground.  To get a 'straight 

on' photo would require it to be taken from a height of probably 30 feet. The perspective 

correction tool can create a similar effect automatically (right example). 

Simply select the photo, and then the Perspective Correction tool.  The process can take 

some time, depending on the resolution of the image. 

Tip:  The resulting corrected photo is in a raw BMP format which can take a lot of 

memory and so you are recommended to optimize your photo to be a JPEG format to 

reduce the memory and file size. Select the menu UTILITIES -> OPTIMIZE PHOTO... 



 

The Photo Tools 435  
 
 

 

Advanced users:  This utility provides no user interface or controls.  However there is a 

stand-alone program called ShiftN that does provide more control over the perspective 

correction parameters.  This is program available from inside the installed files folder of 

Designer (e.g. C:\Program Files\Xara\ShiftN) 

EXIF Tool 

 

With the EXIF button in the Photo Tool fly-out bar you open the EXIF dialog. This 

dialog shows the embedded EXIF values of a JPEG photo. 

 

  

This dialog is mostly transparent (so it doesn't 

get in the way too much). By clicking the small 

down arrow on its title bar you can configure 

which actual EXIF values are shown and how 

transparent the dialog is. 

EXIF data is now preserved on export of JPEG 

photos and across an Optimize Photo 

operation. 

 

Color palette from photo 

 

The COLOR PALETTE FROM PHOTO tool can analyze a photo, identify the most 

predominant colors in the image, and create a color palette of those colors. It adds or 

updates the theme colors in the current document accordingly. This makes it easy to 

match the colors in a document to those of any photo. 

Simply select the photo you want to use to set the document colors, then click the icon 

on the PHOTO TOOL flyout bar. 
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The pages below have been designed to use the standard Xara theme colors that work 

with the PALETTE FROM PHOTO feature. Each of the 3 versions of the page has had the 

photo changed and then PALETTE FROM PHOTO invoked to update the document’s colors 

to match those of the photo. In all other respects these 3 designs are identical. 

 

Photo & Graphic Designer instantly analyzes the photo and chooses up to 5 of the most 

predominant, but independent colors (very similar shades of the same color are 

considered as a single color). It uses these to set the values of the named colors THEME 

COLOR 1 to THEME COLOR 5. If these colors are already in your document, as they 

probably will be if you used a Xara template, they are updated. Otherwise they are added 

and you will see them appear at the bottom left of your color line.  

If the graphical objects that make up your document don’t use these standard Xara 

theme colors, then you won’t see those objects change color. So make sure your 

document uses the standard theme colors, and shades of those colors, to make your 

document easy to re-color. When there are limited numbers of significant colors in the 

image, the program uses shades of gray for the lower theme colors. 

 

The 5 theme colors for each of the 3 examples above - together with their lighter and darker 
linked colors. 
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Using Theme colors  

It’s always good design practice to limit the number of different colors within a document. 

But the use of shades of your predominant color is to be encouraged. To help make the 

use of lighter and darker shades, the program creates two linked paler, and two darker 

shades of each of the THEME COLOR 1 to 5 colors. You can see in the above examples 

the use of brighter and darker shades of THEME COLOR 1 and 2. 

The color analysis is based on an algorithm that determines the predominant colors 

based on their brightness, and coverage area. It automatically combines similar shades. 

For example, a blue sky typically contains many lighter and darker shades of the same 

blue hue. So this would be created as a single blue color. It also adjusts the brightness of 

THEME COLOR 1 and 2 (the two most predominant colors) so it always provides a good 

contrast against a white page background.  

This means you can always use THEME COLOR 1 as a heading color, for example, and it 

will be readable. Or, alternatively you can place white text on THEME COLOR 1 or 2, 

perhaps a colored rectangle of THEME COLOR 1 or 2, and that text will also always be 

readable. 

See Theme colors for more info on the color schemes. 

Text Color 

Another common technique designers use, is to link the main text color to the 

predominant theme color, although obviously this needs to be dark enough to provide 

enough contrast to be legible. Therefore Photo & Graphic Designer also creates a named 

color call TEXT that could be used for the body text of your document. 

Extracting Colors from Logos 

This feature also works with any image - including transparent PNGs so, for example, if 

you add a company logo graphic to your page that includes your brand colors, you can 

automatically set the Theme Colors to match those used in your company logo. 

Customizing  

You can customize The named colors the usual way. Right click on the color patch on 

the color line, and select EDIT.  

Photo Tool Notes 

1. You can select different photos while using the PHOTO TOOLS by just clicking on 

them. This also works for photos inside groups. 

2. If you click and drag, while in the ENHANCE TOOL, it will start a crop on the photo that 

you started dragging on. Or, if you start dragging on the background, the crop will 

be applied to the first photo you touch during the drag. 

3. The UN-CLIP button in the CLIP TOOL will change the outline of any clipped photo, 

and also arbitrarily formed shapes with a bitmap fill, to that rectangular outline of the 

complete photo or bitmap used as the fill. You may have to select the Clear button 

to clear the crop rectangle (or click outside the rectangle). 
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4. All photo operations can be fully undone. Unlike traditional photo or pixel editors, 

the original photo is never altered until or unless you optimize the photo to make the 

changes permanent. So this means you can make as many changes as you like, as 

often as you like, and save and load .xar/.web files as often as you like, and there is 

no degradation of the image (all edit operations are non-destructive and loss-less) 

and give no increase in file size. 

5. All the PHOTO TOOL options, including the levels control, operate on bitmap filled 

objects, as well as stand-alone photos. 

6. Opening a photo with Xara Photo & Graphic Designer (using "FILE" > "OPEN") opens 

it as a Photo Document. After editing it, you can overwrite your photo file by just 

doing a "FILE" > "SAVE" ("Ctrl + S"). A .web or .xar file is also saved into a Masters 

folder alongside your modified photo, preserving your original photo and edits. See 

the Photo Handling chapter for more details. 
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Eraser tool 

Using the Eraser Tool 

 

The ERASER TOOL is used to erase parts of anything from photos to vector shapes. It 

provides a ‘hard erase’ which will permanently ‘cut’ shapes and photos, or it can be used 

with a ‘soft’ setting that is non-destructive and produces soft edges. There’s also a 

powerful facility for intelligently erasing the background from a photo, which makes it 

easy to cut objects out of a photo where there is a good contrast between foreground 

and background.  

.  

The InfoBar for this tool provides controls over NIB SIZE, the ROUNDNESS, NIB ANGLE and the 
SOFTNESS, as well as a smoothness control which adjusts how accurately the nib follows your 
mouse movement (this is exactly like the FREEHAND tool smoothness control).  

Nib size 

 

Control the nib size by dragging the slider. Use the Size button to control whether the nib 

size zooms in when you zoom into the page or stays the same size. If you keep the nib 

size the same then it effectively becomes smaller relative to the objects on the page 

allowing you to erase smaller details. 

You can also conveniently adjust the nib size by holding down the Alt key and using the 

mouse wheel.  

Erasing backgrounds 

This feature is particularly good for removing or changing the background behind 

complex shapes such as fur, hair, trees etc, that would be tedious, or impossible to mask 

manually. You only need to indicate the approximate areas to erase (with the ERASER 

TOOL) and the areas to protect (with the MASK PAINTER TOOL), and then click the ‘ERASE 

BACKGROUND’ button. 
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1. Use the ERASER TOOL to roughly paint over the parts of the picture you want to 

erase (the background).  

2. Select the Mask Painter Tool and paint over some of the parts of the 

foreground you want to keep.  

3. Select the ERASER TOOL again and then click on ERASE BACKGROUND on the 

top InfoBar.  

 

If the foreground is all a similar color you only need to cover part of it with the mask. If the 

foreground has differing colors, then paint the mask over each of the differing color 

areas. Use zoom (Ctrl+mouse wheel) to mask more or less detail and try not to mask 

over any background color or regions.  

If you make a mistake hold Shift to un-paint the mask. If you aren't happy with the results 

you can UNDO (Ctrl+Z) and change the mask, or the erased parts, and try again. In this 

way you can gradually improve the result by undoing, adjusting the mask and erased 

parts of the image then pressing Erase Background again. To improve the results for a 

particular part of an image, make the masked and erased areas more accurately indicate 

the foreground and background in that part of the image, to improve the result in that 

area. There is also a handy ? button on the top InfoBar which you can click to show a 

step by step guide for this feature. 

 

This image has a white 

background which you 

want to remove. 

 

Use the MASK PAINTER tool 

to indicate the part of the 

image to you want to 

protect (pink area). 

Then use the ERASER TOOL 

to roughly mark the area 

you want to remove (white 

area).  
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Click on the ERASE 

BACKGROUND button on the 

Eraser tool InfoBar and the 

white area disappears. 

 

 
ff 

Soft erase 

If you adjust the Softness slider to be non-zero, this tool now becomes a soft eraser, and 

strokes over any object (which can be any shape, text or photo) will erase, that is make 

transparent, the stroked area. The softness control adjusts how hard or soft the edge of 

the nib stroke is. 

Note: You can use the erase tool over any object, including text, blends or 3D extrudes. 

 

 

Softness set to 0% - hard erase permanently 
changing the shape/photo outline. 

Softness set to 50% - soft erase. 
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Shape editing 

Set the softness setting to 0 (the default) to erase with a hard edge. This cuts shapes 

and photos, permanently changing their outlines. It’s a fast and direct way of adjusting 

the vector outline of a shape inwards. If you stroke around the edge of a shape with your 

mouse, it just moves the outline inwards.  

First select the shape you want to erase by clicking on it, then hold the left mouse button 

down and stroke over the shape to erase. Clicking on the backdrop will clear the 

selection. 

If you erase a shape so as to fragment it into separate pieces, it will still remain as a 

single selectable shape. 

If you click and hold (i.e. not perform a stroke), it will simply cut a hole in the object in the 

shape of the nib. 

Non-destructive editing 

It’s important to understand that, as with most features in Photo & Graphic Designer, the 

soft erase feature is not destructive, that is it doesn’t change the underlying erased 

shape or photo at all.It’s also important to realise the soft erase feature is resolution 

independent. The ‘softness’ value is a mathematical vector value, and the nib strokes are 

fully editable vector paths. You can select, adjust or remove any earlier stroke, and for 

advanced users the full vector structure can be seen in the Page & Layer Gallery (on 

page 193). 
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3D Extrude Tool 

Introduction 

The EXTRUDE TOOL provides a fast and easy way of turning 2D drawn shapes and text 

into high quality 3D "extruded" versions, with colored light illumination and very high 

quality shading. It is based on the technology used in the Xara 3D stand-alone program. 

On-screen dragging allows real-time 3D object rotation, dragging of the extrude depth, 

and adjustment of three lights in 3D space around the object. 

 

The InfoBar provides control over the bevel type drawn down the extruded length. You 

can chose from more than 25 different types of bevel. 

 

Extruding a shape 

 

To turn a 2D shape into a 3D extruded object, go into the EXTRUDE TOOL on 

the main toolbar and simply click and drag on your object to rotate it in 3D 

space. 

Initially, your extrusion is given a default depth. The face color of the 3D shape is 

determined by the fill color of the original shape and the color of the extrude (or side) by 
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its line color. After creating an extrude in this way, move your mouse pointer around over 

the 3D object. You'll see that the mouse pointer changes as follows to indicate what will 

happen if you click and drag at any point: 

 

This is shown when the mouse pointer is over the front or back face of the 

object. Clicking and dragging rotates the object in 3D space. 

 

This is shown when the mouse pointer is over the extrusion (the side) of the 

object. Clicking and dragging changes the depth of the extrusion. 

 

This is shown when the mouse pointer is over the extrusion and "Ctrl" is held. 

Clicking and dragging changes the bevel size (see below) 

You can also rotate an extrusion by holding down the Alt key while dragging on the 

extruded side. This is useful when only the side of an extrude is visible and so you aren’t 

able to drag on the face in order to rotate it. As when dragging on the front face, Ctrl and 

Shift can also be used to constrain the rotation. 

Extrude Tool InfoBar 

 

 
Extrude on/off 

 
Slider type list 

 
Slider and numeric value for selected parameter 

 
Bevel type 

 
Bevel size slider and value 

 
Lights on/off 

 
Gloss/matt 

 
Rounded/mitred corner 

You can adjust a 3D extruded object by manipulating it directly on the page as described 

above, or by selecting it and using the controls on the InfoBar of the Extrude Tool. 

Turning extrudes on and off 

 

EXTRUDE ON/OFF 

Once a shape or other object has been extruded, there are only limited modifications that 

can be made to the original object with the extrusion in place. For example, if you've 

extruded a shape, it's not possible to then edit that shape in the SHAPE TOOL (on page 

169) because it's no longer a simple 2D shape that you can interact with. However, using 

this control you can temporarily turn the extrusion off, so that you can see and modify the 

underlying object using other tools, before turning the extrude on again. After making a 
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modification and turning the extrusion on again the extrusion is re-applied to your 

modified 2D object, with all the same 3D attributes that it had when you turned off the 

extrude. 

Note that in some cases if you dramatically change the form of the object while the 

extrusion is turned off (such as changing it to a completely different type of object), the 

3D extrude attributes you applied may not be preserved. In such cases you should be 

able to use PASTE FORMAT/ATTRIBUTES to copy the attributes from a copy of your original 

extrude before the modification. See Copying styles: Paste attributes (on page 153). 

Extrusion depth 

The easiest way to adjust the depth of an extrusion is to simply click and drag on it, as 

described above. However, you can also use the slider on the left of the EXTRUDE TOOL 

InfoBar to adjust it. Make sure that EXTRUDE DEPTH is selected in the dropdown list to the 

left of the slider (this is the default setting) and then use the slider to adjust the extrude 

depth. The current extrude depth is shown in a numeric field to the right of the slider, and 

you can also enter extrude depth values directly into that field to set an exact extrude 

depth. 

Bevel Type & Size 

The bevel type determines the profile of the extruded side of your 3D shape and of its 

edges and corners. By default it's set to rounded which gives a flat side with rounded 

corners. The bevel type dropdown list contains a large selection of different bevel types 

you can choose from. You can adjust the size of the bevel using the slider to the right of 

the bevel type list. To the right of the bevel size slider is a numeric field showing the 

current bevel size and you can enter exact bevel sizes into this field.  

An alternative shortcut to adjust the bevel size is to drag on the side of the 3D object 

holding "Ctrl" (while in the EXTRUDE TOOL). 

Lights 

 

LIGHTS ON/OFF 

You can adjust the lighting of your shape in 3D space by turning on the lights. There are 

3 lights, each of which can be given their own color and position in 3D space around the 

3D shape. 
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In this example the face color of 

the shape is set to white. But you 

can see that it appears green 

because there is a green light 

shining almost directly onto the 

front face of the shape. 

By adjusting the colors of the face 

and extrude and the positions and 

colors of the three lights, you can 

enhance the realism of the 3D 

objects in your design.  

Behind the object is a beige / orange colored light and another that is a purple color. Both 

lights cause reflections down the side, and changing the color, or direction of the lights 

behind will change the reflected highlights. 

To move a light around the 3D object, simply drag on the light arrow. If you happen to 

drop a light so that it is behind the 3D object and therefore isn't selectable, you can 

retrieve it by using the left slider on the Extrude InfoBar. Select one of the light angles 

from the dropdown list to the left of the slider (e.g. "Light 2 Angle 1") and then adjust the 

slider. The light moves around the 3D object in your design. The various "light angle" 

options in this dropdown list allow you to move any of the lights in any direction in 3D 

space to achieve the positions you want. However for most purposes you can achieve 

good results most easily by dragging the light arrows directly on the page. 

To change the colors of the lights, you can simply drag colors from the color bar and drop 

them directly onto the light arrows. To edit a light color with the color editor, double click 

on the light arrow you want to change and the color editor opens with that light color 

selected. You can now edit the light's color. With the color editor open, as you click on 

the different light arrows, extrude face and extrude sides, the color selected in the color 

editor dropdown list changes to match your selection, so you can quickly select the 

different colors on your extrude to modify them. 

Gloss / Matt 

 

Use this toggle button to make the surface of a 3D object more or less 

reflective. With the gloss option on lights placed at the correct position behind 

the object will "bounce off" the sides to good effect. 

 

Mitred corner / Rounded corner 

 
You can choose either MITRED or ROUNDED corners for your 3D object. 

"Mitre" gives square edges, while "Round" produces rounded edges. 
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Textures & Photos 

When you extrude a photo, the photo remains on the front face of your 3D object. 

Therefore, you can produce impressive 3D photo effects in seconds by simply importing 

a photo and extruding it. 

 

This effect is created by extruding a photo, rotating it slightly , creating a reflected copy using 
the SELECTOR TOOL, and the 3D angle adjusted to match. It's then given a graduated 
transparency to create the faded reflection. 

You can use any photo or texture on the face of your extrude. Either import your image 

and extrude it as described above, or drag and drop an image onto the face of an 

existing extrude with "Shift" held down. This applies your photo or texture to the face of 

the extrude object. 
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Extruding Text 

Extrude text the same way that you extrude any shape; just click and drag on the text 

while using the EXTRUDE TOOL. As you would expect, doing this on more than a few 

words can be rather slow and is not recommended. 

 

Because text is usually black, unless you change the color the extruded result will also 

be entirely black, so making it difficult to see. So it's recommended that you change the 

color of the text before you extrude it (although you can change this after by just clicking 

on a color). 

As with other extruded objects, if you want to edit the text, just turn off the extrude using 

the button on the left of the Extrude InfoBar, edit the text, and then switch the extrude 

back on again with the same button. 

Copying 3D extrude attributes 

You can copy and paste the style of the 3D extrusion, from one 3D object to any other. 

This works the same way as for all Photo & Graphic Designer attributes. Simply copy the 

source extruded object to the clipboard, and then select a new one and select "EDIT" > 

"PASTE FORMAT/ ATTRIBUTES".  Note this will only paste the 3D attributes onto another 3D 

extruded objects. So you will have to extrude any shape first before pasting the 3D 

attributes. 

This will copy all the 3D attributes such as the extrude depth, light colors, bevel type as 

well as the face and outline colors. 
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Putting shadows behind 

Using the SHADOW TOOL you can enhance the 3D effect by placing a soft shadow behind 

the object. Simply apply the SHADOW TOOL and drag on the 3D object. 

 

The left example is using a wall shadow, the right us using a floor shadow. 
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Web Graphics 

Creating Buttons, Banners And Other Web Graphics 

Photo & Graphic Designer is great tool for creating any standalone web graphics for use 

with other programs or other web authoring tools. You can draw these objects from 

scratch using the drawing tools, or use ready made web clipart from the Designs Gallery. 

Just draw, design or import an item from the Designs Gallery onto a blank page. 

Manipulate this as required - size it, color it and change the text or fonts as required, and 

then export the item as a PNG or JPG. 

For example this is how to create a standalone button graphic from a template: 

Open the DESIGNS GALLERY and then the Web Templates - Buttons category.  
 

Double click on a design to open this in a new document. Edit this as required e.g. you 

can: 

 Resize it (or rotate) it using the SELECTOR TOOL 

 Change the color by clicking on the appropriate colors on the left end of the Color Line 

and choosing 'edit' 

 Change the text with the TEXT TOOL 

When you're happy, select the object and export it as a PNG or 

JPG using the  buttons in the Website bar (these are on a flyout 

bar on the Export HTML icon). 
 



 

Web Graphics 451  
 
 

 

For almost all graphics, such as buttons, headings, icons and other non-photographic 

objects you should use PNG format. For items that contain photos or that have large 

textured parts made from photos, then JPEG is a better format. If you're saving a rotated 

photo, or one with a soft shadow, or soft edge, then this should be in a PNG format, but 

be warned this will be a lot larger file than JPEG. 

 

In the settings dialog when exporting you can compare side-by-side 

two different versions of the same image. For example you can compare a JPEG against 

a PNG version of the same graphic to compare the quality and / or file size, or you can 

compare two differently optimized PNG images. Refer to the reference chapter on the 

Export dialog (on page 534). The in the above example the JPEG compression is being 

adjusted to produce the optimum file size. 

Stretchy Objects 

Many of the graphic objects, such as 'stretch buttons' and text panels, can automatically 

adjust their size depending on the size or length of text. Most template sets, and all of the 

buttons in the "COMPONENTS" > "PRINT AND WEB COMPONENTS" > "BUTTONS" folder in the 

ONLINE CONTENT CATALOG, have both fixed width and stretchy versions. It's 

recommended that if building a set of navigation buttons (typically either a horizontal or 

vertical collection of links or buttons) that you use fixed width so they are all the same 

size. 
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Similarly many of the side or text panels in the templates, and sometimes the main text area, 
can also adjust their vertical, and sometimes their horizontal size. In the case of text panels 
you can adjust the width of the column in the TEXT TOOL by dragging on the left or right end of 
the column indicator. 

 

Note: You can create new stretching components using Xara Designer Pro. 

Text Panels 

Just as some Design Gallery buttons stretch to accommodate the text, so some text 

panels can adapt to the width or length of text entered into them. 

 

The panel background changes to accommodate longer or wider blocks of text.  
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You can adjust the width of a text column by going into the Text tool and dragging the 

column width handles (under the first line of text). Most of the Design Gallery templates 

provide a few text panels in keeping with the theme. Some text panels will only stretch 

vertically, others will stretch vertically and horizontally. 

To create your own stretching button or text panel, use one of the existing ones from the 

Design Gallery and adapt this by re-coloring the background or adjusting text color / size 

/ width. 

Note: You can create new stretching components using Xara Photo & Graphic Designer. 

See the Document Handling (on page 86) chapter for details. 

Photo Resolution - It's All Automatic! 

When importing high resolution photos (anything above 1920 pixels either wide or high) 

into a web document, Xara Photo & Graphic Designer automatically resizes the photo 

down to HD screen size without asking you if you want to import a lower resolution 

version. For a web document, even at the reduced size, there should be more than 

enough resolution in your photos for high quality results on your website, so it’s rarely 

necessary to import digital camera images at full resolution for web use. 

However, if you are importing a large photo into a print or animation document, Xara 

Photo & Graphic Designer asks you if you want to import a lower resolution version of 

your photos. If your document is to include many photos, you may want to choose this 

reduced resolution option. Otherwise with large photos you may find that your saved 

design file is much bigger than it needs to be (because it contains a copy of each of your 

photos) and you may not have enough memory in your computer to load, edit and export 

your documents. 

If you’re not sure whether you will need the full resolution photo you can import the 

original photo and then optimize it down later. To optimize a photo, right click on it and 

choose the OPTIMIZE option from the context menu. Or you can optimize all the images in 

your document at once, using "UTILITIES" > "OPTIMIZE ALL IMAGES". 

Photo & Graphic Designer always stores the original imported image (or the reduced size 

version if it's reduced on import as mentioned above). This means you can resize or crop 

your image as required with no loss of quality. Photo & Graphic Designer automatically 

converts all photos into the correct resolution JPEG image when saving your website. 

You do not need to bother about dpi, image size, pixels or anything like that. What you 

see in Photo & Graphic Designer (at 100% zoom) is exactly what will be produced on 

your web page. 

If you want to size a photo, or any object, to a specific size, just enter the required size 

into the SELECTOR TOOL InfoBar width or height fields. 

When you drop a photo on the page (assuming you're not replacing an existing photo), 

it's sized to be 500 pixels wide. But if you want this to be exactly 200 pixels wide, just 
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enter 200pix into the W size field of the SELECTOR TOOL. You can enter it in any unit e.g. 

entering 2in will make it 2 inches wide. 

Working with Templates 

Using the templates available in the Online Content Catalog is the quickest and easiest 

way to create high quality designs. 

To load a template, open the Content Catalog and double click on a template thumbnail 

in one of the design categories. Once loaded, you can customize the template to produce 

your own personalized high-quality design. Typically you’ll want to replace any photos 

with your own, enter your own text and perhaps change the color scheme, all of which is 

trivial in Xara Photo & Graphic Designer. This chapter describes how to do these 

customizations easily. 

Replacing photos 

To replace a photo simply drag your own image file (JPEG, GIF, PNG, BMP) from your 

Windows File Explorer and drop it on top of the picture that you want to replace. Your 

photo will automatically be scaled appropriately to replace the template photo. The new 

photo will be selected together with the smartphoto adjustment handles (on page 382) 

enabling you to easily adjust the position and scale of your photo if desired (see below). 

Alternatively you can load your photos into the current design using "FILE" > "IMPORT". 

This adds a new photo object to your design and also adds it into the BITMAP GALLERY 

(on page 364). Remove the new photo from the page by selecting it and pressing 

"Delete". Then drag your photo from the BITMAP GALLERY and drop it onto a template 

photo to replace it, as described above. 

There is also the option of importing stock photos from the Online Content Catalog. You 

can either browse the catalog from the File menu. "FILE" > "NEW FROM CONTENT 

CATALOG". Or you can replace a photo by right-clicking it, and then choosing  "REPLACE 

PHOTO" > "WITH STOCK PHOTO" from the context menu. 

By default when you replace a photo, any other copies of that photo on the current page 

are also replaced. This is usually what you will want, because some templates have 

multiple copies of the same photo which need to be replaced, including some on hidden 

layers. E.g. perhaps a large version of a photo and a thumbnail version of the same 

photo. However if you want more control over the photo replacement, hold down CTRL 

while dropping your photo and then you’ll be asked which instances of the photo you 

want to replace. 

Note: Normally you should not replace photos by first deleting the template photo as this 

will also delete the shape that holds the photo, which determines its size. If you have 

deleted a photo in this way, use the Undo function ("Ctrl + Z") to restore it and replace 

the image as described above instead.. 
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Adjusting a photo in its frame 

You’ll often want to adjust the position, scale and rotation of a photo in its frame. Select 

the photo - you will see the smartphoto adjustment handles appear allowing you to rotate 

and scale the picture, move it within it's outline frame, resize the frame and even round 

its frame edges. 

Editing photos 

The easiest and most convenient way to edit photos in your design is to use the built-in 

PHOTO TOOLS. These can be found on the Photo Tools fly-out bar on the main toolbar. 

 

Use the Photo Enhance Tool to perform the most common adjustments to your photo, 

such as adjusting brightness, contrast and saturation. You can also crop photos while in 

this tool by just dragging on the photo. Or go into the dedicated Clip Tool for more 

clipping options. The Clone Tool is useful for removing unwanted parts of an image non-

destructively, by copying one part of a photo to another. There are also tools for 

intelligently resizing an image, removing red eye effects, making panoramas, correcting 

perspective  and other photo editing functions. 

See the Photo Tool chapter (on page 397) for full details. 

Changing text 

 

Double click on the text you want to edit to go into the TEXT TOOL, or just click the 

TEXT TOOL icon on the main Toolbar. 

You can drag over the text to select it and then type to replace it, just as in a Word 

Processor.  

To change the font, drag select the region of text to be changed and select from the font 

dropdown menu on the InfoBar 

You can add new passages of text to the design by just clicking and typing, or, to create 

a block of text with a set width and height, click and drag diagonally on the page while in 

the TEXT TOOL and then enter your text into the text frame that appears. You can easily 

make a passage of text automatically flow around photos and other objects on your 

page. All you have to do is right click on an object and choose “REPELLING & ANCHORING” 

to make that object repel text that is underneath it. See the Repelling Text section (on 

page 259) of the TEXT TOOL help for details. 

Or you can anchor an object to a particular point in text, so that the object follows the text 

as the anchor point moves. Right click on it and choose ANCHOR TO TEXT. After 

anchoring, move the object to where you want it relative to the text, using the SELECTOR 
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TOOL. Now as you edit the text and the anchor point moves, the anchored object moves 

too. See the Text Tool chapter (on page 262) for more details. 

Changing colors 

Editing theme colors individually 

To edit a template’s theme colors, right click on one of the larger square named color 

patches on the left of the Color Line (on page 206) at the bottom of the window and 

choose Edit in the menu that appears. This opens the Color Editor (on page 210). There 

will usually be several named theme colors in the Color Line - hover the mouse pointer 

over the color to see the tooltip showing the color name. Sometimes there will also be 

several colors linked to a theme color that will change at the same time; these are shown 

on the Color Line with smaller color squares, but normally you won’t need to edit these 

because they change automatically with the main theme colors. 

You can also click on any object in the design to select it and then click a named or 

palette color on the Color Line to change the object’s color.  If the object is not just a 

single color (such as a button made up of a group of different colored shapes) a ‘replace 

colors’ dialog will appear with a list of the colors used in the object. You can choose 

which color you want to replace with your chosen color. This way you can, for example, 

make a button that uses Theme Color 1, use Theme Color 2 instead.  

Once you’ve changed the theme colors in your document, if you then paste in or import 

templates which still use the original theme colors, you’ll be presented with a choice. You 

may want to import the new objects with their original colors, in which case choose the 

‘Don’t match’ option. But more likely you’ll want them to be changed to match the colors 

you’ve chosen for your document, in which case choose the ‘Match’ option. The color 

matching prompt is shown whenever you import objects which share a color name with 

the colors already in your document, where the actual color values differ. See Color 

Handling (on page 205) for more information. 
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Page background color 

If you drag a color from the Color Line over the page, and drop it, it will set the page 

background to that color. 

 

Once you’ve set the color this way, if you want you can refine it using the color editor. 

Right click on the page and choose CHANGE PAGE BACKGROUND from the menu. The 

color editor appears allowing you to edit the page color. 

When working with website documents, setting the page background color actually sets 

the background color for the whole browser window when you view your exported 

website.  

 
To set a repeating background texture, drag the photo or bitmap onto your 

document. Open the Bitmap Gallery, scroll to the photo you just loaded, click on it 

to select it, then click the Background button on the Gallery, and choose the SET 

PAGE BACKGROUND option. 

 

Changing The Page Size of Templates 

You can change the vertical size of the pre-designed web templates by just dragging on 

the bottom edge of the page. As you do this, footer objects will automatically stay with 

the bottom of the page and any background panels will stretch automatically also, so the 

page design is maintained for any page length.  

Page Size 

The pages in the ONLINE CONTENT CATALOG are designed to be a width that is known to 

fit the vast majority of computer screens. Creating wider pages is not recommended, 

even though you will probably have a wider computer screen, experience shows most 
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viewers prefer to have a fixed width page. However you can adjust the page size to be 

anything. 

You can set any page size you like by selecting the PAGE SIZE tab of the OPTIONS DIALOG 

(right click and choose PAGE OPTIONS or PAGE OPTIONS from the FILE menu). It's not 

recommended that you make the page width more than 990 pixels, as that's the 

maximum width for many computer screens (1024 minus a small amount for the scroll 

bar). A more common page width is typically around 800 pixels. 

You can directly adjust the height and width of your page by just dragging on the bottom 

or right margin of the page. Go into the SELECTOR TOOL and hover the pointer over the 

bottom edge of the page, and it will change to indicate you can now drag resize the page 

up or down as required. You will also be prompted to choose whether the change should 

apply to all the pages in the document or website, or just the current one. 

 

Adding Pages 

You can easily add more pages to your design to create multi-page web sites or multi-

page documents. Simply drag a page template from the Designs Gallery (on page 32) 

onto your document and it will be added as a new page immediately following the current 

page.  
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Animations 

Introduction 

Xara Photo & Graphic Designer takes a traditional animator's approach to animation. You 

create key frames (or "snap-shots") of your animation through time, and Xara Photo & 

Graphic Designer automatically creates all the in-between frames for you, a process 

called ‘tweening’. 

 

An example start frame 

 

The next key frame has the star shape moved, rotated a little, reduced in size, and changed to 
a different color. 

 

Xara Photo & Graphic Designer will create a smoothly animated Flash or movie file 
automatically creating the interim frames. This process is called "tweening".  

What Flash can and cannot do 

The Flash format does not support some of the advanced effects that Xara Photo & 

Graphic Designer offers, for example complex graduated transparency, feathering and 

most of the advanced color fill types. 

However, it does support a range of effects that include simple transparency. So, for 

example, if you fade the star on the 2nd key frame above to be 100% transparent, you'll 

get an animation where the star moves, reduces in size, and then fades. 
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The same example, showing in-between frames, but  with a transparency change. 

Like Xara Photo & Graphic Designer, Flash is vector graphics-based, which means that 

you can enlarge objects with no loss of detail. It also means that Flash files can be very 

compact, which is of course ideal for the web! 

To illustrate just how small and compact Xara Photo & Graphic Designer Flash 

animations can be, the previous example animated over one second with 24 frames (so 

the movie plays at a smooth 24 frames per second) creates a Flash file that's only 700 

bytes. 

The 6 core types of animation 

In order to keep Flash files very compact, the types of shape tweening supported by 

Flash are limited to six basic types of animation. These are sometimes called the 6 core 

transforms, because these are the main ways you can transform an object from one key 

frame to the next. 

1.  

2. Scale: Enlarge or reduce objects in size. 

3. Squash or skew: Squash or skew objects. 

4. Rotate: Rotate objects. 

5. Transparency: Adjust the overall (flat) transparency of the objects. 

6.  

The last item, color changes, can be applied to contoned (colored) photos. You can’t  

transform a full color photo into a contoned one, but you can change a photo with one 

contone color into another color. 

Note: the above six transform types are absolutely key to all Flash animations. 

If you look at Flash animation examples on the web, you'll find that almost all consist of 

just these effects. Objects fade in and out; they whiz from one position to another. They 

sometimes spin, grow or shrink. That's the basis for almost all Flash animations, and it's 

very easy to produce such animations in Xara Photo & Graphic Designer. It is also 

possible to tween shape outlines and some PHOTO TOOL attributes in Xara Photo & 

Graphic Designer, but these are less common and only applicable to specific types of 

object. 
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One thing that isn’t possible with Flash is to change the shape of an object between key 

frames though this will work when exporting as a movie clip. 

 

It’s not possible to change the shape between key frames in exported Flash animations.  

Because the shape changes (i.e. it morphs from one shape to another), this is not 

possible in Xara Photo & Graphic Designer Flash animations. 

What you can't do with Xara Photo & Graphic Designer Flash 

Xara Photo & Graphic Designer does not support more complex Flash features such as 

scripting (programming), audio, or embedded movies. 

Additionally, since Flash vector rendering is relatively primitive compared to Xara Photo 

& Graphic Designer’s, there are advanced Photo & Graphic Designer effects such as 

feathering that cannot be used in Flash. These are detailed in the "What Xara Photo & 

Graphic Designer Features Does Flash Support? (on page 480)" section towards the end 

of this chapter. 

Core Principles 

In your animation you are likely to have some objects that remain static between key 

frames (i.e. no tweening is necessary) and other objects you will want to animate. 

 

To tell Xara Photo & Graphic Designer which objects you want to animate, it's 

necessary to give each object a name (via the ADD NAMES button on the 

SELECTORTOOL InfoBar). 

For more information on naming objects, see section "Naming Objects" in the "Document 

Handling (on page 46)" chapter. 

Here is an overview of the typical process to create a new animation from scratch, which 

this chapter will guide you through: 

1. Decide what size you would like your animation to be and set the page size 

accordingly (see "FILE" > "PAGE OPTIONS (on page 551)").  

2. Draw your first frame. Name the objects that you want to animate. 

3. Create a new key frame (usually done by copying the earlier frame). 

4. Move and transform the objects as required. 

5. Preview the results. 
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6. Repeat steps 3 through 5. 

Your First Animation 

To create a new animation: 

Create a new animation document. To do this: 

Choose "FILE" > "NEW" > "ANIMATION" ("Ctrl + Shift + N"). 

A new document will open, and you will see the animation button bar appear that 

contains some relevant buttons. 

 

 

 

 

1. Draw a simple shape, such as a rounded rectangle with the RECTANGLE 

TOOL (but it can be any shape). 

2. Click the APPLY NAME icon on the SELECTOR InfoBar and name it "shape". 

3. Click the COPY FRAME button to create your 2nd key frame. 

Transform the shape as required. You can adjust it using any of the six 

animation types described earlier in the chapter. 

4. Press the PREVIEW MOVIE button to see the animation. 

By default the display period for each key frame is half a second. To produce a longer 

animation, see the "Movie Frame Rate and Tween Steps" section later in the chapter. 

You are not limited to just one moving object; you can have as many as you like on each 

key frame. And as long as they appear transformed in some way, on the next key frame 

(and they are each given a unique name) they will animate. 

Here is another example. 

 

The first key frame has some simple text and a simple shape within a static rectangle. 

 

On the next key frame the text has been enlarged and made darker, the blue rectangle has 
been rotated 90 degrees and transparency altered to be mostly transparent.  

This is how the animation is constructed. 
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Keyframe 1 

Intermediate tween steps 

produced by Xara Photo & 

Graphic Designer 

Keyframe 2 

In this animation, the text object grows, and at the same time the rounded rectangle rotates 
and fades. 

Exporting a Flash File 

To export your animation as a Flash file: 

Select "FILE" > "EXPORT ANIMATION" and then choose Flash under SAVE AS TYPE. 

Or click the EXPORT ANIMATED FLASH button. 

 

This will save the finished SWF file into the location you choose. 

Previewing a Flash file in Xara Photo & Graphic Designer 

 

To view your animation as it would look in a web page, click the PREVIEW  FLASH 

button to instantly see a browser preview. 

The preview page will show your finished animation as well as useful information, such 

as the animation’s dimensions, file size, etc.  It also includes simple instructions on 

inserting your animation into a web page. 

Inserting a Flash file into your webpage 

For those using Xara Photo & Graphic Designer you can simply drop the Flash file onto 

your web page to insert it into your website. A static placeholder image is automatically 

created and placed on your page. Preview your page and you should see your working 

Flash animation! 
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Alternatively you can create a placeholder object manually. On your web page, create a 

placeholder object, which can be anything such as a simple rectangle or an image or 

screen grab even.  Position and size your placeholder where you want your Flash 

animation to appear. 

Then in the WEB PROPERTIES DIALOG ("Ctrl + Shift + W") select the PLACEHOLDER TAB 

and the REPLACE WITH FLASH Browse options to locate the required .SWF file. Click 

APPLY.  

Now when you preview your website, the placeholder is replaced by the Flash animation. 

With either option above, the .swf file gets copied into a support folder next to your .xar 

file, so that there is a copy of the file with your .xar file. Therefore if you subsequently 

change your animation and export an updated .swf file that you want to use instead, 

either browSE FOR THE NEW .SWF FILE USING THE "UTILITIES" > "WEB PROPERTIES" > 

"Placeholder tab" as above, or manually replace the file in the support folder with the 

updated file. 

See the Support Folders section of the Document Handling chapter for more information. 

Inserting using a different web authoring tool 

To place your SWF animation into your HTML click the VIEW HTML link on the Flash 

preview screen to get code that you can paste into your web page using your preferred 

HTML editor. 

Note: You must change the SWF file name in the code to match the actual name of your 

exported SWF file. You must also place your SWF file into the same directory as your 

web page for the code to work. If you place the SWF file in a different directory, you will 

need to change the HTML code accordingly. 

Exporting animations as AVI 

As well as exporting animations as animated GIFs and Flash animations, you can also 

export in the .AVI file format. 

In an animation document, choose EXPORT ANIMATION from the FILE menu, and choose 

AVI ANIMATION (*.AVI) from the Save As Type drop-down list in the Export File dialog. 

Click the OPTIONS button to choose the export settings, or just click the EXPORT button to 

use the current or default settings. 

AVI options 

Codec selection 

Use the dropdown list to select from the range of codecs that you have installed. This 

determines how your AVI is encoded and compressed. Or choose the "uncompressed" 

option if you want to export an uncompressed AVI. Note that this will give you a very 

large file size! 
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Key frame every N frames 

The default value is provided by the selected codec and it’s normally best to keep that 

value. Reducing the number will tend to result in higher quality but larger files, increasing 

it in lower quality smaller files. 

Frame Rate 

Leaving the frame rate at the default 25 frames per second will result in a smooth 

animation, but you may be able to get away with a lower rate of say 12 or 15 frames per 

second if your movie is fairly static with little fast moving action. This will reduce the file 

size.   

Configure 

Pressing the CONFIGURE button opens a settings dialog specific to the selected codec (if 

available), which may give you more configuration options. The ABOUT button tells you 

more about the selected codec.  

Make background transparent 

Selecting this option will make your AVI have a transparent background, which is useful if 

you want your animation to appear on top of a movie (for movie titling, for example). 

When this option is on, the codec list is reduced to show only the "uncompressed" option, 

because transparency can’t currently be supported using a codec. If you export an 

uncompressed AVI with transparency, it will import into MAGIX movie editing software 

and some other movie editing applications with the transparency.  

Area to save 

Choose whether to save a movie that is the size of your animation page or the size of the 

animated drawing. 

Click OK to export the AVI animation. 

Creating animated GIFs 

Animated GIFs are an alternative way to present animated sequences in the web. An 

animated GIF is just a GIF file that contains a sequence of images, rather like frames in a 

movie. Every Xara Photo & Graphic Designer-frame is one frame in the final animation, 

just like a flip-book. 

Opening an animation document 

To create an animated GIF, you must first open an animation document. To do this 

choose "FILE" > "NEW" > "ANIMATION". You will then have access to the FRAME GALLERY 

(on page 468). 



 

 466 Animations 
  

 

 

Creating the animation 

To create an animated GIF: 

 

1. Choose "UTILITIES" > "GALLERIES" > "FRAME GALLERY", or click the FRAME GALLERY 

icon on the GALLERIES toolbar. 

2. Draw what you want to appear in this first frame. 

3. In the FRAME GALLERY, click NEW to create the next frame. 

4. Set the background and overlay flags as required. 

5. Create the objects you want to appear in this frame. 

6. Repeat steps 3 through 5 until you have built up the sequence of frames. 

Exporting the animation 

To save the animation, choose "FILE" > "EXPORT ANIMATION". 

Animation properties 

To alter the animation's properties, right click on a frame in the FRAME GALLERY (on page 

468) and select PROPERTIES. You can then change a number of options detailed below. 

The Frame tab 

In the FRAME tab you can set: 

 NAME: The name of this frame. This is just as a reminder to you, and is not exported 

with the animated GIF. 

 BACKGROUND: If this is set, the frame covers all previous frames. This is useful if you 

want to create a background and then build up an animation on top of this background. 

Often the first frame in the animation is a background frame. If the first frame is not a 

background frame, the animated GIF uses the page background as its background. 

 OVERLAY: If this is set, then the frame overlays the previous frame. 

 LOCAL DELAY: Set how long the frame is displayed for in the animation. 

 SHOW FRAME: When checked, the frame will be shown in the animation. 

 MOVING FRAME IN TIME LINE: This value determines the amount by which a frame time 

is changed when the ‘MOVE FRAME FORWARDS/BACKWARDS' buttons are used in the 

Frame Gallery. 

Flash Options 

Here are several options for Flash animations, most of them are described above 

 Link to be applied to whole animation (on page 483) 

 Flash Movie Speed (on page 476) 

 JPEG quality (on page 471) 

 Area to save (on page 473) 
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GIF Options 

In the GIF OPTIONS tab you can set the color usage in GIF animations. (Not available for 

Flash animations). Click OPTIONS in the Export Animation dialog to show the GIF OPTIONS 

tab in the Animation Export Options dialog. 

 PALETTE COLORS: Set the preferred color palette for your animated GIF. The help 

guide contains more information on the difference between these options. 

 NUMBER OF COLORS IN PALETTE: This option is available only when using optimized 

palettes. For simple graphics you can reduce the number of colors in the palette. This 

can produce much smaller files without losing quality. You may need to experiment to 

find the right balance between file size and quality. 

 DITHERING: You can select between three types of dithering. 

 TRANSPARENCY: Select this to make the bitmap transparent where there are no 

objects. 

Animation Loop and Speed 

In the ANIMATION LOOP AND SPEED tab you can alter the animation rate and frequency: 

 LOOP: Lets you specify how many times the animation should repeat itself. 

 DISPLAY EACH FRAME FOR: If you want the same delay between each frame in the 

animation enter a value here. To specify a different delay for individual frames, use the 

frame tab (described above). This field reads "many" if the animation has more than 

one inter-frame delay time. 

Preview in Browser 

You can select options suitable for the graphic and then load it into your browser so you 

can preview it: 

 BACKGROUND OPTIONS: Alter the background of the animated GIF to see which gives 

the best result. 

 ADDITIONAL INFORMATION: The preview page will contain useful information such as 

potential downloading times when placed in a web page. 

 BROWSER PREVIEW: Press this button to launch a preview in your web browser. 

AVI Options 

Options: Select from a range of codecs you have installed 

Quality: Set the quality value of the AVI (up to 100%) 

Key frame every ...: Enable/disable the outputting of key frames and set the frequency. 

Transparency: Select to make the AVI background transparent. 

Area to save: Setting the area to save to be DRAWING will create an AVI animation that is 

only as large as it needs to be – i.e. the same as the outer bounds of the animation. This 

can be useful if you don't need a specific page size. 
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The Animation Frame Gallery 

By default the ANIMATION FRAME GALLERY is displayed open on the right hand side of the 

Photo & Graphic Designer window (next to the PAGE & LAYER GALLERY) when you open 

or create an animation document. 

 

To toggle display of the FRAME GALLERY, choose "UTILITIES" > "GALLERIES" > 

"FRAME GALLERY", or click the FRAME GALLERY icon on the GALLERIES toolbar. 

 

 

A typical FRAME GALLERY. Frame 3 is selected and thus visible. 

This shows a list of the 

key frames in your 

document. To view any 

key frame just click its 

name in the gallery. 

The ANIMATION FRAME 

GALLERY shows frames 

from the top down, so 

the first frame is at the 

top and the each new 

frame you add gets put 

at the bottom of the list. 

You can re-order frames 

by dragging them. 

There are buttons to 

perform the main 

operations of deleting 

frames, copying the 

selected frame (it will 

always get added to the 

end) and creating new 

blank frames. 
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The PROPERTIES button is very important, since it shows the ANIMATION PROPERTIES 

dialog which controls many aspects of not just the selected frame but the whole 

animation. 

 

The Animation Properties dialog 

A shortcut to display the Animation Properties dialog is to simply double click on a frame 

name in the FRAME GALLERY 

 

The ALL FRAMES VISIBLE (the eye) and EDIT ALL FRAMES (the padlocks) 

buttons on the FRAME GALLERY are useful because they allow you to 

view or edit all frames together, one on top of the other. 

This is particularly useful if you want to select objects that are on multiple frames. 

Note: When you copy a frame, it always copies the selected frame and places it at the 

end. So in order to insert a new frame, say between frames 4 and 5, select frame 4, click 

the COPY button, and then drag the new copy from the end to the desired position 

between frames 4 and 5. 
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Note: Frame names do not matter and can be anything you like. They do not have to be 

Frame 1, Frame 2, etc. Animations always play the frames in the order top to bottom, 

irrespective of the names. 

Copying Objects 

You can copy objects from one frame to another in the usual way (i.e. copy the content, 

select the new frame and then paste into the new frame). The "EDIT" > "PASTE IN PLACE" 

option ("Ctrl + Shift + V") is particularly useful when doing this, as this will always paste 

objects back to the exact position they came from but on the new frame. 

When you copy an object its name is copied with it, but be careful not to have more than 

one object with the same name on a given frame; doing so will generate errors. 

Photos 

Because Flash files usually consist of vector shapes, and the transforms are relatively 

simple, the files can be very small. Photos and bitmaps can be embedded into Flash 

animations, but unless you are careful it will result in huge animation files. You can 

perform all core Flash transforms on bitmaps or photos (i.e. you can move, scale, 

squash, rotate, fade and re-color.). 

Flash files can include both PNG and JPEG images just as .xar files do, and Photo & 

Graphic Designer automatically creates photos of the right resolution when creating the 

Flash file. So for example you can load a hi-res digital camera image, size this down to 

be say 200 pixels, and this means that a 200 pixel image will get included, and not the 

full hi-res JPEG. 

When higher resolution photos are converted down for inclusion in Flash files the JPEG 

compression setting (Animation Properties dialog, Flash Options tab) can be used to 

control how compressed your JPEG images are. See below. 

When tweening bitmaps or photos, only one copy of the bitmap is stored in the Flash file, 

so you can perform transformations of the bitmap with little overhead. In other words, just 

because the bitmap appears on frames 1, 2 and 3 of your animation, this does not mean 

three copies of the bitmap are embedded in the Flash file. 

Non-JPEG Bitmaps 

Other types of bitmaps, for example, BMP, TIFF, or PNG bitmaps, are usually a lot larger 

and thus less suitable for use in Flash animations (for photos JPEG compression is a lot 

better than PNG). However if you include a low resolution PNG image (that is one of 

96dpi or less – the status line shows you the resolution of any selected image) then this 

is kept as a PNG image in the Flash file.  Higher resolution images (>96dpi) will be 

converted into a JPEG (transparent JPEG if required) . 

You can control the compression used for this automatic JPEG conversion using a slider 

in the FLASH OPTIONS tab of the ANIMATION PROPERTIES dialog. The usual compression 
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value is 75%, but you can vary the quality, preview the animation and quickly see the 

quality and size savings. 

  

256 color or less bitmaps (such as GIF) are not encoded as JPEG and will be embedded 

using PNG compression, which is usually the best compression type for these types of 

images 

Bitmap Quality 

Flash Player version 8 and later has higher quality bitmap display. This is particularly 

evident when rotating or scaling bitmaps and photos, whereas older versions of the 

player tend to produce pixelated, and rather jerky movements. 

You can tell which version of the Flash Player you have by right clicking on any Flash 

animation in your web browser and looking at the About menu. 

It’s therefore recommended to export your Flash animation as Version 8 if you’re using 

bitmaps or photos. You can control this from the FLASH OPTIONS tab of the ANIMATION 

PROPERTIES dialog. 
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Animation Frame Rate and Tween Steps 

Flash animations run at a fixed frame rate. The faster the frame rate, the smoother the 

resulting animation and the larger the Flash file. Xara Photo & Graphic Designer 

animations default to showing 24 frames per second, but you can change this. 

When you create each key frame, you determine how long the period is until the next key 

frame. For example, if a frame period is set to half a second, this means the animation 

from that key frame to the next will take half a second. At 24 frames per second this 

means there will be 11 intermediate steps generated by Xara Photo & Graphic Designer 

in the Flash animation, so 12 frames in all. (These intermediate "tween" frames are not 

ever seen in Xara Photo & Graphic Designer and are only generated when you create 

the Flash file.) 

 

The FRAME GALLERY 

always shows you the 

display period for each key 

frame. In this example 

three frames are displayed 

for one second each, so the 

whole animation lasts 3 

seconds before repeating. 

 

To create a longer tween effect (in other words to slow the animation down) increase the 

display period using the ANIMATION PROPERTIES dialog. 

The easiest way to alter the display period for any frame is to just double click on the 

frame name you want to alter to bring up the dialog, enter the new period in seconds, 

and click OK or APPLY. 

Move frame forwards/backwards 

These buttons allow you to move a key frame forwards or backwards in the animation, 

without changing the length of the animation. This is useful when working with 

animations that are exported as AVIs and included in movies, particularly if you are trying 

to track an object in the movie with your animation. By Default each click moves the 

frame by 1/25th of a second, which corresponds to one frame of a 25fps movie. You can 

change this value in the FRAME tab of the ANIMATION PROPERTIES dialog. 

 
Move frame 1/25th sec forwards 

 
Move frame 1/25th sec backwards 

The length of the previous frame is adjusted in order to keep the overall length of the 

animation the same, so effectively you are just moving the key frame forward or 

backward in the animation.   
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Cropping, Clipping and Animation Size 

Before long you'll start to consider creating some Flash animations like you see on the 

web, say with some wording or a photo that whizzes in from one side. 

 

To create an animation like this, all you need to do is set the page size in Xara Photo & 

Graphic Designer to the size you want for your flash animation. So if for example you 

want a Flash banner which is 468 pixels wide and 60 pixels high, set the page size in 

your animation document to 468x60. To set the page size, go to the PAGE TAB of the 

OPTIONS DIALOG (on page 551) (or choose "FILE" > "PAGE OPTIONS") and set the Width 

and Height fields accordingly. 

When exported or previewed, the flash animation is automatically clipped to the page 

size you have set. So it’s easy to arrange your animation so that objects glide in and out 

of the visible animation. E.g. by placing an animating object to the left of the page on one 

key frame and to the right of the page on the next key frame, in the animation the object 

will be seen to slide in from the left side of the design and disappear off the right side. 

You can also change the page dimensions by going into the SELECTOR TOOL (ON PAGE 

115)AND DRAGGING ON THE BOTTOM EDGE OR RIGHT EDGE OF THE PAGE, TO CHANGE THE 

PAGE HEIGHT OR WIDTH RESPECTIVELY. SEE CHANGING THE PAGE SIZE IN THE DOCUMENT 

HANDLING CHAPTER FOR DETAILS. 
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Note: When opening older documents created with earlier versions of Photo & Graphic 

Designer, these will not clip to the page (the page size was huge), instead they clip to the 

size of the drawing. You can control this in the Animation Properties dialog. 

 

Setting the area to save to be Drawing will create a Flash animation that is only as large 

as it needs to be – i.e. the same as the outer bounds of the animation. This can be useful 

if you don’t need a specific page size. 
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Animation Speed 

When you create a new keyframe, it defaults to having a period of half a second. So the 

animation from that keyframe to the next will take half a second. The longer you set the 

period, the slower the animation. To set the frame period for any frame, first select the 

desired frame in the FRAME GALLERY (click on it), and then click the ANIMATION 

PROPERTIES button (or just double click the frame name). 

 

Setting "Display This Frame For" to 2 seconds means the animation will take 2 seconds  to 
tween from this key frame to the next. 

Note: The ANIMATION PROPERTIES dialog is non-modal and you can keep this on screen 

all the time. By pressing the APPLY button instead of OK, the dialog remains on screen. 

Its contents are updated as you select different frames, and for each of them you can set 

the required display period. 
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Animation smoothness 

Flash movies play at a constant frame rate. The faster the frame rate, the smoother the 

animation. Xara Photo & Graphic Designer defaults to showing 24 frames per second. To 

change the rate select the FLASH OPTIONS tab of the ANIMATION PROPERTIES dialog. 

 

 The Flash Options tab, where you can change the movie speed as well as the Flash export 
version. 

Note: The faster the frame rate, the larger the resulting Flash file. You will find that if your 

animation is mostly objects fading in and out with relatively little fast moving animation, 

then you can reduce the frame rate to under 24 frames per second. If you have a lot of 

fast action, it may be necessary to increase the frame rate, but it’s rarely necessary to 

have it above 50 frames per second. 

Rotation 

Xara Photo & Graphic Designer calculates and generates the tween frames automatically 

by working out how to transform the shapes from one key frame to the next. But 

sometimes it's not possible to know exactly what type of rotation is required. 
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Take this example. Suppose you tween 

from the first clock face to the second: 

 

You might expect it to rotate clockwise, 

but of course it could go counter 

clockwise: 

 

 

In fact there are other ways it could rotate. The above 

examples assume the hand rotates around one end, but you 

could tween from one state into the other by doing a straight 

line rotation of the center of the object, which would result in 

this: 

 

If you look closely, the hand rotates around its center rather than one end, and the center 

point moves in the straight line from one key frame to the next. By default, Xara Photo & 

Graphic Designer rotates objects this way. 

The Rotate command 

To force the rotation to be around any other point you can use a special keyword "rotate" 

appended to the front of the object name. Or you can use "rotate +" to force the rotation 

to go clockwise or "rotate -" to make it go counter clockwise. 

To take the simple two keyframes animation example shown on the previous page, 

where the hour hand needs to move from 12 o’clock to 8 o’clock. If you name the hand 

object "rotate + hand", you'll get an animation showing the clock’s hand moving 

clockwise. If you name it "rotate - hand", then the hand will rotate counter clockwise. 

If there is no rotate command, then the tween takes the shortest direct path between the 

object on one keyframe to the next, rotating around its center. With a "rotate" command 

on the object name, it calculates the actual rotation point, which in the above example is 

the "large end" of the hand. 

Note: It's not possible to rotate an object by a full 360° between keyframes if the rotation 

point is not the center. For example, to do a full rotation of the clock hands in the above 

example, you would need to create an intermediate keyframe. 
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The Name Gallery 

To display the NAME GALLERY: 

Choose "UTILITIES -> GALLERIES ->NAME GALLERY". 

 

A typical Name Gallery layout 

The NAME GALLERY lists all fonts, 

bitmaps, named colors and object 

names used in any drawing or 

animation. You can see folder 

sections for each type of name. 

The important thing here is the 

object names for animation, the 

top folder, as you have to give 

names to all objects you want to 

animate from one key frame to 

the next. 

These are the key points to note when using the NAME GALLERY: 

 To name a new object, select it and use the NEW button in the gallery or the NAMES 

BUTTON on the SELECTOR Tool InfoBar. Each object you want to animate must have a 

unique name, and must keep that name for the duration of the animation. i.e. on each 

key frame the object appears on, it must have its correct name. Luckily, once you've 

given an object a name, it retains that name, even when copied and pasted. 

 You can apply a name from the NAME GALLERY to any object by dragging it onto the 

object (or selecting the object and double clicking the name). In this sense, applying 

names is rather like applying colors to objects. This can come in handy if, for 

example, you copied an object to a number of key frames but forgot to name it. You 

can create the name, and then select each object to which you want to give this name, 

then double click the name in the NAME GALLERY. 

 When you select an object, its name is shown highlighted in the Name Gallery with a 

half or full red circle: 

 indicates that there are other objects or copies of this object with the name. 

 indicates the selected object/s are the only occurrences of the name. This is useful if 

you want to be sure of selecting all occurrences of the named object. 

 You can select objects using the NAME GALLERY. By clicking in the circle to the left of 

the name you will select some or all occurrences of the object with that name. 
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 As above, means there are other occurrences of this named object that were not 

selected, typically because they appear on other frames and so are not visible and 

selectable.  

 means all occurrences of this name are selected. 

 If you want to select all occurrences on all frames, then you need to select the ALL 

FRAMES VISIBLE or EDIT ALL FRAMES buttons in the FRAME GALLERY. 

 You can ignore the JPG or GIF symbols to the right. These are features used when 

exporting sliced web images. 

You can also create, apply and remove names from objects using the NAMES dialog 

which you can access using UTILITIES > NAMES, or by pressing the Names button on the 

SELECTOR Tool InfoBar.  

The NAMES DIALOG is much simpler to use, but is not as powerful as the NAME GALLERY 

for examining which names are applied to which objects. However since you can create 

new names, apply existing names and remove names with the Names dialog it’s often all 

you need to create complete animations. 

For more information on naming objects, see "Naming Objects (on page 82)" in 

"Document Handling". 

Groups 

Groups are treated specially when creating animations. To save you naming each 

individual part of a group, you can instead name the whole group and then copy the 

group to the next keyframe. Xara Photo & Graphic Designer will animate the whole group 

from one keyframe to the next. And you can apply the normal transformations to the 

group (resize, rotate, squash, but not group transparency – see the next page). 

If members of a group are to animate differently than the rest of the group, then those 

members must be separately named ("Ctrl + click" to select an object inside a group, 

then name it as usual). 

Note: If you ungroup, make some changes to the group contents and then re-group the 

objects: 

 You must re-apply the name to the new group (select the group then double click on 

the name in the NAME GALLERY). 

 You must not change the stacking order of the items in the group. 

 You must not add or remove items to/from the group. 

Group Transparency 

If you want to fade a grouped object, you need to apply transparency to each individual 

object in the group. There are two ways you can do this: 

 Select each object in the group in turn and adjust its transparency. 

 Or un-check the MAKE GROUPS TRANSPARENT AS A WHOLE option in the OPTIONS dialog 

("UTILITIES" > "OPTIONS", then the GENERAL tab). If you do this, when you adjust the 
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transparency of the whole group Xara Photo & Graphic Designer applies the 

transparency to each individual item in the group, instead of group transparency. 

What Xara Photo & Graphic Designer features does Flash 

support? 

The Flash vector rendering is quite primitive compared to Xara Photo & Graphic 

Designer's, and so you can't use many of the more advanced Xara Photo & Graphic 

Designer features such as feathering, complex transparency and fill types, bevels, soft 

shadows, or contours. Lines (strokes) are limited to be being simple constant thickness, 

round ended lines. No line dashing is supported. The minimum line thickness is one 

pixel—so thinner lines in Xara Photo & Graphic Designer will be displayed one pixel thick 

in Flash. 

There are two aspects to producing Flash-compatible drawings. The first is to limit 

yourself to use only those features supported directly by the Flash player. Secondly, 

when producing animations, there is an even more limited set of characteristics that can 

be tweened or animated. 

Xara Photo & Graphic Designer drawing features that Flash supports: 

 All normal line and shape drawings (although Flash is a lot less precise than Xara 

Photo & Graphic Designer and so sometimes you may notice inaccuracies in lines and 

shapes). 

 Flat, linear, circular and elliptical gradient color fills. 

 Multi-stage gradient color fills, including linear and elliptical fills. Eight color stops 

maximum. 

 Flat transparency. Mix type only. 

 Graduated transparency is supported for flat color filled objects (non-graduated). So 

you can have graduated color objects with flat transparency or flat color objects with 

graduated transparency, but not both. 

 Constant width outlines (stroked paths) with rounded end caps and line joins (version 

8 Flash files support the other join and cap types). 

 Text, including kerning. You can use any fonts you like. The outlines of the characters 

of any used fonts are embedded into the Flash file. This is much more efficient than, 

say, font embedding in PDF documents. 

 Text on a curve. Note: the line used for the curve must be made invisible for the 

animation to work. 

 Bitmaps and bitmap fills. 

 Contoned (colored) bitmaps and bitmap fills. 

 Photo Saturation, temperature color and blur (but not brightness / contrast change). 

 Fractal Cloud and Plasma fills will work, but are converted to bitmaps, so not efficient. 

So you can't use, amongst other things: 

 Any transparency type other than mix. 

 Feathering. 

 All complex graduated fills (conical, diamond, 3 color etc). 
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 All complex graduated transparency styles (as above). (You can use linear, and 

elliptical transparency on flat color filled objects.) 

 Live Effects. 

The following object types will export in static Flash, but do not animate. 

 Soft shadows. 

 Bevels. 

 Contours. 

 Blends. 

 Molds. 

So while some Xara Photo & Graphic Designer effects, such as soft shadows and bevels 

do work in static files, these are exported as bitmaps into the Flash file, so they are not 

very efficient and not suitable for animating. 

What can be animated: 

As listed at the start of this chapter, these are the golden rules as to what you can 

change from one keyframe to the next: 

 Move: Move objects from one position to another. 

 Scale: Enlarge or reduce objects in size. 

 Squash or skew: Squash or skew objects. 

 Rotate: Rotate objects. 

 Transparency: Adjust the overall (flat) transparency of the object. 

 Color transform: Change the fill (flat) color of objects. 

 Or any combination of the above. 

In addition, there are a few special cases of photo color transformations that are 

supported by Flash. You can alter the saturation (so you can tween a full color photo into 

a black and white one), You can also adjust the temperature color control (warm / cool), 

and also the blur value. The latter enables you to tween a blurred photo into a sharp one. 

But note this only works for blur values and not sharpen.  Also there is a slight difference 

in the way Flash blurs photos. Flash blurs the whole photo including the edge, whereas 

the Photo blur in Xara Photo & Graphic Designer only blurs the inside of the photo and 

keeps a sharp edge. 

Secondly, another special case: you can animate text on a curve. This is special because 

you can use this to seemingly morph text along one curve into text along a completely 

different curve. In fact what it does is tween from the character position in one keyframe 

to the corresponding character’s position in the next frame. This can produce some 

interesting effects. 

Note: The line used for the curve must be made invisible for the animation to work. 
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Finally you can also tween outline thickness between one key frame and the next, but 

only for shapes with a constant outline thickness (ie. It will not worked for shapes with a 

stroked outline).  

Non-moving Objects 

You can add new objects by just drawing them on any keyframe. They will appear in the 

animation at the start of the frame and will vanish at the next keyframe, unless they 

appear on that frame as well. So the simplest way to have an object appear static on all 

frames is to ensure it's copied to all the frames. Xara Photo & Graphic Designer Flash 

optimization is very efficient and you'll find that having more than one copy takes hardly 

any additional file space (this is true of multiple copies of objects anywhere). 

Color Transforms—Animating Color Changes 

This is what you can and cannot do with color transforms in Xara Photo & Graphic 

Designer Flash: 

 You can animate simple flat color changes of objects from one keyframe to the next. 

 You can change the line color independently of the fill color. 

 You can change photo contone colors. 

 You cannot adjust the position of gradient fills. 

 You can use RGB, HSV or CMYK colors. These are all converted to RGB colors when 

exported to Flash (which is the only color model Flash supports). 

Transparency 

As mentioned earlier, you can adjust the flat transparency of objects (not group 

transparency) and Flash supports this (for both static objects and tweening transparency 

changes), but Xara Photo & Graphic Designer’s graduated transparency is not really 

supported with Flash. There is just one situation where you can use graduated 

transparency, and that is on flat color filled objects. 

 

It's possible to adjust, and animate, flat transparency given to all types of objects, shapes, text 
and photos. 
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It's possible to give graduated transparency (linear, circular and elliptical) to flat color filled 
objects, but it's not possible to animate the transparency change. Although you can animate 
the color change (rule six). 

URLs in Flash 

To make an object in your Flash animation a clickable link, just select the object you want 

to make clickable and select "UTILITIES" > "WEB PROPERTIES ("Ctrl + Shift + W"). 

Enter the required URL.  (If you require the link to open in a new browser window or 

browser frame select the target web frame by selecting from the ‘OPEN LINK IN’ dropdown 

menu). 

If you want to make text clickable select the RECTANGLE SURROUNDING OBJECT option. 

This ensures those that viewers of your Flash animation can click anywhere over the text 

(rather than just on the actual letter shapes). 

Making the whole animation clickable 

In the "ANIMATION PROPERTIES" > "FLASH OPTIONS" tab you can set a URL to apply to a 

whole animation. This is useful for banner ads where you want a click on any part of the 

animation to go to a given web address.  

clickTAG 

clickTAGs are often used by advertising networks. Rather than hard-coding a URL into a 

Flash animation, the clickTAG allows an organization to insert their own URL into the 

animation, which is particularly useful for tracking advertising clicks. 

If you need to use this feature, check the clickTAG option. 

Advanced Flash Commands 

Accelerating and Decelerating 

Usually the tween steps are evenly spaced between keyframes, producing a linear 

animation from one keyframe to the next. By appending < and > symbols to the front of 

the object name, you can make objects speed up or slow down. So naming an object  

>Name  means that it starts fast and slows. The opposite, <Name, would start slow and 

speed up. 
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You can even use these in combinations. So an object name <>Name would start slow, 

speed up and then slow down towards the end of the frame period. In traditional 

animator’s terminology this is called ‘easing’, so you can ease in or ease out, and the 

command <> would be an ease in/out. 

You can control the degree of acceleration or deceleration by using numbers from 0 to 9. 

So <2Name  would be a very gentle acceleration, while <9Name would be extreme 

acceleration.  Similar >2 in front of the name would give a slight deceleration. Using the 

name >Name (with no number) is the same as >5Name. 

Example: there is an example file called Pendulum in the FLASH EXAMPLES section of the 

DESIGNS GALLERY (on page 32) (click the DISC DESIGNS button on the DESIGNS GALLERY). 

The pendulum group uses a combination of <> and the rotate command. Another 

example called "Zoom.xar" is also worth examining. 

Stop and Goto Commands 

You can append STOP or GOTO commands onto the Frame names (separated by a semi-

colon ; ) to control the sequence flow. So for example if your first frame was named 

"Frame 1;Goto Frame 6", then the animation sequence would jump to Frame 6 at the 

start of Frame 1.  This may produce tween errors, but these can be ignored. It also waits 

for the specified period of the frame with the GOTO command on before jumping, but 

frames with GOTO or STOP commands do not tween. 

Similarly a frame name with ;STOP appended to the end of the name would stop when 

the animation reaches this frame.  Why is this useful?  Because you can make the 

animation jump to any other key frame with either a click or by moving the mouse over 

objects.  For example you might have an animation that waits for the user to click on or 

move the mouse over an object before continuing. 

Clickable Buttons & Mouse-over Effects 

You can make the animation sequence jump to any keyframe either by clicking on an 

object or just by moving the mouse pointer over any object. 
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To do this select the object you want to use as the trigger, open the WEB PROPERTIES 

dialog (Ctrl+Shift+W) and on the LINK tab, select the JUMP TO FRAME option. 

 

If you want the jump to occur by just moving over an object, select the Mouse-Over tab instead 
of the Link tab, and select from the similar ‘JUMP TO FRAME’ option. 

Now in your animation if you click or mouseover the object the animation will redirect to 

the the new frame and proceed from there. See the "River Thames" example file in the 

DESIGNS GALLERY (on page 32). This uses a Goto command to loop from frame 4 to 3, 

and a URL frame re-direct to jump to Frame 1 if you click the Replay link in the corner. 

"Ctrl + Shift + W" is a quick way to open the Web Properties dialog. 

Xara Photo & Graphic Designer Flash Animation Summary 

 Xara Photo & Graphic Designer keyframes are "snapshots" of your animation at any 

point in time. Xara Photo & Graphic Designer automatically produces a smooth blend 

or tween of objects from one keyframe to the next to produce a smooth Flash 

animation. 
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 There is no timeline. Instead, the FRAME GALLERY (on page 468) shows your snap 

shot keyframes though time (top down). Just click the frame name to see and edit that 

keyframe. 

 If you set the Xara Photo & Graphic Designer frame display time to be 2s then it will 

take 2 seconds to animate objects from their position at the start of one keyframe to 

their positions at the start of the next keyframe. Use the ANIMATION PROPERTIES dialog 

to set frame display period. 

 To tell Xara Photo & Graphic Designer which objects are to be blended or tweened 

between one keyframe and the next, you name the object you want to tween. For each 

new object you want to animate click the NAMES button on the SELECTOR TOOL InfoBar 

and give it a name (or select the menu "UTILITIES" > "NAMES"..). The object must have 

exactly the same name on subsequent frames. 

 When you create a new keyframe (snap shot) you usually do this by copying the 

current frame, and this copies all objects to the new frame along with their names. 

Then just move the objects as required. 

 All other (non-named) items appear static for the duration (display period) of the 

keyframe. 

 You can move, enlarge, reduce, rotate, stretch, alter the color or transparency 

between Xara Photo & Graphic Designer frames. Transforming objects in this way is 

very efficient. 

 There is an overall frame rate for the whole Flash movie. The more Flash frames-per-

second, the larger the Flash file and the smoother the animation. 

 Because each Photo & Graphic Designer frame is a snap shot of the full animation, all 

objects that should appear at that snap shot should appear in the frame. You can't 

blend an object from frame 1 to frame 3 without it appearing on frame 2. 

 You can change shapes, text or photos as allowed by the six transform rules 

described earlier (move, resize, squash/skew, rotate, flat transparency and color 

change). If you change the shape in any other way it won't work. 

 The Flash animation is clipped to the page dimensions you have specified in Xara 

Photo & Graphic Designer.  
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Printing 

Show print borders 

The "WINDOW" > "SHOW PRINT BORDERS" menu shows a yellow and red line around the 

page (non-printing) showing the print margins and borders. The page boundary is shown 

by a yellow rectangle and the printing area by a red rectangle. The printing area is 

determined by the margins on the currently selected printer. Some printers let you adjust 

the margins, but few let you print right up to the edge of the page. 

If any objects on the page lie outside the red rectangle they are unlikely to be printed. 

Selecting and setting up a printer 

Select "FILE" > "PRINT" TO open the PRINT dialog box, then click the PRINTER... button.  

This opens the standard Windows PRINT SETUP dialog: 

 

Selecting a printer also selects a suitable paper size and paper orientation. Note that 

these are the size and orientation of the sheets of paper used in the printer. They are 

separate from the size/orientation of the document. PORTRAIT prints the page without 

rotation. LANDSCAPE prints the page turned through 90° (these buttons are duplicated in 

the PRINT OPTIONS dialog box, described later). We recommend leaving the 

LANDSCAPE/PORTRAIT buttons on this dialog box on their default setting. 
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Please note: We cannot give you advice about installing or configuring printers as these 

are standard system operations. In case of difficulties, contact the supplier of your printer 

or computer. 

Properties button 

This displays a dialog box letting you set options for the selected type of printer. This 

dialog box is not controlled by Photo & Graphic Designer. 

Network button 

If your computer is connected to a network, this lets you connect to shared printers on 

the network. This dialog box is not controlled by Photo & Graphic Designer. 

The print dialog box 

Choose "FILE" > "PRINT" ("Ctrl + P"). 

 

Print button 

When you have selected the required options click this to start printing. 

Printer… button 

This opens the "PRINT SETUP" dialog box (described earlier). 
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Options button 

This opens a tabbed dialog box that lets you set additional print options. These are 

described later (on page 490). 

Pages 

ALL PAGES:  Prints every page of the document. 

CURRENT PAGE(S): Prints the currently selected page or spread. 

SELECTED OBJECTS: This option is available when any objects in the document are 

selected. When active, only the selected objects are printed. Note that other objects 

within the bounds of the selected objects are not printed – only the objects which are 

actually selected are printed. 

Hidden objects, objects on hidden layers and the guides layer never print. See Page & 

Layer Gallery for more details. 

PAGE RANGE: Allows you specific control over which pages you wish to print. You can 

type specific pages numbers, separated by commas, or page ranges by typing two 

numbers with a hyphen in between them. 

Page range examples: 

2 will print just page 2. 

1,3,5-7 will print pages 1, 3, 5, 6 and 7. 

2,3,6-8,11-12 will print pages 2,3,6,7, 8,11 and 12. 

The Options section of the dialog will indicate if your page range is OK or invalid. 

Double page spreads 

If the document comprises a double-page spread, you can print both sides or just the left 

or just the right page. 

This option is dimmed when the spread comprises a single page (see Document 

Handling (on page 56) for how to select single or double-page spreads). Or the 

"PRINT/EXPORT INDIVIDUAL PAGES" is active in the Page Options (on page 552), so that 

the two pages of a double-page spread are treated as individual single pages. 

Print to File 

You can select the PRINT TO FILE option to create a document that you can give to a 

printing company (if they are able to accept this type of file). 

After checking this option, when you click PRINT Photo & Graphic Designer displays the 

standard Windows SAVE dialog box so you can specify a file name and location for the 

file. 
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Print files have a default extension of .prn. 

If you want to create a PDF file we recommend selecting the "File -> Export…" option 

and selecting PDF. This produces a higher quality, and usually more compact PDF file 

than you'd get from printing to a PDF file. 

For more information on exporting as PDF refer to Importing and Exporting (on page 

505). 

Number of copies 

Sets how many copies of the document to print. 

Collated 

This is dimmed except when printing multiple copies of a double-page spread as two 

separate pages. With this option selected, pages are printed as left-right-left-right, etc. 

With this option deselected, all the left-hand pages are printed then all the right-hand 

pages. 

Printers that hold a page image in memory take some time to process the image. The 

printer can then print multiple copies at its maximum speed. For such printers it is often 

faster to manually collate the pages after printing. 

Other types of printers have to process the page for each copy. For these, select collate 

copies and save yourself the chore of collating. 

Print Options: Output tab

 

Print layers 

There are two options: 

 Print ALL FOREGROUND LAYERS. 

 Print only the currently VISIBLE FOREGROUND LAYERS. 

Note that only foreground layers are printed. Background layers are never printed. 

Print As 

NORMAL is suitable for most types of document. 

However some printers do not reproduce consistent colors when printing bitmaps or 

vector objects that are the same color (this is a fault with the printer driver). This is 

noticeable if objects overlap onto bitmaps or onto objects with transparency applied to 

them. In this case, select BITMAP or ANTI-ALIASED BITMAP and retry. 
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The choice between BITMAP and ANTI-ALIASED BITMAP depends on the printer and 

personal preference. Some printers give best results with anti-aliasing turned off 

especially when printing thin lines. As a rule, using anti-aliasing allows lower resolution 

printing. For example, 150 DPI bitmap printing is usually good enough for all uses-even 

typesetting. Without anti-aliasing, higher resolutions may be needed which gives much 

slower printing. 

Transparency resolution 

When printing, Xara Photo & Graphic Designer's transparency effects are created using 

bitmaps. 

This option controls the resolution of those bitmaps when sent to the printer. Automatic is 

suitable for most drawings, and means Xara Photo & Graphic Designer automatically 

selects a resolution suitable for the current printer.  This might be unsuitable if printing to 

a very high resolution printer such as image setting devices. In this case you may wish to 

control the print resolution manually by entering the desired value. 

Note that modern printers often claim to be able to print at over 1000 dots-per-inch, but 

this is not the same thing as "pixels-per-inch", which is what you see on screen. 

Generally, it's never necessary to print at more than 600 pixels-per-inch, and typically 

300 pixels per inch produces perfectly adequate print results, especially if anti-aliased. 

Fill quality 

Using this option, you can choose how many steps make up the graduated fills in your 

document when it is printed. The NORMAL setting is suitable for most purposes. This 

option is dimmed for PostScript printers. 

Text options 

If your printer has problems reproducing fonts, select the PRINT ALL TEXT AS SHAPES 

option. All text is then converted to vector shapes before the document is sent to the 

printer. This may be slower, but will reproduce exactly what you see on screen. 
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Print Options: Print Layout tab 

 

Most options in print layout are dimmed if you have BEST FIT or AUTOMATIC FIT selected. 

We recommend using these options as they are the easiest way to print. 

However you can choose custom options (see “custom fit” below). 

Best fit 

Your design will be moved to the center of the page and it will be expanded or shrunk to 

suit the paper size. 

This option is best if you have a large or small design and want it to fit on one page. 

Automatic fit 

Your design will be orientated as necessary, but Photo & Graphic Designer will not 

change the size. We recommend this option if you are having any difficulty getting the 

orientation right (there are at least four places where you can set the page orientation, 

sometimes more for some printer drivers). 

This option is best if you have a set size for your design and don't want it altered. 

Custom fit 

Allows you to have control over your print out, including orientation, size and margins. 
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The ORIENTATION buttons can be used to choose the orientation of the printout. The 

scale can be altered using the SCALE field. The top and left margin fields can be changed 

(these set where the top left-hand corner of the page appears on the printer's paper). 

The WIDTH and HEIGHT fields give you an alternative way of setting the print scale (when 

you change one of these settings, the other changes to ensure the page is always 

printed with a 100% aspect ratio). 

Multiple fit 

To print multiple copies on one page, choose MULTIPLE FIT, enter a value for the number 

of copies needed across the page (rows), the number down the page (columns), and the 

distance between each (gutter). 
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Imagesetting 

Spot colors 

Normally four colors are used when printing, cyan, magenta, yellow and black (key) 

commonly known as CMYK. But it’s also possible to produce spot colors. Spot colors are 

not normally printed using the CMYK inks, and are instead additional inks. 

Spot colors have two uses: 

 Many simple jobs use only two or three ink colors (for example a simple newsletter 

with black text and blue headings). Creating a spot color for each ink color can make 

the job cheaper to print. 

 Some complex jobs require either PANTONE COLOR BRIDGE colors or special inks 

that cannot be reproduced in CMYK such as gold or silver. These special colors 

require spot colors. 

See chapter PANTONE colors for more on PANTONE COLOR BRIDGE. 

Note: As each spot color is an additional ink and printing plate, it does increase printing 

costs. 

Spot colors appear as circles on the COLOR LINE and COLOR Gallery. 

Spot colors are always Named colors.  

Technical notes on color separations: 

 Tints based on a spot color output on that spot separation. So if you require a lighter 

shade of a spot color, define the color as a Tint (on page 220) of the spot color.  

 Shades and linked colors based on a spot color output on the CMYK separations. 

 Objects with transparency applied always output on the CMYK separations, not to the 

spot separation. 

For more information on how spot colors are affected by transparencies, fills and blends 

see "Transparency and Color Separations" later in the chapter. 

On screen printer plate previews 

The process of printing requires that your artwork is separated into CMYK print colors. It 

can sometimes be useful to see and understand exactly what inks are printed on each 

printer plate, especially if using spot colors.  Xara Photo & Graphic Designer can show a 

simulation of the CMYK separation process on screen, showing a preview of each printer 

ink color separation. Normally this would be the four CMYK colors, but if you use spot 

colors you can preview these as well. 

To preview any required plate or ink color, select "WINDOW" > "SHOW PRINTER COLORS" 

and the required ink color. 
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Simulating print colors on screen 

Because printed colors are often a very different shade to those available on screen, 

Xara Photo & Graphic Designer can adjust the screen color to more accurately simulate 

the printed color.  Simply select "Window -> Show Printer Colors -> Simulate Print 

Colors".  See the section "Viewing Print Colors on Screen" in PANTONE Colors for more 

information. 

Imagesetting dialog 

The IMAGESETTING dialog gives control over printer’s marks and film settings. 

To open it, choose "File -> Print Options", then select the IMAGESETTING tab. Or, from the 

PRINT dialog, click "Options", then select the IMAGESETTING tab. 

 

Output Printer’s Marks 

This switches selected printer’s marks on or off in one operation. Printer’s marks provide 

useful information when printing professionally, for example indicating the edge of the 

document so that it can be cropped to the proper size after printing. 

The default options that are then selected will be suitable for most print jobs. Only 

change them if asked to do so by your print company. 
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As well as for printing, these settings also apply to PDF/X export if the INCLUDE CROP AND 

PRINTER MARKS option is selected in the ADVANCEDOPTIONS, LAYERS tab of the PDF 

export dialog. 

See PDF Export (on page 517) for more information on exporting as PDF/X. 

These are the various printer’s marks options that you can turned on or off. 

 

1) Crop marks 

These are used for jobs that will be trimmed to size after printing. They tell the print shop 

where to cut the paper. 

2) Plate information 

This is information such as plate name, file name and date & time. 

3) Registration targets 

Registration targets appear in the same position on each separation so the print 

company can align the separations when making printing plates and when printing. 
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4) Registration stars 

These are a further check that the separations are lined up. 

5) Grayscale bar 

This shows that the imagesetter or printer has rendered the full range of gray tones from 

10% to 100%. It also provides the print shop with useful information during printing. 

Useful for both monochrome and color work. 

6) Progressive color bar 

Similar to the grayscale bar. Provides the print company with useful information when 

printing multicolor work. 

7) Long registration targets (Not shown in the example)  

These are an alternative form of registration targets. Some print companies may prefer to 

work with this type of target. They replace the registration marks shown (option number 

three) with this target type: 

 

8) Overprinted color bar 

Similar to the grayscale bar. If your document uses overprint, this provides the print 

company with useful information during printing. 

Print films 

Films used to be used for press printing, but have been phased out by most print 

companies in favor of PDF/X. But if you need to create films, these settings may be 

relevant, and again only change them if asked to do so by your print company. 

Emulsion down (reflect image): Creates a mirror image. This option, if enabled, will 

only work when outputting to PostScript printers. The imagesetting material is coated 

with photographic emulsion on only one side. With this option off, the emulsion is on the 

top of the film when you can read it normally. This may be known as "right reading, 

emulsion up". With this option on, the emulsion is on the back of the film as you read it. 

Called "right reading, emulsion down" or "wrong reading, emulsion up". 

Negative: Produces a negative image. This option, if enabled, will only work when 

outputting to PostScript printers. Leave off if you are asked for "positive" or just "pos". 

Turn on for "negative" or "neg". 

Always overprint black: Overprints any objects that are over 95% Key (CMYK black). 

Black is a relatively opaque ink and overprinting reduces registration problems. This 

option is particularly useful if you have a lot of black text. If your document has large 

areas of solid black, overprinting all black can cause problems with over-inking on the 

press. Overprinting is described later in the chapter. 
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Separations dialog 

The SEPARATIONS dialog gives control over separations and PostScript settings. 

To open it, choose "File -> Print Options" then select the SEPARATIONS tab. Or, from the 

PRINT dialog, click OPTIONS then select the SEPARATIONS tab. 

 

PostScript options 

The settings give you control when sending to a PostScript printer. They are ignored by 

any other type of printer. It is unlikely you will need to change these, but if asked to do so 

you can change the settings described below. 

Use printer defaults: Selecting USE PRINTER DEFAULTS uses the standard settings for 

the selected printer. Generally these give good results, but if you want greater control 

choose USE CUSTOM SETTINGS. 

Use custom settings: Selecting USE CUSTOM SETTINGS lets you configure the printer 

settings to suit your requirements. Note: No check is made whether the settings you 

choose are suitable for the type of printer; it is assumed you know your requirements. 

Target printer resolution: Specified in dots-per-inch (DPI). 

Default screen frequency: Specified in lines-per-inch (LPI). Tints of the basic ink color 

are printed as small dots called halftone dots. The dots are arranged in rows and the 
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number of rows to the inch is the screen frequency. The lower the screen frequency, the 

larger the individual halftone dots and the more noticeable they are. Your print company 

may ask for “120 line screen” which would be a screen frequency of 120LPI. 

Screen/dot type: PostScript printers can print halftone dots in a variety of shapes. 

Generally round dots give the best results but some presses work better with a different 

dot shape. 

Print Color Separations 

If you want to print all the colors in one pass through the printer, deselect PRINT COLOR 

SEPARATIONS. This full color output is referred to as a composite output. 

If you want to produce output separated into the CMYK process colors and any spot 

colors, select PRINT COLOR SEPARATIONS. If you have one spot color, for example, you 

will get five printouts: one for each of the CMYK colors, and one for the spot color. 

Your print company can advise you on whether they want composite or separated files. 

Separating to a local printer is useful if you want to view each separation. 

You can now set options for the individual separations. 

To output a separation for an ink color, select the left-hand check box. By default all 

plates are set to print. 

You can also view each separation within Xara Photo & Graphic Designer with the 

"Window -> Show Printer Colors" options. 

To set an ink color to overprint, select the right-hand check box. Overprinting is described 

later in the chapter. 

To change the screen angle and 

frequency, click on the ink name to 

select it then click PROPERTIES. 

This opens the SEPARATION 

PROPERTIES dialog: 

 

Angle: To change the screen angle for this color, type in a new value in degrees. 

Frequency: To change the screen frequency for this color, type in a new value. This 

overrides the default screen frequency (described in PostScript options earlier) for this 

color. 

Print this ink: This duplicates the check box in the main SEPARATIONS dialog. 
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Overprint this ink: This duplicates the check box in the main SEPARATIONS dialog. It 

protects the selected color from being knocked-out, so works in the reverse to object-

level overprinting. Overprinting is described later in the chapter. 

Print spot colors as process colors: Desktop printers and some printing processes 

can only print process (CMYK) colors. Select this option to print any spot colors as their 

equivalent CMYK color. Note: some spot colors look very different when output as 

CMYK, and it removes the ability to use PANTONE COLOR BRIDGE (Designer Pro only) 

colors or any special inks. The main use of this option is when checking your artwork on 

a local printer. 

Overprinting 

If you are producing color documents that will be printed on litho printing presses, you 

may find overprint useful. Printing presses are mechanical devices with the inevitable 

slight misalignments when they are running. Overprinting lets you overcome these 

misalignments. For example, your job may have a black circle on a cyan background. 

When the document is imageset, the circle appears on the black separation and the cyan 

separation has a non-printing area under the circle (the technical term is that the circle 

"knocks-out" the background). The knock-out is the same size as the circle. 

 

A black circle knocks-out out the cyan background 

If the two plates do not line up exactly during printing, the circle will slightly offset from 

the knock-out (known as "out of register") and a small white gap can appear. 

 

This example is exaggerated to illustrate the 

out of register printing, but even thin lines can 

be noticeable with dark colors. 

Overprinting compensates for this problem. Xara Photo & Graphic Designer has two 

types of overprinting: object level and ink level. 
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Object level overprinting 

You can separately specify overprint for the line and fill colors of an object. 

To overprint the line on an object, select the object then: 

 Right click and choose "IMAGESETTING" > "OVERPRINT LINE" 

 Or choose "UTILITIES -> IMAGESETTING -> OVERPRINT LINE". 

 Or right click the object, then choose "IMAGESETTING -> OVERPRINT LINE". 

To overprint the fill on an object, select the object then: 

 Right click and choose "IMAGESETTING" > "OVERPRINT FILL" 

 Or choose "UTILITIES -> IMAGESETTING -> OVERPRINT FILL". 

 Or right click the object, then choose "IMAGESETTING -> OVERPRINT FILL". 

To turn off overprint on an object, just select the relevant option again. You can overprint 

both the line and a fill on an object if required. The object’s fill and/or line will then not 

knock-out the colors any colors below it. Overprinting the fill is most commonly used to 

overprint dark colored text. 

Overprinting the line is the normal way of avoiding out of register printing. The print 

company can tell you the tolerance to allow (usually 0.5pt to lpt). The line color depends 

on the background and object colors. Unless you want a specific line color, set the line to 

the lighter color. 

Ink-level overprinting 

Xara Photo & Graphic Designer has two ink-level overprint options: 

 Overprint everything, including tints, in the specified ink color. Set in the SEPARATIONS 

dialog box (see above). This option is rarely useful, but works in the reverse of object-

level overprinting. For example if you select Cyan to be overprinted, it will cause cyan 

to not be knocked-out. 

 Always overprint black (everything over 95% Key). Set in the IMAGESETTING dialog 

box. Black is a relatively opaque ink and overprinting reduces registration problems. 

This option is particularly useful if you have a lot of black text. If your document has 

large areas of solid black, overprinting all black can cause problems with over-inking 

on the press. 

Printing on all plates 

PRINT ON ALL PLATES is known in some programs as REGISTRATION BLACK. 

You sometimes want an object to appear on all separations. To do this, select the object 

then right click and select "IMAGESETTING" > "PRINT ON ALL PLATES" or choose "UTILITIES 

-> IMAGESETTING -> PRINT ON ALL PLATES". 

The object color changes to black or gray, depending on its original color, to remind you 

that PRINT ON ALL PLATES is applied. 
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To cancel PRINT ON ALL PLATES, select the option again. 

Usually PRINT ON ALL PLATES is applied only to small areas such as additional printer’s 

marks or lines of text. Do not apply PRINT ON ALL PLATES to large areas as this can flood 

the printing press with excess ink. 

Printing & color separating: technical details 

Color separating 

Xara Photo & Graphic Designer converts RGB, HSV and grayscale colors to CMYK for 

printing. Because the inks in printers are not pure color, some color correction is 

required. For example, theoretically 100% red in RGB is 100% magenta and 100% 

yellow in CMYK. In practice, less magenta is required to get the right color. Also, in dark 

colors and grays, black ink can replace a proportion of CMY. Color correction in Xara 

Photo & Graphic Designer is entirely automatic. 

CMYK colors do not need color correction and so are usually printed without 

modification. The exception is areas where transparency has been applied. This is 

described in detail below. 

Transparency and color separations 

Transparency helps create some outstanding illustration, but can also cause unexpected 

results when color separating because PostScript imagesetters, and printers do not 

directly support transparency. Areas covered by objects with transparency applied are 

output as an RGB bitmap. This bitmap is then color corrected and separated to CMYK. 

This process happens even to objects with 100% transparency. 

This means that in objects under a transparent object: 

 CMYK color values change. This is particularly noticeable with black and grays which 

will then appear on all four separations rather than just the black separation. 

 Spot colors (and PANTONE COLOR BRIDGE colors) are separated to CMYK (and 

color corrected) (see PANTONE Colors for more on PANTONE COLOR BRIDGE). 

Watch out for: 

Objects under totally transparent objects. Instead of using 100% transparency you can 

use NO COLOR (see The color line (on page 205) for how to apply NO COLOR).                                                                                                                                                                                         

 Text under a transparent object. Where possible, have text as the front object so these 

problems don't occur. 

Intermediate colors in blends and fills 

This section applies to all blends and multicolor fills. That is, all fill types except flat. 

Normally, a graduated color fill mixes colors using the RGB color model. The exception is 

when both end colors are defined as CMYK. In this case, colors are mixed in CMYK. One 
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advantage of this for grayscale blends. An RGB gray is printed as a mixture of the four 

CMYK inks. Defining the gray as a tint of CMYK black gives better printed results. 

Rainbow and Alt Rainbow mix colors using HSV. 

Three-color, four-color, fractal and bitmap fills always output as RGB bitmaps and are 

color-corrected. This means that any spot colors used in these fill types output to the 

CMYK separations not to the spot separation. 

Special rules apply for spot colors: 

 In blends: If either end color is a spot color, you can do fade mixes but not rainbow 

mixes (the reason is because you cannot alter the hue of a spot color). 

 In fills: If either fill color is a spot color, you can do fade mixes but not rainbow mixes. 

 In blends: If both end colors are the same spot color (or tints of the spot color), the 

blend outputs only to the spot separation. 

 In fills: If both fill colors are the same spot color (or tints of the spot color), the fill 

outputs only to the spot separation. Note: this does not apply to three-color, four-color, 

fractal and bitmap fills which output only to the CMYK separations. 

If you blend or fill from a spot color to a non-spot color, Xara Photo & Graphic Designer 

creates the requested blend. For example, if you blend from cyan (CMYK color) to gold 

(spot color) the cyan separation shows a blend from 100% color to no color and the Gold 

separation shows no color to 100% color. This is approximately what you see on screen 

(allowing for differences between screen and printer colors). 

If you convert the blend to editable shapes, the intermediate shapes lose all spot color 

information. They separate only to CMYK. Only the final object prints as a spot color. 

RGB and CMYK Blacks 

Because shades of black and gray that are defined as RGB or HSV colors will separate 

into a mix of all four CMYK process colors when printed, you can sometimes get less 

than perfect gray shades. And any slight mis-registration of the CMYK color printing 

process will sometimes be visible on the edges of black objects. 

Although the theory is that an equal mix of CMY inks will give a perfect shade of gray, it 

does not (and this is why the black "K" ink is added to the mix). So a gray that is defined 

as an RGB or HSV gray will contain a mix of all four colors to improve the gray color.  But 

the best gray can be achieved by using only the K (black) ink plate. Thus if you require 

perfect grays it’s better to use gray shades that are defined as a tint of a CMYK "pure" 

black. 

When creating documents based on the default templates designed to be printed, such 

as US Letter or A4, then the shades of gray defined on the Color Line are defined to be 

tints of pure "K" black.  So if you use these gray colors from the Color Line, you will get 

quality printed grays. 

There is a corollary situation that a printed black that is based solely on the use of "K" 

ink, is not that black. You can get far darker blacks by adding some of the other inks 
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printed on top of the black. So if you require really dark blacks for large objects or areas, 

then you can define a CMYK color that has 100% K ink and a percentage of the other 

colors (30% of each of the CMY colors is sometimes used). 
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Importing and Exporting 

General notes on exporting and importing 

You may want to export Xara Photo & Graphic Designer documents to other applications, 

or export them for use on a website. Or you may want to import designs from other 

sources. For easy transfer, Photo & Graphic Designer offers a wide range of import and 

export options. 

Firstly, it is important to note the distinction between saving and exporting files: 

 SAVING deals with storing your work so that you can open it and work on it at a later 

date. Xara Photo & Graphic Designer saves your work in the .xar file format. Think of 

this as the "master document" format. 

 EXPORTING deals with converting designs to other supported formats. Exporting allows 

you to use and distribute your designs. For example, you may want to create a PNG 

file for a website, or a TIFF or PDF file for a printing company. Exported files are no 

substitute for saved .xar files because they are not a complete representation of your 

Xara Photo & Graphic Designer design, so always save your design as a .xar file too.  

Recommended formats 

The universal export formats, that can be read by the widest range of programs are the 

bitmap formats, GIF, PNG and JPEG. These are also guaranteed to look exactly as you 

see on screen in Xara Photo & Graphic Designer.  PNG is the highest quality and can 

include transparency support and is recommended for Microsoft Office applications. 

PDF is the recommend export format for sharing files to be viewed or exported into 

Adobe Illustrator. Xara Photo & Graphic Designer's PDF export is very high quality, is 

vector based, and supports advanced features such as graduated transparency. 

Export your document as HTML to export each page as a web page that can be 

published and viewed using any popular web browser.  

Other notes 

With EPS and bitmap files you have a range of options on how to translate the data. 

Some of these options can produce very large files (if, for example, your document has a 

lot of graduated or radial fills or transparency). 

File translation can take some time for a complex illustration. 

Please note that other manufacturers can, and often do, change the specification of other 

file formats. Information is given here in good faith but no guarantee is given that files 

can be transferred between Photo & Graphic Designer and any other package. Further, 

there are often numerous different variations of a given file format, and Xara Photo & 

Graphic Designer cannot support them all, especially if they are recent and non-

documented formats. 
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Because other programs do not support all of the features of Xara Photo & Graphic 

Designer, for example, the advanced fill and transparency types, these have to be 

simulated, usually by exporting these objects as bitmaps. 

Import and Export Supported File Formats 

You can change the order of supported import and export file formats in the FILE > 

EXPORT and FILE > IMPORT dialogs by editing the FileFormats.xml file found in the 

program folder where you installed Photo & Graphic Designer. 

Import formats 

It is important that you use the three letter file extensions listed below when you load files 

into Xara Photo & Graphic Designer. 

Bitmap Import Formats 

.BMP Windows Bitmap 

.CUT Halo CUT (256 color) 

.DCM Digital Imaging and Communications in Medicine (DICOM) image format 

.DCX DCX 

.FAX Fax image from a fax received or created with fax software 

.GIF Graphics Interchange Format 

.ICO Microsoft Windows Icon (16 color) 

.JPG JPEG 

JPEG2000 (.JP2, .J2C, .J2K, .JPX, .JPF) 

.HPD, .WDP,.JXR Microsoft Photo HD / Windows Media Photo/ import (also known as 

JPEG XR)  

.MXB MAGIX Bitmap 

.PAI MAGIX Photo Clinic Image 

.PBM UNIX monochrome 

.PCD PhotoCD 

.PCT PICT 

.PCX PCX Paintbrush 

 PGM UNIX grayscale 

.PNG PNG 

.PPM UNIX color (up to 24 bit) 

.PSD Photoshop (see importing (on page 509) and exporting PSD files (on page 514)) 

16bit files and CMYK colors are supported in Designer Pro & Photo & Graphic Designer 

only. 

.RAS Sun Raster 

.SGI Silicon Graphics Image 

.TGA TrueVision TARGA  

.TIF TIFF (RGB, RGBA with alpha-channel transparency).  

Xara Photo & Graphic Designer supports: fax TIFF files (black and white images. Multi-

page faxes will be imported as multiple pages); Mac or PC byte order TIFF files; TIFF 

with layers and transparency (if saved from Photoshop the rules for blend mode 

compatibility are the same as for PSD files); JPEG in TIFF (transparency is not possible 

in this case) 
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.XAR Xara Photo & Graphic Designer 

.XBM X Windows (2 color) 

.XPM X Windows (256 color) 

.WBMP Wireless Bitmap Image. Black and white (1-bit) bitmap image format used by 

mobile devices 

.RAW camera import formats (see RAW photo import (on page 511) for a list of 

supported file types). 

EPS Import Formats 

.AI Illustrator EPS 

.EPS ArtWorks EPS 

.EPS Illustrator EPS 

.EPS CorelDRAW 3 & 4 EPS 

.EPS FreeHand 3.0 EPS 

.EPS Photoshop EPS (For importing data from Photoshop into Xara Photo & Graphic 

Designer, use PSD files instead of EPS files for best results) 

.EPS XaraX EPS 

Other Import Formats 

.ART Xara Studio 

.WEB Xara Webster files 

.AFF Acorn Draw 

.CDR CorelDRAW (3,4 & 5)  

.CDT CorelDRAW Template 

.CMX Corel CMX 5 & 6 

.DRW Acorn Draw 

.HTM, .HTML Graphics on HTML pages, HTML files 

.WMF Windows Metafile (16bit) 

.EMF/ .WMF Enhanced Windows Metafile 

.DOCX/.DOC  Microsoft Word Document 

.RTF Text 

.SVG Internet Scalable Vector Graphics 

.WIX For internal use by Xara 

Palette Import Formats 

.CPL CorelDRAW Palette 

.PAL CorelDRAW Palette 

.PAL Microsoft Palette 

.PAL PaintShop Pro Palette 

.ACT Adobe Color Table 

.ACO Adobe Color Swatch 

For information on how to import palettes, see Importing colors and palettes (on page 

222) 
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Export formats 

Bitmap Export Formats (see GIF, PNG, BMP and JPEG export dialog overview (on page 

534)) 

.BMP Windows Bitmap  

.DCX DCX 

.PCX PCX 

.GIF CompuServe GIF 

.GIF Animated GIF files (see Creating animated GIF files (on page 465)) 

.JPG JPEG  

JPEG2000 (.JP2, .J2C, .J2K, .JPX, .JPF) 

.PDF (see Creating PDF files (on page 518)) 

.PCT PICT 

.PNG PNG 

.RAS Sun Raster 

.TGA TrueVision TARGA 

.TIF TIFF (RGB) 

.WBMP Wireless Bitmap Image. Black and white (1-bit) bitmap image format used by 

mobile devices 

EPS Export Formats 

.AI Illustrator EPS 

.EPS ArtWorks EPS 

.EPS Illustrator EPS 

.EPS Xara Xtreme EPS 

Other Export Formats 

.AVI AVI animation (animation documents) 

.XAR CorelXARA 

.XAR Photo & Graphic Designer 

.WEB Xara Webster files 

.WMF Windows Metafile  

.DOCX/.DOC  Microsoft Word Document 

.EMF Enhanced Windows Metafile 

.PSD Photoshop (see importing and exporting PSD files (on page 514)) 

.CMX Corel CMX 5 & 6  

.HTM Image map 

.HTM, .HTML Website (HTML) 

.SWF Flash (animated Flash export with automatic tweening and single frame Flash 

export - see Flash Animations (on page 459)) 

.RTF Rich Text Format 

.SVG Internet Scalable Vector Graphics 

.WIX For internal use by Xara 

.PDF + PDF/X-4 Portable Document Format, High quality PDF files 

Importing files 

To import a file: 
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 Select "FILE" > "IMPORT" -  This normally merges the file's contents into the existing 

document. With some formats you get the choice of importing the document into the 

current page or adding it as a new page. With some other formats you are given the 

option of either importing the file data conventionally, or adding a link to the file and 

including it in your published website. 

 Or select "FILE" > "OPEN" - This opens the file as a new document. 

Xara Photo & Graphic Designer supports drag and drop import of files. If you drag a file 

from your File Explorer onto an open Xara Photo & Graphic Designer document it will 

import the file and place it on the current page, centered on the drop point. Or drag & 

drop a suitable file from Windows Explorer onto any bar or the title bar of Photo & 

Graphic Designer's window - it will open the file as a new document. 

Replacing Image Files 

You can replace any loaded image or image-filled shape with your own images. To 

replace an image simply drag your own file (JPEG, GIF, PNG, BMP) from your Windows 

File Explorer and drop it on top of the picture that you want to replace. Your photo will 

automatically be scaled appropriately to replace the existing photo. The new photo will be 

selected and you’ll be put into the FILL TOOL (on page 296) so that you can easily adjust 

the position and scale of your photo if desired.  

See the "Replacing photos (on page 360)” section of the Photo Handling chapter for 

more details. 

Importing a Photoshop PSD file 

To import a PSD file, import the file as normal with "FILE" > "IMPORT", or just drag and 

drop the .psd file into Xara Photo & Graphic Designer.  

A dialog opens asking you if you want to import the Photoshop layers as objects - this is 

the default, or if you want to import the layers as layers. 

It’s recommended that you use the default option, where PSD layers become Xara 

objects, because whereas in Photoshop effects like transparency are applied to layers, in 

Xara layers are simply containers for objects and different objects on the same layer can 

have different transparency and other settings.  

The default DPI setting will be the one at which the PSD file was created.  

The file will open on your workspace. View the file/object structure by opening the PAGE & 

LAYER GALLERY.  (on page 193) 

All the Xara transparency modes (apart from the Enhance mode) are compatible with the 

equivalent Photoshop blends and will remain editable in in Xara Photo & Graphic 

Designer using the TRANSPARENCY TOOL. 

Photoshop calls it Opacity, but it’s the same thing as Transparency (just the other way 

around), i.e. a 90% opacity value in Photoshop becomes a 10% transparency setting in 

Xara Photo & Graphic Designer. 



 

 510 Importing and Exporting 
  

 

 

Tip: if you have separate objects in Photoshop that you wish to be able to move and 

change independently of one another in Xara Photo & Graphic Designer, place them on 

separate layers in Photoshop before exporting. 

Attention: Only Designer Pro & Photo & Graphic Designer can import PSD files with 

16bit colors or CMYK color model 

TIFF Import 

Xara Photo & Graphic Designer TIFF import supports a much wider range of TIFF file 

types, including: 

 CMYK TIFF files. 

 Fax TIFF files (black and white images. Multi-page faxes will be imported as multiple 

pages into Xara Photo & Graphic Designer). 

 TIFF with transparency (if exporting a TIFF from Photoshop (Save As) you can select 

the SAVE TRANSPARENCY checkbox). 

 Mac or PC byte order TIFF files. 

 TIFF with layers and transparency (if saved from Photoshop the rules for blend mode 

compatibility are the same as for PSD files). 

 JPEG in TIFF (transparency is not possible in this case). 

Usually TIFF files have a file extension of .tif. 

PDF Import 

PDF is a complex vector graphics format that has evolved over 10 years or more and 

contains numerous sub-formats and options. PDF was designed as a portable document 

format for viewing and printing only, and was not intended as a file format for transferring 

data between applications. However Xara Photo & Graphic Designer should load the 

vast majority of PDF files. 

PDF is now the recommended way of transferring vector files from Adobe Illustrator to 

Xara Photo & Graphic Designer. Save as PDF and then import the resulting file into Xara 

Photo & Graphic Designer. 

The following points are worth noting: 

 Multi-page PDF files are imported as multi-page documents in Xara Photo & Graphic 

Designer. 

 Text in PDF files is typically broken into many separate small text objects in the PDF 

file. This doesn’t stop it viewing and printing, but means when imported what might 

appear as one or more continuous paragraphs of text is not. Xara Photo & Graphic 

Designer tries to re-assemble the lines of text into lines and paragraphs of editable 

text, but often you will find the text broken into separate text objects. 

 In order to make it easier to extract just the text of a PDF file, a new layer is created 

containing just the text on that PDF page. Use the PAGE & LAYER GALLERY (on page 

193) to view this layer. 
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 PDF files make liberal use of clipping. This appears in Xara Photo & Graphic Designer 

as ClipView objects, and so it’s often necessary to use "ARRANGE > REMOVE CLIPVIEW" 

in order to edit the objects on the page. 

 Any annotations in the PDF file are imported onto a separate layer called “PDF 

annotations” in your Xara Photo & Graphic Designer document. 

What might not work: 

 Many PDF files include embedded fonts. It’s not possible to legally extract and install 

these fonts onto your system. So if you do not already have the fonts used in the PDF 

file you will find alternative fonts have been substituted. 

 If you attempt to edit embedded subset fonts with the Print and Preview permissions 

you will receive a restricted license font warning which you can either cancel, or ignore 

(for the current session only).  

 Files that are encrypted or password protected cannot be imported. 

PDF is a highly complex format, and often can't be imported perfectly. The best way to 

import it may depend on how you intend to use it. The "OPTIMIZE FOR VIEWING" option 

attempts to make the imported result look as similar to Acrobat as possible, but it may be 

more difficult to edit (it could have many nested clipviews for example). The alternative 

“OPTIMIZE FOR EDITING" option strips out some constructs which are difficult to manually 

edit (for example, nested clipviews). 

Importing a Word document 

You can easily import a Microsoft Word document (.docx). Simply drag and drop the file 

from Windows Explorer, or else select "FILE" > "IMPORT".  

RAW photo import 

You can import RAW digital camera files, either by using the Import menu option or just 

drag & drop the file onto the Photo & Graphic Designer window. 

Supported file extensions include: *.crw, *.cr2, *.rw2, *.nef,*.mrw,*raf,*.kdc,*.orf, *.dng, 

*.ptx, *.pef, *.anw, *.x3f 

However there are many different extensions used for RAW files by different camera 

manufacturers, so if you have a RAW file with a file extension not listed above it’s worth 

trying to import it anyway. 

Importing from a website 

You can import text and graphics directly from web pages on the Internet into your 

document, or copy and paste text and graphics directly from a web browser onto your 

page.  

To import from an online web page: 

1. FILE" > "IMPORT FROM WEB ADDRESS" (or "Ctrl + Alt + W"). 

2. Type in the web address (URL) of the page or graphic you want to import.  

3.  
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If the URL entered is that of a web page, all the text and images on that page will be 

imported and positioned on your page in approximately the same positions as they are 

on the web page. In other words, this function gives you a way to roughly import an entire 

web page in terms of its text and graphics. However note that most modern web pages 

are made up of a complex combination of text, graphics, JavaScript and other features, 

so such imports are unlikely to give you a complete and accurate representation of the 

page in Xara Photo & Graphic Designer.  

When importing from web pages, the length of your page in Xara Photo & Graphic 

Designer will be automatically extended to accommodate the incoming text and graphics, 

if it is not already long enough. 

Exporting files 

To export a file: 

 Right click and choose EXPORT 

 Or select "FILE" > "EXPORT". 

 Or press "Ctrl + Shift + E". 

An EXPORT dialog box will appear. Choose a name for your file, and select the required 

format from the SAVE AS TYPE dropdown list. Some of the supported formats are detailed 

below. 

Exporting as PDF 

The PDF format is an ideal way to distribute your document for a variety of uses. It can 

be used to supply artwork to a printing company, or it can be used to import in to other 

programs such as Adobe Illustrator 9 and later. This is described in detail in the next 

section. 

Exporting to a Word document 

Select "FILE" > "EXPORT" and then choose the MICROSOFT WORD (.DOCX) option from the 

drop-down menu.  

Exporting as Flash 

You can export a drawing to Adobe's SWF Flash format (static). This is best suited to 

vector designs, and can provide very small file sizes. You can then use the SWF in a 

website, or import it into Flash for use in Flash animations. 

You can also create animated Flash. See Flash Animations (on page 459) for more 

details on Flash export. 

Exporting as AVI 

Select FILE > EXPORT ANIMATION and choose the AVI type from the type list. Click the 

OPTIONS button on the file dialog to change the codec and other settings used for the 

export. 
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Exporting as Photo & Graphic Designer EPS 

This saves the document as an EPS file. It is the recommended EPS format for exporting 

to (for example) DTP programs, as all information is retained. 

Exporting as ArtWorks EPS 

This saves the document so that you can load it into ArtWorks, Computer Concepts' 

illustration program for Acorn RISC computers. Files in this format cannot be loaded into 

other programs on the PC. Some features, such as transparency, do not exist on 

ArtWorks. 

Exporting as Illustrator EPS 

This is recommended for older versions of Adobe Illustrator (for version 9 onwards we 

recommend using PDF export, see above). 

 

Exporting as Windows metafiles (.wmf) 

Files in this format can be read by Word and several other programs. 

Exporting as SVG 

Export either the currently selected objects or the whole page area as an SVG (Scalable 

Vector Graphic) file. 

The export dialog allows the setting of a dpi value (96 dpi default) for bitmaps should they 

be included on the page and also the following formatting options: 

 PATTERN (INKSCAPE) 

 CLIP PATH (ADOBE) 

 NON-REPEATING AS CLIP PATH 

Exporting as Extended Metafile Format (EMF) 

Modern Windows applications support this enhanced type of vector graphic format. This 

format is also available to applications that provide a Paste Special menu option. 

Note that Xara Photo & Graphic Designer can contain features, such as advanced fill 

styles, that cannot be represented in vector formats such as EMF. In this case parts of 

the image will be exported as bitmaps. Those vector parts that can be exported as 

vectors are exported as vectors. 

Exporting as a bitmap 

JPEG, GIF and PNG are universal formats supported by most modern computer 

applications. PNG is the highest quality. JPEG is better suited to photographic work, but 

can produce acceptable, compact files (you can control the quality and file size). 
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GIF format only supports 256 colors, and although common on many websites, PNG is a 

better format.  PNG also supports semi-transparent graphics (use the True Color + Alpha 

option), but this is not correctly supported by older Microsoft Internet Explorer versions (it 

is by all other web browsers). 

The fewer colors you have in a file, the smaller the file and the lower the quality. 

However, when using 256 colors or less Xara Photo & Graphic Designer provides very 

advanced techniques to simulate a much wider range of colors, and so you can get very 

high, near photographic quality results using only 256 colors or less. 

See also GIF, PNG, BMP and JPEG export dialog overview (on page 534). 

Important 

 

Bitmaps are output at the current view quality so for best results 

make sure that "WINDOW" > "QUALITY" or the slider on the Standard 

control bar is set to anti-aliased. 

 

Exporting a Photoshop PSD file 

Photoshop is a bitmap editor, so when exporting to PSD format all the vector objects in 

Xara Photo & Graphic Designer are rasterized. You can select the resolution (dpi) when 

exporting. 

Always save your work in Xara Photo & Graphic Designer prior to exporting. Then, if you 

wish to alter your original objects in the future, just load Xara Photo & Graphic Designer, 

make any changes and then export the required objects again. 

To export as a PSD file choose "FILE" > "EXPORT" then select ADOBE PHOTOSHOP in the 

SAVE AS TYPE list. 
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PSD Export settings 

The PSD export dialog gives you several options. 

 

Resolution in DPI 

A DPI of 96 is the normal Windows screen resolution, and so exporting at 96dpi will 

appear in Photoshop at the same size at 100% as it does at 100% in Xara Photo & 

Graphic Designer. For print work you should choose a higher DPI. 

Export each object as a PS Layer     

Xara objects are mapped to PS layers so each object becomes a separate layer in 

Photoshop. This is a good fit between the two applications, because whereas in 

Photoshop effects and blend modes are applied to whole layers, in Xara the same tools 

are applied to objects, not layers. So it’s more useful to map Xara objects to and from 

PSD layers where they will remain editable. This is the default option. 

Export each layer as a PS Layer 

Each Xara layer is exported as a separate layer in Photoshop. All objects on the same 

layer (including the layer names) are exported as one bitmap.  If you choose this method 

and want to have objects like text and transparency (blends in Photoshop) remain 

editable then they have to be placed on their own separate layers before export. If 

objects using different types of transparency are combined on the same layer in Xara 

Photo & Graphic Designer, an alert - warning you of this will pop up when you export.  

Export just visible objects 

Exports all visible objects on the page and pasteboard areas.  

Export whole page area 



 

 516 Importing and Exporting 
  

 

 

Exports the whole page area together with visible objects on the page area only.  

Image slicing 

Large, complex graphics for web pages can produce large files which take a long time to 

download over the Internet. You can reduce this problem by "slicing" the image into 

sections which can be downloaded separately. 

Another use of slicing is optimization. For example, if you have a photo on a plain flat 

color background, then you can optimize the graphic by exporting just the high detail 

area (photo) as a JPEG or 256-color GIF, and the other areas as, say, a 2-color GIF. 

This minimizes the amount of data to download. 

To slice an image: 

1. 
slice (for example, the photo) a name. Use theNAME GALLERY OR THE NAMES ICON 

ON THE SELECTOR TOOL INFOBAR. (FOR MORE COMPLICATED IMAGES YOU MIGHT 

WANT TO NAME MORE OBJECTS.) 

2. NAME GALLERY choose the export options for the slice. Click EXPORTS from 

the dropdown menu, click on the file type next to the named image, set your export 

options as you wish for that slice, and then click APPLY. 

For more on the Name Gallery refer to Document Handling (on page 83). 

Export the graphic in slices 

You do not need to specify how to slice the image as Xara Photo & Graphic Designer 

does this automatically from the information in the NAME GALLERY. 

1. Select the complete image including any slices 

2. Select "File -> Export image in slices". 

3. Select the file format (this will apply to all areas of the image other than your slice). 

4. The file name is the HTML file that contains the HTML code for the sliced image. 

You can change the file name if required. 

5. Click SAVE. 

6. Select the required save options (these will apply to all areas of the image other 

than your slice). 

7. Click EXPORT to save the sliced image. 

To prevent specific named objects from slicing: 

1. In the dropdown list in the NAME GALLERY, select SLICES. 

2. Names with a check beside them slice the graphic – if necessary, deselect any 

check boxes. 
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PDF Export 

The Portable Document Format (PDF) provides the best way to transfer drawings and 

document to others.  The free Adobe PDF Reader is very popular and enables anyone to 

view and print your PDF document. 

For very complex vector graphics, PDF can be very slow (sometimes 20 times or more 

than Xara Photo & Graphic Designer), so drawings that take a few seconds to draw in 

Xara Photo & Graphic Designer can take minutes, especially when printing. So 

sometimes it’s quicker to convert complex vector graphics into a bitmap before exporting 

your PDF. 

PDF files are vector graphics files-which means they are resolution independent, and are 

great for printing on high resolution devices, and you can zoom in to view detail with no 

loss of quality.  Your graphics or document exported as a PDF should look exactly like it 

does in Xara Photo & Graphic Designer. 

There are different versions of PDF, including a specialized version, known as PDF/X 

which was developed by the printing industry and has become a very popular way of 

transferring files for commercial printing. 

Xara Photo & Graphic Designer provides very comprehensive controls over many 

aspects of your PDF output. These are just some of the options and features you can 

control in Xara Photo & Graphic Designer PDF output. You can: 

 embed fonts in the file which means all readers can be sure of seeing the file exactly 

as you intend, but this makes the files larger. You can also select to embed only a 

subset of the fonts (only the used characters) to reduce the PDF file size; 

 set it to re-sample all images or photos to be any required resolution so they are not 

unnecessarily high resolution; 

 set it to convert bitmaps to JPEG or remain in their raw state; 

 make it so that layers in your Xara Photo & Graphic Designer drawing are visible and 

can be switched on and off in Adobe Reader; 

 select which version of PDF or PDF/X file you want to create; 

 select which pages of a multi-page document are exported; 

 make your PDF file password protected; 

 even embed the original .xar file (or other files) into the PDF for the ultimate in 

document portability. 

To make life easier all the options have been distilled down to four easy choices. When 

you export as a PDF you are presented with a choice of the following presets: 

 Draft quality. 

 Email distribution or Web download. 

 High quality. 

 Commercial printing (PDF/X). (Designer Pro, Photo & Graphic Designer only) 

You can customize the settings of any of these presets by clicking the ADVANCED 

OPTIONS button. 
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Exporting PDF files 

PDF versions 

PDF has evolved over the years as more features have been added. Typically, along 

with each new version of PDF, a new version of Adobe Reader is released to support the 

new PDF features. Unfortunately, the version number of PDF Reader and the PDF file do 

not match. So, for example, Adobe Reader version 5 is required to read PDF versions 

1.4. 

PDF version 1.4 was the first version to support transparency and so is the minimum 

generally recommended version to use.  Later versions support some of the extra 

features. For example, if you want to use the Layer feature (so you can switch Xara 

Photo & Graphic Designer layers on and off in Adobe Reader), you need to export as a 

PDF version 1.5, or higher, and this requires Adobe Reader version 6, or higher. 

You can export files in PDF version 1.3, 1.4, 1.5, 1.6 and 1.7 formats as well as the 

following PDF/X standards: 

 PDF/X-1a:2001 (ISO 15930-1). 

 PDF/X-1a:2003 (ISO 15930-4). 

 PDF/X-3:2002 (ISO 15930-3). 

 PDF/X-3:2003 (ISO 15930-6). 

 PDF/X-4:2008 (ISO 15930-7).  

Objects not supported by PDF 

Some Xara Photo & Graphic Designer features do not exist in PDF, so the conversion to 

PDF has to simulate these features, usually by converting to a bitmap or bitmap fill. 

Transparency 

PDF version 1.3 does not support transparency. Any objects containing transparency will 

be exported as bitmaps, a process sometimes called "flattening". Xara Photo & Graphic 

Designer does this automatically. The resulting PDF file should still look correct however. 

Transparency Types 

Xara Photo & Graphic Designer supports a number of different transparency types and 

ten of these have direct equivalents in PDF/X-4. 

 Normal (Mix) 

 Screen (Bleach) . 

 Multiply (Stained Glass). 

 Color Dodge  

 Color Burn 

 Hardlight 

 Overlay 

 Softlight 

 Luminosity 

 Color 
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Other transparency types in Xara Photo & Graphic Designer have no direct PDF 

equivalents, so they are converted to bitmap in the PDF file. 

Fill types 

Fill types flat, linear, circular and elliptical are all mapped directly to equivalent PDF 

types, but the other more complex fill types (Conical, Diamond, Three Color, Four Color, 

Fractal Cloud fills and Fractal Plasma fills) supported by Xara Photo & Graphic Designer 

have to be represented using bitmap fills in the PDF. 

ClipViews 

The PDF export filter does not directly support ClipViews comprised of lines or text. 

Convert all lines and text to shapes to ensure that a ClipView that contains these objects 

is properly converted. 

Blends, Molds and QuickShapes. 

Blends and Molds are not part of the PDF format. They are exported as individual 

objects. All QuickShapes are converted to simple shapes. 

Font embedding 

The PDF filter includes support for embedding fonts within a PDF document where 

permission has been granted by the font vendor for this purpose. Where fonts are not 

embedded, if readers do not have the correct font on their system, then usually a "best 

guess" font is substituted by the reading application, resulting in loss of fidelity. 

During the export of a PDF file, you are warned about missing fonts or where required 

fonts could not be embedded. If you intend to distribute your PDF file or submit it to a 

service bureau for printing it is recommended that you: 

Ensure that the target platform has legal copies of any required fonts. 

Flash Embedding 

If you export to PDF version 1.5 or higher, you can include embedded Flash objects in 

your document. Recent versions of Adobe Reader will play the Flash animation while 

viewing the PDF. This feature is not supported by all PDF viewers however.  

To export a PDF file 

1. +E). 

2. Select PDF OR PDF/X (*.PDF) from the SAVE AS TYPE list. 

3. SAVE. The PDF Export dialog will appear: 
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The four preset options will be suitable for most PDFs. They are: 

Draft quality (96 DPI, no font embedding) 

The draft setting is typically used when proofing a design and offers the fastest mode of 

PDF generation. The following settings are used: 

 PDF version 1.4. 

 No fonts are embedded. 

 All bitmaps and photos are embedded as JPEG images at 96dpi. 

This option will produce the smallest file, but note that because no fonts are embedded. If 

you give the file to anyone they must have the any fonts used installed on their system in 

order to be able to see the document exactly as you intended. 

E-mail distribution or web download (Adobe Reader version 5 and above) 

This setting specifies filter options that are optimal for distributing PDF documents 

through e-mail and the web. Fonts are included, so you can be sure your document will 

be viewed exactly as you intended and all images are medium resolution suitable for 

inkjet printing and viewing on screen 

 PDF version 1.4. 
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 Fonts are embedded, and subsetted (meaning only characters used are embedded as 

fonts). 

 All bitmaps and photos are converted to JPG at 150 dpi. 

High quality (300 DPI, larger PDF files)  

The high quality setting includes options for rendering designs as PDF documents where 

full fidelity is required at high resolution. This if most suitable for printing on inkjet printers 

or viewing at high zoom. The following are the key settings: 

 PDF 1.5. 

 Fonts are embedded, and subsetted (meaning only those characters used are 

embedded as fonts). 

 All bitmaps and photos are passed through untouched, unless they are more than 300 

dpi in which case they are sampled down to be 300 dpi but retain their existing type 

(they are not all converted to JPG). 

Commercial printing (PDF/X, 300 DPI images)  

This setting specifies the options required for generating PDF/X documents that will be 

submitted to a print company. The following are the key settings used: 

 PDF version 1.3 (as required by PDF/X). 

 Files are conformant to PDF/X-1a: 2001 (ISO standard 15930-1). 

 Fonts are embedded and subsetted. 

 Bitmaps are converted to CMYK in native (uncompressed) format according the ICC 

Color Profile "US Web Coated SWOP". 

 Crop and printer’s marks are included if these are switched on in the PRINT OPTIONS 

dialog in Xara Photo & Graphic Designer. 

Customizing PDF export using advanced options 

If you select the ADVANCED OPTIONS button you can customize any of the above presets. 

Once you have altered any of the preset values, the next time you export a PDF it 

remembers the last settings, and the CUSTOM option will be shown. The following section 

provides an overview of this feature. 

While the four presets included in the PDF Export Filter will cover most typical scenarios 

for generating PDF output, situations may arise when greater control is required in order 

to specify the properties of the resulting document. 

To customize the output filter settings: 

1. Select the preset that is closest to the desired type of PDF. 

2. Click ADVANCED OPTIONS.... 

3. Modify the desired filter settings. 

4. Click EXPORT to generate the PDF document. 

The modified settings will automatically be stored under the CUSTOM option for use from 

that point on. 

When the ADVANCED OPTIONS button is clicked, the PDF Export Filter options appear in a 

separate dialog box grouped within the following categories: General, Objects, 

Document, Layers, Pre-Press (only Designer Pro) and Security. 
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PDFs for import into Adobe Illustrator (V9 onwards) 

PDF is the best format to use if you need to transfer designs from Xara Photo & Graphic 

Designer to recent versions of Adobe Illustrator. Vector shapes, bitmaps, text and the 

simple fill and transparency types will all transfer with no loss of fidelity. 

Layers 

Adobe Illustrator 9 & 10 fully support editing of layers exported in PDF files. Unselect the 

EXCLUDE INVISIBLE LAYERS option to make sure all layers in your design are included. 

Illustrator CS & CS2 will not preserve design layering. 

Text 

In order to edit text in PDF documents in Adobe Illustrator 9 and 10, embedded fonts 

must be installed on the host system. Also, you must unselect the USE UNICODE FOR TEXT 

ENCODING option in the SETTINGS dialog. 

Bitmap tiling 

Adobe Illustrator 9 and 10 will not read the PDF if tiling is used, so unselect the 

PRESERVE BITMAP TILING option. This is not necessary for CS or CS2 versions. 

Groups 

Select the PRESERVE GROUPS option in the export settings if your document contains 

groups so that they are maintained in Adobe Illustrator. 

Note however that because PDF does not natively support groups, clipping masks will 

appear as part of imported groups in Illustrator CS & CS2. Therefore, when ungrouping 

you also need to remove the clipping mask. 
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PDF Export Filter Settings: General Options 

 

The GENERAL OPTIONS tab in the PDF Export Filter provides a range of settings that can 

be configured to specify PDF document attributes including version compatibility, how 

content is encoded, and which pages are to be rendered. 

PDF Version compatibility 

The PDF Export Filter supports versions 1.3, 1.4, 1.5, 1.6 and 1.7 of the PDF format, as 

well as the most commonly used PDF/X standards to ensure compatibility with a wide 

range of applications. Unless PDF version 1.3 compatibility is required, select PDF 

version 1.4 or greater as the output format as this will provide support for transparency 

Color Model 

The color encoding standard for the PDF document can be selected from CMYK, RGB, 

and NATIVE. The NATIVE option represents colors in the PDF file as they are specified in 

the drawing using RGB and/or CMYK. 
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When CMYK is selected as the color model for a PDF document, an ICC (International 

Color Consortium) profile can be specified. Please refer to the section on Pre-Press 

options later in the chapter for additional information.  

Note: PDF/X documents are limited to CMYK color encoding.Our implementation allows 

you to export a PDF/X-4 as CMYK color model or RGB Color model. CMYK is the default 

option and allows you to select an output from the Pre-Press tab. If RGB is selected, the 

options from the Pre-press are greyed out and a sRGB profile is automatically applied.  

Note that Adobe Reader (and Adobe applications generally) display CMYK colors very 

differently from their RGB or HSV equivalents. To preview what your colors will look like 

when exported to PDF/X select the option "WINDOW" > "SHOW PRINTER COLOR" > 

"SIMULATE PRINT COLORS". 

Options 

 OPTIMIZE FOR FAST WEB VIEWING (LINEARIZATION). Linearization of PDF files generated 

by the export filter encodes the PDF for optimal transfer and viewing over the Internet. 

Be default this option is enabled. 

 EMBED FONTS WHEN PERMITTED. Select this option to include copies of fonts in the PDF 

file that are not included in the PDF base 14 fonts supported by Adobe Reader. Note 

that only those fonts that are not restricted by copyrighting restrictions will be 

embedded in the PDF file. By default this option is enabled.  

Note: PDF/X documents require that all fonts are embedded in the resulting document. 

When exporting PDF/X with font embedding turned on, all fonts are embedded. However 

when exporting PDF the 14 base fonts are not embedded as these fonts are generally 

available to all PDF readers. 

 FONT SUBSET ONLY. This option can be used in conjunction with the EMBED FONTS 

WHEN PERMITTED option to indicate that only those characters that are used within a 

typeface will be embedded in the resulting PDF file. Selecting this option can reduce 

the size of the PDF file that is generated however it will also limit the level of editability. 

By default this option is unselected. 

 VIEW PDF WHEN FINISHED. This option can be selected to automatically launch and view 

the resulting PDF using the default application that is associated with the format under 

Windows. This option is enabled by default. 

 ENABLE CONTINUOUS SCROLLING IN ADOBE READER. Choose this option to have Adobe 

Reader synchronize the scrolling of the PDF document with the movement of the scroll 

bars in the viewing application. By default this option is selected. Note: this option only 

applies to PDF documents that contain more than one page. 

Page Generation 

When generating a PDF document from a multi-page design,  Xara Photo & Graphic 

Designer optionally allows a range of pages to be specified.  

To specify which pages are to be rendered to the resulting PDF document: 



 

Importing and Exporting 525  
 
 

 

 Select ALL to export all pages contained within the design 

 Select CURRENT PAGE to export the currently selected page or 

 Select SELECTED OBJECTS to print only those objects that are selected. 

 To export a range of pages within the design, select PAGES and enter the desired 

range in the edit box. Specify individual pages by their number, separated by commas. 

To specify a range, enter a starting and ending page. For example, to specify that the 

first, third page and pages 5 through 12 of a design should be exported to the resulting 

PDF document enter the following: 1, 3, 5-12. Note: pages will be exported to the PDF 

document in the order in which they appear in the original design. 

PDF Export Filter Settings: Objects Options 

 

The OBJECTS tab in the PDF Export Filter provides a series of settings that can be used 

to specify how design elements are rendered in a PDF document. 
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Bitmap Compression 

Choose the compression scheme for bitmapped images that appear in the document by 

selecting from the options in the dropdown list. Supported compression schemes include: 

NATIVE (use the bitmap compression in the document), NONE (do not apply compression), 

JPEG and FLATE. 

Flate is lossless compression, the same compression used in PNG graphic files or zip 

archives. FLATE can give better results if the PDF contains lot of schematic drawings with 

less colors, but not recommended for PDFs with many photos. 

JPEG Quality 

Use the slider control to set the JPEG quality index when using JPEG compression for 

bitmapped images. Values range from 0 to 100, with higher values specifying increased 

quality and lower values specifying increased compression and the loss of some image 

fidelity. The default JPEG quality is 85. 

Rasterization Resolution (DPI) 

For Xara Photo & Graphic Designer graphic objects that cannot be exported as native 

vector PDF objects (things like soft shadows, feathered objects, bevels), Xara Photo & 

Graphic Designer will automatically rasterize, that is convert to a bitmap. This option 

allows you to choose the DPI (dots per inch) for the rasterization resolution using the 

dropdown list, or click USE CUSTOM DPI and enter a custom value by checking the USE 

CUSTOM DPI option and specifying an integer value between 20 and 600. The default 

preset value for rasterization is 150. The higher the resolution, the larger the PDF file. It 

is not usually necessary, even for the highest quality printing to use a value above 

300dpi. 

Options 

INCLUDE HYPERLINKS: Select this option to preserve any objects containing hyperlinks in 

the outgoing PDF file. By default, this option is selected for standard PDF documents. 

This option is not selected and disabled for PDF/X documents, since hyperlinks are not 

allowed. 

Xara Photo & Graphic Designer supports a number of different link types and mouse-

over actions, which are used mainly when creating websites. Some of these features are 

also supported in exported PDFs, but others are incompatible with PDF and/or not 

useful. Of the many features available in the Utilities->Web Properties dialog, only the 

following are supported with PDF:- 

 Ordinary links to URLs (the ‘open link in’ options do not apply) 

 Page links. When viewing the PDF you can click these links to navigate to the different 

pages of the document, if the PDF viewer supports this. 

 Links to anchors 

 Popup title text (See the Mouse-over tab of the Web Properties dialog). 

CONVERT TEXT INTO SHAPES: This option can be selected to convert all text content into 

vector shapes. This option can be specified to preserve the appearance of text when 

equivalent fonts may not be available on the target system or when font embedding is not 
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permitted. Note that the text in the resulting PDF file is translated into shapes and is no 

longer editable as text. By default this option is not selected. 

USE UNICODE FOR TEXT ENCODING: This option can be used to select the method to be 

used for encoding text in the resulting PDF document. By default, this option is not 

selected and text is encoded using the ANSI encoding scheme. Selecting this option 

specifies that text should be encoded using Unicode. 

PRESERVE BITMAP TILING: This option determines the method that the export filter uses to 

generate tiles in the PDF file. By default, the preserve bitmap tiling option is selected and 

a series of individual bitmaps are used to fill the corresponding object. This option should 

be unchecked when the resulting PDF files are to be used in Adobe Illustrator 9 and 10 

or in any other application that does not directly support bitmap tiles as fills. 

PRESERVE GROUPS: Use this option to maintain groups in the resulting PDF document. 

Note that because the PDF format does not natively support groups, grouping is 

emulated using clipping masks. 
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PDF Export Filter Settings: Document Options 

 

The DOCUMENT tab contains items that can be used to specify authoring information and 

how a PDF document will be opened within Adobe Reader. 

Description 

Within this section, the title, author, subject and keywords for the outgoing PDF 

document can be optionally added. Select INCLUDE DOCUMENT INFORMATION to embed 

these details in the resulting PDF file. By default this feature is not selected. 

Initial View 

Select from among the document viewing options in the dropdown list to specify the 

magnification level of the resulting PDF file when it is viewed in applications that support 

this feature. The default magnification level is 100%. 
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Note: This feature is not available for PDF/X documents. 

Reader Display Setup 

When generating a PDF file that is intended for display in Adobe Reader, you can select 

from among the display setup options in the dropdown list to specify how the viewer is 

configured when the file is opened. 

Options are included for displaying only the page, the bookmarks panel and page, the 

pages panel and page, a full screen version of the document, the layers panel and page 

(PDF 1.5) and the attachments panel (PDF 1.6). The display setup options for showing 

the bookmarks, pages and the layers panel are particularly useful when generating PDF 

documents in which layers are used. 

The default Reader display setup option is PAGE ONLY. 

Note: This feature is not available for PDF/X documents. 

File Embedding 

A unique feature supported by the PDF document format is its ability to embed files at 

the document level. The Xara Photo & Graphic Designer PDF Export Filter allows one file 

of any size and  type to be added to the exported PDF. When the PDF document is 

opened by applications that support file embedding (such as Adobe Reader or Acrobat), 

the embedded file appears in the attachments list panel. 

Embedding a file within the PDF document is particularly useful when distributing an 

illustration or submitting it to a service bureau. Examples for the use of this feature 

include attaching the original Xara Photo & Graphic Designer .xar file, a readme file 

outlining author and copyright information or a high resolution rasterized version of the 

illustration to the resulting PDF. 

To embed a file within an outgoing PDF document, simply click the ellipses button [...] to 

select a file from within a file open dialog or type in the path of the file manually.  

Enable EMBED SELECTED FILE to add the file to the PDF document. By default this option 

is not selected. 

An optional description may also be provided for the embedded file. This description will 

appear as a comment when the attachments panel is viewed in Adobe Reader and 

Acrobat. 

Note: File Embedding requires that the PDF Version compatibility be selected as 1.4 or 

greater. 
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PDF Export Filter Settings: Layer Options 

 

The LAYERS tab within the PDF Export Filter provides a means to specify how layers 

within a drawing are rendered for in the PDF document. 

General Options 

Exclude invisible layers. This option can be checked to exclude all invisible layers in 

the outgoing PDF file. To eliminate guide layers from a PDF document, set the layer to 

invisible in the Xara Photo & Graphic Designer Page & Layer Gallery and export the 

drawing with this option checked. 
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Layering Methods (standard PDF only) 

DO NOT GENERATE READER LAYERS: Separate layers do not appear in the resulting PDF 

document. This option is enabled by default. 

ENABLE READER LAYERS IN A SINGLE PAGE (PDF 1.5 AND ABOVE ONLY): Layers are 

rendered within the document on a single page, with layering labels included for display 

within Adobe Reader's Layer Gallery. 

GENERATE BOOKMARKS FOR EACH PAGE: Select this option to include bookmarks in the 

resulting PDF document for each page of your document. A bookmark is generated for 

each page, using the ‘Page title’ value as defined on the ‘Page’ tab of the Utilities->Web 

Properties dialog. If no page title is defined, the ‘Page filename’ (as defined in the same 

dialog) is used instead. If there is no page filename set either, then pages are named 

simply “Page 1”, “Page 2”, etc. In Adobe Reader you can display the list of bookmarks in 

the document and then just click on them to jump to each page.  
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PDF Export Filter Settings: Security Options 

 

The SECURITY tab provides support for specifying security attributes and permissions 

settings that determine how the PDF document can be used once it is distributed. These 

options are only available for standard PDF documents and cannot be used when 

generating PDF/X files. 

To include these security settings in the outgoing PDF document, check "Apply security". 

By default this feature is not selected. 

File Open Password 

To password-protect a PDF document, specify and confirm a password. This password 

will be required when a user attempts to open the document for viewing. 
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Note that it is strongly recommended that a document also be encrypted if a file open 

password is applied as this security scheme is known to be relatively easy to 

compromise. As a result, file open passwords should only be used as a means of 

security to prevent inexperienced users from accessing sensitive documents. 

Document Encryption and Permissions Password 

To encrypt a PDF document, select an encryption method and specify and confirm a 

password. This password will be required when a user attempts to make changes to the 

document, including modifying security and permissions settings. The encryption 

password is often referred to as the owner or master password and it may also be used 

to open the PDF document. 

Additional document permissions settings (outlined in the section below) may be applied 

to determine the degree to which a user can interact with the encrypted document. 

Four encryption methods are available: 

 NONE: This setting will not apply any document encryption. This is the default 

encryption option for the document. 

 40-BIT RC4: This setting will apply a 40-bit encryption algorithm to the document. 

 128-BIT RC4: This setting will apply a 128-bit encryption algorithm to the document. 

 128-BIT AES: This setting will apply the 128-bit AES encryption algorithm to the 

document. If the PDF document contains confidential or highly sensitive material this 

method of encryption is considered to be the most effective means of securing the 

contents. Note: PDF 1.6 is required to support this encryption method. 

Document Permissions Settings 

The document permissions settings section allows you to specify actions that can be 

undertaken on an encrypted PDF document when it is rendered or processed by another 

application. 

Within the DOCUMENT PERMISSIONS SUMMARY section, check any of the following settings 

to allow a user to perform the following tasks: 

Printing: Selecting this option allows a user to print the PDF document. By default this 

option is selected. 

Extraction for accessibility: Selecting this option allows content to be extracted by 

applications that assist users with impairments. By default this option is selected. 

Commenting: Checking this option allows users to add comments and annotations to 

the PDF document. By default this option is selected. 

Modification: Enabling this option allows users to change the contents of the PDF 

document. By default this option is selected. 
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Document assembly (requires 128-bit encryption): Checking this option allows a user 

to merge or append this document with other documents. By default this option is 

selected. 

Content copying or extraction (requires 128-bit encryption): Selecting this option 

allows a user to copy or extract elements of the document, including text and graphics. 

By default this option is selected. 

Note: The PDF document must be encrypted in order for these permissions settings to 

be applied. In addition, the responsibility for respecting these permissions settings is left 

to the application that is used for processing the PDF document. 

JPEG, PNG, GIF and BMP export dialog overview 

 

The Export settings dialog has two 

preview windows, IMAGE A on the left 

and IMAGE B on the right, so you can 

compare alternative export settings 

or file types, side-by-side. Just click 

on the left or right preview window to 

change the active preview. 

Above the preview window is a small 

dropdown that lets you select from 

the most common four export type, 

JPEG, PNG, GIF and BMP. 

When you have selected preview A or B you can then adjust a wide range of export 

options using the five tabs below the preview. Some options, such as the Palette Options 

are only applicable to some file types such as PNG and not relevant to JPEG type. 

Other options under the OPTIONS tab change depending on the file type. e.g. when 

exporting a JPEG this is where you can set the required quality. 

So the process for exporting an image: 

1. Select the object or objects on the page you want to export 

2. Select the Export menu, or "Ctrl + Shift + E", enter a file name, and select file type 

from the drop down list. The main export type will display the above preview dialog. 

3. In this Preview dialog adjust the settings if you want, or skip this if you're happy with 

the default settings 

4. Click the EXPORT button 

For most commonly used JPEG and PNG formats, at step 2 you can instead use the 

direct operations available in the FILE MENU: EXPORT JPEG and EXPORT PNG. The export 
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dialog shown includes a “Settings” button which takes you to the export settings dialog 

shown above. 

Most export settings are remembered for the next time you export. For example if you 

adjust the JPEG quality, the next time you export a JPEG it will remember the last quality 

setting. 

Exported Image Size 

When you export the normal default size is the same as you see on screen at 100% 

zoom. The pixel size is shown under the preview window. You can adjust the pixel 

dimensions either by adjusting the object size on the page before you export, or by 

entering alternative pixel or dpi values in the BITMAP SIZE tab. 

Preview Controls 

These buttons alter the preview of the images, but do not affect the exported file: 

 

 ZOOM TOOL: Click on a preview to zoom in. Shift-click to zoom out. Drag 

over an area of the preview to zoom into that area. 

 PUSH TOOL: Lets you drag the image around in the preview window. 

 ZOOM TO FIT: Scales the preview image to fit the window. 

 ZOOM TO 100%: Scales the image to full-size (100%). 

 ZOOM TO RESOLUTION OF IMAGE (1:1): Has no effect for GIFs. Scales the 

image so one pixel in the bitmap is one pixel on screen. This is useful for 

previewing detail in the bitmap. 

The following tool is only relevant to files using less than 256 colors (but you will see the 

result when you have the PALETTE OPTIONS tab selected): 

 

COLOR SELECTOR: Moving the pointer over the image highlights the color under 

the pointer. Click to select that color in the palette. You can then use PALETTE 

OPTIONS buttons (described below) to alter that color. 

PREVIEW: The preview button is available on all tabs of this dialog. It updates the preview 

windows to reflect any changes you have made to the export options. 

Palette Options tab 

This tab allows you to alter the color settings of your exported image. 

Dithering & Palette 

The DITHERING and PALETTE options only apply when you export with 256 color or less, 

and affect how the image is displayed and its color palette. It is recommended to always 

use an OPTIMIZED PALETTE. Set DITHER to none, which produces smaller files but may be 

banded, or ERROR DIFFUSION, which creates higher quality results, but larger files. 
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Color Depth 

Choose the number of colors your bitmap requires. The more colors, the larger the file 

(usually), and the higher the quality.  The TRUE COLOR option supports up to 16 millions 

colors. TRUE COLOR + ALPHA includes semi-transparent features such as soft shadows 

and transparency. For applications that support alpha-channel PNG files this is the 

recommended format. 

If you choose 256 colors of less, you have the option to use simple transparency (Wine 

glass icon-see below). This doesn't support semi-transparent pixels, only "on/off" fully 

opaque or fully transparency pixels, and so can produce jagged edges. 

Max Colors 

If you select a Color Depth of 256 or less you can control exactly how many colors are 

used in the file. This provides a high degree of control over quality vs. file size. Just enter 

the required number of colors and press the PREVIEW button to preview. 

Buttons 

These buttons (except TRANSPARENT BACKGROUND) apply when exporting 256 color 

images or less. These files are created with a limited palette of colors, and these controls 

provide a great degree of control over those palette colors. See COLOR SELECTOR above 

on how to select a color, or click on a color in the COLOR PALETTE). 

 
Lock a Color 

You can specify the number of colors you want in the palette of exported bitmaps. You 

may want to ensure that certain colors always appear in the palette; you can lock these 

colors. Click on a color to select it, then select the LOCK button. A small square appears 

in the bottom left of the color to tell you it is a locked color. 

 
Make a Palette Color Web Safe 

When clicked this button will shift the selected color to be one of the 216 common web 

browser palette colors. This is a legacy system that is no longer particularly important or 

relevant, as nearly all computers can display millions of colors, and there's no benefit in 

restricting web graphics to only this limited palette. 

 
Make the Image Background Transparent 

Make any areas not covered by the selected objects transparent. Selecting this option 

automatically makes one entry in the palette transparent. 

 
Make a Palette Color Transparent 

Make this color entry transparent. Note the difference between this option, which makes 

parts of the selected objects transparent, and Make The Image Background 

Transparent which makes those areas behind the selected objects transparent. 
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Delete a Palette Color 

Delete this color from the palette. Any areas in the bitmap that use the deleted color then 

use the nearest color in the palette. The fewer colors in the palette, the smaller the 

bitmap file. 

 
Restore a Previously Deleted Color 

Undelete a deleted color. 

 
Add system colors 

Adds 28 colors to the palette. These colors are the regular Windows system colors and a 

number of primary colors. This ensures the palette includes a spread of colors and may 

improve the quality of the image, particularly if it contains a wide range of colors. You 

may need to experiment with this option to get the best results. 

Bitmap Size tab 

With this tab, you can change the size of the exported image. 

Bitmap Size and Resolution 

You can change the size of the exported bitmap by changing: 

 SIZE: Type the required width or height into one of the fields. Note that the aspect ratio 

of the bitmap is fixed, so changing one dimension automatically changes the other. 

SIZE is more suitable than SCALE if you want to create a bitmap of a particular size in 

pixels. 

 SCALE: (Dimmed for JPEG & PNG). This lets you scale the bitmap up or down by a 

percentage. SCALE is more suitable than Size if you want, for example, a bitmap 50% 

bigger than the original. 

 RESOLUTION: (Dimmed for GIF & BMP) Type the resolution into the DPI field. If you are 

exporting an image for viewing on screen (e.g. a website), you do not normally need a 

setting higher than 96dpi. (If you need to export for a Retina device you can 

automatically export a higher resolution 192dpi version as well).    

Area to Save 

The bitmap can be created using one of these areas of the document: 

 PAGE: The whole page area. 

 DRAWING: The area covered by objects. 

 SELECTION: The area covered by the objects in the selection. Only available when 

objects are selected. 

Anti-aliasing 

Anti-aliasing improves the appearance of graphics by smoothing jagged edges: 
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 MAINTAIN SCREEN ANTI-ALIASING: The exported bitmap uses the exact same 

positioning as shown on screen, and so has identical anti-aliasing. This can result in 

the edges of objects being slightly blurred because they do not fall exactly on pixel 

boundaries. 

 MINIMIZE VISIBLE ANTI-ALIASING: This will slightly reposition the objects by fractions of a 

pixel to minimize the anti-aliasing around the edge of the exported bitmap. If in doubt 

which option to use, select this. 

Put HTML Image Tag on Clipboard 

This lets you save out the basic HTML IMG tag information when you save the bitmap. 

You can then paste the tag into your text or external HTML page editor. 

Also export Retina (192dpi) bitmap 

With this option checked you can simultaneously export a 192 dpi high definition Retina 

image. This saves you exporting twice if you have a need to provide a 96dpi as well as a 

192dpi resolution image for Retina devices. For JPEG and PNG the operation is only 

valid when you have the 96dpi option selected.  

See High resolution images for more info on Retina images. 

Options tab 

With this tab you can alter JPEG compression and turn on progressive/interlacing for the 

GIF and PNG options if required. 

JPEG Quality: (JPEG only) A low setting will result in a small file with a loss in quality 

whereas a high value will give only slight file size reductions, but high quality. Note that a 

setting of 100% will still compress the file. A setting of 85% gives good compression 

without causing a noticeable loss in quality for most uses. 

Interlaced: (GIF and PNG only) This is like a JPEG. In the browser the picture first 

appears as a low resolution image. As more of the file loads, the resolution increases. 

Transparent: (GIF and PNG only) This makes any areas not covered by the selected 

objects transparent. Selecting this option automatically makes one entry in the palette 

transparent. 

Export each layer to a file of its own: (GIF and PNG only) Selecting this option when 

exporting a design that contains multiple layers results in a separate file being exported 

for each layer. The names of each layer (as set in the Page & Layer Gallery) are used to 

name the exported files. 

Image Map tab 

An image map lets you have "clickable" areas on the graphic when displayed in a 

browser. Clicking one of these areas jumps to a new web page. If you want to create an 

image map, use "Utilities -> Web Address" to add web addresses (URLs) to the different 

parts of your drawing. 
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Export Image Map to Clipboard: This copies the image map HTML to the clipboard so 

you can paste it into your text or web page editor. There is an option on the BITMAP Size 

tab to save the HTML IMG tab to the clipboard. Selecting either of these clipboard 

options automatically deselects the other option. 

Export Image Map to File: This copies the image map text to a file. You can either: 

 INSERT IMAGE MAP INTO EXISTING FILE: This inserts the image map into the specified 

file. If the file already contains an image map with the same name, the existing image 

map is replaced. If this is a new image map, it is inserted at the end of the file. 

 REPLACE EXISTING FILE: This overwrites any existing contents of the file. This option is 

useful if you want to save the image map text for use later. 

Note that opening this file in a browser displays a blank window, i.e. you don't see the 

graphic. The reason is that the file does not include the IMG tag needed to display the 

graphic. The IMG tag might look like this: <img src="file name.gif" usemap="#example" 

/>. 

Adobe Dreamweaver Integration: With this option selected, the bitmap in 

Dreamweaver is linked to the original Photo & Graphic Designer document. If you later 

need to edit the bitmap, Dreamweaver can load Xara Photo & Graphic Designer and 

display the original document. 

Image Map Options 

 NAME: Image maps are named. (Names must be unique within a document.) If you are 

merging this image map into an existing file, you can either type in a new map name or 

choose the name of an existing map. This lets you replace an existing map with new 

data. 

 APPROXIMATE CURVES WITH LINES: Image map polygons are a series of straight lines 

and this option lets you select how closely any curves in the clickable areas are 

followed. (Note that circles are a special case in image maps.) Very closely gives the 

best approximation. This increases the size of your web page and so makes it slower 

to download. 

 SAVE ALL CLICKABLE AREAS AS RECTANGLES: Ignore the shape of clickable areas. 

Save all clickable areas as simple rectangles that totally enclose the clickable area. 

Browser Preview tab 

Using the A and B preview boxes in the EXPORT dialog box (shown above), you can 

select the best compromise of file size and quality for web graphics. However the best 

test is checking how the graphic looks in a web browser. This tab provides a number of 

options for that preview. Click the BROWSER PREVIEW button to launch your web browser 

and preview the graphics before exporting. 
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Other bitmaps Export dialog box 

Bitmaps other than GIF, PNG BMP and JPEG (for example TIF) use this EXPORT dialog 

box. Not all options apply to all types of bitmap: 

 

Bitmap size and resolution 

Lower resolutions produce smaller files but at reduced image quality. The best resolution 

depends on where the bitmap will be used. For display on screen a resolution of 96 DPI 

is adequate. For printing, higher resolutions are required. 

Experience shows that it is rarely necessary to output bitmaps at more than 300 DPI 

(especially when anti-aliased) even for highest quality typeset results. 

Enlarging or reducing the displayed image changes the apparent resolution. For 

example, a 100 DPI bitmap displayed at half size has an apparent resolution of 200 DPI. 

Conversely, enlarging the image reduces the apparent resolution. 

You can also specify the size in pixels. Either choose from the menu or type a value into 

any of the text boxes. 

Compression 

The compression options vary depending on the bitmap type. BMP files offer RLE 

compression. TIF files offer LZW compression, or for monochrome (1-bit) you also get a 

choice of HUFFMAN, GROUP 3 FAX, GROUP 4 FAX, ORPACKBITS COMPRESSION. 

Save Spread/Save Drawing/Save Selection 

You can: 
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 Save the entire area (the spread). This can create very large files especially if you 

select more than 256 colors. 

 Or save the area covered by the drawing. 

 Or save the area containing all the selected objects. Everything within the area is 

saved including any unselected objects. 
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Customizing Photo & Graphic Designer 

Changing the blank template document 

The blank template documents are the options available under "FILE" > "NEW".  

To add a template document: 

1. Open an existing document ("FILE" > "OPEN", or "Ctrl + O") or create a new 

one with the NEW button on the Standard control bar or "Ctrl + N". 

2. Make any required changes (these could be changing the page size, 

adding a logo or adding a message). You can edit the template document 

just like an ordinary document. 

3. When you are happy with the changes choose "FILE" > "SAVE TEMPLATE" 

and choose a template name. 

 

To make your new template the default template (i.e. which is there when you first open 

Photo & Graphic Designer, and which appears when you press "Ctrl + N") check the USE 

AS DEFAULT TEMPLATE option when saving the template. 

Options in the Utilities menu 

Keyboard shortcut: "Ctrl + Shift + O" or right click the page/pasteboard and choose PAGE 

OPTIONS. 

This menu option opens the OPTIONS dialog box. This lets you set various options for 

Photo & Graphic Designer. 
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General tab 

This page describes the General tab of the Utilities, Options dialog 

 

Current layer always visible and editable 

With this option selected, selecting a layer in the PAGE & LAYER GALLERY automatically 

makes it visible and editable. 

With this option unset, the visible and editable states of a layer remain unchanged when 

you select that layer. 
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Give new objects most recent attributes (GNOMRA) 

Examples of attributes are line width, dash pattern, arrowheads, color, fill color and type 

of fill. 

With this option set, new objects take the attributes of the object that was last drawn or 

selected. For example, you might give an existing shape a red fill and green line color. If 

you then draw a new shape it will also have a red fill and green line color. See Current 

attributes (on page 24) for a full description of current attributes and this option. 

This option is on by default. 

Ask before setting current attribute 

This applies when changing a current attribute (this happens when you change an 

attribute with no objects selected). With this option set, you are asked to confirm whether 

you want to change the attribute. With this option unset, the change is made without 

confirmation. 

Make groups be transparent as a whole. 

See Transparency for more on transparencies. 

When applying transparency to a group of objects, by default Photo & Graphic Designer 

will apply the transparency to the group as if it were one object (i.e. you will not see 

individual transparencies within the group). Unselecting this option will make Photo & 

Graphic Designer add transparency to each object in the group separately. 

Maintain imported layer names 

With this option set, layer information is preserved when you import templates or other 

files. With IMPORT LAYERS INTO THE ACTIVE LAYER instead selected, all imported objects 

appear in the current layer and the layering information in the incoming data is ignored. 

IMPORT LAYERS INTO NEW LAYERS will create a layer for each imported layer. 

IMPORTANT: Note that you should not change this setting if you use any of the web 

templates in the ONLINE CONTENT CATALOG/DESIGNS GALLERY. Most web templates have 

multiple layers which are used to implement mouseover effects. These typically have 

layers MouseOff and MouseOver and so when importing these designs it’s important that 

these layers are preserved and merged with the same layers in your document. 

Recent files 

The File menu shows a list of the most recently loaded or saved files in its ‘Open recent’ 

sub-menu. This list gives a quick way to reload any of those files. This option lets you 

change the number of files listed (between 1 and 20 files). 
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Marquee Object Selection 

This option enables you to change the default setting for marquee selection (on page 

116) (where you drag a selection rectangle over the objects you want to select). So you 

can choose to have objects touching the selection rectangle selected or only the objects 

wholly inside the rectangle. 

Legacy web browser compatible line lengths 

Older web browsers were not able to render text very accurately. When you asked for a 

certain font size they rounded it up or down, often displaying the wrong size and width 

(compared to the original font design, and how Photo & Graphic Designer, Word, PDF 

and all modern DTP programs would display it). 

Older versions of Photo & Graphic Designer attempted to compensate for these 

inaccuracies, by providing a LEGACY WEB BROWSER LINE LENGTH COMPATIBILITY option 

which meant the text was slightly differently formatted - line lengths would be different 

compared to normal print documents, or the same text in Word, or PDF documents. 

Most modern web browsers are getting better at rendering text accurately - you can now 

specify any px or pt font size, even fractional sizes, and the text will for the most part, be 

rendered accurately*. The text formatting should be the same as in print documents, 

PDF, and page layout documents. This includes auto-kerning, manual kerning and 

tracking (letter spacing). 

If you load an older Photo & Graphic Designer web document, a dialog will appear 

prompting you to update the text formatting. This in effect prepares your web document 

so that it will display accurately on most modern web browsers.  

 

 

A consequence of updating the formatting to support the more modern browsers is that 

text may re-flow because of slightly different line lengths, causing text columns to be 

slightly longer or shorter than before. Once you update formatting the document will 

remain like this and you will not be asked again. 

To turn formatting back to the old style use the GENERAL TAB of "UTILITIES" > "OPTIONS" 

dialog and make sure that the LEGACY WEB BROWSER LINE LENGTH COMPATIBILITY option 

is checked. Or if you are loading an older document into Photo & Graphic Designer just 

choose the KEEP ORIGINAL FORMATTING option. 
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*As of writing the Apple Safari and Chrome browsers when used on mobile devices such 

as phones and tablets still round font sizes to the nearest whole pixel size. 

Angle constraint 

This applies when rotating or moving an object with "Ctrl" pressed. 

You can either select from the menu or type in a value in degrees. 

Nudge size 

This applies when moving objects using the arrow keys on the keyboard. 

This text box defines how far the object moves for each key press. If the document uses 

scaled units (for example, 1inch to 1mile), this text box shows the distance in the scaled 

units. 

When nudging, "Ctrl" and "Shift" increase the nudge distance by five and ten times, 

respectively. 

Duplication distance 

"EDIT" > "DUPLICATE" (Ctrl + D) creates a duplicate which is offset from the original 

object. These text boxes set the offset distance. 

Positive values create the duplicate above or to the right of the original object. 

Negative values create the duplicate below or to the left. 



 

Customizing Photo & Graphic Designer 547  
 
 

 

Grid and Ruler tab 

This page describes the Grid and Ruler tab of the Utilities, Options dialog 

 

Grid and Ruler spacing 

MAJOR SPACING defines the distance between the major grid and ruler divisions. The 

units used for the grid and rulers are defined by the units you use for the major spacing. 

For example entering a major grid spacing of 2CM will set the grid and ruler units to 

centimeters regardless of the page units specified in the units options. 

Grid type 

Xara Photo & Graphic Designer allows the use of a standard RECTANGULAR grid or an 

ISOMETRIC grid. 

Origin (0,0 point) 

Normally, the origin for the grid and rulers is at the bottom left-hand corner of the page. If 

you wish to move it to a different location, change the origin value. 
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Coordinate Direction 

Here you can change the direction of page coordinates so that, for example, Y values 

increase as you go down the page. This is useful when you want the 0,0 point to be the 

top left corner and increase down the page like it does for HTML.  

Internet tab 

This page describes the Internet tab of the Utilities, Options dialog 

 

Internet Cache 

When Xara Photo & Graphic Designer downloads gallery items from the Internet, it 

stores them in a reserved area of disk memory called a "cache". When Xara Photo & 

Graphic Designer uses these items in the future, it can load them directly from the cache, 

which is much more efficient than downloading over the Internet. 

CACHE USAGE indicates the amount of cache space currently in use. This gives an idea 

as to whether the cache size is correct. That is, if cache usage is consistently nearing 

100% the cache size should be increased if possible. A larger cache size does not affect 

the program adversely or take up unnecessary space on the drive. We recommend a 

cache size of 15 - 20 MB. The minimum cache size is 500KB, the maximum is the free 

space on the drive when the size is set. Anything outside these limits generates an error. 

You can type in byte values directly (800000). For kilobytes or megabytes, follow the 

value with K or M (500K or 8M). 
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The EMPTY CACHE button removes all files from the cache except a few essential data 

files needed by Xara Photo & Graphic Designer (this means that cache usage might not 

return to 0% after emptying). To use a file that has been removed from the cache, you 

have to download it again. 

Connection Type 

Over faster modems, ISDN, and networks, Xara Photo & Graphic Designer can speed up 

downloads by using multiple connections. These multiple connections are invisible to you 

and you just see an increase in speed. 

If you connect to the internet using a dial-up modem, select the appropriate speed option. 

If you are not sure about your modem, use the default setting. If you connect to the 

Internet using broadband (like ADSL or cable), select dual ISDN or better. 

Proxy Server Settings 

If your computer is using an Internet proxy, then it will list its details here. This 

information is not relevant to most users. 

Mouse tab 

This page describes the Mouse tab of the Utilities, Options dialog 
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Mouse button function 

Photo & Graphic Designer gives you a range of possible actions when you click either 

the left or right mouse buttons. For example, if you're left-handed, you may prefer to use 

the right-hand button as the normal button. You would therefore assign the normal click 

to the right mouse button (you can also set both buttons to have the same action if you 

wish). 

Possible actions: 

 Normal click - At least one button should always be assigned as the normal click. 

 "Shift + click". 

 "Ctrl + click". 

 "Alt + click". 

 Display a pop-up menu (see below). 

 Toggle full-screen mode (described in Document Handling (on page 50)). 

 Zoom in or out -click to zoom in, "Shift + click" to zoom out (described in Document 

Handling (on page 51)). 

 PUSHTOOL (as if you pressed "Shift + F8") 

The pop-up menu contains options suitable for the object you click on. For example, for 

most object types the menu contains CUT, COPY, PASTE, DELETE, DUPLICATE, CLONE 

(these are described in Object Handling (on page 123)). 

MOUSE WHEEL MOVEMENT: You can change the mouse wheel action here between 

Scrolling and Zooming.  

Click RESET DEFAULTS to return to the original button assignments. This has immediate 

effect; you don't need to click OK or APPLY NOW. 

The Windows Control Panel also lets you swap the left and right mouse buttons. 

Magnetic Snap Radii 

Snapping is described in Object Handling (on page 123). 

These text boxes define how close you can drag an object before it snaps to a magnetic 

object. These are distances on the screen and independent of any document scaling. 
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Page Size tab 

This page describes the Page Size tab of the Utilities, Options dialog 

 

These options apply only to the selected document. 

Paper 

Options relating to setting the page size (paper, orientation, spread) are described in 

“changing the page size” in Document Handling (on page 54). 

If the Lock page size option is turned on, you can't resize a page by dragging the bottom 

or right edges and any PUSH objects that get pushed off the bottom edge of the page will 

not cause the page to grow. 
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Page 

OUTER MARGIN sets the size of the margin (or Pasteboard) around the page.  

BLEED determines the bleed area size around your document. This area (typically 1-

3mm) is important for format filling prints in print shops. Read more in the "Changing the 

page size" section in the chapter Document Handling (on page 57)! 

SHOW PAGE SHADOW sets whether a shadow is displayed under the page (this is only on-

screen, it is not exported or printed). 

If you select DOUBLE PAGE SPREAD you can create a document consisting of two pages. 

This option adds a second page to your document. 

PRINT/EXPORT WHOLE SPREAD: When this option is selected, each double page spread is 

printed and exported (for example to PDF) to a single page, just as it appears in Xara 

Photo & Graphic Designer. 

PRINT/EXPORT INDIVIDUAL PAGES: When this option is selected, each double page spread 

is printed and exported as 2 separate pages, just as if they were designed as separate 

pages in Xara Photo & Graphic Designer. 

Document 

ALL PAGES IN DOCUMENT THE SAME: When this option is selected, all the pages in your 

multi-page document will be given the same dimensions. So if you change the 

dimensions on one page, all the other pages will update too. This is normally required 

when working on print documents, because typically each page will need to print to the 

same paper size.  

SAME LAYERS ON ALL PAGES: When this option is selected, all pages in your multi-page 

document will have the same layers. If you add or delete layers from one page, all the 

other pages are similarly updated. . Additionally, the contents of background layers are 

synchronised across all pages so that every page has the same background design 

(change the background design on one page and all pages update). In website 

documents you need to make sure this option is not selected if you want different popup 

layers on different pages of your site. See the Page & Layer Gallery (on page 196) 

chapter for information about Layers. 

Auto-fit to Page... 

The AUTO-FIT TO PAGE... button will open the AUTO-FIT TO PAGE dialog. This enables the 

automatic repositioning and scaling of page content to fit a new page size. The dialog 

also lets you fine tune the position of document content. This may sometimes be 

necessary especially with items around the margins of the document like headers, 

footers etc. 

 See the Auto-fit to Page (on page 160) section in the Object Handling (on page 123) 

chapter for details. 

.  
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Backups Tab 

This tab allows you to turn the automatic backup facility on and off. This facility saves a 

copy of all your modified open documents at regular intervals. It’s recommended that you 

work with this backup option turned on, so your work is saved regularly. You can also 

choose whether you are prompted about unsaved documents when closing the program, 

or if instead all open documents should be backed up and restored for you when you 

next start up. 

See the Document Handling chapter (on page 66) for full details about these facilities. 

Effects & Plug-ins tab 

This page describes the Effects & Plug-ins tab of the Utilities, Options dialog 

 

For more on Live Effects refer to Live Effects (on page 417). 

Photoshop Plug-ins 

Clicking SETUP lets you add and remove folders of Live Effects plug-ins. 

Effects 

Here you can set the default resolution of Live Effects and locked effects. 

New Effects Are Locked By Default 

This will make any Live Effects you create locked by default, so they will not change if 

you move or resize them. 
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Default Live Effect resolution 

If a Live Effect resolution is set to AUTOMATIC, then any Live Effects on an object will, by 

default, be produced at screen resolution. If you wish to print your design you can set 

one Live Effect to a higher DPI and all effects on that object (as long as the other effects 

are set to automatic) will automatically be rendered at the highest DPI. It won't then be 

necessary to alter each effect one by one. Or you can set a different default in this 

window, and all Live Effects will be created at that resolution. 

Default Locked effect resolution 

This is the default resolution for locked effects. If you wish to change the DPI of a locked 

effect, you need to recreate that effect. Please note: this only applies to locked effects, 

and does not apply to a locked Live Effect. 

Photo Editing 

This page describes the Photo Editing of the Utilities, Options dialog 

 

Photo Editing 

You can choose what should happen when you save a Photo Document with a modified 

photo in it. By default the original photo file is preserved in a .xar file in a "Masters" sub-

folder and the original opened photo file is overwritten. You can choose to have the 

original photo file saved in the "Masters" folder instead, or you can choose to not have 

the original photo preserved at all. See the Editing Photo Files (on page 392) section of 

the Photo Handling chapter for details. 
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Editing Bitmaps 

Here you can select the bitmap editor that you want to use to edit bitmaps in Xara Photo 

& Graphic Designer. 

See Integration with external Photo Editors (on page 386) in the Photo Handling chapter 

for details. 

Bitmap transfer 

Always use bmp  

Images will always be transferred as bmp files. This is the fastest way to transfer images 

to and from the bitmap editor, but bmp does not support transparency. So if you want to 

edit bitmaps that include some transparency, or you want to introduce some 

transparency while editing the image, don’t use this option. 

Always use png 

Images will be transferred to the bitmap editor as uncompressed png files, preserving 

any transparency in the image. Most editors will return images as compressed png files 

in this case and this may be slow for large images. Use this option if you want to edit 

24bpp (opaque) bitmaps, but you want to introduce some transparency while editing in 

the bitmap editor.  

Automatic 

This is the default option. Xara Photo & Graphic Designer will automatically decide 

whether to use bmp or png to transfer the bitmap to the bitmap editor. If the bitmap does 

not have any transparency (24bpp) bmp will be used. Otherwise png will be used. This 

option should be fine for most editing, but if you want to introduce some transparency to 

your image while editing it, choose the png option instead. 

Scaling tab 

This page describes the Scaling tab of the Utilities, Options dialog 

 

Described in Measurement Units in Document Handling (on page 72). 
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Tune-ups tab 

This page describes the Tune-ups tab of the Utilities, Options dialog 

 

Redraw 

The value set in this option is used when redrawing the document on the screen and 

during exporting and printing. Normally automatic gives the best results, but if you have 

an old computer with limited memory you can specify a lower value. This may, however, 

slow down redraws. 

Gallery cache 

When displaying items in a gallery, Photo & Graphic Designer reads the information off 

disk into a cache. This speeds up gallery redraw speed for recent items. 

The default value is generally suitable. You may want to reduce it if memory is tight, or 

increase it if you use galleries frequently. 

Undo size 

Applies only to the selected document-described in Undo & Redo (on page 87). 
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Cache Control 

Complex objects including layers, groups, bevels, shadows, blends, molds, contours, 

ClipViews and Live Effects can be cached as bitmaps when they are rendered. This 

means that the next time these objects need to be redrawn, the bitmap can often be used 

instead of re-rendering the objects, making redraws and object drags very much faster. 

The difference is particularly noticeable with complex documents. 

Since caching involves storing additional bitmaps in memory, it has the potential to 

increase the amount of memory used by Xara Photo & Graphic Designer significantly. 

Therefore in this dialog you can turn caching on and off and you can also control how 

much memory is used for caching when it's turned on. Increase the percentage memory 

figure to make Xara Photo & Graphic Designer cache more objects in your design, 

generally making redraws and object drags faster at the expense of larger memory 

usage. Or reduce it to lower the amount of memory that Xara Photo & Graphic Designer 

uses for caching. In complex designs, some cacheable objects will not be cached if there 

is insufficient memory to do so. 

This dialog also shows you how much memory is currently being used for caching. 

Live drag is described in Document Handling (on page 50). 

Note: Cached bitmaps will only be used during object dragging if you use LIVE DRAG. If 

you have LIVE DRAG turned off, then as you would expect you will just see the outlines of 

objects when moving them. 
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Units tab 

This page describes the Units tab of the Utilities, Options dialog 

 

Described in Measurement Units in Document Handling (on page 70). 
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View tab 

This page describes the View tab of the Utilities, Options dialog 

 

Display 

Show progress bar: During long operations Photo & Graphic Designer can display a 

progress bar on the status line. If instead you'd prefer an hourglass to replace the mouse 

pointer until the operation is completed, uncheck the SHOW PROGRESS BAR setting. 

The hourglass and progress bar are for information only-they have no effect on the 

document itself. 

Interactive fill dragging: Interactive fill dragging allows you to see how fills and 

transparencies look as you drag the fill handles. This is on by default. 

Dithering 

These options set the dithering method used to display your document on the screen. 

It is recommended that you leave this on its default setting. 
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Bitmaps 

These options apply only to the current document. They have no affect on any other 

documents currently loaded. 

NEVER SMOOTH: When Xara Photo & Graphic Designer scales a bitmap, it usually 

smoothes (interpolates) between the individual pixels to give a smooth look to the 

bitmap. Usually this gives the best results. Check this option if you if you do not want this 

effect. 

DPI WHEN AUTO-GENERATED: Some features such as shadows and bevels are created 

using bitmaps. Xara Photo & Graphic Designer calculates the resolution of these bitmaps 

when they are displayed. However, when you perform actions on shadows and bevels 

such as CONVERT TO EDITABLE SHAPES, COMBINE SHAPES, EXPORT AS EPS and EXPORT 

AS FLASH, Xara Photo & Graphic Designer creates a new bitmap using the resolution you 

specify here. For on-screen use (such as web page graphics) 96 DPI is the best value. 

For work that will be printed, you may need a higher value. Changes to this value apply 

to new auto-generated bitmaps; it has no effect on existing bitmaps. 

The 3 radio button group allows you to choose how large photos should be handled 

when you import them. Given the large size of digital camera photos, often if you’re 

working on a document the photo you import will be many times the size of your  page.  

RESIZE LARGE IMPORTED IMAGES DOWN TO ... PIXELS: This is the default option. Large 

images are scaled down to a more manageable 500 pixels wide, or whatever size you 

set here. The document zoom is not altered. 

IMPORT ALL PHOTOS AT 96DPI (1:1 AT 100% ZOOM): With this option the DPI of the image is 

ignored and it is loaded as if the DPI is 96 (screen 1:1 size). So if an image is 1000 pixels 

wide, it will display as 1000 pixels wide in Xtreme Pro. Also Xara Photo & Graphic 

Designer will automatically zoom out if required, so that the whole photo fits into the view. 

IMPORT AT DPI SPECIFIED IN THE IMAGE: With this option, any DPI value specified inside 

the image itself is read and the image is imported at that DPI. Note that some digital 

cameras write incorrect or unhelpful DPI values into photos and so this option may not 

always give you the results you expect. 

Note that the above import options do not apply to photo documents. Photos are always 

imported/opened at their full size in photo documents. 

Color 

COLOR LINE SIZE:This lets you select the size of the color bar at the bottom of the screen. 

A scroll bar is displayed when the number of colors is wider than the width of the color 

bar. 

EDIT LOCAL COLORS IN: This affects the color model displayed when editing a local color. 
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Automatic displays the color model of the original color style that the local color is based 

upon. For example, the HSV color model for a color style defined in HSV. This is 

important if you need to ensure your objects are in CMYK, for example. 

The other options let you select which of the four color models (RGB, CMYK, HSV, 

grayscale) to always use by default. 

RIGHT CLICK ON COLOR: This option is to turn off the color-line right-click menu (on page 

206) and make right click set the line color, as in earlier versions of Xara Photo & 

Graphic Designer.  

DELETE UNUSED COLORS WHEN SAVING AND LOADING: When this option is selected, any 

unused named colors in your document will be deleted when you save/load. This 

prevents your Color Line becoming cluttered with named colors which are not used in the 

design. This is particularly useful when loading older designs, because earlier versions of 

Xara Photo & Graphic Designer used to create named colors implicitly. So many older 

designs contain numerous unused named colors. Load them with this option turned off 

and it’s hard to identify the important used named colors on the COLOR LINE from the 

unused ones.  

Control bars 

You can move Photo & Graphic Designer's control bars to different places around the 

window, re-order the buttons, create new control bars, move or copy buttons between 

control bars and many other operations. 

You cannot change the tool-dependent InfoBar or the contents of the fly-out bars which 

are on the main toolbar and top bars. 

Full screen mode 

Photo & Graphic Designer has two configurations of control bars: 

 One configuration appears when the window is its normal size. 

 The second configuration appears after you choose "WINDOW" > "FULL SCREEN". 

Any changes to one configuration of control bars (for example, resizing or moving) have 

no effect on the other configuration. Changes to individual buttons (for example, setting 

an option) apply in both normal and full screen modes. 
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Displaying & hiding control bars 

 

The display of control bars is controlled by 

the CONTROL BARS dialog box ("WINDOW" > 

"CONTROL BARS"). 

Against the name of each control bar is a 

check box. A tick in the check box shows 

that the control bar is currently displayed. 

Click on the required control bar's check 

box to display or hide that bar. 

You can also quickly turn CONTROL BARS on or off if you right-click in any empty area at 

the top of the program window. Use the drop-down menu to choose which bars you want 

to display. 

 

Docked and free floating control bars 

Normally, control bars are docked (attached to the edges of the window). Moving the 

window also moves docked control bars. 
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Control bars can also be floating. These do not follow movements of the window. 

  

 

Floating control bar Docked control bar 

You can hide a floating control bar either using the CONTROL BARS dialog box (described 

above) or by clicking its CLOSE icon. 

To make a control bar float, drag it away from the edge of the window either onto the 

editing area or off the Photo & Graphic Designer window. 

To dock  a control bar, drag it over: 

 The edge of the window. 

 Or the menu bar. 

 Or another control bar. 

A floating control bar has a double line outline while dragging. This changes to a single 

line when in a docking position. If you want the control bar to remain floating, hold down 

"Ctrl" while dragging. 

Resizing a control bar 

Move the pointer over the edge of the control bar. It changes to a double-headed arrow. 

You can now drag the edge to resize the control bar. 

Creating new control bars 

To create a new control bar: 

 Drag a button onto the editing area or off the window. This opens a new control bar 

containing the button. 

Or click NEW on the CONTROL BARS dialog box. This lets you create a new control bar and 

allocate a name to it. The new control bar is empty. You can then drag buttons to it. 

Moving buttons is described below. 

Deleting control bars 

You can only delete control bars that are empty. Therefore move any buttons to another 

control bar. Close the control bar (either click on the CLOSE icon or use the CONTROL 

BARS dialog box). The control bar is automatically deleted when you quit Photo & 

Graphic Designer. 
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Changing the size of buttons 

Buttons can be large or small as selected in the CONTROL BARS dialog box. 

Moving buttons and tools 

To move buttons or tools: 

1. Move the mouse pointer over the button you want to move. 

2. Hold down "Alt" (left ALT) to move the button or "AltGr" (right ALT) to copy the 

button when used on user-defined control bars and other control bars. Although on 

the predefined "Button palette" both ALT-keys do only copy the button. 

3. Drag the button to: 

- A different place on the same control bar. 

- Or another control bar. 

- Or onto the editing area/off Photo & Graphic Designer to create a new control 

bar. 

You cannot move buttons onto or off the InfoBar. 

Hiding buttons and tools 

Move the unwanted buttons or tools to another control bar and then hide that control bar 

(described above). 

If you need the button or tool in the future, use the CONTROL BARS dialog box to redisplay 

the control bar. 

You cannot delete buttons or tools. 

Fly-out menus 

Some buttons have a small black triangle which indicates that there is a fly-out bar, which 

appears when the mouse pointer is held over the button for a short period. You cannot 

customize the contents of these flyout bars, but you can drag the button as a whole onto 

and off bars, just as you do with ordinary buttons. 

Gallery docking and undocking 

It is possible to dock one or more galleries on either side of the Photo & Graphic 

Designer window. See moving and docking a gallery (on page 76). 

Restoring the default control bars/galleries 

Choose "WINDOW" > "CONTROL BARS" and click RESET to restore the control bar setup to 

the default setting. 
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Menus and Keyboard Shortcuts 

Introduction 

This chapter describes the operations available on each of the menus and those 

available via keyboard shortcuts. In many cases the operations described in this chapter 

apply to the selected object. In most cases, the described action also applies when you 

have several selected objects. We use selected object as shorthand for selected object 

or objects. 

Often you can select options from either a menu, a control bar or a keyboard shortcut. 

Where a button on a control bar and/or keyboard shortcut exists, these are shown after 

the menu name. For example, the following means there is a button on the STANDARD 

control bar that has the same effect as selecting new, or you can use the shortcut "Ctrl + 

N". 

New (Standard control bar or "Ctrl + N") 

File menu 

New (Standard control bar or Ctrl+N) 

Opens a new document. 

New from Content Catalog (Shift+Ctrl+Alt+K) 

Opens the Online Content Catalog. Choose SmartShapes, templates, widgets and clipart 

from the catalog's web, layout and photo and graphic categories. 

New from Designs Gallery 

This option opens the DESIGNS GALLERY if it’s not open already, allowing you to choose a 

template for a new document. Click on the folder icons in the gallery to open a folder and 

double-click on a template thumbnail to start a new document using that template. 

 
You can also open the DESIGNS GALLERY by clicking the tab in the Galleries bar. 

 

Open (Standard control bar or Ctrl+O) 

Opens a new editing window and loads a file into it. This file can be: 

 An Photo & Graphic Designer .xar file to view or edit an existing Photo & Graphic 

Designer document, 

 Or any of the other import formats (see Importing & Exporting (on page 505) for a list 

of formats). This opens a new document showing the drawing in the file. 
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Open recent 

A list of the most recently loaded or saved files. Provides a quick way to reload any of 

these files. 

You can change the number of files in this list (refer to Customizing Photo & Graphic 

Designer (on page 542) for details). 

Close (Ctrl+W) 

Closes the current editing window. Photo & Graphic Designer remains loaded. You are 

warned if the file has unsaved changes. 

Save (Standard control bar or Ctrl+S) 

Saves the selected document. 

Save As 

Lets you save the selected document under a different name or to a different directory or 

drive. 

Save All 

Saves all loaded documents. 

Save Template 

Saves the selected document as a template document (see Customizing Photo & 

Graphic Designer (on page 542)). 

Import (Ctrl+Alt+I) 

Loads a file into the selected document. The file can be any of the import formats (see 

Importing & Exporting (on page 505) for more information). 

Note the difference between OPEN and IMPORT: both load a variety of file formats but 

OPEN opens a new document. IMPORT loads the file into the current open document. 

Import from Web Address (Ctrl+Alt+W) 

Import text and graphics directly from web pages on the Internet into your document. 

Enter the URL (web address) of the site you wish to import into the dialog box. 

Export (Ctrl+Shift+E) 

Or right click and choose EXPORT. 

Lets you export the document in any of the export formats supported by Photo & Graphic 

Designer (see Importing & Exporting (on page 505) for a list of formats). 

Export JPEG 

Lets you export selected objects, a page or the whole document as a JPEG.  
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Export PNG 

Lets you export selected objects, a page or the whole document as a PNG.  

Export PDF 

Lets you export the selected document as a PDF. See Exporting PDF files (on page 518) 

for more information. 

Preview Flash 

This option is only enabled when the current document is an animation document. It 

exports your animation as Flash and brings up a pop-up window showing your Flash 

animation running. The window also includes basic information about your Flash 

animation, such as the size of the Flash file. 

 

The button on the animation toolbar is a quicker way to invoke this operation. 

 

Export Animation 

  

Also in the animation toolbar displayed under the standard toolbar in an 

animation document. 

Export an animation for use in a website. 

Export image in slices (Ctrl+I) 

This exports the selected objects as several sections (see Web Graphics (on page 516) 

for more information). 

Document Info 

This displays an information box about the selected document. It includes a 

comprehensive amount of information about the document including which fonts, 

together their permissions are included, as well as which Live Effects plug-ins are used.  

Page Options 

Also right click and choose PAGE OPTIONS. 

Allows you to edit the page layout, size, etc. 

Print (Ctrl+P) 

Sets options relating to printing the document and lets you print the document (refer to 

Printing (on page 487) for more information). 

Exit 

Closes all windows and removes Photo & Graphic Designer from memory. You are 

warned if any files have unsaved changes. 
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Edit menu 

Undo (Standard control bar or Ctrl+Z) 

Undo the previous operation. The description of this option reflects the last operation 

performed. For example, UNDO CUT (refer to Undo & Redo (on page 87)). 

Redo (Standard control bar or Ctrl+Y) 

Cancel the last UNDO command. The description of this option reflects the last UNDO 

operation (refer to Undo & Redo). 

Cut (Edit control bar or Ctrl+X) 

Cut the selected object to the clipboard (refer to Object Handling (on page 124)). 

Copy (Edit control bar or Ctrl+C) 

Copy the selected object to the clipboard. The object remains in place in the document 

(refer to Object Handling (on page 124)). 

Paste (Edit control bar or Ctrl+V) 

Or right click and choose PASTE. 

Paste the clipboard contents into the selected document (refer to Object Handling (on 

page 124)). 

Sometimes, when you paste the contents of the clipboard into a document, it could be 

inserted using several different formats. If this is the case the PASTE SPECIAL dialog box 

will appear so you can choose a format. See Cut Copy and Paste (on page 124) in the 

Object Handling (on page 123) chapter for more detail. 

Paste unformatted text 

Pastes any text on the clipboard into your document without any formatting. 

Paste in place (Ctrl+Shift+V) 

The same as Paste, except your object will be pasted in the exact same position from 

which you copied it. This is useful for moving objects from one layer or page to another, 

without changing its X/Y position 

Paste format/attributes (Ctrl+Shift+A) 

Preserves the format (e.g., font and font size) or style attributes (e.g., line and fill color) of 

the pasted object. 

Paste position 

This option applies the position of a copied object on the clipboard to a currently selected 

object, which moves to the exact same position as the copied object. 
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Paste size 

This option applies the size of a copied object on the clipboard to a currently selected 

object, which resizes around its center to the exact size of the copied object. 

Paste size and position 

As the name suggests, this option applies both the size and exact position of the object 

on the clipboard, to the selected object.  

Paste replacing selection 

This is similar to PASTE POSITION, except that the copied object on the clipboard replaces 

the currently selected object and retains the deleted item's position. The copied object is 

pasted into the center position of the deleted object. 

Paste in current layer 

The same as PASTE IN PLACE, except your object will only be pasted into the current 

layer. 

Paste in place in current layer 

The same as PASTE IN CURRENT LAYER, except your object will be pasted into the current 

layer in the exact same position from which you copied it. 

Paste opacity mask (Ctrl+Shift+M) 

See Opacity Masks (on page 396) 

Paste opacity mask in place 

The same as PASTE OPACITY MASK, except your opacity mask will be pasted in the exact 

same position from which you copied it. This is useful for moving opacity masks from one 

layer or page to another, without changing its X/Y position.  

Paste on all pages 

Pastes the copied object at the same size and position on all pages of the document.  

Delete (Edit & Standard control bars or Delete) 

Or right click and choose DELETE. 

Delete the selected object (refer to Object Handling (on page 123)). 

Select All (Ctrl+A) 

Select all objects in editable layers (editable and locked layers are described in Layers 

(on page 196)). 



 

 570 Menus and Keyboard Shortcuts 
  

 

 

Clear Selection / Reset current attributes (Esc) 

Deselect all objects. If nothing is selected, the current attributes (on page 24) are set 

back to its default values. You can easily get this by pressing ESC twice. 

Find/Replace (Ctrl+Alt+F) 

Find/Replace for text objects, see chapter Text Handling, section Find & Replace (on 

page 252). 

Duplicate (Edit control bar or Ctrl+Alt+D) 

Or right click and choose DUPLICATE. 

Copy the selected object placing the copy slightly offset from the original. The copy 

becomes the selected object. The offset distance can be customized (see Customizing 

Photo & Graphic Designer (on page 546)). 

Clone (Ctrl+K) 

Like DUPLICATE copies the selected object, but places the copy directly over the original. 

The copy becomes the selected object. 

Pages 

Or right click and choose PAGES. 

The Pages submenu lets you add or remove pages from your multi-page document, 

duplicate the current page or move the current page up and down. Read more on multi-

page documents in Multi-page Documents. 

Arrange menu 

Move to Layer in Front (Arrange control bar or Ctrl+Shift+U) 

Or right click and choose ARRANGE > MOVE TO LAYER IN FRONT. 

Move the selected object forward by one layer. The selected object becomes the back 

object in the new layer. In an animation document, this option is MOVE TO NEXT FRAME. 

Bring to Front (Arrange control bar or Ctrl+F) 

Or right click and choose ARRANGE > BRING TO FRONT. 

Move the selected object to the front of all other objects in the same layer. See Object 

Handling (on page 123) for more information. 

Move Forwards (Arrange control bar or Ctrl+Shift+F) 

Or right click and choose ARRANGE > MOVE FORWARDS. 
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Move the selected object one step towards the front (refer to Object Handling (on page 

123)). 

Move Backwards (Arrange control bar or Ctrl+Shift+B) 

Or right click and choose ARRANGE > MOVE BACKWARDS. 

Move the selected object one step towards the back (refer to Object Handling (on page 

123)). 

Put to Back (Arrange control bar or Ctrl+B) 

Or right click and choose ARRANGE > PUT TO BACK. 

Move the selected object behind all others in the same layer (refer to Object Handling (on 

page 123)). 

Move To Layer Behind (Arrange control bar or Ctrl+Shift+D) 

Or right click and choose ARRANGE > MOVE TO LAYER BEHIND. 

Move the selected object one layer backwards. The selected object becomes the front 

object in the new layer. In an animation document, this option is MOVE TO PREVIOUS 

FRAME. 

Group (Arrange control bar or Ctrl+G) 

Or right click and choose GROUP. 

Group the selected objects together to appear as a single object (refer to Object 

Handling (on page 123)). 

Ungroup (Arrange control bar or Ctrl+U) 

Or right click and choose UNGROUP. 

Split the group or groups into separate objects.  Dimmed unless the selected object is a 

group. Or, for several selected objects, there is at least one group. 

Apply soft group (Ctrl+Alt+G) 

Or right click and choose APPLY SOFT GROUP. 

Make the selected objects form a soft group. Unlike groups, soft groups can include 

objects on different layers. Refer to Object Handling (on page 149) for details. 

Remove soft group (Ctrl+Alt+U) 

Or right click and choose REMOVE SOFT GROUP. 

Disband the selected soft group, so the objects are separately selectable objects again. 
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Apply/Remove ClipView (Q/Alt+Q) 

This option reads: 

 APPLY CLIPVIEW when there are two or more objects selected. 

 REMOVE CLIPVIEW when there is a ClipView selected. 

For APPLY CLIPVIEW, the rear object in the selection (the object behind the other selected 

objects) 'clips' or 'masks' the other objects (the effect is similar to viewing the other 

objects through a window the shape of the rear object). REMOVE CLIPVIEW removes any 

clipping applied to the objects in the ClipView. See Object Handling (on page 154). 

Apply opacity mask 

Shortcut to quick apply an opacity mask, see Opacity masks (on page 396) in chapter 

Transparency 

Flatten photo group 

Converts a photo group to a single bitmap. 

Alignment (Ctrl+Shift+L) 

Or right click and choose ALIGN. 

Used to align several objects. Has no effect when a single object is selected (refer to 

Object Handling (on page 150) for more information). 

Join Shapes (Arrange control bar or Ctrl +J) 

Used to create holes within shapes (refer to Shape Handling (on page 190) for more 

information). 

Break Shapes (Arrange control bar) 

Cancels a JOIN SHAPES command (refer to Shape Handling (on page 187) for more 

information). 

Combine Shapes (Arrange control bar) 

The Combine Shapes sub-menu lets you: 

 Add shapes together. 

 Or subtract the top shape from the other shapes. 

 Or discard parts of other shapes not covered by the top shape. 

 Or use the top shape to slice the other shapes. 

 Or use intersecting shapes to create slices of the grouped shapes. 

Only shapes in the selection are combined. Unselected shapes do not change (refer to 

chapter Shape handling (on page 187) for more information). 
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Convert Line to Shape 

This option converts a line into a shape. 

Convert to Editable Shapes (Arrange control bar Ctrl+Shift+S) 

Convert predefined objects such as rectangles, ellipses, and text into shapes, i.e. Photo 

& Graphic Designer no longer sees them as rectangles, ellipses or text but as a 

collection of straight and curved lines. 

Create Bitmap Copy (Ctrl+Shift+C) 

CREATE BITMAP COPY creates a bitmap version (on page 390) of the selected objects. 

Fit Text to Curve/Remove Text From Curve 

Or right click and choose FIT TEXT TO CURVE/REMOVE TEXT FROM CURVE. 

Lets you fit a line of text to an arbitrary curve or remove text from a curve (see Text 

Handling (on page 257) for more information). 

Repelling and Anchoring 

Or right click and choose REPEL TEXT UNDER, ANCHOR TO TEXT or REPELLING AND 

ANCHORING. 

Make the object repel underlying text, and anchor an object within a column of text. See 

Repelling text objects (on page 259) and Anchored Graphics (on page 262) for details. 

Repeating object 

The Repeating object sub-menu lets you: 

 REPEAT ON ALL PAGES (SHIFT+CTRL+ALT+R) The selected object will be copied to the 

same place on all pages. 

 STOP REPEATING (SHIFT+CTRL+ALT+O) Turns off the repeating nature of the object - 

either for the selected object only, or all copies of the object. 

See Repeating objects (on page 155) for more information. 

Live copy 

The LIVE COPY sub-menu lets you: 

 CREATE LIVE COPY (SHIFT+CTLR+ALT+C) - the selected object is turned into an instance 

of a live copy 

 STOP LIVE COPY - turns off the the live copy object, either for the selected object only, 

or all copies of the object. 

See Live Copies (on page 159) for more information. 
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Insert menu 

From Content Catalog (Shift+Alt+I) 

Opens the Online Content Catalog. Choose templates, widgets and clipart from the 

catalog's web, layout and photo and graphic categories. 

Image 

 From file - browse your computer to load an image file into the selected document. 

 From Web address - extracts all images from a specified web site. (Ctrl+Alt+W) 

 Stock photo - Opens the relevant section in the Content Catalog 

 Screen Capture - Opens the Screen Capture Tool (on page 378). 

 Photo filter - Opens the relevant section in the Content Catalog. 

 Photo frame - Opens the relevant section in the Content Catalog 

 More image resources... - Opens the relevant section in the Content Catalog 

 From Camera - Detects a web camera or other Windows associated video capture 

device attached to your computer and inserts a still image into the document. 

Shape 

 Rectangle - inserts a rectangle into the current document (Shift+R) 

 Ellipse - inserts an ellipse into the current document (Shift+Ctrl+Alt+E) 

 Line - inserts a Line SmartShape into the current document. 

 Arrow - inserts an Arrow SmartShape into the current document. 

 Spiral - inserts a spiral into the current document 

 More Shapes...  opens the Other Shapes section of the Online Content Catalog 

 More Lines & Arrows... opens the Lines & Arrows section of the Online Content 

Catalog 

See Shape Handling (on page 169) for more information. 

Text Box 

Inserts a text box into the current document. 

Panels 

 Text Panel - Inserts a simple Text Panel into the current document. 

 Photo Text panel - Inserts a simple Photo Text panel into the current document 

 Speech Bubble - Inserts a Speech Bubble into the current document 

 More Text Panels... opens the Text Panels section of the Online Content Catalog 

 More Photo Panels... opens the Photo Panels section of the Online Content Catalog 

Symbol 

Inserts a Symbol (on page 233) into your document either as a character font or as a 

shape.  

Table 

Insert a table from the Online Content Catalog into the current document. 
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Charts 

Opens the Charts section of the ONLINE CONTENT CATALOG.  

New Page 

 New blank page - inserts a new blank page into the document after the current or 

selected page. 

 Duplicate page - inserts a duplicate page into the document after the current or 

selected page. 

 From Content Catalog - opens the Online Content Catalog 

Lorem Ipsum Text 

Inserts a block of dummy Lorem Ipsum text at the text carat position. Alternatively use 

the shortcut Ctrl + Shift + L. 

Smart Fields... 

Opens the Smart Field dialog allowing you to insert a Smart Field into the current doc. 

Utilities menu 

Galleries 

Color Gallery (Galleries control bar or F9) 

Displays or hides the COLOR GALLERY (see Color Handling (on page 205)). 

Page & Layer Gallery (Galleries control bar or F10) 

Displays or hides the PAGE & LAYER GALLERY. Only used in non-animation documents 

(see Layers (on page 196)). 

Bitmap Gallery (Galleries control bar or F11) 

Displays or hides the BITMAP GALLERY (see Bitmap Handling (on page 364)). 

Line Gallery (Galleries control bar or Shift+F12) 

Displays or hides the LINE GALLERY (see Drawing Lines (on page 107)). 

Fonts Gallery (Galleries control bar or Shift+F9) 

Displays or hides the FONTS GALLERY (see Text Handling (on page 225)). 

Designs Gallery (Galleries control bar or Shift+F10) 

Displays or hides the DESIGNS GALLERY (see Importing and Exporting (on page 505)). 

Fill Gallery (Galleries control bar or Shift+F11) 

Displays or hides the FILL GALLERY (see Bitmap Handling (on page 364)). 
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Frame Gallery (Galleries control bar or Shift+F12) 

Displays or hides the FRAME GALLERY. Only used in animation documents (see Web 

Graphics). 

Name Gallery (Galleries control bar or Ctrl+Shift+F9) 

Displays or hides the NAME GALLERY (see Document Handling (on page 83)). 

Color Editor (Ctrl+E) 

Or right click and choose FILL COLOR. 

Opens the COLOR EDITOR (refer to Color Handling). 

Names 

Or right click and choose NAMES. 

Opens the Apply/remove names dialog (on page 82). 

Web link... (Shift+Ctrl+W) 

Adds an Hyperlink to an object when exporting to PDF or other web document. See 

Adding Hyperlinks to objects for details (on page 167). 

Bitmap-Editor 

When a bitmap is selected, this opens the BITMAP EDITOR. In the Program Options 

("Utilities -> Options -> Effects & Plug-ins Tab") you can also choose the enclosed 

Xtreme Photo Designer 7 or any other program for bitmap editing. For further information 

on the bitmap editor, read the program help or the electronic manual (PDF) of the 

according program. 

Optimize Photo 

Or right click and choose OPTIMIZE PHOTO. 

Optimize bitmap resolution for use in Xara Photo & Graphic Designer designs. See Photo 

Optimization (on page 387) for details. 

Optimize all Images 

Optimizes all photos and bitmaps in the design. See Photo Optimization (on page 387). 

Bitmap Tracer 

Opens the TRACER dialog box (see Bitmap Handling (on page 393)). 

Animation 

This menu is only available in animation documents and offers three choices: 
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 ANIMATION PROPERTIES: With this dialog box you can change the options for the 

animation and for each frame. 

 PREVIEW ALL FRAMES: Use this to preview all the frames of your animation. This is not 

very useful for Flash animations as it shows only the key frames with no tweening.  

 PREVIEW GIF ANIMATION IN BROWSER: This item creates an animated GIF file from the 

frames in your document and opens it in your web browser so you can see what it 

looks like. There is a button on the animation bar for quick access to this operation. 

 PREVIEW FLASH ANIMATION IN BROWSER: Pops up a window displaying your animation 

as Flash, as it will appear in a web browser when you export. Use this to preview 

Flash animations. There is a button on the animation bar for quick access to this 

operation. 

Screen Capture 

Open the Screen Capture Tool (on page 378). 

Check spelling as you type 

This option activates the SPELL CHECKER (on page 248) in the TEXT TOOL. 

Customize Key Shortcuts 

This command allows you to change the keyboard shortcuts. See Integrated key shortcut 

utility (on page 586) in Menus and Keyboard shortcuts for details. 

Auto-Fit to page... 

Open the Auto-fit to Page... (on page 160) dialog. 

Options (Ctrl+Shift+O) 

Or right click and choose PAGE OPTIONS. 

Opens the OPTIONS dialog box (described in Customizing Photo & Graphic Designer (on 

page 542). 

Smart Fields... 

Opens the Smart Field dialog allowing you to insert a Smart Field into the current doc. 

Share Menu 

If you have compatible MAGIX and other applications installed, the Share menu will 

include options to send the selected image to those applications. 

Window menu 

Show Mask or Region (Standard control bar or Ctrl+M) 

Toggle the visibility of the current mask or region. See Masks & Regions (on page 339) 

for details! 
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Invert Mask or Region (Ctrl+Shift+I) 

Inverts the current mask or region. See the Masks (on page 339) chapter for details! 

Clear Mask or Region (Ctrl+D) 

Deletes the current mask or region. See the Masks (on page 339) chapter for details! 

Clear Selection / Reset current attributes (Esc) 

Deselect all objects. If nothing is selected, the current attributes (on page 24) are set 

back to its default values. You can easily get this by pressing ESC twice. 

Multiple Page View 

Or right click and choose MULTIPLE PAGE VIEW. 

By default Photo & Graphic Designer shows only the current page of the currently open 

document. Choosing multiple page view shows all the pages in your document. 

New View 

Opens a new window onto the selected document. 

Arrange Views 

Displays all Photo & Graphic Designer windows as tiles. 

Cascade 

Displays all Photo & Graphic Designer windows stacked behind each other so that the 

title bars are visible. 

Arrange Icons 

Tidies up any icons for minimized Photo & Graphic Designer windows. 

Control Bars 

Displays the CONTROL BARS dialog box (described in Customizing Photo & Graphic 

Designer (on page 561)). 

Bars 

Menu entries to switch on and off the most important control bars.  

Quality (Standard control bar) 

Selects how objects are displayed from wire frame to anti-aliased (see Document 

Handling (on page 73)). 
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Show Printer Colors 

Allows you to simulate what the document will look like when printed. This doesn't alter 

your document, and is just a different way of viewing it on screen. 

In Designer Pro & Photo & Graphic Designer you can also show CMYK color separations 

(on page 494) here. 

Show Document Tabs 

Toggles display of the document tabs that provide quick access to each open document 

at the top of the Photo & Graphic Designer window. 

Clicking on a tab makes that document the selected document. A "*" after the document 

name indicates that it currently has unsaved changes. 

Full Screen (8 on numeric keypad) 

Toggles between full-screen and normal screen modes. 

Show Grid (#) 

Or right click and choose SHOW GRID/GUIDES > SHOW GRID. 

Makes the on-screen grid visible (see Document Handling (on page 68)). 

Show Guides (1 on numeric keypad) 

Or right click and choose SHOW GRID/GUIDES > SHOW GUIDES. 

Displays or hides the Guides layer which contains all guidelines and guide objects. 

Show Print Borders 

Most printers have a non-printing margin (the print border) around the edge of the paper. 

With SHOW PRINT BORDERS selected two rectangles are displayed on screen. One shows 

the edge of the paper, the other shows the printable area. 

Snap to Grid (. on numeric keypad) 

Or right click and choose SNAP TO > SNAP TO GRID. 

With this option set, an object snaps to any grid point it is dragged close to (see 

Document Handling (on page 46)). 

Snap to Guides (2 on numeric keypad) 

Or right click and choose SNAP TO > SNAP TO GUIDES. 

With this option set, an object snaps to any guide it is dragged close to (see Object 

Handling (on page 123)). 
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Snap to Objects (* on numeric keypad) 

Or right click and choose SNAP TO > SNAP TO OBJECTS. 

With this option selected, dragging a handle close to another object snaps the handle to 

the object; see Object Handling (on page 123) for more details. You can also adjust the 

snapping distance; see Customizing Photo & Graphic Designer (on page 542) for more 

details. 

Documents Loaded 

A list of the currently open documents. Clicking on a name makes that document the 

selected document ("Ctrl + F6" also switches between open documents). A "*" after the 

document name indicates that it currently has unsaved changes. 

Help menu 

Xara Photo & Graphic Designer help 

Use the command <PROGRAMMNAME > HELP in the HELP menu to open the start page of 

the program Help. Here you can work through the Help step-by-step and jump to specific 

sections via the tree structure on the left-hand side. 

Help 

This command is available at almost every point of this program and opens the program 

Help at the corresponding topic. Use this command to get help on any function of Xara 

Photo & Graphic Designer. 

Shortcut:  F1 

Movies 

A list of movies to help you make the most out of Photo & Graphic Designer. 

Knowledge Base 

Opens the Xara Photo & Graphic Designer Knowledge Base, an invaluable source of 

online help containing useful information on such matters as... 

 Sales and Support 

 Purchase and Accounts 

 Product questions 

 News and Updates 

 Installation and Activation 

More Photo & Graphic Designer 

Opens internet links to Xara’s website and other useful online help resources. 
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Tip of the Day 

See the tip of the day. There is also a check box below the Tip of the Day where you 

select whether or not you see a tip each time you start Photo & Graphic Designer. 

Deactivate programme 

Deactivates the Xara Photo & Graphic Designer installation on the current machine 

freeing up the licence key for installation on another one. 

Check for updates 

Check for recent updates to Photo & Graphic Designer 

Download content installer 

This option is only available after purchasing and activating the trial version of this 

program. It downloads additional content that’s not included in the trial installer, such as 

Live Effect plug-ins, fonts for the Fonts Gallery, fills for the Fills gallery and spell-checker 

dictionaries for other languages.  

Info pop-ups 

At several places in Photo & Graphic Designer, when you chose a specific tool, 

introductory usage hints are displayed in a pop-up message. You can disable each pop-

up by checking DON'T SHOW ME AGAIN in the message window. With TURN ALL ON all 

messages are enabled again, with TURN ALL OFF all messages are turned off. 

About Xara Photo & Graphic Designer 

Displays copyright info and version number of Xara Photo & Graphic Designer. 
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Key shortcuts 

The tools 

Selector Tool F2 or V or Alt + S 

Region Painter Tool Alt + F3 

Freehand Region Tool Alt + F5 

Rectangle Region Tool Alt + F6 

Mask Painter Tool Alt + F7 

Invert region or mask Ctrl + F1    

Show/hide region or mask Ctrl + H 

Clear region or mask Alt + F1     

Freehand & Brush Tool F3 or N 

Shape Tool F4 

Erase background Ctrl + Shift + Alt + P     

Rectangle Tool  Shift + F3 or M 

Ellipse Tool Shift + F4 or L 

QuickShape Tool Shift + F2 

Text Tool  F8 or T 

Fill Tool G 

Transparency Tool  F6 

Shadow Tool  Ctrl + F2 

Bevel Tool Ctrl + F3 

Contour Tool Ctrl + F7 

Blend Tool F7 or W 

Mold Tool Shift + F6 

Live Effects Tool  Ctrl + F5 

Photo Tool P 

Extrude Tool E 

Push Tool  Shift + F8 or H or Alt + X (or the Space bar 

when not in the Text Tool) 

Zoom Tool Shift + F7 or Z or Alt + Z 

 

The galleries 

Fonts Gallery Shift + F9 

Clipart Gallery Shift + F10 

Fill Gallery Shift + F11 

Frame Gallery Shift + F12 

Color Gallery F9 

Page & Layer Gallery F10 

Bitmap Gallery F11 

Line Gallery Ctrl + F9 

Name Gallery Ctrl + Shift + F9 
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Zooming 

Previous zoom Ctrl + R 

Zoom to selection Ctrl + Shift + Z 

Zoom to drawing Ctrl + Shift + J 

Zoom to page Ctrl + Shift + P 

Zoom in (enlarge) Ctrl + + on the numeric keypad 

Zoom out (reduce) Ctrl + - on the numeric keypad 

Zoom to 100% 1 

Zoom to 200% 2 

Zoom to 300% 3 

Zoom to 400% 4 

Zoom to 50% 5 

You can also zoom and slide the document using a mouse-wheel (Ctrl+Mouse-Wheel 

zooms in/out). 

Manipulating documents 

When in the Text Tool, shortcuts marked with a star (*) have a different action-see below. 

New document Ctrl + N 

New animation document Ctrl + Shift + N 

Web animation dialog Ctrl+Shift+Alt+N 

Open document Ctrl + O 

Close document Ctrl + W* 

Switch document Ctrl + Tab 

Print document Ctrl + P 

Save document Ctrl + S 

Import  Ctrl + Alt + I 

Import graphics from Web Ctrl + Alt + W 

Add Google fonts Ctrl + Shift + Alt + W 

Export  Ctrl + Shift + E 

Time a document redraw Ctrl + Shift + T 

Show grid # 

Show guides 1 on numeric keypad 

Snap to grid . on the numeric keypad 

Snap to guides 2 on the numeric keypad 

Snap to objects * on the numeric keypad 

Select full screen 8 on the numeric keypad 

Show rulers  Ctrl + Shift + R or Ctrl + L* 

Undo Ctrl + Z or < or , 

Redo Ctrl + Y or > or . 

 

Manipulating objects 

When in the Text Tool, shortcuts marked with a star (*) have a different action-see below. 



 

 584 Menus and Keyboard Shortcuts 
  

 

 

Select all Ctrl + A * 

Select next object Tab 

Delete the selection Delete * 

Clear selection/Reset current attributes Esc 

Bring object to front Ctrl + F 

Put object to back Ctrl + B * 

Move object forwards Ctrl + Shift + F 

Move object backwards Ctrl + Shift + B 

Move object to layer in front (drawing documents) Ctrl + Shift + U 

Move object to layer behind (drawing documents) Ctrl + Shift + D 

Move to next frame (animation documents) Ctrl + Shift + U 

Move to previous frame (animation documents) Ctrl + Shift + D 

Group objects Ctrl + G 

Ungroup objects Ctrl + U 

Apply Soft Group Ctrl + Shift + G 

Remove Soft Group Ctrl + Shift + U 

Clone object  Ctrl + K 

Duplicate object with offset Ctrl + Alt+ D 

Copy object to clipboard Ctrl + C 

Cut selection to clipboard Ctrl + X 

Paste object from clipboard Ctrl + V 

Paste object in original position Ctrl + Shift + V 

Paste opacity mask Ctrl + Shift + M 

Paste attributes Ctrl + Shift + A 

Create bitmap copy Ctrl + Shift + C 

Export sliced image Ctrl + I * 

Add shapes Ctrl + 1 

Subtract shapes Ctrl + 2 

Intersect shapes Ctrl + 3 

Intersect all shapes Ctrl + 5 

Slice shapes Ctrl + 4 

Join Shapes Ctrl + J 

Apply ClipView Q 

Line width adjust Ctrl + Shift + mousewheel 

Remove ClipView Alt + Q 

Create opacity mask O 

Ungroup opacity mask Alt + O 

Convert to editable shapes Ctrl + Shift + S 

Open the alignment dialog box Ctrl + Shift + L* 

Web address Ctrl + Shift + W 

Repeat on all pages Ctrl + Shift + Alt + R 

Stop repeating Ctrl + Shift + Alt + O 

Move the selected objects cursor (arrow) keys with the Selector Tool (see Nudging 

objects (on page 124) ) 

Move the selected handles cursors (arrow) keys in tools other than the selector. 
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Text Tool 

Cursor keys Move the text cursor up up, down, left or right 

one character at a time. 

Home Move the text cursor to the start of the line. 

End Move the text cursor to the end of the line. 

Ctrl + left/right cursor Move the text cursor left/right one word. 

Ctrl + Home Move the text cursor to the start of the first line in a text 

object. 

Ctrl + End Move the text cursor to the end of the last line in a text 

object. 

Ctrl + A Selects all characters in a text object. 

Ctrl + B  Apply the bold attribute. 

Ctrl + I  Apply the italic attribute. 

Ctrl + C Copy the selected region of text to the clipboard. 

Ctrl + L Select all characters in the line containing the text cursor. 

Ctrl + Return Insert page break 

Ctrl + Shift + Return Insert column break 

Ctrl + Shift + L Insert 'Lorem ipsum' dummy text 

Ctrl + V Paste text at the text cursor position (if the clipboard 

contains text). 

Ctrl + W Swap the case of the character to the right of the text cursor. 

Ctrl + Shift + F1  Toggle text selection between uppercase and lowercase. 

Ctrl + - Insert Soft Hyphen (appears only when wrapping at line 

end). 

Ctrl + Shift + - Insert hard hyphen (dash) to prevent a dash being 

misinterpreted as a hyphen at line end. 

Ctrl + < 

Ctrl + > 

Increase/Decrease font size of selected text (only if the 

selection is all the same point size) 

Alt + cursor keys Increase/Decrease kerning/tracking. 

 Start a new line of text. 

Delete Delete the character to the right of the text cursor. If the 

cursor is on the end of a text line, join this line to the line 

below. 

Backspace Delete the character to the left of the text cursor. If the 

cursor is at the start of a text line, join this line to the line 

above. 

Shift + cursor keys Select all text between the cursor position and the beginning 

of the line. 

Shift + End Select all text between the cursor position and the end of the 

line. 

  



 

 586 Menus and Keyboard Shortcuts 
  

 

 

Special characters (in Text Tool) 

Ctrl + Space  Hard space (words with hard spaces 

between will not wrap at the end of a line) 

Ctrl + NumPad – – EN dash  (An EN dash is longer than a 

minus, and is a more correct ‘dash’) 

Ctrl +  Alt + NumPad – — EM dash (An EM dash is a long dash) 

Ctrl + Alt +.(Full stop) … Ellipsis (An ellipsis is three dots) 

Ctrl + Alt + C © Copyright 

Ctrl + Alt + R ® Registered 

Ctrl + Alt + T ™ Trademark 

Ctrl + Alt + B • Bullet  

 

Feather Tool 

You can control the feather slider with your mouse and keyboard. When the feather text 

box or slider are selected: 

Mouse wheel up/down increases or decreases feathering 

Ctrl + Mouse wheel up/down increases or decreases in larger 

increments. 

Page up/page down keys increases or decreases in larger 

increments. 

Home/end keys select minimum or maximum feather values. 

 

Other 

Color Editor Ctrl + E (opens and closes) 

Options dialog Ctrl + Shift + O 

Xara Photo & Graphic Designer Help F1 
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Integrated key shortcut utility 

This utility provides an easy and direct way to configure key shortcuts. It allows you to 

define a shortcut for a command which doesn't have a shortcut by default, or to change a 

command's shortcut. 

To open the Shortcut Tool, select CUSTOMIZE KEY SHORTCUTS... from the UTILITIES menu. 

 

Command categories 

There are many different commands which can be assigned to shortcuts and so they are 

split into several categories to help finding a command easier. The command categories 

are presented in a dropdown list and the "Commands" list below it lists all the commands 

in that category. Many categories correspond with the name of a menu (e.g. File, Edit, 

Arrange), so finding a command that is on one of the menus is easy. Choose "All" to 

display all available commands in the Commands list. 

Commands 

The Commands list shows all the commands for the selected category. Where a 

command already has a key shortcut, that shortcut is shown in the column to the right of 

the command name. Those commands that don't have any shortcut assigned show 

nothing in the shortcut column. 

If a command has more than one shortcut assigned, then that command will appear 

more than once in the list of commands, once for each of its shortcuts. 

To assign an additional shortcut to a command which already has a shortcut, select the 

command in the list and press the ADD SHORTCUT button. 
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Press the REMOVE SHORTCUT button below the Commands list to remove the selected 

shortcut assignment from the list. 

Key press 

Once you've selected a command in the Commands list, assigning a shortcut key to it is 

easy. Simply press the key combination that you wish to use for the selected command. 

The keypress you choose will then appear in the Keypress field on the Shortcuts Tool 

dialog. Note that if the selected command already had a shortcut shown in the 

Commands list, that shor-cut is replaced by your new keypress.  

If you want to add an additional shortcut, first use the ADD SHORTCUT button under the 

Commands list as described in the Commands section above. 

Pressing the CLEAR button below the Keypress field removes the shortcut for the 

selected command and clears the Keypress field. 

After entering a new keypress, check the CLASHES list which is shown below the 

Keypress field. 

Clashes 

A keypress can be used as a shortcut for one command only. If the keypress you chose 

for a command shortcut is already assigned to another command, the CLASHES list will 

show you this and will allow you to quickly resolve the clash. 

If there is more than one command currently associated with the keypress shown in the 

Keypress field, the Clashes list shows you all the commands that are currently assigned 

to it. You need to remove all but one of the shortcut assignments for the keypress so that 

only one command is associated with it.  

To do this simply select one of the clashing assignments shown in the Clashes list and 

then press the REMOVE CLASH button below it to remove the shortcut assignment.  

Once only two assignments are shown in the Clashes list, deleting one of them will leave 

you with an empty Clashes list, because there is then only one assignment for the 

keypress and so there are no longer any clashes. 

Alternatively you may wish to change the shortcut associated with one of the clashing 

commands. To do this, select the shortcut in the Clashes list and click the EDIT CLASH 

button below it. This automatically locates the command and selects it in the Commands 

list on the left, ready for you to define a new keypress for it. Once it's selected, enter the 

keypress that you want to use for that command and once again resolve any clashes 

shown in the Clashes list. 

Once the Clashes list is empty, your new keypress is defined as a shortcut. You can then 

either select other commands to which you want to assign shortcuts or commit your 

shortcuts changes by pressing OK. You don't need to keep track of all the clashes as you 
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change shortcuts because when you click OK to commit your changes a check is done to 

make sure no clashes remain. 

Standard keys / Classic keys 

At any time you can press STANDARD KEYS to set all the command shortcuts back to the 

default settings for Xara Photo & Graphic Designer. 

Alternatively press Classic Keys to reset to a keyset that was used by early versions of 

Xara Photo & Graphic Designer. Over time, as the product has evolved, various standard 

shortcuts that are commonly used by other applications have been adopted by Xara 

Photo & Graphic Designer. Those who have become familiar with Xara’s original 

shortcuts may prefer to use the ‘classic’ defaults instead. 

Save 

Use the SAVE button to save the current shortcut definitions as a ".ini" file, without 

necessarily applying them so they are used by Xara Photo & Graphic Designer you to 

setup different sets of shortcut assignments and allows you to share the assignments 

between different computers or different users. For example, you could setup shortcut 

assignments that make Photo & Graphic Designer compatible with the shortcuts of 

another application and save them in a .ini file so you can share them. 

Load 

Use the LOAD button to load the shortcuts defined in a .ini file. Once they are loaded, you 

can inspect or modify them in the Shortcuts Tool or apply them to Xara Photo & Graphic 

Designer OK button. 

Cancel 

Press the CANCEL button to discard all the shortcuts changes you have made since you 

opened the Shortcuts Tool. 

OK 

Use the OK button to commit the changes you have made since you opened the 

Shortcuts Tool. If there are any unresolved clashes, you will be told about them at this 

point. You are strongly advised to go back and fix any clashes because otherwise your 

chosen shortcuts may not work. Click the Back button on the warning alert to go back. 

When you do this the first keypress with clashes is automatically selected for you, so you 

can quickly resolve it. 

If no clashes are reported when you click the OK button, your new shortcuts have been 

defined successfully. 
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Example 

Here's an example of the process you would go through if you wanted to use "Ctrl + P" to 

bring up the Print Options dialog. 

1. Bring up the Shortcuts Tool dialog by choosing "Utilities -> Customize Key 

Shortcuts". 

2. The Print Options command is in the File menu, so choose the "File" category from 

the Commands category list. 

3. Select the Print Options command in the list of commands. 

4. Press "Ctrl + P". You'll see "Ctrl + P" appear in the Keypress field. Also the "Print 

Options..." command is now shown as having the "Ctrl + P" shortcut in the 

Commands list. 

5. You can also see that a clash has been identified. The Clashes list shows that Ctrl-

P is now assigned to BOTH "Print..." and "Print Options...". 

6. Select "Print..." in the Clashes list and then click the button below it to remove this 

shortcut. This eliminates the clash. 

7. Now the Clashes list is empty, indicating that there are no clashes for "Ctrl + P". 

8. Click Ok to confirm your changes. 

Now when you press "Ctrl + P" the Print Options dialog appears. 

Temporary key shortcuts 

Three of the most commonly used tools (Selector, Push and Zoom) have special 

shortcuts that allow quick temporary selection of the tool, and then return to the 

previously used tool after use. 

What’s more these shortcuts can be used two ways; either as a toggle (press the key 

once and it selects the tool, press it again and it returns to the previous) or as a 

temporary switch (hold key down and it switches to the tool, and release key to return to 

the previous tool). 

The default key shortcuts for these tools are: 

 "Alt + Z" for Zoom. 

 Space or "Alt + X" for Push. 

 "Alt + S" for Selector Tool. 

These key combinations are deliberately chosen to be near the left hand to make very 

easy selection. 

Note: If you have a mouse with a scroll wheel or center button, there is a better 

temporary shortcut to the Push Tool, namely to press and hold the wheel or button. 

Release it to return to the previous tool. 
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These three commands are listed at the top of the Tool group and described as Switch to 

Push tool (Hold Down to Switch and Return), etc. (you can see the full description of the 

command in the Status line). 

Tip: Long term users of Xara Photo & Graphic Designer will notice that the space bar no 

longer acts as a temporary Select Tool. This was changed to get a greater workflow 

compatibility with Adobe software and Xtreme Photo Designer 7 users will be used to 

using the space bar as a temporary Push Tool (although we believe the mouse button 

short cut is much better and is a more standard Windows shortcut— see note above). 

Long-term users can quickly reconfigure the Spacebar to activate the Selector tool, and 

restore several other back-compatible key shortcuts, by clicking the "CLASSIC KEYS" 

button. Note that this will reset all your current shortcuts and so we recommend that you 

save your current set first by using the "SAVE..." option. 
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More about Xara Group 

About Xara Group Ltd. 

 

Xara is one of the oldest software developers in the UK, with an 

uninterrupted history of innovation dating back to 1981. 

From Wordwise, one of the earliest microcomputer word processors, to Xara Designer, 

the world's fastest, and many believe the world's best drawing and illustration software, 

Xara has developed a wide range of products covering the whole realm of publishing 

software. Xara has pioneered many technologies taken for granted nowadays. From 

developing the world's first check-as-you-type spell checker, to award winning desktop-

publishing software, to the first drawing software to provide real-time anti-aliasing and 

transparency control, Xara continues to innovate and develop leading edge technical 

solutions. 

Xara's first Windows illustration software, Xara Studio, was licensed to Corel and 

distributed for many years as CorelXARA. Now back under Xara control this product has 

been enhanced and relaunched and is now sold in two versions, Xara Photo & Graphic 

Designer and Xara Designer Pro, and also forms the basis for Xara Web Designer. 

Xara has been involved in the Internet from the very beginning. Xara Networks, a 

subsidiary of the Xara Group, was a pioneer Internet provider in the mid 1990s 

(subsequently sold). Another early innovation was Xara Online, which provided online 

Web Service based web graphic and photo effect add-ons.  Xara's most recent 

development is Xara Cloud https://xara.cloud/, a cloud based service which offers the 

ability to design rich documents in the web browser, using any device, and in 

collaboration with colleagues. Today Xara does all of its business via the web, and has 

millions of online customers, worldwide. 

Xara has offices in Berlin, Germany and Gaddesden Place, a historic house in the UK, 

north of London.  

Xara benefits from a distribution partnership with MAGIX Software GmbH. MAGIX has 

been a leading international provider of high-quality software, online services and digital 

contents for multimedia communications since 1993. Internationally, MAGIX operates 

from branches in the USA, Canada, the UK, Germany, France, Italy and the Netherlands. 

https://xara.cloud/
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The MAGIX product range is targeted towards laymen and professionals alike and goes 

beyond the PC range to include seamlessly integrated online and mobile applications. 

According to its retail sales figures, MAGIX leads in the multimedia software sector in the 

most important European markets, and is one of the most successful competitors in the 

USA 

Web Links 

Xara Home Page - www.xara.com  

MAGIX Home Page – www.MAGIX.com 
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Legal 

Copyright 

This documentation is protected by law. All rights, especially the right of duplication, 

circulation, and translation are reserved. 

No part of this publication may be reproduced in form of copies, microfilms or other 

processes, or transmitted into a language used for machines, especially data processing 

machines, without the express written consent of the publisher. 

All copyrights reserved. 

All other product names are trademarks of the corresponding manufacturers. Errors in 

and changes to the contents as well as program modifications reserved. 

Copyright © Xara Group Ltd., 1994 – 2019. All rights reserved. 

Other mentioned product names may be registered trademarks of the respective 

manufacturer. 

This product uses MAGIX patent pending technology. 

Xara is a registered trademark of Xara Group Ltd. 

MAGIX is a registered trademark of MAGIX Software GmbH  & Co. 

Other mentioned product names may be registered trademarks of the respective 

manufacturer. 

Acknowledgements 

The Geotype font is provided by kind permission of Gary Bouton and remain © Gary 

Bouton, see www.theboutons.com. Some fonts copyright © FontBank Inc., all rights 

reserved. Other fonts are provided by third parties who retain the copyright. 

Xara Photo & Graphic Designer uses Font Awesome by Dan Gandy – 

http://fontawesome.io  

Xara is a trademark of Xara Group Ltd. The contents of this documentation and the 

associated Xara Photo & Graphic Designer software are the property of Xara Group Ltd 

and are copyrighted. Any reproduction in whole or in part is strictly prohibited.  

Portions of this software are copyright © 2006 The FreeType Project (www.freetype.org ). 

All rights reserved. 

Redistributable portions of Microsoft MSVC and MFC are copyright of Microsoft 

Corporation. Microsoft, Internet Explorer, Windows and Windows Vista are either 
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trademarks or registered trademarks of Microsoft Corporation in the United States and/or 

other countries. 

Adobe, Encapsulated PostScript, Illustrator, Photoshop, Dreamweaver, Fireworks, 

Freehand, Flash, PostScript and Type Manager and  are either registered trademarks or 

trademarks of Adobe Systems Incorporated in the United States and/or other countries. 

PANTONE® and other Pantone trademarks are the property of Pantone LLC. 

MAGIX is a registered trademark of MAGIX GmbH & Co. 

Apple, Macintosh, Retina and TrueType are registered trademarks of Apple Computer, 

Inc. 

Corel, CorelDRAW and Paintshop Pro are either registered trademarks or trademarks of 

Corel Corporation. 

Xara Photo & Graphic Designer uses Little CMS.  http://www.littlecms.com/ A copy of the 

license is included in littlecms.txt in the HelpAndSupport folder of your program 

installation. 

Xara Photo & Graphic Designer uses the Google Web Fonts API 

Xara Photo & Graphic Designer uses the FontForge library http://fontforge.github.io/en-

US/. A copy of the FontForge license is included in FontForgeLicense.txt in the 

HelpAndSupport folder of your program installation 

Xara Photo & Graphic Designer includes MiniWeb HTTP server, available under LGPL 

from here: (http://www.sourceforge.net/projects/miniweb/) 

Xara Photo & Graphic Designer uses the Mersenne Twister random number generator , 

Copyright (C) 1997 - 2002, Makoto Matsumoto and Takuji Nishimura, and 2000 - 2003, 

Richard J. Wagner. All rights reserved. Further copyright information can be found in the 

MTRand.txt file located in the HelpAndSupport folder of your Photo & Graphic Designer 

installation. 

Some program code is Copyright (c) 1996 Silicon Graphics Computer Systems, Inc. 

Further copyright information can be found in the sg.txt HelpAndSupport folder of your 

Photo & Graphic Designer installation. 

Some program code is  Copyright (c) 1994 Hewlett-Packard Company. Further copyright 

information can be found in the hp.txt HelpAndSupport folder of your Photo & Graphic 

Designer installation. 

This software is based in part on the work of the Independent JPEG Group. 

Some import and export filters (including PDF) utilize color profiles from Adobe Systems 

Inc. The license agreement can be found in the Filters\pdfxfilter\icc folder of your  Photo 

& Graphic Designerinstallation. 

http://www.littlecms.com/
http://fontforge.github.io/en-US/
http://fontforge.github.io/en-US/
http://www.sourceforge.net/projects/miniweb/
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Photo & Graphic Designer’s PDF Import function uses a separate pdf2xar conversion 

program, which itself uses the open source Poppler library 

(http://poppler.freedesktop.org/ ). The source for pdf2xar is released by Xara as open 

source and is available from http://www.xara.com/pdf-import/ . 

Xara Photo & Graphic Designer uses the zlib compression library www.zlib.net 

Xara Photo & Graphic Designer uses the ImageMagick library Copyright 1999-2007 

ImageMagick Studio LLC http://www.imagemagick.org. A copy of the ImageMagick 

license is included in ImageMagick.txt in the HelpAndSupport folder of your Photo & 

Graphic Designer installation. 

Photo & Graphic Designer's spell checker is based on the Open Source Hunspell library 

used without any modifications under the Mozilla Public License Version 1.1. You can 

find a copy of the Mozilla Public License in the file MPL-1.1.txt in the "dict" folder of your 

Photo & Graphic Designer installation and a copy of the Hunspell source code at 

http://hunspell.sourceforge.net/ . The Xara Photo & Graphic Designer distribution 

includes various language dictionaries which are distributed under various different 

licenses, for use with the spell checker. See the text files in the "dict" folder of your Photo 

& Graphic Designer installation for details of each license. The Russian dictionary is 

Copyright (c) 1997-2008, Alexander I. Lebedev. See README_ru_RU.txt in the “dict” 

folder of your program installation for details and license. 

Perspective correction photo tool based on ShiftN technology provided by Marcus Hebel, 

http://www.shiftn.de: ShiftN version 3.5, May 2009. 

Xara Photo & Graphic Designer uses the libcurl library curl.haxx.se/libcurl 

http://www.curl.haxx.se/libcurl for FTP publishing. A copy of the license for this library is 

included in libcurl.txt in the HelpAndSupport folder of your Xara Photo & Graphic 

Designer installation. 

Mehdi plugins © Guessous Mehdi , Redfield plugins © John Redfield. 

All other trademarks or registered trademarks are the property of their respective owners. 

http://www.imagemagick.org/
http://www.shiftn.de/
http://www.curl.haxx.se/libcurl


 

Index 597  
 
 

 

Index 

 

3D color editor 211 
3D Extrude Tool 443 

 

About Xara Group Ltd. 592 
About Xara Photo & Graphic Designer 19, 581 
Accelerating and Decelerating 483 
Accuracy 395 
Acknowledgements 594 
Adding a new point handle 99 
Adding arrowheads & tails 93 
Adding Hyperlinks 167 
Adding more line segments 93 
Adding more Live Effects 420 
Adding names 83 
Adding Pages 458 
Adding to a gallery 80 
Adjusting a photo in its frame 455 
Adjusting brightness 426 
Adjusting painted effects 414 
Adjusting the clip region 409 
Adjusting the left and right margin of text on a curve 243 
Adjusting tolerance and fade 406 
Adobe Photoshop vs. Xara Picture Editor plug-ins 418 
Advanced 160, 344 
Advanced color operations 210 
Advanced Flash Commands 483 
Advanced Levels - The Green Line 428 
Advanced options 315 
Advanced text properties 289 
Aligning 152 
Alignment 150 
Alignment (Ctrl+Shift+L) 572 
Alt + S 116 
Alternative Content Aware Scaling 424 
An example 243, 304 
An Example Using a Photo Region 369 
Anchored Graphics 262 
Anchored Objects 42 
Angle constraint 546 
Animation 576 
Animation Frame Rate and Tween Steps 472 
Animation Loop and Speed 467 
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Animation properties 466 
Animation smoothness 476 
Animation Speed 475 
Animations 459 
Apply directly 315 
Apply opacity mask 572 
Apply soft group (Ctrl+Alt+G) 571 
Apply/Remove ClipView (Q/Alt+Q) 572 
Applying a bevel 325 
Applying a bevel to several objects 325 
Applying a contour to several objects 333 
Applying a floor shadow 321 
Applying a font from the Fonts Gallery 292 
Applying a glow effect 321 
Applying a Live Effect 417 
Applying a scaling factor 72 
Applying a shadow 320 
Applying a shadow to several objects 324 
Applying attributes to whole text stories 290 
Applying Enhance 403 
Applying Enhance transparency 311 
Applying fill & line colors by drag & drop 207 
Applying flat transparency 310 
Applying graduated transparency 310 
Applying text attributes 281 
Applying the same Levels correction to multiple images 431 
Applying transparency to several objects 313 
Applying using the clipboard 314 
Arrange Icons 578 
Arrange menu 570 
Arrange Views 578 
Arrow SmartShapes 180 
Ask before setting current attribute 544 
Attributes 14 
Auto correction 249 
Auto Enhance 400 
Auto Levels 428 
Auto-fit for individual page objects 163 
Auto-fit to page... 160 
Auto-fit to Page... 58, 552 
Auto-Fit to page... 577 
Auto-fit to text areas 239 
Automatic Backups 43, 66 
Automatic fit 492 
AVI Options 467 

 

Backup location 67 
Backup open documents 66 
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Backup open documents on program close 67 
Backups on system shut down 68 
Backups Tab 553 
Balancing curves 104 
Bars 14, 578 
Baseline shift 287 
Best fit 492 
Bevel direction 326 
Bevel Type & Size 445 
Bevels 325 
Bitmap coloring 303 
Bitmap Compression 526 
Bitmap fills 301 
Bitmap Properties 366 
Bitmap Quality 471 
Bitmap Size tab 537 
Bitmap Tracer 576 
Bitmap transfer 555 
Bitmap-Editor 576 
Bitmaps 312, 560 
Bleed 57 
Blending & Merging photos 368 
Blending along a curve 351 
Blends 346 
Blends and PDF or PostScript files 351 
Blur the edges of the shadow 322 
Blur/Sharpen 401 
Bold & Italic 281 
Bold, Italic & Synthesized fonts 231 
Break Shapes (Arrange control bar) 572 
Breaking joined shapes 191 
Brightness Curves 430 
Brightness/Contrast/Color Temperature/Saturation/Hue 400 
Bring to Front (Arrange control bar or Ctrl+F) 570 
Browser Preview tab 539 
Brush styles 92 
Brushes 109 
Bullet Lists 268 
Bulleted and numbered lists 41 
Bulleted and Numbered lists 268 

 

Cache Control 557 
Cancel 589 
Cascade 578 
Change join type 109 
Change line cap 109 
Change object selection 116 
Change the transparency of the shadow 322 
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Changing a straight line to a curve (and vice versa) 104 
Changing background colors 217 
Changing colors 456 
Changing curves 102 
Changing text 455 
Changing text into editable shapes 290 
Changing the angle of the column 237 
Changing the bevel color or fill effect 328 
Changing the bevel join style 328 
Changing the bevel light source 326 
Changing the bevel shape 328 
Changing the bevel size 327 
Changing the blank template document 542 
Changing the colors in a fill 299 
Changing the contour attribute profile 332 
Changing the contour color 331 
Changing the contour join style 332 
Changing the contour position profile 332 
Changing the default display units 71 
Changing the font size 281 
Changing the light elevation (vertical angle) 327 
Changing the light strength (contrast) 327 
Changing the line width (thickness) 105 
Changing the number of steps in a contour 331 
Changing the page size 54 
Changing The Page Size of Templates 457 
Changing the ruler zero points 70 
Changing the shadow color or fill effect 323 
Changing the shadow profile 322 
Changing the size of buttons 564 
Changing the size of the undo list 87 
Changing the width of the column 237 
Changing the zoom using the zoom InfoBar/control bar 52 
Changing the zoom value 51 
Changing the zoom value using the mouse 52 
Chart SmartShapes 175 
Charts 575 
Check for updates 580 
Check spelling as you type 577 
Chevron Bar SmartShape 182 
Circular fills 300 
Clashes 588 
Clear 408 
Clear Mask or Region (Ctrl+D) 577 
Clear Selection / Reset current attributes (Esc) 570, 578 
Clickable Buttons & Mouse-over Effects 484 
Clip Tool 407 
Clipping in Photo Documents 409 
ClipView 154, 343 
Clone (Ctrl+K) 570 
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Clone Tool Infobar 410 
Clone Tool Operation Summary 411 
Cloning 128 
Close (Ctrl+W) 566 
Closing a freehand shape (to create a filled shape) 91 
Closing the document 65 
CMYK colors and transparency effects 213 
Collated 490 
Color 560 
Color Blend Effect 352 
Color cast - fixing the white balance 427 
Color Editor (Ctrl+E) 576 
Color Handling 205 
Color line context menu 206 
Color Model 523 
Color palette from photo 435 
Color separating 502 
Color Transforms—Animating Color Changes 482 
Coloring Imported Clipart 36 
Coloring photos 379 
Coloring Photos 36 
Coloring Shapes 36 
Colors on the color line 205 
Colors on the screen and on the printer 213 
Combine Shapes 344 
Combine Shapes (Arrange control bar) 572 
Combining shapes 187 
Command categories 587 
Commands 587 
Common photo functions 397 
Compare & Restoring the original 432 
Condensing and expanding characters (aspect ratio) 288 
Conflicts in page layouts 168 
Conical fills 300 
Connecting text areas—text flow 238 
Connection Type 549 
Constraining the line 102 
Content Aware Photo Resize 421 
Content Aware photo scaling 341 
Content Aware Scaling notes 424 
Content-aware photo zoom 423 
Contouring objects 330 
Contours 330 
Control bars 48, 561 
Control Bars 578 
Convert Line to Shape 573 
Convert to Editable Shapes (Arrange control bar Ctrl+Shift+S) 573 
Converting contours to shapes 333 
Converting objects or drawings to bitmaps 390 
Converting shadows to shapes 323 
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Coordinate Direction 548 
Copy (Edit control bar or Ctrl+C) 568 
Copying & Pasting between Xara Photo & Graphic Designer and other 
programs 88 
Copying 3D extrude attributes 448 
Copying and pasting pages 60 
Copying Live Effects 421 
Copying Objects 30, 470 
Copying shadows onto other objects 324 
Copying Shapes To The Mask Layer 344 
Copying Styles 

Paste Attributes 153 
Copying text appearances 289 
Copying/Pasting formatted text (RTF) 290 
Copyright 594 
Core Principles 461 
Create Bitmap Copy (Ctrl+Shift+C) 573 
Creating a graduated color fill 296 
Creating a guideline 144 
Creating a new brush 110 
Creating a new unit 71 
Creating a Tint, Shade or Linked color 221 
Creating animated GIFs 465 
Creating Buttons, Banners And Other Web Graphics 450 
Creating circles and ellipses 184 
Creating holes in shapes 188 
Creating Live Copies 160 
Creating new control bars 563 
Creating new named colors 215 
Creating new Styles 277 
Creating New Text Objects 41 
Creating polygons and stars 184 
Creating rectangles and squares 183 
Creating Regions and Masks 339 
Creating rounded corner rectangles 183 
Creating Soft Groups 149 
Creating the animation 466 
Creating your own color schemes 214 
Creating your own Named Colors 37 
Cropping photos 375 
Cropping photos with a mask 375 
Cropping photos with the Eraser Tool 375 
Cropping, Clipping and Animation Size 473 
Current attributes 24 
Current layer always visible and editable 543 
Custom fit 492 
Custom tab types 258 
Custom tabs 257 
Customize Key Shortcuts 577 
Customizing PDF export using advanced options 521 
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Customizing Photo & Graphic Designer 542 
Cut (Edit control bar or Ctrl+X) 568 
Cut, copy and paste 124 
Cut, Copy, Delete 342 
Cutting objects 127 

 

Deactivate programme 580 
Decimal point & thousands separator characters 72 
Default Live Effect resolution 554 
Default Locked effect resolution 554 
Delete (Edit & Standard control bars or Delete) 569 
Deleting a guideline 145 
Deleting a scaling factor 72 
Deleting a unit 71 
Deleting control bars 563 
Deleting images from the Gallery 366 
Deleting named colors 218 
Deleting objects 127 
Deleting points 100 
Deleting repeating objects 159 
Deleting sections from a gallery 81 
Deleting Styles 280 
Deleting unused color 218 
Description 528 
Deselecting an object 118 
Diamond fills 301 
Display 559 
Displaying & hiding control bars 562 
Displaying a gallery 75 
Displaying/hiding rulers 70 
Distribute 153 
Dithering 559 
Docked and free floating control bars 562 
Document 13, 552 
Document Encryption and Permissions Password 533 
Document Font embedding 293 
Document handling 46 
Document info 19 
Document Info 567 
Document Info and Live Effects 420 
Document Permissions Settings 533 
Documents Loaded 580 
Double page spread 56 
Double page spreads 489 
Double page spreads in multi-page documents 63 
Double-click shortcuts to tools 119 
Download content installer 581 
Dragging the line segment 103 
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Drawing & editing straight lines 93 
Drawing Lines and Shapes 89 
Drawing straight segments in the Freehand Tool 90 
Drawing Tools 23 
Drop copy 123 
Duplicate (Edit control bar or Ctrl+Alt+D) 570 
Duplicate a page 60 
Duplicate, Clone 343 
Duplicating 128 
Duplicating and cloning 127 
Duplication distance 546 

 

Easy crop 407 
Edit menu 568 
Editing a Scatter brush 111 
Editing an Art brush 112 
Editing an object’s color 208 
Editing Bitmaps 555 
Editing group contents 147 
Editing inside an opacity mask group 315 
Editing inside groups 147 
Editing lines/shapes with the Freehand & Brush Tool 91 
Editing List items 270 
Editing Live Effects 419 
Editing mold shapes 338 
Editing named colors 217 
Editing Photo Files 392 
Editing Photo Filter Presets 382 
Editing photos 455 
Editing polygons and stars 186 
Editing shapes 418 
Editing SmartShapes 170 
Editing stars 187 
Editing text 246 
Editing the contents of a repeating object 157 
Editing the outline of Photos 374 
Editing the parent color 222 
Editing the shapes in a blend 351 
Editing theme colors individually 456 
Effect Painter Tool 413 
Effects 553 
Effects & Plug-ins tab 553 
Elliptical fills 300 
Embedded Fonts 42 
Embedded JPEG files 367 
Embedding Graphics 265 
Enhance 311 
Enhance photo colors 401 
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Enhance Tool 398 
Enhancing different colors 404 
Entering dummy text ('Lorem Ipsum') 248 
Entering special characters 248 
Enveloping 337 
Eraser tool 439 
Erasing backgrounds 439 
Erasing while drawing 90 
Example 590 

To resize a photo and save as a new JPEG 373 
Example Graphics 26 
EXIF Tool 435 
Exit 567 
Export (Ctrl+Shift+E) 566 
Export Animation 567 
Export formats 508 
Export image in slices (Ctrl+I) 567 
Export JPEG 566 
Export PDF 567 
Export PNG 567 
Export the graphic in slices 516 
Exporting a Flash File 463 
Exporting a Photoshop PSD file 514 
Exporting animations as AVI 464 
Exporting as a bitmap 513 
Exporting as ArtWorks EPS 513 
Exporting as AVI 512 
Exporting as Extended Metafile Format (EMF) 513 
Exporting as Flash 512 
Exporting as Illustrator EPS 513 
Exporting as PDF 512 
Exporting as Photo & Graphic Designer EPS 513 
Exporting as SVG 513 
Exporting as Windows metafiles (.wmf) 513 
Exporting files 512 
Exporting PDF files 518 
Exporting the animation 466 
Exporting to a Word document 512 
Exports 85 
Exports, slices, and stretches properties 85 
Extend Selection 117 
Extending a line 90 
Extending the line 98 
Extracting the original JPEG 368 
Extrude Tool InfoBar 444 
Extruding a shape 443 
Extruding Text 448 
Extrusion depth 445 
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Feather 26 
Feather Tool 586 
Feathering 138 
File Embedding 529 
File menu 565 
File Open Password 532 
Fill quality 491 
Fill Tool 25 
Fill Tool InfoBar 296 
Filling shapes with a bitmap 366 
Fills 124, 295 
Find & Replace 252 
Find/Replace (Ctrl+Alt+F) 570 
Finding Objects 203 
Finding objects in the Page & Layer Gallery 120 
Finishing the line 98 
Fit Text to Curve/Remove Text From Curve 573 
Flash Embedding 519 
Flash Options 466 
Flat fills 298 
Flatten photo group 572 
Flipping objects 138 
Flowline SmartShapes 183 
Flyout Bars 22 
Fly-out menus 564 
Font replacement 236 
Font Size 41 
Fonts and PDF 293 
Four-color fills 301 
Fractal fills 304 
From Content Catalog (Shift+Alt+I) 574 
Full Screen (8 on numeric keypad) 579 
Full screen mode 561 

 

Galleries 74, 575 
Gallery cache 556 
Gallery docking and undocking 564 
General notes on exporting and importing 505 
General Options 530 
General tab 543 
Getting Help 17 
Getting Started 20 
GIF Options 467 
Give new objects most recent attributes (GNOMRA) 544 
Gloss / Matt 446 
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Google fonts 231 
Graphical Bullets and Numbered Lists 273 
Grid and Ruler spacing 547 
Grid and Ruler tab 547 
Grid type 547 
Group (Arrange control bar or Ctrl+G) 571 
Group Transparency 479 
Group transparency on blends 313 
Grouping and ungrouping objects 145 
Groups 44, 479 
Groups and layers 146 
Guide Objects and Guidelines 143 

 

Handle/resolution 313 
Headers/Footers 158 
Help 580 
Help menu 580 
Hidden Styles 280 
Hiding buttons and tools 564 
Hiding Layers and Objects 203 
Hiding objects 121 
Highlights brightness 401 
Horizon Straighten 384 
How Live Effects work 419 
How to creating hanging indents 259 
Hyphenation 250 

 

Identifying a selected object 119 
Image 574 
Image Map tab 538 
Image slicing 516 
Imagesetting 494 
Imagesetting dialog 495 
Import (Ctrl+Alt+I) 566 
Import and Export Supported File Formats 506 
Import formats 506 
Import from Web Address (Ctrl+Alt+W) 566 
Important 514 
Importing a Photoshop PSD file 509 
Importing a Word document 511 
Importing and Exporting 505 
Importing colors and palettes 222 
Importing files 508 
Importing from a website 511 
Importing Large Photos 40 
Importing named colors 219 
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Importing Photos 360 
Indents and Outdents 287 
Info pop-ups 581 
InfoBar 29, 48 
Initial and final color tolerance 395 
Initial Photo size 362 
Initial View 528 
Ink-level overprinting 501 
Inline anchored objects 265 
Insert menu 574 
Inserting a Flash file into your webpage 463 
Inserting pages into your document 59 
Inserting Symbols as graphics 235 
Inserting Symbols into text 235 
Inserting using a different web authoring tool 464 
Installing or uninstalling a font 293 
Instant font menu navigation 231 
Integrated key shortcut utility 587 
Integration with external Photo Editors 386 
Internet Cache 548 
Internet tab 548 
Intersecting shapes 188 
Introduction 225, 295, 309, 443, 459, 565 
Introduction to Xara Photo & Graphic Designer 13 
Invert Mask or Region (Ctrl+Shift+I) 577 

 

Join Shapes (Arrange control bar or Ctrl +J) 572 
Joined RGB - or separate Red, Green and Blue 429 
Joining lines 104 
Joining shapes 190 
Joining two lines 90 
JPEG Quality 526 
JPEG, PNG, GIF and BMP export dialog overview 534 
Justification or text alignment 281 

 

Kerning 288 
Key press 588 
Key shortcuts 582 
Knowledge Base 580 

 

Labeled lines 181 
Language selection 248 
Layer Operations 197 
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Layer Properties 198 
Layering Methods (standard PDF only) 531 
Layers 45, 195 
Layers in PDF documents 197 
Legacy web browser compatible line lengths 545 
Legal 594 
Levels Tool notes 431 
Ligatures 282 
Lights 445 
Limit to Browser palette 212 
Line Gallery 107 
Line spacing 287 
Linear fills 299 
Lines, shapes, and objects 13 
Linked colors 221 
Linked shades 37 
List Styles 275 
Live Copies 159 
Live Copies are Groups 159 
Live copy 573 
Live Effect resolution 419 
Live Effects 417 
Live Font Preview 230 
Live Font Size preview 231 
Load 589 
Local and Global Edits 159 
Local colors and Theme colors 213 
Lock Aspect 409 
Lock Aspect button 133 
Locked vs. Live Effects 418 
Locking effects 418 
Locking Layers and Objects 203 
Locking objects 121 
Lorem Ipsum Text 575 

 

Magnetic Lasso 376 
Magnetic object snapping (snap to objects) 140 
Magnetic Snap Radii 550 
Main toolbar 49 
Maintain imported layer names 544 
Make groups be transparent as a whole. 544 
Make Named Color local to Frame/Layer 220 
Making a photo its full size 387 
Making an object repel 260 
Making shapes editable 191 
Making sharp corners 103 
Making smooth curves 103 
Manipulating documents 583 
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Manipulating objects 583 
Margins and indents 256 
Marquee Object Selection 545 
Marquee selection 116 
Masks vs Photo Regions 339 
Measurement units 70 
Menus 15 
Menus and Keyboard Shortcuts 565 
Merging several shapes into one 188 
Microsoft Outlook 2003 88 
Millipoints 70 
Minimizing multiple windows 51 
Minimum area 395 
Mitred corner / Rounded corner 446 
Mixing curved and straight lines 97 
Mixing individual and group transparencies 313 
Modifying a bevel 326 
More about Xara Group 592 
More Photo & Graphic Designer 580 
Mouse actions 15 
Mouse button function 550 
Mouse tab 549 
Move Backwards (Arrange control bar or Ctrl+Shift+B) 571 
Move Forwards (Arrange control bar or Ctrl+Shift+F) 570 
Move To Layer Behind (Arrange control bar or Ctrl+Shift+D) 571 
Move to Layer in Front (Arrange control bar or Ctrl+Shift+U) 570 
Movies 580 
Moving Anchored Objects 265 
Moving and docking a gallery 76 
Moving buttons and tools 564 
Moving content from previous versions of Xara Photo & Graphic Designer 81 
Moving objects 123 
Moving Objects Between Layers 45, 204 
Moving objects forward and backwards 128 
Moving objects selected under or inside 118 
Moving pages within the document 61 
Moving point handles—Selector Tool 102 
Moving point handles—Shape Editor Tool 100 
Moving the start or end handle of the fill 299 
Multi-page Documents 58 
Multiple fit 493 
Multiple Page View 578 
Multi-stage blends 349 
Multi-stage color graduations 305 
Multi-stage graduated transparency 310 

 

Names 576 
Names applied 83 
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Naming objects 82 
Navigating between pages 62 
Network button 488 
New (Standard control bar or Ctrl+N) 565 
New Effects Are Locked By Default 553 
New from Content Catalog (Shift+Ctrl+Alt+K) 565 
New from Designs Gallery 565 
New Page 575 
New page from template 60 
New View 578 
Nib size 439 
Non-destructive editing 442 
Non-destructive photo editing 354 
Non-JPEG Bitmaps 470 
Non-moving Objects 482 
Normal colors 220 
Normal colors, Tints, Shades and Linked colors 220 
Normal/full screen modes 50 
Nudge size 546 
Nudging objects 124 
Nudging Objects 29 
Number of copies 490 
Numbered Lists 269 

 

Object Based Design 27 
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